
Error Code Error Description Supported Versions
5 Invalid procedure call or argument Access 2003+
6 Overflow Access 2003+
7 Out of memory Access 2003+
9 Subscript out of range Access 2003+
10 This array is fixed or temporarily locked Access 2003+
11 Division by zero Access 2003+
13 Type mismatch Access 2003+
14 Out of string space Access 2003+
16 Expression too complex Access 2003+
17 Can't perform requested operation Access 2003+
18 User interrupt occurred Access 2003+
28 Out of stack space Access 2003+
47 Too many DLL application clients Access 2003+
48 Error in loading DLL Access 2003+
49 Bad DLL calling convention Access 2003+
51 Internal error Access 2003+
52 Bad file name or number Access 2003+
53 File not found Access 2003+
54 Bad file mode Access 2003+
55 File already open Access 2003+
57 Device I/O error Access 2003+
Error Code Error Description Supported Versions
58 File already exists Access 2003+
59 Bad record length Access 2003+
61 Disk full Access 2003+
62 Input past end of file Access 2003+
63 Bad record number Access 2003+
67 Too many files Access 2003+
68 Device unavailable Access 2003+
70 Permission denied Access 2003+
71 Disk not ready Access 2003+
74 Can't rename with different drive Access 2003+
75 Path/File access error Access 2003+
76 Path not found Access 2003+
93 Invalid pattern string Access 2003+

96 Unable to sink events of object because the object is already firing events to the
maximum number of event receivers that it supports Access 2003+

97 Can not call friend function on object which is not an instance of defining class Access 2003+

98 A property or method call cannot include a reference to a private object, either
as an argument or as a return value Access 2003+

321 Invalid file format Access 2003+
322 Can't create necessary temporary file Access 2003+
325 Invalid format in resource file Access 2003+
380 Invalid property value Access 2003+
Error Code Error Description Supported Versions
381 Invalid property array index Access 2003+



382 Set not supported at runtime Access 2003+
383 Set not supported (read-only property) Access 2003+
385 Need property array index Access 2003+
387 Set not permitted Access 2003+
393 Get not supported at runtime Access 2003+
394 Get not supported (write-only property) Access 2003+
422 Property not found Access 2003+
423 Property or method not found Access 2003+
424 Object required Access 2003+
429 ActiveX component can't create object Access 2003+
430 Class does not support Automation or does not support expected interface Access 2003+
432 File name or class name not found during Automation operation Access 2003+
438 Object doesn't support this property or method Access 2003+
440 Automation error Access 2003+

442 Connection to type library or object library for remote process has been lost.
Press OK for dialog to remove reference. Access 2003+

443 Automation object does not have a default value Access 2003+
445 Object doesn't support this action Access 2003+
446 Object doesn't support named arguments Access 2003+
447 Object doesn't support current locale setting Access 2003+
Error Code Error Description Supported Versions
448 Named argument not found Access 2003+
449 Argument not optional Access 2003+
450 Wrong number of arguments or invalid property assignment Access 2003+

451 Property let procedure not defined and property get procedure did not return an
object Access 2003+

452 Invalid ordinal Access 2003+
453 Specified DLL function not found Access 2003+
454 Code resource not found Access 2003+
455 Code resource lock error Access 2003+
457 This key is already associated with an element of this collection Access 2003+
458 Variable uses an Automation type not supported in Visual Basic Access 2003+
459 Object or class does not support the set of events Access 2003+
460 Invalid clipboard format Access 2003+
461 Method or data member not found Access 2003+
462 The remote server machine does not exist or is unavailable Access 2003+
463 Class not registered on local machine Access 2003+
481 Invalid picture Access 2003+
482 Printer error Access 2003+
735 Can't save file to TEMP Access 2003+
744 Search text not found Access 2003+
746 Replacements too long Access 2003+
Error Code Error Description Supported Versions

2001
You canceled the previous operation.@@@1@5738@1 Access 2007+ uses
different description: 'You canceled the previous
operation.@@@1@2@5738@1'

Access 2003+

2002 You tried to perform an operation involving a function or feature that was not
installed in this version of Microsoft Office Access.@@@1@@1 Access
2007+ uses different description: 'You tried to perform an operation involving

Access 2003+



a function or feature that was not installed in this version of Microsoft Office
Access.@@@1@@@1' Access 2010+ uses different description: 'You tried
to perform an operation involving a function or feature that was not installed in
this version of Microsoft Access.@@@1@@@1'

2004 There isn't enough memory to perform this operation. Close unneeded
programs and try the operation again. Access 2003+

2005

There isn't enough free memory to start Microsoft Office Access.@Close
unneeded programs and try again. For information on freeing memory, search
the Microsoft Windows Help index for 'memory, troubleshooting'.@@1@@3
Access 2007+ uses different description: 'There isn't enough free memory to
start Microsoft Office Access.@Close unneeded programs and try again. For
information on freeing memory, search the Microsoft Windows Help index for
'memory, troubleshooting'.@@1@@@3' Access 2010+ uses different
description: 'There isn't enough free memory to start Microsoft Access.@Close
unneeded programs and try again. For information on freeing memory, search
the Microsoft Windows Help index for 'memory,
troubleshooting'.@@1@@@3'

Access 2003+

2006

The object name '|' you entered doesn't follow Microsoft Office Access object-
naming rules.@For more information about naming objects, click
Help.@@2@553714184@1 Access 2007+ uses different description: 'The
object name '|' you entered doesn't follow Microsoft Office Access object-
naming rules.@For more information about naming objects, click
Help.@@2@1@553714184@1' Access 2010+ uses different description:
'The object name '|1' you entered doesn't follow Microsoft Access object-
naming rules.@For more information about naming objects, click
Help.@@2@1@553714184@1'

Access 2003+

2007

You already have an open database object named '|.'@Use a different name for
each database object of the same type. If you want this object to replace the
original object, close the original object, and then save this object using the
same name. For more information on renaming a database object, click
Help.@@2@209043@1 Access 2007+ uses different description: 'You
already have an open database object named '|.'@Use a different name for each
database object of the same type. If you want this object to replace the original
object, close the original object, and then save this object using the same name.
For more information on renaming a database object, click
Help.@@2@1@9043@1'

Access 2003+

2008

You can't delete the database object '|' while it's open.@Close the database
object, and then delete it.@@1@@1 Access 2007+ uses different description:
'You can't delete the database object '|' while it's open.@Close the database
object, and then delete it.@@1@@@1'

Access 2003+

2009

You can't rename the database object '|' while it's open.@Close the database
object, and then rename it.@@1@@1 Access 2007+ uses different
description: 'You can't rename the database object '|' while it's open.@Close
the database object, and then rename it.@@1@@@1'

Access 2003+

2010

You can't delete the database object '|' while it's open.@Close the database
object, and then delete it.@@1@@1 Access 2007+ uses different description:
'You can't delete the database object '|' while it's open.@Close the database
object, and then delete it.@@1@@@1'

Access 2003+

2011 The password you entered is incorrect. Access 2003+

2014

You have given this |1 the same name as an existing |2 in your database.@You
can't give a table and a query the same name.@Give this object a name that isn't
already used by another table or query.@1@@1 Access 2007+ uses different
description: 'You have given this |1 the same name as an existing |2 in your
database.@You can't give a table and a query the same name.@Give this object
a name that isn't already used by another table or query.@1@@@1'

Access 2003+



2015

There are no registered wizards of this type.@Rerun Microsoft Office Access
or Microsoft Office Setup to reinstall the wizards. If you want to preserve your
security or custom settings, back up the Microsoft Office Access workgroup
information file. For more information on backing up files, search the
Microsoft Windows Help index for 'backing up files'.@@1@@1 Access 2007+
uses different description: 'There are no registered wizards of this
type.@Rerun Microsoft Office Access or Microsoft Office Setup to reinstall the
wizards. If you want to preserve your security or custom settings, back up the
Microsoft Office Access workgroup information file. For more information on
backing up files, search the Microsoft Windows Help index for 'backing up
files'.@@1@@@1' Access 2010+ uses different description: 'There are no
registered wizards of this type.@Rerun Microsoft Access or Microsoft Office
Setup to reinstall the wizards. If you want to preserve your security or custom
settings, back up the Microsoft Access workgroup information file. For more
information on backing up files, search the Microsoft Windows Help index for
'backing up files'.@@1@@@1'

Access 2003+

2016 You can't modify the attributes of System Tables. Access 2003+

2017

Microsoft helps protect this Visual Basic for Applications Project with a
password. You must supply the password in the Visual Basic Editor before you
can perform this operation.@@@1@@1 Access 2007+ uses different
description: 'Microsoft helps protect this Visual Basic for Applications Project
with a password. You must supply the password in the Visual Basic Editor
before you can perform this operation.@@@1@@@1'

Access 2003+

2018

The data access page name '|' you entered is misspelled or refers to a data
access page that isn't open or doesn't exist.@@@1@@1 Access 2007+ uses
different description: 'The data access page name '|' you entered is misspelled
or refers to a data access page that isn't open or doesn't exist.@@@1@@@1'

Access 2003+

2019

The number you used to refer to the data access page is invalid.@Use the Count
property to count the open data access pages and make sure that the page
number is not greater than the number of open data access pages minus
one.@@1@2019460@1 Access 2007+ uses different description: 'The
number you used to refer to the data access page is invalid.@Use the Count
property to count the open data access pages and make sure that the page
number is not greater than the number of open data access pages minus
one.@@1@4@2019460@1'

Access 2003+

2020
The data access page theme name '|' you entered is misspelled or refers to a
theme name that doesn't exist.@@@1@@1 Access 2007+ uses different
description: ''

Access 2003

2021

One or more operators in the filter expression is invalid.@For a valid list of
operators refer to the help file@@1@@1 Access 2007+ uses different
description: 'One or more operators in the filter expression is invalid.@For a
valid list of operators refer to the help file@@1@@@1'

Access 2003+

2022

You entered an expression that requires a data access page to be the active
window.@@@1@5601@1 Access 2007+ uses different description: 'You
entered an expression that requires a data access page to be the active
window.@@@1@2@5601@1'

Access 2003+

2023 The file name you specified for the data access page already
exists.@@@1@5601@1 Access 2007+ uses different description: '' Access 2003

Error Code Error Description Supported Versions

2024

The report snapshot was not created because you don't have enough free disk
space for temporary work files.@To fix this, free up disk space (for example,
empty the Recycle Bin or delete unnecessary files).@@1@@1 Access 2007+
uses different description: 'The report snapshot was not created because you
don't have enough free disk space for temporary work files.@To fix this, free
up disk space (for example, empty the Recycle Bin or delete unnecessary
files).@@1@@@1'

Access 2003+



2025

The file is not in the correct format for a Microsoft Office Access
project.@@@1@@1 Access 2007+ uses different description: 'The file is not
in the correct format for a Microsoft Office Access project.@@@1@@@1'
Access 2010+ uses different description: 'The file is not in the correct format
for a Microsoft Access project.@@@1@@@1'

Access 2003+

2026

Your computer is missing at least one of the Microsoft Access 97 object
libraries.Your converted database will not work until you open this database
using Access 97 and then fix any missing references. @Press OK to continue
saving this database in the Access 97 format with missing references, or press
Cancel if you no longer wish to save this database.@@4@@2 Access 2007+
uses different description: ''

Access 2003

2027

This operation is not supported for Microsoft Office Access 1.X
databases.@@@1@@1 Access 2007+ uses different description: 'This
operation is not supported for Microsoft Office Access 1.X
databases.@@@1@@@1' Access 2010+ uses different description: 'This
operation is not supported for Microsoft Access 1.X databases.@@@1@@@1'

Access 2003+

2028
Microsoft Office Access was unable to close the database object. Access 2010+
uses different description: 'Microsoft Access was unable to close the database
object.'

Access 2003+

2029
Microsoft Office applications cannot suspend while you have documents open
from a network location.Exit the applications or close the open documents and
try again.

Access 2003+

2030

The Microsoft Office Access project '|' will be opened read-only because one of
the following occurred:@The file is locked for editing by another user, or the
file (or the folder in which it is located,) is marked as read-only, or you
specified that you wanted to open this file read-only.@@1@@1 Access 2007+
uses different description: 'The Microsoft Office Access project '|' will be
opened read-only because one of the following occurred:@Either the file is
locked for editing by another user, the file (or the folder in which it is located)
is marked as read-only, or you specified that you wanted to open the file read-
only.@@3@@@1' Access 2010+ uses different description: 'The Microsoft
Access project '|1' will be opened read-only because one of the following
occurred:@Either the file is locked for editing by another user, the file (or the
folder in which it is located) is marked as read-only, or you specified that you
wanted to open the file read-only.@@3@@@1'

Access 2003+

2031
You can't convert or enable an MDE file.@@@1@@1 Access 2007+ uses
different description: 'You can't convert or enable an MDE
file.@@@1@@@1'

Access 2003+

2032 Some errors happened during the conversion. No converted database was
generated.@@@1@@1 Access 2007+ uses different description: '' Access 2003

2033
Name conflicts with existing module, project, or object library.@@@1@@1
Access 2007+ uses different description: 'Name conflicts with existing
module, project, or object library.@@@1@@@1'

Access 2003+

2034 Cannot Compile Project.@@@1@@1 Access 2007+ uses different
description: 'Cannot Compile Project.@@@1@@@1' Access 2003+

2035 Cannot Load Project of wrong version.@@@1@@1 Access 2007+ uses
different description: 'Cannot Load Project of wrong version.@@@1@@@1' Access 2003+

2036 Microsoft Office Access does not support using ADP Projects when running in
Runtime Mode.@@@1@@1 Access 2007+ uses different description: '' Access 2003

2037 Microsoft Office Access could not perform name AutoCorrect during this
operation.The 'Log name AutoCorrect' option is set, but the Data and Misc.
Objects is not checked out.@@@1@@3 Access 2007+ uses different
description: 'Microsoft Office Access could not perform name AutoCorrect
during this operation.The 'Log name AutoCorrect' option is set, but the Data
and Misc. Objects is not checked out.@@@1@@@3' Access 2010+ uses

Access 2003+



different description: 'Microsoft Access could not perform name AutoCorrect
during this operation.The 'Log name AutoCorrect' option is set, but the Data
and Misc. Objects is not checked out.@@@1@@@3'

2038 The file '|' cannot be opened because it has been locked by another user. Access 2003+

2039
You cannot convert a workgroup file from Microsoft Access2000 to Access 97.
You must create new security settings in Access 97. Access 2007+ uses
different description: ''

Access 2003

2040
Microsoft Office Access can't run.@@@1@@3 Access 2007+ uses different
description: 'Microsoft Office Access can't run.@@@1@@@3' Access 2010+
uses different description: 'Microsoft Access can't run.@@@1@@@3'

Access 2003+

2041
Microsoft Office Access couldn't find file '|'.This file is required for startup.
Access 2010+ uses different description: 'Microsoft Access couldn't find file
'|1'.This file is required for startup.'

Access 2003+

2042

A system error occurred, or there isn't enough free memory to start Microsoft
Office Access. Close unneeded programs and try again. Access 2010+ uses
different description: 'A system error occurred, or there isn't enough free
memory to start Microsoft Access. Close unneeded programs and try again.'

Access 2003+

2043

Microsoft Office Access can't find the database file '|.'@Make sure you entered
the correct path and file name.@@1@@1 Access 2007+ uses different
description: 'Microsoft Office Access can't find the database file '|.'@Make
sure you entered the correct path and file name.@@1@@@1' Access 2010+
uses different description: 'Microsoft Access can't find the database file
'|1.'@Make sure you entered the correct path and file name.@@1@@@1'

Access 2003+

Error Code Error Description Supported Versions

2044

You can't exit Microsoft Office Access now.@If you're running a Visual Basic
module that is using OLE or DDE, you may need to interrupt the
module.@@1@@1 Access 2007+ uses different description: 'You can't exit
Microsoft Office Access now.@If you're running a Visual Basic module that is
using OLE or DDE, you may need to interrupt the module.@@1@@@1'
Access 2010+ uses different description: 'You can't exit Microsoft Access
now.@If you're running a Visual Basic module that is using OLE or DDE, you
may need to interrupt the module.@@1@@@1'

Access 2003+

2045

The command line you used to start Microsoft Office Access contains an option
that Microsoft Office Access doesn't recognize.@Exit and restart Microsoft
Office Access using valid command-line options.@@1@@1 Access 2007+
uses different description: 'The command line you used to start Microsoft
Office Access contains an option that Microsoft Office Access doesn't
recognize.@Exit and restart Microsoft Office Access using valid command-line
options.@@1@@@1' Access 2010+ uses different description: 'The
command line you used to start Microsoft Access contains an option that
Microsoft Access doesn't recognize.@Exit and restart Microsoft Access using
valid command-line options.@@1@@@1'

Access 2003+

2046 The command or action '|' isn't available now.@* You may be in a read-only
database or an unconverted database from an earlier version of Microsoft
Office Access. * The type of object the action applies to isn't currently selected
or isn't in the active view.@Use only those commands and macro actions that
are currently available for this database.@1@@1 Access 2007+ uses different
description: 'The command or action '|' isn't available now.@* You may be in a
read-only database or an unconverted database from an earlier version of
Microsoft Office Access. * The type of object the action applies to isn't
currently selected or isn't in the active view.@Use only those commands and
macro actions that are currently available for this database.@1@@@1' Access
2010+ uses different description: 'The command or action '|1' isn't available
now.@* You may be in a read-only database or an unconverted database from
an earlier version of Microsoft Access. * The type of object the action applies

Access 2003+



to isn't currently selected or isn't in the active view.@Use only those commands
and macro actions that are currently available for this database.@1@@@1'

2048

There isn't enough free memory to open the file '|.'@Close unneeded programs
and try again. For more information on freeing memory, search the Microsoft
Windows Help index for 'memory, troubleshooting'.@@1@@1 Access 2007+
uses different description: 'There isn't enough free memory to open the file
'|.'@Close unneeded programs and try again. For more information on freeing
memory, search the Microsoft Windows Help index for 'memory,
troubleshooting'.@@1@@@1'

Access 2003+

2049 The Tahoma font is not present.To restore it, please run Detect and Repair from
the Help menu. Access 2007+ uses different description: '' Access 2003

2050
Enter an OLE/DDE Timeout setting from 0 through 300 seconds.@@@1@@1
Access 2007+ uses different description: 'Enter an OLE/DDE Timeout setting
from 0 through 300 seconds.@@@1@@@1'

Access 2003+

2051

The object name '|1' can't be longer than |2 characters according to Microsoft
Office Access object-naming rules.@@@1@@1 Access 2007+ uses different
description: 'The object name '|1' can't be longer than |2 characters according
to Microsoft Office Access object-naming rules.@@@1@@@1' Access 2010+
uses different description: 'The object name '|1' can't be longer than |2
characters according to Microsoft Access object-naming rules.@@@1@@@1'

Access 2003+

2052 There isn't enough free memory to update the display. Close unneeded
programs and try again. Access 2003+

2053
The command name can't be blank.@Please choose a name.@@1@@1 Access
2007+ uses different description: 'The command name can't be blank.@Please
choose a name.@@1@@@1'

Access 2003+

2054

Microsoft Office Access is unable to load the Visual Basic for Applications
dynamic-link library (DLL) Vbe6.@Rerun the Microsoft Office Access Setup
program.@@1@@3 Access 2007+ uses different description: 'Microsoft
Office Access is unable to load the Visual Basic for Applications dynamic-link
library (DLL) Vbe6.@Rerun the Microsoft Office Access Setup
program.@@1@@@3' Access 2010+ uses different description: 'Microsoft
Access is unable to load the Visual Basic for Applications dynamic-link library
(DLL) Vbe7.@Rerun the Microsoft Access Setup program.@@1@@@3'

Access 2003+

2055
The expression '|' you entered is invalid.@@@1@311732@1 Access 2007+
uses different description: 'The expression '|' you entered is
invalid.@@@1@1@11732@1'

Access 2003+

2056

Microsoft Office Access can't supply context-sensitive Help.@@@1@@1
Access 2007+ uses different description: 'Microsoft Office Access can't
supply context-sensitive Help.@@@1@@@1' Access 2010+ uses different
description: 'Microsoft Access can't supply context-sensitive
Help.@@@1@@@1'

Access 2003+

2057

There isn't enough stack memory left to perform the operation.@The operation
is too complicated. Try simplifying the operation.@@1@@3 Access 2007+
uses different description: 'There isn't enough stack memory left to perform
the operation.@The operation is too complicated. Try simplifying the
operation.@@1@@@3'

Access 2003+

2058 The file '|' is incompatible. Microsoft Office Access needs to be
reinstalled.@Run Setup to reinstall Microsoft Office Access. If you want to
preserve your security or custom settings, back up the Microsoft Office Access
workgroup information file. For more information on backing up files, search
the Microsoft Windows Help index for 'backing up files'.@@1@@3 Access
2007+ uses different description: 'The file '|' is incompatible. Microsoft Office
Access needs to be reinstalled.@Run Setup to reinstall Microsoft Office
Access. If you want to preserve your security or custom settings, back up the
Microsoft Office Access workgroup information file. For more information on
backing up files, search the Microsoft Windows Help index for 'backing up

Access 2003+



files'.@@1@@185309@3' Access 2010+ uses different description: 'The file
'|1' is incompatible. Microsoft Access needs to be reinstalled.@Run Setup to
reinstall Microsoft Access. If you want to preserve your security or custom
settings, back up the Microsoft Access workgroup information file. For more
information on backing up files, search the Microsoft Windows Help index for
'backing up files'.@@1@@185309@3'

2059

Microsoft Office Access cannot find the object '|'.@Make sure the object exists
and that you spell its name correctly.@@1@@1 Access 2007+ uses different
description: 'Microsoft Office Access cannot find the object '|'.@Make sure the
object exists and that you spell its name correctly.@@1@@@1' Access 2010+
uses different description: 'Microsoft Access cannot find the object
'|1'.@Make sure the object exists and that you spell its name
correctly.@@1@@@1'

Access 2003+

2060

You can't create a field list based on the action query '|.'@Action queries don't
have fields. A form or report must be based on a table, or on a select or crosstab
query.@Change the RecordSource property for the form or report, or open the
action query and change it to a select query.@1@209232@1 Access 2007+
uses different description: 'You can't create a field list based on the action
query '|.'@Action queries don't have fields. A form or report must be based on a
table, or on a select or crosstab query.@Change the RecordSource property for
the form or report, or open the action query and change it to a select
query.@1@1@9232@1'

Access 2003+

2061
Enter a zero or greater-than-zero number for this option.@@@1@@1 Access
2007+ uses different description: 'Enter a zero or greater-than-zero number
for this option.@@@1@@@1'

Access 2003+

2062

The command name must be shorter than 255 Characters.@Please choose a
name.@@1@@1 Access 2007+ uses different description: 'The command
name must be shorter than 255 Characters.@Please choose a
name.@@1@@@1'

Access 2003+

2063

Microsoft Office Access can't create, open, or write to the index file '|'; the
information (.inf) file it uses to keep track of dBASE indexes.@The index file
may be damaged, or you may not have read/write permission for the network
drive you're trying to link to.@You can link to the dBASE file without
specifying any dBASE indexes, but the existing indexes will not be used with
the linked table.@1@@1 Access 2007+ uses different description: 'Microsoft
Office Access can't create, open, or write to the index file '|'; the information
(.inf) file it uses to keep track of dBASE indexes.@The index file may be
damaged, or you may not have read/write permission for the network drive
you're trying to link to.@You can link to the dBASE file without specifying any
dBASE indexes, but the existing indexes will not be used with the linked
table.@1@@@1' Access 2010+ uses different description: 'Microsoft Access
can't create, open, or write to the index file '|1'; the information (.inf) file it uses
to keep track of dBASE indexes.@The index file may be damaged, or you may
not have read/write permission for the network drive you're trying to link
to.@You can link to the dBASE file without specifying any dBASE indexes,
but the existing indexes will not be used with the linked table.@1@@@1'

Access 2003+

2064

The menu bar value '|' is invalid.@You supplied an argument to the
DoMenuItem method that refers to a menu bar that is invalid.@Use an intrinsic
constant or numeric value that refers to a valid menu bar value, such as
acFormbar.@1@611895@1 Access 2007+ uses different description: 'The
menu bar value '|' is invalid.@You supplied an argument to the DoMenuItem
method that refers to a menu bar that is invalid.@Use an intrinsic constant or
numeric value that refers to a valid menu bar value, such as
acFormbar.@1@1@11895@1'

Access 2003+

Error Code Error Description Supported Versions



2065

The name for the menu, command, or subcommand you entered is
invalid.@You supplied an argument to the DoMenuItem method that refers to a
menu name, command, or subcommand that is invalid.@Use an intrinsic
constant or numeric value that refers to a valid menu, command, or
subcommand value, such as acRecordsMenu.@1@611895@1 Access 2007+
uses different description: 'The name for the menu, command, or
subcommand you entered is invalid.@You supplied an argument to the
DoMenuItem method that refers to a menu name, command, or subcommand
that is invalid.@Use an intrinsic constant or numeric value that refers to a valid
menu, command, or subcommand value, such as
acRecordsMenu.@1@1@11895@1'

Access 2003+

2066 A video adapter resolution of at least 640 x 480 pixels is required to run
Microsoft Office Access. Access 2007+ uses different description: '' Access 2003

2067

A menu bar macro can only be run if the menu bar macro name is the setting
used by particular properties or options.@You tried to run a menu bar macro
containing the AddMenu action. Set one of the following properties or options
to the name of the menu bar macro: * The MenuBar property of a form or
report. * The ShortcutMenuBar property of a form, report, or control. * The
Menu Bar or Shortcut Menu Bar option in the Startup dialog box. This error
also occurs if Microsoft Office Access attempts to run a menu bar macro
containing an AddMenu action that follows an action that makes some other
object the active object. For example, the OpenForm action.@@2@603704@1
Access 2007+ uses different description: 'A menu bar macro can only be run
if the menu bar macro name is the setting used by particular properties or
options.@You tried to run a menu bar macro containing the AddMenu action.
Set one of the following properties or options to the name of the menu bar
macro: * The MenuBar property of a form or report. * The ShortcutMenuBar
property of a form, report, or control. * The Menu Bar or Shortcut Menu Bar
option in the Startup dialog box. This error also occurs if Microsoft Office
Access attempts to run a menu bar macro containing an AddMenu action that
follows an action that makes some other object the active object. For example,
the OpenForm action.@@2@1@3704@1' Access 2010+ uses different
description: 'A menu bar macro can only be run if the menu bar macro name is
the setting used by particular properties or options.@You tried to run a menu
bar macro containing the AddMenu action. Set one of the following properties
or options to the name of the menu bar macro: * The MenuBar property of a
form or report. * The ShortcutMenuBar property of a form, report, or control. *
The Menu Bar or Shortcut Menu Bar option in the Startup dialog box. This
error also occurs if Microsoft Access attempts to run a menu bar macro
containing an AddMenu action that follows an action that makes some other
object the active object. For example, the OpenForm
action.@@2@1@3704@1'

Access 2003+

2068

The selected item is customized and doesn't have context-sensitive Help.@For
more information on creating custom Help for a form, report, or control, click
Help.@@2@110930@1 Access 2007+ uses different description: 'The
selected item is customized and doesn't have context-sensitive Help.@For more
information on creating custom Help for a form, report, or control, click
Help.@@2@1@10930@1'

Access 2003+

2069

The key or key combination |1 in |2 has invalid syntax or is not allowed.@Use
the SendKeys syntax to specify the key or key combinations. For the allowed
key or key combinations, click Help.@@2@610144@1 Access 2007+ uses
different description: 'The key or key combination |1 in |2 has invalid syntax
or is not allowed.@Use the SendKeys syntax to specify the key or key
combinations. For the allowed key or key combinations, click
Help.@@2@1@10144@1'

Access 2003+

2070 You already assigned the key or key combination |1 in |2 to another
macro.@Only the first key or key combination will be used.@@2@610144@1

Access 2003+



Access 2007+ uses different description: 'You already assigned the key or key
combination |1 in |2 to another macro.@Only the first key or key combination
will be used.@@2@1@10144@1'

2071

The Docking property can't be set to '|1' at this time.@If you want to set the
Docking property to '|2', move the toolbar from its current position and try
again.@@1@@1 Access 2007+ uses different description: 'The Docking
property can't be set to '|1' at this time.@If you want to set the Docking property
to '|2', move the toolbar from its current position and try again.@@1@@@1'

Access 2003+

2072 Successfully imported '|'. Access 2007+ uses different description: 'All objects
were imported successfully.' Access 2003+

2073 Successfully exported '|'. Access 2003+

2074
This operation is not supported within transactions.@@@1@@1 Access 2007+
uses different description: 'This operation is not supported within
transactions.@@@1@@@1'

Access 2003+

2075
This operation requires an open database.@@@1@@1 Access 2007+ uses
different description: 'This operation requires an open
database.@@@1@@@1'

Access 2003+

2076 Successfully linked '|'. Access 2003+
2077 This Recordset is not updatable Access 2003+

2078

Help isn't available due to lack of memory or improper installation of Microsoft
Windows or Microsoft Office Access.@For more information on
troubleshooting a low memory problem, search the Microsoft Windows Help
index for 'memory, troubleshooting'.@If you need to reinstall Microsoft Office
Access, you may want to preserve your security or custom settings. To do so,
back up the Microsoft Office Access workgroup information file. For more
information on backing up files, search the Microsoft Windows Help index for
'backing up files'.@1@@3 Access 2007+ uses different description: 'Help
isn't available due to lack of memory or improper installation of Microsoft
Windows or Microsoft Office Access.@For more information on
troubleshooting a low memory problem, search the Microsoft Windows Help
index for 'memory, troubleshooting'.@If you need to reinstall Microsoft Office
Access, you may want to preserve your security or custom settings. To do so,
back up the Microsoft Office Access workgroup information file. For more
information on backing up files, search the Microsoft Windows Help index for
'backing up files'.@1@@@3' Access 2010+ uses different description: 'Help
isn't available due to lack of memory or improper installation of Microsoft
Windows or Microsoft Access.@For more information on troubleshooting a
low memory problem, search the Microsoft Windows Help index for 'memory,
troubleshooting'.@If you need to reinstall Microsoft Access, you may want to
preserve your security or custom settings. To do so, back up the Microsoft
Access workgroup information file. For more information on backing up files,
search the Microsoft Windows Help index for 'backing up files'.@1@@@3'

Access 2003+

2079 Form is read-only, because the Unique Table property is not set. Access 2003+

2080

The toolbar or menu | already exists.@Do you want to replace the existing
toolbar or menu?@@19@@2 Access 2007+ uses different description: 'The
toolbar or menu | already exists.@Do you want to replace the existing toolbar
or menu?@@19@@@2'

Access 2003+

2081

The Create From Macro command only works when a macro is selected in the
Database window.@@@1@@1 Access 2007+ uses different description:
'The Create From Macro command only works when a macro is selected in the
Navigation Pane.@@@1@@@1'

Access 2003+

2082 Only fields from the Unique Table can be edited. Access 2007+ uses different
description: '' Access 2003

2083 The database '|' is read-only.@You can't save changes made to data or object
definitions in this database.@@1@@1 Access 2007+ uses different

Access 2003+



description: 'The database '|' is read-only.@You can't save changes made to
data or object definitions in this database.@@1@@@1'

2084 Field '|' is based on an expression and can't be edited Access 2003+
Error Code Error Description Supported Versions

2085

The ODBC Refresh Interval setting must be from 1 through 32,766
seconds.@@@1@@1 Access 2007+ uses different description: 'The ODBC
Refresh Interval setting must be from 1 through 32,766
seconds.@@@1@@@1'

Access 2003+

2086 Recordset requires a form to be updatable. Access 2003+

2087

Microsoft Office Access can't display the Add-ins submenu.@The Add-ins
submenu expression '|' you entered exceeds the 256-character limit.@Shorten
the macroname or functionname expression in the Menu Add-ins key of the
Windows Registry setting, and then restart Microsoft Office Access. For more
information on customizing Microsoft Office Access settings in the Windows
Registry, click Help.@2@109015@3 Access 2007+ uses different
description: 'Microsoft Office Access can't display the Add-ins submenu.@The
Add-ins submenu expression '|' you entered exceeds the 256-character
limit.@Shorten the macroname or functionname expression in the Menu Add-
ins key of the Windows Registry setting, and then restart Microsoft Office
Access. For more information on customizing Microsoft Office Access settings
in the Windows Registry, click Help.@2@1@9015@3' Access 2010+ uses
different description: 'Microsoft Access can't display the Add-ins
submenu.@The Add-ins submenu expression '|1' you entered exceeds the 256-
character limit.@Shorten the macroname or functionname expression in the
Menu Add-ins key of the Windows Registry setting, and then restart Microsoft
Access. For more information on customizing Microsoft Access settings in the
Windows Registry, click Help.@2@1@9015@3'

Access 2003+

2088

Microsoft Office Access can't display the Add-ins submenu | because a setting
you entered in the Windows Registry is missing a macro name or function
name expression.@@Supply the missing expression in the Menu Add-ins key
of the Windows Registry, and then restart Microsoft Office Access. For more
information on customizing Microsoft Office Access settings in the Windows
Registry, click Help.@2@109015@3 Access 2007+ uses different
description: 'Microsoft Office Access can't display the Add-ins submenu |
because a setting you entered in the Windows Registry is missing a macro name
or function name expression.@@Supply the missing expression in the Menu
Add-ins key of the Windows Registry, and then restart Microsoft Office Access.
For more information on customizing Microsoft Office Access settings in the
Windows Registry, click Help.@2@1@9015@3' Access 2010+ uses different
description: 'Microsoft Access can't display the Add-ins submenu |1 because a
setting you entered in the Windows Registry is missing a macro name or
function name expression.@@Supply the missing expression in the Menu Add-
ins key of the Windows Registry, and then restart Microsoft Access. For more
information on customizing Microsoft Access settings in the Windows Registry,
click Help.@2@1@9015@3'

Access 2003+

2089

Microsoft Office Access can't display the same menu more than once in a menu
bar.@@@1@603704@1 Access 2007+ uses different description: 'Microsoft
Office Access can't display the same menu more than once in a menu
bar.@@@1@1@3704@1' Access 2010+ uses different description:
'Microsoft Access can't display the same menu more than once in a menu
bar.@@@1@1@3704@1'

Access 2003+

2090 An action within the current global menu's macro group can't change the global
menu bar.@Microsoft Office Access can't display the global menu bar because
the macro called when you first set the global menu includes another action that
tries to reset the global menu.@Check your menu bar macros, and make sure
that you set the global menu bar only once.@1@@1 Access 2007+ uses

Access 2003+



different description: 'An action within the current global menu's macro group
can't change the global menu bar.@Microsoft Office Access can't display the
global menu bar because the macro called when you first set the global menu
includes another action that tries to reset the global menu.@Check your menu
bar macros, and make sure that you set the global menu bar only
once.@1@@@1' Access 2010+ uses different description: 'An action within
the current global menu's macro group can't change the global menu
bar.@Microsoft Access can't display the global menu bar because the macro
called when you first set the global menu includes another action that tries to
reset the global menu.@Check your menu bar macros, and make sure that you
set the global menu bar only once.@1@@@1'

2091 '|' is an invalid name.@@@1@@1 Access 2007+ uses different description:
''|' is an invalid name.@@@1@@@1' Access 2003+

2092

The value you specified for the setting argument in the SetOption method isn't
the correct type of Variant for this option.@You specified a string when
Microsoft Office Access expected a number.@Check the Options dialog box
(Tools menu) to see what type of data is required to set this particular option.
For example, the setting for the Default Database Folder option must be a
string. To see what type of Variant you passed to the SetOption method, use the
VarType function. For more information, search the Help index for 'Variant data
type' and 'VarType function'.@1@@1 Access 2007+ uses different
description: 'The value you specified for the Setting argument in the SetOption
method is not the correct type of Variant for this option.@You specified a string
when Microsoft Office Access expected a number.@See the Access Options
dialog box (click the Microsoft Office Button, and then click Access Options)
to see what type of data is required to set this particular option. For example,
the setting for the Default Database Folder option must be a string. To see what
type of Variant you passed to the SetOption method, use the VarType function.
For more information, search the Help index for 'Variant data type' and
'VarType function'.@1@@@1' Access 2010+ uses different description: 'The
value you specified for the Setting argument in the SetOption method is not the
correct type of Variant for this option.@You specified a string when Microsoft
Access expected a number.@See the Access Options dialog box (click the File
tab, and then click Access Options) to see what type of data is required to set
this particular option. For example, the setting for the Default Database Folder
option must be a string. To see what type of Variant you passed to the
SetOption method, use the VarType function. For more information, search the
Help index for 'Variant data type' and 'VarType function'.@1@@@0'

Access 2003+

2093

The numeric value for the setting argument in the SetOption method doesn't
correspond to any list box or option group settings in the Options dialog
box.@Valid settings are 0 (the first item in the list) through | (the last item in
the list).@@1@606210@1 Access 2007+ uses different description: 'The
numeric value for the Setting argument in the SetOption method does not
correspond to any list box or option group settings in the Access Options dialog
box.@Valid settings are 0 (the first item in the list) through | (the last item in
the list).@@1@1@6210@1optimize.ids'

Access 2003+

2094 Microsoft Office Access can't find the toolbar '|.'@You tried to run a macro that
includes a ShowToolbar action or a Visual Basic procedure that includes a
ShowToolbar method. * The toolbar name may be misspelled. * This action
may refer to a custom toolbar that was deleted from or renamed in the current
database. * This action may refer to a custom toolbar that exists in a different
database.@@1@606458@1 Access 2007+ uses different description:
'Microsoft Office Access cannot find the toolbar '|.'@You tried to run a macro
that includes a ShowToolbar action or a Visual Basic for Applications
procedure that includes a ShowToolbar method. * The toolbar name might be
misspelled or might refer to a legacy toolbar that is no longer available. * This
action might refer to a custom toolbar that was deleted from or renamed in the

Access 2003+



current database. * This action might refer to a custom toolbar that exists in a
different database.@@1@1@6458@1' Access 2010+ uses different
description: 'Microsoft Access cannot find the toolbar '|1.'@You tried to run a
macro that includes a ShowToolbar action or a Visual Basic for Applications
procedure that includes a ShowToolbar method. * The toolbar name might be
misspelled or might refer to a legacy toolbar that is no longer available. * This
action might refer to a custom toolbar that was deleted from or renamed in the
current database. * This action might refer to a custom toolbar that exists in a
different database.@@1@1@6458@1'

2095
Microsoft Office Access can't switch to |.@The Microsoft application you tried
to open can't be found or hasn't been installed on your computer.@@1@@3
Access 2007+ uses different description: ''

Access 2003

2096

Microsoft Office Access can't open the Microsoft Office application because it
can't find the dynamic-link library Mstool32.@Run Setup to reinstall Microsoft
Office Access. If you want to preserve your security or custom settings, back up
the Microsoft Office Access workgroup information file. For more information
on backing up files, search the Microsoft Windows Help index for 'backing up
files'.@@1@@3 Access 2007+ uses different description: ''

Access 2003

2097

The table you tried to create an import/export specification for was created in
an earlier version of Microsoft Office Access.@Convert this database to the
current version of Microsoft Office Access by using the Convert Database
command (Tools menu, Database Utilities submenu).@@1@@1 Access 2007+
uses different description: 'The table for which you tried to create an
import/export specification was created in an earlier version of Microsoft
Office Access.@To convert this database to the current version of Microsoft
Office Access, click the Microsoft Office Button, and then click
'Convert'.@@1@@@1' Access 2010+ uses different description: 'The table
for which you tried to create an import/export specification was created in an
earlier version of Microsoft Access.@To convert this database to the current
version of Microsoft Access, click the File tab, and then click
'Convert'.@@1@@@0'

Access 2003+

2098

The operation could not be completed because the Smart Tag '|' is not
recognized by your system Access 2007 uses different description: 'The
operation could not be completed because the Smart Tag '|' is not recognized by
your system.@@@1@@@1' Access 2010 uses different description: 'The
operation could not be completed because the Action Tag '|' is not recognized by
your system.@@@1@@@1' Access 2013 uses different description:
'Microsoft Access cannot create the reports database right now because your
computer setup requires that you manually open the database to accept
connections from any location. Click the Manage button below and select the
From Any Location option, then click the Create Reports button again to get
setup.@@@1@@@1' Access 2016 uses different description: 'Microsoft
Access cannot create the reports database right now because your computer
setup requires that you manually open the database to accept connections from
any location. Click the Manage button below and select the From Any Location
option, then click the Create Reports button again to get setup.@@@1@@@1'

Access 2003+

2099 The operation could not be completed because the Action Tag '|' is not
recognized by your system.@@@1@@@1 Access 2013+

2100

The control or subform control is too large for this location.@The number you
entered for the Left, Top, Height, or Width property is too large or is a negative
number.@Reduce the size of the control or subform control, or enter a positive
number.@1@@1 Access 2007+ uses different description: 'The control or
subform control is too large for this location.@The number you entered for the
Left, Top, Height, or Width property is too large or is a negative
number.@Reduce the size of the control or subform control, or enter a positive
number.@1@@@1'

Access 2003+



2101

The setting you entered isn't valid for this property.@To see the valid settings
for this property, search the Help index for the name of the property.@@1@@1
Access 2007+ uses different description: 'The setting you entered isn't valid
for this property.@To see the valid settings for this property, search the Help
index for the name of the property.@@1@@@1'

Access 2003+

2102

The form name '|' is misspelled or refers to a form that doesn't exist.@If the
invalid form name is in a macro, an Action Failed dialog box will display the
macro name and the macro's arguments after you click OK. Open the Macro
window, and enter the correct form name.@@1@@1 Access 2007+ uses
different description: 'The form name '|' is misspelled or refers to a form that
doesn't exist.@If the invalid form name is in a macro, an Action Failed dialog
box will display the macro name and the macro's arguments after you click OK.
Open the Macro window, and enter the correct form name.@@1@@@1'

Access 2003+

2103

The report name '|' you entered in either the property sheet or macro is
misspelled or refers to a report that doesn't exist.@If the invalid report name is
in a macro, an Action Failed dialog box will display the macro name and the
macro's arguments after you click OK. Open the Macro window, and enter the
correct report name.@@1@@1 Access 2007+ uses different description: 'The
report name '|' you entered in either the property sheet or macro is misspelled or
refers to a report that doesn't exist.@If the invalid report name is in a macro, an
Action Failed dialog box will display the macro name and the macro's
arguments after you click OK. Open the Macro window, and enter the correct
report name.@@1@@@1'

Access 2003+

2104

You entered the control name '|,' which is already in use.@You already have a
control on the form with this name, or an existing control has its name mapped
to this name for Visual Basic. Visual Basic maps spaces in control names to
underscores. For example, My Control and My_Control are treated as duplicate
names.@@1@611734@1 Access 2007+ uses different description: 'You
entered the control name '|,' which is already in use.@You already have a
control on the form with this name, or an existing control has its name mapped
to this name for Visual Basic. Visual Basic maps spaces in control names to
underscores. For example, My Control and My_Control are treated as duplicate
names.@@1@1@11734@1'

Access 2003+

Error Code Error Description Supported Versions

2105
You can't go to the specified record.@You may be at the end of a
recordset.@@1@@1 Access 2007+ uses different description: 'You can't go
to the specified record.@You may be at the end of a recordset.@@1@@@1'

Access 2003+

2106

| errors occurred when you loaded the form or report.@You loaded a form or
report that has controls or properties that Microsoft Office Access doesn't
recognize and will ignore.@@1@@1 Access 2007+ uses different
description: '| errors occurred when you loaded the form or report.@You
loaded a form or report that has controls or properties that Microsoft Office
Access doesn't recognize and will ignore.@@1@@@1' Access 2010+ uses
different description: '|1 errors occurred when you loaded the form or
report.@You loaded a form or report that has controls or properties that
Microsoft Access doesn't recognize and will ignore.@@1@@@1'

Access 2003+

2107 The value you entered doesn't meet the validation rule defined for the field or
control.@To see the validation rule, click Design view, click the appropriate
field, and then, if the property sheet isn't open, click the Properties button on
the toolbar. Then click the Data tab.@To solve this problem, enter a value that
meets the validation rule, or press ESC to undo your changes.@1@211730@1
Access 2007+ uses different description: 'The value you entered does not
meet the validation rule defined for the field or control.@To see the validation
rule, switch to Design view, click the appropriate field, and then, if the property
sheet is not open, press F4. Then, click the Data tab in the property
sheet.@Enter a value that meets the validation rule, or press ESC to undo your

Access 2003+



changes.@1@1@11730@1' Access 2010+ uses different description: 'The
value you entered does not meet the validation rule defined for the field or
control.@To see the validation rule, switch to Design view or Layout view,
click the appropriate field, and then, if the property sheet is not open, press F4.
Then, click the Data tab in the property sheet.@Enter a value that meets the
validation rule, or press ESC to undo your changes.@1@1@11730@1'

2108

You must save the field before you execute the GoToControl action, the
GoToControl method, or the SetFocus method.@You tried to move the focus to
another control using the SetFocus method,GoToControl action, or the
GoToControl method.@Set the macro or method to the AfterUpdate property
instead of the BeforeUpdate property so it saves the field before changing the
focus.@1@606314@1 Access 2007+ uses different description: 'You must
save the field before you execute the GoToControl action, the GoToControl
method, or the SetFocus method.@You tried to move the focus to another
control using the SetFocus method,GoToControl action, or the GoToControl
method.@Set the macro or method to the AfterUpdate property instead of the
BeforeUpdate property so it saves the field before changing the
focus.@1@1@6314@1'

Access 2003+

2109
There is no field named '|' in the current record.@@@1@@1 Access 2007+
uses different description: 'There is no field named '|' in the current
record.@@@1@@@1'

Access 2003+

2110

Microsoft Office Access can't move the focus to the control |.@* The control
may be a type that can't receive the focus, such as a label. * The control's
Visible property may be set to No. * The control's Enabled property may be set
to No.@@1@603016@1 Access 2007+ uses different description: 'Microsoft
Office Access can't move the focus to the control |.@* The control may be a
type that can't receive the focus, such as a label. * The control's Visible property
may be set to No. * The control's Enabled property may be set to
No.@@1@1@3016@1' Access 2010+ uses different description: 'Microsoft
Access can't move the focus to the control |1.@* The control may be a type that
can't receive the focus, such as a label. * The control's Visible property may be
set to No. * The control's Enabled property may be set to
No.@@1@1@3016@1'

Access 2003+

2111

The changes you made can't be saved.@The save operation may have failed
due to the temporary locking of the records by another user. * Click OK to try
again. You may need to click OK several times (or wait until the other user
closes the table). * Click Cancel if repeated attempts to save your changes
fail.@@3@@1 Access 2007+ uses different description: 'The changes you
made can't be saved.@The save operation may have failed due to the temporary
locking of the records by another user. * Click OK to try again. You may need
to click OK several times (or wait until the other user closes the table). * Click
Cancel if repeated attempts to save your changes fail.@@3@@@1'

Access 2003+

2112
The item on the Clipboard can't be pasted into this control.@@@1@@1
Access 2007+ uses different description: 'The item on the Clipboard can't be
pasted into this control.@@@1@@@1'

Access 2003+

2113

The value you entered isn't valid for this field.@For example, you may have
entered text in a numeric field or a number that is larger than the FieldSize
setting permits.@@1@@1 Access 2007+ uses different description: 'The
value you entered isn't valid for this field.@For example, you may have entered
text in a numeric field or a number that is larger than the FieldSize setting
permits.@@1@@@1'

Access 2003+

2114 Microsoft Office Access doesn't support the format of the file '|,' or file is too
large. Try converting the file to BMP or GIF format.@@@1@@1 Access
2007+ uses different description: 'Microsoft Office Access doesn't support the
format of the file '|,' or file is too large. Try converting the file to BMP
format.@@@1@@@1' Access 2010+ uses different description: 'Microsoft

Access 2003+



Access doesn't support the format of the file '|1,' or file is too large. Try
converting the file to BMP format.@@@1@@@1'

2115

The macro or function set to the BeforeUpdate or ValidationRule property for
this field is preventing Microsoft Office Access from saving the data in the
field.@* If this is a macro, open the macro in the Macro window and remove
the action that forces a save (for example, GoToControl). * If the macro
includes a SetValue action, set the macro to the AfterUpdate property of the
control instead. * If this is a function, redefine the function in the Module
window.@@1@@1 Access 2007+ uses different description: 'The macro or
function set to the BeforeUpdate or ValidationRule property for this field is
preventing Microsoft Office Access from saving the data in the field.@* If this
is a macro, open the macro in the Macro window and remove the action that
forces a save (for example, GoToControl). * If the macro includes a SetValue
action, set the macro to the AfterUpdate property of the control instead. * If this
is a function, redefine the function in the Module window.@@1@@@1'
Access 2010+ uses different description: 'The macro or function set to the
BeforeUpdate or ValidationRule property for this field is preventing Microsoft
Access from saving the data in the field.@* If this is a macro, open the macro
in the Macro window and remove the action that forces a save (for example,
GoToControl). * If the macro includes a SetValue action, set the macro to the
AfterUpdate property of the control instead. * If this is a function, redefine the
function in the Module window.@@1@@@1'

Access 2003+

2116

The value in the field or record violates the validation rule for the record or
field.@For example, you may have changed a validation rule without verifying
whether the existing data matches the new validation rule.@Click Undo on the
Edit menu to restore the previous value, or enter a new value that meets the
validation rule for the field.@2@209121@1 Access 2007+ uses different
description: 'The value violates the validation rule for the field or record.@For
example, you might have changed a validation rule without verifying whether
the existing data matches the new validation rule.@Click Undo to restore the
previous value, or enter a new value that meets the validation rule for the field
or record.@2@1@9121@1'

Access 2003+

2117

Microsoft Office Access has canceled the Paste operation.@The text on the
Clipboard is too long to paste into the form. For example, you may have pasted
too much text into a label or entered too much text in the ColumnWidths
property.@Paste smaller sections. For labels, you must paste fewer than 2,048
characters.@1@@1 Access 2007+ uses different description: 'Microsoft
Office Access has canceled the Paste operation.@The text on the Clipboard is
too long to paste into the form. For example, you may have pasted too much
text into a label or entered too much text in the ColumnWidths property.@Paste
smaller sections. For labels, you must paste fewer than 2,048
characters.@1@@@1' Access 2010+ uses different description: 'Microsoft
Access has canceled the Paste operation.@The text on the Clipboard is too long
to paste into the form. For example, you may have pasted too much text into a
label or entered too much text in the ColumnWidths property.@Paste smaller
sections. For labels, you must paste fewer than 2,048 characters.@1@@@1'

Access 2003+

2118

You must save the current field before you run the Requery action.@* If you
are running a macro from the Database window, save the field first, and then
run the macro. * If the macro name is the setting of the BeforeUpdate property
in a Visual Basic function, set the AfterUpdate property to the name of the
macro instead.@@1@603033@1 Access 2007+ uses different description:
'You must save the current field before you run the Requery action.@* If you
are running a macro from the Navigation Pane, save the field first, and then run
the macro. * If the macro name is the setting of the BeforeUpdate property in a
Visual Basic function, set the AfterUpdate property to the name of the macro
instead.@@1@1@3033@1'

Access 2003+



2119

The Requery action can't be used on the control '|.'@Certain controls, such as
labels and rectangles, can't receive the focus; therefore, you can't apply a
Requery action to them.@@1@603033@1 Access 2007+ uses different
description: 'The Requery action can't be used on the control '|.'@Certain
controls, such as labels and rectangles, can't receive the focus; therefore, you
can't apply a Requery action to them.@@1@1@3033@1'

Access 2003+

2120

To create a form, report or data access page using this wizard, you must first
select the table or query on which the form, report or data access page will be
based.@@@1@@1 Access 2007+ uses different description: 'To create a
form, report or data access page using this wizard, you must first select the
table or query on which the form, report or data access page will be
based.@@@1@@@1'

Access 2003+

2121

Microsoft Office Access can't open the form '|.'@It contains data that Microsoft
Office Access doesn't recognize. Re-create the form or, if you maintain backup
copies of your database, retrieve a copy of the form.@@1@@1 Access 2007+
uses different description: 'Microsoft Office Access can't open the form '|.'@It
contains data that Microsoft Office Access doesn't recognize. Re-create the
form or, if you maintain backup copies of your database, retrieve a copy of the
form.@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access can't open the form '|1.'@It contains data that Microsoft Access doesn't
recognize. Re-create the form or, if you maintain backup copies of your
database, retrieve a copy of the form.@@1@@@1'

Access 2003+

2122

You can't view a form as a continuous form if it contains a subform, an ActiveX
control, or a bound chart.@Set the DefaultView property of the form to Single
Form, Datasheet, PivotTable, or PivotChart.@@1@@1 Access 2007+ uses
different description: 'You can't view a form as a continuous form if it
contains a subform, an ActiveX control, or a bound chart.@Set the DefaultView
property of the form to Single Form, Datasheet, PivotTable, or
PivotChart.@@1@@@1' Access 2010+ uses different description: 'You can't
view a form as a continuous form if it contains a subform, an ActiveX control, a
bound chart or a Web browser control.@Set the DefaultView property of the
form to Single Form, Datasheet, PivotTable, or PivotChart.@@1@@@1'

Access 2003+

2123

The control name you entered doesn't follow Microsoft Office Access object-
naming rules.@@@2@611734@1 Access 2007+ uses different description:
'The control name you entered doesn't follow Microsoft Office Access object-
naming rules.@@@2@1@11734@1' Access 2010+ uses different
description: 'The control name you entered doesn't follow Microsoft Access
object-naming rules.@@@2@1@11734@1'

Access 2003+

2124

The form name you entered doesn't follow Microsoft Office Access object-
naming rules.@@@2@611734@1 Access 2007+ uses different description:
'The form name you entered doesn't follow Microsoft Office Access object-
naming rules.@@@2@1@11734@1' Access 2010+ uses different
description: 'The form name you entered doesn't follow Microsoft Access
object-naming rules.@@@2@1@11734@1'

Access 2003+

Error Code Error Description Supported Versions

2125

The setting for the FontSize property must be from 1 through
127.@@@1@612551@1 Access 2007+ uses different description: 'The
setting for the FontSize property must be from 1 through
127.@@@1@1@12551@1'

Access 2003+

2126

The setting for the ColumnCount property must be from 1 through
255.@@@1@600936@1 Access 2007+ uses different description: 'The
setting for the ColumnCount property must be from 1 through
255.@@@1@1@936@1'

Access 2003+

2127 The setting for the BoundColumn property can't be greater than the setting for
the ColumnCount property.@@@1@600839@1 Access 2007+ uses different

Access 2003+



description: 'The setting for the BoundColumn property can't be greater than
the setting for the ColumnCount property.@@@1@1@839@1'

2128

Microsoft Office Access encountered errors while importing |1.@For more
detailed error information, see the file '|2'.@@1@@1 Access 2007+ uses
different description: 'Microsoft Office Access encountered errors while
importing |1.@For more detailed error information, see the file
'|2'.@@1@@@1' Access 2010+ uses different description: 'Microsoft Access
encountered errors while importing |1.@For more detailed error information,
see the file '|2'.@@1@@@1'

Access 2003+

2129

The setting for the DefaultEditing property must be Allow Edits, Read Only,
Data Entry, or Can't Add Records.@Enter 1, 2, 3, or 4 for the DefaultEditing
property.@@1@@1 Access 2007+ uses different description: 'The setting for
the DefaultEditing property must be Allow Edits, Read Only, Data Entry, or
Can't Add Records.@Enter 1, 2, 3, or 4 for the DefaultEditing
property.@@1@@@1'

Access 2003+

2130
The settings for the GridX and GridY properties must be from 1 through
64.@@@1@@1 Access 2007+ uses different description: 'The settings for
the GridX and GridY properties must be from 1 through 64.@@@1@@@1'

Access 2003+

2131
An expression can't be longer than 2,048 characters.@@@1@@1 Access
2007+ uses different description: 'An expression can't be longer than 2,048
characters.@@@1@@@1'

Access 2003+

2132

The setting for the DecimalPlaces property must be from 0 through 15, or 255
for Auto (default).@@@1@@1 Access 2007+ uses different description:
'The setting for the DecimalPlaces property must be from 0 through 15, or 255
for Auto (default).@@@1@@@1'

Access 2003+

2133

You can't place a form (or report) within itself.@Select or enter a different form
or report to serve as the subform or subreport.@@1@@1 Access 2007+ uses
different description: 'You can't place a form (or report) within itself.@Select
or enter a different form or report to serve as the subform or
subreport.@@1@@@1'

Access 2003+

2134

The setting for the Width property must be from 0 through 22 inches (55.87
cm).@@@1@@1 Access 2007+ uses different description: 'The setting for
the Width property must be from 0 through 22 inches (55.87
cm).@@@1@@@1'

Access 2003+

2135
This property is read-only and can't be set.@@@1@@1 Access 2007+ uses
different description: 'This property is read-only and can't be
set.@@@1@@@1'

Access 2003+

2136

To set this property, open the form or report in Design view.@For more
information on this property, search the Help index for the name of the
property.@@1@@1 Access 2007+ uses different description: 'To set this
property, open the form or report in Design view.@For more information on
this property, search the Help index for the name of the property.@@1@@@1'

Access 2003+

2137

You can't use Find or Replace now.@The fields are not searchable due to one of
the following: * The fields are controls (such as buttons or OLE objects). * The
fields have no data. * There are no fields to search.@@1@@1 Access 2007+
uses different description: 'You can't use Find or Replace now.@The fields are
not searchable due to one of the following: * The fields are controls (such as
buttons or OLE objects). * The fields have no data. * There are no fields to
search.@@1@@@1'

Access 2003+

2138

You can't search the field for the specified value.@Resolve the error given in
the previous error message before you attempt to search again.@@1@@1
Access 2007+ uses different description: 'You can't search the field for the
specified value.@Resolve the error given in the previous error message before
you attempt to search again.@@1@@@1'

Access 2003+

2139 You can't replace the current value of the field with the replacement
text.@Resolve any errors before making further replacements.@@1@@1

Access 2003+



Access 2007+ uses different description: 'You can't replace the current value
of the field with the replacement text.@Resolve any errors before making
further replacements.@@1@@@1'

2140

Microsoft Office Access can't save the change you made to the record in the
Replace operation for the reason given in the previous error message.@Click
Undo Current Record on the Edit menu, or enter a new value in the
field.@@1@@1 Access 2007+ uses different description: 'Microsoft Office
Access cannot save the change you made to the record in the Replace operation
for the reason shown in the previous message.@Click Undo or enter a new
value in the field.@@1@@@1' Access 2010+ uses different description:
'Microsoft Access cannot save the change you made to the record in the
Replace operation for the reason shown in the previous message.@Click Undo
or enter a new value in the field.@@1@@@1'

Access 2003+

2141

Microsoft Office Access can't find the text you specified in the Find What
box.@@@1@@1 Access 2007+ uses different description: 'Microsoft Office
Access can't find the text you specified in the Find What box.@@@1@@@1'
Access 2010+ uses different description: 'Microsoft Access can't find the text
you specified in the Find What box.@@@1@@@1'

Access 2003+

2142

The FindRecord action requires a Find What argument.@You tried to run a
macro set to one of the current field's properties, but you left the Find What
argument blank.@When you click OK, an Action Failed dialog box will display
the macro name and the macro's arguments. In the Macro window, enter text or
an expression for the Find What argument, and try the Search operation
again.@1@603015@1 Access 2007+ uses different description: 'The
FindRecord action requires a Find What argument.@You tried to run a macro
set to one of the current field's properties, but you left the Find What argument
blank.@When you click OK, an Action Failed dialog box will display the
macro name and the macro's arguments. In the Macro window, enter text or an
expression for the Find What argument, and try the Search operation
again.@1@1@3015@1'

Access 2003+

2143

You didn't specify search criteria with a FindRecord action.@In the Macro
window, insert a FindRecord action before the FindNext
action.@@1@603015@1 Access 2007+ uses different description: 'You
didn't specify search criteria with a FindRecord action.@In the Macro window,
insert a FindRecord action before the FindNext action.@@1@1@3015@1'

Access 2003+

2144

The setting for the ListRows property must be from 1 through
255.@@@1@604055@1 Access 2007+ uses different description: 'The
setting for the ListRows property must be from 1 through
255.@@@1@1@4055@1'

Access 2003+

Error Code Error Description Supported Versions

2145

The ColumnWidths property setting must be a value from 0 through 22 inches
(55.87 cm) for each column in a list box or a combo box.@If there is more than
one column, separate the numbers with either a semicolon or the list separator
character. List separator characters are defined in the Regional Settings section
of Windows Control Panel.@@1@600847@1 Access 2007+ uses different
description: 'The ColumnWidths property setting must be a value from 0
through 22 inches (55.87 cm) for each column in a list box or a combo box.@If
there is more than one column, separate the numbers with either a semicolon or
the list separator character. List separator characters are defined in the Regional
Settings section of Windows Control Panel.@@1@1@847@1'

Access 2003+

2146

Microsoft Office Access can't save the last change for the reason given in the
previous error message.@For example, you may have entered a duplicate value
in a field with an index that prohibits duplicate values.@Click Undo on the Edit
menu, or enter a new value in the field.@1@@1 Access 2007+ uses different
description: ''

Access 2003



2147
You must be in Design view to create or delete controls.@@@1@5054@1
Access 2007+ uses different description: 'You must be in Design view to
create or delete controls.@@@1@2@5054@1'

Access 2003+

2148

The number you used to refer to the form or report section is invalid.@Make
sure that the number is less than the number of sections in the form or
report.@@1@@1 Access 2007+ uses different description: 'The number you
used to refer to the form or report section is invalid.@Make sure that the
number is less than the number of sections in the form or report.@@1@@@1'

Access 2003+

2149

The constant you entered for the control type is invalid.@For a list of valid
constants you can use to create a control, click Help.@@2@610905@1 Access
2007+ uses different description: 'The constant you entered for the control
type is invalid.@For a list of valid constants you can use to create a control,
click Help.@@2@1@10905@1'

Access 2003+

2150
This type of control can't contain other controls.@@@1@@1 Access 2007+
uses different description: 'This type of control can't contain other
controls.@@@1@@@1'

Access 2003+

2151

The parent control can't contain the type of control you selected.@For example,
you used the CreateControl function to designate an option group as the parent
of a text box.@@1@@1 Access 2007+ uses different description: 'The parent
control can't contain the type of control you selected.@For example, you used
the CreateControl function to designate an option group as the parent of a text
box.@@1@@@1'

Access 2003+

2152
You can set group levels for reports only, not for forms.@@@1@@1 Access
2007+ uses different description: 'You can set group levels for reports only,
not for forms.@@@1@@@1'

Access 2003+

2153
You can't specify more than 10 group levels.@@@1@@1 Access 2007+ uses
different description: 'You can't specify more than 10 group
levels.@@@1@@@1'

Access 2003+

2154
You can't call this function when the Sorting and Grouping box is
open.@@@1@@1 Access 2007+ uses different description: 'You can't call
this function when the Group, Sort, and Total Pane is open.@@@1@@@1'

Access 2003+

2155

Microsoft Office Access has encountered an error in compiling the Visual Basic
code.@You don't have permission to edit code; inform someone who does have
permission about this error.@@1@@1 Access 2007+ uses different
description: ''

Access 2003

2156
Microsoft Office Access has encountered an error in compiling the Visual Basic
code.@Do you want to view the error in its context?@@19@@2 Access
2007+ uses different description: ''

Access 2003

2157

The sum of the top margin, the bottom margin, the height of the page header,
and the height of the page footer is greater than the length of the page you are
printing on.@@@1@@1 Access 2007+ uses different description: 'The sum
of the top margin, the bottom margin, the height of the page header, and the
height of the page footer is greater than the length of the page you are printing
on.@@@1@@@1'

Access 2003+

2158

You can use the Print method and the report graphics methods (Circle, Line,
PSet, and Scale) only in an event procedure or a macro set to the OnPrint, the
OnFormat, or the OnPage event property.@@@1@210129@1 Access 2007+
uses different description: 'You can use the Print method and the report
graphics methods (Circle, Line, PSet, and Scale) only in an event procedure or
a macro set to the OnPrint, the OnFormat, or the OnPage event
property.@@@1@1@10129@1'

Access 2003+

2159 There isn't enough memory to initialize the Print method or one of the report
graphics methods (Circle, Line, PSet, Scale).@Close unneeded programs and
try again to print or preview the report. For more information on freeing
memory, search the Microsoft Windows Help index for 'memory,

Access 2003+



troubleshooting'.@@1@@1 Access 2007+ uses different description: 'There
isn't enough memory to initialize the Print method or one of the report graphics
methods (Circle, Line, PSet, Scale).@Close unneeded programs and try again
to print or preview the report. For more information on freeing memory, search
the Microsoft Windows Help index for 'memory,
troubleshooting'.@@1@@@1'

2160

Microsoft Office Access couldn't create the graphic or text.@An error occurred
while initializing the Print method or one of the report graphics methods
(Circle, Line, PSet, Scale).@Close unneeded programs and try again to print or
preview the report. For information on freeing memory, search the Microsoft
Windows Help index for 'memory, troubleshooting'.@1@@1 Access 2007+
uses different description: 'Microsoft Office Access couldn't create the
graphic or text.@An error occurred while initializing the Print method or one of
the report graphics methods (Circle, Line, PSet, Scale).@Close unneeded
programs and try again to print or preview the report. For information on
freeing memory, search the Microsoft Windows Help index for 'memory,
troubleshooting'.@1@@@1' Access 2010+ uses different description:
'Microsoft Access couldn't create the graphic or text.@An error occurred while
initializing the Print method or one of the report graphics methods (Circle,
Line, PSet, Scale).@Close unneeded programs and try again to print or preview
the report. For information on freeing memory, search the Microsoft Windows
Help index for 'memory, troubleshooting'.@1@@@1'

Access 2003+

2161

The text or expression you entered doesn't match the type of data you are
searching for.@Redefine the text or expression, or search in a different
field.@@1@@1 Access 2007+ uses different description: 'The text or
expression you entered doesn't match the type of data you are searching
for.@Redefine the text or expression, or search in a different
field.@@1@@@1'

Access 2003+

2162

A macro set to one of the current field's properties failed because of an error in
a FindRecord action argument.@In the Macro window, change the Search As
Formatted argument to Yes. If you want the argument setting to remain No, do
all of the following: * Select No for the Match Case argument. * Select Yes for
the Only Current Field argument. * Make sure you are searching in a bound
control.@@2@603015@1 Access 2007+ uses different description: 'A macro
set to one of the current field's properties failed because of an error in a
FindRecord action argument.@In the Macro window, change the Search As
Formatted argument to Yes. If you want the argument setting to remain No, do
all of the following: * Select No for the Match Case argument. * Select Yes for
the Only Current Field argument. * Make sure you are searching in a bound
control.@@2@1@3015@1'

Access 2003+

2163

The page number you used as an argument for the GoToPage action or method
doesn't exist in this form.@@@1@603017@1 Access 2007+ uses different
description: 'The page number you used as an argument for the GoToPage
action or method doesn't exist in this form.@@@1@1@3017@1'

Access 2003+

2164
You can't disable a control while it has the focus.@@@1@5250@1 Access
2007+ uses different description: 'You can't disable a control while it has the
focus.@@@1@2@5250@1'

Access 2003+

Error Code Error Description Supported Versions

2165
You can't hide a control that has the focus.@@@1@@1 Access 2007+ uses
different description: 'You can't hide a control that has the
focus.@@@1@@@1'

Access 2003+

2166
You can't lock a control while it has unsaved changes.@@@1@@1 Access
2007+ uses different description: 'You can't lock a control while it has
unsaved changes.@@@1@@@1'

Access 2003+

2167 This property is read-only and can't be modified.@@@1@@1 Access 2007+
uses different description: 'This property is read-only and can't be

Access 2003+



modified.@@@1@@@1'

2169

You can't save this record at this time.@Microsoft Office Access may have
encountered an error while trying to save a record. If you close this object now,
the data changes you made will be lost. Do you want to close the database
object anyway?@@20@@2 Access 2007+ uses different description: 'You
can't save this record at this time.@Microsoft Office Access may have
encountered an error while trying to save a record. If you close this object now,
the data changes you made will be lost. Do you want to close the database
object anyway?@@20@@@2' Access 2010+ uses different description: 'You
can't save this record at this time.@Microsoft Access may have encountered an
error while trying to save a record. If you close this object now, the data
changes you made will be lost. Do you want to close the database object
anyway?@@20@@@2'

Access 2003+

2170

There isn't enough memory to retrieve data for the list box.@Close unneeded
programs. Then close and reopen the active form, and click the list box again.
For more information on freeing memory, search the Microsoft Windows Help
index for 'memory, troubleshooting'.@@1@@1 Access 2007+ uses different
description: 'There isn't enough memory to retrieve data for the list
box.@Close unneeded programs. Then close and reopen the active form, and
click the list box again. For more information on freeing memory, search the
Microsoft Windows Help index for 'memory, troubleshooting'.@@1@@@1'

Access 2003+

2171

You can't have more than seven nested subforms in a main form.@Remove the
eigth nested subform.@@1@@1 Access 2007+ uses different description:
'You can't have more than seven nested subforms in a main form.@Remove the
eigth nested subform.@@1@@@1'

Access 2003+

2172

You can't use a pass-through query or a non-fixed-column crosstab query as a
record source for a subform or subreport.@Before you bind the subform or
subreport to a crosstab query, set the query's ColumnHeadings
property.@@2@209979@1 Access 2007+ uses different description: 'You
can't use a pass-through query or a non-fixed-column crosstab query as a record
source for a subform or subreport.@Before you bind the subform or subreport
to a crosstab query, set the query's ColumnHeadings
property.@@2@1@9979@1'

Access 2003+

2173

The control '|' the macro is attempting to search can't be searched.@Try one of
the following: * Add a GoToControl action before the FindRecord action. * For
the FindRecord action, change the Only Current Field action argument from
Yes to No. * Change the focus to a searchable control.@@2@603015@1
Access 2007+ uses different description: 'The control '|' the macro is
attempting to search can't be searched.@Try one of the following: * Add a
GoToControl action before the FindRecord action. * For the FindRecord action,
change the Only Current Field action argument from Yes to No. * Change the
focus to a searchable control.@@2@1@3015@1'

Access 2003+

2174

You can't switch to a different view at this time.@Code was executing when
you tried to switch views.@If you are debugging code, you must end the
debugging operation before switching views.@1@@1 Access 2007+ uses
different description: 'You can't switch to a different view at this time.@Code
was executing when you tried to switch views.@If you are debugging code,
you must end the debugging operation before switching views.@1@@@1'

Access 2003+

2175

There isn't enough free memory to continue the Search operation.@Close
unneeded programs. Then try the Search operation again. For more information
on freeing memory, search the Microsoft Windows Help index for 'memory,
troubleshooting'.@@1@@3 Access 2007+ uses different description: 'There
isn't enough free memory to continue the Search operation.@Close unneeded
programs. Then try the Search operation again. For more information on
freeing memory, search the Microsoft Windows Help index for 'memory,
troubleshooting'.@@1@@@3'

Access 2003+



2176

The setting for this property is too long.@You can enter up to either 255 or
2,048 characters for this property, depending on the data type.@@1@@1
Access 2007+ uses different description: 'The setting for this property is too
long.@You can enter up to either 255 or 2,048 characters for this property,
depending on the data type.@@1@@@1'

Access 2003+

2177
You can't insert a report into a form.@A report can be inserted only into a
report.@@1@@1 Access 2007+ uses different description: 'You can't insert a
report into a form.@A report can be inserted only into a report.@@1@@@1'

Access 2003+

2178

You can't add another section now.@The maximum total height for all sections
in a report, including the section headers, is 200 inches (508 cm).@Remove or
reduce the height of at least one section, and then add the new section.@1@@1
Access 2007+ uses different description: 'You can't add another section
now.@The maximum total height for all sections in a report, including the
section headers, is 200 inches (508 cm).@Remove or reduce the height of at
least one section, and then add the new section.@1@@@1'

Access 2003+

2181

You can't sort on a calculated field in a form.@You can sort on a calculated
field only in a query.@Create a calculated field in a query, sort the field, and
then base the form on the query. Because the query must execute before the
form opens, the form will open more slowly.@1@@1 Access 2007+ uses
different description: 'You can't sort on a calculated field in a form.@You can
sort on a calculated field only in a query.@Create a calculated field in a query,
sort the field, and then base the form on the query. Because the query must
execute before the form opens, the form will open more slowly.@1@@@1'

Access 2003+

2182 You can't sort on this field.@@@1@@1 Access 2007+ uses different
description: 'You can't sort on this field.@@@1@@@1' Access 2003+

2183

Microsoft Office Access can't create an object of the type requested.@You are
trying either to create a form from a report that has been saved as text, or to
create a report from a saved form.@@1@@1 Access 2007+ uses different
description: 'Microsoft Office Access can't create an object of the type
requested.@You are trying either to create a form from a report that has been
saved as text, or to create a report from a saved form.@@1@@@1' Access
2010+ uses different description: 'Microsoft Access can't create an object of
the type requested.@You are trying either to create a form from a report that
has been saved as text, or to create a report from a saved form.@@1@@@1'

Access 2003+

2184

The value you used for the TabIndex property isn't valid. The correct values are
from 0 through |.@@@2@606348@1 Access 2007+ uses different
description: 'The value you used for the TabIndex property isn't valid. The
correct values are from 0 through |.@@@2@1@6348@1'

Access 2003+

2185

You can't reference a property or method for a control unless the control has the
focus.@Try one of the following: * Move the focus to the control before you
reference the property. In Visual Basic code, use the SetFocus method. In a
macro, use the GoToControl action. * Reference or set the property from a
macro or event procedure that runs when the GotFocus event for the control
occurs.@@2@606215@1 Access 2007+ uses different description: 'You can't
reference a property or method for a control unless the control has the
focus.@Try one of the following: * Move the focus to the control before you
reference the property. In Visual Basic code, use the SetFocus method. In a
macro, use the GoToControl action. * Reference or set the property from a
macro or event procedure that runs when the GotFocus event for the control
occurs.@@2@1@6215@1'

Access 2003+

2186

This property isn't available in Design view.@Switch to Form view to access
this property, or remove the reference to the property.@@1@@1 Access 2007+
uses different description: 'This property isn't available in Design
view.@Switch to Form view to access this property, or remove the reference to
the property.@@1@@@1'

Access 2003+



2187
This property is available only in Design view.@@@1@@1 Access 2007+
uses different description: 'This property is available only in Design
view.@@@1@@@1'

Access 2003+

Error Code Error Description Supported Versions

2188

The object you attempted to load from text has an invalid value for the property
'|1' on a |2.@@@1@@1 Access 2007+ uses different description: 'The object
you attempted to load from text has an invalid value for the property '|1' on a
|2.@@@1@@@1'

Access 2003+

2189

Your code contains a syntax error, or a Microsoft Office Access function you
need isn't available.@If the syntax is correct, check the Control Wizards subkey
or the Libraries key in the Microsoft Office Access section of the Windows
Registry to verify that the entries you need are listed and available.@If the
entries are correct, you need to correct the Microsoft Office Access Utility Add-
in or the file acWzlib or this wizard has been disabled. To reenable this wizard,
click About Microsoft Office Access on the Help menu, and then click the
Disabled Items button to view a list of addins which you can enable. Rerun
Microsoft Office Access or Microsoft Office Setup to reinstall Microsoft Office
Access. Before you reinstall, delete the Windows Registry keys for the
Microsoft Office Access Utility Add-in and acWzlib.@1@@1 Access 2007+
uses different description: 'The code contains a syntax error, or a Microsoft
Office Access function you need is not available.@If the syntax is correct,
check the Control Wizards subkey or the Libraries key in the Microsoft Office
Access section of the Windows Registry to verify that the entries you need are
listed and available.@If the entries are correct, either you must correct the
Microsoft Office Access Utility Add-in, or the file acWzlib or this wizard has
been disabled. To reenable this wizard, run Microsoft Office Access or
Microsoft Office Setup again to reinstall Microsoft Office Access. Before you
reinstall Microsoft Office Access, delete the Windows Registry keys for the
Microsoft Office Access Utility Add-in and acWzlib.@1@@@1' Access 2010+
uses different description: 'The code contains a syntax error, or a Microsoft
Access function you need is not available.@If the syntax is correct, check the
Control Wizards subkey or the Libraries key in the Microsoft Access section of
the Windows Registry to verify that the entries you need are listed and
available.@If the entries are correct, either you must correct the Microsoft
Access Utility Add-in, or the file acWzlib or this wizard has been disabled. To
reenable this wizard, run Microsoft Access or Microsoft Office Setup again to
reinstall Microsoft Access. Before you reinstall Microsoft Access, delete the
Windows Registry keys for the Microsoft Access Utility Add-in and
acWzlib.@1@@@1'

Access 2003+

2190

This property has been replaced by a new property; use the new property
instead.@@@1@@1 Access 2007+ uses different description: 'This property
has been replaced by a new property; use the new property
instead.@@@1@@@1'

Access 2003+

2191

You can't set the | property in print preview or after printing has started.@Try
setting this property in the OnOpen event.@@1@@1 Access 2007+ uses
different description: 'You can't set the | property in print preview or after
printing has started.@Try setting this property in the OnOpen
event.@@1@@@1'

Access 2003+

2192

The bitmap you specified is not in a device-independent bitmap (.dib)
format.@You tried to set the PictureData property of a form, report, button, or
image control.@@1@@1 Access 2007+ uses different description: 'The
bitmap you specified is not in a device-independent bitmap (.dib) format.@You
tried to set the PictureData property of a form, report, button, or image
control.@@1@@@1'

Access 2003+

2193 The left margin, right margin, or both margins are wider than the paper size
specified in the Print Setup dialog box.@@@1@@1 Access 2007+ uses

Access 2003+



different description: 'The left margin, right margin, or both margins are wider
than the paper size specified in the Print Setup dialog box.@@@1@@@1'

2194

You can't set the PictureData property in Datasheet view.@To see the valid
settings for this property, search the Help index for 'PictureData
property'.@@1@@1 Access 2007+ uses different description: 'You can't set
the PictureData property in Datasheet view.@To see the valid settings for this
property, search the Help index for 'PictureData property'.@@1@@@1'

Access 2003+

2195

The section name you entered doesn't follow Microsoft Office Access object-
naming rules.@@@2@611734@1 Access 2007+ uses different description:
'The section name you entered doesn't follow Microsoft Office Access object-
naming rules.@@@2@1@11734@1' Access 2010+ uses different
description: 'The section name you entered doesn't follow Microsoft Access
object-naming rules.@@@2@1@11734@1'

Access 2003+

2196

Microsoft Office Access can't retrieve the value of this property.@The property
isn't available from the view in which you're running the macro or Visual Basic
code, or Microsoft Office Access encountered an error while retrieving the
value of the property. To see the valid settings for this property, search the Help
index for the name of the property.@@1@@1 Access 2007+ uses different
description: 'Microsoft Office Access can't retrieve the value of this
property.@The property isn't available from the view in which you're running
the macro or Visual Basic code, or Microsoft Office Access encountered an
error while retrieving the value of the property. To see the valid settings for this
property, search the Help index for the name of the property.@@1@@@1'
Access 2010+ uses different description: 'Microsoft Access can't retrieve the
value of this property.@The property isn't available from the view in which
you're running the macro or Visual Basic code, or Microsoft Access
encountered an error while retrieving the value of the property. To see the valid
settings for this property, search the Help index for the name of the
property.@@1@@@1'

Access 2003+

2197

You can't set a subform control's SourceObject property to a zero-length string
if you're displaying the main form in Form view.@You can set this property to
a zero-length string from Design view, Datasheet view, or Print
Preview.@@1@@1 Access 2007+ uses different description: 'You can't set a
subform control's SourceObject property to a zero-length string if you're
displaying the main form in Form view.@You can set this property to a zero-
length string from Design view, Datasheet view, or Print Preview.@@1@@@1'

Access 2003+

2200 The number you entered is invalid.@@@1@@1 Access 2007+ uses different
description: 'The number you entered is invalid.@@@1@@@1' Access 2003+

2201

There was a problem retrieving printer information for the |1 on |2. The object
may have been sent to a printer that is unavailable.@@@@@ Access 2007+
uses different description: 'There was a problem retrieving printer information
for the |1 on |2. The object may have been sent to a printer that is
unavailable.@@@@@@'

Access 2003+

2202

You must install a printer before you print.@To install a printer, point to
Settings on the Windows Start menu, click Printers, and then double-click Add
Printer. Follow the instructions in the wizard.@@1@@1 Access 2007+ uses
different description: 'There are currently no printers installed on your
computer.To use this feature, you must first install a printer in Windows.@For
more information about how to install a printer, search for ""install printer"" in
Windows Help.@@1@@@1'

Access 2003+

2203 The dynamic-link library Commdlg failed: error code '0x|'.@The printer driver
for the selected printer may be incorrectly installed. For information on
selecting another printer or reinstalling this printer from Microsoft Windows,
search the Windows Help index for 'printer setup'.@@1@@1 Access 2007+
uses different description: 'The dynamic-link library Commdlg failed: error
code '0x|'.@The printer driver for the selected printer may be incorrectly

Access 2003+



installed. For information on selecting another printer or reinstalling this printer
from Microsoft Windows, search the Windows Help index for 'printer
setup'.@@1@@@1'

2204

The default printer driver isn't set up correctly.@For information on setting a
default printer, search the Microsoft Windows Help index for 'default printer,
setting'.@@1@@1 Access 2007+ uses different description: 'The default
printer driver isn't set up correctly.@For information on setting a default
printer, search the Microsoft Windows Help index for 'default printer,
setting'.@@1@@@1'

Access 2003+

2205

The default printer driver isn't set up correctly.@For information on setting a
default printer, search the Microsoft Windows Help index for 'default printer,
setting'.@@1@@1 Access 2007+ uses different description: 'The default
printer driver isn't set up correctly.@For information on setting a default
printer, search the Microsoft Windows Help index for 'default printer,
setting'.@@1@@@1'

Access 2003+

2206

The page number you entered is invalid.@For example, it may be a negative
number or an invalid range, such as 6 to 3.@@1@@1 Access 2007+ uses
different description: 'The page number you entered is invalid.@For example,
it may be a negative number or an invalid range, such as 6 to 3.@@1@@@1'

Access 2003+

2207

Microsoft Office Access can't print macros.@You tried to use the PrintOut
action or method, but the active object is a macro.@If you want to print an
object other than a macro, use the SelectObject action or method to select the
desired object before you run the PrintOut action.@1@603041@1 Access
2007+ uses different description: 'Microsoft Office Access can't print
macros.@You tried to use the PrintOut action or method, but the active object
is a macro.@If you want to print an object other than a macro, use the
SelectObject action or method to select the desired object before you run the
PrintOut action.@1@1@3041@1' Access 2010+ uses different description:
'Microsoft Access can't print macros.@You tried to use the PrintOut action or
method, but the active object is a macro.@If you want to print an object other
than a macro, use the SelectObject action or method to select the desired object
before you run the PrintOut action.@1@1@3041@1'

Access 2003+

2210

Microsoft Office Access can't print or preview the page because the page size
you selected is larger than 22.75 inches.@@@1@@1 Access 2007+ uses
different description: 'Microsoft Office Access can't print or preview the page
because the page size you selected is larger than 22.75 inches.@@@1@@@1'
Access 2010+ uses different description: 'Microsoft Access can't print or
preview the page because the page size you selected is larger than 22.75
inches.@@@1@@@1'

Access 2003+

2211

Microsoft Office Access can't print or preview the Debug
window.@@@1@@1 Access 2007+ uses different description: 'Microsoft
Office Access can't print or preview the Debug window.@@@1@@@1'
Access 2010+ uses different description: 'Microsoft Access can't print or
preview the Debug window.@@@1@@@1'

Access 2003+

Error Code Error Description Supported Versions

2212

Microsoft Office Access couldn't print your object.@Make sure that the
specified printer is available. For information on setting a default printer, search
the Windows Help index for 'default printer, setting'.@@1@@1 Access 2007+
uses different description: 'Microsoft Office Access couldn't print your
object.@Make sure that the specified printer is available. For information on
setting a default printer, search the Windows Help index for 'default printer,
setting'.@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access couldn't print your object.@Make sure that the specified printer is
available. For information on setting a default printer, search the Windows Help
index for 'default printer, setting'.@@1@@@1'

Access 2003+



2213

There was a problem retrieving printer information for this object. The object
may have been sent to a printer that is unavailable.@@@1@@1 Access 2007+
uses different description: 'There was a problem retrieving printer information
for this object. The object may have been sent to a printer that is
unavailable.@@@1@@@1'

Access 2003+

2214

There was a problem retrieving information from the printer. New printer has
not been set.@@@1@@1 Access 2007+ uses different description: 'There
was a problem retrieving information from the printer. New printer has not been
set.@@@1@@@1'

Access 2003+

2215

Microsoft Office Access cannot print this PivotTable because its |1 exceed(s)
22.75 inches.@Reduce the |1 by making changes to the formatting or included
data of the PivotTable view, and then try to print again.@@1@@1 Access
2007+ uses different description: 'Microsoft Office Access cannot print this
PivotTable because its |1 exceed(s) 22.75 inches.@Reduce the |1 by making
changes to the formatting or included data of the PivotTable view, and then try
to print again.@@1@@@1' Access 2010+ uses different description:
'Microsoft Access cannot print this PivotTable because its |1 exceed(s) 22.75
inches.@Reduce the |1 by making changes to the formatting or included data of
the PivotTable view, and then try to print again.@@1@@@1'

Access 2003+

2220

Microsoft Office Access can't open the file '|'.@@@1@@1 Access 2007+ uses
different description: 'Microsoft Office Access can't open the file
'|'.@@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access can't open the file '|1'.@@@1@@@1'

Access 2003+

2221 The text is too long to be edited.@@@1@@1 Access 2007+ uses different
description: 'The text is too long to be edited.@@@1@@@1' Access 2003+

2222
This control is read-only and can't be modified.@@@1@@1 Access 2007+
uses different description: 'This control is read-only and can't be
modified.@@@1@@@1'

Access 2003+

2223
The file name '|' is too long.@Enter a file name that's 256 characters or
less.@@1@@1 Access 2007+ uses different description: 'The file name '|' is
too long.@Enter a file name that's 256 characters or less.@@1@@@1'

Access 2003+

2225

Microsoft Office Access couldn't open the Clipboard.@The Clipboard isn't
responding, probably because another application is using it. Close all other
applications and try the operation again.@@1@@1 Access 2007+ uses
different description: 'Microsoft Office Access couldn't open the
Clipboard.@The Clipboard isn't responding, probably because another
application is using it. Close all other applications and try the operation
again.@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access couldn't open the Clipboard.@The Clipboard isn't responding, probably
because another application is using it. Close all other applications and try the
operation again.@@1@@@1'

Access 2003+

2226

The Clipboard isn't responding, so Microsoft Office Access can't paste the
Clipboard's contents.@* Another application may be using the Clipboard. *
There may not be enough free memory for the paste operation. Close all other
applications, and then copy and paste again.@@1@@1 Access 2007+ uses
different description: 'The Clipboard isn't responding, so Microsoft Office
Access can't paste the Clipboard's contents.@* Another application may be
using the Clipboard. * There may not be enough free memory for the paste
operation. Close all other applications, and then copy and paste
again.@@1@@@1' Access 2010+ uses different description: 'The Clipboard
isn't responding, so Microsoft Access can't paste the Clipboard's contents.@*
Another application may be using the Clipboard. * There may not be enough
free memory for the paste operation. Close all other applications, and then copy
and paste again.@@1@@@1'

Access 2003+

2227 The data on the Clipboard is damaged, so Microsoft Office Access can't paste
it.@There may be an error in the Clipboard, or there may not be enough free

Access 2003+



memory. Try the operation again.@@1@@1 Access 2007+ uses different
description: 'The data on the Clipboard is damaged, so Microsoft Office
Access can't paste it.@There may be an error in the Clipboard, or there may not
be enough free memory. Try the operation again.@@1@@@1' Access 2010+
uses different description: 'The data on the Clipboard is damaged, so
Microsoft Access can't paste it.@There may be an error in the Clipboard, or
there may not be enough free memory. Try the operation again.@@1@@@1'

2229

Microsoft Office Access can't start the OLE server.@You tried to use a form,
report, or datasheet that contains an OLE object, but the OLE server (the
application used to create the object) may not be registered properly. Reinstall
the OLE server to register it correctly.@@1@@1 Access 2007+ uses different
description: 'Microsoft Office Access can't start the OLE server.@You tried to
use a form, report, or datasheet that contains an OLE object, but the OLE server
(the application used to create the object) may not be registered properly.
Reinstall the OLE server to register it correctly.@@1@@@1' Access 2010+
uses different description: 'Microsoft Access can't start the OLE server.@You
tried to use a form, report, or datasheet that contains an OLE object, but the
OLE server (the application used to create the object) may not be registered
properly. Reinstall the OLE server to register it correctly.@@1@@@1'

Access 2003+

2234

Microsoft Office Access can't paste the OLE object.@@@1@@1 Access
2007+ uses different description: 'Microsoft Office Access can't paste the
OLE object.@@@1@@@1' Access 2010+ uses different description:
'Microsoft Access can't paste the OLE object.@@@1@@@1'

Access 2003+

2237

The text you entered isn't an item in the list.@Select an item from the list, or
enter text that matches one of the listed items.@@1@@1 Access 2007+ uses
different description: 'The text you entered isn't an item in the list.@Select an
item from the list, or enter text that matches one of the listed
items.@@1@@@1'

Access 2003+

2239

The database '|' needs to be repaired or isn't a Microsoft Office Access database
file.@You may have quit Microsoft Office Access unexpectedly with the
database open.@To repair the database, click the Repair Database command on
the Tools menu (Database Utilities submenu). If the database can't be repaired,
the .mdb file is unusable. Restore the database from a backup copy or create a
new database.@1@@1 Access 2007+ uses different description: 'Microsoft
Office Access has detected that this database is in an inconsistent state, and
cannot attempt to recover the database because the file is read-only. To allow
Access to recover the database, close the database and set the file to read/write,
and then open the database.@@@1@@@1' Access 2010+ uses different
description: 'Microsoft Access has detected that this database is in an
inconsistent state, and cannot attempt to recover the database because the file is
read-only. To allow Access to recover the database, close the database and set
the file to read/write, and then open the database.@@@1@@@1'

Access 2003+

2243

The data in the Clipboard isn't recognizable; Microsoft Office Access can't
paste the OLE object.@@@1@@1 Access 2007+ uses different description:
'The data in the Clipboard isn't recognizable; Microsoft Office Access can't
paste the OLE object.@@@1@@@1' Access 2010+ uses different
description: 'The data in the Clipboard isn't recognizable; Microsoft Access
can't paste the OLE object.@@@1@@@1'

Access 2003+

2244

The file name you specified in the Picture property for a command button or
toggle button can't be read.@* The file you specified may be corrupted. Restore
the file from a backup copy or re-create the file. * The disk where the file is
located may be unreadable.@@1@@1 Access 2007+ uses different
description: 'The file name you specified in the Picture property for a
command button or toggle button can't be read.@* The file you specified may
be corrupted. Restore the file from a backup copy or re-create the file. * The
disk where the file is located may be unreadable.@@1@@@1'

Access 2003+



2245

The file you specified doesn't contain valid icon data.@Specify a valid icon
file.@@1@600829@1 Access 2007+ uses different description: 'The file you
specified doesn't contain valid icon data.@Specify a valid icon
file.@@1@1@829@1'

Access 2003+

2246

Microsoft Office Access can't run the query; the parameter values are too
large.@The total length of all the values entered for the parameters cannot
exceed 1,024 characters.@@1@@1 Access 2007+ uses different description:
''

Access 2003

2260

An error occurred while sending data to the OLE server (the application used to
create the object).@* You may have tried to send too much data. If you're
creating a chart and the chart is based on a query, modify the query so that it
selects less data. If the chart is based on a table, consider basing it on a query
instead so that you can limit the data. * You may be using an OLE server that
doesn't accept the Clipboard format. * You may not be able to start the OLE
server because it's not properly registered. Reinstall it to register it. * Your
computer may be low on memory. Close other application windows to free up
memory.@@1@208951@1 Access 2007+ uses different description: 'An
error occurred while sending data to the OLE server (the application used to
create the object).@* You may have tried to send too much data. If you're
creating a chart and the chart is based on a query, modify the query so that it
selects less data. If the chart is based on a table, consider basing it on a query
instead so that you can limit the data. * You may be using an OLE server that
doesn't accept the Clipboard format. * You may not be able to start the OLE
server because it's not properly registered. Reinstall it to register it. * Your
computer may be low on memory. Close other application windows to free up
memory.@@1@1@8951@1'

Access 2003+

Error Code Error Description Supported Versions

2262 This value must be a number.@@@1@@1 Access 2007+ uses different
description: 'This value must be a number.@@@1@@@1' Access 2003+

2263 The number is too large.@@@1@@1 Access 2007+ uses different
description: 'The number is too large.@@@1@@@1' Access 2003+

2264

Microsoft Office Access didn't recognize the unit of measurement.@Type a
valid unit, such as inches (in) or centimeters (cm).@@1@@1 Access 2007+
uses different description: 'Microsoft Office Access didn't recognize the unit
of measurement.@Type a valid unit, such as inches (in) or centimeters
(cm).@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access didn't recognize the unit of measurement.@Type a valid unit, such as
inches (in) or centimeters (cm).@@1@@@1'

Access 2003+

2265

You must specify a unit of measurement, such as inches (in) or centimeters
(cm).@@@1@@1 Access 2007+ uses different description: 'You must
specify a unit of measurement, such as inches (in) or centimeters
(cm).@@@1@@@1'

Access 2003+

2266

'|' may not be a valid setting for the RowSourceType property, or there was a
compile error in the function.@For information on valid settings for the
RowSourceType property, click Help.@@2@603853@1 Access 2007+ uses
different description: ''|' may not be a valid setting for the RowSourceType
property, or there was a compile error in the function.@For information on
valid settings for the RowSourceType property, click Help.@@2@1@3853@1'

Access 2003+

2267

There is not enough disk space to create a temporary buffer file for
printing.@Free up some disk space to make room for the temporary buffer
file.@@1@@1 Access 2007+ uses different description: 'There is not enough
disk space to create a temporary buffer file for printing.@Free up some disk
space to make room for the temporary buffer file.@@1@@@1'

Access 2003+

2269 Some library databases couldn't be loaded because too many were
specified.@To change library database references, click References on the
Tools menu.@@1@209017@1 Access 2007+ uses different description:

Access 2003+



'Some library databases couldn't be loaded because too many were
specified.@To change library database references, click References on the
Tools menu.@@1@1@9017@1'

2272

The setting for the Update Retry Interval must be from 0 through 1,000
milliseconds.@@@1@@1 Access 2007+ uses different description: 'The
setting for the Update Retry Interval must be from 0 through 1,000
milliseconds.@@@1@@@1'

Access 2003+

2273
The setting for Update Retries must be from 0 through 10.@@@1@@1 Access
2007+ uses different description: 'The setting for Update Retries must be from
0 through 10.@@@1@@@1'

Access 2003+

2274
The database '|' is already open as a library database.@@@1@@1 Access
2007+ uses different description: 'The database '|' is already open as a library
database.@@@1@@@1'

Access 2003+

2275

The string returned by the builder was too long.@The result will be
truncated.@@1@@1 Access 2007+ uses different description: 'The string
returned by the builder was too long.@The result will be
truncated.@@1@@@1'

Access 2003+

2276

The custom builder you're using caused an error by changing the focus to a
different window while you were using it.@Enter a value without using the
custom builder.@@1@@1 Access 2007+ uses different description: 'The
custom builder you're using caused an error by changing the focus to a different
window while you were using it.@Enter a value without using the custom
builder.@@1@@@1'

Access 2003+

2277 There was a font initialization error.@@@1@@1 Access 2007+ uses different
description: 'There was a font initialization error.@@@1@@@1' Access 2003+

2278

Microsoft Office Access can't save your changes to this bound OLE
object.@Either you don't have permission to write to the record in which the
object is stored, or the record is locked by another user. Copy the object to the
Clipboard (select the object and click Copy on the Edit menu), and click Undo
Current Record on the Edit menu. Then open the application you used to create
the object, paste the object from the Clipboard, and save it.@@1@410222@1
Access 2007+ uses different description: 'Microsoft Office Access can't save
your changes to this bound OLE object.@Either you don't have permission to
write to the record in which the object is stored, or the record is locked by
another user. Copy the object to the Clipboard (select the object and click Copy
on the Edit menu), and click Undo Current Record on the Edit menu. Then
open the application you used to create the object, paste the object from the
Clipboard, and save it.@@1@1@10222@1' Access 2010+ uses different
description: 'Microsoft Access can't save your changes to this bound OLE
object.@Either you don't have permission to write to the record in which the
object is stored, or the record is locked by another user. Copy the object to the
Clipboard (select the object and click Copy on the Edit menu), and click Undo
Current Record on the Edit menu. Then open the application you used to create
the object, paste the object from the Clipboard, and save
it.@@1@1@10222@1'

Access 2003+

2279

The value you entered isn't appropriate for the input mask '|' specified for this
field.@@@2@509118@1 Access 2007+ uses different description: 'The
value you entered isn't appropriate for the input mask '|' specified for this
field.@@@2@1@9118@1'

Access 2003+

2280 You have added more output formats to the Windows Registry than Microsoft
Office Access can initialize.@Some output formats will not be available.
Remove those formats that you never or least often use.@@1@@1 Access
2007+ uses different description: 'You have added more output formats to the
Windows Registry than Microsoft Office Access can initialize.@Some output
formats will not be available. Remove those formats that you never or least
often use.@@1@@@1' Access 2010+ uses different description: 'You have

Access 2003+



added more output formats to the Windows Registry than Microsoft Access can
initialize.@Some output formats will not be available. Remove those formats
that you never or least often use.@@1@@@1'

2281

The formats that enable you to output data as a Microsoft Excel, rich-text
format, MS-DOS text, or HTML file are missing or incorrectly registered in the
Windows Registry.@Run Setup to reinstall Microsoft Office Access or, if
you're familiar with the settings in the Registry, try to correct them yourself.
For more information about the Registry, click Help.@@2@109015@1 Access
2007+ uses different description: 'Output format information is missing.
There appears to be a problem with your Microsoft Office Access installation.
Please reinstall Microsoft Office Access or contact your system administrator or
help desk representative.@@@2@1@9015@1' Access 2010+ uses different
description: 'Output format information is missing. There appears to be a
problem with your Microsoft Access installation. Please reinstall Microsoft
Access or contact your system administrator or help desk
representative.@@@2@1@9015@1'

Access 2003+

2282

The format in which you are attempting to output the current object is not
available.@Either you are attempting to output the current object to a format
that is not valid for its object type, or the formats that enable you to output data
as a Microsoft Excel, rich-text format, MS-DOS text, or HTML file are missing
from the Windows Registry. Run Setup to reinstall Microsoft Office Access or,
if you're familiar with the settings in the Registry, try to correct them yourself.
For more information on the Registry, click Help.@@2@109015@1 Access
2007+ uses different description: 'The format in which you are attempting to
output the current object is not available.@Either you are attempting to output
the current object to a format that is not valid for its object type, or the formats
that enable you to output data as a Microsoft Excel, rich-text format, MS-DOS
text, or HTML file are missing from the Windows Registry. Run Setup to
reinstall Microsoft Office Access or, if you're familiar with the settings in the
Registry, try to correct them yourself. For more information on the Registry,
click Help.@@2@1@9015@1' Access 2010+ uses different description: 'The
format in which you are attempting to output the current object is not
available.@Either you are attempting to output the current object to a format
that is not valid for its object type, or the formats that enable you to output data
as a Microsoft Excel, rich-text format, MS-DOS text, or HTML file are missing
from the Windows Registry. Run Setup to reinstall Microsoft Access or, if
you're familiar with the settings in the Registry, try to correct them yourself.
For more information on the Registry, click Help.@@2@1@9015@1'

Access 2003+

2283

The format specification for '|' is invalid.@You can't save output data to a file in
this format until you correct the setting for the format in the Windows Registry.
Run Setup to reinstall Microsoft Office Access or, if you're familiar with the
settings in the Registry, try to correct them yourself. For more information on
the Registry, click Help.@@2@109015@1 Access 2007+ uses different
description: 'The format specification for '|' is invalid.@You can't save output
data to a file in this format until you correct the setting for the format in the
Windows Registry. Run Setup to reinstall Microsoft Office Access or, if you're
familiar with the settings in the Registry, try to correct them yourself. For more
information on the Registry, click Help.@@2@1@9015@1' Access 2010+
uses different description: 'The format specification for '|1' is invalid.@You
can't save output data to a file in this format until you correct the setting for the
format in the Windows Registry. Run Setup to reinstall Microsoft Access or, if
you're familiar with the settings in the Registry, try to correct them yourself.
For more information on the Registry, click Help.@@2@1@9015@1'

Access 2003+

2284 Microsoft Office Access can't write to the file.@* The network may not be
working. Wait until the network is working, and then try again. * You may be
out of memory. Close one or more Microsoft Office Access windows, close
other applications, and then try again.@@1@@1 Access 2007+ uses different

Access 2003+



description: 'Microsoft Office Access can't write to the file.@* The network
may not be working. Wait until the network is working, and then try again. *
You may be out of memory. Close one or more Microsoft Office Access
windows, close other applications, and then try again.@@1@@@1' Access
2010+ uses different description: 'Microsoft Access can't write to the file.@*
The network may not be working. Wait until the network is working, and then
try again. * You may be out of memory. Close one or more Microsoft Access
windows, close other applications, and then try again.@@1@@@1'

Error Code Error Description Supported Versions

2285

Microsoft Office Access can't create the output file.@* You may be out of disk
space on the destination drive. * The network may not be working. Wait until
the network is working, and then try again. * You may be out of memory. Close
one or more Microsoft Office Access windows, close other applications, and
then try again.@@1@@1 Access 2007+ uses different description: 'Microsoft
Office Access can't create the output file.@* You may be out of disk space on
the destination drive. * The network may not be working. Wait until the
network is working, and then try again. * You may be out of memory. Close
one or more Microsoft Office Access windows, close other applications, and
then try again.@@1@@@1' Access 2010+ uses different description:
'Microsoft Access can't create the output file.@* You may be out of disk space
on the destination drive. * The network may not be working. Wait until the
network is working, and then try again. * You may be out of memory. Close
one or more Microsoft Access windows, close other applications, and then try
again.@@1@@@1'

Access 2003+

2286

Microsoft Office Access can't close the file.@* The network may not be
working. Wait until the network is working, and then try again. * You may be
out of memory. Close one or more Microsoft Office Access windows, close
other applications, and then try again.@@1@@1 Access 2007+ uses different
description: 'Microsoft Office Access can't close the file.@* The network may
not be working. Wait until the network is working, and then try again. * You
may be out of memory. Close one or more Microsoft Office Access windows,
close other applications, and then try again.@@1@@@1' Access 2010+ uses
different description: 'Microsoft Access can't close the file.@* The network
may not be working. Wait until the network is working, and then try again. *
You may be out of memory. Close one or more Microsoft Access windows,
close other applications, and then try again.@@1@@@1'

Access 2003+

2287

Microsoft Office Access can't open the mail session.@Check your mail
application to make sure that it's working properly.@@1@@1 Access 2007+
uses different description: 'Microsoft Office Access can't open the mail
session.@Check your mail application to make sure that it's working
properly.@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access can't open the mail session.@Check your mail application to make sure
that it's working properly.@@1@@@1'

Access 2003+

2288 Microsoft Office Access can't load the '|' format.@The setting for this format in
the Windows Registry is incorrect. You can't save the output data to a file in this
format until you correct the setting in the Registry.@Run Setup to reinstall
Microsoft Office Access or, if you're familiar with the settings in the Registry,
try to correct them yourself. For more information on the Registry, click
Help.@2@109015@1 Access 2007+ uses different description: 'Microsoft
Office Access can't load the '|' format.@The setting for this format in the
Windows Registry is incorrect. You can't save the output data to a file in this
format until you correct the setting in the Registry.@Run Setup to reinstall
Microsoft Office Access or, if you're familiar with the settings in the Registry,
try to correct them yourself. For more information on the Registry, click
Help.@2@1@9015@1' Access 2010+ uses different description: 'Microsoft
Access can't load the '|1' format.@The setting for this format in the Windows
Registry is incorrect. You can't save the output data to a file in this format until

Access 2003+



you correct the setting in the Registry.@Run Setup to reinstall Microsoft
Access or, if you're familiar with the settings in the Registry, try to correct them
yourself. For more information on the Registry, click Help.@2@1@9015@1'

2289

Microsoft Office Access can't output the module in the requested
format.@@@1@@1 Access 2007+ uses different description: 'Microsoft
Office Access can't output the module in the requested format.@@@1@@@1'
Access 2010+ uses different description: 'Microsoft Access can't output the
module in the requested format.@@@1@@@1'

Access 2003+

2290
There were too many message recipients; the message was not
sent.@@@1@@1 Access 2007+ uses different description: 'There were too
many message recipients; the message was not sent.@@@1@@@1'

Access 2003+

2291
There are too many message attachments; the message was not
sent.@@@1@@1 Access 2007+ uses different description: 'There are too
many message attachments; the message was not sent.@@@1@@@1'

Access 2003+

2292
The message text is too long, so it was not sent.@@@1@@1 Access 2007+
uses different description: 'The message text is too long, so it was not
sent.@@@1@@@1'

Access 2003+

2293

Microsoft Office Access can't send this e-mail message.@Before attempting to
send an e-mail message from Microsoft Office Access, resolve the problem
identified in the previous message, or configure your computer to send and
receive e-mail messages.@@1@@1 Access 2007+ uses different description:
'Microsoft Office Access can't send this e-mail message.@Before attempting to
send an e-mail message from Microsoft Office Access, resolve the problem
identified in the previous message, or configure your computer to send and
receive e-mail messages.@@1@@@1' Access 2010+ uses different
description: 'Microsoft Access can't send this e-mail message.@Before
attempting to send an e-mail message from Microsoft Access, resolve the
problem identified in the previous message, or configure your computer to send
and receive e-mail messages.@@1@@@1'

Access 2003+

2294

Microsoft Office Access can't attach the object; the message was not sent.@*
The network may not be working. Wait until the network is working, and then
try again. * You may be out of memory. Close one or more Microsoft Office
Access windows, close other applications, and then try again.@@1@@1
Access 2007+ uses different description: 'Microsoft Office Access can't attach
the object; the message was not sent.@* The network may not be working.
Wait until the network is working, and then try again. * You may be out of
memory. Close one or more Microsoft Office Access windows, close other
applications, and then try again.@@1@@@1' Access 2010+ uses different
description: 'Microsoft Access can't attach the object; the message was not
sent.@* The network may not be working. Wait until the network is working,
and then try again. * You may be out of memory. Close one or more Microsoft
Access windows, close other applications, and then try again.@@1@@@1'

Access 2003+

2295
Unknown message recipient(s); the message was not sent.@@@1@@1 Access
2007+ uses different description: 'Unknown message recipient(s); the
message was not sent.@@@1@@@1'

Access 2003+

2296
The password is invalid; the message wasn't sent.@@@1@@1 Access 2007+
uses different description: 'The password is invalid; the message wasn't
sent.@@@1@@@1'

Access 2003+

2297 Microsoft Office Access can't open the mail session.@You may be out of
memory. Close one or more Microsoft Office Access windows, close other
applications, and then try again. You may also want to check your mail
application to ensure that it's working properly.@@1@@1 Access 2007+ uses
different description: 'Microsoft Office Access can't open the mail
session.@You may be out of memory. Close one or more Microsoft Office
Access windows, close other applications, and then try again. You may also
want to check your mail application to ensure that it's working

Access 2003+



properly.@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access can't open the mail session.@You may be out of memory. Close one or
more Microsoft Access windows, close other applications, and then try again.
You may also want to check your mail application to ensure that it's working
properly.@@1@@@1'

2298

Microsoft Office Access can't start the wizard, builder, or add-in.@* The
library database containing the wizard, builder, or add-in may not be installed.
Point to Add-ins on the Tools menu, and then click Add-in Manager to see if the
library database is installed. * The wizard, builder, or add-in code may not be
compiled and Microsoft Office Access can't compile it. There may be a syntax
error in the code. * The key for the add-in in the Windows Registry file may be
incorrect.@@2@109015@1 Access 2007+ uses different description:
'Microsoft Office Access can't start the wizard, builder, or add-in.@* The
library database containing the wizard, builder, or add-in may not be installed.
Point to Add-ins on the Tools menu, and then click Add-in Manager to see if the
library database is installed. * The wizard, builder, or add-in code may not be
compiled and Microsoft Office Access can't compile it. There may be a syntax
error in the code. * The key for the add-in in the Windows Registry file may be
incorrect.@@2@1@9015@1' Access 2010+ uses different description:
'Microsoft Access can't start the wizard, builder, or add-in.@* The library
database containing the wizard, builder, or add-in may not be installed. Point to
Add-ins on the Tools menu, and then click Add-in Manager to see if the library
database is installed. * The wizard, builder, or add-in code may not be compiled
and Microsoft Access can't compile it. There may be a syntax error in the code.
* The key for the add-in in the Windows Registry file may be
incorrect.@@2@1@9015@1'

Access 2003+

2299

Microsoft Office Access can't open the Zoom box.@The Microsoft Office
Access Utility add-in is missing or was modified. Rerun Microsoft Office
Access or Microsoft Office Setup to reinstall Microsoft Office Access and the
Microsoft Office Access Utility add-in.@@1@212620@1 Access 2007+ uses
different description: 'Microsoft Office Access can't open the Zoom
box.@The Microsoft Office Access Utility add-in is missing or was modified.
Rerun Microsoft Office Access or Microsoft Office Setup to reinstall Microsoft
Office Access and the Microsoft Office Access Utility add-
in.@@1@1@12620@1' Access 2010+ uses different description: 'Microsoft
Access can't open the Zoom box.@The Microsoft Access Utility add-in is
missing or was modified. Rerun Microsoft Access or Microsoft Office Setup to
reinstall Microsoft Access and the Microsoft Access Utility add-
in.@@1@1@12620@1'

Access 2003+

2300

Microsoft Office Access can't output because there are too many controls
selected that have different styles, such as color and font.@Select fewer
controls, and then try again.@@1@@1 Access 2007+ uses different
description: 'Microsoft Office Access can't output because there are too many
controls selected that have different styles, such as color and font.@Select
fewer controls, and then try again.@@1@@@1' Access 2010+ uses different
description: 'Microsoft Access can't output because there are too many controls
selected that have different styles, such as color and font.@Select fewer
controls, and then try again.@@1@@@1'

Access 2003+

2301

There are not enough system resources to output the data.@Close one or more
Microsoft Office Access windows and close other applications. Then try to
output the data again.@@1@@1 Access 2007+ uses different description:
'There are not enough system resources to output the data.@Close one or more
Microsoft Office Access windows and close other applications. Then try to
output the data again.@@1@@@1' Access 2010+ uses different description:
'There are not enough system resources to output the data.@Close one or more
Microsoft Access windows and close other applications. Then try to output the
data again.@@1@@@1'

Access 2003+



2302

Microsoft Office Access can't save the output data to the file you've
selected.@* The file may be open. If so, close it, and then save the output data
to the file again. * If you are using a template, check to make sure the template
exists. * If the file isn't open, check to make sure that you have enough free
disk space. * Make sure that the file exists on the path specified. * Check to
make sure you have permission to write to the specified folder.@@1@@1
Access 2007+ uses different description: 'Microsoft Office Access can't save
the output data to the file you've selected.@* The file may be open. If so, close
it, and then save the output data to the file again. * If you are using a template,
check to make sure the template exists. * If the file isn't open, check to make
sure that you have enough free disk space. * Make sure that the file exists on
the path specified. * Check to make sure you have permission to write to the
specified folder.@@1@@@1' Access 2010+ uses different description:
'Microsoft Access can't save the output data to the file you've selected.@* The
file may be open. If so, close it, and then save the output data to the file again. *
If you are using a template, check to make sure the template exists. * If the file
isn't open, check to make sure that you have enough free disk space. * Make
sure that the file exists on the path specified. * Check to make sure you have
permission to write to the specified folder.@@1@@@1'

Access 2003+

2303

Microsoft Office Access can't output data now.@* The network may not be
working. Wait until the network is working, and then try again. * You may be
out of disk space. Free up disk space and try again.@@1@@1 Access 2007+
uses different description: 'Microsoft Office Access can't output data now.@*
The network may not be working. Wait until the network is working, and then
try again. * You may be out of disk space. Free up disk space and try
again.@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access can't output data now.@* The network may not be working. Wait until
the network is working, and then try again. * You may be out of disk space.
Free up disk space and try again.@@1@@@1'

Access 2003+

2304

Microsoft Office Access can't save output data to the specified file.@Make sure
that you have enough free disk space on your destination drive.@@1@@1
Access 2007+ uses different description: 'Microsoft Office Access can't save
output data to the specified file.@Make sure that you have enough free disk
space on your destination drive.@@1@@@1' Access 2010+ uses different
description: 'Microsoft Access can't save output data to the specified
file.@Make sure that you have enough free disk space on your destination
drive.@@1@@@1'

Access 2003+

Error Code Error Description Supported Versions

2305

There are too many columns to output, based on the limitation specified in the
output format or by Microsoft Office Access.@@@1@@1 Access 2007+ uses
different description: 'There are too many columns to output, based on the
limitation specified in the output format or by Microsoft Office
Access.@@@1@@@1' Access 2010+ uses different description: 'There are
too many columns to output, based on the limitation specified in the output
format or by Microsoft Access.@@@1@@@1'

Access 2003+

2306

There are too many rows to output, based on the limitation specified by the
output format or by Microsoft Office Access.@@@1@@1 Access 2007+ uses
different description: 'There are too many rows to output, based on the
limitation specified by the output format or by Microsoft Office
Access.@@@1@@@1' Access 2010+ uses different description: 'There are
too many rows to output, based on the limitation specified by the output format
or by Microsoft Access.@@@1@@@1'

Access 2003+

2307 You haven't selected any data, or the object you've selected is
blank.@@@1@@1 Access 2007+ uses different description: '' Access 2003

2308 The file '|' already exists.@Do you want to replace the existing file?
@@20@@2 Access 2007+ uses different description: 'The file '|' already

Access 2003+



exists.@Do you want to replace the existing file?@@20@@@2'

2309

There is an invalid add-in entry for '|.'@There is an error in the Windows
Registry for this add-in. Correct the setting and restart Microsoft Office Access.
For information on the Registry, click Help.@@2@109015@1 Access 2007+
uses different description: 'There is an invalid add-in entry for '|.'@There is an
error in the Windows Registry for this add-in. Correct the setting and restart
Microsoft Office Access. For information on the Registry, click
Help.@@2@1@9015@1' Access 2010+ uses different description: 'There is
an invalid add-in entry for '|1.'@There is an error in the Windows Registry for
this add-in. Correct the setting and restart Microsoft Access. For information on
the Registry, click Help.@@2@1@9015@1'

Access 2003+

2311
There isn't enough memory to run the NotInList event procedure.@@@1@@1
Access 2007+ uses different description: 'There isn't enough memory to run
the NotInList event procedure.@@@1@@@1'

Access 2003+

2312

The shortcut '|' must be re-created.@The file may be missing, damaged, or in an
older format that can't be read.@@1@@1 Access 2007+ uses different
description: 'The shortcut '|' must be re-created.@The file may be missing,
damaged, or in an older format that can't be read.@@1@@@1'

Access 2003+

2313

Microsoft Office Access can't find the shortcut databases '|1' or '|2.'@Re-create
the shortcut with the correct locations of the databases.@@2@209032@1
Access 2007+ uses different description: 'Microsoft Office Access can't find
the shortcut databases '|1' or '|2.'@Re-create the shortcut with the correct
locations of the databases.@@2@1@9032@1' Access 2010+ uses different
description: 'Microsoft Access can't find the shortcut databases '|1' or '|2.'@Re-
create the shortcut with the correct locations of the
databases.@@2@1@9032@1'

Access 2003+

2314

Microsoft Office Access can't find the shortcut database '|.'@Re-create the
shortcut with the correct location of the database.@@2@209032@1 Access
2007+ uses different description: 'Microsoft Office Access can't find the
shortcut database '|.'@Re-create the shortcut with the correct location of the
database.@@2@1@9032@1' Access 2010+ uses different description:
'Microsoft Access can't find the shortcut database '|1.'@Re-create the shortcut
with the correct location of the database.@@2@1@9032@1'

Access 2003+

2315 The input string is too long.@@@1@@1 Access 2007+ uses different
description: 'The input string is too long.@@@1@@@1' Access 2003+

2316

This table or query can't be opened because it has no visible fields.@This can
result if the table or query has only system fields, and the Show System Objects
option is off.@To turn on the Show System Objects option, click Options on
the Tools menu, click the View tab, and select the System Objects check
box.@1@@1 Access 2007+ uses different description: 'This table or query
can't be opened because it has no visible fields.@This can result if the table or
query has only system fields, and the Show System Objects option is off.@To
turn on the Show System Objects option, click Options on the Tools menu,
click the View tab, and select the System Objects check box.@1@@@1'

Access 2003+

2317

The database '|' can't be repaired or isn't a Microsoft Office Access database
file.@@@1@@1 Access 2007+ uses different description: 'The database '|'
can't be repaired or isn't a Microsoft Office Access database
file.@@@1@@@1' Access 2010+ uses different description: 'The database
'|1' can't be repaired or isn't a Microsoft Access database file.@@@1@@@1'

Access 2003+

2319 Microsoft Office Access can't import the object '|' while it is open.@@@1@@3
Access 2007+ uses different description: '' Access 2003

2320 Microsoft Office Access can't display the field for which you entered Where in
the Total row.@Clear the Show check box for that field. If you want this field
to appear in the query's results, add it to the design grid twice.For the field that
will appear in the query's results, don't specify Where in the Total row, and
make sure the Show check box is checked.@@1@@1 Access 2007+ uses
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different description: 'Microsoft Office Access can't display the field for
which you entered Where in the Total row.@Clear the Show check box for that
field. If you want this field to appear in the query's results, add it to the design
grid twice.For the field that will appear in the query's results, don't specify
Where in the Total row, and make sure the Show check box is
checked.@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access can't display the field for which you entered Where in the Total
row.@Clear the Show check box for that field. If you want this field to appear
in the query's results, add it to the design grid twice.For the field that will
appear in the query's results, don't specify Where in the Total row, and make
sure the Show check box is checked.@@1@@@1'

2321

You can't set criteria before you add a field or expression to the Field
row.@Either add a field from the field list to the column and enter an
expression, or delete the criteria.@@1@@1 Access 2007+ uses different
description: 'You can't set criteria before you add a field or expression to the
Field row.@Either add a field from the field list to the column and enter an
expression, or delete the criteria.@@1@@@1'

Access 2003+

2322

You can't sort on the asterisk (*).@Because the asterisk represents all fields in
the underlying table or query, you can't sort on it.@Add the asterisk to the
query design grid, along with the specific fields you want to sort on. Clear the
Show check box for the sorting fields, and then specify a sort order.@1@@1
Access 2007+ uses different description: 'You can't sort on the asterisk
(*).@Because the asterisk represents all fields in the underlying table or query,
you can't sort on it.@Add the asterisk to the query design grid, along with the
specific fields you want to sort on. Clear the Show check box for the sorting
fields, and then specify a sort order.@1@@@1'

Access 2003+

2323

You can't specify criteria for the asterisk (*).@Because the asterisk represents
all the fields in the underlying table or query, you can't specify criteria for
it.@Add the asterisk to the query design grid, along with the field(s) you want
to set criteria for, and then enter criteria for the specific fields. In the query
design grid, clear the Show check box for the criteria field(s), before you run
the query.@1@@1 Access 2007+ uses different description: 'You can't
specify criteria for the asterisk (*).@Because the asterisk represents all the
fields in the underlying table or query, you can't specify criteria for it.@Add the
asterisk to the query design grid, along with the field(s) you want to set criteria
for, and then enter criteria for the specific fields. In the query design grid, clear
the Show check box for the criteria field(s), before you run the
query.@1@@@1'

Access 2003+

2324

You can't calculate totals on the asterisk (*).@Because the asterisk represents
all the fields in the table, you can't calculate totals on it.@Remove the asterisk
from the query design grid. Add the fields you want to use to the design grid,
and then select the total you want to calculate for specific fields.@1@11202@1
Access 2007+ uses different description: 'You can't calculate totals on the
asterisk (*).@Because the asterisk represents all the fields in the table, you can't
calculate totals on it.@Remove the asterisk from the query design grid. Add the
fields you want to use to the design grid, and then select the total you want to
calculate for specific fields.@1@2@11202@1'

Access 2003+

2325 The field name you entered exceeds the LinkMasterFields property's 64-
character limit.@When you use the Relationships command (Tools menu) to
define a relationship between the tables underlying a form and subform,
Microsoft Office Access links the form and subform automatically and sets the
LinkChildFields and LinkMasterFields properties.@@1@603990@1 Access
2007+ uses different description: 'The field name you entered exceeds the 64-
character limit of the LinkMasterFields property.@When you use the
Relationships command (on the Database Tools tab, click Relationships) to
define a relationship between the tables underlying a form and subform,
Microsoft Office Access links the form and subform automatically and sets the
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LinkChildFields and LinkMasterFields properties.@@1@1@3990@1' Access
2010+ uses different description: 'The field name you entered exceeds the 64-
character limit of the LinkMasterFields property.@When you use the
Relationships command (on the Database Tools tab, click Relationships) to
define a relationship between the tables underlying a form and subform,
Microsoft Access links the form and subform automatically and sets the
LinkChildFields and LinkMasterFields properties.@@1@1@3990@1'

2326

You can't specify Group By, Expression, or Where in the Total row for this
column.@Specify an aggregate function, such as Sum or Count, for the field or
expression you designate as the Value in the crosstab query. For more
information on aggregate functions, click Help.@@2@209980@1 Access
2007+ uses different description: 'You can't specify Group By, Expression, or
Where in the Total row for this column.@Specify an aggregate function, such
as Sum or Count, for the field or expression you designate as the Value in the
crosstab query. For more information on aggregate functions, click
Help.@@2@1@9980@1'

Access 2003+

Error Code Error Description Supported Versions

2327

You must enter Group By in the Total row for a field that has Column Heading
in the Crosstab row.@The values derived from the field or expression that you
designate as the Column Heading are used to group data in the crosstab
query.@@1@209980@1 Access 2007+ uses different description: 'You must
enter Group By in the Total row for a field that has Column Heading in the
Crosstab row.@The values derived from the field or expression that you
designate as the Column Heading are used to group data in the crosstab
query.@@1@1@9980@1'

Access 2003+

2328

You can't run an update query on the asterisk (*).@Because the asterisk
represents all the fields in the table, you can't update it.@Remove the asterisk
from the query design grid. Add the fields you want to update to the design
grid.@1@210001@1 Access 2007+ uses different description: 'You can't run
an update query on the asterisk (*).@Because the asterisk represents all the
fields in the table, you can't update it.@Remove the asterisk from the query
design grid. Add the fields you want to update to the design
grid.@1@1@10001@1'

Access 2003+

2329

To create a crosstab query, you must specify one or more Row Heading(s)
options, one Column Heading option, and one Value
option.@@@1@209980@1 Access 2007+ uses different description: 'To
create a crosstab query, you must specify one or more Row Heading(s) options,
one Column Heading option, and one Value option.@@@1@1@9980@1'

Access 2003+

2330

Microsoft Office Access can't represent the join expression | in Design view.@*
One or more fields may have been deleted or renamed. * The name of one or
more fields or tables specified in the join expression may be misspelled. * The
join may use an operator that isn't supported in Design view, such as > or
<.@@1@@1 Access 2007+ uses different description: 'Microsoft Office
Access can't represent the join expression | in Design view.@* One or more
fields may have been deleted or renamed. * The name of one or more fields or
tables specified in the join expression may be misspelled. * The join may use
an operator that isn't supported in Design view, such as > or <.@@1@@@1'
Access 2010+ uses different description: 'Microsoft Access can't represent the
join expression |1 in Design view.@* One or more fields may have been
deleted or renamed. * The name of one or more fields or tables specified in the
join expression may be misspelled. * The join may use an operator that isn't
supported in Design view, such as > or <.@@1@@@1'

Access 2003+



2331

You must enter Group By in the Total row for at least one of the Row Heading
options you enter in the Crosstab row.@@@1@209980@1 Access 2007+ uses
different description: 'You must enter Group By in the Total row for at least
one of the Row Heading options you enter in the Crosstab
row.@@@1@1@9980@1'

Access 2003+

2332

Microsoft Office Access can't match the fields you added using the asterisk (*)
in the append query.@Because the asterisk represents all the fields in the
underlying table or query, you can't append an asterisk to one field or
expression, and you can't append a single field or expression to an
asterisk.@Append an asterisk to an asterisk (for example, a table to a table), or
append specific fields.@1@209999@1 Access 2007+ uses different
description: 'Microsoft Office Access can't match the fields you added using
the asterisk (*) in the append query.@Because the asterisk represents all the
fields in the underlying table or query, you can't append an asterisk to one field
or expression, and you can't append a single field or expression to an
asterisk.@Append an asterisk to an asterisk (for example, a table to a table), or
append specific fields.@1@1@9999@1' Access 2010+ uses different
description: 'Microsoft Access can't match the fields you added using the
asterisk (*) in the append query.@Because the asterisk represents all the fields
in the underlying table or query, you can't append an asterisk to one field or
expression, and you can't append a single field or expression to an
asterisk.@Append an asterisk to an asterisk (for example, a table to a table), or
append specific fields.@1@1@9999@1'

Access 2003+

2333

You must enter the name of the table you are creating or appending records
to.@You tried to define a make-table or append query without specifying a
destination table.@@1@@1 Access 2007+ uses different description: 'You
must enter the name of the table you are creating or appending records to.@You
tried to define a make-table or append query without specifying a destination
table.@@1@@@1'

Access 2003+

2334

Microsoft Office Access can't print '|' because it is an action query.@Because
action queries don't produce a recordset, you can't print a Datasheet view of
them. Note that an exclamation point (!) joined to a query icon in the Database
window marks an action query.@To print a Datasheet view of the records that
will be selected by the query, display the query in Design view, click the
Datasheet button, and then click the Print button.@1@@1 Access 2007+ uses
different description: 'Microsoft Office Access can't print '|' because it is an
action query.@Because action queries don't produce a recordset, you can't print
a Datasheet view of them. Note that an exclamation point (!) joined to a query
icon in the Navigation Pane marks an action query.@To print a Datasheet view
of the records that will be selected by the query, display the query in Design
view, click the Datasheet button, and then click the Print button.@1@@@1'
Access 2010+ uses different description: 'Microsoft Access can't print '|1'
because it is an action query.@Because action queries don't produce a
recordset, you can't print a Datasheet view of them. Note that an exclamation
point (!) joined to a query icon in the Navigation Pane marks an action
query.@To print a Datasheet view of the records that will be selected by the
query, display the query in Design view, click the Datasheet button, and then
click the Print button.@1@@@1'

Access 2003+

2335 You must use the same number of fields when you set the LinkChildFields and
LinkMasterFields properties.@You entered a different number of fields for one
property than you did for the other. If you use the Relationships command
(Tools menu) to define a relationship between the tables underlying the form
and subform, Microsoft Office Access will link the form and subform
automatically and then set the LinkChildFields and LinkMasterFields
properties.@@1@209086@1 Access 2007+ uses different description: 'You
must specify the same number of fields when you set the LinkChildFields and
LinkMasterFields properties.@You entered a different number of fields for one
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property than you did for the other. If you use the Relationships command (on
the Database Tools tab, click Relationships) to define a relationship between the
tables underlying the form and subform, Microsoft Office Access will link the
form and subform automatically and then set the LinkChildFields and
LinkMasterFields properties.@@1@1@9086@1' Access 2010+ uses different
description: 'You must specify the same number of fields when you set the
LinkChildFields and LinkMasterFields properties.@You entered a different
number of fields for one property than you did for the other. If you use the
Relationships command (on the Database Tools tab, click Relationships) to
define a relationship between the tables underlying the form and subform,
Microsoft Access will link the form and subform automatically and then set the
LinkChildFields and LinkMasterFields properties.@@1@1@9086@1'

2337

You can't specify criteria on the same field for which you entered Value in the
Crosstab row.@You tried to display a crosstab query after entering Value in the
Crosstab row and criteria in the Criteria row.@If you want this field to supply
the cross-tabulated values in the crosstab query, delete the entry in the Criteria
row. If you want this to be a criteria field, leave the Crosstab row
blank.@1@209980@1 Access 2007+ uses different description: 'You can't
specify criteria on the same field for which you entered Value in the Crosstab
row.@You tried to display a crosstab query after entering Value in the Crosstab
row and criteria in the Criteria row.@If you want this field to supply the cross-
tabulated values in the crosstab query, delete the entry in the Criteria row. If
you want this to be a criteria field, leave the Crosstab row
blank.@1@1@9980@1'

Access 2003+

2338

Microsoft Office Access truncated the expression you entered.@The expression
'|' exceeds the 1,024-character limit for the query design grid.@@1@@1
Access 2007+ uses different description: 'Microsoft Office Access truncated
the expression you entered.@The expression '|' exceeds the 1,024-character
limit for the query design grid.@@1@@@1' Access 2010+ uses different
description: 'Microsoft Access truncated the expression you entered.@The
expression '|1' exceeds the 1,024-character limit for the query design
grid.@@1@@@1'

Access 2003+

2339

Microsoft Office Access can't create a temporary link.@You reached the limit
for the number of links in your database. Microsoft Office Access needs to
create a temporary link in order to import your ODBC table.@Remove all
unneeded links or tables.@1@@1 Access 2007+ uses different description:
'Microsoft Office Access can't create a temporary link.@You reached the limit
for the number of links in your database. Microsoft Office Access needs to
create a temporary link in order to import your ODBC table.@Remove all
unneeded links or tables.@1@@@1' Access 2010+ uses different description:
'Microsoft Access can't create a temporary link.@You reached the limit for the
number of links in your database. Microsoft Access needs to create a temporary
link in order to import your ODBC table.@Remove all unneeded links or
tables.@1@@@1'

Access 2003+

2340

The expression you entered exceeds the 1,024-character limit for the query
design grid.@@@1@@1 Access 2007+ uses different description: 'The
expression you entered exceeds the 1,024-character limit for the query design
grid.@@@1@@@1'

Access 2003+

2342

A RunSQL action requires an argument consisting of an SQL statement.@For
example, an action query that appends records starts with INSERT INTO. A
data-definition query that creates a table starts with CREATE
TABLE.@@1@603698@1 Access 2007+ uses different description: 'A
RunSQL action requires an argument consisting of an SQL statement.@For
example, an action query that appends records starts with INSERT INTO. A
data-definition query that creates a table starts with CREATE
TABLE.@@1@1@3698@1'

Access 2003+



2343

The value you entered exceeds the Alias property's 64-character
limit.@@@1@606146@1 Access 2007+ uses different description: 'The
value you entered exceeds the Alias property's 64-character
limit.@@@1@1@6146@1'

Access 2003+

2344

For the TopValues property in the query property sheet, you must enter an
integer greater than zero.@@@1@@1 Access 2007 uses different
description: 'For the TopValues property in the query property sheet, you must
enter an integer greater than zero.@@@1@@@1' Access 2010 uses different
description: 'For the TopValues property in the query property sheet, you must
enter an integer greater than zero.@@@1@@@1' Access 2013 uses different
description: 'The value specified for top number of rows must be an integer
value greater than zero.@@@1@@@1' Access 2016 uses different
description: 'The value specified for top number of rows must be an integer
value greater than zero.@@@1@@@1'

Access 2003+

2345

For the TopValues property in the query property sheet, you must enter a
percentage from 1 through 100.@@@1@@1 Access 2007 uses different
description: 'For the TopValues property in the query property sheet, you must
enter a percentage from 1 through 100.@@@1@@@1' Access 2010 uses
different description: 'For the TopValues property in the query property sheet,
you must enter a percentage from 1 through 100.@@@1@@@1' Access 2013
uses different description: 'The value specified for top percentage of rows
must be a number between 1 and 100.@@@1@@@1' Access 2016 uses
different description: 'The value specified for top percentage of rows must be
a number between 1 and 100.@@@1@@@1'

Access 2003+

2346

For the TopValues property in the query property sheet, you must enter a
number greater than zero.@@@1@@1 Access 2007 uses different
description: 'For the TopValues property in the query property sheet, you must
enter a number greater than zero.@@@1@@@1' Access 2010 uses different
description: 'For the TopValues property in the query property sheet, you must
enter a number greater than zero.@@@1@@@1' Access 2013 uses different
description: 'The value specified for top number of rows must be a number
greater than zero.@@@1@@@1' Access 2016 uses different description:
'The value specified for top number of rows must be a number greater than
zero.@@@1@@@1'

Access 2003+

2347

Microsoft Office Access can't find the file name you entered for the
DestinationDB property in an action query's property sheet.@You may have
misspelled the database file name, or the file may have been deleted or
renamed.@@1@606183@1 Access 2007+ uses different description:
'Microsoft Office Access can't find the file name you entered for the
DestinationDB property in an action query's property sheet.@You may have
misspelled the database file name, or the file may have been deleted or
renamed.@@1@1@6183@1' Access 2010+ uses different description:
'Microsoft Access can't find the file name you entered for the DestinationDB
property in an action query's property sheet.@You may have misspelled the
database file name, or the file may have been deleted or
renamed.@@1@1@6183@1'

Access 2003+

2348
You can't leave the Alias property blank.@@@1@606146@1 Access 2007+
uses different description: 'You can't leave the Alias property
blank.@@@1@1@6146@1'

Access 2003+

Error Code Error Description Supported Versions
2349 For the TopValues property in the query property sheet, you must enter a

number smaller than 2,147,483,647.@@@1@@1 Access 2007 uses different
description: 'For the TopValues property in the query property sheet, you must
enter a number smaller than 2,147,483,647.@@@1@@@1' Access 2010 uses
different description: 'For the TopValues property in the query property sheet,
you must enter a number smaller than 2,147,483,647.@@@1@@@1' Access

Access 2003+



2013 uses different description: 'The value specified for top number of rows
must be a number between 1 and 2,147,483,647.@@@1@@@1' Access 2016
uses different description: 'The value specified for top number of rows must
be a number between 1 and 2,147,483,647.@@@1@@@1'

2350

Microsoft Office Access can't save the query.@* The query is a pass-through
query and can't be represented as a simple SQL string. Save the query as a
named query from the Query Builder. When you close the Query Builder,
Microsoft Office Access will fill the RecordSource or RowSource property with
the saved query name. * Make sure the query doesn't have an SQL syntax
error.@@1@604309@1 Access 2007+ uses different description: 'Microsoft
Office Access can't save the query.@* The query is a pass-through query and
can't be represented as a simple SQL string. Save the query as a named query
from the Query Builder. When you close the Query Builder, Microsoft Office
Access will fill the RecordSource or RowSource property with the saved query
name. * Make sure the query doesn't have an SQL syntax
error.@@1@1@4309@1' Access 2010+ uses different description: 'Microsoft
Access can't save the query.@* The query is a pass-through query and can't be
represented as a simple SQL string. Save the query as a named query from the
Query Builder. When you close the Query Builder, Microsoft Access will fill
the RecordSource or RowSource property with the saved query name. * Make
sure the query doesn't have an SQL syntax error.@@1@1@4309@1'

Access 2003+

2351

Microsoft Office Access can't represent an implicit VALUES clause in the
query design grid.@Edit this in SQL view.@@1@@1 Access 2007+ uses
different description: 'Microsoft Office Access can't represent an implicit
VALUES clause in the query design grid.@Edit this in SQL
view.@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access can't represent an implicit VALUES clause in the query design
grid.@Edit this in SQL view.@@1@@@1'

Access 2003+

2352

You can't modify this query because it has been deleted or renamed by another
user.@@@1@@1 Access 2007+ uses different description: 'You can't modify
this query because it has been deleted or renamed by another
user.@@@1@@@1'

Access 2003+

2353 Bad query parameter'|'.@@@1@@1 Access 2007+ uses different description:
'Bad query parameter'|'.@@@1@@@1' Access 2003+

2354 This query or table has an expression that is failing to evaluate. Access 2007+

2355 You can select up to | values in a column filter for a multi-valued field. Remove
some values, and then try again. Access 2007+

2356 You cannot assign a multivalued or Attachment field to the Link Master Fields
or Link Child Fields properties.@@@1@@@1 Access 2007+

2360

A field name is missing.@You have defined a data type or a description for a
field without specifying the field name.@Enter a name for the field, or delete
the row.@1@@1 Access 2007+ uses different description: 'A field name is
missing.@You have defined a data type or a description for a field without
specifying the field name.@Enter a name for the field, or delete the
row.@1@@@1'

Access 2003+

2361

Microsoft Office Access can't save this table.@There are no fields in this
table.@Define at least one field by entering a field name and selecting a data
type.@1@@1 Access 2007+ uses different description: 'Microsoft Office
Access can't save this table.@There are no fields in this table.@Define at least
one field by entering a field name and selecting a data type.@1@@@1' Access
2010+ uses different description: 'Microsoft Access can't save this
table.@There are no fields in this table.@Define at least one field by entering a
field name and selecting a data type.@1@@@1'

Access 2003+

2362 You already have a field named '|.'@@@1@@1 Access 2007+ uses different
description: 'You already have a field named '|.'@@@1@@@1' Access 2003+



2363

Microsoft Office Access allows only one AutoNumber field per table.@Use the
Number data type for similar fields.@@1@@1 Access 2007+ uses different
description: 'Microsoft Office Access allows only one AutoNumber field per
table.@Use the Number data type for similar fields.@@1@@@1' Access
2010+ uses different description: 'Microsoft Access allows only one
AutoNumber field per table.@Use the Number data type for similar
fields.@@1@@@1'

Access 2003+

2364

Microsoft Office Access can't open the table in Datasheet view.@@@1@@1
Access 2007+ uses different description: 'Microsoft Office Access can't open
the table in Datasheet view.@@@1@@@1' Access 2010+ uses different
description: 'Microsoft Access can't open the table in Datasheet
view.@@@1@@@1'

Access 2003+

2366

Microsoft Office Access was unable to save the field ordering. All other
changes were saved successfully.@Close this database and choose the Repair
Database command on the Tools menu (Database Utilities
submenu).@@1@@1 Access 2007+ uses different description: 'Microsoft
Office Access was unable to save the field ordering. All other changes were
saved successfully.@Click the Microsoft Office Button, point to Manage, and
then click Compact and Repair Database.@@1@@@1' Access 2010+ uses
different description: 'Microsoft Access was unable to save the field ordering.
All other changes were saved successfully.@Click the File tab, point to
Manage, and then click Compact and Repair Database.@@1@@@0'

Access 2003+

2370

Removing or changing the index for this field would require removal of the
primary key.@If you want to delete the primary key, select that field and click
the Primary Key button.@@1@@1 Access 2007+ uses different description:
'Removing or changing the index for this field would require removal of the
primary key.@If you want to delete the primary key, select that field and click
the Primary Key button.@@1@@@1'

Access 2003+

2371

Microsoft Office Access can't create a primary key. Your changes weren't
saved.@@@1@@1 Access 2007+ uses different description: 'Microsoft
Office Access can't create a primary key. Your changes weren't
saved.@@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access can't create a primary key. Your changes weren't saved.@@@1@@@1'

Access 2003+

2372

The field name is not valid.@Make sure that the name doesn't contain a period
(.), exclamation point (!), bracket ([]), leading space, or non-printable character
such as a carriage return.If you have pasted the name from another application,
try pressing ESC and typing the name again.@@2@613793@1 Access 2007+
uses different description: 'The field name is not valid.@Make sure that the
name doesn't contain a period (.), exclamation point (!), bracket ([]), leading
space, or non-printable character such as a carriage return.If you have pasted
the name from another application, try pressing ESC and typing the name
again.@@2@1@13793@1' Access 2010+ uses different description: 'The
field name you entered does not follow Microsoft Access object-naming rules.
If you pasted the name from another application, try pressing ESC and typing
the name again.@For more information about naming objects, click
Help.@@2@1@553714184@1'

Access 2003+

2373
The setting for the FieldSize property must be from 0 through
255.@@@1@@1 Access 2007+ uses different description: 'The setting for
the FieldSize property must be from 0 through 255.@@@1@@@1'

Access 2003+

2374
You can't create an index or primary key on more than 10 fields.@@@1@@1
Access 2007+ uses different description: 'You can't create an index or primary
key on more than 10 fields.@@@1@@@1'

Access 2003+

2375 You can't paste beyond the end of a table.@You have attempted to paste fields
beyond the 255th row in a table in Design view.@@1@@1 Access 2007+ uses
different description: 'You can't paste beyond the end of a table.@You have

Access 2003+



attempted to paste fields beyond the 255th row in a table in Design
view.@@1@@@1'

Error Code Error Description Supported Versions

2376

Microsoft Office Access can't create a primary key.@You have selected too
many fields for a multiple-field primary key.@@1@@1 Access 2007+ uses
different description: 'Microsoft Office Access can't create a primary
key.@You have selected too many fields for a multiple-field primary
key.@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access can't create a primary key.@You have selected too many fields for a
multiple-field primary key.@@1@@@1'

Access 2003+

2377

Once you enter data in a table, you can't change the data type of any field to
AutoNumber, even if you haven't yet added data to that field.@Add a new field
to the table, and define its data type as AutoNumber. Microsoft Office Access
then enters data in the AutoNumber field automatically, numbering the records
consecutively starting with 1.@@1@@1 Access 2007+ uses different
description: 'Once you enter data in a table, you can't change the data type of
any field to AutoNumber, even if you haven't yet added data to that field.@Add
a new field to the table, and define its data type as AutoNumber. Microsoft
Office Access then enters data in the AutoNumber field automatically,
numbering the records consecutively starting with 1.@@1@@@1' Access
2010+ uses different description: 'Once you enter data in a table, you can't
change the data type of any field to AutoNumber, even if you haven't yet added
data to that field.@Add a new field to the table, and define its data type as
AutoNumber. Microsoft Access then enters data in the AutoNumber field
automatically, numbering the records consecutively starting with
1.@@1@@@1'

Access 2003+

2378

This table is read-only.@Use a different name in the Save As dialog box to save
your changes.@@1@@1 Access 2007+ uses different description: 'This table
is read-only.@Use a different name in the Save As dialog box to save your
changes.@@1@@@1'

Access 2003+

2379

You can't create a primary key on a field of this data type.@You can't define a
primary key on fields with an OLE Object data type.@@1@@1 Access 2007+
uses different description: 'You can't create a primary key on a field of this
data type.@You can't define a primary key on fields with an OLE Object,
Memo, Attachment, or Multi-valued lookup field.@@1@@@1'

Access 2003+

2380

Microsoft Office Access can't create a primary key because no fields have been
selected.@You have selected a row with no fields defined.@Place the insertion
point somewhere in the row of the field you want to define as the primary
key.@1@@1 Access 2007+ uses different description: 'Microsoft Office
Access can't create a primary key because no fields have been selected.@You
have selected a row with no fields defined.@Place the insertion point
somewhere in the row of the field you want to define as the primary
key.@1@@@1' Access 2010+ uses different description: 'Microsoft Access
can't create a primary key because no fields have been selected.@You have
selected a row with no fields defined.@Place the insertion point somewhere in
the row of the field you want to define as the primary key.@1@@@1'

Access 2003+

2381

Microsoft Office Access can't create a primary key because the field doesn't
have a name.@Name the field, and then define it as a primary key
field.@@1@@1 Access 2007+ uses different description: 'Microsoft Office
Access can't create a primary key because the field doesn't have a
name.@Name the field, and then define it as a primary key field.@@1@@@1'
Access 2010+ uses different description: 'Microsoft Access can't create a
primary key because the field doesn't have a name.@Name the field, and then
define it as a primary key field.@@1@@@1'

Access 2003+

2382 You can't switch to Datasheet view and you can't return to Design
view.@Another user has opened this table or a query, form, or report that is

Access 2003+



bound to this table.@@1@@1 Access 2007+ uses different description: 'You
can't switch to Datasheet view and you can't return to Design view.@Another
user has opened this table or a query, form, or report that is bound to this
table.@@1@@@1'

2383

Microsoft Office Access can't change the data type.@There isn't enough disk
space or memory.@@1@@1 Access 2007+ uses different description:
'Microsoft Office Access can't change the data type.@There isn't enough disk
space or memory.@@1@@@1' Access 2010+ uses different description:
'Microsoft Access can't change the data type.@There isn't enough disk space or
memory.@@1@@@1'

Access 2003+

2384

You can't change one field from an AutoNumber data type and add another
AutoNumber field at the same time.@Do the following: 1.Delete the
AutoNumber field you added, and click Save on the File menu. 2.Add the new
AutoNumber field, and save the table again.@@1@@1 Access 2007+ uses
different description: 'You cannot change one field from an AutoNumber data
type and add another AutoNumber field at the same time.@Do the following: 1.
Delete the AutoNumber field you just added, click the Microsoft Office Button,
and then click Save. 2.Add the new AutoNumber field, and then save the table
again.@@1@@@1' Access 2010+ uses different description: 'You cannot
change one field from an AutoNumber data type and add another AutoNumber
field at the same time.@Do the following: 1. Delete the AutoNumber field you
just added, click the File tab, and then click Save. 2. ?Add the new
AutoNumber field, and then save the table again.@@1@@@0'

Access 2003+

2385
Errors were encountered during the save operation.|@@@1@@1 Access
2007+ uses different description: 'Errors were encountered during the save
operation.|@@@1@@@1'

Access 2003+

2386

Microsoft Office Access was unable to create the table.@@@1@@1 Access
2007+ uses different description: 'Microsoft Office Access was unable to
create the table.@@@1@@@1' Access 2010+ uses different description:
'Microsoft Access was unable to create the table.@@@1@@@1'

Access 2003+

2387

You can't delete the table '|'; it is participating in one or more relationships.@If
you want to delete this table, first delete its relationships in the Relationships
window.@@1@@1 Access 2007+ uses different description: 'You can't
delete the table '|'; it is participating in one or more relationships.@If you want
to delete this table, first delete its relationships in the Relationships
window.@@1@@@1'

Access 2003+

2388

You can't change the primary key.@This table is the primary table in one or
more relationships.@If you want to change or remove the primary key, first
delete the relationship in the Relationships window.@1@@1 Access 2007+
uses different description: 'You can't change the primary key.@This table is
the primary table in one or more relationships.@If you want to change or
remove the primary key, first delete the relationship in the Relationships
window.@1@@@1'

Access 2003+

2389

You can't delete the field '|.'@It is part of one or more relationships.@If you
want to delete this field, first delete its relationships in the Relationships
window.@1@@1 Access 2007+ uses different description: 'You can't delete
the field '|.'@It is part of one or more relationships.@If you want to delete this
field, first delete its relationships in the Relationships window.@1@@@1'

Access 2003+

2390

You can't change the data type or field size of this field; it is part of one or more
relationships.@If you want to change the data type of this field, first delete its
relationships in the Relationships window.@@1@@1 Access 2007+ uses
different description: 'You can't change the data type or field size of this field;
it is part of one or more relationships.@If you want to change the data type of
this field, first delete its relationships in the Relationships
window.@@1@@@1'

Access 2003+



2391

Field '|1' doesn't exist in destination table '|2.'@Microsoft Office Access was
unable to complete the append operation. The destination table must contain the
same fields as the table you are pasting from.@@1@@1 Access 2007+ uses
different description: 'Field '|1' doesn't exist in destination table
'|2.'@Microsoft Office Access was unable to complete the append operation.
The destination table must contain the same fields as the table you are pasting
from.@@1@@@1' Access 2010+ uses different description: 'Field '|1'
doesn't exist in destination table '|2.'@Microsoft Access was unable to complete
the append operation. The destination table must contain the same fields as the
table you are pasting from.@@1@@@1'

Access 2003+

2392

You can't set the Unique property of a primary key to No.@A primary key, by
definition, contains only unique values.@If you want to allow nonunique
values in this field, remove the primary key definition by setting the Primary
property to No.@1@@1 Access 2007+ uses different description: 'You can't
set the Unique property of a primary key to No.@A primary key, by definition,
contains only unique values.@If you want to allow nonunique values in this
field, remove the primary key definition by setting the Primary property to
No.@1@@@1'

Access 2003+

2393

You can't set the IgnoreNulls property of a primary key to Yes.@A primary key,
by definition, can't allow null values.@If you want null values in this field,
remove the primary key definition by setting the Primary property to
No.@1@@1 Access 2007+ uses different description: 'You can't set the
IgnoreNulls property of a primary key to Yes.@A primary key, by definition,
can't allow null values.@If you want null values in this field, remove the
primary key definition by setting the Primary property to No.@1@@@1'

Access 2003+

2394

The index name is invalid.@The index name may be too long (over 64
characters) or contain invalid characters.@@1@@1 Access 2007+ uses
different description: 'The index name is invalid.@The index name may be
too long (over 64 characters) or contain invalid characters.@@1@@@1'

Access 2003+

2395 Indexes must have names.@@@1@@1 Access 2007+ uses different
description: 'Indexes must have names.@@@1@@@1' Access 2003+

Error Code Error Description Supported Versions

2396

Microsoft Office Access can't create an index or primary key.@One or more
field names are missing.@Enter or select at least one field in the Field Name
column for each index you name.@1@@1 Access 2007+ uses different
description: 'Microsoft Office Access can't create an index or primary
key.@One or more field names are missing.@Enter or select at least one field
in the Field Name column for each index you name.@1@@@1' Access 2010+
uses different description: 'Microsoft Access can't create an index or primary
key.@One or more field names are missing.@Enter or select at least one field
in the Field Name column for each index you name.@1@@@1'

Access 2003+

2397 You already have an index named '|.'@@@1@@1 Access 2007+ uses
different description: 'You already have an index named '|.'@@@1@@@1' Access 2003+

2398

The primary key has been changed.@This table is the primary table in one or
more relationships. Changes to the primary key won't be saved.@@1@@1
Access 2007+ uses different description: 'The primary key has been
changed.@This table is the primary table in one or more relationships. Changes
to the primary key won't be saved.@@1@@@1'

Access 2003+

2399
The setting for the FieldSize property must be from 1 through
8000.@@@1@@1 Access 2007+ uses different description: 'The setting for
the FieldSize property must be from 1 through 8000.@@@1@@@1'

Access 2003+

2400

The row you inserted in the grid exceeds the limit of 255 rows (fields) for a
table or 1,000 rows (actions) for a macro.@@@1@@1 Access 2007+ uses
different description: 'The row you inserted in the grid exceeds the limit of
255 rows (fields) for a table or 1,000 rows (actions) for a
macro.@@@1@@@1'

Access 2003+



2401

You can't delete the '|1' column at this time. @The '|1' column is part of the
primary key for the '|2' table. It is used to identify and store the rows in your
table in the database.@You cannot delete a primary key while using Datasheet
view. To delete the primary key, open the table in Design view and remove the
primary key field.@1@@@1

Access 2007+

2420
The expression you entered has an invalid number.@@@2@611732@1 Access
2007+ uses different description: 'The expression you entered has an invalid
number.@@@2@1@11732@1'

Access 2003+

2421
The expression you entered has an invalid date value.@@@2@611729@1
Access 2007+ uses different description: 'The expression you entered has an
invalid date value.@@@2@1@11729@1'

Access 2003+

2422

The expression you entered has an invalid string.@A string can be up to 2048
characters long, including opening and closing quotation marks.@@1@@1
Access 2007+ uses different description: 'The expression you entered has an
invalid string.@A string can be up to 2048 characters long, including opening
and closing quotation marks.@@1@@@1'

Access 2003+

2423

The expression you entered has an invalid . (dot) or ! operator or invalid
parentheses.@You may have entered an invalid identifier or typed parentheses
following the Null constant.@@2@611736@1 Access 2007+ uses different
description: 'The expression you entered has an invalid . (dot) or ! operator or
invalid parentheses.@You may have entered an invalid identifier or typed
parentheses following the Null constant.@@2@1@11736@1'

Access 2003+

2424

The expression you entered has a field, control, or property name that Microsoft
Office Access can't find.@@@1@@1 Access 2007+ uses different
description: 'The expression you entered has a field, control, or property name
that Microsoft Office Access can't find.@@@1@@@1' Access 2010+ uses
different description: 'The expression you entered has a field, control, or
property name that Microsoft Access can't find.@@@1@@@1'

Access 2003+

2425

The expression you entered has a function name that Microsoft Office Access
can't find.@@@1@@1 Access 2007+ uses different description: 'The
expression you entered has a function name that Microsoft Office Access can't
find.@@@1@@@1' Access 2010+ uses different description: 'The
expression you entered has a function name that Microsoft Access can't
find.@@@1@@@1'

Access 2003+

2426

The function you entered can't be used in this expression.@* You may have
used a DoEvents, LBound, UBound, Spc, or Tab function in an expression. *
You may have used an aggregate function, such as Count, in a design grid or in
a calculated control or field.@@1@@1 Access 2007+ uses different
description: 'The function you entered can't be used in this expression.@* You
may have used a DoEvents, LBound, UBound, Spc, or Tab function in an
expression. * You may have used an aggregate function, such as Count, in a
design grid or in a calculated control or field.@@1@@@1'

Access 2003+

2427

You entered an expression that has no value.@The expression may refer to an
object that has no value, such as a form, a report, or a label control.@@1@@1
Access 2007+ uses different description: 'You entered an expression that has
no value.@The expression may refer to an object that has no value, such as a
form, a report, or a label control.@@1@@@1'

Access 2003+

2428

You entered an invalid argument in a domain aggregate function.@* A field in
the string expression may not be in the domain. * A field specified in the
criteria expression may not be in the domain.@@2@610931@1 Access 2007+
uses different description: 'You entered an invalid argument in a domain
aggregate function.@* A field in the string expression may not be in the
domain. * A field specified in the criteria expression may not be in the
domain.@@2@1@10931@1'

Access 2003+

2429 The In operator you entered requires parentheses.@@@1@@1 Access 2007+
uses different description: 'The In operator you entered requires

Access 2003+



parentheses.@@@1@@@1'

2430

You did not enter the keyword And in the Between...And operator.@The
correct syntax is as follows: expression [Not] Between value1 And
value2@@1@@1 Access 2007+ uses different description: 'You did not enter
the keyword And in the Between...And operator.@The correct syntax is as
follows: expression [Not] Between value1 And value2@@1@@@1'

Access 2003+

2431

The expression you entered contains invalid syntax.@You may have entered a
comma without a preceding value or identifier.@@1@@1 Access 2007+ uses
different description: 'The expression you entered contains invalid
syntax.@You may have entered a comma without a preceding value or
identifier.@@1@@@1'

Access 2003+

2432

The expression you entered contains invalid syntax, or you need to enclose
your text data in quotes.@You may have entered an invalid comma or omitted
quotation marks. For example, if the Default Value property of a text field is
''Huey, Louie, and Dewey,'' it must be enclosed in quotes if you mean it as a
literal text string. This avoids the confusion with the expression ''Huey Louie''
And ''Dewey''.@@1@@1 Access 2007+ uses different description: 'The
expression you entered contains invalid syntax, or you need to enclose your text
data in quotes.@You may have entered an invalid comma or omitted quotation
marks. For example, if the Default Value property of a text field is ''Huey,
Louie, and Dewey,'' it must be enclosed in quotes if you mean it as a literal text
string. This avoids the confusion with the expression ''Huey Louie'' And
''Dewey''.@@1@@@1'

Access 2003+

2433

The expression you entered contains invalid syntax.@You may have entered an
operator, such as the + operator, in an expression without a corresponding
operand.@@1@@1 Access 2007+ uses different description: 'The expression
you entered contains invalid syntax.@You may have entered an operator, such
as the + operator, in an expression without a corresponding
operand.@@1@@@1'

Access 2003+

Error Code Error Description Supported Versions

2434

The expression you entered contains invalid syntax.@You may have entered an
operand without an operator.@@1@@1 Access 2007+ uses different
description: 'The expression you entered contains invalid syntax.@You may
have entered an operand without an operator.@@1@@@1'

Access 2003+

2435
The expression you entered has too many closing parentheses.@@@1@@1
Access 2007+ uses different description: 'The expression you entered has too
many closing parentheses.@@@1@@@1'

Access 2003+

2436

The expression you entered is missing a closing parenthesis, bracket (]), or
vertical bar (|).@@@1@@1 Access 2007+ uses different description: 'The
expression you entered is missing a closing parenthesis, bracket (]), or vertical
bar (|).@@@1@@@1'

Access 2003+

2437
The expression you entered has invalid vertical bars (|).@@@1@@1 Access
2007+ uses different description: 'The expression you entered has invalid
vertical bars (|).@@@1@@@1'

Access 2003+

2438

The expression you entered contains invalid syntax.@You omitted an operand
or operator, you entered an invalid character or comma, or you entered text
without surrounding it in quotation marks.@@2@611732@1 Access 2007+
uses different description: 'The expression you entered contains invalid
syntax.@You omitted an operand or operator, you entered an invalid character
or comma, or you entered text without surrounding it in quotation
marks.@@2@1@11732@1'

Access 2003+

2439

The expression you entered has a function containing the wrong number of
arguments.@@@1@@1 Access 2007+ uses different description: 'The
expression you entered has a function containing the wrong number of
arguments.@@@1@@@1'

Access 2003+



2440
You must enclose IIf function arguments in parentheses.@@@1@1012957@1
Access 2007+ uses different description: 'You must enclose IIf function
arguments in parentheses.@@@1@3@1012957@1'

Access 2003+

2442

The expression you entered has invalid parentheses.@You may have used the
parenthesis syntax for an identifier in a query. Use the standard identifier
syntax: Forms![Form]![Control].@@1@411729@1 Access 2007+ uses
different description: 'The expression you entered has invalid
parentheses.@You may have used the parenthesis syntax for an identifier in a
query. Use the standard identifier syntax: Forms![Form]!
[Control].@@1@1@11729@1'

Access 2003+

2443

You can use the Is operator only in an expression with Null or Not
Null.@@@1@1008950@1 Access 2007+ uses different description: 'You
can use the Is operator only in an expression with Null or Not
Null.@@@1@3@1008950@1'

Access 2003+

2445
The expression you entered is too complex.@@@2@611732@1 Access 2007+
uses different description: 'The expression you entered is too
complex.@@@2@1@11732@1'

Access 2003+

2446

There isn't enough memory available to perform this calculation.@Close
unneeded programs, and try again. For more information on freeing memory,
search the Microsoft Windows Help index for 'memory,
troubleshooting'.@@1@@1 Access 2007+ uses different description: 'There
isn't enough memory available to perform this calculation.@Close unneeded
programs, and try again. For more information on freeing memory, search the
Microsoft Windows Help index for 'memory, troubleshooting'.@@1@@@1'

Access 2003+

2447

There is an invalid use of the . (dot) or ! operator or invalid parentheses.@You
may have entered an invalid identifier or typed parentheses following the Null
constant.@@2@611736@1 Access 2007+ uses different description: 'There
is an invalid use of the . (dot) or ! operator or invalid parentheses.@You may
have entered an invalid identifier or typed parentheses following the Null
constant.@@2@1@11736@1'

Access 2003+

2448

You can't assign a value to this object.@* The object may be a control on a
read-only form. * The object may be on a form that is open in Design view. *
The value may be too large for this field.@@1@209424@1 Access 2007+ uses
different description: 'You can't assign a value to this object.@* The object
may be a control on a read-only form. * The object may be on a form that is
open in Design view. * The value may be too large for this
field.@@1@1@9424@1'

Access 2003+

2449

There is an invalid method in an expression.@For example, you may have tried
to use the Print method with an object other than Report or
Debug.@@2@2015551@1 Access 2007+ uses different description: 'There is
an invalid method in an expression.@For example, you may have tried to use
the Print method with an object other than Report or
Debug.@@2@4@2015551@1'

Access 2003+

2450

Microsoft Office Access can't find the form '|' referred to in a macro expression
or Visual Basic code.@* The form you referenced may be closed or may not
exist in this database. * Microsoft Office Access may have encountered a
compile error in a Visual Basic module for the form.@@1@211735@1 Access
2007+ uses different description: 'Microsoft Office Access can't find the form
'|' referred to in a macro expression or Visual Basic code.@* The form you
referenced may be closed or may not exist in this database. * Microsoft Office
Access may have encountered a compile error in a Visual Basic module for the
form.@@1@1@11735@1' Access 2010+ uses different description:
'Microsoft Access cannot find the referenced form '|1'.@* The form you
referenced may be closed or may not exist in this database.* Microsoft Access
may have encountered a compile error in a Visual Basic module for the
form.@@1@1@11735@1'

Access 2003+



2451

The report name '|' you entered is misspelled or refers to a report that isn't open
or doesn't exist.@@@1@@1 Access 2007+ uses different description: 'The
report name '|' you entered is misspelled or refers to a report that isn't open or
doesn't exist.@@@1@@@1'

Access 2003+

2452

The expression you entered has an invalid reference to the Parent
property.@For example, you may be using the Parent property with a control
on a main form or report rather than with a control on a subform or
subreport.@@2@604852@1 Access 2007+ uses different description: 'The
expression you entered has an invalid reference to the Parent property.@For
example, you may be using the Parent property with a control on a main form
or report rather than with a control on a subform or
subreport.@@2@1@4852@1'

Access 2003+

2453

The control name '|' you entered in your expression is misspelled or refers to a
control on a form or report that isn't open or doesn't exist.@@@1@411730@1
Access 2007+ uses different description: 'The control name '|' you entered in
your expression is misspelled or refers to a control on a form or report that isn't
open or doesn't exist.@@@1@1@11730@1'

Access 2003+

2454

The object name '|' you entered following the ! operator in the expression is
invalid.@For example, you may have tried to enter an identifier with two
control names separated by the ! operator.@@2@611736@1 Access 2007+
uses different description: 'The object name '|' you entered following the !
operator in the expression is invalid.@For example, you may have tried to enter
an identifier with two control names separated by the !
operator.@@2@1@11736@1'

Access 2003+

2455

You entered an expression that has an invalid reference to the property |.@The
property may not exist or may not apply to the object you
specified.@@2@2015567@1 Access 2007+ uses different description: 'You
entered an expression that has an invalid reference to the property |.@The
property may not exist or may not apply to the object you
specified.@@2@4@2015567@1'

Access 2003+

Error Code Error Description Supported Versions

2456

The number you used to refer to the form is invalid.@Use the Count property
to count the open forms and make sure that the form number is not greater than
the number of open forms minus one.@@1@2019460@1 Access 2007+ uses
different description: 'The number you used to refer to the form is
invalid.@Use the Count property to count the open forms and make sure that
the form number is not greater than the number of open forms minus
one.@@1@4@2019460@1'

Access 2003+

2457

The number you used to refer to the report is invalid.@Use the Count property
to count the open reports and make sure that the report number is not greater
than the number of open reports.@@1@2019460@1 Access 2007+ uses
different description: 'The number you used to refer to the report is
invalid.@Use the Count property to count the open reports and make sure that
the report number is not greater than the number of open
reports.@@1@4@2019460@1'

Access 2003+

2458

The control number you specified is greater than the number of controls.@Use
the Count property to count the controls on the form or report and then check
that the control number you cite is within the range of existing
controls.@@1@2019460@1 Access 2007+ uses different description: 'The
control number you specified is greater than the number of controls.@Use the
Count property to count the controls on the form or report and then check that
the control number you cite is within the range of existing
controls.@@1@4@2019460@1'

Access 2003+

2459 You can't refer to the Parent property of a form or report when either is open in
Design view.@@@1@@1 Access 2007+ uses different description: 'You

Access 2003+



can't refer to the Parent property of a form or report when either is open in
Design view.@@@1@@@1'

2460

You can't refer to the RecordsetClone property of a form open in Design
view.@@@1@607393@1 Access 2007+ uses different description: 'You
can't refer to the RecordsetClone property of a form open in Design
view.@@@1@1@7393@1'

Access 2003+

2461
Use a section number, not a string, to refer to a form or report
section.@@@1@@1 Access 2007+ uses different description: 'Use a section
number, not a string, to refer to a form or report section.@@@1@@@1'

Access 2003+

2462
The section number you entered is invalid.@@@1@@1 Access 2007+ uses
different description: 'The section number you entered is
invalid.@@@1@@@1'

Access 2003+

2463
Use a number, not a string, to refer to a group level.@@@2@606361@1
Access 2007+ uses different description: 'Use a number, not a string, to refer
to a group level.@@@2@1@6361@1'

Access 2003+

2464

There is no sorting or grouping field or expression defined for the group level
number you used.@A valid group level number can be from 0 (for the first field
or expression you sort or group on) through 9 (for the tenth). Count the group
levels in the report starting with zero.@@1@@1 Access 2007+ uses different
description: 'There is no sorting or grouping field or expression defined for the
group level number you used.@A valid group level number can be from 0 (for
the first field or expression you sort or group on) through 9 (for the tenth).
Count the group levels in the report starting with zero.@@1@@@1'

Access 2003+

2465

Microsoft Office Access can't find the field '|' referred to in your
expression.@You may have misspelled the field name, or the field may have
been renamed or deleted.@@1@411730@1 Access 2007+ uses different
description: 'Microsoft Office Access can't find the field '|' referred to in your
expression.@You may have misspelled the field name, or the field may have
been renamed or deleted.@@1@1@11730@1' Access 2010+ uses different
description: 'Microsoft Access can't find the field '|1' referred to in your
expression.@You may have misspelled the field name, or the field may have
been renamed or deleted.@@1@1@11730@1'

Access 2003+

2466

The expression you entered has an invalid reference to the Dynaset
property.@For example, you may have used the Dynaset property with a form
that isn't based on a table or query.@@1@@1 Access 2007+ uses different
description: 'The expression you entered has an invalid reference to the
Dynaset property.@For example, you may have used the Dynaset property with
a form that isn't based on a table or query.@@1@@@1'

Access 2003+

2467

The expression you entered refers to an object that is closed or doesn't
exist.@For example, you may have assigned a form to a Form object variable,
closed the form, and then referred to the object variable.@@1@@1 Access
2007+ uses different description: 'The expression you entered refers to an
object that is closed or doesn't exist.@For example, you may have assigned a
form to a Form object variable, closed the form, and then referred to the object
variable.@@1@@@1'

Access 2003+

2468

The value you entered for the interval, number, or date argument in the function
is invalid.@Check the argument to make sure that you entered it correctly. For
more information on valid argument values, search the Help index for 'DatePart
function,' 'DateAdd function,' or 'DateDiff function'.@@1@@1 Access 2007+
uses different description: 'The value you entered for the interval, number, or
date argument in the function is invalid.@Check the argument to make sure that
you entered it correctly. For more information on valid argument values, search
the Help index for 'DatePart function,' 'DateAdd function,' or 'DateDiff
function'.@@1@@@1'

Access 2003+

2469 The expression |2 you entered in the form control's ValidationRule property
contains the error |1.@Microsoft Office Access can't parse the ValidationRule

Access 2003+



expression you entered.For example, if you enter the expression =MyFunction()
in the ValidationRule property, and the function MyFunction doesn't exist,
Microsoft Office Access displays the following message: Unknown function
name in validation rule: 'MyFunction'.@To help you create expressions as
arguments in Visual Basic, use the Expression Builder. For more information,
search the Help index for 'Expression Builder'.@1@111805@1 Access 2007+
uses different description: 'The expression |2 you entered in the form control's
ValidationRule property contains the error |1.@Microsoft Office Access can't
parse the ValidationRule expression you entered.For example, if you enter the
expression =MyFunction() in the ValidationRule property, and the function
MyFunction doesn't exist, Microsoft Office Access displays the following
message: Unknown function name in validation rule: 'MyFunction'.@To help
you create expressions as arguments in Visual Basic, use the Expression
Builder. For more information, search the Help index for 'Expression
Builder'.@1@1@11805@1' Access 2010+ uses different description: 'The
expression |2 you entered in the form control's ValidationRule property contains
the error |1.@Microsoft Access can't parse the ValidationRule expression you
entered.For example, if you enter the expression =MyFunction() in the
ValidationRule property, and the function MyFunction doesn't exist, Microsoft
Access displays the following message: Unknown function name in validation
rule: 'MyFunction'.@To help you create expressions as arguments in Visual
Basic, use the Expression Builder. For more information, search the Help index
for 'Expression Builder'.@1@1@11805@1'

2470

There is a(n) '|' in the form control's ValidationRule property.@To help you
create expressions as arguments in Visual Basic, use the Expression Builder.
For more information, search the Help index for 'Expression
Builder'.@@1@111805@1 Access 2007+ uses different description: 'There is
a(n) '|' in the form control's ValidationRule property.@To help you create
expressions as arguments in Visual Basic, use the Expression Builder. For more
information, search the Help index for 'Expression
Builder'.@@1@1@11805@1'

Access 2003+

2471

The expression you entered as a query parameter produced this error:
'|'@@@2@611805@1 Access 2007+ uses different description: 'The
expression you entered as a query parameter produced this error:
'|'@@@2@1@11805@1'

Access 2003+

2472

The LinkMasterFields property setting has produced this error:
'|'@@@2@603990@1 Access 2007+ uses different description: 'The
LinkMasterFields property setting has produced this error:
'|'@@@2@1@3990@1'

Access 2003+

2473

The expression |2 you entered as the event property setting produced the
following error: |1.@* The expression may not result in the name of a macro,
the name of a user-defined function, or [Event Procedure]. * There may have
been an error evaluating the function, event, or macro.@@1@@1 Access
2007+ uses different description: 'The expression |2 you entered as the event
property setting produced the following error: |1.@* The expression may not
result in the name of a macro, the name of a user-defined function, or [Event
Procedure]. * There may have been an error evaluating the function, event, or
macro.@@1@@@1'

Access 2003+

2474

The expression you entered requires the control to be in the active
window.@Try one of the following: * Open or select a form or report
containing the control. * Create a new control in the active window, and try the
operation again.@@1@@1 Access 2007+ uses different description: 'The
expression you entered requires the control to be in the active window.@Try
one of the following: * Open or select a form or report containing the control. *
Create a new control in the active window, and try the operation
again.@@1@@@1'

Access 2003+



2475

You entered an expression that requires a form to be the active
window.@@@1@5601@1 Access 2007+ uses different description: 'You
entered an expression that requires a form to be the active
window.@@@1@2@5601@1'

Access 2003+

Error Code Error Description Supported Versions

2476

You entered an expression that requires a report to be the active
window.@@@1@5603@1 Access 2007+ uses different description: 'You
entered an expression that requires a report to be the active
window.@@@1@2@5603@1'

Access 2003+

2477

You entered an invalid objecttype value '|' in an If TypeOf object Is objecttype
condition of an If...Then...Else statement.@The objecttype can be any one of
the following: BoundObjectFrame, CheckBox, ComboBox, CommandButton,
Label, Line, ListBox, UnboundObjectFrame, OptionButton, OptionGroup,
PageBreak, Rectangle, Subform, Subreport, TextBox, ToggleButton,
ImageControl, or OLEControl.@@1@@1 Access 2007+ uses different
description: 'You entered an invalid objecttype value '|' in an If TypeOf object
Is objecttype condition of an If...Then...Else statement.@The objecttype can be
any one of the following: BoundObjectFrame, CheckBox, ComboBox,
CommandButton, Label, Line, ListBox, UnboundObjectFrame, OptionButton,
OptionGroup, PageBreak, Rectangle, Subform, Subreport, TextBox,
ToggleButton, ImageControl, or OLEControl.@@1@@@1'

Access 2003+

2478

Microsoft Office Access doesn't allow you to use this method in the current
view.@Most methods, including the SetFocus and Requery methods, can't be
used in form or report Design view.@@2@2015551@1 Access 2007+ uses
different description: 'Microsoft Office Access doesn't allow you to use this
method in the current view.@Most methods, including the SetFocus and
Requery methods, can't be used in form or report Design
view.@@2@4@2015551@1' Access 2010+ uses different description:
'Microsoft Access doesn't allow you to use this method in the current
view.@Most methods, including the SetFocus and Requery methods, can't be
used in form or report Design view.@@2@4@2015551@1'

Access 2003+

2479

The event procedure '|' can't be a Function procedure; it must be a Sub
procedure.@If you want to run a Function procedure when an event occurs, try
one of the following: * Set the event property to the name of a macro
containing a RunCode action that runs the Function procedure. * Set the event
property to =FunctionName().@@1@@1 Access 2007+ uses different
description: 'The event procedure '|' can't be a Function procedure; it must be a
Sub procedure.@If you want to run a Function procedure when an event
occurs, try one of the following: * Set the event property to the name of a
macro containing a RunCode action that runs the Function procedure. * Set the
event property to =FunctionName().@@1@@@1'

Access 2003+

2480

You referred to a property by a numeric argument that isn't one of the property
numbers in the collection.@Check the property numbers in the
collection.@@1@@1 Access 2007+ uses different description: 'You referred
to a property by a numeric argument that isn't one of the property numbers in
the collection.@Check the property numbers in the collection.@@1@@@1'

Access 2003+

2481
You can't set a value while a document is in Print Preview.@@@1@@1
Access 2007+ uses different description: 'You can't set a value while a
document is in Print Preview.@@@1@@@1'

Access 2003+

2482 Microsoft Office Access can't find the name '|' you entered in the
expression.@You may have specified a control that wasn't on the current object
without specifying the correct form or report context.@To refer to a control on
another form or report, precede the control name with the name of a collection,
usually either Forms or Reports, and the name of the form or report to which
the control belongs. For example, Forms![Products]![Units In Stock].@1@@1
Access 2007+ uses different description: 'Microsoft Office Access can't find

Access 2003+



the name '|' you entered in the expression.@You may have specified a control
that wasn't on the current object without specifying the correct form or report
context.@To refer to a control on another form or report, precede the control
name with the name of a collection, usually either Forms or Reports, and the
name of the form or report to which the control belongs. For example, Forms!
[Products]![Units In Stock].@1@@@1' Access 2010+ uses different
description: 'Microsoft Access cannot find the name '|1' you entered in the
expression.@You may have specified a control that wasn't on the current object
without specifying the correct form or report context.@To refer to a control on
another form or report, precede the control name with the name of a
collection.This is usually either Forms or Reports, and the name of the form or
report to which the control belongs. For example, Forms![Products]![Units In
Stock].@1@@@1'

2483

You can't move to a previous control when only one control has had the
focus.@Use the PreviousControl property only after you've moved the focus to
a second control.@@1@607144@1 Access 2007+ uses different description:
'You can't move to a previous control when only one control has had the
focus.@Use the PreviousControl property only after you've moved the focus to
a second control.@@1@1@7144@1'

Access 2003+

2484 There is no active datasheet.@@@1@@1 Access 2007+ uses different
description: 'There is no active datasheet.@@@1@@@1' Access 2003+

2485

Microsoft Office Access can't find the macro '|.'@The macro (or its macro
group) doesn't exist, or the macro is new but hasn't been saved. Note that when
you enter the macrogroupname.macroname syntax in an argument, you must
specify the name the macro's macro group was last saved
under.@@1@210183@1 Access 2007+ uses different description: 'Microsoft
Office Access can't find the object '|.'@If '|' is a new macro or macro group,
make sure you have saved it and that you have typed its name
correctly.@@1@1@10183@1' Access 2010+ uses different description:
'Microsoft Access cannot find the object '|1.'@If '|1' is a new macro or macro
group, make sure you have saved it and that you have typed its name
correctly.@@1@1@10183@1'

Access 2003+

2486

You can't carry out this action at the present time.@You tried to run a macro or
used the DoCmd object in Visual Basic to carry out an action. However,
Microsoft Office Access is performing another activity that prevents this action
from being carried out now. For example, no actions on a form can be carried
out while Microsoft Office Access is repainting a control or calculating an
expression.@Carry out the action later.@1@@1 Access 2007+ uses different
description: 'You can't carry out this action at the present time.@You tried to
run a macro or used the DoCmd object in Visual Basic to carry out an action.
However, Microsoft Office Access is performing another activity that prevents
this action from being carried out now. For example, no actions on a form can
be carried out while Microsoft Office Access is repainting a control or
calculating an expression.@Carry out the action later.@1@@@1' Access
2010+ uses different description: 'You can't carry out this action at the present
time.@You tried to run a macro or used the DoCmd object in Visual Basic to
carry out an action. However, Microsoft Access is performing another activity
that prevents this action from being carried out now. For example, no actions on
a form can be carried out while Microsoft Access is repainting a control or
calculating an expression.@Carry out the action later.@1@@@1'

Access 2003+

2487 The Object Type argument for the action or method is blank or invalid.@* For
a Close, GoToRecord, or RepaintObject action, enter values for both
arguments, or leave both blank to perform the action on the active object. * For
a DeleteObject, Rename, or CopyObject action, enter values for both
arguments, or leave both blank to perform the action on the object currently
selected in the Database window. * For a SendObject or OutputTo action, enter
values for both arguments, or leave the Object Name argument blank if you

Access 2003+



want the action performed on the active object of the specified object type. * If
you're using a method with the DoCmd object, use an intrinsic constant that
equates to a valid object type or the corresponding numeric value for the
argument name.@@1@612276@1 Access 2007+ uses different description:
'The Object Type argument for the action or method is blank or invalid.@* For
a Close, GoToRecord, SearchForRecord or RepaintObject action, enter values
for both arguments, or leave both blank to perform the action on the active
object. * For a DeleteObject, Rename, or CopyObject action, enter values for
both arguments, or leave both blank to perform the action on the object
currently selected in the Navigation Pane. * For a SendObject or OutputTo
action, enter values for both arguments, or leave the Object Name argument
blank if you want the action performed on the active object of the specified
object type. * If you're using a method with the DoCmd object, use an intrinsic
constant that equates to a valid object type or the corresponding numeric value
for the argument name.@@1@1@12276@1'

2488

You can't use the ApplyFilter action on this window.@* You tried to use the
ApplyFilter action or method, but you didn't apply the filter to a table, query,
form, or report. * You may have applied the filter to a form, but the form wasn't
open in Form or Datasheet view. * You may have applied the filter to a report
but didn't use the ApplyFilter action in a macro specified by the OnOpen
property setting.@Use the SelectObject action or method to select the table,
query, form, or report before applying the filter.@1@603041@1 Access 2007+
uses different description: 'You can't use the ApplyFilter action on this
window.@* You tried to use the ApplyFilter action or method, but you didn't
apply the filter to a table, query, form, or report. * You may have applied the
filter to a form, but the form wasn't open in Form or Datasheet view. * You may
have applied the filter to a report but didn't use the ApplyFilter action in a
macro specified by the OnOpen property setting.@Use the SelectObject action
or method to select the table, query, form, or report before applying the
filter.@1@1@3041@1'

Access 2003+

2489

The object '|' isn't open.@* The macro you are running (directly or indirectly)
contains a GoToRecord, RepaintObject, or SelectObject action, but the Object
Name argument names an object that is closed. * The objectname argument for
the GoToRecord, RepaintObject, or SelectObject method names an object that
is closed.@Use one of the Open actions or methods to open the object so that
you can carry out the desired action.@1@@1 Access 2007+ uses different
description: 'The object '|' isn't open.@* The macro you are running (directly
or indirectly) contains a GoToRecord, RepaintObject, or SelectObject action,
but the Object Name argument names an object that is closed. * The
objectname argument for the GoToRecord, RepaintObject, or SelectObject
method names an object that is closed.@Use one of the Open actions or
methods to open the object so that you can carry out the desired
action.@1@@@1'

Access 2003+

2491 The action or method is invalid because the form or report isn't bound to a table
or query.@You tried to use the ApplyFilter action or method. However, the
form or report you applied the filter to is not based on a table or query, so the
form or report doesn't have any records to apply a filter to.@Use the
SelectObject action or method to select the desired form or report before you
run the ApplyFilter action. To base a form or report on a table or query, open
the form or report in Design view, and enter the table or query name in the
RecordSource property.@1@603041@1 Access 2007+ uses different
description: 'The action or method is invalid because the form or report isn't
bound to a table or query.@You tried to use the ApplyFilter or
SearchForRecord action or method. However, the form or report you applied
the filter to is not based on a table or query, so the form or report doesn't have
any records to apply a filter to.@Use the SelectObject action or method to
select the desired form or report before you run the ApplyFilter action. To base
a form or report on a table or query, open the form or report in Design view,

Access 2003+



and enter the table or query name in the RecordSource
property.@1@1@3041@1'

2492

Microsoft Office Access can't find the macro '|2' in the macro group '|1.'@You
used the macrogroupname.macroname syntax to specify a macro. You then
tried to run the macro (directly or indirectly), or you used the RunMacro
method to run the macro. However, the macro you specified isn't in this macro
group.@Create the macro in the macro group, specify the correct macro group,
or specify the correct macro name.@1@611313@1 Access 2007+ uses
different description: 'Microsoft Office Access can't find the macro '|2' in the
macro group '|1.'@You used the macrogroupname.macroname syntax to specify
a macro. You then tried to run the macro (directly or indirectly), or you used the
RunMacro method to run the macro. However, the macro you specified isn't in
this macro group.@Create the macro in the macro group, specify the correct
macro group, or specify the correct macro name.@1@1@11313@1' Access
2010+ uses different description: 'Microsoft Access can't find the macro '|2' in
the macro group '|1.'@You used the macrogroupname.macroname syntax to
specify a macro. You then tried to run the macro (directly or indirectly), or you
used the RunMacro method to run the macro. However, the macro you
specified isn't in this macro group.@Create the macro in the macro group,
specify the correct macro group, or specify the correct macro
name.@1@1@11313@1'

Access 2003+

2493
This action requires an Object Name argument.@@@1@@1 Access 2007+
uses different description: 'This action requires an Object Name
argument.@@@1@@@1'

Access 2003+

2494

The action or method requires a Form Name argument.@You tried to use the
OpenForm action or method, but you left the Form Name argument blank.@In
the Form Name argument, enter the name of a form in the current
database.@1@611313@1 Access 2007+ uses different description: 'The
action or method requires a Form Name argument.@You tried to use the
OpenForm action or method, but you left the Form Name argument blank.@In
the Form Name argument, enter the name of a form in the current
database.@1@1@11313@1'

Access 2003+

2495

The action or method requires a Table Name argument.@You tried to use the
OpenTable, TransferSpreadsheet, or TransferText action or method, but you left
the Table Name argument blank.@In the Table Name argument, enter the name
of a table that is in the current database.@1@@1 Access 2007+ uses different
description: 'The action or method requires a Table Name argument.@You
tried to use the OpenTable, TransferSpreadsheet, or TransferText action or
method, but you left the Table Name argument blank.@In the Table Name
argument, enter the name of a table that is in the current database.@1@@@1'

Access 2003+

2496

The action or method requires a Query Name argument.@You tried to use the
OpenQuery action or method, but you left the Query Name argument
blank.@In the Query Name argument, enter a query name.@1@@1 Access
2007+ uses different description: 'The action or method requires a Query
Name argument.@You tried to use the OpenQuery action or method, but you
left the Query Name argument blank.@In the Query Name argument, enter a
query name.@1@@@1'

Access 2003+

Error Code Error Description Supported Versions

2497

The action or method requires a Report Name argument.@You tried to use the
OpenReport action or method, but you left the Report Name argument
blank.@In the Report Name argument, enter the name of a report.@1@@1
Access 2007+ uses different description: 'The action or method requires a
Report Name argument.@You tried to use the OpenReport action or method,
but you left the Report Name argument blank.@In the Report Name argument,
enter the name of a report.@1@@@1'

Access 2003+



2498

An expression you entered is the wrong data type for one of the
arguments.@You tried to run a macro or use a method to carry out an action,
but an expression evaluated to the wrong data type. For example, for the Close
method you specified a string for the Object Type argument, but this argument
can be set only to certain intrinsic constants or their numeric
equivalents.@@1@@1 Access 2007+ uses different description: 'An
expression you entered is the wrong data type for one of the arguments.@You
tried to run a macro or use a method to carry out an action, but an expression
evaluated to the wrong data type. For example, for the Close method you
specified a string for the Object Type argument, but this argument can be set
only to certain intrinsic constants or their numeric equivalents.@@1@@@1'

Access 2003+

2499

You can't use the GoToRecord action or method on an object in Design
view.@Try one of the following: * Switch to Form or Datasheet view for a
form. * Switch to Datasheet view for a query or table. * If you are running a
macro or Visual Basic procedure containing an action that opens the object, set
the View argument to the correct view before you carry out the GoToRecord
action.@@2@603018@1 Access 2007+ uses different description: 'You can't
use the GoToRecord or SearchForRecord action or method on an object in
Design view.@Try one of the following: * Switch to Form or Datasheet view
for a form. * Switch to Datasheet view for a query or table. * If you are running
a macro or Visual Basic procedure containing an action that opens the object,
set the View argument to the correct view before you carry out the GoToRecord
action.@@2@1@3018@1'

Access 2003+

2500

You must enter a number greater than zero for a Repeat Count argument.@You
tried to use the RunMacro action or method, but you entered a value less than
zero (or an expression that evaluates to less than zero) in the Repeat Count
argument.@To run the macro once, leave this argument blank.@1@@1 Access
2007+ uses different description: 'You must enter a number greater than zero
for a Repeat Count argument.@You tried to use the RunMacro action or
method, but you entered a value less than zero (or an expression that evaluates
to less than zero) in the Repeat Count argument.@To run the macro once, leave
this argument blank.@1@@@1'

Access 2003+

2501

The | action was canceled.@You used a method of the DoCmd object to carry
out an action in Visual Basic, but then clicked Cancel in a dialog box. For
example, you used the Close method to close a changed form, then clicked
Cancel in the dialog box that asks if you want to save the changes you made to
the form.@@1@@1 Access 2007+ uses different description: 'The | action
was canceled.@You used a method of the DoCmd object to carry out an action
in Visual Basic, but then clicked Cancel in a dialog box. For example, you used
the Close method to close a changed form, then clicked Cancel in the dialog
box that asks if you want to save the changes you made to the
form.@@1@@@1'

Access 2003+

2502 The action or method requires a Macro Name argument.@* You tried to use the
RunMacro action or method, but you left the Macro Name argument blank. *
Microsoft Office Access tried to create a custom menu bar for a form or report,
but the Menu Macro Name argument of the AddMenu action is blank.@In the
Menu Macro Name argument, enter the name of a macro or macro group that is
in the current database.@1@@1 Access 2007+ uses different description:
'The action or method requires a Macro Name argument.@* You tried to use
the RunMacro action or method, but you left the Macro Name argument blank.
* Microsoft Office Access tried to create a custom menu bar for a form or
report, but the Menu Macro Name argument of the AddMenu action is
blank.@In the Menu Macro Name argument, enter the name of a macro or
macro group that is in the current database.@1@@@1' Access 2010+ uses
different description: 'The action or method requires a Macro Name
argument.@* You tried to use the RunMacro action or method, but you left the
Macro Name argument blank. * Microsoft Access tried to create a custom menu

Access 2003+



bar for a form or report, but the Menu Macro Name argument of the AddMenu
action is blank.@In the Menu Macro Name argument, enter the name of a
macro or macro group that is in the current database.@1@@@1'

2503

You can't use this action with the DoCmd object.@For a list of the actions that
the DoCmd object doesn't support and some alternatives to using these actions,
click Help. Any actions that aren't in this list can be used with the DoCmd
object.@@2@611313@1 Access 2007+ uses different description: 'You can't
use this action with the DoCmd object.@For a list of the actions that the
DoCmd object doesn't support and some alternatives to using these actions,
click Help. Any actions that aren't in this list can be used with the DoCmd
object.@@2@1@11313@1'

Access 2003+

2504

The action or method requires at least | argument(s).@You tried to run a macro
containing an action or used a method or action with the DoCmd object, but
you didn't set the required number of arguments. For example, if you use the
MoveSize action, you must set at least one of the four
arguments.@@1@611313@1 Access 2007+ uses different description: 'The
action or method requires at least | argument(s).@You tried to run a macro
containing an action or used a method or action with the DoCmd object, but
you didn't set the required number of arguments. For example, if you use the
MoveSize action, you must set at least one of the four
arguments.@@1@1@11313@1'

Access 2003+

2505

An expression in argument | has an invalid value.@You tried to run a macro or
used the DoCmd object in Visual Basic. The argument number above is the
position of the argument as it appears in the Macro window, the Action Failed
dialog box, or the Object Browser (if you're using the DoCmd object).@Try
one of the following: * Select a setting from the drop-down list box in each
argument. * Use an intrinsic constant equating to a valid object type. *
Substitute the correct corresponding expression.@1@611895@1 Access 2007+
uses different description: 'An expression in argument | has an invalid
value.@You tried to run a macro or used the DoCmd object in Visual Basic.
The argument number above is the position of the argument as it appears in the
Macro window, the Action Failed dialog box, or the Object Browser (if you're
using the DoCmd object).@Try one of the following: * Select a setting from the
drop-down list box in each argument. * Use an intrinsic constant equating to a
valid object type. * Substitute the correct corresponding
expression.@1@1@11895@1'

Access 2003+

2506

A value you entered for the Transfer Type argument is invalid.@An expression
in the Transfer Type argument doesn't evaluate to a valid numeric value.@Valid
values for the Transfer Type argument are as follows: * 0, 1, and 2 for the
TransferDatabase action. * 0, 1, and 2 for the TransferSpreadsheet action. * 0
through 6 for the TransferText action.@1@611313@1 Access 2007+ uses
different description: 'A value you entered for the Transfer Type argument is
invalid.@An expression in the Transfer Type argument doesn't evaluate to a
valid numeric value.@Valid values for the Transfer Type argument are as
follows: * 0, 1, and 2 for the TransferDatabase action. * 0, 1, and 2 for the
TransferSpreadsheet action. * 0 through 6 for the TransferText
action.@1@1@11313@1'

Access 2003+

2507

The | type isn't an installed database type or doesn't support the operation you
chose.@You used the TransferDatabase method, but an expression in the
databasetype argument doesn't evaluate to a valid database type for importing,
exporting, or linking. For information on valid database types, click
Help.@@2@604780@1 Access 2007+ uses different description: 'The | type
isn't an installed database type or doesn't support the operation you
chose.@You used the TransferDatabase method, but an expression in the
databasetype argument doesn't evaluate to a valid database type for importing,
exporting, or linking. For information on valid database types, click
Help.@@2@1@4780@1'

Access 2003+



2508

A value you entered for the spreadsheettype argument is invalid.@You used the
TransferSpreadsheet method, and an expression in the spreadsheettype
argument doesn't evaluate to a valid numeric value.@Valid values are 0, 2, 3, 4,
5, 6, 7, and 8. Note that 1 is an invalid value; you can't import or export to a
Lotus .wks format file.@1@604781@1 Access 2007+ uses different
description: 'A value you entered for the spreadsheettype argument is
invalid.@You used the TransferSpreadsheet method, and an expression in the
spreadsheettype argument doesn't evaluate to a valid numeric value.@Valid
values are 0, 2, 3, 4, 5, 6, 7, and 8. Note that 1 is an invalid value; you can't
import or export to a Lotus .wks format file.@1@1@4781@1'

Access 2003+

2509

The setting for the Range argument can't be longer than 255
characters.@@@1@604781@1 Access 2007+ uses different description:
'The setting for the Range argument can't be longer than 255
characters.@@@1@1@4781@1'

Access 2003+

2510

The expression you entered in the Specification Name argument exceeds the
64-character limit.@Select one of the existing specification names from the
argument list box when you use the TransferText action in a macro, or enter a
name in Visual Basic that follows Microsoft Office Access object-naming
rules.@@2@611734@1 Access 2007+ uses different description: 'The
expression you entered in the Specification Name argument exceeds the 64-
character limit.@Select one of the existing specification names from the
argument list box when you use the TransferText action in a macro, or enter a
name in Visual Basic that follows Microsoft Office Access object-naming
rules.@@2@1@11734@1' Access 2010+ uses different description: 'The
expression you entered in the Specification Name argument exceeds the 64-
character limit.@Select one of the existing specification names from the
argument list box when you use the TransferText action in a macro, or enter a
name in Visual Basic that follows Microsoft Access object-naming
rules.@@2@1@11734@1'

Access 2003+

2511

The action or method requires a Specification Name argument.@You tried to
use the TransferText action or method and you specified a Transfer Type
argument but left the Specification Name argument blank.@In the Specification
Name argument, enter an existing specification name from the argument list
box.@1@611313@1 Access 2007+ uses different description: 'The action or
method requires a Specification Name argument.@You tried to use the
TransferText action or method and you specified a Transfer Type argument but
left the Specification Name argument blank.@In the Specification Name
argument, enter an existing specification name from the argument list
box.@1@1@11313@1'

Access 2003+

2512

Microsoft Office Access can't parse the expression: '|'.@Click OK to return to
the action argument or conditional expression where this expression appears,
and then correct the syntax.@@1@@1 Access 2007+ uses different
description: 'Microsoft Office Access can't parse the expression: '|'.@Click OK
to return to the action argument or conditional expression where this expression
appears, and then correct the syntax.@@1@@@1' Access 2010+ uses
different description: 'Microsoft Access cannot parse the expression:
'|1'.@Click OK to return to the action argument or conditional expression where
this expression appears, and then correct the syntax.@@1@@@1'

Access 2003+

2513

The Macro Name argument can't be longer than 64 characters according to
Microsoft Office Access object-naming rules.@@@1@411734@1 Access
2007+ uses different description: 'The Macro Name argument can't be longer
than 64 characters according to Microsoft Office Access object-naming
rules.@@@1@1@11734@1' Access 2010+ uses different description: 'The
Macro Name argument can't be longer than 64 characters according to
Microsoft Access object-naming rules.@@@1@1@11734@1'

Access 2003+

2514 The action or method requires a Control Name argument.@You tried to use the
GoToControl action or method, but you left the control name blank.@In the

Access 2003+



Control Name argument, enter a control or field name from the active form or
datasheet.@1@611313@1 Access 2007+ uses different description: 'The
action or method requires a Control Name argument.@You tried to use the
GoToControl action or method, but you left the control name blank.@In the
Control Name argument, enter a control or field name from the active form or
datasheet.@1@1@11313@1'

2515

Microsoft Office Access can't open the macro '|' because it was saved using a
different version of Microsoft Office Access.@Re-create the macro in the
current version of Microsoft Office Access.@@1@@1 Access 2007+ uses
different description: 'Microsoft Office Access can't open the macro '|' because
it was saved using a different version of Microsoft Office Access.@Re-create
the macro in the current version of Microsoft Office Access.@@1@@@1'
Access 2010+ uses different description: 'Microsoft Access cannot open the
macro '|1' because it was saved using a different version of Microsoft
Access.@Re-create the macro in the current version of Microsoft
Access.@@1@@@1'

Access 2003+

2516

Microsoft Office Access can't find the module '|.'@You tried to use the
OpenModule action or method, but Microsoft Office Access can't find the
module you specified in the Module Name argument.@Enter a valid module
name from the current database.@1@@1 Access 2007+ uses different
description: 'Microsoft Office Access can't find the module '|.'@You tried to
use the OpenModule action or method, but Microsoft Office Access can't find
the module you specified in the Module Name argument.@Enter a valid
module name from the current database.@1@@@1' Access 2010+ uses
different description: 'Microsoft Access cannot find the module '|1.'@You
tried to use the OpenModule action or method, but Microsoft Access can't find
the module you specified in the Module Name argument.@Enter a valid
module name from the current database.@1@@@1'

Access 2003+

Error Code Error Description Supported Versions

2517

Microsoft Office Access can't find the procedure '|.'@* You may have used the
Run method in Visual Basic but entered an invalid procedure name, or you used
the Run method without first opening a database. * You tried to use the
OpenModule action or method, but you used an invalid procedure
name.@@1@@1 Access 2007+ uses different description: 'Microsoft Office
Access can't find the procedure '|.'@* You may have used the Run method in
Visual Basic but entered an invalid procedure name, or you used the Run
method without first opening a database. * You tried to use the OpenModule
action or method, but you used an invalid procedure name.@@1@@@1'
Access 2010+ uses different description: 'Microsoft Access cannot find the
procedure '|1.'@* You may have used the Run method in Visual Basic but
entered an invalid procedure name, or you used the Run method without first
opening a database. * You tried to use the OpenModule action or method, but
you used an invalid procedure name.@@1@@@1'

Access 2003+

2519
The database must be open for the SelectObject method to run.@You tried to
run a function in a library database, and the function contains the SelectObject
method.@@1@@1 Access 2007+ uses different description: ''

Access 2003

2520

The action or method requires a Module or Procedure Name argument.@You
tried to use the OpenModule action or method, but you didn't enter a name in
either the Module Name or the Procedure Name argument in the Macro
window.@Enter a valid name in one of these arguments.@1@@1 Access
2007+ uses different description: 'The action or method requires a Module or
Procedure Name argument.@You tried to use the OpenModule action or
method, but you didn't enter a name in either the Module Name or the
Procedure Name argument in the Macro window.@Enter a valid name in one of
these arguments.@1@@@1'

Access 2003+

2521 You have specified a Transfer Type that doesn't support the HTML Table Name
argument.@Leave the HTML Table Name argument blank unless you are using

Access 2003+



the Import HTML or Link HTML Transfer Types.@@1@@1 Access 2007+
uses different description: 'You have specified a Transfer Type that doesn't
support the HTML Table Name argument.@Leave the HTML Table Name
argument blank unless you are using the Import HTML or Link HTML Transfer
Types.@@1@@@1'

2522

The action or method requires a File Name argument.@You tried to use the
TransferSpreadsheet or TransferText action or method.@In the File Name
argument, enter a file name.@1@611313@1 Access 2007+ uses different
description: 'The action or method requires a File Name argument.@You tried
to use the TransferSpreadsheet or TransferText action or method.@In the File
Name argument, enter a file name.@1@1@11313@1'

Access 2003+

2523

The value you entered for the show argument is invalid.@You used the
ShowToolbar method.@Valid values for this argument are acToolbarYes,
acToolbarWhereApprop, and acToolbarNo, or the corresponding numeric
values 0, 1, and 2.@1@612446@1 Access 2007+ uses different description:
'The value you entered for the show argument is invalid.@You used the
ShowToolbar method.@Valid values for this argument are acToolbarYes,
acToolbarWhereApprop, and acToolbarNo, or the corresponding numeric
values 0, 1, and 2.@1@1@12446@1'

Access 2003+

2524

Microsoft Office Access can't invoke the application using the RunApp
action.@The path to the application is invalid, or a component of the
application is missing.@Check the path in Windows Explorer or File
Manager.@1@@1 Access 2007+ uses different description: 'Microsoft Office
Access can't invoke the application using the RunApp action.@The path to the
application is invalid, or a component of the application is missing.@Check the
path in Windows Explorer or File Manager.@1@@@1' Access 2010+ uses
different description: 'Microsoft Access can't invoke the application using the
RunApp action.@The path to the application is invalid, or a component of the
application is missing.@Check the path in Windows Explorer or File
Manager.@1@@@1'

Access 2003+

2525

A macro can call itself a maximum of 20 times.@Your macro contains a
RunMacro action that calls the same macro more than 20 times.@Use a
condition to stop the macro after it has been run 20 times, or call another macro
with the RunMacro action.@1@@1 Access 2007+ uses different description:
'A macro can call itself a maximum of 20 times.@Your macro contains a
RunMacro action that calls the same macro more than 20 times.@Use a
condition to stop the macro after it has been run 20 times, or call another macro
with the RunMacro action.@1@@@1' Access 2010+ uses different
description: 'Macros can only be called 19 times.@Your macro contains one or
more RunMacro actions that calls a macro more than 19 times.@Use an If
block to stop the macro after it has been run 19 times.@1@@@1'

Access 2003+

2526

The SendKeys action requires the Microsoft Office Access Utility Add-in to be
loaded.@Rerun Microsoft Office Access or Microsoft Office Setup to reinstall
Microsoft Office Access and the Microsoft Office Access Utility Add-
in.@@1@@1 Access 2007+ uses different description: 'The SendKeys action
requires the Microsoft Office Access Utility Add-in to be loaded.@Rerun
Microsoft Office Access or Microsoft Office Setup to reinstall Microsoft Office
Access and the Microsoft Office Access Utility Add-in.@@1@@185309@1'
Access 2010+ uses different description: 'The SendKeys action requires the
Microsoft Access Utility Add-in to be loaded.@Rerun Microsoft Access or
Microsoft Office Setup to reinstall Microsoft Access and the Microsoft Access
Utility Add-in.@@1@@185309@1'

Access 2003+

2527 Lotus .wks file formats aren't supported in the current version of Microsoft
Office Access.@Convert your .wks file to a more recent format, such as
.wk1.@@1@@1 Access 2007+ uses different description: 'Lotus .wks file
formats aren't supported in the current version of Microsoft Office
Access.@Convert your .wks file to a more recent format, such as

Access 2003+



.wk1.@@1@@@1' Access 2010+ uses different description: 'Lotus .wks file
formats aren't supported in the current version of Microsoft Access.@Convert
your .wks file to a more recent format, such as .wk1.@@1@@@1'

2528

The RunCommand macro action argument is missing, or you entered an invalid
command ID for the RunCommand method.@@@1@@1 Access 2007+ uses
different description: 'The RunCommand macro action argument is missing,
or you entered an invalid command ID for the RunCommand
method.@@@1@@@1'

Access 2003+

2529
The Toolbar argument can't be longer than 64 characters.@@@1@@1 Access
2007+ uses different description: 'The Toolbar argument can't be longer than
64 characters.@@@1@@@1'

Access 2003+

2530

The SelectObject method can't be used on a report that is currently
printing.@@@1@@1 Access 2007+ uses different description: 'The
SelectObject method can't be used on a report that is currently
printing.@@@1@@@1'

Access 2003+

2531

Your HTML file does not contain any tabular data that Microsoft Office Access
can import.@.@@1@@1 Access 2007+ uses different description: 'Your
HTML file does not contain any tabular data that Microsoft Office Access can
import.@.@@1@@@1' Access 2010+ uses different description: 'Your
HTML file does not contain any tabular data that Microsoft Access can
import.@.@@1@@@1'

Access 2003+

2532

Microsoft Office Access can't find the macro or sub procedure '|.'@The
specified macro, macro group, or sub procedure doesn't exist.@ Note that when
you enter the macrogroupname.macroname syntax in an argument, you must
specify the name the macro's macro group was last saved under.Also, ensure
that the referenced macro has been saved, or that the referenced sub procedure
expects 0 arguments.@1@@1 Access 2007+ uses different description:
'Microsoft Office Access can't find the macro or sub procedure '|.'@The
specified macro, macro group, or sub procedure doesn't exist.@ Note that when
you enter the macrogroupname.macroname syntax in an argument, you must
specify the name the macro's macro group was last saved under.Also, ensure
that the referenced macro has been saved, or that the referenced sub procedure
expects 0 arguments.@1@@@1' Access 2010+ uses different description:
'Microsoft Access cannot find the macro or sub procedure '|1.'@The specified
macro, macro group, or sub procedure doesn't exist.@ Note that when you enter
the macrogroupname.macroname syntax in an argument, you must specify the
name the macro's macro group was last saved under.Also, ensure that the
referenced macro has been saved, or that the referenced sub procedure expects
0 arguments.@1@@@1'

Access 2003+

2533

The ApplyFilter action requires that either the Filter Name or Where Condition
argument is set.@You tried to run a macro containing an ApplyFilter action, but
you didn't set the required arguments.@@1@611313@1 Access 2007+ uses
different description: 'The ApplyFilter action requires that either the Filter
Name or Where Condition argument is set.@You tried to run a macro
containing an ApplyFilter action, but you didn't set the required
arguments.@@1@1@11313@1'

Access 2003+

2534

The action or method requires a data access page Name argument.@You tried
to use the OpenDataAccessPage action or method, but you left the data access
page Name argument blank.@In the data access page Name argument, enter the
name of a data access page in the current database.@1@611313@1 Access
2007+ uses different description: 'The action or method requires a data access
page Name argument.@You tried to use the OpenDataAccessPage action or
method, but you left the data access page Name argument blank.@In the data
access page Name argument, enter the name of a data access page in the current
database.@1@1@11313@1'

Access 2003+



2535

The ApplyFilter action contains a Filter Name that cannot be applied.@The
filter name is not a valid argument in the ApplyFilter action in Client
Server.@@1@611313@1 Access 2007+ uses different description: 'The
ApplyFilter action contains a Filter Name that cannot be applied.@The filter
name is not a valid argument in the ApplyFilter action in Client
Server.@@1@1@11313@1'

Access 2003+

2536 Macros are disabled in this database.@@@1@@1 Access 2007+ uses
different description: '' Access 2003

2537 The feature '|' is not available while the database is opened in disabled
mode.@@@1@@@1 Access 2007+

Error Code Error Description Supported Versions
2538 The '|' macro action cannot be run in disabled mode.@@@1@@@1 Access 2007+

2539 The Name argument of the SetLocalVar macro action is a reserved name.
Please change the name argument of the SetLocalVar action. Access 2010+

2540

The file '|' you tried to replace is a Microsoft Office Access system file that is in
use and can't be replaced or deleted.@@@1@@1 Access 2007+ uses different
description: 'The file '|' you tried to replace is a Microsoft Office Access
system file that is in use and can't be replaced or deleted.@@@1@@@1'
Access 2010+ uses different description: 'The file '|1' you tried to replace is a
Microsoft Access system file that is being used and can't be replaced or
deleted.@@@1@@@1'

Access 2003+

2541

The contents of the Clipboard have been deleted and can't be pasted.@Some
applications do not put large objects on the Clipboard. Instead, they put a
pointer to the object on the Clipboard. The pointer may vanish before the paste
happens.@@1@@1 Access 2007+ uses different description: 'The contents
of the Clipboard have been deleted and can't be pasted.@Some applications do
not put large objects on the Clipboard. Instead, they put a pointer to the object
on the Clipboard. The pointer may vanish before the paste
happens.@@1@@@1'

Access 2003+

2542

Specify the database name in the command line so that Microsoft Office Access
can find the macro.@@@1@@1 Access 2007+ uses different description:
'Specify the database name in the command line so that Microsoft Office
Access can find the macro.@@@1@@@1' Access 2010+ uses different
description: 'Specify the database name in the command line so that Microsoft
Access can find the macro.@@@1@@@1'

Access 2003+

2543
You can't paste a database object onto itself.@@@1@@1 Access 2007+ uses
different description: 'You can't paste a database object onto
itself.@@@1@@@1'

Access 2003+

2544

Microsoft Office Access can't find the | you referenced in the Object Name
argument.@The macro you tried to run includes a SelectObject action with an
invalid name for the Object Name argument.@In the Database window, verify
the name of the object you want the macro to select. Then open the macro in
the Macro window and enter the correct name for the Object Name
argument.@2@603041@1 Access 2007+ uses different description: '' Access
2010+ uses different description: 'Microsoft Access cannot find the |1 you
referenced in the Object Name argument.@The macro you tried to run includes
a SelectObject action with an invalid name for the Object Name argument.@In
the Navigation Pane, verify the name of the object you want the macro to
select. Then open the macro in the Macro window and enter the correct name
for the Object Name argument.@2@1@3041@1'

Access 2010+

2545 The CopyObject action requires you to specify a different destination database
or a new name to copy from the current database.@The macro you are running
includes a CopyObject action.@Open the macro in the Macro window, and
select the CopyObject action. Enter a destination database or a new name in the
appropriate argument box.@1@603009@1 Access 2007+ uses different
description: 'The CopyObject action requires you to specify a different

Access 2003+



destination database or a new name to copy from the current database.@The
macro you are running includes a CopyObject action.@Open the macro in the
Macro window, and select the CopyObject action. Enter a destination database
or a new name in the appropriate argument box.@1@1@3009@1'

2546

Select a database object in the Database window before you run the macro
containing the | action.@@@2@603009@1 Access 2007+ uses different
description: 'Select a database object in the Navigation Pane before you run
the macro containing the | action.@@@2@1@3009@1'

Access 2003+

2547

The database '|' you tried to delete and replace is read-only and can't be deleted
or replaced.@Enter a different name for the new database.@@1@@1 Access
2007+ uses different description: 'The database '|' you tried to delete and
replace is read-only and can't be deleted or replaced.@Enter a different name
for the new database.@@1@@@1'

Access 2003+

2548

Microsoft Office Access can't run the Security Wizard because this database is
open in exclusive mode.@Do you want Microsoft Office Access to open the
database in shared mode and run the Security Wizard?@@19@@2 Access
2007+ uses different description: 'Microsoft Office Access can't run the
Security Wizard because this database is open in exclusive mode.@Do you
want Microsoft Office Access to open the database in shared mode and run the
Security Wizard?@@19@@@2' Access 2010+ uses different description:
'Microsoft Access can't run the Security Wizard because this database is open in
exclusive mode.@Do you want Microsoft Access to open the database in
shared mode and run the Security Wizard?@@19@@@2'

Access 2003+

2549

Microsoft Office Access can't delete |1 after compacting it. The compacted
database has been named |2.@If you compact a database using the same name,
Microsoft Office Access creates a new compacted database and then deletes the
original database. In this case, however, the original database wasn't deleted
because it is read-only.@If you can, remove the read-only status, delete the
original database, and then rename the new database using the original name. If
you can't remove the read-only status, inform your workgroup
administrator.@1@310299@1 Access 2007+ uses different description:
'Microsoft Office Access can't delete |1 after compacting it. The compacted
database has been named |2.@If you compact a database using the same name,
Microsoft Office Access creates a new compacted database and then deletes the
original database. In this case, however, the original database wasn't deleted
because it is read-only.@If you can, remove the read-only status, delete the
original database, and then rename the new database using the original name. If
you can't remove the read-only status, inform your workgroup
administrator.@1@1@10299@1' Access 2010+ uses different description:
'Microsoft Access can't delete |1 after compacting it. The compacted database
has been named |2.@If you compact a database using the same name, Microsoft
Access creates a new compacted database and then deletes the original
database. In this case, however, the original database wasn't deleted because it
is read-only.@If you can, remove the read-only status, delete the original
database, and then rename the new database using the original name. If you
can't remove the read-only status, inform your workgroup
administrator.@1@1@10299@1'

Access 2003+

2550 Microsoft Office Access can't delete |1 after encoding it. The encoded database
has been named |2.@If you encode a database using the same name, Microsoft
Office Access creates a new encoded database, and then deletes the original
database. In this case, however, the original database can't be deleted because it
is read-only.@If you can, remove the read-only status, delete the original
database, and then rename the new database using the original name. If you
can't remove the read-only status, inform your workgroup
administrator.@1@310299@1 Access 2007+ uses different description:
'Microsoft Office Access can't delete |1 after encoding it. The encoded database
has been named |2.@If you encode a database using the same name, Microsoft

Access 2003+



Office Access creates a new encoded database, and then deletes the original
database. In this case, however, the original database can't be deleted because it
is read-only.@If you can, remove the read-only status, delete the original
database, and then rename the new database using the original name. If you
can't remove the read-only status, inform your workgroup
administrator.@1@1@10299@1' Access 2010+ uses different description:
'Microsoft Access can't delete |1 after encoding it. The encoded database has
been named |2.@If you encode a database using the same name, Microsoft
Access creates a new encoded database, and then deletes the original database.
In this case, however, the original database can't be deleted because it is read-
only.@If you can, remove the read-only status, delete the original database, and
then rename the new database using the original name. If you can't remove the
read-only status, inform your workgroup administrator.@1@1@10299@1'

2551

Microsoft Office Access can't delete |1 after decoding it. The decoded database
has been named |2.@If you decode a database using the same name, Microsoft
Office Access creates a new decoded database, and then deletes the original
database. In this case, however, the original database can't be deleted because it
is read-only.@If you can, remove the read-only status, delete the original
database, and then rename the new database using the original name. If you
can't remove the read-only status, inform your workgroup
administrator.@1@310299@1 Access 2007+ uses different description:
'Microsoft Office Access can't delete |1 after decoding it. The decoded database
has been named |2.@If you decode a database using the same name, Microsoft
Office Access creates a new decoded database, and then deletes the original
database. In this case, however, the original database can't be deleted because it
is read-only.@If you can, remove the read-only status, delete the original
database, and then rename the new database using the original name. If you
can't remove the read-only status, inform your workgroup
administrator.@1@1@10299@1' Access 2010+ uses different description:
'Microsoft Access can't delete |1 after decoding it. The decoded database has
been named |2.@If you decode a database using the same name, Microsoft
Access creates a new decoded database, and then deletes the original database.
In this case, however, the original database can't be deleted because it is read-
only.@If you can, remove the read-only status, delete the original database, and
then rename the new database using the original name. If you can't remove the
read-only status, inform your workgroup administrator.@1@1@10299@1'

Access 2003+

2552

You can't encode a database that you didn't create or don't own.@See the owner
of the database or your workgroup administrator.@@1@@1 Access 2007+
uses different description: 'You can't encode a database that you didn't create
or don't own.@See the owner of the database or your workgroup
administrator.@@1@@@1'

Access 2003+

2553

You can't decode a database that you didn't create or don't own.@See the owner
of the database or your workgroup administrator.@@1@@1 Access 2007+
uses different description: 'You can't decode a database that you didn't create
or don't own.@See the owner of the database or your workgroup
administrator.@@1@@@1'

Access 2003+

2554

Can't find the database you specified, or you didn't specify a database at
all.@Specify a valid database name in the command line, and include a path if
necessary.@@1@110283@1 Access 2007+ uses different description: 'Can't
find the database you specified, or you didn't specify a database at all.@Specify
a valid database name in the command line, and include a path if
necessary.@@1@1@10283@1'

Access 2003+

2556 Microsoft Office Access can't run the Security Wizard because the database has
had a password set on it.@You will have to unset the database password by
choosing Tools|Security|Unset Database Password.@@1@@1 Access 2007+
uses different description: 'Microsoft Office Access can't run the Security
Wizard because the database uses a password.@Remove the database password

Access 2003+



by clicking Unset Database Password in the Database Tools group on the
Database Tools tab.@@1@@@1' Access 2010+ uses different description:
'Microsoft Access can't run the Security Wizard because the database uses a
password.@Remove the database password by clicking Unset Database
Password in the Database Tools group on the Database Tools tab.@@1@@@1'

2557

The database you tried to convert was either created in or was already
converted to the requested version of Microsoft Office Access.@@@1@@1
Access 2007+ uses different description: 'The database you tried to convert
was either created in or was already converted to the requested version of
Microsoft Office Access.@@@1@@@1' Access 2010+ uses different
description: 'The database you tried to convert was either created in or was
already converted to the requested version of Microsoft
Access.@@@1@@@1'

Access 2003+

2559

Microsoft Office Access was unable to refresh the linked table '|1' in database
'|2' during conversion.Try and refresh the links manually by using the Linked
Table Manager (Tools menu, Database Utilities submenu).. Access 2007+ uses
different description: 'Microsoft Office Access was unable to refresh the
linked table '|1' in database '|2' during conversion.Try to refresh the links
manually by using the Linked Table Manager command in the Database Tools
group on the Database Tools tab.' Access 2010+ uses different description:
'Microsoft Access was unable to refresh the linked table '|1' in database '|2'
during conversion.Try to refresh the links manually by using the Linked Table
Manager command in the Database Tools group on the Database Tools tab.'

Access 2003+

Error Code Error Description Supported Versions

2560

Microsoft Office Access is unable to load the Database
Properties.@@@1@@3 Access 2007+ uses different description: 'Microsoft
Office Access is unable to load the Database Properties.@@@1@@@3'
Access 2010+ uses different description: 'Microsoft Access is unable to load
the Database Properties.@@@1@@@3'

Access 2003+

2561

Microsoft Office Access can't display the Database Properties dialog
box.@@@1@@1 Access 2007+ uses different description: 'Microsoft Office
Access can't display the Database Properties dialog box.@@@1@@@1'
Access 2010+ uses different description: 'Microsoft Access can't display the
Database Properties dialog box.@@@1@@@1'

Access 2003+

2562

Microsoft Office Access is unable to save the Database
Properties.@@@1@@1 Access 2007+ uses different description: 'Microsoft
Office Access is unable to save the Database Properties.@@@1@@@1'
Access 2010+ uses different description: 'Microsoft Access is unable to save
the Database Properties.@@@1@@@1'

Access 2003+

2563

Microsoft Office Access can't load a dynamic-link library.@Run Setup to
reinstall Microsoft Office Access. If you want to preserve your security or
custom settings, back up the Microsoft Office Access workgroup information
file. For information on backing up files, search the Microsoft Windows Help
index for 'backing up files'.@@1@@3 Access 2007+ uses different
description: ''

Access 2003

2564

You can't hide the document '|' while it is open.@Close the database object first,
and then hide it.@@1@@1 Access 2007+ uses different description: 'You
can't hide the document '|' while it is open.@Close the database object first, and
then hide it.@@1@@@1'

Access 2003+

2565

You can't unhide the database object '|' while it is open.@Close the database
object first, and then unhide it.@@1@@1 Access 2007+ uses different
description: 'You can't unhide the database object '|' while it is open.@Close
the database object first, and then unhide it.@@1@@@1'

Access 2003+

2566 Microsoft Office Access is unable to set the application's icon to the file
'|'.@Make sure the file is a valid icon (.ico) file. If you're using Microsoft
Windows, you can also use .bmp files.@@1@@1 Access 2007+ uses different

Access 2003+



description: 'Microsoft Office Access is unable to set the application's icon to
the file '|'.@Make sure the file is a valid icon (.ico) file. If you're using
Microsoft Windows, you can also use .bmp files.@@1@@@1' Access 2010+
uses different description: 'Microsoft Access is unable to set the application's
icon to the file '|1'.@Make sure the file is a valid icon (.ico) file. If you're using
Microsoft Windows, you can also use .bmp files.@@1@@@1'

2567

Microsoft Office Access can't open or convert this previous version
database.@The database was created in an earlier version of Microsoft Office
Access. You don't have appropriate security permissions to open or convert
databases created in earlier versions.@@1@@1 Access 2007+ uses different
description: 'Microsoft Office Access can't open or convert this previous
version database.@The database was created in an earlier version of Microsoft
Office Access. You don't have appropriate security permissions to open or
convert databases created in earlier versions.@@1@@@1' Access 2010+ uses
different description: 'Microsoft Access can't open or convert this previous
version database.@The database was created in an earlier version of Microsoft
Access. You don't have appropriate security permissions to open or convert
databases created in earlier versions.@@1@@@1'

Access 2003+

2568

Microsoft Office Access can't undo this operation.@An object with the same
name already exists. Another user might have created an object named '|' after
you had performed this operation on an object with the same name.@@1@@1
Access 2007+ uses different description: 'Microsoft Office Access can't undo
this operation.@An object with the same name already exists. Another user
might have created an object named '|' after you had performed this operation
on an object with the same name.@@1@@@1' Access 2010+ uses different
description: 'Microsoft Access can't undo this operation.@An object with the
same name already exists. Another user might have created an object named '|'
after you had performed this operation on an object with the same
name.@@1@@@1'

Access 2003+

2569

Microsoft Office Access can't delete |1 after enabling it. The enabled database
has been named |2.@If you enable a database using the same name, Microsoft
Office Access creates a new enabled database and then deletes the original
database. In this case, however, the original database wasn't deleted because it
is read-only.@If you can, remove the read-only status, delete the original
database, and then rename the new database using the original name. If you
can't remove the read-only status, inform your workgroup
administrator.@1@@1 Access 2007+ uses different description: ''

Access 2003

2571

You can't modify objects created using an earlier version of Microsoft Office
Access.@To convert this database to the current version of Microsoft Office
Access, close the database, point to Database Utilities on the Tools menu, and
then click Convert Database.@@1@@1 Access 2007+ uses different
description: 'You cannot modify objects created in an earlier version of
Microsoft Office Access.@To convert this database to the current version of
Microsoft Office Access, close the database, click the Microsoft Office Button,
and then click Convert.@@1@@@1' Access 2010+ uses different
description: 'You cannot modify objects created in an earlier version of
Microsoft Access.@To convert this database to the current version of Microsoft
Access, close the database, click the File tabn, and then click
Convert.@@1@@@0'

Access 2003+

2572 This database is in an unexpected state; Microsoft Office Access can't open
it.@This database has been converted from a prior version of Microsoft Office
Access by using the DAO CompactDatabase method instead of the Convert
Database command on the Tools menu (Database Utilities submenu). This has
left the database in a partially converted state.@If you have a copy of the
database in its original format, use the Convert Database command on the Tools
menu (Database Utilities submenu) to convert it. If the original database is no
longer available, create a new database and import your tables and queries to

Access 2003+



preserve your data. Your other database objects can't be recovered.@1@@1
Access 2007+ uses different description: 'This database is in an unexpected
state and Microsoft Office Access cannot open it.@This database has been
converted from a prior version of Microsoft Office Access by using the DAO
CompactDatabase method instead of the Convert Database command (click the
Microsoft Office Button and then click Convert). Converting by using the DAO
CompactDatabase method has left the database in a partially converted
state.@If you have a copy of the database in its original format, click the
Microsoft Office Button and then click Convert to convert it. If the original
database is no longer available, create a new database and import your tables
and queries to preserve your data and try again. Your other database objects
cannot be recovered.@1@@@1' Access 2010+ uses different description:
'This database is in an unexpected state and Microsoft Access cannot open
it.@This database has been converted from a prior version of Microsoft Access
by using the DAO CompactDatabase method instead of the Convert Database
command (click the File tab and then click Convert). Converting by using the
DAO CompactDatabase method has left the database in a partially converted
state.@If you have a copy of the database in its original format, click the File
tab and then click Convert to convert it. If the original database is no longer
available, create a new database and import your tables and queries to preserve
your data and try again. Your other database objects cannot be
recovered.@1@@@1'

2573

This database is a replica created in a different version of Access. @You can
only convert this replica by synchronizing with its Design Master. @Convert
the Design Master of this replica set then synchronize the replica with the
Design Master.@1@@1 Access 2007+ uses different description: 'This
database is a replica created in a different version of Access. @You can only
convert this replica by synchronizing with its Design Master. @Convert the
Design Master of this replica set then synchronize the replica with the Design
Master.@1@@@1'

Access 2003+

2574

You can't create another Microsoft Office Access database with the same name
and location as an existing database.@You carried out the Make MDE File
command, but tried to give the new database the same extension as the old
one.@Accept the default .mde extension for your new MDE database.@1@@1
Access 2007+ uses different description: 'You can't create another Microsoft
Office Access database with the same name and location as an existing
database.@You carried out the Make MDE File command, but tried to give the
new database the same extension as the old one.@Accept the default .mde
extension for your new MDE database.@1@@@1' Access 2010+ uses
different description: 'You can't create another Microsoft Access database with
the same name and location as an existing database.@You carried out the Make
MDE File command, but tried to give the new database the same extension as
the old one.@Accept the default .mde extension for your new MDE
database.@1@@@1'

Access 2003+

2575

You can't create a Microsoft Office Access MDE database from a database
replica.@@@1@@1 Access 2007+ uses different description: 'You can't
create a Microsoft Office Access MDE database from a database
replica.@@@1@@@1' Access 2010+ uses different description: 'You can't
create a Microsoft Access MDE database from a database
replica.@@@1@@@1'

Access 2003+

2576 This database is a Microsoft Office Access 7.0/8.0/9.0 Design
Master/Replica.@If you click OK, the database you selected will be renamed to
|1 and then converted to |2. Everyone using a replica of this database will have
to upgrade to Microsoft Access 2000 after the next synchronization.@@4@@2
Access 2007+ uses different description: 'This database is a Microsoft Office
Access 7.0/8.0/9.0 Design Master/Replica.@If you click OK, the database you
selected will be renamed to |1 and then converted to |2. Everyone using a
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replica of this database will have to upgrade to Microsoft Access 2000 after the
next synchronization.@@4@@@2' Access 2010+ uses different description:
'This database is a Microsoft Access 7.0/8.0/9.0 Design Master/Replica.@If
you click OK, the database you selected will be renamed to |1 and then
converted to |2. Everyone using a replica of this database will have to upgrade
to Microsoft Access 2000 after the next synchronization.@@4@@@2'

2577

The database | is already open.@Close the database before carrying out the
Make MDE File command.@@1@@1 Access 2007+ uses different
description: 'The database | is already open.@Close the database before
carrying out the Make MDE File command.@@1@@@1'

Access 2003+

2578

Microsoft Office Access was unable to create an MDE database.@@@1@@1
Access 2007+ uses different description: 'Microsoft Office Access was unable
to create the .accde, .mde, or .ade file.@@@1@@@1' Access 2010+ uses
different description: 'Microsoft Access was unable to create the .accde, .mde,
or .ade file.@@@1@@@1'

Access 2003+

2579

Local forms, reports, macros, and modules in this replica will not be converted.
@To retain these objects, please be sure to import them into the Design Master
from the original replica.@@1@@1 Access 2007+ uses different description:
'Local forms, reports, macros, and modules in this replica will not be converted.
@To retain these objects, please be sure to import them into the Design Master
from the original replica.@@1@@@1'

Access 2003+

2580

The record source '|' specified on this form or report does not exist. @You
misspelled the name, or it was deleted or renamed in the current database, or it
exists in a different database.@In the Form or Report's Design view, display the
property sheet by clicking the Properties button, and then set the RecordSource
property to an existing table or query. @1@@1 Access 2007+ uses different
description: 'The record source '|' specified on this form or report does not
exist. @The name of the recordsource may be misspelled, the recordsource was
deleted or renamed, or the recordsource exists in a different database.@In the
Form or Report's Design view, display the property sheet by clicking the
Properties button, and then set the RecordSource property to an existing table
or query. @1@@@1' Access 2010+ uses different description: 'The record
source '|' specified on this form or report does not exist. @The name of the
recordsource may be misspelled, the recordsource was deleted or renamed, or
the recordsource exists in a different database.@In the Form or Report's Design
view or Layout view, display the property sheet by clicking the Properties
button, and then set the RecordSource property to an existing table or query.
@1@@@1'

Access 2003+

Error Code Error Description Supported Versions

2581

You must define a sort field or expression for the group header or footer in the
report you tried to preview or print.@@@1@208753@1 Access 2007+ uses
different description: 'You must define a sort field or expression for the group
header or footer in the report you tried to preview or
print.@@@1@1@8753@1'

Access 2003+

2582

You can't set the GroupInterval property to zero when the GroupOn property is
set to Interval.@Click Sorting and Grouping on the View menu and try one of
the following: * Change the GroupInterval property setting to a number higher
than zero. * Change the GroupOn property setting to Each Value.@@1@@1
Access 2007+ uses different description: 'You cannot set the GroupInterval
property to 0 when the GroupOn property is set to Interval.@Click the Sorting
and Grouping Design tab and try one of the following: * Change the
GroupInterval property setting to a number higher than 0. * Change the
GroupOn property setting to Each Value.@@1@@@1'

Access 2003+

2583 The ApplyFilter action or method can be carried out only from an Open macro
or Open event procedure.@* You may have tried to run a macro or procedure
containing the ApplyFilter action or method from a report property other than

Access 2003+



the OnOpen property. * You may have tried to run a macro or event procedure
on a report that is already open.@To use the ApplyFilter action in a report, set
the OnOpen property to the name of the macro, close the report, and then
reopen it.@1@603004@1 Access 2007+ uses different description: 'The
ApplyFilter action or method can be carried out only from an Open macro or
Open event procedure.@* You may have tried to run a macro or procedure
containing the ApplyFilter action or method from a report property other than
the OnOpen property. * You may have tried to run a macro or event procedure
on a report that is already open.@To use the ApplyFilter action in a report, set
the OnOpen property to the name of the macro, close the report, and then
reopen it.@1@1@3004@1'

2584

You can't use aggregate functions in a page header or footer.@The page header
or footer of the report you tried to preview contains a calculated control with an
aggregate function in its expression.@If you want to show the result of an
aggregate function in a page header or footer, create a hidden calculated control
in an appropriate section of the report. Then create an unbound text box in the
page header or footer. If you are running a macro, use the SetValue action to set
the unbound text box value to the value in the hidden control.@1@411839@1
Access 2007+ uses different description: 'You can't use aggregate functions in
a page header or footer.@The page header or footer of the report you tried to
preview contains a calculated control with an aggregate function in its
expression.@If you want to show the result of an aggregate function in a page
header or footer, create a hidden calculated control in an appropriate section of
the report. Then create an unbound text box in the page header or footer. If you
are running a macro, use the SetValue action to set the unbound text box value
to the value in the hidden control.@1@1@11839@1'

Access 2003+

2585

This action can't be carried out while processing a form or report event.@A
macro specified as the OnOpen, OnClose, OnFormat, OnRetreat, OnPage, or
OnPrint property setting contains an invalid action for the property.@When you
click OK, an Action Failed dialog box will display the name of the macro that
failed and its arguments.@1@611909@1 Access 2007+ uses different
description: 'This action can't be carried out while processing a form or report
event.@A macro specified as the OnOpen, OnLoad, OnClose, OnFormat,
OnRetreat, OnPage, or OnPrint property setting contains an invalid action for
the property.@When you click OK, an Action Failed dialog box will display the
name of the macro that failed and its arguments.@1@1@11909@1'

Access 2003+

2586

Microsoft Office Access changed the MoveLayout and NextRecord properties
to True from False.@The macro or Visual Basic function run by the OnFormat
property of one of the sections of the report set both the MoveLayout and
NextRecord properties to False. Having both properties set to False can make
the report print continuously.@Revise the macro or function so that it sets these
properties to the values you want.@1@604656@1 Access 2007+ uses
different description: 'Microsoft Office Access changed the MoveLayout and
NextRecord properties to True from False.@The macro or Visual Basic
function run by the OnFormat property of one of the sections of the report set
both the MoveLayout and NextRecord properties to False. Having both
properties set to False can make the report print continuously.@Revise the
macro or function so that it sets these properties to the values you
want.@1@1@4656@1' Access 2010+ uses different description: 'Microsoft
Access changed the MoveLayout and NextRecord properties to True from
False.@The macro or Visual Basic function run by the OnFormat property of
one of the sections of the report set both the MoveLayout and NextRecord
properties to False. Having both properties set to False can make the report
print continuously.@Revise the macro or function so that it sets these properties
to the values you want.@1@1@4656@1'

Access 2003+

2587 Microsoft Office Access can't complete the Output operation.@The Visual
Basic code you entered contains a syntax error or the Output procedures are not
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available.@Make sure there isn't a syntax error in your code. If the syntax is
correct, run Setup to reinstall Microsoft Office Access. If you want to preserve
your security or custom settings, back up the Microsoft Office Access
workgroup information file. For information on backing up files, search the
Microsoft Windows Help index for 'backing up files'.@1@@1 Access 2007+
uses different description: 'Microsoft Office Access can't complete the Output
operation.@The Visual Basic code you entered contains a syntax error or the
Output procedures are not available.@Make sure there isn't a syntax error in
your code. If the syntax is correct, run Setup to reinstall Microsoft Office
Access. If you want to preserve your security or custom settings, back up the
Microsoft Office Access workgroup information file. For information on
backing up files, search the Microsoft Windows Help index for 'backing up
files'.@1@@185309@1' Access 2010+ uses different description: 'Microsoft
Access can't complete the Output operation.@The Visual Basic code you
entered contains a syntax error or the Output procedures are not
available.@Make sure there isn't a syntax error in your code. If the syntax is
correct, run Setup to reinstall Microsoft Access. If you want to preserve your
security or custom settings, back up the Microsoft Access workgroup
information file. For information on backing up files, search the Microsoft
Windows Help index for 'backing up files'.@1@@185309@1'

2588
You must select a form to save as a report.@@@1@@1 Access 2007+ uses
different description: 'You must select a form to save as a
report.@@@1@@@1'

Access 2003+

2589

The expression '|' is invalid.@Aggregate functions are only allowed on output
fields of the Record Source. @@1@@1 Access 2007+ uses different
description: 'The expression '|' is invalid.@Aggregate functions are only
allowed on output fields of the Record Source. @@1@@@1'

Access 2003+

2590

The Var and VarP aggregate functions are not supported in an Access
project.@@@1@@1 Access 2007+ uses different description: 'The Var and
VarP aggregate functions are not supported in an Access
project.@@@1@@@1'

Access 2003+

2591
You can't change printer properties in the OnOpen event of a
report.@@@1@@1 Access 2007+ uses different description: 'You can't
change printer properties in the OnOpen event of a report.@@@1@@@1'

Access 2003+

2592 You cannot bind a hierarchical report to a DAO Recordset.@@@1@@1
Access 2007+ uses different description: '' Access 2003

2593
This feature is not available in an MDB.@@@1@@1 Access 2007+ uses
different description: 'This feature is not available in an MDB or
ACCDB.@@@1@@@1'

Access 2003+

2594
You cannot Filter By Form when form record source is a recordset
object.@@@1@@1 Access 2007+ uses different description: 'You cannot
Filter By Form when form record source is a recordset object.@@@1@@@1'

Access 2003+

2595

Microsoft Office Access cannot set this property when DefaultSize property is
set to True.@@@1@@1 Access 2007+ uses different description: 'Microsoft
Office Access cannot set this property when DefaultSize property is set to
True.@@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access cannot set this property when DefaultSize property is set to
True.@@@1@@@1'

Access 2003+

2596
Printer object is not available on subforms and subreports.@@@1@@1 Access
2007+ uses different description: 'Printer object is not available on subforms
and subreports.@@@1@@@1'

Access 2003+

2597

Unable to bind the report to the specified recordset because the shape does not
match the sorting and grouping specified on the report.@@@1@@1 Access
2007+ uses different description: 'Unable to bind the report to the specified
recordset because the shape does not match the sorting and grouping specified
on the report.@@@1@@@1'

Access 2003+



2598 Recordset property not available for natively bound reports in MDB
files.@@@1@@1 Access 2007+ uses different description: '' Access 2003

2599 Report view is not available for this report.@@@1@@@1 Access 2007+

2600
Verify the new password by retyping it in the Verify box and clicking
OK.@@@1@@1 Access 2007+ uses different description: 'Verify the new
password by retyping it in the Verify box and clicking OK.@@@1@@@1'

Access 2003+

Error Code Error Description Supported Versions

2601

You don't have permission to read '|.'@To read this object, you must have Read
Design permission for it. For more information on permissions and who can set
them, click Help.@@2@410222@1 Access 2007+ uses different description:
'You don't have permission to read '|.'@To read this object, you must have Read
Design permission for it. For more information on permissions and who can set
them, click Help.@@2@1@10222@1'

Access 2003+

2602

You don't have permission to modify '|.'@To modify this object, you must have
Modify Design permission for it. If the object is a table, you must also have
Delete Data and Update Data permissions for it. For more information on
permissions and who can set them, click Help.@@2@410222@1 Access
2007+ uses different description: 'You don't have permission to modify
'|.'@To modify this object, you must have Modify Design permission for it. If
the object is a table, you must also have Delete Data and Update Data
permissions for it. For more information on permissions and who can set them,
click Help.@@2@1@10222@1'

Access 2003+

2603

You don't have permission to run '|.'@To run this object, you must have
Open/Run permission for it. For more information on permissions and who can
set them, click Help.@@2@410222@1 Access 2007+ uses different
description: 'You don't have permission to run '|.'@To run this object, you must
have Open/Run permission for it. For more information on permissions and
who can set them, click Help.@@2@1@10222@1'

Access 2003+

2604

You can't view this object's permissions.@To view or change permissions for
this object, you must have Administer permission for it. For more information
on permissions and who can set them, click Help.@@2@410222@1 Access
2007+ uses different description: 'You can't view this object's
permissions.@To view or change permissions for this object, you must have
Administer permission for it. For more information on permissions and who
can set them, click Help.@@2@1@10222@1'

Access 2003+

2605

You can't remove this user account from group '|.'@* You may have tried to
remove a user account from the default Users group. Microsoft Office Access
automatically adds all users to the default Users group. To remove a user
account from the Users group, you must first delete the account. * You may
have tried to remove all users from the Admins group. There must be at least
one user in the Admins group.@@1@210212@1 Access 2007+ uses different
description: 'You can't remove this user account from group '|.'@* You may
have tried to remove a user account from the default Users group. Microsoft
Office Access automatically adds all users to the default Users group. To
remove a user account from the Users group, you must first delete the account.
* You may have tried to remove all users from the Admins group. There must
be at least one user in the Admins group.@@1@1@10212@1' Access 2010+
uses different description: 'You can't remove this user account from group
'|1.'@* You may have tried to remove a user account from the default Users
group. Microsoft Access automatically adds all users to the default Users group.
To remove a user account from the Users group, you must first delete the
account. * You may have tried to remove all users from the Admins group.
There must be at least one user in the Admins group.@@1@1@10212@1'

Access 2003+

2606 The object type is invalid.@@@1@@1 Access 2007+ uses different
description: 'The object type is invalid.@@@1@@@1' Access 2003+



2607

You don't have permission to cut '|.'@To cut this object, you must have Modify
Design permission for it. If the object is a table, you must also have Delete Data
permission for it. For more information on permissions and who can set them,
click Help.@@2@410222@1 Access 2007+ uses different description: 'You
don't have permission to cut '|.'@To cut this object, you must have Modify
Design permission for it. If the object is a table, you must also have Delete Data
permission for it. For more information on permissions and who can set them,
click Help.@@2@1@10222@1'

Access 2003+

2608

You don't have permission to copy '|.'@To copy this object, you must have
Read Design permission for it. If the object is a table, you must also have Read
Data permission for it. For more information on permissions and who can set
them, click Help.@@2@410222@1 Access 2007+ uses different description:
'You don't have permission to copy '|.'@To copy this object, you must have
Read Design permission for it. If the object is a table, you must also have Read
Data permission for it. For more information on permissions and who can set
them, click Help.@@2@1@10222@1'

Access 2003+

2609

You don't have permission to delete '|.'@To delete this object, you must have
Modify Design permission for it. If the object is a table, you must also have
Delete Data permission for it. For more information on permissions and who
can set them, click Help.@@2@410222@1 Access 2007+ uses different
description: 'You don't have permission to delete '|.'@To delete this object, you
must have Modify Design permission for it. If the object is a table, you must
also have Delete Data permission for it. For more information on permissions
and who can set them, click Help.@@2@1@10222@1'

Access 2003+

2610

You must enter a personal identifier (PID) consisting of at least 4 and no more
than 20 characters and digits.@Microsoft Office Access uses the combination
of the user or group name and the PID to identify the user or group. Note that
Microsoft Office Access hides the PID after you create it, so make sure to write
down the exact user or group account name and the PID entries. If you ever
have to re-create the account, you must supply the same name and PID
entries.@@1@@1 Access 2007+ uses different description: 'You must enter a
personal identifier (PID) consisting of at least 4 and no more than 20 characters
and digits.@Microsoft Office Access uses the combination of the user or group
name and the PID to identify the user or group. Note that Microsoft Office
Access hides the PID after you create it, so make sure to write down the exact
user or group account name and the PID entries. If you ever have to re-create
the account, you must supply the same name and PID entries.@@1@@@1'
Access 2010+ uses different description: 'You must enter a personal identifier
(PID) consisting of at least 4 and no more than 20 characters and
digits.@Microsoft Access uses the combination of the user or group name and
the PID to identify the user or group. Note that Microsoft Access hides the PID
after you create it, so make sure to write down the exact user or group account
name and the PID entries. If you ever have to re-create the account, you must
supply the same name and PID entries.@@1@@@1'

Access 2003+

2611

Microsoft Office Access can't find the workgroup file '|.'Would you like to use
the default workgroup file?@@@20@@1 Access 2007+ uses different
description: 'Microsoft Office Access can't find the workgroup file '|.'Would
you like to use the default workgroup file?@@@20@@@1' Access 2010+
uses different description: 'Microsoft Access can't find the workgroup file
'|1.'Would you like to use the default workgroup file?@@@20@@@1'

Access 2003+

2612

The account name is invalid.@For information about naming conventions,
click Help.@@2@210213@1 Access 2007+ uses different description: 'The
account name is invalid.@For information about naming conventions, click
Help.@@2@1@10213@1'

Access 2003+

2613 You don't have permission to rename '|.'@To rename a database object, you
must have Modify Design permission for the object. For more information on
permissions and who can set them, click Help.@@2@410222@1 Access

Access 2003+



2007+ uses different description: 'You don't have permission to rename
'|.'@To rename a database object, you must have Modify Design permission for
the object. For more information on permissions and who can set them, click
Help.@@2@1@10222@1'

2614

You don't have permission to insert this form into another form.@To insert a
form into another form as a subform, you must have Read Design permission
for the form being inserted. For more information on permissions and who can
set them, click Help.@@2@410222@1 Access 2007+ uses different
description: 'You don't have permission to insert this form into another
form.@To insert a form into another form as a subform, you must have Read
Design permission for the form being inserted. For more information on
permissions and who can set them, click Help.@@2@1@10222@1'

Access 2003+

2615

You don't have permission to change the owner of '|.'@To change the owner of
a database object, you must have Administer permission for it. For more
information on permissions and who can set them, click
Help.@@5@410222@1 Access 2007+ uses different description: 'You don't
have permission to change the owner of '|.'@To change the owner of a database
object, you must have Administer permission for it. For more information on
permissions and who can set them, click Help.@@5@1@10222@1'

Access 2003+

2616

You can't change permissions for '|.'@To change permissions for this object,
you must have Administer permission for it. For more information on
permissions and who can set them, click Help.@@5@410222@1 Access
2007+ uses different description: 'You can't change permissions for '|.'@To
change permissions for this object, you must have Administer permission for it.
For more information on permissions and who can set them, click
Help.@@5@1@10222@1'

Access 2003+

2617

You don't have permission to import, export, or link to '|.'@To import, export,
or link to this object, you must have Read Design and Read Data permissions
for it. For more information on permissions and who can set them, click
Help.@@2@410222@1 Access 2007+ uses different description: 'You don't
have permission to import, export, or link to '|.'@To import, export, or link to
this object, you must have Read Design and Read Data permissions for it. For
more information on permissions and who can set them, click
Help.@@2@1@10222@1'

Access 2003+

2618

You need to have the database open for exclusive use to set or unset the
database password.@To open the database exclusively, close the database, and
then reopen it using the Open command on the File menu. In the Open dialog
box, click the arrow to the right of the Open button, and then choose Open
Exclusive.@@1@@1 Access 2007+ uses different description: 'You must
have the database open for exclusive use to set or remove the database
password.@To open the database exclusively, close the database, and then
reopen it by clicking the Microsoft Office Button and using the Open
command. In the Open dialog box, click the arrow next to the Open button, and
then select Open Exclusive.@@1@@@1' Access 2010+ uses different
description: 'You must have the database open for exclusive use to set or
remove the database password.@To open the database exclusively, close the
database, and then reopen it by clicking the File tab and using the Open
command. In the Open dialog box, click the arrow next to the Open button, and
then select Open Exclusive.@@1@@@1'

Access 2003+

2619

You can't change permissions for '|' in a replica.@Permissions may only be
changed in the Design Master for the replica set.@@3@@1 Access 2007+ uses
different description: 'You can't change permissions for '|' in a
replica.@Permissions may only be changed in the Design Master for the replica
set.@@3@@@1'

Access 2003+

2620 The password you entered in the Old Password box is incorrect.@Please enter
the correct password for this account.@@1@@1 Access 2007+ uses different

Access 2003+



description: 'The password you entered in the Old Password box is
incorrect.@Please enter the correct password for this account.@@1@@@1'

Error Code Error Description Supported Versions

2621
That password isn't valid.@You may have used a semicolon.@@1@@1 Access
2007+ uses different description: 'That password isn't valid.@You may have
used a semicolon.@@1@@@1'

Access 2003+

2622

You can't save '|' because it is read-only.@To save, switch to Design View and
choose Save As from the File menu.@@3@@1 Access 2007+ uses different
description: 'You cannot save '|' because it is read-only.@To save, switch to
Design View, click the Microsoft Office Button, point to Save As, and enter a
new name.@@3@@@1' Access 2010+ uses different description: 'You
cannot save '|' because it is read-only.@To save, switch to Design View, click
the File tab, point to Save As, and enter a new name.@@3@@@0'

Access 2003+

2623
Saving the database to the previous version of Access will create a new
database that contains none of the security information that you have set.Are
you sure you want to proceed? Access 2007+ uses different description: ''

Access 2003

2624
An error has occurred while changing workgroup database.@@@1@@1
Access 2007+ uses different description: 'An error has occurred while
changing workgroup database.@@@1@@@1'

Access 2003+

2625

Workgroup Administrator couldn't create the workgroup information file.Make
sure that you have specified a valid path and file name, that you have adequate
permissions to create the file, and that you have enough disk space on the
destination drive. (|)@@@1@@1 Access 2007+ uses different description:
'Workgroup Administrator couldn't create the workgroup information file.Make
sure that you have specified a valid path and file name, that you have adequate
permissions to create the file, and that you have enough disk space on the
destination drive. (|)@@@1@@@1'

Access 2003+

2626
Reserved error (|); there is no message for this error.@@@1@@1 Access
2007+ uses different description: 'Reserved error (|); there is no message for
this error.@@@1@@@1'

Access 2003+

2627 There's not enough disk space.@@@1@@1 Access 2007+ uses different
description: 'There's not enough disk space.@@@1@@@1' Access 2003+

2628 One of your parameters is invalid.@@@1@@1 Access 2007+ uses different
description: 'One of your parameters is invalid.@@@1@@@1' Access 2003+

2629
Could not open workgroup file. This is a directory.@@@1@@1 Access 2007+
uses different description: 'Could not open workgroup file. This is a
directory.@@@1@@@1'

Access 2003+

2630 The specified path is invalid.@@@1@@1 Access 2007+ uses different
description: 'The specified path is invalid.@@@1@@@1' Access 2003+

2631 The specified path is too long.@@@1@@1 Access 2007+ uses different
description: 'The specified path is too long.@@@1@@@1' Access 2003+

2632 Change Workgroup cannot proceed without your Name, PIN, and a path to the
new Workgroup Information File. Access 2003+

2633

Microsoft Office Access cannot change the password for the logon account '|'
because the current connection is using Microsoft Windows NT integrated
security.@@@1@@1 Access 2007+ uses different description: 'Microsoft
Office Access cannot change the password for the logon account '|' because the
current connection is using Microsoft Windows NT integrated
security.@@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access cannot change the password for the logon account '|1' because the
current connection is using Microsoft Windows NT integrated
security.@@@1@@@1'

Access 2003+

2634
The new password doesn't match the verify password value.@@@1@@1
Access 2007+ uses different description: 'The new password doesn't match
the verify password value.@@@1@@@1'

Access 2003+



2635

Microsoft Office Access is unable to change the password because the old
password doesn't match the password of the currently logged in user. Access
2010+ uses different description: 'Microsoft Access is unable to change the
password because the old password doesn't match the password of the currently
logged in user.'

Access 2003+

2636 Workgroup file already exists. Access 2003+

2637

Unable to start SQL Server service.To restart the SQL Server service, double
click on the SQL Server System Manager icon in the system tray and click
Start/Continue.@Once the service is started, point to Connection on the File
menu in Access and click OK.@@19@@2 Access 2007+ uses different
description: 'Unable to start SQL Server service. To restart the SQL Server
service, double-click the SQL Server System Manager icon in the system tray
and click Start/Continue.@When the service is started, in Microsoft Office
Access, click the Microsoft Office Button, point to Server Tasks, click
Connection, and then click OK.@@19@@@2' Access 2010+ uses different
description: 'Unable to start SQL Server service. To restart the SQL Server
service, double-click the SQL Server System Manager icon in the system tray
and click Start/Continue.@When the service is started, in Microsoft Access,
click the File tab, point to Server Tasks, click Connection, and then click
OK.@@19@@@2'

Access 2003+

2638

Unable to start SQL Server service.To restart the SQL Server service, double
click on the SQL Server System Manager icon in the system tray and click
Start/Continue. If the service fails to start, go to the Services console and verify
that the MSSQLServer service Log On information is correct.@Once the
service is started, point to Connection on the File menu in Access and click
OK.@@19@@2 Access 2007+ uses different description: 'Unable to start
SQL Server service. To restart the SQL Server service, double-click the SQL
Server System Manager icon in the system tray and click Start/Continue. If the
service fails to start, go to the Services console and verify that the
MSSQLServer service Log On information is correct.@When the service is
started, in Microsoft Office Access, click the Microsoft Office Button, point to
Server Tasks, click Connection, and then click OK.@@19@@@2' Access
2010+ uses different description: 'Unable to start SQL Server service. To
restart the SQL Server service, double-click the SQL Server System Manager
icon in the system tray and click Start/Continue. If the service fails to start, go
to the Services console and verify that the MSSQLServer service Log On
information is correct.@When the service is started, in Microsoft Access, click
the File tab, point to Server Tasks, click Connection, and then click
OK.@@19@@@2'

Access 2003+

2639

Microsoft Office Access cannot open | due to security restrictions.@Security
settings restrict access to the file because it is not digitally
signed.@@2@553714138@2 Access 2007+ uses different description:
'Microsoft Office Access cannot open | due to security restrictions.@Security
settings restrict access to the file because it is not digitally
signed.@@2@1@553714138@2' Access 2010+ uses different description:
'Microsoft Access cannot open |1 due to security restrictions.@Security settings
restrict access to the file because it is not digitally
signed.@@2@1@553714138@2'

Access 2003+

2646 Microsoft Office Access can't create this relationship and enforce referential
integrity.@Data in the table '|' violates referential integrity rules. For example,
there may be records relating to an employee in the related table, but no record
for the employee in the primary table.@Edit the data so that records in the
primary table exist for all related records. If you want to create the relationship
without following the rules of referential integrity, clear the Enforce Referential
Integrity check box.@1@209086@1 Access 2007+ uses different description:
'Microsoft Office Access can't create this relationship and enforce referential
integrity.@Data in the table '|' violates referential integrity rules. For example,

Access 2003+



there may be records relating to an employee in the related table, but no record
for the employee in the primary table.@Edit the data so that records in the
primary table exist for all related records. If you want to create the relationship
without following the rules of referential integrity, clear the Enforce Referential
Integrity check box.@1@1@9086@1' Access 2010+ uses different
description: 'Microsoft Access can't create this relationship and enforce
referential integrity.@Data in the table '|1' violates referential integrity rules.
For example, there may be records relating to an employee in the related table,
but no record for the employee in the primary table.@Edit the data so that
records in the primary table exist for all related records. If you want to create
the relationship without following the rules of referential integrity, clear the
Enforce Referential Integrity check box.@1@1@9086@1'

Error Code Error Description Supported Versions

2648

Microsoft Office Access created a one-to-one relationship instead of a one-to-
many relationship because there is a unique index on the field(s) specified for
the related table.@If you want to define a one-to-many relationship between
these tables, try one of the following: * Delete the one-to-one relationship, and
then change the setting of the Indexed property for the foreign key field from
No Duplicates to Duplicates OK. * Choose different matching
fields.@@1@@1 Access 2007+ uses different description: ''

Access 2003

2649

Microsoft Office Access can't enforce referential integrity for this
relationship.@Make sure the fields you drag are primary key fields or uniquely
indexed and that the unique index or primary key is correctly set. If you want to
create the relationship without following the rules of referential integrity, clear
the Enforce Referential Integrity check box.@@1@209086@1 Access 2007+
uses different description: 'Microsoft Office Access can't enforce referential
integrity for this relationship.@Make sure the fields you drag are primary key
fields or uniquely indexed and that the unique index or primary key is correctly
set. If you want to create the relationship without following the rules of
referential integrity, clear the Enforce Referential Integrity check
box.@@1@1@9086@1' Access 2010+ uses different description: 'Microsoft
Access can't enforce referential integrity for this relationship.@Make sure the
fields you drag are primary key fields or uniquely indexed and that the unique
index or primary key is correctly set. If you want to create the relationship
without following the rules of referential integrity, clear the Enforce Referential
Integrity check box.@@1@1@9086@1'

Access 2003+

2650 Microsoft Office Access can't create this relationship and enforce referential
integrity.@* The fields you chose may have different data types. * The fields
may have the Number data type but not the same FieldSize property
setting.@Try one of the following: * Select fields with the same data type. *
Open the tables in Design view, and change the data types and field sizes so
that the fields match. If you want to create the relationship without following
the rules of referential integrity, clear the Enforce Referential Integrity check
box.@2@209086@1 Access 2007+ uses different description: 'Microsoft
Office Access can't create this relationship and enforce referential integrity.@*
The fields you chose may have different data types. * The fields may have the
Number data type but not the same FieldSize property setting.@Try one of the
following: * Select fields with the same data type. * Open the tables in Design
view, and change the data types and field sizes so that the fields match. If you
want to create the relationship without following the rules of referential
integrity, clear the Enforce Referential Integrity check box.@2@1@9086@1'
Access 2010+ uses different description: 'Microsoft Access can't create this
relationship and enforce referential integrity.@* The fields you chose may have
different data types. * The fields may have the Number data type but not the
same FieldSize property setting.@Try one of the following: * Select fields with
the same data type. * Open the tables in Design view, and change the data types
and field sizes so that the fields match. If you want to create the relationship

Access 2003+



without following the rules of referential integrity, clear the Enforce Referential
Integrity check box.@2@1@9086@1'

2651

You can't create a relationship between fields with the Memo, OLE Object,
Yes/No, or Hyperlink data type.@You tried to enforce referential integrity for a
relationship, but one or more of the fields you chose have the Memo, OLE
Object, Yes/No, or Hyperlink data type.@Select fields in the grid that don't
have these data types, or open the tables in Design view and change data
types.@1@@1 Access 2007+ uses different description: 'You can't create a
relationship between fields with the Memo, OLE Object, Yes/No, or Hyperlink
data type.@You tried to enforce referential integrity for a relationship, but one
or more of the fields you chose have the Memo, OLE Object, Yes/No, or
Hyperlink data type.@Select fields in the grid that don't have these data types,
or open the tables in Design view and change data types.@1@@@1'

Access 2003+

2652
You can't delete a relationship inherited from a linked database.@@@1@@1
Access 2007+ uses different description: 'You can't delete a relationship
inherited from a linked database.@@@1@@@1'

Access 2003+

2680

The form or report includes more OLE objects than Microsoft Office Access
can display at one time.@Delete some of the bound or unbound object
frames.@@1@@1 Access 2007+ uses different description: 'The form or
report includes more OLE objects than Microsoft Office Access can display at
one time.@Delete some of the bound or unbound object frames.@@1@@@1'
Access 2010+ uses different description: 'The form or report includes more
OLE objects than Microsoft Access can display at one time.@Delete some of
the bound or unbound object frames.@@1@@@1'

Access 2003+

2683 There is no object in this control.@@@1@@1 Access 2007+ uses different
description: 'There is no object in this control.@@@1@@@1' Access 2003+

2684

The OLE object is empty.@You can't edit a bound object frame if the field in
the underlying table doesn't contain an OLE object.@Embed or link an OLE
object into the bound object frame using the Object command on the Insert
menu.@1@109360@1 Access 2007+ uses different description: 'The OLE
object is empty.@You can't edit a bound object frame if the field in the
underlying table doesn't contain an OLE object.@Right-click the field, click
Insert Object, and use the dialog box to locate and add the object to the
field.@1@1@9360@1'

Access 2003+

2685

The object doesn't have an OLE object data type.@The bound object frame
containing the object you tried to edit isn't bound to a field with the OLE object
data type.@If you want to display an OLE object, set the ControlSource
property for the bound object frame to a field with the OLE object data type. Or
use a different control, such as a text box, to display the data.@1@109360@1
Access 2007+ uses different description: 'The object doesn't have an OLE
object data type.@The bound object frame containing the object you tried to
edit isn't bound to a field with the OLE object data type.@If you want to
display an OLE object, set the ControlSource property for the bound object
frame to a field with the OLE object data type. Or use a different control, such
as a text box, to display the data.@1@1@9360@1'

Access 2003+

2686

Microsoft Office Access is unable to save the | object.@Your computer ran out
of disk space while Microsoft Office Access was saving the OLE object. For
information on freeing disk space, search the Microsoft Windows Help index
for 'disk space, freeing'.@@1@@1 Access 2007+ uses different description:
'Microsoft Office Access is unable to save the | object.@Your computer ran out
of disk space while Microsoft Office Access was saving the OLE object. For
information on freeing disk space, search the Microsoft Windows Help index
for 'disk space, freeing'.@@1@@@1' Access 2010+ uses different
description: 'Microsoft Access is unable to save the |1 object.@Your computer
ran out of disk space while Microsoft Access was saving the OLE object. For
information on freeing disk space, search the Microsoft Windows Help index
for 'disk space, freeing'.@@1@@@1'

Access 2003+



2687 There was a problem reading the | object.@@@1@@1 Access 2007+ uses
different description: '' Access 2003

2690

A system resource necessary for displaying the | object isn't available.@Your
computer may be low on memory.@Close unneeded programs, and try the
operation again. For more information on freeing memory, search the Microsoft
Windows Help index for 'memory, troubleshooting'.@1@@1 Access 2007+
uses different description: 'A system resource necessary for displaying the |
object isn't available.@Your computer may be low on memory.@Close
unneeded programs, and try the operation again. For more information on
freeing memory, search the Microsoft Windows Help index for 'memory,
troubleshooting'.@1@@@1'

Access 2003+

2691

Microsoft Office Access can't communicate with the OLE server.@The OLE
server may not be registered.@To register the OLE server, reinstall it.@1@@1
Access 2007+ uses different description: 'Microsoft Office Access can't
communicate with the OLE server.@The OLE server may not be
registered.@To register the OLE server, reinstall it.@1@@@1' Access 2010+
uses different description: 'Microsoft Access can't communicate with the OLE
server.@The OLE server may not be registered.@To register the OLE server,
reinstall it.@1@@@1'

Access 2003+

2694

The Clipboard isn't available.@The Clipboard may be in use by another
application, or your computer may be low on memory.@If your computer is
low on memory, close unneeded programs, and then try the operation again. For
more information on freeing memory, search the Microsoft Windows Help
index for 'memory, troubleshooting'.@1@@1 Access 2007+ uses different
description: 'The Clipboard isn't available.@The Clipboard may be in use by
another application, or your computer may be low on memory.@If your
computer is low on memory, close unneeded programs, and then try the
operation again. For more information on freeing memory, search the Microsoft
Windows Help index for 'memory, troubleshooting'.@1@@@1'

Access 2003+

2695

Microsoft Office Access is unable to display the converted | object.@Delete the
object in the bound object frame, and then re-create it.@@1@@1 Access
2007+ uses different description: 'Microsoft Office Access is unable to
display the converted | object.@Delete the object in the bound object frame,
and then re-create it.@@1@@@1' Access 2010+ uses different description:
'Microsoft Access is unable to display the converted |1 object.@Delete the
object in the bound object frame, and then re-create it.@@1@@@1'

Access 2003+

2696

Microsoft Office Access can't read the OLE object.@Delete the object in the
bound object frame, and then re-create it.@@1@@1 Access 2007+ uses
different description: 'Microsoft Office Access can't read the OLE
object.@Delete the object in the bound object frame, and then re-create
it.@@1@@@1' Access 2010+ uses different description: 'Microsoft Access
can't read the OLE object.@Delete the object in the bound object frame, and
then re-create it.@@1@@@1'

Access 2003+

2697

There was a problem loading the | object.@The object you tried to create or edit
is not a valid OLE object.@Re-create the object, and then embed or link it
again.@1@109360@1 Access 2007+ uses different description: 'There was a
problem loading the | object.@The object you tried to create or edit is not a
valid OLE object.@Re-create the object, and then embed or link it
again.@1@1@9360@1'

Access 2003+

2698 The | object you tried to create or edit is too large to save.@* Your database
may not contain enough space for the object. * Your computer may be out of
disk space. For information on freeing disk space, search the Microsoft
Windows Help index for 'disk space, freeing'.@@1@@1 Access 2007+ uses
different description: 'The | object you tried to create or edit is too large to
save.@* Your database may not contain enough space for the object. * Your
computer may be out of disk space. For information on freeing disk space,

Access 2003+



search the Microsoft Windows Help index for 'disk space,
freeing'.@@1@@@1'

2699

The connection with the OLE server was lost, or the OLE server encountered
an error while you were using it.@Restart the OLE server, and then try the
operation again.@@1@@1 Access 2007+ uses different description: 'The
connection with the OLE server was lost, or the OLE server encountered an
error while you were using it.@Restart the OLE server, and then try the
operation again.@@1@@@1'

Access 2003+

2700

Microsoft Office Access can't find an OLE server or a dynamic-link library
(DLL) required for the OLE operation.@The OLE server or DLL may not be
registered.@To register the OLE server or DLL, reinstall it.@1@@1 Access
2007+ uses different description: 'Microsoft Office Access can't find an OLE
server or a dynamic-link library (DLL) required for the OLE operation.@The
OLE server or DLL may not be registered.@To register the OLE server or
DLL, reinstall it.@1@@@1' Access 2010+ uses different description:
'Microsoft Access can't find an OLE server or a dynamic-link library (DLL)
required for the OLE operation.@The OLE server or DLL may not be
registered.@To register the OLE server or DLL, reinstall it.@1@@@1'

Access 2003+

Error Code Error Description Supported Versions

2701

The OLE server for the OLE object you tried to create is already open.@Switch
to the OLE server window and close it. Then try to create or edit the OLE
object again.@@1@@1 Access 2007+ uses different description: 'The OLE
server for the OLE object you tried to create is already open.@Switch to the
OLE server window and close it. Then try to create or edit the OLE object
again.@@1@@@1'

Access 2003+

2702

The | object isn't registered.@The object may be calling an application that isn't
installed.@To register the application, reinstall it.@1@@1 Access 2007+ uses
different description: 'The | object isn't registered.@The object may be calling
an application that isn't installed.@To register the application, reinstall
it.@1@@@1'

Access 2003+

2703

Microsoft Office Access can't read the | object because communication was
interrupted.@If the OLE server application is located on a network server,
make sure your computer is connected to it.@@1@@1 Access 2007+ uses
different description: 'Microsoft Office Access can't read the | object because
communication was interrupted.@If the OLE server application is located on a
network server, make sure your computer is connected to it.@@1@@@1'
Access 2010+ uses different description: 'Microsoft Access can't read the |1
object because communication was interrupted.@If the OLE server application
is located on a network server, make sure your computer is connected to
it.@@1@@@1'

Access 2003+

2704

The | object you tried to edit doesn't have any displayable
information.@@@2@109360@1 Access 2007+ uses different description:
'The | object you tried to edit doesn't have any displayable
information.@@@2@1@9360@1'

Access 2003+

2707 Microsoft Office Access can't open the file containing the OLE object.@* You
may have specified an invalid file name or an invalid unit of data (such as a
range of cells from a worksheet) within the file for the OLE object. * The file
you specified may not be available because it's locked by another user or you
don't have permission to use it.@Try one of the following: * Make sure the file
is available and that you used the correct file name. * Check the OLE server's
documentation for information about the syntax to use when specifying an OLE
object's data.@1@109360@1 Access 2007+ uses different description:
'Microsoft Office Access can't open the file containing the OLE object.@* You
may have specified an invalid file name or an invalid unit of data (such as a
range of cells from a worksheet) within the file for the OLE object. * The file
you specified may not be available because it's locked by another user or you

Access 2003+



don't have permission to use it.@Try one of the following: * Make sure the file
is available and that you used the correct file name. * Check the OLE server's
documentation for information about the syntax to use when specifying an OLE
object's data.@1@1@9360@1' Access 2010+ uses different description:
'Microsoft Access can't open the file containing the OLE object.@* You may
have specified an invalid file name or an invalid unit of data (such as a range of
cells from a worksheet) within the file for the OLE object. * The file you
specified may not be available because it's locked by another user or you don't
have permission to use it.@Try one of the following: * Make sure the file is
available and that you used the correct file name. * Check the OLE server's
documentation for information about the syntax to use when specifying an OLE
object's data.@1@1@9360@1'

2711

The file name argument in the GetObject function of the Visual Basic
procedure you ran is invalid.@* You may not have entered, or may have
misspelled, the file name. * The unit of data (such as a range of cells from a
worksheet) may not be valid.@Try one of the following: * Make sure the file is
installed on your computer and that you used the correct file name. * Check the
OLE server's documentation for information about the syntax to use when
specifying an OLE object's data.@1@1010959@1 Access 2007+ uses
different description: 'The file name argument in the GetObject function of the
Visual Basic procedure you ran is invalid.@* You may not have entered, or
may have misspelled, the file name. * The unit of data (such as a range of cells
from a worksheet) may not be valid.@Try one of the following: * Make sure
the file is installed on your computer and that you used the correct file name. *
Check the OLE server's documentation for information about the syntax to use
when specifying an OLE object's data.@1@3@1010959@1'

Access 2003+

2713

A problem occurred when Microsoft Office Access tried to access the |
object.@* You may have specified an invalid file name or an invalid unit of
data (such as a range of cells from a worksheet) within the file for the OLE
object. * The file you specified may not be available because it's locked by
another user or you don't have permission to use it.@Try one of the following:
* Make sure that the file is installed on your computer and that you used the
correct file name. * Check the OLE server's documentation for information
about the syntax to use when specifying an OLE object's data.@1@109360@1
Access 2007+ uses different description: 'A problem occurred when Microsoft
Office Access tried to access the | object.@* You may have specified an invalid
file name or an invalid unit of data (such as a range of cells from a worksheet)
within the file for the OLE object. * The file you specified may not be available
because it's locked by another user or you don't have permission to use it.@Try
one of the following: * Make sure that the file is installed on your computer and
that you used the correct file name. * Check the OLE server's documentation
for information about the syntax to use when specifying an OLE object's
data.@1@1@9360@1' Access 2010+ uses different description: 'A problem
occurred when Microsoft Access tried to access the |1 object.@* You may have
specified an invalid file name or an invalid unit of data (such as a range of cells
from a worksheet) within the file for the OLE object. * The file you specified
may not be available because it's locked by another user or you don't have
permission to use it.@Try one of the following: * Make sure that the file is
installed on your computer and that you used the correct file name. * Check the
OLE server's documentation for information about the syntax to use when
specifying an OLE object's data.@1@1@9360@1'

Access 2003+

2714 The | object doesn't support verbs that can be performed on an OLE object,
such as play or edit.@Check the OLE server's documentation for information
on the verbs the OLE object supports, or use the ObjectVerbs property or the
ObjectVerbsCount property to find the verbs supported by an OLE
object.@@1@606970@1 Access 2007+ uses different description: 'The |
object doesn't support verbs that can be performed on an OLE object, such as
play or edit.@Check the OLE server's documentation for information on the
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verbs the OLE object supports, or use the ObjectVerbs property or the
ObjectVerbsCount property to find the verbs supported by an OLE
object.@@1@1@6970@1'

2715

The index for the Action or the Verb property for the | object is invalid.@The
setting you entered may be a negative number or may be too
large.@@1@606967@1 Access 2007+ uses different description: 'The index
for the Action or the Verb property for the | object is invalid.@The setting you
entered may be a negative number or may be too large.@@1@1@6967@1'

Access 2003+

2717

The | object has no displayable information.@You tried to perform an operation
on a bound or unbound object frame containing an OLE object, but the OLE
object is empty.@Use the Object command on the Insert menu to create an
OLE object or to embed or link an OLE object from a file that isn't
empty.@1@109360@1 Access 2007+ uses different description: 'The | object
has no information that can be displayed.@You tried to perform an operation
on a bound or unbound object frame containing an OLE object, but the OLE
object is empty.@Right-click the frame, click Insert Object, and then use the
dialog box to locate and either add or link to an object from a file that is not
empty.@1@1@9360@1'

Access 2003+

2719

A problem occurred while accessing the | object.@* The OLE server may not
be available because it's on a network server and you lost the connection. Try
re-establishing the connection. * The OLE object may be stored in a linked file,
but the file isn't available. Activate the OLE server outside of Microsoft Office
Access, and then open the file containing the OLE object to verify that it still
exists and can be accessed.@@1@@1 Access 2007+ uses different
description: 'A problem occurred while accessing the | object.@* The OLE
server may not be available because it's on a network server and you lost the
connection. Try re-establishing the connection. * The OLE object may be
stored in a linked file, but the file isn't available. Activate the OLE server
outside of Microsoft Office Access, and then open the file containing the OLE
object to verify that it still exists and can be accessed.@@1@@@1' Access
2010+ uses different description: 'A problem occurred while accessing the |1
object.@* The OLE server may not be available because it's on a network
server and you lost the connection. Try re-establishing the connection. * The
OLE object may be stored in a linked file, but the file isn't available. Activate
the OLE server outside of Microsoft Access, and then open the file containing
the OLE object to verify that it still exists and can be accessed.@@1@@@1'

Access 2003+

2723

The | object doesn't support the attempted operation.@The OLE object was
changed to a picture, or the link to the object was broken.@If you want to
perform the operation, delete the OLE object, and then embed or link it
again.@1@109360@1 Access 2007+ uses different description: 'The | object
doesn't support the attempted operation.@The OLE object was changed to a
picture, or the link to the object was broken.@If you want to perform the
operation, delete the OLE object, and then embed or link it
again.@1@1@9360@1'

Access 2003+

2724 One or more dynamic-link libraries required for using OLE objects is an
incorrect version.@Run Setup to reinstall Microsoft Office Access. If you want
to preserve your security or custom settings, back up the Microsoft Office
Access workgroup information file. For information on backing up files, search
the Microsoft Windows Help index for 'backing up files'.@@1@@1 Access
2007+ uses different description: 'One or more dynamic-link libraries
required for using OLE objects is an incorrect version.@Run Setup to reinstall
Microsoft Office Access. If you want to preserve your security or custom
settings, back up the Microsoft Office Access workgroup information file. For
information on backing up files, search the Microsoft Windows Help index for
'backing up files'.@@1@@185309@1' Access 2010+ uses different
description: 'One or more dynamic-link libraries required for using OLE
objects is an incorrect version.@Run Setup to reinstall Microsoft Access. If you
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want to preserve your security or custom settings, back up the Microsoft Access
workgroup information file. For information on backing up files, search the
Microsoft Windows Help index for 'backing up files'.@@1@@185309@1'

2725
The OLE server isn't registered.@To register the OLE server, reinstall
it.@@1@@1 Access 2007+ uses different description: 'The OLE server isn't
registered.@To register the OLE server, reinstall it.@@1@@@1'

Access 2003+

2726

Microsoft Office Access can't perform the OLE operation because it was unable
to read the Windows Registry where the OLE server is registered.@Reinstall
the OLE server, and then try the operation again. If problems continue, reinstall
Microsoft Windows and the other applications on your computer. If you
reinstall Microsoft Office Access, you may want to back up your Microsoft
Office Access workgroup information file first to preserve any custom settings.
For information on backing up files, search the Microsoft Windows Help index
for 'backing up files'. For information on the Windows Registry, search the
Microsoft Windows Help index for 'registry'.@@1@@1 Access 2007+ uses
different description: 'Microsoft Office Access can't perform the OLE
operation because it was unable to read the Windows Registry where the OLE
server is registered.@Reinstall the OLE server, and then try the operation again.
If problems continue, reinstall Microsoft Windows and the other applications
on your computer. If you reinstall Microsoft Office Access, you may want to
back up your Microsoft Office Access workgroup information file first to
preserve any custom settings. For information on backing up files, search the
Microsoft Windows Help index for 'backing up files'. For information on the
Windows Registry, search the Microsoft Windows Help index for
'registry'.@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access can't perform the OLE operation because it was unable to read the
Windows Registry where the OLE server is registered.@Reinstall the OLE
server, and then try the operation again. If problems continue, reinstall
Microsoft Windows and the other applications on your computer. If you
reinstall Microsoft Access, you may want to back up your Microsoft Access
workgroup information file first to preserve any custom settings. For
information on backing up files, search the Microsoft Windows Help index for
'backing up files'. For information on the Windows Registry, search the
Microsoft Windows Help index for 'registry'.@@1@@@1'

Access 2003+

2727 Microsoft Office Access can't perform the OLE operation because it was unable
to write to the Windows Registry where the OLE server is
registered.@Reinstall the OLE server, and then try the operation again. If
problems continue, reinstall Microsoft Windows and the other applications on
your computer. If you reinstall Microsoft Office Access, you may want to back
up your Microsoft Office Access workgroup information file first to preserve
any custom settings. For information on backing up files, search the Microsoft
Windows Help index for 'backing up files'. For information on the Windows
Registry, search the Microsoft Windows Help index for 'registry'.@@1@@1
Access 2007+ uses different description: 'Microsoft Office Access can't
perform the OLE operation because it was unable to write to the Windows
Registry where the OLE server is registered.@Reinstall the OLE server, and
then try the operation again. If problems continue, reinstall Microsoft Windows
and the other applications on your computer. If you reinstall Microsoft Office
Access, you may want to back up your Microsoft Office Access workgroup
information file first to preserve any custom settings. For information on
backing up files, search the Microsoft Windows Help index for 'backing up
files'. For information on the Windows Registry, search the Microsoft Windows
Help index for 'registry'.@@1@@@1' Access 2010+ uses different
description: 'Microsoft Access can't perform the OLE operation because it was
unable to write to the Windows Registry where the OLE server is
registered.@Reinstall the OLE server, and then try the operation again. If
problems continue, reinstall Microsoft Windows and the other applications on
your computer. If you reinstall Microsoft Access, you may want to back up

Access 2003+



your Microsoft Access workgroup information file first to preserve any custom
settings. For information on backing up files, search the Microsoft Windows
Help index for 'backing up files'. For information on the Windows Registry,
search the Microsoft Windows Help index for 'registry'.@@1@@@1'

2729
The OLE object you tried to edit is busy.@Try again later.@@1@@1 Access
2007+ uses different description: 'The OLE object you tried to edit is
busy.@Try again later.@@1@@@1'

Access 2003+

2730

There was a problem communicating with the OLE server.@Try again later. If
you still can't access the object, try one or more of the following: * Free up
system memory. For information on freeing memory, search the Microsoft
Windows Help index for 'memory, troubleshooting'. * Reinstall the OLE server
to make sure it's registered. * Check the OLE server's documentation for
information about the syntax to use when specifying an OLE object's
data.@@1@@1 Access 2007+ uses different description: 'There was a
problem communicating with the OLE server.@Try again later. If you still can't
access the object, try one or more of the following: * Free up system memory.
For information on freeing memory, search the Microsoft Windows Help index
for 'memory, troubleshooting'. * Reinstall the OLE server to make sure it's
registered. * Check the OLE server's documentation for information about the
syntax to use when specifying an OLE object's data.@@1@@@1'

Access 2003+

2731

An error occurred while accessing the OLE server.@The OLE server may not
be registered.@To register the OLE server, reinstall it.@1@@1 Access 2007+
uses different description: 'An error occurred while accessing the OLE
server.@The OLE server may not be registered.@To register the OLE server,
reinstall it.@1@@@1'

Access 2003+

2732

Microsoft Office Access can't read the | object.@Communication between
Microsoft Office Access and the OLE server was interrupted.@Make sure your
computer is connected to the network server on which the OLE server is
located.@1@@1 Access 2007+ uses different description: 'Microsoft Office
Access can't read the | object.@Communication between Microsoft Office
Access and the OLE server was interrupted.@Make sure your computer is
connected to the network server on which the OLE server is
located.@1@@@1' Access 2010+ uses different description: 'Microsoft
Access can't read the |1 object.@Communication between Microsoft Access
and the OLE server was interrupted.@Make sure your computer is connected to
the network server on which the OLE server is located.@1@@@1'

Access 2003+

Error Code Error Description Supported Versions

2733

The OLE object you tried to edit can't be accessed.@You don't have permission
to change the object, or another user opened and locked the object.@@1@@1
Access 2007+ uses different description: 'The OLE object you tried to edit
can't be accessed.@You don't have permission to change the object, or another
user opened and locked the object.@@1@@@1'

Access 2003+

2734

You can't save the | object now.@The OLE server is running an operation, or
another user opened and locked the object.@Try to save the object again
later.@1@@1 Access 2007+ uses different description: 'You can't save the |
object now.@The OLE server is running an operation, or another user opened
and locked the object.@Try to save the object again later.@1@@@1'

Access 2003+

2735
This disk is write-protected. You can't save the | object to it.@@@1@@1
Access 2007+ uses different description: 'This disk is write-protected. You
can't save the | object to it.@@@1@@@1'

Access 2003+

2737 Microsoft Office Access can't find the file containing the linked OLE object
you tried to update using the OLE/DDE Links command.@You may have
misspelled the file name, or the file may have been deleted or renamed.@If the
file has been moved to a different location, use the OLE/DDE Links command
to change the source. Or delete the object, and create a new linked
object.@1@@1 Access 2007+ uses different description: 'Microsoft Office
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Access can't find the file containing the linked OLE object you tried to update
using the OLE/DDE Links command.@You may have misspelled the file name,
or the file may have been deleted or renamed.@If the file has been moved to a
different location, use the OLE/DDE Links command to change the source. Or
delete the object, and create a new linked object.@1@@@1' Access 2010+
uses different description: 'Microsoft Access can't find the file containing the
linked OLE object you tried to update using the OLE/DDE Links
command.@You may have misspelled the file name, or the file may have been
deleted or renamed.@If the file has been moved to a different location, use the
OLE/DDE Links command to change the source. Or delete the object, and
create a new linked object.@1@@@1'

2738

There isn't enough memory to complete the operation.@Close unneeded
programs and try the operation again. For more information on freeing memory,
search the Microsoft Windows Help index for 'memory,
troubleshooting'.@@1@@1 Access 2007+ uses different description: 'There
isn't enough memory to complete the operation.@Close unneeded programs
and try the operation again. For more information on freeing memory, search
the Microsoft Windows Help index for 'memory,
troubleshooting'.@@1@@@1'

Access 2003+

2739
An error occurred during the operation with an OLE object.@The object is in
use.@@1@@1 Access 2007+ uses different description: 'An error occurred
during the operation with an OLE object.@The object is in use.@@1@@@1'

Access 2003+

2741

Your computer ran out of disk space while Microsoft Office Access was saving
the changes you made to the | object.@For information on freeing disk space,
search the Microsoft Windows Help index for 'disk space, freeing'.@@1@@1
Access 2007+ uses different description: 'Your computer ran out of disk space
while Microsoft Office Access was saving the changes you made to the |
object.@For information on freeing disk space, search the Microsoft Windows
Help index for 'disk space, freeing'.@@1@@@1' Access 2010+ uses different
description: 'Your computer ran out of disk space while Microsoft Access was
saving the changes you made to the |1 object.@For information on freeing disk
space, search the Microsoft Windows Help index for 'disk space,
freeing'.@@1@@@1'

Access 2003+

2742

Microsoft Office Access was unable to create more files.@Your computer may
be low on memory or disk space.@Close unneeded programs and try the
operation again. For information on freeing memory or disk space, search the
Microsoft Windows Help index for 'memory, troubleshooting' or 'disk space,
freeing'.@1@@1 Access 2007+ uses different description: 'Microsoft Office
Access was unable to create more files.@Your computer may be low on
memory or disk space.@Close unneeded programs and try the operation again.
For information on freeing memory or disk space, search the Microsoft
Windows Help index for 'memory, troubleshooting' or 'disk space,
freeing'.@1@@@1' Access 2010+ uses different description: 'Microsoft
Access was unable to create more files.@Your computer may be low on
memory or disk space.@Close unneeded programs and try the operation again.
For information on freeing memory or disk space, search the Microsoft
Windows Help index for 'memory, troubleshooting' or 'disk space,
freeing'.@1@@@1'

Access 2003+

2743

The | object is stored in a format that is incompatible with the version of OLE
on your computer.@@@1@@1 Access 2007+ uses different description:
'The | object is stored in a format that is incompatible with the version of OLE
on your computer.@@@1@@@1'

Access 2003+

2744 Microsoft Office Access can't find the OLE server.@The setting for the
SourceDoc property may be invalid, or the file may have been deleted,
renamed, or moved.@@1@606973@1 Access 2007+ uses different
description: 'Microsoft Office Access can't find the OLE server.@The setting
for the SourceDoc property may be invalid, or the file may have been deleted,
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renamed, or moved.@@1@1@6973@1' Access 2010+ uses different
description: 'Microsoft Access can't find the OLE server.@The setting for the
SourceDoc property may be invalid, or the file may have been deleted,
renamed, or moved.@@1@1@6973@1'

2745

Share.exe or Vshare.386 is missing from your computer; OLE support needs
these files to work correctly.@Rerun Microsoft Office Access or Microsoft
Office Setup to reinstall Microsoft Office Access, the Share program, and
Vshare.386.@If you want to preserve your security or custom settings, back up
the Microsoft Office Access workgroup information file. Then restore the file to
its original location. For information on backing up files, search the Microsoft
Windows Help index for 'backing up files'.@1@@3 Access 2007+ uses
different description: 'Share.exe or Vshare.386 is missing from your
computer; OLE support needs these files to work correctly.@Rerun Microsoft
Office Access or Microsoft Office Setup to reinstall Microsoft Office Access,
the Share program, and Vshare.386.@If you want to preserve your security or
custom settings, back up the Microsoft Office Access workgroup information
file. Then restore the file to its original location. For information on backing up
files, search the Microsoft Windows Help index for 'backing up
files'.@1@@185309@3' Access 2010+ uses different description: 'Share.exe
or Vshare.386 is missing from your computer; OLE support needs these files to
work correctly.@Rerun Microsoft Access or Microsoft Office Setup to reinstall
Microsoft Access, the Share program, and Vshare.386.@If you want to
preserve your security or custom settings, back up the Microsoft Access
workgroup information file. Then restore the file to its original location. For
information on backing up files, search the Microsoft Windows Help index for
'backing up files'.@1@@185309@3'

Access 2003+

2746

You can't switch to Design view because your form contains too many OLE
objects.@Close other applications, close the form, and then open the form
again in Design view. Then delete some of the OLE objects or move them to a
different form.@@1@@1 Access 2007+ uses different description: 'You can't
switch to Design view because your form contains too many OLE
objects.@Close other applications, close the form, and then open the form
again in Design view. Then delete some of the OLE objects or move them to a
different form.@@1@@@1'

Access 2003+

2747

The OLE server can't display the | object.@There is a problem with the file
containing the OLE object, or there isn't enough memory available.@Open the
OLE server outside of Microsoft Office Access, and then open the OLE object
file. If you can do this, then your computer may be low on memory. Close other
programs, and then try the operation again. For more information on freeing
memory, search the Microsoft Windows Help index for 'memory,
troubleshooting'.@1@@1 Access 2007+ uses different description: 'The OLE
server can't display the | object.@There is a problem with the file containing the
OLE object, or there isn't enough memory available.@Open the OLE server
outside of Microsoft Office Access, and then open the OLE object file. If you
can do this, then your computer may be low on memory. Close other programs,
and then try the operation again. For more information on freeing memory,
search the Microsoft Windows Help index for 'memory,
troubleshooting'.@1@@@1' Access 2010+ uses different description: 'The
OLE server can't display the |1 object.@There is a problem with the file
containing the OLE object, or there isn't enough memory available.@Open the
OLE server outside of Microsoft Access, and then open the OLE object file. If
you can do this, then your computer may be low on memory. Close other
programs, and then try the operation again. For more information on freeing
memory, search the Microsoft Windows Help index for 'memory,
troubleshooting'.@1@@@1'

Access 2003+

2748 The Automation object operation isn't available for the | object.@Check the
component's documentation for information on which operations are available
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for an Automation object.@@1@@1 Access 2007+ uses different
description: 'The Automation object operation isn't available for the |
object.@Check the component's documentation for information on which
operations are available for an Automation object.@@1@@@1'

2749

There isn't enough memory to complete the Automation object operation on the
| object.@Close unneeded programs and try the operation again. For more
information on freeing memory, search the Microsoft Windows Help index for
'memory, troubleshooting'.@@1@@1 Access 2007+ uses different
description: 'There isn't enough memory to complete the Automation object
operation on the | object.@Close unneeded programs and try the operation
again. For more information on freeing memory, search the Microsoft Windows
Help index for 'memory, troubleshooting'.@@1@@@1'

Access 2003+

2750

The operation on the | object failed.@The OLE server may not be
registered.@To register the OLE server, reinstall it.@1@@1 Access 2007+
uses different description: 'The operation on the | object failed.@The OLE
server may not be registered.@To register the OLE server, reinstall
it.@1@@@1'

Access 2003+

2751

The Exit or Update operation failed.@You pressed the ESC key (or another key
used in the OLE server to stop an operation) while Microsoft Office Access was
saving the changes you made to an OLE object in a form or report.@Try to exit
or update again.@1@@1 Access 2007+ uses different description: 'The Exit
or Update operation failed.@You pressed the ESC key (or another key used in
the OLE server to stop an operation) while Microsoft Office Access was saving
the changes you made to an OLE object in a form or report.@Try to exit or
update again.@1@@@1' Access 2010+ uses different description: 'The Exit
or Update operation failed.@You pressed the ESC key (or another key used in
the OLE server to stop an operation) while Microsoft Access was saving the
changes you made to an OLE object in a form or report.@Try to exit or update
again.@1@@@1'

Access 2003+

2753

A problem occurred while Microsoft Office Access was communicating with
the OLE server or ActiveX Control.@Close the OLE server and restart it
outside of Microsoft Office Access. Then try the original operation again in
Microsoft Office Access.@@1@@1 Access 2007+ uses different description:
'A problem occurred while Microsoft Office Access was communicating with
the OLE server or ActiveX Control.@Close the OLE server and restart it
outside of Microsoft Office Access. Then try the original operation again in
Microsoft Office Access.@@1@@@1' Access 2010+ uses different
description: 'A problem occurred while Microsoft Access was communicating
with the OLE server or ActiveX Control.@Close the OLE server and restart it
outside of Microsoft Access. Then try the original operation again in Microsoft
Access.@@1@@@1'

Access 2003+

2754 A problem occurred while Microsoft Office Access was communicating with
the OLE server.@Try one or more of the following: * Make sure you're
connected to the network server where the OLE server application is located. *
Close the OLE server and restart it outside of Microsoft Office Access. Then try
the original operation again from within Microsoft Office Access. * Reinstall
the OLE server to ensure that it's registered.@@1@@1 Access 2007+ uses
different description: 'A problem occurred while Microsoft Office Access was
communicating with the OLE server.@Try one or more of the following: *
Make sure you're connected to the network server where the OLE server
application is located. * Close the OLE server and restart it outside of Microsoft
Office Access. Then try the original operation again from within Microsoft
Office Access. * Reinstall the OLE server to ensure that it's
registered.@@1@@@1' Access 2010+ uses different description: 'A problem
occurred while Microsoft Access was communicating with the OLE
server.@Try one or more of the following: * Make sure you're connected to the
network server where the OLE server application is located. * Close the OLE

Access 2003+



server and restart it outside of Microsoft Access. Then try the original operation
again from within Microsoft Access. * Reinstall the OLE server to ensure that
it's registered.@@1@@@1'

2755

There was a problem referencing a property or method of the object.@You tried
to run a Visual Basic procedure that references an object property or
method.@Try one or more of the following: * Make sure the component is
properly registered. * Make sure your computer is connected to the network
server where the component is located. * Close the component and restart it
outside of Microsoft Office Access. Then try again to run the procedure in
Microsoft Office Access.@1@@1 Access 2007+ uses different description:
'There was a problem referencing a property or method of the object.@You
tried to run a Visual Basic procedure that references an object property or
method.@Try one or more of the following: * Make sure the component is
properly registered. * Make sure your computer is connected to the network
server where the component is located. * Close the component and restart it
outside of Microsoft Office Access. Then try again to run the procedure in
Microsoft Office Access.@1@@@1' Access 2010+ uses different
description: 'There was a problem referencing a property or method of the
object.@You tried to run a Visual Basic procedure that references an object
property or method.@Try one or more of the following: * Make sure the
component is properly registered. * Make sure your computer is connected to
the network server where the component is located. * Close the component and
restart it outside of Microsoft Access. Then try again to run the procedure in
Microsoft Access.@1@@@1'

Access 2003+

Error Code Error Description Supported Versions

2756

A problem occurred when Microsoft Office Access tried to access the OLE
object.@Close the Microsoft Office Access form or report that displays the
OLE object, and close the OLE server. Then reopen the form or report to see if
it can display the OLE object.@@1@@1 Access 2007+ uses different
description: 'A problem occurred when Microsoft Office Access tried to access
the OLE object.@Close the Microsoft Office Access form or report that
displays the OLE object, and close the OLE server. Then reopen the form or
report to see if it can display the OLE object.@@1@@@1' Access 2010+ uses
different description: 'A problem occurred when Microsoft Access tried to
access the OLE object.@Close the Microsoft Access form or report that
displays the OLE object, and close the OLE server. Then reopen the form or
report to see if it can display the OLE object.@@1@@@1'

Access 2003+

2757

There was a problem accessing a property or method of the OLE object.@Try
one or more of the following: * Verify that the OLE server is registered
correctly by reinstalling it. * Make sure your computer is connected to the
server on which the OLE server application resides. * Close the OLE server and
restart it outside of Microsoft Office Access. Then try the original operation
again from within Microsoft Office Access.@@1@@1 Access 2007+ uses
different description: 'There was a problem accessing a property or method of
the OLE object.@Try one or more of the following: * Verify that the OLE
server is registered correctly by reinstalling it. * Make sure your computer is
connected to the server on which the OLE server application resides. * Close
the OLE server and restart it outside of Microsoft Office Access. Then try the
original operation again from within Microsoft Office Access.@@1@@@1'
Access 2010+ uses different description: 'There was a problem accessing a
property or method of the OLE object.@Try one or more of the following: *
Verify that the OLE server is registered correctly by reinstalling it. * Make sure
your computer is connected to the server on which the OLE server application
resides. * Close the OLE server and restart it outside of Microsoft Access. Then
try the original operation again from within Microsoft Access.@@1@@@1'

Access 2003+

2758 There was a problem initializing the dynamic-link library Msole20 when you
tried to perform the OLE operation.@* You may have too many Microsoft
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applications open. Close Windows applications other than Microsoft Office
Access, and try the OLE operation again. * Your computer may have an older
version of the dynamic-link library Msole20, in which case you will need to run
Setup to reinstall Microsoft Office Access. If you need to reinstall Microsoft
Office Access, you may want to preserve your security or custom settings by
backing up the Microsoft Office Access workgroup information file. For
information on backing up files, search the Microsoft Windows Help index for
'backing up files'.@@1@@1 Access 2007+ uses different description: ''

2759

The method you tried to invoke on an object failed.@* You may have specified
too many or too few arguments for a property or method of an object. Check
the component's documentation for information on the properties and methods
it makes available for Automation operations. * There may not be enough
memory to run the procedure. Close unneeded programs and try to run the
procedure again. For more information on freeing memory, search the
Microsoft Windows Help index for 'memory, troubleshooting'.@@1@@1
Access 2007+ uses different description: 'The method you tried to invoke on
an object failed.@* You may have specified too many or too few arguments for
a property or method of an object. Check the component's documentation for
information on the properties and methods it makes available for Automation
operations. * There may not be enough memory to run the procedure. Close
unneeded programs and try to run the procedure again. For more information
on freeing memory, search the Microsoft Windows Help index for 'memory,
troubleshooting'.@@1@@@1'

Access 2003+

2760

An error occurred while referencing the object.@You tried to run a Visual Basic
procedure that improperly references a property or method of an
object.@@1@@1 Access 2007+ uses different description: 'An error
occurred while referencing the object.@You tried to run a Visual Basic
procedure that improperly references a property or method of an
object.@@1@@@1'

Access 2003+

2761

There was a problem referencing a property or method of an object.@Check the
component's documentation for information on the properties and methods it
makes available for Automation operations.@@1@@1 Access 2007+ uses
different description: 'There was a problem referencing a property or method
of an object.@Check the component's documentation for information on the
properties and methods it makes available for Automation
operations.@@1@@@1'

Access 2003+

2762

| returned an error while referencing a property of an object.@Check the
component's documentation for information on the properties and methods it
makes available for Automation operations.@@1@@1 Access 2007+ uses
different description: '| returned an error while referencing a property of an
object.@Check the component's documentation for information on the
properties and methods it makes available for Automation
operations.@@1@@@1'

Access 2003+

2763

|1 returned the error: |2.@Check the component's documentation for
information on the properties and methods it makes available for Automation
operations.@@1@@1 Access 2007+ uses different description: '|1 returned
the error: |2.@Check the component's documentation for information on the
properties and methods it makes available for Automation
operations.@@1@@@1'

Access 2003+

2764 The object's property or method can't be set.@You tried to run a Visual Basic
procedure to set a property or apply a method for an object. However, the
property or method doesn't support named arguments.@Check the component's
documentation for information on the properties and methods it makes
available to Automation operations.@1@@1 Access 2007+ uses different
description: 'The object's property or method can't be set.@You tried to run a
Visual Basic procedure to set a property or apply a method for an object.
However, the property or method doesn't support named arguments.@Check

Access 2003+



the component's documentation for information on the properties and methods
it makes available to Automation operations.@1@@@1'

2765

Visual Basic can't convert the data type of one of the arguments you
entered.@You tried to run a Visual Basic procedure that executes a method or
sets a property of an object.@Check the component's documentation for
information on the properties and methods it makes available for Automation
operations.@1@@1 Access 2007+ uses different description: 'Visual Basic
can't convert the data type of one of the arguments you entered.@You tried to
run a Visual Basic procedure that executes a method or sets a property of an
object.@Check the component's documentation for information on the
properties and methods it makes available for Automation
operations.@1@@@1'

Access 2003+

2766

The object doesn't contain the Automation object '|.'@You tried to run a Visual
Basic procedure to set a property or method for an object. However, the
component doesn't make the property or method available for Automation
operations.@Check the component's documentation for information on the
properties and methods it makes available for Automation operations.@1@@1
Access 2007+ uses different description: 'The object doesn't contain the
Automation object '|.'@You tried to run a Visual Basic procedure to set a
property or method for an object. However, the component doesn't make the
property or method available for Automation operations.@Check the
component's documentation for information on the properties and methods it
makes available for Automation operations.@1@@@1'

Access 2003+

2767

The object doesn't support American English; it was developed using a different
language.@Use a version of the object developed in Visual Basic that supports
the language you are using.@@1@@1 Access 2007+ uses different
description: 'The object doesn't support American English; it was developed
using a different language.@Use a version of the object developed in Visual
Basic that supports the language you are using.@@1@@@1'

Access 2003+

2768

The number you used to reference an element in the array is outside the bounds
of the array.@For example, the array is from 0 through 10, and you entered a -1
or an 11.@Check the component's documentation for information on the
properties and methods it makes available for Automation operations.@1@@1
Access 2007+ uses different description: 'The number you used to reference
an element in the array is outside the bounds of the array.@For example, the
array is from 0 through 10, and you entered a -1 or an 11.@Check the
component's documentation for information on the properties and methods it
makes available for Automation operations.@1@@@1'

Access 2003+

2769

A property of the Automation object requires or returns a data type that isn't
supported by Visual Basic.@You tried to run a Visual Basic procedure that
references an Automation object's property. However, the value of the property
isn't supported by Visual Basic.@Check the component's documentation for
information on the properties and methods it makes available for Automation
operations.@1@@1 Access 2007+ uses different description: 'A property of
the Automation object requires or returns a data type that isn't supported by
Visual Basic.@You tried to run a Visual Basic procedure that references an
Automation object's property. However, the value of the property isn't
supported by Visual Basic.@Check the component's documentation for
information on the properties and methods it makes available for Automation
operations.@1@@@1'

Access 2003+

2770

The object you referenced in the Visual Basic procedure as an OLE object isn't
an OLE object.@@@1@@1 Access 2007+ uses different description: 'The
object you referenced in the Visual Basic procedure as an OLE object isn't an
OLE object.@@@1@@@1'

Access 2003+

2771 The bound or unbound object frame you tried to edit doesn't contain an OLE
object.@Use the Object command on the Insert menu to add an OLE object to
the bound or unbound object frame.@@1@109360@1 Access 2007+ uses
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different description: 'The bound or unbound object frame you tried to edit
does not contain an OLE object.@Right-click the frame, click Insert Object,
and then use the dialog box to locate and either add or link to an object from a
file that is not empty.@@1@1@9360@1'

2774

The component doesn't support Automation.@You tried to run a Visual Basic
procedure that references an Automation object.@Check the component's
documentation for information on whether it supports Automation.@1@@1
Access 2007+ uses different description: 'The component doesn't support
Automation.@You tried to run a Visual Basic procedure that references an
Automation object.@Check the component's documentation for information on
whether it supports Automation.@1@@@1'

Access 2003+

2775

You specified too many arguments in the Visual Basic procedure, or there isn't
enough memory to run the procedure.@Specify fewer arguments, or close
unneeded programs, and then try to run the procedure again. For more
information on freeing memory, search the Microsoft Windows Help index for
'memory, troubleshooting'.@@1@@1 Access 2007+ uses different
description: 'You specified too many arguments in the Visual Basic procedure,
or there isn't enough memory to run the procedure.@Specify fewer arguments,
or close unneeded programs, and then try to run the procedure again. For more
information on freeing memory, search the Microsoft Windows Help index for
'memory, troubleshooting'.@@1@@@1'

Access 2003+

2777

The class argument in the CreateObject function of the Visual Basic procedure
you're trying to run is invalid.@Try one of the following: * Make sure the file
is installed on your computer and that you used the correct file name. * Check
the OLE server's documentation for information about the syntax to use when
specifying an OLE object's data.@@1@1010851@1 Access 2007+ uses
different description: 'The class argument in the CreateObject function of the
Visual Basic procedure you're trying to run is invalid.@Try one of the
following: * Make sure the file is installed on your computer and that you used
the correct file name. * Check the OLE server's documentation for information
about the syntax to use when specifying an OLE object's
data.@@1@3@1010851@1'

Access 2003+

2778

Microsoft Office Access tried to create an OLE link, but there was no source
document for this object.@@@1@@1 Access 2007+ uses different
description: 'Microsoft Office Access tried to create an OLE link, but there
was no source document for this object.@@@1@@@1' Access 2010+ uses
different description: 'Microsoft Access tried to create an OLE link, but there
was no source document for this object.@@@1@@@1'

Access 2003+

Error Code Error Description Supported Versions

2782

You must specify a property or method for the object.@You tried to run a
Visual Basic procedure that references and sets a property or method for the
object.@Enter a property or method for the object.@1@606968@1 Access
2007+ uses different description: 'You must specify a property or method for
the object.@You tried to run a Visual Basic procedure that references and sets a
property or method for the object.@Enter a property or method for the
object.@1@1@6968@1'

Access 2003+



2783

You entered an invalid setting for the Action property.@Use one of the
Microsoft Office Access intrinsic constants for the Action property. For a list of
valid settings you can use with the Action property, click
Help.@@2@606967@1 Access 2007+ uses different description: 'You
entered an invalid setting for the Action property.@Use one of the Microsoft
Office Access intrinsic constants for the Action property. For a list of valid
settings you can use with the Action property, click Help.@@2@1@6967@1'
Access 2010+ uses different description: 'You entered an invalid setting for
the Action property.@Use one of the Microsoft Access intrinsic constants for
the Action property. For a list of valid settings you can use with the Action
property, click Help.@@2@1@6967@1'

Access 2003+

2784

The path you entered for the SourceDoc property setting for a linked OLE
object is too long.@Move the file to a location with a shorter
path.@@1@606973@1 Access 2007+ uses different description: 'The path
you entered for the SourceDoc property setting for a linked OLE object is too
long.@Move the file to a location with a shorter path.@@1@1@6973@1'

Access 2003+

2785

The OLE server wasn't able to open the object.@* The OLE server may not be
installed. * You may have specified an invalid setting for the SourceDoc or
SourceItem property in a property sheet, a macro, or a Visual Basic
procedure.@To see the valid settings for either of these properties, search the
Help index for the property topic.@1@606973@1 Access 2007+ uses
different description: 'The OLE server wasn't able to open the object.@* The
OLE server may not be installed. * You may have specified an invalid setting
for the SourceDoc or SourceItem property in a property sheet, a macro, or a
Visual Basic procedure.@To see the valid settings for either of these properties,
search the Help index for the property topic.@1@1@6973@1'

Access 2003+

2786

The OLE server doesn't support linking.@You tried to run a Visual Basic
procedure using the Action property. However, you provided insufficient
information to establish a link.@@1@@1 Access 2007+ uses different
description: 'The OLE server doesn't support linking.@You tried to run a
Visual Basic procedure using the Action property. However, you provided
insufficient information to establish a link.@@1@@@1'

Access 2003+

2788

The | object isn't a linked object.@The property you tried to set in Visual Basic
applies only to linked objects.@@1@@1 Access 2007+ uses different
description: 'The | object isn't a linked object.@The property you tried to set in
Visual Basic applies only to linked objects.@@1@@@1'

Access 2003+

2790

You can't embed an OLE object into a bound or unbound object frame if the
OLETypeAllowed property for the bound or unbound object frame is set to
Linked.@Insert a linked object, or set the OLETypeAllowed property to
Embedded or Either, and then embed the object.@@1@606439@1 Access
2007+ uses different description: 'You can't embed an OLE object into a
bound or unbound object frame if the OLETypeAllowed property for the bound
or unbound object frame is set to Linked.@Insert a linked object, or set the
OLETypeAllowed property to Embedded or Either, and then embed the
object.@@1@1@6439@1'

Access 2003+

2791 Microsoft Office Access can't link the OLE object or the bound or unbound
object frame.@The OLETypeAllowed property for the bound or unbound
object frame is set to Embedded.@Embed the object, or set the
OLETypeAllowed property to Linked or Either, and then link the
object.@1@606439@1 Access 2007+ uses different description: 'Microsoft
Office Access can't link the OLE object or the bound or unbound object
frame.@The OLETypeAllowed property for the bound or unbound object
frame is set to Embedded.@Embed the object, or set the OLETypeAllowed
property to Linked or Either, and then link the object.@1@1@6439@1' Access
2010+ uses different description: 'Microsoft Access can't link the OLE object
or the bound or unbound object frame.@The OLETypeAllowed property for the
bound or unbound object frame is set to Embedded.@Embed the object, or set
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the OLETypeAllowed property to Linked or Either, and then link the
object.@1@1@6439@1'

2792 You can't save a locked OLE object.@@@1@@1 Access 2007+ uses different
description: 'You can't save a locked OLE object.@@@1@@@1' Access 2003+

2793

Microsoft Office Access can't perform the operation specified in the Action
property of the Visual Basic procedure you're trying to run.@The object frame
may be locked or disabled.@Set the Locked property to No and the Enabled
property to Yes.@1@@1 Access 2007+ uses different description: 'Microsoft
Office Access can't perform the operation specified in the Action property of
the Visual Basic procedure you're trying to run.@The object frame may be
locked or disabled.@Set the Locked property to No and the Enabled property to
Yes.@1@@@1' Access 2010+ uses different description: 'Microsoft Access
can't perform the operation specified in the Action property of the Visual Basic
procedure you're trying to run.@The object frame may be locked or
disabled.@Set the Locked property to No and the Enabled property to
Yes.@1@@@1'

Access 2003+

2794

The ActiveX control you tried to insert isn't registered.@For information on
registering an ActiveX control, click Help.@@2@212639@1 Access 2007+
uses different description: 'The ActiveX control you tried to insert isn't
registered.@For information on registering an ActiveX control, click
Help.@@2@1@12639@1'

Access 2003+

2797

This OLE object was created in an earlier version of OLE so it can't be
displayed as an icon.@For an effect similar to displaying an object as an icon,
add an image control to your form, and add the icon for the application to the
image control. Then set the image control's OnDblClick property to a Visual
Basic procedure that opens the OLE object.@@1@@1 Access 2007+ uses
different description: 'This OLE object was created in an earlier version of
OLE so it can't be displayed as an icon.@For an effect similar to displaying an
object as an icon, add an image control to your form, and add the icon for the
application to the image control. Then set the image control's OnDblClick
property to a Visual Basic procedure that opens the OLE object.@@1@@@1'

Access 2003+

2798

You can't use the Action property to delete a bound OLE object from its
underlying table or query.@You tried to run a Visual Basic procedure that
deletes the object in a bound object frame by setting the Action property to
acOLEDelete.@Delete the object in a different way, such as with the DAO
Delete method in Visual Basic.@1@613790@1 Access 2007+ uses different
description: 'You can't use the Action property to delete a bound OLE object
from its underlying table or query.@You tried to run a Visual Basic procedure
that deletes the object in a bound object frame by setting the Action property to
acOLEDelete.@Delete the object in a different way, such as with the DAO
Delete method in Visual Basic.@1@1@13790@1'

Access 2003+

2799

The OLE object can't be activated upon receiving the focus.@If you selected an
OLE object or a chart, and the AutoActivate property for that control is set to
GetFocus, the OLE object or chart should be activated automatically when it
receives the focus. However, the ActiveX component doesn't support this
operation.@Check the component's documentation for information on the
properties and methods it makes available to Automation operations.@1@@1
Access 2007+ uses different description: 'The OLE object can't be activated
upon receiving the focus.@If you selected an OLE object or a chart, and the
AutoActivate property for that control is set to GetFocus, the OLE object or
chart should be activated automatically when it receives the focus. However,
the ActiveX component doesn't support this operation.@Check the component's
documentation for information on the properties and methods it makes
available to Automation operations.@1@@@1'

Access 2003+

2800 The object is locked, so any changes you make will be discarded when the form
is closed.@Click Save As on the File menu and save the object under a
different name.@@1@@1 Access 2007+ uses different description: 'This
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object is locked. Any changes you make will be discarded when the form is
closed.@Click the Microsoft Office Button, point to Save As, and save the
object under a different name.@@1@@@1' Access 2010+ uses different
description: 'This object is locked. Any changes you make will be discarded
when the form is closed.@Click the File tab, point to Save As, and save the
object under a different name.@@1@@@0'

2801

The OLE object isn't loaded because the unbound ActiveX control hasn't been
initialized.@@@1@109015@1 Access 2007+ uses different description:
'The OLE object isn't loaded because the unbound ActiveX control hasn't been
initialized.@@@1@1@9015@1'

Access 2003+

2802

You can't insert an ActiveX control in a bound or unbound object
frame.@ActiveX controls are automatically contained in ActiveX control
frames.@@1@@1 Access 2007+ uses different description: 'You can't insert
an ActiveX control in a bound or unbound object frame.@ActiveX controls are
automatically contained in ActiveX control frames.@@1@@@1'

Access 2003+

2803

You don't have the license required to use this ActiveX control.@You tried to
open a form containing an OLE object or an ActiveX control or you tried to
create an ActiveX control.@To obtain the appropriate license, contact the
company that provides the licensed OLE object or ActiveX control.@1@@1
Access 2007+ uses different description: 'You don't have the license required
to use this ActiveX control.@You tried to open a form containing an OLE
object or an ActiveX control or you tried to create an ActiveX control.@To
obtain the appropriate license, contact the company that provides the licensed
OLE object or ActiveX control.@1@@@1'

Access 2003+

2804

You can't create an ActiveX control in an unbound object frame.@ActiveX
controls are automatically contained in ActiveX control
frames.@@1@211711@1 Access 2007+ uses different description: 'You can't
create an ActiveX control in an unbound object frame.@ActiveX controls are
automatically contained in ActiveX control frames.@@1@1@11711@1'

Access 2003+

2805

There was an error loading an ActiveX control on one of your forms or
reports.@Make sure all the controls that you are using are properly registered.
For information on registering an ActiveX control, click
Help.@@2@212639@1 Access 2007+ uses different description: 'There was
an error loading an ActiveX control on one of your forms or reports.@Make
sure all the controls that you are using are properly registered. For information
on registering an ActiveX control, click Help.@@2@1@12639@1'

Access 2003+

Error Code Error Description Supported Versions

2806

Microsoft Office Access doesn't support this ActiveX control.@@@1@@1
Access 2007+ uses different description: 'Microsoft Office Access doesn't
support this ActiveX control.@@@1@@@1' Access 2010+ uses different
description: 'Microsoft Access doesn't support this ActiveX
control.@@@1@@@1'

Access 2003+

2807
You can't paste this object as the type you specified.@Choose another object
type.@@1@@1 Access 2007+ uses different description: 'You can't paste this
object as the type you specified.@Choose another object type.@@1@@@1'

Access 2003+

2808

Microsoft Office Access can't find the Active Accessibility dynamic-link library
(DLL) OleAcc.@Rerun the Microsoft Office Access Setup
program.@@1@@3 Access 2007+ uses different description: 'Microsoft
Office Access can't find the Active Accessibility dynamic-link library (DLL)
OleAcc.@Rerun the Microsoft Office Access Setup program.@@1@@@3'
Access 2010+ uses different description: 'Microsoft Access can't find the
Active Accessibility dynamic-link library (DLL) OleAcc.@Rerun the Microsoft
Access Setup program.@@1@@@3'

Access 2003+

2811
Microsoft Office Access is unable to create the data access page. Access 2010+
uses different description: 'Microsoft Access is unable to create the data
access page.'

Access 2003+



2812

|@The path specified was invalid, or may be too long.@Please check the path
and ensure it is correct.@1@@1 Access 2007+ uses different description:
'|@The path specified was invalid, or may be too long.@Please check the path
and ensure it is correct.@1@@@1'

Access 2003+

2813
|@The file could not be opened.It may currently be in use.@@1@@1 Access
2007+ uses different description: '|@The file could not be opened.It may
currently be in use.@@1@@@1'

Access 2003+

2814 |@Unable to save the file.@@1@@1 Access 2007+ uses different
description: '|@Unable to save the file.@@1@@@1' Access 2003+

2815
|@Unable to save the file to an alternate location.@@1@@1 Access 2007+
uses different description: '|@Unable to save the file to an alternate
location.@@1@@@1'

Access 2003+

2816 |@Unable to close the file.@@1@@1 Access 2007+ uses different
description: '|@Unable to close the file.@@1@@@1' Access 2003+

2817
Microsoft Office Access is unable to save (or send) the data access page.
Access 2010+ uses different description: 'Microsoft Access is unable to save
(or send) the data access page.'

Access 2003+

2818

Microsoft Office Access is unable to retrieve the file: |.@Either the file is not
available, or you do not have enough disk space to copy the file.@@1@@
Access 2007+ uses different description: 'Microsoft Office Access is unable to
retrieve the file: |.@Either the file is not available, or you do not have enough
disk space to copy the file.@@1@@@' Access 2010+ uses different
description: 'Microsoft Access is unable to retrieve the file: |1.@Either the file
is not available, or you do not have enough disk space to copy the
file.@@1@@@'

Access 2003+

2819
Microsoft Office Access is unable to open the data access page. Access 2010+
uses different description: 'Microsoft Access is unable to open the data access
page.'

Access 2003+

2820
Microsoft Office Access is unable to change the BASE HREF for your
document. Access 2010+ uses different description: 'Microsoft Access is
unable to change the BASE HREF for your document.'

Access 2003+

2821 File in use Access 2003+

2822

Microsoft Office Access encountered an unexpected error while attempting to
recover from a failed save (or send).@Your data access page may not be in a
usable state.Please attempt to save to a different location.@@1@@ Access
2007+ uses different description: 'Microsoft Office Access encountered an
unexpected error while attempting to recover from a failed save (or
send).@Your data access page may not be in a usable state.Please attempt to
save to a different location.@@1@@@' Access 2010+ uses different
description: 'Microsoft Access encountered an unexpected error while
attempting to recover from a failed save (or send).@Your data access page may
not be in a usable state.Please attempt to save to a different
location.@@1@@@'

Access 2003+

2823 The Microsoft Office Access data access page name '|' is misspelled or refers to
a Page that doesn't exist.@If the invalid Page name is in a macro, an Action
Failed dialog box will display the macro name and the macro's arguments after
you click OK. Open the Macro window, and enter the correct Page
name.@@1@@1 Access 2007+ uses different description: 'The Microsoft
Office Access data access page name '|' is misspelled or refers to a Page that
doesn't exist.@If the invalid Page name is in a macro, an Action Failed dialog
box will display the macro name and the macro's arguments after you click OK.
Open the Macro window, and enter the correct Page name.@@1@@@1'
Access 2010+ uses different description: 'The Microsoft Access data access
page name '|1' is misspelled or refers to a Page that doesn't exist.@If the invalid
Page name is in a macro, an Action Failed dialog box will display the macro

Access 2003+



name and the macro's arguments after you click OK. Open the Macro window,
and enter the correct Page name.@@1@@@1'

2824
|@You do not have adequate file permissions.@@1@@1 Access 2007+ uses
different description: '|@You do not have adequate file
permissions.@@1@@@1'

Access 2003+

2825
|@The file does not exist, or you do not have read access to the file.@@1@@1
Access 2007+ uses different description: '|@The file does not exist, or you do
not have read access to the file.@@1@@@1'

Access 2003+

2827 |@File read error.@@1@@1 Access 2007+ uses different description:
'|@File read error.@@1@@@1' Access 2003+

2828 |@File write error.@The disk may be full.@1@@1 Access 2007+ uses
different description: '|@File write error.@The disk may be full.@1@@@1' Access 2003+

Error Code Error Description Supported Versions

2832

|@Check file permissions and delete them from their location in your
computer's file system.@@1@@1 Access 2007+ uses different description:
'|@Check file permissions and delete them from their location in your
computer's file system.@@1@@@1'

Access 2003+

2833 |@An unexpected error has occurred.@@1@@1 Access 2007+ uses different
description: '|@An unexpected error has occurred.@@1@@@1' Access 2003+

2835

|@An attempt to create this file has failed.@Please select another location and
retry the operation.@1@@1 Access 2007+ uses different description: '|@An
attempt to create this file has failed.@Please select another location and retry
the operation.@1@@@1'

Access 2003+

2837

|@There was not enough memory.@Please close other applications and try the
operation again.@1@@1 Access 2007+ uses different description: '|@There
was not enough memory.@Please close other applications and try the operation
again.@1@@@1'

Access 2003+

2838
Microsoft Office Access is unable to preview the selected theme. Access 2010+
uses different description: 'Microsoft Access is unable to preview the selected
theme.'

Access 2003+

2839

|@An attempt to create a temporary file has failed.@Please confirm that you
have adequate disk space on your system drive and try the operation
again.@1@@1 Access 2007+ uses different description: '|@An attempt to
create a temporary file has failed.@Please confirm that you have adequate disk
space on your system drive and try the operation again.@1@@@1'

Access 2003+

2840
|@Unable to read the list of supporting files from the data access
page.@@1@@1 Access 2007+ uses different description: '|@Unable to read
the list of supporting files from the data access page.@@1@@@1'

Access 2003+

2842
Microsoft Office Access encountered an error after saving (or sending) your
data access page. Access 2010+ uses different description: 'Microsoft Access
encountered an error after saving (or sending) your data access page.'

Access 2003+

2845
Microsoft Office Access is unable to open the data access page from the mail
envelope. Access 2010+ uses different description: 'Microsoft Access is
unable to open the data access page from the mail envelope.'

Access 2003+

2846

|@The save destination is full.@Please clear space at the destination or save to
another location.@1@@1 Access 2007+ uses different description: '|@The
save destination is full.@Please clear space at the destination or save to another
location.@1@@@1'

Access 2003+

2847

|@Unable to create a folder for the supporting files.@You may not have
adequate permissions at the save destination.@1@@1 Access 2007+ uses
different description: '|@Unable to create a folder for the supporting
files.@You may not have adequate permissions at the save
destination.@1@@@1'

Access 2003+



2848

|@The maximum path length was exceeded.@Please specifiy a shorter
filename, or use a folder that is closer to the root.@1@@1 Access 2007+ uses
different description: '|@The maximum path length was exceeded.@Please
specifiy a shorter filename, or use a folder that is closer to the root.@1@@@1'

Access 2003+

2849

|@There are too many supporting files in your document.@Please remove a
few supporting files from your document, and try again.@1@@1 Access
2007+ uses different description: '|@There are too many supporting files in
your document.@Please remove a few supporting files from your document,
and try again.@1@@@1'

Access 2003+

2850
|@You do not have write permission at the save destination.@@1@@1 Access
2007+ uses different description: '|@You do not have write permission at the
save destination.@@1@@@1'

Access 2003+

2851

|@You are saving to a server that does not support long filenames and do not
have permission to create a folder.@You must have permission to create a
folder at the save destination to complete this operation.@1@@1 Access
2007+ uses different description: '|@You are saving to a server that does not
support long filenames and do not have permission to create a folder.@You
must have permission to create a folder at the save destination to complete this
operation.@1@@@1'

Access 2003+

2854

Microsoft Office Access was unable to parse the document properties for this
data access page.@They may be corrupted.@@1@@1 Access 2007+ uses
different description: 'Microsoft Office Access was unable to parse the
document properties for this data access page.@They may be
corrupted.@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access was unable to parse the document properties for this data access
page.@They may be corrupted.@@1@@@1'

Access 2003+

2855
Microsoft Office Access could not delete one or more files related to the page.
Access 2010+ uses different description: 'Microsoft Access could not delete
one or more files related to the page.'

Access 2003+

2859

Access could not load the e-mail envelope.This could be caused by a network
connection problem or a problem with your Office installation.@@@1@@1
Access 2007+ uses different description: 'Access could not load the e-mail
envelope.This could be caused by a network connection problem or a problem
with your Office installation.@@@1@@@1'

Access 2003+

2860 You cannot insert a bound field to a caption or record navigation section. Access 2003+

2861
Microsoft Office Access is unable to preview the selected web page. Access
2010+ uses different description: 'Microsoft Access is unable to preview the
selected web page.'

Access 2003+

Error Code Error Description Supported Versions

2862

|@The file you attempted to load was not recognized as HTML.@You may
have selected the wrong file, or tried to open a database file off of a web
server.@1@@1 Access 2007+ uses different description: '|@Access cannot
open the specified file type from a Web server.@You may have selected the
wrong file.@1@@@1'

Access 2003+

2863

|@Unable to create or load a file due to network or access permission
problems.@@1@@1 Access 2007+ uses different description: '|@Unable to
create or load a file due to network or access permission
problems.@@1@@@1'

Access 2003+

2864

|@This file (or a supporting file) is already in use, or has the read-only attribute
set.@@1@@1 Access 2007+ uses different description: '|@This file (or a
supporting file) is already in use, or has the read-only attribute
set.@@1@@@1'

Access 2003+

2865 |@The disk is write-protected.@@1@@1 Access 2007+ uses different
description: '|@The disk is write-protected.@@1@@@1' Access 2003+



2866 |@Unexpected data corruption failure.@@1@@1 Access 2007+ uses different
description: '|@Unexpected data corruption failure.@@1@@@1' Access 2003+

2867 |@Unexpected data I/O failure.@@1@@1 Access 2007+ uses different
description: '|@Unexpected data I/O failure.@@1@@@1' Access 2003+

2868

|@You cannot save this data access page over itself because it is read-
only.@Please select a different file for the save.@1@@1 Access 2007+ uses
different description: '|@You cannot save this data access page over itself
because it is read-only.@Please select a different file for the save.@1@@@1'

Access 2003+

2869

|@The file does not exist.@You do not have adequate permission to modify the
data access page link to point to a valid file.Please contact the database
administrator.@1@@1 Access 2007+ uses different description: '|@The file
does not exist.@You do not have adequate permission to modify the data access
page link to point to a valid file.Please contact the database
administrator.@1@@@1'

Access 2003+

2870

Microsoft Office Access encountered an error synchronizing the HTML from
the Microsoft Script Editor.@Please check the HTML for syntax errors and try
again.@@1@@1 Access 2007+ uses different description: 'Microsoft Office
Access encountered an error synchronizing the HTML from the Microsoft
Script Editor.@Please check the HTML for syntax errors and try
again.@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access encountered an error synchronizing the HTML from the Microsoft
Script Editor.@Please check the HTML for syntax errors and try
again.@@1@@@1'

Access 2003+

2871

Microsoft Office Access is unable to create a data access page using the
codepage selected in Web Options.@The codepage may not be installed on
your system.@Please install the codepage, or select a different one in Web
Options.@1@@1 Access 2007+ uses different description: 'Microsoft Office
Access is unable to create a data access page using the codepage selected in
Web Options.@The codepage may not be installed on your system.@Please
install the codepage, or select a different one in Web Options.@1@@@1'
Access 2010+ uses different description: 'Microsoft Access is unable to create
a data access page using the codepage selected in Web Options.@The codepage
may not be installed on your system.@Please install the codepage, or select a
different one in Web Options.@1@@@1'

Access 2003+

2873

|@The filename specified is a long filename, but you have the 'use long
filenames' web option turned off.@Please specify a file name that uses a
maximum of eight characters for the name and three characters for the file
extension.@1@@1 Access 2007+ uses different description: '|@The filename
specified is a long filename, but you have the 'use long filenames' web option
turned off.@Please specify a file name that uses a maximum of eight characters
for the name and three characters for the file extension.@1@@@1'

Access 2003+

2874 Cannot move or paste the grouping field '|' into a section at a higher group level Access 2003+

2875

|@Unable to complete the save.@The drive or network connection you
attempted to save to may no longer be available.@1@@1 Access 2007+ uses
different description: '|@Unable to complete the save.@The drive or network
connection you attempted to save to may no longer be available.@1@@@1'

Access 2003+

2876 The data definition of this data access page has been corrupted and can't be
repaired.You must recreate the page.Save has been disabled. Access 2003+

2877

In a Microsoft Office Access database (.mdb), you can't group on a control
bound to a field that has a Memo or OLE Object data type. In a Microsoft
Office Access project (.adp), you can't group on a control bound to a field that
has an Imageor Text data type. Access 2010+ uses different description: 'In a
Microsoft Access database (.mdb), you can't group on a control bound to a field
that has a Memo or OLE Object data type. In a Microsoft Access project (.adp),
you can't group on a control bound to a field that has an Imageor Text data
type.'

Access 2003+



2878 You cannot add a bound field to a caption or record navigation section. Access 2003+
2879 Caption and record navigation sections cannot contain bound fields. Access 2003+
2880 Can't edit pages that contain framesets. Access 2003+

2881
This web page contains XML namespaces that may conflict with Access
namespaces.You should edit the HTML source to ensure that all namespaces
have a unique prefix.

Access 2003+

2882

|@The folder that this Web page would use to organize supporting files is
already reserved for use in the current location.@Please choose a different
name or location for this Web page.@1@@1 Access 2007+ uses different
description: '|@The folder that this Web page would use to organize supporting
files is already reserved for use in the current location.@Please choose a
different name or location for this Web page.@1@@@1'

Access 2003+

Error Code Error Description Supported Versions

2883

A supporting file path for this data access page has been altered outside of
Access.@Please save this page to a different location and ensure that all
supporting files are maintained.@@1@@1 Access 2007+ uses different
description: 'A supporting file path for this data access page has been altered
outside of Access.@Please save this page to a different location and ensure that
all supporting files are maintained.@@1@@@1'

Access 2003+

2884
Cannot find the database or some database objects that this page refers
to.Update the connection information of the page, or fix the references to the
missing database objects.

Access 2003+

2885 This page uses a database which is not supported. You will not be able to make
data changes until you connect to a supported database Access 2003+

2886 Components necessary for data access pages are not installed. Access 2003+

2887

|@The path specified is not a valid absolute (non-relative) path or
URL.@Please enter a valid path.@1@@1 Access 2007+ uses different
description: '|@The path specified is not a valid absolute (non-relative) path or
URL.@Please enter a valid path.@1@@@1'

Access 2003+

2888

Microsoft Office Access detects some HTML elements between the banner and
the section of your data access page. Saving this page in Access will corrupt it.
Close the page without saving it, and then edit the page in another HTML editor
to remove these elements. Access 2010+ uses different description: 'Microsoft
Access detects some HTML elements between the banner and the section of
your data access page. Saving this page in Access will corrupt it. Close the page
without saving it, and then edit the page in another HTML editor to remove
these elements.'

Access 2003+

2889 This section cannot be deleted. Access 2003+

2890

You cannot edit this page because it contains frames.@The data access page
designer cannot edit pages with frames.@@1@@1 Access 2007+ uses
different description: 'You cannot edit this page because it contains
frames.@The data access page designer cannot edit pages with
frames.@@1@@@1'

Access 2003+

2892 You can't move the group filter control to another section. Delete the group
filter control from the current section and create it in a different section. Access 2003+

2893

A link to this data access page could not be created because the database cannot
be exclusively locked.@To create the link later, open the page by selecting 'Edit
web page that already exists', and then save.@@1@@1 Access 2007+ uses
different description: 'A link to this data access page could not be created
because the database cannot be exclusively locked.@To create the link later,
open the page by selecting 'Edit web page that already exists', and then
save.@@1@@@1'

Access 2003+

2894 The link to the data access page specified could not be updated because the
database cannot be exclusively locked.@To update the link, open this page

Access 2003+



again when you are the only person using the database.@@1@@1 Access
2007+ uses different description: 'The link to the data access page specified
could not be updated because the database cannot be exclusively locked.@To
update the link, open this page again when you are the only person using the
database.@@1@@@1'

2895

This page was designed with a version of the Microsoft Office Web
Components that is not currently installed on this machine.If you have not been
prompted to install those components on this page, please contact the page
author for the installation location.

Access 2003+

2896

The operation is only valid on a data access page opened in Design
View.@Please switch the page to Design View and try the operation
again.@@1@@1 Access 2007+ uses different description: 'The operation is
only valid on a data access page opened in Design View.@Please switch the
page to Design View and try the operation again.@@1@@@1'

Access 2003+

2897

You have opened a page that was last modified using Access 2000. To be able
to edit the page, you must save it using a more recent version of the Microsoft
Office Web Components. Do you want Access to convert this page by saving it
using a more recent version of the Microsoft Office Web Components?

Access 2003+

2898

Microsoft Office Access has created a backup copy of your original page.This
page can be used if you want to revert to the Office 2000 Web Components.
The backup page name is:'|' Access 2010 uses different description: 'Microsoft
Access has created a backup copy of your original page.This page can be used
if you want to revert to the Office 2000 Web Components. The backup page
name is:'|1'' Access 2013 uses different description: 'Microsoft Access has
created a backup copy of your original page.This page can be used if you want
to revert to the Office 2000 Web Components. The backup page name is:'|1''
Access 2016 uses different description: 'Microsoft Access has created a
backup copy of your original page.This page can be used if you want to revert
to the Office 2000 Web Components.The backup page name is:'|1''

Access 2003+

2899

Microsoft Office Access could not create a backup copy of your original page.
This page cannot be opened. Access 2010+ uses different description:
'Microsoft Access could not create a backup copy of your original page. This
page cannot be opened.'

Access 2003+

2900

Microsoft Office Access could not upgrade the Office Web Components on
your page.This page cannot be opened. Access 2010+ uses different
description: 'Microsoft Access could not upgrade the Office Web Components
on your page.This page cannot be opened.'

Access 2003+

2901 Error loading ActiveX control '|1' on form or report '|2'. Access 2003+

2902 Access is unable to save the | object because it does not support persistence, or
your computer may have run out of disk space. Access 2003+

2903
Do you want to set this folder as the default location for data access pages?
@|@@19@@1 Access 2007+ uses different description: 'Do you want to set
this folder as the default location for data access pages?@|@@19@@@1'

Access 2003+

Error Code Error Description Supported Versions

2904
You must match each field on the left with a field on the right.@@@@@1
Access 2007+ uses different description: 'You must match each field on the
left with a field on the right.@@@1@@@1'

Access 2003+

2905
You must choose a linking field for every parameter.@@@@@1 Access 2007+
uses different description: 'You must choose a linking field for every
parameter.@@@1@@@1'

Access 2003+

2906 '|' contains no fields that can participate in a relationship.@@@@@1 Access
2007+ uses different description: ''|' contains no fields that can participate in a
relationship.@The contents of the RecordSource property may be invalid, or
the RecordSource may contain only fields that are not acceptable for use in a

Access 2003+



join.@Correct the RecordSource property for this form or report and try your
field operation again.@1@@@1'

2907 Do you want to revert to the saved '|'?@@@19@@1 Access 2007+ uses
different description: 'Do you want to revert to the saved '|'?@@@19@@@1' Access 2003+

2908

The Control ID '|' is already in use. Specify a different ID for the
control.@@@@@1 Access 2007+ uses different description: 'The Control ID
'|' is already in use. Specify a different ID for the control.@@@@@@1' Access
2010+ uses different description: 'The Control ID '|' is already in use. Specify
a different ID for the control.'

Access 2003+

2909

This relationship is not valid because the fields in the first table do not match
the fields in the second table.@To repair the relationship, select at least one
field from each table.@@@@1 Access 2007+ uses different description:
'This relationship is not valid because the fields in the first table do not match
the fields in the second table.@To repair the relationship, select at least one
field from each table.@@@@@1' Access 2010+ uses different description:
'This relationship is not valid because the fields in the first table do not match
the fields in the second table.@To repair the relationship, select at least one
field from each table.@@1@@@1'

Access 2003+

2910

This connection file refers to a provider not supported by data access
pages.@Please select a different connection file.@@@@1 Access 2007+ uses
different description: 'This connection file refers to a provider not supported
by data access pages.@Please select a different connection file.@@@@@1'
Access 2010+ uses different description: 'This connection file refers to a
provider not supported by data access pages.@Please select a different
connection file.@@1@@@1'

Access 2003+

2911

You cannot change the data access page path while it it open.@Please close the
page and try again.@@@@1 Access 2007+ uses different description: 'You
cannot change the data access page path while it it open.@Please close the page
and try again.@@@@@1' Access 2010+ uses different description: 'You
cannot change the data access page path while it it open.@Please close the page
and try again.@@1@@@1'

Access 2003+

2912

If you create a data access page in this version of Access, you cannot open it in
Design view in Access 2000. If you have installed the Microsoft Office XP Web
Components, however, you can open this page in Page view in Access
2000.@&Don't show this warning again@@3@@1 Access 2007+ uses
different description: 'If you create a data access page in this version of
Access, you cannot open it in Design view in Access 2000. If you have installed
the Microsoft Office XP Web Components, however, you can open this page in
Page view in Access 2000.@&Don't show this warning again@@3@@@1'
Access 2010+ uses different description: 'If you create a Data Access Page in
this version of Access, you cannot open it in Design view in Access 2000.@If
you have installed the Microsoft Office XP Web Components, however, you
can open this page in Page view in Access 2000.@&Don't show this warning
again@3@@@1'

Access 2003+

2913

Cannot save to a URL address with a bookmark.@Please specify a valid
path.@@@@1 Access 2007+ uses different description: 'Cannot save to a
URL address with a bookmark.@Please specify a valid path.@@@@@1'
Access 2010+ uses different description: 'Cannot save to a URL address with
a bookmark.@Please specify a valid path.@@1@@@1'

Access 2003+

2914

Microsoft Office Access could not link to a connection file.@A connection
string will be embedded in the page.@@@@1 Access 2007+ uses different
description: 'Microsoft Office Access could not link to a connection file.@A
connection string will be embedded in the page.@@@@@1' Access 2010+
uses different description: 'Microsoft Access could not link to a connection
file.@A connection string will be embedded in the page.@@1@@@1'

Access 2003+



2915

Microsoft Office Access is unable to connect to the data source specified in the
connection string of this page.@The server may not exist on the network, or
there may be an error in the connection string information for this
page.@@1@@1 Access 2007+ uses different description: 'Microsoft Office
Access is unable to connect to the data source specified in the connection string
of this page.@The server may not exist on the network, or there may be an
error in the connection string information for this page.@@1@@@1' Access
2010+ uses different description: 'Microsoft Access is unable to connect to the
data source specified in the connection string of this page.@The server may not
exist on the network, or there may be an error in the connection string
information for this page.@@1@@@1'

Access 2003+

2916
You cannot edit HTML pages created using PowerPoint in Microsoft Office
Access. Access 2010+ uses different description: 'You cannot edit HTML
pages created using PowerPoint in Microsoft Access.'

Access 2003+

2917 Invalid HTML color value. Access 2003+

2918

Unable to open or read this connection file.@Either the file has been damaged
or the file format is not valid.@@@@1 Access 2007+ uses different
description: 'Unable to open or read this connection file.@Either the file has
been damaged or the file format is not valid.@@@@@1' Access 2010+ uses
different description: 'Unable to open or read this connection file.@Either the
file has been damaged or the file format is not valid.@@1@@@1'

Access 2003+

2919

You can't place this control in the section you specified.@@@@@1 Access
2007+ uses different description: 'You can't place this control in the section
you specified.@@@@@@1' Access 2010+ uses different description: 'You
can't place this control in the section you specified.'

Access 2003+

2920

Microsoft Office Access is unable to load the database schema.Save has been
disabled.Either repair or reinstall Microsoft Office. Access 2010+ uses
different description: 'Microsoft Access is unable to load the database
schema.@Save has been disabled.@Either repair or reinstall Microsoft
Office.@1@@@1'

Access 2003+

2921

Microsoft Office Access cannot open this page because it was created using a
newer version of Access. Try opening the page using a newer version of
Microsoft Office Access. Access 2010+ uses different description: 'Microsoft
Access cannot open this page because it was created using a newer version of
Access. Try opening the page using a newer version of Microsoft Access.'

Access 2003+

2922

Microsoft Office Access has created a backup copy of your original page.This
page can be used if you want to revert to the Office XP Web Components. The
backup page name is:'|' Access 2010 uses different description: 'Microsoft
Access has created a backup copy of your original page. This page can be used
if you want to revert to the Office XP Web Components. The backup page name
is: '|1'' Access 2013 uses different description: 'Microsoft Access has created a
backup copy of your original page. This page can be used if you want to revert
to the Office XP Web Components. The backup page name is: '|1'' Access 2016
uses different description: 'Microsoft Access has created a backup copy of
your original page. This page can be used if you want to revert to the Office XP
Web Components.The backup page name is: '|1''

Access 2003+

2923 You do not have the correct permissions. Contact the server administrator. Access 2007+
Error Code Error Description Supported Versions
2924 You cannot compact a file that was opened from a Web Server. Access 2007+
2925 You cannot encrypt a file that was opened from a Web Server. Access 2007+

2926 Because of your security settings and current security policy, this control is
disabled. To modify your policy and enable the database, use the Message Bar. Access 2007+

3000
Reserved error (|); there is no message for this error.@@@2@5363@1 Access
2007+ uses different description: 'Reserved error (|); there is no message for
this error.'

Access 2003+



3001 Invalid argument. Access 2003+
3002 Could not start session. Access 2003+
3003 Could not start transaction; too many transactions already nested. Access 2003+
3004 ********** Access 2003+
3005 '|' is not a valid database name. Access 2003+
3006 Database '|' is exclusively locked. Access 2003+
3007 Cannot open library database '|'. Access 2003+

3008 The table '|' is already opened exclusively by another user, or it is already open
through the user interface and cannot be manipulated programmatically. Access 2003+

3009

You tried to lock table '|' while opening it, but the table cannot be locked
because it is currently in use.Wait a moment, and then try the operation again.
Access 2010+ uses different description: 'You tried to lock table '|' while
opening it, but the table cannot be locked because it is currently in use. Wait a
moment, and then try the operation again.'

Access 2003+

3010 Table '|' already exists. Access 2003+

3011

The Microsoft Jet database engine could not find the object '|'.Make sure the
object exists and that you spell its name and the path name correctly. Access
2007+ uses different description: 'The Microsoft Office Access database
engine could not find the object '|'.Make sure the object exists and that you spell
its name and the path name correctly.' Access 2010+ uses different
description: 'The Microsoft Access database engine could not find the object '|'.
Make sure the object exists and that you spell its name and the path name
correctly. If '|' is not a local object, check your network connection or contact
the server administrator.'

Access 2003+

3012 Object '|' already exists. Access 2003+
3013 Could not rename installable ISAM file. Access 2003+
3014 Cannot open any more tables. Access 2003+
3015 Index not found. Access 2003+
3016 Field will not fit in record. Access 2003+
Error Code Error Description Supported Versions
3017 The size of a field is too long. Access 2003+
3018 Could not find field. Access 2003+
3019 Operation invalid without a current index. Access 2003+
3020 Update or CancelUpdate without AddNew or Edit. Access 2003+
3021 No current record. Access 2003+

3022

The changes you requested to the table were not successful because they would
create duplicate values in the index, primary key, or relationship.Change the
data in the field or fields that contain duplicate data, remove the index, or
redefine the index to permit duplicate entries and try again. Access 2010+ uses
different description: 'The changes you requested to the table were not
successful because they would create duplicate values in the index, primary
key, or relationship. Change the data in the field or fields that contain duplicate
data, remove the index, or redefine the index to permit duplicate entries and try
again.'

Access 2003+

3023 AddNew or Edit already used. Access 2003+
3024 Could not find file '|'. Access 2003+
3025 Cannot open any more files. Access 2003+
3026 Not enough space on disk. Access 2003+

3027 Cannot update.Database or object is read-only. Access 2010+ uses different
description: 'Cannot update. Database or object is read-only.' Access 2003+

3028 Cannot start your application. The workgroup information file is missing or
opened exclusively by another user. Access 2003+



3029 Not a valid account name or password. Access 2003+
3030 '|' is not a valid account name. Access 2003+
3031 Not a valid password. Access 2003+
3032 Cannot perform this operation. Access 2003+

3033

You do not have the necessary permissions to use the '|' object.Have your
system administrator or the person who created this object establish the
appropriate permissions for you. Access 2010+ uses different description:
'You do not have the necessary permissions to use the '|' object. Have your
system administrator or the person who created this object establish the
appropriate permissions for you.'

Access 2003+

3034 You tried to commit or rollback a transaction without first beginning a
transaction. Access 2003+

3035 System resource exceeded. Access 2003+
3036 Database has reached maximum size. Access 2003+
Error Code Error Description Supported Versions
3037 Cannot open any more tables or queries. Access 2003+
3038 System resource exceeded. Access 2003+
3039 Could not create index; too many indexes already defined. Access 2003+
3040 Disk I/O error during read. Access 2003+
3041 Cannot open a database created with a previous version of your application. Access 2003+
3042 Out of MS-DOS file handles. Access 2003+

3043 Disk or network error. Access 2007+ uses different description: 'Your network
access was interrupted. To continue, close the database, and then open it again.' Access 2003+

3044

'|' is not a valid path.Make sure that the path name is spelled correctly and that
you are connected to the server on which the file resides. Access 2010+ uses
different description: ''|' is not a valid path. Make sure that the path name is
spelled correctly and that you are connected to the server on which the file
resides.'

Access 2003+

3045 Could not use '|'; file already in use. Access 2003+
3046 Could not save; currently locked by another user. Access 2003+
3047 Record is too large. Access 2003+
3048 Cannot open any more databases. Access 2003+

3049

Cannot open database '|'.It may not be a database that your application
recognizes, or the file may be corrupt. Access 2010+ uses different
description: 'Cannot open database '|'. It may not be a database that your
application recognizes, or the file may be corrupt.'

Access 2003+

3050 Could not lock file. Access 2003+

3051

The Microsoft Jet database engine cannot open the file '|'.It is already opened
exclusively by another user, or you need permission to view its data. Access
2007+ uses different description: 'The Microsoft Office Access database
engine cannot open or write to the file '|'. It is already opened exclusively by
another user, or you need permission to view and write its data.' Access 2010+
uses different description: 'The Microsoft Access database engine cannot open
or write to the file '|'. It is already opened exclusively by another user, or you
need permission to view and write its data.'

Access 2003+

3052 File sharing lock count exceeded. Increase MaxLocksPerFile registry entry. Access 2003+
3053 Too many client tasks. Access 2003+
3054 Too many Memo, OLE, or Hyperlink Object fields. Access 2003+
3055 Not a valid file name. Access 2003+
3056 Could not repair this database. Access 2003+
Error Code Error Description Supported Versions



3057 Operation not supported on linked tables. Access 2003+
3058 Index or primary key cannot contain a Null value. Access 2003+
3059 Operation canceled by user. Access 2003+
3060 Wrong data type for parameter '|'. Access 2003+
3061 Too few parameters. Expected |. Access 2003+
3062 Duplicate output alias '|'. Access 2003+
3063 Duplicate output destination '|'. Access 2003+
3064 Cannot open action query '|'. Access 2003+
3065 Cannot execute a select query. Access 2003+
3066 Query must have at least one destination field. Access 2003+
3067 Query input must contain at least one table or query. Access 2003+
3068 Not a valid alias name. Access 2003+
3069 The action query '|' cannot be used as a row source. Access 2003+

3070

The Microsoft Jet database engine does not recognize '|' as a valid field name or
expression. Access 2007+ uses different description: 'The Microsoft Office
Access database engine does not recognize '|' as a valid field name or
expression.' Access 2010+ uses different description: 'The Microsoft Access
database engine does not recognize '|' as a valid field name or expression.'

Access 2003+

3071

This expression is typed incorrectly, or it is too complex to be evaluated.For
example, a numeric expression may contain too many complicated
elements.Try simplifying the expression by assigning parts of the expression to
variables. Access 2010+ uses different description: 'This expression is typed
incorrectly, or it is too complex to be evaluated. For example, a numeric
expression may contain too many complicated elements. Try simplifying the
expression by assigning parts of the expression to variables.'

Access 2003+

3072 | Access 2003+
3073 Operation must use an updateable query. Access 2003+
3074 Cannot repeat table name '|' in FROM clause. Access 2003+
3075 |1 in query expression '|2'. Access 2003+
3076 | in criteria expression. Access 2003+
Error Code Error Description Supported Versions
3077 | in expression. Access 2003+

3078

The Microsoft Jet database engine cannot find the input table or query '|'.Make
sure it exists and that its name is spelled correctly. Access 2007+ uses different
description: 'The Microsoft Office Access database engine cannot find the
input table or query '|'.Make sure it exists and that its name is spelled correctly.'
Access 2010+ uses different description: 'The Microsoft Access database
engine cannot find the input table or query '|'. Make sure it exists and that its
name is spelled correctly.'

Access 2003+

3079 The specified field '|' could refer to more than one table listed in the FROM
clause of your SQL statement. Access 2003+

3080 Joined table '|' not listed in FROM clause. Access 2003+
3081 Cannot join more than one table with the same name (|). Access 2003+
3082 JOIN operation '|' refers to a field that is not in one of the joined tables. Access 2003+
3083 Cannot use internal report query. Access 2003+
3084 Cannot insert data with action query. Access 2003+
3085 Undefined function '|' in expression. Access 2003+
3086 Could not delete from specified tables. Access 2003+
3087 Too many expressions in GROUP BY clause. Access 2003+
3088 Too many expressions in ORDER BY clause. Access 2003+
3089 Too many expressions in DISTINCT output. Access 2003+



3090 Resultant table not allowed to have more than one AutoNumber field. Access 2003+
3091 HAVING clause (|) without grouping or aggregation. Access 2003+
3092 Cannot use HAVING clause in TRANSFORM statement. Access 2003+
3093 ORDER BY clause (|) conflicts with DISTINCT. Access 2003+
3094 ORDER BY clause (|) conflicts with GROUP BY clause. Access 2003+
3095 Cannot have aggregate function in expression (|). Access 2003+
3096 Cannot have aggregate function in WHERE clause (|). Access 2003+
Error Code Error Description Supported Versions
3097 Cannot have aggregate function in ORDER BY clause (|). Access 2003+
3098 Cannot have aggregate function in GROUP BY clause (|). Access 2003+
3099 Cannot have aggregate function in JOIN operation (|). Access 2003+
3100 Cannot set field '|' in join key to Null. Access 2003+

3101

The Microsoft Jet database engine cannot find a record in the table '|2' with key
matching field(s) '|1'. Access 2007+ uses different description: 'The Microsoft
Office Access database engine cannot find a record in the table '|2' with key
matching field(s) '|1'.' Access 2010+ uses different description: 'The Microsoft
Access database engine cannot find a record in the table '|2' with key matching
field(s) '|1'.'

Access 2003+

3102 Circular reference caused by '|'. Access 2003+
3103 Circular reference caused by alias '|' in query definition's SELECT list. Access 2003+
3104 Cannot specify fixed column heading '|' in a crosstab query more than once. Access 2003+
3105 Missing destination field name in SELECT INTO statement (|). Access 2003+
3106 Missing destination field name in UPDATE statement (|). Access 2003+
3107 Record(s) cannot be added; no insert permission on '|'. Access 2003+
3108 Record(s) cannot be edited; no update permission on '|'. Access 2003+
3109 Record(s) cannot be deleted; no delete permission on '|'. Access 2003+
3110 Could not read definitions; no read definitions permission for table or query '|'. Access 2003+
3111 Could not create; no modify design permission for table or query '|'. Access 2003+
3112 Record(s) cannot be read; no read permission on '|'. Access 2003+
3113 Cannot update '|'; field not updateable. Access 2003+

3114 Cannot include Memo, OLE, or Hyperlink Object when you select unique
values (|). Access 2003+

3115 Cannot have Memo, OLE, or Hyperlink Object fields in aggregate argument (|). Access 2003+

3116 Cannot have Memo, OLE, or Hyperlink Object fields in criteria (|) for
aggregate function. Access 2003+

Error Code Error Description Supported Versions
3117 Cannot sort on Memo, OLE, or Hyperlink Object (|). Access 2003+
3118 Cannot join on Memo, OLE, or Hyperlink Object (|). Access 2003+
3119 Cannot group on Memo, OLE, or Hyperlink Object (|). Access 2003+
3120 Cannot group on fields selected with '*' (|). Access 2003+
3121 Cannot group on fields selected with '*'. Access 2003+

3122

You tried to execute a query that does not include the specified expression '|' as
part of an aggregate function. Access 2013+ uses different description: 'Your
query does not include the specified expression '|' as part of an aggregate
function.'

Access 2003+

3123 Cannot use '*' in crosstab query. Access 2003+
3124 Cannot input from internal report query (|). Access 2003+
3125 '|' is not a valid name.Make sure that it does not include invalid characters or

punctuation and that it is not too long. Access 2010+ uses different
Access 2003+



description: ''|' is not a valid name. Make sure that it does not include invalid
characters or punctuation and that it is not too long.'

3126 Invalid bracketing of name '|'. Access 2003+

3127

The INSERT INTO statement contains the following unknown field name:
'|'.Make sure you have typed the name correctly, and try the operation again.
Access 2010+ uses different description: 'The INSERT INTO statement
contains the following unknown field name: '|'. Make sure you have typed the
name correctly, and try the operation again.'

Access 2003+

3128 Specify the table containing the records you want to delete. Access 2003+

3129 Invalid SQL statement; expected 'DELETE', 'INSERT', 'PROCEDURE',
'SELECT', or 'UPDATE'. Access 2003+

3130 Syntax error in DELETE statement. Access 2003+
3131 Syntax error in FROM clause. Access 2003+
3132 Syntax error in GROUP BY clause. Access 2003+
3133 Syntax error in HAVING clause. Access 2003+
3134 Syntax error in INSERT INTO statement. Access 2003+
3135 Syntax error in JOIN operation. Access 2003+

3136 The LEVEL clause includes a reserved word or argument that is misspelled or
missing, or the punctuation is incorrect. Access 2003+

Error Code Error Description Supported Versions
3137 Missing semicolon (;) at end of SQL statement. Access 2003+
3138 Syntax error in ORDER BY clause. Access 2003+
3139 Syntax error in PARAMETER clause. Access 2003+
3140 Syntax error in PROCEDURE clause. Access 2003+

3141 The SELECT statement includes a reserved word or an argument name that is
misspelled or missing, or the punctuation is incorrect. Access 2003+

3142 Characters found after end of SQL statement. Access 2003+
3143 Syntax error in TRANSFORM statement. Access 2003+
3144 Syntax error in UPDATE statement. Access 2003+
3145 Syntax error in WHERE clause. Access 2003+
3146 ODBC--call failed. Access 2003+
3151 ODBC--connection to '|' failed. Access 2003+
3154 ODBC--could not find DLL '|'. Access 2003+
3155 ODBC--insert on a linked table '|' failed. Access 2003+
3156 ODBC--delete on a linked table '|' failed. Access 2003+
3157 ODBC--update on a linked table '|' failed. Access 2003+
3158 Could not save record; currently locked by another user. Access 2003+
3159 Not a valid bookmark. Access 2003+
3160 Table is not open. Access 2003+
3161 Could not decrypt file. Access 2003+
3162 You tried to assign the Null value to a variable that is not a Variant data type. Access 2003+
Error Code Error Description Supported Versions

3163

The field is too small to accept the amount of data you attempted to add.Try
inserting or pasting less data. Access 2010+ uses different description: 'The
field is too small to accept the amount of data you attempted to add. Try
inserting or pasting less data.'

Access 2003+

3164 Field cannot be updated. Access 2003+
3165 Could not open .inf file. Access 2003+
3166 Cannot locate the requested Xbase memo file. Access 2003+



3167 Record is deleted. Access 2003+
3168 Invalid .inf file. Access 2003+

3169

The Microsoft Jet database engine could not execute the SQL statement
because it contains a field that has an invalid data type. Access 2007+ uses
different description: 'The Microsoft Office Access database engine could not
execute the SQL statement because it contains a field that has an invalid data
type.' Access 2010+ uses different description: 'The Microsoft Access
database engine could not execute the SQL statement because it contains a field
that has an invalid data type.'

Access 2003+

3170 Could not find installable ISAM. Access 2003+
3171 Could not find network path or user name. Access 2003+
3172 Could not open Paradox.net. Access 2003+
3173 Could not open table 'MSysAccounts' in the workgroup information file. Access 2003+
3174 Could not open table 'MSysGroups' in the workgroup information file. Access 2003+
3175 Date is out of range or is in an invalid format. Access 2003+
3176 Could not open file '|'. Access 2003+
3177 Not a valid table name. Access 2003+
3179 Encountered unexpected end of file. Access 2003+
3180 Could not write to file '|'. Access 2003+
3181 Invalid range. Access 2003+
3182 Invalid file format. Access 2003+

3183

Not enough space on temporary disk. Access 2007+ uses different
description: 'The query cannot be completed. Either the size of the query result
is larger than the maximum size of a database (2 GB), or there is not enough
temporary storage space on the disk to store the query result.'

Access 2003+

Error Code Error Description Supported Versions
3184 Could not execute query; could not find linked table. Access 2003+
3185 SELECT INTO on a remote database tried to produce too many fields. Access 2003+
3186 Could not save; currently locked by user '|2' on machine '|1'. Access 2003+
3187 Could not read; currently locked by user '|2' on machine '|1'. Access 2003+
3188 Could not update; currently locked by another session on this machine. Access 2003+
3189 Table '|1' is exclusively locked by user '|3' on machine '|2'. Access 2003+
3190 Too many fields defined. Access 2003+
3191 Cannot define field more than once. Access 2003+
3192 Could not find output table '|'. Access 2003+
3193 (unknown) Access 2003+
3194 (unknown) Access 2003+
3195 (expression) Access 2003+

3196

The database '|' is already in use by another person or process.When the
database is available, try the operation again. Access 2010+ uses different
description: 'The database '|' is already in use by another person or process.
When the database is available, try the operation again.'

Access 2003+

3197

The Microsoft Jet database engine stopped the process because you and another
user are attempting to change the same data at the same time. Access 2007+
uses different description: 'The Microsoft Office Access database engine
stopped the process because you and another user are attempting to change the
same data at the same time.' Access 2010+ uses different description: 'The
Microsoft Access database engine stopped the process because you and another
user are attempting to change the same data at the same time.'

Access 2003+

3198 Could not start session.Too many sessions already active. Access 2010+ uses
different description: 'Could not start session. Too many sessions already

Access 2003+



active.'
3199 Could not find reference. Access 2003+

3200 The record cannot be deleted or changed because table '|' includes related
records. Access 2003+

3201 You cannot add or change a record because a related record is required in table
'|'. Access 2003+

3202 Could not save; currently locked by another user. Access 2003+
3203 Subqueries cannot be used in the expression (|). Access 2003+
Error Code Error Description Supported Versions
3204 Database already exists. Access 2003+
3205 Too many crosstab column headers (|). Access 2003+
3206 Cannot create a relationship between a field and itself. Access 2003+
3207 Operation not supported on a Paradox table with no primary key. Access 2003+
3208 Invalid Deleted setting in the Xbase keyof the Windows Registry. Access 2003+
3209 ********** Access 2003+

3210
The connection string is too long. Access 2007+ uses different description:
'The connection string is too long. The connection string cannot exceed 255
characters.'

Access 2003+

3211 The database engine could not lock table '|' because it is already in use by
another person or process. Access 2003+

3212 Could not lock table '|1'; currently in use by user '|3' on machine '|2'. Access 2003+
3213 Invalid Date setting in the Xbase key of the Windows Registry. Access 2003+
3214 Invalid Mark setting in the Xbase key of the Windows Registry. Access 2003+
3215 Too many Btrieve tasks. Access 2003+
3216 Parameter '|' specified where a table name is required. Access 2003+
3217 Parameter '|' specified where a database name is required. Access 2003+
3218 Could not update; currently locked. Access 2003+
3219 Invalid operation. Access 2003+
3220 Incorrect collating sequence. Access 2003+
3221 Invalid settings in the Btrieve key of the Windows Registry. Access 2003+
3222 Query cannot contain a Database parameter. Access 2003+
3223 '|' is invalid because it is too long, or contains invalid characters. Access 2003+
Error Code Error Description Supported Versions
3224 Cannot read Btrieve data dictionary. Access 2003+
3225 Encountered a record locking deadlock while performing a Btrieve operation. Access 2003+
3226 Errors encountered while using the Btrieve DLL. Access 2003+
3227 Invalid Century setting in the Xbase key of the Windows Registry. Access 2003+
3228 Selected collating sequence not supported by the operating system. Access 2003+
3229 Btrieve--cannot change field. Access 2003+
3230 Out-of-date Paradox lock file. Access 2003+
3231 ODBC--field would be too long; data truncated. Access 2003+
3232 ODBC--could not create table. Access 2003+
3234 ODBC--remote query timeout expired. Access 2003+
3235 ODBC--data type not supported on server. Access 2003+
3238 ODBC--data out of range. Access 2003+
3239 Too many active users. Access 2003+
3240 Btrieve--missing Btrieve engine. Access 2003+
3241 Btrieve--out of resources. Access 2003+



3242 Invalid reference in SELECT statement. Access 2003+
3243 None of the import field names match fields in the appended table. Access 2003+
3244 Cannot import password-protected spreadsheet. Access 2003+
3245 Could not parse field names from the first row of the import table. Access 2003+
3246 Operation not supported in transactions. Access 2003+
Error Code Error Description Supported Versions
3247 ODBC--linked table definition has changed. Access 2003+
3248 Invalid NetworkAccess setting in the Windows Registry. Access 2003+
3249 Invalid PageTimeout setting in the Windows Registry. Access 2003+
3250 Could not build key. Access 2003+
3251 Operation is not supported for this type of object. Access 2003+

3252 Cannot open a form whose underlying query contains a user-defined function
that attempts to set or get the form's RecordsetClone property. Access 2003+

3254 ODBC--Cannot lock all records. Access 2003+
3256 Index file not found. Access 2003+
3257 Syntax error in WITH OWNERACCESS OPTION declaration. Access 2003+

3258

The SQL statement could not be executed because it contains ambiguous outer
joins.To force one of the joins to be performed first, create a separate query that
performs the first join and then include that query in your SQL statement.
Access 2010+ uses different description: 'The SQL statement could not be
executed because it contains ambiguous outer joins. To force one of the joins to
be performed first, create a separate query that performs the first join and then
include that query in your SQL statement.'

Access 2003+

3259 Invalid field data type. Access 2003+
3260 Could not update; currently locked by user '|2' on machine '|1'. Access 2003+
3261 Table '|' is exclusively locked by user '|2' on machine '|1'. Access 2003+
3262 Could not lock table Access 2003+
3263 Invalid Database object. Access 2003+
3264 No field defined--cannot append TableDef or Index. Access 2003+
3265 Item not found in this collection. Access 2003+
3266 Cannot append a Field that is already a part of a Fields collection. Access 2003+

3267 Property can be set only when the Field is part of a Recordset object's Fields
collection. Access 2003+

3268 Cannot set this property once the object is part of a collection. Access 2003+
Error Code Error Description Supported Versions
3269 Cannot append an Index that is already a part of an Indexes collection. Access 2003+
3270 Property not found. Access 2003+
3271 Invalid property value. Access 2003+
3272 Object is not a collection. Access 2003+
3273 Method not applicable for this object. Access 2003+
3274 External table is not in the expected format. Access 2003+
3275 Unexpected error from external database driver (|). Access 2003+
3276 Invalid database object reference. Access 2003+
3277 Cannot have more than 10 fields in an index. Access 2003+

3278

The Microsoft Jet database engine has not been initialized. Access 2007+ uses
different description: 'The Microsoft Office Access database engine has not
been initialized.' Access 2010+ uses different description: 'The Microsoft
Access database engine has not been initialized.'

Access 2003+

3279 The Microsoft Jet database engine has already been initialized. Access 2007+
uses different description: 'The Microsoft Office Access database engine has

Access 2003+



already been initialized.' Access 2010+ uses different description: 'The
Microsoft Access database engine has already been initialized.'

3280 Cannot delete a field that is part of an index or is needed by the system. Access 2003+

3281
Cannot delete this index or table.It is either the current index or is used in a
relationship. Access 2010+ uses different description: 'Cannot delete this
index or table. It is either the current index or is used in a relationship.'

Access 2003+

3282 Operation not supported on a table that contains data. Access 2003+
3283 Primary key already exists. Access 2003+
3284 Index already exists. Access 2003+
3285 Invalid index definition. Access 2003+
3286 Format of memo file does not match specified external database format. Access 2003+
3287 Cannot create index on the given field. Access 2003+
3288 Paradox index is not primary. Access 2003+
Error Code Error Description Supported Versions
3289 Syntax error in CONSTRAINT clause. Access 2003+
3290 Syntax error in CREATE TABLE statement. Access 2003+
3291 Syntax error in CREATE INDEX statement. Access 2003+
3292 Syntax error in field definition. Access 2003+
3293 Syntax error in ALTER TABLE statement. Access 2003+
3294 Syntax error in DROP INDEX statement. Access 2003+
3295 Syntax error in DROP TABLE or DROP INDEX. Access 2003+

3296 Join expression not supported. Access 2007+ uses different description: 'JOIN
expression not supported.' Access 2003+

3297
Could not import table or query.No records found, or all records contain errors.
Access 2010+ uses different description: 'Could not import table or query. No
records found, or all records contain errors.'

Access 2003+

3298
There are several tables with that name.Please specify owner in the format
'owner.table'. Access 2010+ uses different description: 'There are several
tables with that name. Please specify owner in the format 'owner.table'.'

Access 2003+

3299

ODBC Specification Conformance Error (|).Report this error to the developer
of your application. Access 2010+ uses different description: 'ODBC
Specification Conformance Error (|). Report this error to the developer of your
application.'

Access 2003+

3300 Cannot create a relationship. Access 2003+

3301 Cannot perform this operation; features in this version are not available in
databases with older formats. Access 2003+

3302 Cannot change a rule while the rules for this table are in use. Access 2003+

3303
Cannot delete this field.It is part of one or more relationships. Access 2010+
uses different description: 'Cannot delete this field. It is part of one or more
relationships.'

Access 2003+

3304 You must enter a personal identifier (PID) consisting of at least 4 and no more
than 20 characters and digits. Access 2003+

3305 Invalid connection string in pass-through query. Access 2003+

3306

You have written a subquery that can return more than one field without using
the EXISTS reserved word in the main query's FROM clause.Revise the
SELECT statement of the subquery to request only one field. Access 2010+
uses different description: 'You have written a subquery that can return more
than one field without using the EXISTS reserved word in the main query's
FROM clause. Revise the SELECT statement of the subquery to request only
one field.'

Access 2003+

3307 The number of columns in the two selected tables or queries of a union query
do not match. Access 2003+



3308 Invalid TOP argument in select query. Access 2003+
Error Code Error Description Supported Versions
3309 Property value is too large. Access 2003+

3310 This property is not supported for external data sources or for databases created
with a previous version of Microsoft Jet. Access 2003+

3311 Property specified already exists. Access 2003+
3312 Validation rules and default values cannot be placed on system or linked tables. Access 2003+
3313 Cannot place this validation expression on this field. Access 2003+

3314
The field '|' cannot contain a Null value because the Required property for this
field is set to True.Enter a value in this field. Access 2007+ uses different
description: 'You must enter a value in the '|' field.'

Access 2003+

3315 Field '|' cannot be a zero-length string. Access 2003+
3316 | Access 2003+

3317

One or more values are prohibited by the validation rule '|2' set for '|1'.Enter a
value that the expression for this field can accept. Access 2010+ uses different
description: 'One or more values are prohibited by the validation rule '|2' set
for '|1'. Enter a value that the expression for this field can accept.'

Access 2003+

3318 Values specified in a TOP clause are not allowed in delete queries or reports. Access 2003+
3319 Syntax error in union query. Access 2003+
3320 | in table-level validation expression. Access 2003+
3321 No database specified in connection string or IN clause. Access 2003+
3322 Crosstab query contains one or more invalid fixed column headings. Access 2003+
3323 The query cannot be used as a row source. Access 2003+
3324 The query is a DDL query and cannot be used as a row source. Access 2003+

3325 Pass-through query with ReturnsRecords property set to True did not return any
records. Access 2003+

3326 This Recordset is not updateable. Access 2003+
3327 Field '|' is based on an expression and cannot be edited. Access 2003+

3328 Table '|2' is read-only. Access 2010+ uses different description: 'Table is read-
only.' Access 2003+

Error Code Error Description Supported Versions
3329 Record in table '|' was deleted by another user. Access 2003+
3330 Record in table '|' is locked by another user. Access 2003+
3331 To make changes to this field, first save the record. Access 2003+
3332 Cannot enter value into blank field on 'one' side of outer join. Access 2003+
3333 Records in table '|' would have no record on the 'one' side. Access 2003+
3334 Can be present only in version 1.0 format. Access 2003+
3335 DeleteOnly called with non-zero cbData. Access 2003+
3336 Btrieve: Invalid IndexDDF option in initialization setting. Access 2003+
3337 Invalid DataCodePage option in initialization setting. Access 2003+
3338 Btrieve: Xtrieve options are not correct in initialization setting. Access 2003+
3339 Btrieve: Invalid IndexDeleteRenumber option in initialization setting. Access 2003+
3340 Query '|' is corrupt. Access 2003+
3341 The current field must match the join key '|' in the table that serves as the 'one'

side of one-to-many relationship.Enter a record in the 'one' side table with the
desired key value, and then make the entry with the desired join key in the
'many-only' table. Access 2010+ uses different description: 'The current field
must match the join key '|' in the table that serves as the 'one' side of one-to-
many relationship. Enter a record in the 'one' side table with the desired key

Access 2003+



value, and then make the entry with the desired join key in the 'many-only'
table.'

3342 Invalid Memo, OLE, or Hyperlink Object in subquery '|'. Access 2003+
3343 Unrecognized database format '|'. Access 2003+

3344 The database engine does not recognize either the field '|1' in a validation
expression, or the default value in the table '|2'. Access 2003+

3345 Unknown or invalid field reference '|'. Access 2003+
3346 Number of query values and destination fields are not the same. Access 2003+
3347 Cannot add record(s); primary key for table '|' not in recordset. Access 2003+
3348 Cannot add record(s); join key of table '|' not in recordset. Access 2003+
Error Code Error Description Supported Versions

3349

Numeric field overflow. Access 2007+ uses different description: 'You cannot
record your changes because a value you entered violates the settings defined
for this table or list (for example, a value is less than the minimum or greater
than the maximum).Correct the error and try again.' Access 2010+ uses
different description: 'You cannot record your changes because a value you
entered violates the settings defined for this table or list (for example, a value is
less than the minimum or greater than the maximum). Correct the error and try
again.'

Access 2003+

3350 Object is invalid for operation. Access 2003+

3351

The ORDER BY expression (|) includes fields that are not selected by the
query.Only those fields requested in the first query can be included in an
ORDER BY expression. Access 2010+ uses different description: 'The
ORDER BY expression (|) includes fields that are not selected by the query.
Only those fields requested in the first query can be included in an ORDER BY
expression.'

Access 2003+

3352 No destination field name in INSERT INTO statement (|). Access 2003+
3353 Btrieve: Cannot find file Field.ddf. Access 2003+
3354 At most one record can be returned by this subquery. Access 2003+
3355 Syntax error in default value. Access 2003+

3356

You attempted to open a database that is already opened exclusively by user '|2'
on machine '|1'.Try again when the database is available. Access 2010+ uses
different description: 'You attempted to open a database that is already opened
exclusively by user '|2' on machine '|1'. Try again when the database is
available.'

Access 2003+

3357 This query is not a properly formed data-definition query. Access 2003+

3358

Cannot open the Microsoft Jet engine workgroup information file. Access
2007+ uses different description: 'Cannot open the Microsoft Office Access
database engine workgroup information file.' Access 2010+ uses different
description: 'Cannot open the Microsoft Access database engine workgroup
information file.'

Access 2003+

3359 Pass-through query must contain at least one character. Access 2003+
3360 Query is too complex. Access 2003+
3361 Unions not allowed in a subquery. Access 2003+

3362

Single-row update/delete affected more than one row of a linked table.Unique
index contains duplicate values. Access 2010+ uses different description:
'Single-row update/delete affected more than one row of a linked table. Unique
index contains duplicate values.'

Access 2003+

3363 Record(s) cannot be added; no corresponding record on the 'one' side. Access 2003+

3364 Cannot use Memo, OLE, or Hyperlink Object field '|' in the SELECT clause of
a union query. Access 2003+

3365 Property value not valid for REMOTE objects. Access 2003+



3366 Cannot append a relation with no fields defined. Access 2003+

3367
Cannot append.An object with that name already exists in the collection.
Access 2010+ uses different description: 'Cannot append. An object with that
name already exists in the collection.'

Access 2003+

3368 Relationship must be on the same number of fields with the same data types. Access 2003+
Error Code Error Description Supported Versions
3369 ********** Access 2003+

3370
Cannot modify the design of table '|'.It is in a read-only database. Access 2010+
uses different description: 'Cannot modify the design of table '|'. It is in a read-
only database.'

Access 2003+

3371 Cannot find table or constraint. Access 2003+
3372 No such index '|2' on table '|1'. Access 2003+

3373
Cannot create relationship.Referenced table '|' does not have a primary key.
Access 2010+ uses different description: 'Cannot create relationship.
Referenced table '|' does not have a primary key.'

Access 2003+

3374 The specified fields are not uniquely indexed in table '|'. Access 2003+
3375 Table '|1' already has an index named '|2'. Access 2003+
3376 Table '|' does not exist. Access 2003+
3377 No such relationship '|2' on table '|1'. Access 2003+
3378 There is already a relationship named '|' in the current database. Access 2003+

3379

Cannot create relationships to enforce referential integrity.Existing data in table
'|2' violates referential integrity rules in table '|1'. Access 2010+ uses different
description: 'Cannot create relationships to enforce referential integrity.
Existing data in table '|2' violates referential integrity rules in table '|1'.'

Access 2003+

3380 Field '|2' already exists in table '|1'. Access 2003+
3381 There is no field named '|2' in table '|1'. Access 2003+
3382 Size of field '|' is too long. Access 2003+

3383
Cannot delete field '|'.It is part of one or more relationships. Access 2010+ uses
different description: 'Cannot delete field '|'. It is part of one or more
relationships.'

Access 2003+

3384 Cannot delete a built-in property. Access 2003+
3385 User-defined properties do not support a Null value. Access 2003+
3386 Property '|' must be set before using this method. Access 2003+
3387 Cannot find TEMP directory. Access 2003+
3388 Unknown function '|2' in validation expression or default value on '|1'. Access 2003+
Error Code Error Description Supported Versions
3389 Query support unavailable. Access 2003+
3390 Account name already exists. Access 2003+

3391 An error has occurred.Properties were not saved. Access 2010+ uses different
description: 'An error has occurred. Properties were not saved.' Access 2003+

3392 ********** Access 2003+

3393 Cannot perform join, group, sort, or indexed restriction. A value being searched
or sorted on is too long. Access 2003+

3394 Cannot save property; property is a schema property. Access 2003+
3395 ********** Access 2003+

3396

Cannot perform cascading operation.Since related records exist in table '|',
referential integrity rules would be violated. Access 2010+ uses different
description: 'Cannot perform cascading operation. Since related records exist
in table '|', referential integrity rules would be violated.'

Access 2003+

3397 Cannot perform cascading operation.There must be a related record in table '|'.
Access 2010+ uses different description: 'Cannot perform cascading

Access 2003+



operation. There must be a related record in table '|'.'

3398
Cannot perform cascading operation.It would result in a null key in table '|'.
Access 2010+ uses different description: 'Cannot perform cascading
operation. It would result in a null key in table '|'.'

Access 2003+

3399
Cannot perform cascading operation.It would result in a duplicate key in table
'|'. Access 2010+ uses different description: 'Cannot perform cascading
operation. It would result in a duplicate key in table '|'.'

Access 2003+

3400
Cannot perform cascading operation.It would result in two updates to field '|2'
in table '|1'. Access 2010+ uses different description: 'Cannot perform
cascading operation. It would result in two updates to field '|2' in table '|1'.'

Access 2003+

3401

Cannot perform cascading operation.It would cause field '|' to become Null,
which is not allowed. Access 2010+ uses different description: 'Cannot
perform cascading operation. It would cause field '|' to become Null, which is
not allowed.'

Access 2003+

3402

Cannot perform cascading operation.It would cause field '|' to become a zero-
length string, which is not allowed. Access 2010+ uses different description:
'Cannot perform cascading operation. It would cause field '|' to become a zero-
length string, which is not allowed.'

Access 2003+

3403 Cannot perform cascading operation:'|'. Access 2003+

3404

Cannot perform cascading operation.The value entered is prohibited by the
validation rule '|2' set for '|1'. Access 2010+ uses different description: 'Cannot
perform cascading operation. The value entered is prohibited by the validation
rule '|2' set for '|1'.'

Access 2003+

3405 Error '|' in validation rule. Access 2003+

3406

The expression you are trying to use for the DefaultValue property is invalid
because '|'.Use a valid expression to set this property. Access 2010+ uses
different description: 'The expression you are trying to use for the
DefaultValue property is invalid because '|'. Use a valid expression to set this
property.'

Access 2003+

3407

The server's MSysConf table exists, but is in an incorrect format.Contact your
system administrator. Access 2010+ uses different description: 'The server's
MSysConf table exists, but is in an incorrect format. Contact your system
administrator.'

Access 2003+

3408 Too many FastFind Sessions were invoked. Access 2003+
Error Code Error Description Supported Versions
3409 Invalid field definition '|' in definition of index or relationship. Access 2003+

3411

Invalid entry.Cannot perform cascading operation in table '|1' because the value
entered is too large for field '|2'. Access 2010+ uses different description:
'Invalid entry. Cannot perform cascading operation in table '|1' because the
value entered is too large for field '|2'.'

Access 2003+

3412 Cannot perform cascading update on the table because it is currently in use by
another user. Access 2003+

3413 Cannot perform cascading operation on table '|1' because it is currently in use
by user '|3' on machine '|2'. Access 2003+

3414 Cannot perform cascading operation on table '|1' because it is currently in use. Access 2003+
3415 Zero-length string is valid only in a Text or Memo field. Access 2003+
3416 | Access 2003+
3417 An action query cannot be used as a row source. Access 2003+

3418

Cannot open '|'.Another user has the table open using a different network
control file or locking style. Access 2010+ uses different description: 'Cannot
open '|'. Another user has the table open using a different network control file or
locking style.'

Access 2003+



3419 Cannot open this Paradox 4.x or 5.x table because ParadoxNetStyle is set to 3.x
in the Windows Registry. Access 2003+

3420 Object invalid or no longer set. Access 2003+
3421 Data type conversion error. Access 2003+

3422
Cannot modify table structure.Another user has the table open. Access 2010+
uses different description: 'Cannot modify table structure. Another user has
the table open.'

Access 2003+

3423

You cannot use ODBC to import from, export to, or link an external Microsoft
Jet or ISAM database table to your database. Access 2007+ uses different
description: 'You cannot use ODBC to import from, export to, or link an
external Microsoft Office Access or ISAM database table to your database.'
Access 2010+ uses different description: 'You cannot use ODBC to import
from, export to, or link an external Microsoft Access or ISAM database table to
your database.'

Access 2003+

3424 Cannot create database because the locale is invalid. Access 2003+
3425 This method or property is not currently available on this Recordset. Access 2003+
3426 This action was cancelled by an associated object. Access 2003+
3427 Error in DAO automation. Access 2003+

3428

A problem occurred in your database.Correct the problem by repairing and
compacting the database. Access 2010+ uses different description: 'A problem
occurred in your database. Correct the problem by repairing and compacting the
database.'

Access 2003+

3429 Incompatible version of an installable ISAM. Access 2003+
Error Code Error Description Supported Versions

3430 While loading the Microsoft Excel installable ISAM, OLE was unable to
initialize. Access 2003+

3431 This is not a Microsoft Excel 5.0 file. Access 2003+
3432 Error opening a Microsoft Excel 5.0 file. Access 2003+
3433 Invalid setting in Excel key of the Engines section of the Windows Registry. Access 2003+
3434 Cannot expand named range. Access 2003+
3435 Cannot delete spreadsheet cells. Access 2003+
3436 Failure creating file. Access 2003+
3437 Spreadsheet is full. Access 2003+

3438 The data being exported does not match the format described in the Schema.ini
file. Access 2003+

3439 You attempted to link or import a Microsoft Word mail merge file. Although
you can export such files, you cannot link or import them. Access 2003+

3440 An attempt was made to import or link an empty text file. To import or link a
text file, the file must contain data. Access 2003+

3441 Text file specification field separator matches decimal separator or text
delimiter. Access 2003+

3442 In the text file specification '|1', the |2 option is invalid. Access 2003+
3443 The fixed width specification '|1' contains no column widths. Access 2003+
3444 In the fixed width specification '|1', column '|2' does not specify a width. Access 2003+
3445 Incorrect version of theDLL file '|' was found. Access 2003+

3446

Jet VBA file (VBAJET.dll for 16-bit versions, or VBAJET32.dll for 32-bit
versions) is missing. Try reinstalling the application that returned the error.
Access 2007+ uses different description: 'The VBA file (VBAJET.dll for 16-
bit versions, or VBAJET32.dll for 32-bit versions) is missing. Try reinstalling
the application that returned the error.' Access 2010+ uses different
description: 'VBAJET32.dll is missing. Try reinstalling the Microsoft Access
database engine.'

Access 2003+



3447

The Jet VBA file (VBAJET.dll for 16-bit versions, or VBAJET32.dll for 32-bit
versions) failed to initialize when called. Try reinstalling the application that
returned the error. Access 2007+ uses different description: 'The VBA file
(VBAJET.dll for 16-bit versions, or VBAJET32.dll for 32-bit versions) failed to
initialize when called. Try reinstalling the application that returned the error.'
Access 2010+ uses different description: 'VBAJET32.dll failed to initialize
when called. Try reinstalling the Microsoft Access database engine.'

Access 2003+

3448 A call to an OLE system function was not successful. Try reinstalling the
application that returned the error. Access 2003+

3449
No country code found in connection string for a linked table. Access 2007+
uses different description: 'No country/region code found in connection string
for a linked table.'

Access 2003+

Error Code Error Description Supported Versions

3450 Syntax error in query.Incomplete query clause. Access 2010+ uses different
description: 'Syntax error in query. Incomplete query clause.' Access 2003+

3451 Illegal reference in query. Access 2003+
3452 You cannot make changes to the design of the database at this replica. Access 2003+

3453 You cannot establish or maintain an enforced relationship between a replicated
table and a local table. Access 2003+

3455 Cannot make the database replicable. Access 2003+
3456 Cannot make the |2 object in |1 container replicable. Access 2003+
3457 You cannot set the KeepLocal property for an object that is already replicated. Access 2003+

3458 The KeepLocal property cannot be set on a database; it can be set only on the
objects in a database. Access 2003+

3459 After a database has been replicated, you cannot remove the replication features
from the database. Access 2003+

3460 The operation you attempted conflicts with an existing operation involving this
member of the replica set. Access 2003+

3461 The replication property you are attempting to set or delete is read-only and
cannot be changed. Access 2003+

3462 Failure to load a DLL. Access 2003+
3463 Cannot find the .dll '|2'. Access 2003+
3464 Data type mismatch in criteria expression. Access 2003+
3465 The disk drive you are attempting to access is unreadable. Access 2003+
3468 Access was denied while accessing dropbox folder '|2'. Access 2003+
3469 The disk for dropbox folder '|2' is full. Access 2003+
3470 Disk failure accessing dropbox folder '|2'. Access 2003+
3471 Failure to write to the Synchronizer log file. Access 2003+
3472 Disk full for path '|1'. Access 2003+
Error Code Error Description Supported Versions
3473 Disk failure while accessing log file '|1'. Access 2003+
3474 Cannot open the log file '|1' for writing. Access 2003+
3475 Sharing violation while attempting to open log file '|1' in Deny Write mode. Access 2003+
3476 Invalid dropbox path '|2'. Access 2003+
3477 Dropbox address '|2' is syntactically invalid. Access 2003+
3478 The replica is not a partial replica. Access 2003+
3479 Cannot designate a partial replica as the Design Master for the replica set. Access 2003+
3480 The relationship '|' in the partial filter expression is invalid. Access 2003+
3481 The table name '|' in the partial filter expression is invalid. Access 2003+
3482 The filter expression for the partial replica is invalid. Access 2003+



3483 The password supplied for the dropbox folder '|2' is invalid. Access 2003+

3484 The password used by the Synchronizer to write to a destination dropbox folder
is invalid. Access 2003+

3485 The object cannot be replicated because the database is not replicated. Access 2003+
3486 You cannot add a second Replication ID AutoNumber field to a table. Access 2003+
3487 The database you are attempting to replicate cannot be converted. Access 2003+
3488 The value specified is not a ReplicaID for any member in the replica set. Access 2003+

3489 The object specified cannot be replicated because it is missing anecessary
resource. Access 2003+

3490 Cannot create a new replica because the '|2' object in '|1' container could not be
replicated. Access 2003+

3491 The database must be opened in exclusive mode before it can be replicated. Access 2003+

3492 The synchronization failed because a design change could not be applied to one
of the replicas. Access 2003+

Error Code Error Description Supported Versions
3493 Cannot set the specified Registry parameter for the Synchronizer. Access 2003+
3494 Unable to retrieve the specified Registry parameter for the Synchronizer. Access 2003+
3495 There are no scheduled synchronization's between the two Synchronizers. Access 2003+

3496 Replication Manager cannot find the ExchangeID in the MSysExchangeLog
table. Access 2003+

3497 Unable to set a schedule for the Synchronizer. Access 2003+
3499 Cannot retrieve the full path information for a member of the replica set. Access 2003+
3500 You cannot specify two different Synchronizers to manage the same replica. Access 2003+
3502 The Design Master or replica is not being managed by a Synchronizer. Access 2003+
3503 The Synchronizer's Registry has no value set for the key you queried. Access 2003+

3504 The Synchronizer ID does not match an existing ID in the MSysTranspAddress
table. Access 2003+

3505 You attempted to delete or get information about a partial filter that does not
exist in MSysFilters. Access 2003+

3506 The Synchronizer is unable to open the Synchronizer log. Access 2003+
3507 Failure writing to the Synchronizer log. Access 2003+
3508 There is no active transport for the Synchronizer. Access 2003+
3509 Could not find a valid transport for this Synchronizer. Access 2003+

3510 The member of the replica set you are attempting to synchronize is currently
being used in another synchronization. Access 2003+

3512 Failed to read the dropbox folder. Access 2003+
3513 Failed to write to the dropbox folder. Access 2003+

3514 Synchronizer could not find any scheduled or on-demand synchronization's to
process. Access 2003+

3515

The Microsoft Jet database engine could not read the system clock on your
computer. Access 2007+ uses different description: 'The Microsoft Office
Access database engine could not read the system clock on your computer.'
Access 2010+ uses different description: 'The Microsoft Access database
engine could not read the system clock on your computer.'

Access 2003+

Error Code Error Description Supported Versions

3516
Destination synchronizer is not configured to support indirect
synchronronization, and the destination replica is unavailable for direct
synchronization.

Access 2003+

3517 Synchronizer could not find any messages to process. Access 2003+
3518 Could not find Synchronizer in the MSysTranspAddress table. Access 2003+



3519 Failed to send a message. Access 2003+

3520 The replica name or ID does not match a currently managed member of the
replica set. Access 2003+

3521 Two members of the replica set cannot be synchronized because there is no
common point to start the synchronization. Access 2003+

3522 Synchronizer cannot find the record of a specific synchronization in the
MSysExchangeLog table. Access 2003+

3523 Synchronizer cannot find a specific version number in the MSysSchChange
table. Access 2003+

3524 The history of design changes in the replica does not match the history in the
Design Master. Access 2003+

3525 Synchronizer could not access the message database. Access 2003+
3526 The name selected for the system object is already in use. Access 2003+
3527 The Synchronizer or Replication Manager could not find the system object. Access 2003+

3528 There is no new data in shared memory for the Synchronizer or Replication
Manager to read. Access 2003+

3529 The Synchronizer or Replication Manager found unread data in the shared
memory. The existing data will be overwritten. Access 2003+

3530 The Synchronizer is already serving a client. Access 2003+
3531 The wait period for an event has timed out. Access 2003+
3532 Synchronizer could not be initialized. Access 2003+
3533 The system object used by a process still exists after the process has stopped. Access 2003+

3534 Synchronizer looked for a system event but did not find one to report to the
client. Access 2003+

3535 Client has asked the Synchronizer to terminate operation. Access 2003+
Error Code Error Description Supported Versions

3536 Synchronizer received an invalid message for a member of the replica set that it
manages. Access 2003+

3537 The Synchronizer's client is no longer present and cannot be notified. Access 2003+
3538 Cannot initialize Synchronizer because there are too many applications running. Access 2003+
3539 A system error has occurred or your swap file has reached its limit. Access 2003+
3540 Your swap file has reached its limit or is corrupted. Access 2003+
3541 Synchronizer could not be shut down properly and is still active. Access 2003+
3542 Process stopped when attempting to terminate Synchronizer client. Access 2003+
3543 Synchronizer has not been set up. Access 2003+
3544 Synchronizer is already running. Access 2003+

3545 The two replicas you are attempting to synchronize are from different replica
sets. Access 2003+

3546 The type of synchronization you are attempting is not valid. Access 2003+

3547 Synchronizer could not find a replica from the correct set to complete the
synchronization. Access 2003+

3548 GUIDs do not match or the requested GUID could not be found. Access 2003+
3549 The file name you provided is too long. Access 2003+
3550 There is no index on the GUID column. Access 2003+
3551 Unable to delete the specified Registry parameter for the Synchronizer. Access 2003+
3552 The size of the Registry parameter exceeds the maximum allowed. Access 2003+
3553 The GUID could not be created. Access 2003+
3555 All valid nicknames for replicas are already in use. Access 2003+
3556 Invalid path for destination dropbox folder. Access 2003+



Error Code Error Description Supported Versions
3557 Invalid address for destination dropbox folder. Access 2003+
3558 Disk I/O error at destination dropbox folder. Access 2003+
3559 Failure to write because destination disk is full. Access 2003+

3560 The two members of the replica set you are attempting to synchronize have the
same ReplicaID. Access 2003+

3561 The two members of the replica set you are attempting to synchronize are both
Design Masters. Access 2003+

3562 Access denied at destination dropbox folder. Access 2003+
3563 Fatal error accessing a local dropbox folder. Access 2003+
3564 Synchronizer cannot find the source file for messages. Access 2003+

3565 There is a sharing violation in the source dropbox folder because the message
database is open in another application. Access 2003+

3566 Network I/O error. Access 2003+
3567 Message in dropbox folder belongs to the wrong Synchronizer. Access 2003+
3568 Synchronizer could not delete a file. Access 2003+

3569 This member of the replica set has been logically removed from the set and is
no longer available. Access 2003+

3570
The filters defining a partial replica have been changed.The partial replica must
be repopulated. Access 2010+ uses different description: 'The filters defining
a partial replica have been changed. The partial replica must be repopulated.'

Access 2003+

3571 The attemptto set a column in a partial replica violated a rule governing partial
replicas. Access 2003+

3572 A disk I/O error occurred while reading or writing to the TEMP directory. Access 2003+
3573 The directory you queried for a list of replicas is not a managed directory. Access 2003+

3574 The ReplicaID for this member of the replica set was reassigned during a move
or copy procedure. Access 2003+

3575 The disk drive you are attempting to write to is full. Access 2003+

3576 The database you are attempting to open is already in use by another
application. Access 2003+

Error Code Error Description Supported Versions
3577 Cannot update replication system column. Access 2003+

3578 Failure to replicate database; cannot determine whether the database is open in
exclusive mode. Access 2003+

3579 Could not create replication system tables needed to make the database
replicable. Access 2003+

3580 Could not add rows needed to make the database replicable. Access 2003+
3581 Cannot open replication system table '|' because the table is already in use. Access 2003+

3582 Cannot make a new replica because the |2 object in |1 container could not be
made replicable. Access 2003+

3583 Cannot make the |2 object in |1 container replicable. Access 2003+
3584 Insufficient memory to complete operation. Access 2003+

3585 Cannot replicate the table; the number of columns exceeds the maximum
allowed. Access 2003+

3586 Syntax error in partial filter expression on table |1. Access 2003+
3587 Invalid expression in the ReplicaFilter property. Access 2003+
3588 Error when evaluating the partial filter expression. Access 2003+
3589 The partial filter expression contains an unknown function. Access 2003+
3590 Violates the rules for partial replicas. Access 2003+
3591 Log file path '|1' is invalid. Access 2003+



3592 You cannot replicate a password-protected database or set password protection
on a replicated database. Access 2003+

3593 You cannot change the data master attribute for the replica set. Access 2003+

3594

You cannot change the data master attribute for the replica set.It allows data
changes only at the Design Master. Access 2010+ uses different description:
'You cannot change the data master attribute for the replica set. It allows data
changes only at the Design Master.'

Access 2003+

3595 The system tables in your replica are no longer reliable and the replica should
not be used. Access 2003+

3600 Aggregation expressions cannot use GUIDs. Access 2003+
Error Code Error Description Supported Versions

3605 Synchronizing with a non-replicated database is not allowed. The '|' database is
not a Design Master or replica. Access 2003+

3607 The replication property you are attempting to delete is read-only and cannot be
removed. Access 2003+

3608 Record length is too long for an indexed Paradox table. Access 2003+
3609 No unique index found for the referenced field of the primary table. Access 2003+
3610 Same table '|' referenced as both the source and destination in make-table query. Access 2003+
3611 Cannot execute data definition statements on linked data sources. Access 2003+
3612 Multi-level GROUP BY clause is not allowed in a subquery. Access 2003+
3613 Cannot create a relationship on linked ODBC tables. Access 2003+
3614 GUID not allowed in Find method criteria expression. Access 2003+
3615 Type mismatch in expression. Access 2003+
3616 Updating data in a linked table is not supported by this ISAM. Access 2003+
3617 Deleting data in a linked table is not supported by this ISAM. Access 2003+
3618 Exceptions table could not be created on import/export. Access 2003+
3619 Records could not be added to exceptions table. Access 2003+
3620 The connection for viewing your linked Microsoft Excel worksheet was lost. Access 2003+
3621 Cannot change password on a shared open database. Access 2003+

3622 You must use the dbSeeChanges option with OpenRecordset when accessing a
SQL Server table that has an IDENTITY column. Access 2003+

3623 Cannot access the FoxPro 3.0 bound DBF file '|'. Access 2003+
3624 Could not read the record; currently locked by another user. Access 2003+

3625

The text file specification '|' does not exist.You cannot import, export, or link
using the specification. Access 2010+ uses different description: 'The text file
specification '|' does not exist. You cannot import, export, or link using the
specification.'

Access 2003+

Error Code Error Description Supported Versions

3626

The operation failed.There are too many indexes on table '|'.Delete some of the
indexes on the table and try the operation again. Access 2010+ uses different
description: 'The operation failed. There are too many indexes on table '|'.
Delete some of the indexes on the table and try the operation again.'

Access 2003+

3627 Cannot find the executable file for the Synchronizer (mstran40.exe). Access 2003+
3628 Partner replica is not managed by a Synchronizer. Access 2003+
3629 Synchronizer '|1' is also using the same File System dropbox '|2'. Access 2003+
3630 Synchronizer '|1' is also using the same File System dropbox '|2'. Access 2003+
3631 Invalid Table Name In Filter Access 2003+
3632 Internet Transport not enabled on the remote Synchronizer. Access 2003+
3633 Cannot load DLL:'|' Access 2003+
3634 Cannot create a replica using a partial replica. Access 2003+



3635 Cannot create partial replica of a system database. Access 2003+

3636 Cannot populate the replica or change the replica's filter because the replica has
conflicts or data errors. Access 2003+

3637 Cannot use the crosstab of a non-fixed column as a subquery. Access 2003+
3638 A Source Controlled database cannot be made replicable. Access 2003+
3639 Cannot create a replica of a System database. Access 2003+
3640 The fetch buffer was too small for the amount of data you requested. Access 2003+
3641 There are fewer records remaining in the recordset than you requested. Access 2003+
3642 A cancel was performed on the operation. Access 2003+
3643 One of the records in the recordset was deleted by another process. Access 2003+
3645 One of the binding parameters is incorrect. Access 2003+
3646 The specified row length is shorter than the sum of the column lengths. Access 2003+
Error Code Error Description Supported Versions
3647 A column requested is not being returned to the recordset. Access 2003+
3648 Cannot synchronize a partial replica with another partial replica. Access 2003+
3649 The language-specific code page was not specified or could not be found. Access 2003+

3650 Either the Internet is very slow or there is some problem in the replication
manager setup on the internet server machine. Access 2003+

3651 Invalid internet address. Access 2003+
3652 Internet login failure. Access 2003+
3653 Internet not set up. Access 2003+
3654 Internal internet failure. Access 2003+
3655 The wininet.dll cannot be loaded or initialized. Access 2003+
3656 Error in evaluating a partial expression Access 2003+
3657 Error in evaluating the boolean filter expression for table '|1'. Access 2003+
3658 Binary column '|' cannot be used in a boolean filter. Access 2003+

3659 Relationship '|1' is unenforced. Relationship in a partial filter expression must
be enforced. Access 2003+

3660 Requested exchange failed because '|1'. Access 2003+
3661 Requested exchange failed because '|1' Access 2003+
3663 This operation requires a different cursor library. Access 2003+

3664 An asynchronous OpenConnection call is not yet complete; you cannot yet
reference the returned connection object until it is complete. Access 2003+

3665 You cannot modify the replication system object '|'. Access 2003+
3666 You cannot modify the replication system object '|'. Access 2003+
3667 A different operation is preventing this operation from being executed. Access 2003+
Error Code Error Description Supported Versions
3668 Cannot perform this operation because there is no active connection. Access 2003+
3669 Execution cancelled. Access 2003+
3670 Cursor is not valid. Access 2003+
3671 Cannot find table to update. Access 2003+
3672 Failed to load RDOCURS.DLL. Access 2003+

3673 This table contains cells that are outside the range of cells defined in this
spreadsheet. Access 2003+

3674 Internet dll (wininet.dll) could not be found or loaded. Access 2003+
3675 Failure to read from an internet handle. Try the operation again. Access 2003+
3676 Failure to write to an internet handle. Try the operation again. Access 2003+
3677 Failure to execute the HTTP request to start internet synchronizer on the

internet server. Use Replication Manager to configure internet synchronizer on
Access 2003+



the internet server.

3678 Failure to connect to the FTP service on the internet server. Make sure that FTP
service is running properly on the server and supports anonymous connections. Access 2003+

3679 Failure to do open file using FTP service. Make sure that FTP dropbox has read
permissions. Access 2003+

3680 Failure in getting a file from the server using FTP. Make sure that FTP dropbox
has read permissions. Access 2003+

3681 Failure in putting a file to the server using FTP. Make sure that FTP dropbox
has write permissions. Access 2003+

3682 Failure to delete a file on the server using FTP. Make sure that FTP dropbox has
read and write permissions. Access 2003+

3683 Internet synchronizer exited unexpectedly on the server. Look at the partner
replica exchange history on the internet server to figure out the problem. Access 2003+

3684 There is no suitable replica with which to exchange. Access 2003+
3685 Invalid HTTP address. Access 2003+
3686 Invalid replica path or name. Access 2003+
3687 Invalid SQL syntax - expected token: Option. Access 2003+
Error Code Error Description Supported Versions
3688 Invalid SQL syntax - expected token: For. Access 2003+
3689 Invalid SQL syntax - expected token: Privileges. Access 2003+
3690 Invalid SQL syntax - expected a table right/privilege. Access 2003+
3691 Invalid SQL syntax - expected an object name. Access 2003+

3692

Invalid SQL syntax - related tokens did not match.Jet expected GRANT...TO,
REVOKE...FROM, ADD...TO, or DROP...FROM. Access 2007+ uses
different description: 'Invalid SQL syntax - related tokens did not
match.Microsoft Office Access database engine expected GRANT...TO,
REVOKE...FROM, ADD...TO, or DROP...FROM.' Access 2010+ uses
different description: 'Invalid SQL syntax - related tokens did not match. The
Microsoft Access database engine expected GRANT...TO, REVOKE...FROM,
ADD...TO, or DROP...FROM.'

Access 2003+

3693 Invalid SQL syntax - expected user or group name. Access 2003+
3694 Invalid SQL syntax - expected token: Grant. Access 2003+
3695 Invalid SQL syntax - GRANT/REVOKE syntax error. Access 2003+
3696 Invalid SQL syntax - expected token: User (or) Group. Access 2003+
3697 Invalid SQL syntax - expected token: Password. Access 2003+
3698 Invalid SQL syntax - expected password. Access 2003+
3699 Invalid SQL syntax - expected token: User. Access 2003+
3700 Invalid precision for decimal data type. Access 2003+
3701 Invalid scale for decimal data type. Access 2003+
3702 The width of a Unicode text column must be an even number of bytes. Access 2003+

3703 Operation not supported on replicable databases that have not been converted to
the current version. Access 2003+

3704

You attempted to open a database that is already opened by user '|2' on machine
'|1'.Try again when the database is available. Access 2010+ uses different
description: 'You attempted to open a database that is already opened by user
'|2' on machine '|1'. Try again when the database is available.'

Access 2003+

3705 Cannot make the |2 table replicable - too many columns. Access 2003+
3706 Cannot make the |2 table replicable - too many indexes. Access 2003+
3707 The cascading options for the new reference conflict with existing reference '|'. Access 2003+
Error Code Error Description Supported Versions



3708
Syntax error in Transaction statement.Expected TRANSACTION, WORK, or
nothing. Access 2010+ uses different description: 'Syntax error in Transaction
statement. Expected TRANSACTION, WORK, or nothing.'

Access 2003+

3709 The search key was not found in any record. Access 2003+
3710 MAPI folder or address book not found. Access 2003+

3711
Recovered replicable data. This row was recovered from a corrupted replicable
database. Verify that the record contents are correct and then reinsert the record,
or delete this conflict record.

Access 2003+

3712 Other. This record was rejected due to an undefined replication conflict
problem. Access 2003+

3713

Update/update conflict. Another replica also updated this record.This record
lost the conflict.Either resubmit your update or delete this conflict record.
Access 2010+ uses different description: 'Update/update conflict. Another
replica also updated this record. This record lost the conflict. Either resubmit
your update or delete this conflict record.'

Access 2003+

3714

Locked table. This record could not be applied during synchronization since the
table was locked by another user.Resubmit this conflict record. Access 2010+
uses different description: 'Locked table. This record could not be applied
during synchronization since the table was locked by another user. Resubmit
this conflict record.'

Access 2003+

3715

Unique key violation. This record has the same key value as another record,
whereas only unique values are permitted.Either change the key value in this
conflict record or the winning record and then resubmit this record, or delete
this conflict record. Access 2010+ uses different description: 'Unique key
violation. This record has the same key value as another record, whereas only
unique values are permitted. Either change the key value in this conflict record
or the winning record and then resubmit this record, or delete this conflict
record.'

Access 2003+

3716

TLV violation. This record contains a field value that does not meet the table
level validation constraint.Either update the field value that is violating the
validation rule and then resubmit this conflict record, or delete this conflict
record. Access 2010+ uses different description: 'TLV violation. This record
contains a field value that does not meet the table level validation constraint.
Either update the field value that is violating the validation rule and then
resubmit this conflict record, or delete this conflict record.'

Access 2003+

3717

Delete/RI conflict. The primary key record has been deleted by another replica,
therefore this referencing record has been rejected.Either create a new primary
key record that satisfies the referential integrity constraint and then resubmit
your update, or delete this conflict record. Access 2010+ uses different
description: 'Delete/RI conflict. The primary key record has been deleted by
another replica, therefore this referencing record has been rejected. Either
create a new primary key record that satisfies the referential integrity constraint
and then resubmit your update, or delete this conflict record.'

Access 2003+

3718

Update/RI conflict. The primary key record has been updated by another
replica, therefore this referencing record has been rejected.Either create a new
primary key record that satisfies the referential integrity constraint, modify the
foreign key value in this conflict record to match a valid primary key value and
then resubmit your update, or delete this conflict record. Access 2010+ uses
different description: 'Update/RI conflict. The primary key record has been
updated by another replica, therefore this referencing record has been rejected.
Either create a new primary key record that satisfies the referential integrity
constraint, modify the foreign key value in this conflict record to match a valid
primary key value and then resubmit your update, or delete this conflict record.'

Access 2003+

3719 Foreign key violation resulting from an invalid primary key record that was
involved in a replication conflict.Either create a new primary key record that
satisfies the referential integrity constraint, modify the foreign key value in this

Access 2003+



conflict record to match a valid primary key value and then resubmit this
conflict record, or delete this conflict record. Access 2010+ uses different
description: 'Foreign key violation resulting from an invalid primary key
record that was involved in a replication conflict. Either create a new primary
key record that satisfies the referential integrity constraint, modify the foreign
key value in this conflict record to match a valid primary key value and then
resubmit this conflict record, or delete this conflict record.'

3720
Cannot change field '|'.It is part of one or more relationships. Access 2010+
uses different description: 'Cannot change field '|'. It is part of one or more
relationships.'

Access 2003+

3721 Invalid SQL syntax - expected constraint name. Access 2003+
3722 Invalid SQL syntax - expected token: DEFAULT. Access 2003+
3723 Invalid SQL syntax - expected token: COMPRESSION to follow WITH. Access 2003+
3724 Invalid SQL syntax - expected token: UPDATE or DELETE. Access 2003+

3725 Invalid SQL syntax - expected token: CASCADE, SET NULL, or NO
ACTION. Access 2003+

3726 Invalid SQL syntax - expected token: NULL. Access 2003+
3727 Invalid SQL syntax - only one update rule and/or one delete rule allowed. Access 2003+
Error Code Error Description Supported Versions
3728 Invalid SQL syntax - expected token: AS. Access 2003+
3729 Invalid SQL syntax - expected token: SELECT. Access 2003+
3730 VIEW cannot contain a parameter. Access 2003+

3731 The number of aliases specified shall be the same as the number of output
columns. Access 2003+

3732 Expected query name after EXECUTE. Access 2003+

3733 The database has been placed in a state by an unknown user that prevents it
from being opened or locked. Access 2003+

3734 The database has been placed in a state by user '|2' on machine '|1' that prevents
it from being opened or locked. Access 2003+

3735 Too many columns in inverted index. Access 2003+

3736 Update/delete conflict. This updated record was deleted at another replica.
Either reinsert this conflict record or delete it. Access 2003+

3737 Cannot create this type of replica from the given source replica. Access 2003+
3738 Local or Anonymous replicas must synch only to their designated hub replica. Access 2003+
3739 The proxy replica has been removed. Access 2003+

3740

Cannot add a new column to conflict table '|'.Delete obsolete columns and
compact the database. Access 2010+ uses different description: 'Cannot add a
new column to conflict table '|'. Delete obsolete columns and compact the
database.'

Access 2003+

3741

Invalid partner synchronizer.Local or anonymous replica must synchronize with
designated hub replica. Access 2010+ uses different description: 'Invalid
partner synchronizer. Local or anonymous replica must synchronize with
designated hub replica.'

Access 2003+

3742 An internet function timed out. Access 2003+
3743 Replica has not been synchronized within the replica set retention period. Access 2003+
3744 Counter columns in replicable tables cannot be modified. Access 2003+

3745 The combined length of Internet Server Name, HTTP Share name, and FTP
alias name should not be greater than 252 characters. Access 2003+

3746 Syntax error in parameters clause. Make sure the parameter exists and that you
typed its value correctly. Access 2003+

3747 Parameter has no default value. Access 2003+



Error Code Error Description Supported Versions
3748 Parameter | has no default value. Access 2003+
3749 The object is not a stored procedure. Access 2003+
3750 Object | is not a stored procedure. Access 2003+
3751 Requested row locking, but DB is in page lock mode. Access 2003+
3752 Requested page locking, but DB is in row lock mode. Access 2003+

3753

Cannot create replica of a Jet SQL replica. Access 2007+ uses different
description: 'Cannot create replica of a Microsoft Office Access database
engine SQL replica.' Access 2010+ uses different description: 'Cannot create
replica of a Microsoft Access database engine SQL replica.'

Access 2003+

3754 Cannot delete from a Prevent Deletes Replica. Access 2003+
3755 CHECK constraint '|' does not exist. Access 2003+
3756 CHECK constraint '|' already exists. Access 2003+

3757

The Jet sorting DLLs could not be loaded properly. Access 2007+ uses
different description: 'The Microsoft Office Access database engine sorting
DLLs could not be loaded properly.' Access 2010+ uses different description:
'The Microsoft Access database engine sorting DLLs could not be loaded
properly.'

Access 2003+

3758 Scaling of decimal value resulted in data truncation. Access 2003+
3759 Scaling of decimal value resulted in data truncation. Access 2003+
3760 Scaling of decimal value resulted in data overflow. Access 2003+

3761 The decimal field's precision is too small to accept the numeric you attempted
to add. Access 2003+

3762 Invalid SQL syntax - expected token: ACTION. Access 2003+

3763
Concurrent schema changes caused the create replica operation to fail.Try
again. Access 2010+ uses different description: 'Concurrent schema changes
caused the create replica operation to fail. Try again.'

Access 2003+

3764 Failed to re-create one or more indexes. Access 2003+
3765 Syntax error in CHECK constraint clause. Access 2003+
3766 Only simple SELECT queries are allowed in VIEWS. Access 2003+

3767 Table '|' could not be made replicable because it could not be opened
exclusively. Access 2003+

Error Code Error Description Supported Versions
3768 FastFind cannot search on non-column references. Access 2003+
3769 Conflict tables cannot be renamed. Access 2003+
3770 Counter definition not in valid range. Access 2003+
3771 Local or Anonymous replicas cannot be made the design master. Access 2003+
3772 Without Administer permission, replica priority must be in the range 0 - |. Access 2003+
3773 Cannot delete one or more objects: |. Access 2003+
3774 Pin value is not valid. Access 2003+

3775

Unable to load Jet SQL Server Reconciler - MSRPJT40.dll. Access 2007+ uses
different description: 'Unable to load Microsoft Office Access database SQL
Server Reconciler - MSRPJT40.dll.' Access 2010+ uses different description:
'Unable to load Microsoft Access database SQL Server Reconciler -
MSRPJT40.dll.'

Access 2003+

3776

Unable to exchange between two Jet SQL Server Replicas. Access 2007+ uses
different description: 'Unable to exchange between two Microsoft Office
Access database SQL Server Replicas.' Access 2010+ uses different
description: 'Unable to exchange between two Microsoft Access database SQL
Server Replicas.'

Access 2003+



3777

Illegal Operation performed on a Jet SQL Server Replica. Access 2007+ uses
different description: 'Illegal Operation performed on a Microsoft Office
Access database SQL Server Replica.' Access 2010+ uses different
description: 'Illegal Operation performed on a Microsoft Access database SQL
Server Replica.'

Access 2003+

3778

The Jet database is wrong or missing for this SQL/Jet replica set. Access 2007+
uses different description: 'The Microsoft Office Access database is wrong or
missing for this SQL/Microsoft Office Access database replica set.' Access
2010+ uses different description: 'The Microsoft Access database is wrong or
missing for this SQL/Microsoft Access database replica set.'

Access 2003+

3779 Unable to change Column Level Tracking Property on objects that are already
Replicable. Access 2003+

3780 Invalid SQL syntax - expected a view name. Access 2003+
3781 Invalid SQL syntax - expected a procedure name. Access 2003+

3782 Invalid SQL syntax - currently only one column-level CHECK constraint is
allowed. Access 2003+

3783 Invalid SQL syntax - cannot use multiple columns in a column-level CHECK
constraint. Access 2003+

3784 Database is already replicable. Access 2003+
3785 Invalid SQL syntax - expected token: Database. Access 2003+

3786 Invalid SQL syntax - expected a database privilege, such as CREATEDB or
CONNECT. Access 2003+

3787 This operation is not allowed in subqueries. Access 2003+
Error Code Error Description Supported Versions
3788 Cannot create an index on this MAPI folder/addressbook. Access 2003+
3789 Illegal column-level constraint. Access 2003+

3790

This object requires a newer version of the Microsoft Jet database engine.
Access 2007+ uses different description: 'This object requires a newer version
of the Microsoft Office Access database engine.' Access 2010+ uses different
description: 'This object requires a newer version of the Microsoft Access
database engine.'

Access 2003+

3791

This index requires Microsoft Jet database engine |. Access 2007+ uses
different description: 'This index requires Microsoft Office Access database
engine |.' Access 2010+ uses different description: 'This index requires
Microsoft Access database engine |.'

Access 2003+

3792

The index '|2' requires Microsoft Jet database engine |1. Access 2007+ uses
different description: 'The index '|2' requires Microsoft Office Access database
engine |1.' Access 2010+ uses different description: 'The index '|2' requires
Microsoft Access database engine |1.'

Access 2003+

3793

The column '|2' requires Microsoft Jet database engine |1. Access 2007+ uses
different description: 'The column '|2' requires Microsoft Office Access
database engine |1.' Access 2010+ uses different description: 'The column '|2'
requires Microsoft Access database engine |1.'

Access 2003+

3794

This table requires Microsoft Jet database engine |. Access 2007+ uses
different description: 'This table requires Microsoft Office Access database
engine |.' Access 2010+ uses different description: 'This table requires
Microsoft Access database engine |.'

Access 2003+

3795

The table '|2' requires Microsoft Jet database engine |1. Access 2007+ uses
different description: 'The table '|2' requires Microsoft Office Access database
engine |1.' Access 2010+ uses different description: 'The table '|2' requires
Microsoft Access database engine |1.'

Access 2003+

3796 The version of MSRECR40.DLL that was loaded was too old. Run setup again
to get the correct version of this file. Access 2007+ uses different description:

Access 2003+



'The version of AceRecr.DLL that was loaded was too old. Run setup again to
get the correct version of this file.'

3797

The SQL/Jet exchange failed, look in the SQLServer Agent history for details.
Access 2007+ uses different description: 'The SQL/Microsoft Office Access
database engine exchange failed, look in the SQLServer Agent history for
details.' Access 2010+ uses different description: 'The SQL/Microsoft Access
database engine exchange failed, look in the SQLServer Agent history for
details.'

Access 2003+

3798 CHECK constraints are not allowed on replicable databases. Access 2003+
3799 Could not find field '|'. Access 2003+
3800 '|' is not an index in this table. Access 2003+
3801 The object (|) cannot be used in a CHECK constraint clause. Access 2003+
3802 Error evaluating | CHECK constraint. | Access 2003+

3803 DDL cannot be completed on this table because it is referenced by constraint |
on table |. Access 2003+

3804

There are no MAPI clients installed on this machine.Install a MAPI client (like
Outlook) on this machine. Access 2010+ uses different description: 'There are
no MAPI clients installed on this machine. Install a MAPI client (like Outlook)
on this machine.'

Access 2003+

3805

CHECK constraints on table | will not be transferred to this table.CHECK
constraints can only be created via SQL DDL statements. Access 2010+ uses
different description: 'CHECK constraints on table | will not be transferred to
this table. CHECK constraints can only be created via SQL DDL statements.'

Access 2003+

3806 Cannot set multiple NULL, NOT NULL attributes. Access 2003+

3807

Query | contains an ambiguous column name that is conflicting with the
correlation (alias) name |.Either fully qualify the column name or change the
correlation (alias) name. Access 2010+ uses different description: 'Query |
contains an ambiguous column name that is conflicting with the correlation
(alias) name |. Either fully qualify the column name or change the correlation
(alias) name.'

Access 2003+

Error Code Error Description Supported Versions
3808 Need a version 4.x or greater format system database to perform this operation. Access 2007+

3809

Query | was created with a later release of Microsoft Office Access database
engine and may have syntax that this version of Microsoft Office Access
database engine cannot execute. This query can only be executed with the
version of Microsoft Office Access database that created it. Access 2010+ uses
different description: 'Query | was created with a later release of Microsoft
Access database engine and may have syntax that this version of Microsoft
Access database engine cannot execute. This query can only be executed with
the version of Microsoft Access database that created it.'

Access 2007+

3810 Unrecognized keyword WHEN. Access 2007+
3811 Query could not be executed. Access 2007+

3812

You cannot update this field because the value you're trying to apply is not
valid or would break a data integrity rule.Please correct and try again. Access
2010+ uses different description: 'You cannot update this field because the
value you're trying to apply is not valid or would break a data integrity rule.
Please correct and try again.'

Access 2007+

3813 SQL pass through queries are disabled. Access 2007+

3814 Columns that accept multiple values for a record cannot be included in a
multiple-column relationship. Access 2007+

3815 Columns that accept multiple values for a record cannot be included in a
multiple-column index. Access 2007+

3816 The unique index on the '|' column cannot be deleted. Access 2007+



3817 The multi-valued field '|' is not valid in a CROSSTAB query. Access 2007+

3818

Operation cannot be completed on this database because it uses attachements or
multi-valued lookup fields. Access 2010+ uses different description:
'Operation cannot be completed on this database because it uses attachments or
multi-valued lookup fields.'

Access 2007+

3819 Find cannot be executed on columns that accept multiple values for a record. Access 2007+

3820
You cannot enter that value because it duplicates an existing value in the multi-
valued lookup or attachment field. Multi-valued lookup or attachment fields
cannot contain duplicate values.

Access 2007+

3821 You cannot change a multi-valued lookup field to the selected data type. Access 2007+

3822 The value cannot be added to this new row until the row has been committed.
Commit the row first, and then try adding the value. Access 2007+

3823
You cannot edit this field because it resides in a linked Excel spreadsheet. The
ability to edit data in a linked Excel spreadsheet has been disabled in this
Access release.

Access 2007+

3824 An INSERT INTO query cannot contain a multi-valued field. Access 2007+

3825 SELECT * cannot be used in an INSERT INTO query when the source or
destination table contains a multi-valued field. Access 2007+

3826 An UPDATE or DELETE query cannot contain a multi-valued field. Access 2007+

3827 Cannot perform an aggregate function on a multi-valued column when a JOIN
clause contains a different multi-valued column. Access 2007+

Error Code Error Description Supported Versions

3828 Cannot reference a table with a multi-valued field using an IN clause that refers
to another database. Access 2007+

3829 The multi-valued field '|' cannot be used in an ORDER BY clause. Access 2007+
3830 The multi-valued field '|' cannot be used in an GROUP BY clause. Access 2007+
3831 The multi-valued field '|' cannot be used in a WHERE or HAVING clause. Access 2007+

3832 The current file format no longer supports user-level security. The conversion
or compaction process has removed any user-level permissions. Access 2007+

3833 The multi-valued field '|' is not valid in the specified JOIN clause. Access 2007+
3834 The multi-valued field '|1' is not valid in the expression '|2'. Access 2007+
3835 The DISTINCT keyword cannot be used with the multi-valued field '|'. Access 2007+

3836

You are attempting to work with a Paradox file that requires the Borland
Database Engine (BDE). Microsoft Office Access cannot load the BDE, or the
BDE is not correctly installed. To correct this, run the setup program for the
BDE. Access 2010+ uses different description: 'You are attempting to work
with a Paradox file that requires the Borland Database Engine (BDE).
Microsoft Access cannot load the BDE, or the BDE is not correctly installed. To
correct this, run the setup program for the BDE.'

Access 2007+

3837 The multi-valued field '|' cannot be used in a UNION query. Access 2007+
3838 Multi-valued fields are not allowed in SELECT INTO statements. Access 2007+
3839 The specified file exists already. Access 2007+
3840 The attachment you are adding exceeds the system resources available. Access 2007+

3841 Cannot connect to the Sharepoint site '|'. Try again later. Access 2010+ uses
different description: 'Cannot connect to the SharePoint site '|'. Try again later.' Access 2007+

3842 The expression '|' must be part of an aggregate function. Access 2007+

3843 An INSERT INTO query that contains a multivalued field cannot contain
another field. Access 2007+

3844 Cannot reference a multi-valued field in an UPDATE or DELETE statement
that contains other fields. Access 2007+

3845 Microsoft Office Access does not support linking to an Access database or
Microsoft Office Excel workbook saved in a format that is a later version than

Access 2007+



the current database format. Access 2010+ uses different description:
'Microsoft Access does not support linking to an Access database or Microsoft
Office Excel workbook saved in a format that is a later version than the current
database format.'

3846 The multi-valued field '|' in an ORDER BY must also appear in the SELECT
list. Access 2007+

3847
ODBCDirect is no longer supported.Rewrite the code to use ADO instead of
DAO. Access 2010+ uses different description: 'ODBCDirect is no longer
supported. Rewrite the code to use ADO instead of DAO.'

Access 2007+

Error Code Error Description Supported Versions

3848

You cannot record your changes because a value you entered violates the
settings defined for field '|' (for example, a value is less than the minimum or
greater than the maximum).Correct the error and try again. Access 2010+ uses
different description: 'You cannot record your changes because a value you
entered violates the settings defined for field '|' (for example, a value is less than
the minimum or greater than the maximum). Correct the error and try again.'

Access 2007+

3849
Replication is only supported on Access 2000 or Access 2002-2003 format
databases. Use the conversion feature in your application to convert the
database to the proper format.

Access 2007+

3850

This file was created in a previous beta version of Excel 2007.Open the file
with Excel 2007 to save it to the most recent version of the Excel 2007 file
format before opening the file in Access 2007. Access 2010+ uses different
description: 'This file was created in a previous beta version of Excel 2007.
Open the file with Excel 2007 to save it to the most recent version of the Excel
2007 file format before opening the file in Access 2007 or greater.'

Access 2007+

3851

The schema for this table has changed. You must refresh the table before
editing or adding new records Access 2010+ uses different description: 'The
schema for this table has changed. You must refresh the table before editing or
adding new records.'

Access 2007+

3852 Cannot update a multivalued field if its parent recordset is not in edit mode. To
place the parent recordset in edit mode use the AddNew or Edit method. Access 2007+

3853

Microsoft Office Access cannot create the database in the specified format
because of a Group Policy set by your administrator. Create the database using
a different file format or contact your administrator. Access 2010+ uses
different description: 'Microsoft Access cannot create the database in the
specified format because of a Group Policy set by your administrator. Create
the database using a different file format or contact your administrator.'

Access 2007+

3854

This operation will fail because the text file you are about to import contains
more than 255 columns. We recommend that you first make a backup copy of
your source file, reduce the number of columns to 255 or less, and then try
again.

Access 2007+

3855 The Microsoft Access database engine cannot read the data in |1. The minimum
required version to read the data is |2. Access 2010+

3856 The Microsoft Access database engine cannot update the data in |1. The
minimum required version to update the data is |2. Access 2010+

3857 The Microsoft Access database engine cannot change the design of |1. The
minimum required version to change the design is |2. Access 2010+

3858 Expression not supported for conversion Access 2010+
3859 The expression | cannot be used in a calculated column. Access 2010+
3860 The expression | cannot be converted in a query. Access 2010+
3861 The expression | cannot be converted in the results of a query. Access 2010+
3862 The expression | cannot be converted in a UI macro. Access 2010+
3863 The expression | cannot be converted in a default value. Access 2010+
3864 The expression | cannot be converted in a validation rule. Access 2010+



3865 The expression cannot be saved because it contains a circular reference. Access 2010+
3866 The expression cannot be saved because it refers to itself. Access 2010+
3867 The expression cannot be saved because it refers to another table. Access 2010+
Error Code Error Description Supported Versions
3868 There is no data macro AXL stored for the specified table. Access 2010+

3869 The data macro AXL is incompatible with the server with which you are trying
to synchronize. Access 2010+

3870 Microsoft Access cannot interpret the text you are pasting as a data macro.
Correct the text and then try again. Access 2010+

3871 The specified argument is invalid. Access 2010+

3872
A data macro resource limit was hit. This may be caused by a data macro
recursively calling itself. The Updated() function may be used to detect which
field in a record has been updated to help prevent recursive calls.

Access 2010+

3873 The '|1' action failed because it is not supported from a '|2' event. Access 2010+
3874 Type mismatch on field '|'. Access 2010+
3875 The data macro '|' could not be found. Access 2010+
3876 The 'ExitForEachRecord' action is only available in a ForEachRecord loop. Access 2010+
3877 The 'SendEmail' action failed because no recipients were specified. Access 2010+
3878 The 'SendEmail' action failed because the current database is not trusted. Access 2010+
3879 The password is invalid; the message was not sent. Access 2010+

3880
The mail session could not be opened. You may be out of memory. Close other
applications, and then try again. You may also want to check your mail
application to ensure that it's working correctly.

Access 2010+

3881 The e-mail could not be sent. Please ensure that your computer is configured to
send and receive e-mail messages. Access 2010+

3882 This calculated column needs to be recalculated. Access 2010+
3883 This calculated column contains an invalid expression. Access 2010+

3884 The Microsoft Access database engine encountered an error while connecting to
Data Services: '|'. Access 2010+

3885 The type of field '|' cannot be used as part of a calculated column. Examples of
unsupported types include multi-value and binary fields. Access 2010+

3887 A calculated column cannot be saved without a valid expression in the
Expression property. Access 2010+

3888 Calculated columns cannot be used in system relationships. Access 2010+
Error Code Error Description Supported Versions
3889 The variable '|' could not be found. Access 2010+
3890 The identifier '|' could not be found. Access 2010+

3891 Queries that contain linked tables, action queries, and database references are
not allowed in data macros. Access 2010+

3892 The function '|' is not valid for expressions used in data macros. Access 2010+
3893 Invalid constant '|' in data macro expression. Access 2010+
3894 Invalid text '|' in data macro expression. Access 2010+

3895
You cannot record your changes because a value you entered violates the
settings defined for field '|' (for example, a value is less than the minimum or
greater than the maximum). Correct the error and try again.

Access 2010+

3896
The limit of 20 recursive events has been exceeded. This can be caused by an
After Update event that changes data on the table that triggers it. You can use
the Update() function to determine which fields were changed in the record.

Access 2010+

3897 The alias '|' could not be found. Access 2010+



3898
There is no data context in which to perform the action. This error can be
caused by using the RunDataMacro action to run a data macro that calls
DeleteRecord or EditRecord with no alias specified.

Access 2010+

3899 The list item could not be inserted or updated because duplicate values were
found for one or more fields in the list. Access 2010+

3900 The delete operation is not allowed because a child record still exists. Access 2010+
3901 At least one relationship lookup field points to non-existent items in this list. Access 2010+

3902 Cached links cannot be added because the database '|' cannot be opened in
exclusive mode. Access 2010+

3903 The database '|' cannot be opened in exclusive mode because it contains links in
cached mode. Access 2010+

3904 A table cannot be updated because there is no connection to a SharePoint site.
Try the update again when the connection to the server is restored. Access 2010+

3905 The table '|' cannot be updated because there is no connection to a SharePoint
site. Try the update again when the connection to the server is restored. Access 2010+

3906 Linked table is unavailable. Microsoft Access cannot contact the server. Check
your network connection or contact the server administrator. Access 2010+

3907 Linked table '|' is unavailable. Microsoft Access cannot contact the server.
Check your network connection or contact the server administrator. Access 2010+

3908 Data cannot be added, updated or deleted until all related data has been fetched
from the server. Access 2010+

Error Code Error Description Supported Versions

3909 Data cannot be added, updated or deleted because data table '|' has not been
fetched from the server. Access 2010+

3910 Your encryption settings are not valid. Re-install Microsoft Access or contact
your administrator for more information. Access 2010+

3911 Microsoft Access cannot open this file because the contents have been
damaged. Access 2010+

3912 A table is not synchronized with the SharePoint site. Close and reopen the table
to retrieve the most recent data from the SharePoint site. Access 2010+

3913 The table '|' is not synchronized with the SharePoint site. Close and reopen the
table to retrieve the most recent data from the SharePoint site. Access 2010+

3914 Selected collating sequence not supported with the specified file format. Access 2010+
3915 The expression | cannot be converted in a data macro. Access 2010+

3916 The property '|' can only be set or changed by the Microsoft Access database
engine. Access 2010+

3918 Microsoft Access does not support this operation for this IISAM type. To
perform this action, you must use the 2007 Microsoft Office system or earlier. Access 2010+

3919 The Microsoft Access database engine encountered an error while
communicating with SharePoint. More detailed information: '|' Access 2010+

3920 Unable to execute query. Invalid operation or syntax using multi-value field. Access 2010+

3921 Cannot reference a table with a multi-valued field using a FROM clause that
refers to another database. Access 2010+

3922 The expression | cannot be converted in a form. Access 2010+

3923 The inclusion of constant expressions in an outer join operation is not
supported. Access 2010+

3924 Access was unable to convert the query for use on the Web. Access 2010+
3925 The definition of the query is invalid, so the query object cannot be created. Access 2010+

3926
Access was unable to convert the query for use on the Web because it uses an
unsupported query type, unsupported expressions, unsupported criteria, or other
features that are not supported on the Web.

Access 2010+



3927 Access was unable to convert the query for use on the Web because it contains
a sub-query. Access 2010+

3928 Access was unable to convert the query for use on the Web because it relies on
a different query that is not Web compatible. Access 2010+

3929 Access was unable to convert the query for use on the Web because it doesn't
include any fields in its results. Access 2010+

Error Code Error Description Supported Versions

3930 Access was unable to convert the query for use on the Web because it displays
too many fields in its results. Access 2010+

3931 Access was unable to convert the query for use on the Web because it relies on
an ORDER BY clause that is not supported on the Web. Access 2010+

3932 Access was unable to convert the query for use on the Web because it specifies
a JOIN type that is not supported on the Web. Access 2010+

3933 Access was unable to convert the query for use on the Web because it is a
cross-product query. Access 2010+

3934 Access was unable to convert the query for use on the Web because it does not
specify which table to SELECT FROM. Access 2010+

3935 Access was unable to convert the query for use on the Web because the query
results contain multiple fields with the same name. Access 2010+

3936 Access was unable to convert the query for use on the Web because some of its
parameters could not be converted for use on the Web. Access 2010+

3937 Access was unable to convert the query for use on the Web because some of its
parameters are displayed as result fields or used in ORDER BY statements. Access 2010+

3938 The expression could not be saved because its result is an invalid type, such as
NULL. Access 2010+

3939 |1 Access 2010+
3940 Could not coerce argument number |1 to an integer for the |2 action. Access 2010+
3941 Could not coerce argument number |1 to a string for the |2 action. Access 2010+
3942 Could not coerce argument number |1 to a Boolean for the |2 action. Access 2010+
3943 Missing parameter '|1' when attempting to run a named data macro. Access 2010+

3944 The type of field '|' cannot be used in a validation rule for Web tables. Invalid
types include Memo, Binary and Lookup. Access 2010+

3945 System tables cannot contain data macros. Access 2010+

3946 The OnError action cannot be used with Go To set to Macro Name in before
events. Access 2010+

3947
The server does not support the type of field '|' as part of a calculated column.
Examples of unsupported types include multi-value, memo, hyperlink, binary,
AutoNumber and lookup fields.

Access 2010+

3948 The expression could not be saved because its result type, such as binary or
NULL, is not supported by the server. Access 2010+

3949 The Microsoft Access database engine cannot compact the data in |1 because it
contains objects from a newer version. Access 2010+

Error Code Error Description Supported Versions
3950 Syntax error in expression. Access 2010+

3951
The application has changed on the server. Your last entered row will not be
saved. Copy and paste your last entered row to a temporary file and then
synchronize the application with the server.

Access 2010+

3952 The data macro failed to run because its AXL definition was invalid. Access 2010+

3953

The local var name '|1' is invalid. Local variable names must be less than or
equal to 64 characters in length, may not start with an equal sign or a space, and
may not contain any of the following characters including CR, LF or TAB: .!
[]/:*?""<>|2#{}%&.

Access 2010+



3954

The parameter name '|1' is invalid. Parameter names must be less than or equal
to 64 characters in length, may not start with an equal sign or a space, and may
not contain any of the following characters including CR, LF or TAB: .![]/:*?""
<>|2#{}%&.

Access 2010+

3955 The data macro name '|1' is invalid. Access 2010+

3956 The database you are trying to open requires a newer version of Microsoft
Access. Access 2010+

3957
The field could not be added on the server. Synchronize with the server and
remove any references to hidden, lookup, AutoNumber, hyperlink and memo
fields.

Access 2010+

3958 The field could not be deleted on the server. Synchronize with the server and
verify that no other field references this field. Access 2010+

3959 Calculated columns are not allowed in SELECT INTO statements. Access 2010+
3960 The expression | cannot be converted for the Apply Filter macro action. Access 2010+

3961 The maximum number of parameters for named data macros, ForEachRecord,
and LookupRecord is 255. Access 2010+

3962 EditRecord failed due to repeated data conflicts when attempting to commit
data. Access 2010+

3963 The action '|1' is not valid inside of CreateRecord or EditRecord. Access 2010+
3964 The action '|1' is not valid outside of CreateRecord and EditRecord. Access 2010+

3965 The field '|1' could not be changed because the record is not currently
updatable. Use EditRecord to make the record updatable. Access 2010+

3966 The field '|1' could not be changed. In the BeforeChange event only the record
being changed is updatable. Access 2010+

3967 EditRecord failed because the alias '|1' represents a record which is read only. Access 2010+

3968 EditRecord failed because the default alias represents a record which is read
only. Access 2010+

3969 Attachments cannot be added to new rows until the rows have been committed
to the server. Commit the row first, and then try attaching the document to it. Access 2010+

Error Code Error Description Supported Versions

3970 The expression could not be saved because it would be longer than 255
characters when published. Access 2010+

3971
Linked table cannot be opened. You do not have permission to view the entire
list because it is larger than the list view threshold enforced by the server
administrator.

Access 2010+

3972
Linked table '|' cannot be opened. You do not have permission to view the entire
list because it is larger than the list view threshold enforced by the server
administrator.

Access 2010+

3973 Values stored in multi-value and attachment fields are not supported within data
macro queries. Access 2010+

3974 The field '|1' could not be read because it is a multi-value or attachment field. Access 2010+
3975 The field '|1' could not be set because it is a multi-value or attachment field. Access 2010+

3976
The column '|1' could not be read because it is a calculated column in a record
that was retrieved from ForEachRecord or LookupRecord and has been
modified by EditRecord.

Access 2010+

3977 URL data '|1' in field '|2' could not be sent to the server. The URL may be
invalid or longer than 255 characters. Access 2010+

3978 The calculation of day or time difference with a + or - sign is not supported.
Please use the DateAdd() function instead. Access 2010+

3979 The linked table has been changed on the server. Your last entered row will not
be saved. Copy and paste your last entered row to a temporary file, then

Access 2010+



synchronize the linked table with the server by right-clicking on the linked
table, choosing More options and clicking Refresh List.

3980

The linked table '|' has been changed on the server. Your last entered row will
not be saved. Copy and paste your last entered row to a temporary file, then
synchronize the linked table with the server by right-clicking on the linked
table, choosing More options and clicking Refresh List.

Access 2010+

3981 There were errors executing the bulk query or sending data to the server.
Reconnect the tables to resolve the conflicts or discard the pending changes. Access 2010+

3982
The field '|1' could not be read because it is the primary key of the record being
created. This field's value will be available in the LastCreateRecordIdentity
variable after the CreateRecord block has completed.

Access 2010+

3983 An argument to the Updated function was invalid. The field name must be
provided as a string value enclosed in quotation marks. Access 2010+

3984 Access was unable to convert the query for use on the Web because it contains
a cyclical join. Access 2010+

3985 Within a ForEachRecord only the records of the outermost ForEachRecord may
be edited or deleted. Access 2010+

3986 CreateRecord cannot be used inside of a ForEachRecord. Access 2010+
3987 Data cannot be inserted because there is no matching record. Access 2010+
3988 The table is too large for this change to be saved. Access 2010+
3989 You don't have permission to modify the design of this list. Access 2010+
Error Code Error Description Supported Versions

3990
A data macro on table '|1' failed to execute, since it has not yet been
synchronized with the server. Please synchronize this table with the server
using the ""Sync All"" command and try again.

Access 2010+

3991 The query failed to execute because the identifier '|1' could not be found. Access 2010+

3992 The validation rule contains a syntax error and cannot be saved. A field or
function may be misspelled or missing. Access 2010+

3993 A timeout prevented the change from saving to the server. Access 2010+

3994
The field '|' cannot be modified because it contains invalid characters, invalid
punctuation, or an existing field name. Correct the name on the server and
refresh the table.

Access 2010+

3995
This table already has the maximum number of fields with the data type
specified. For the purposes of this calculation, Number and Currency are
considered the same data type.

Access 2010+

3996 Microsoft Access cannot reconnect one or more of the disconnected tables.
Please check network connectivity and server availability. Access 2010+

3997 Microsoft Access detected changes to an open object. Please close and reopen
the object to get updates. Access 2010+

3998 The Updated function is not supported for memo, rich text, hyperlink, OLE
Object, multi-value, or attachment fields. Access 2010+

3999
You cannot reference rows created when you are disconnected from the server
because this violates the lookup settings defined for this table or list. Please
reconnect all tables with the server and try again.

Access 2010+

4000 | Access 2010+

4001 One or more values are prohibited by the validation rule set for '|1'. Enter a
value that the expression for this field can accept. Access 2010+

4002 The '|1' value is not available because the field is of type memo, rich text,
hyperlink, or OLE Object. Access 2010+

4003 The maximum number of return variables is 255. Access 2010+
4004 The return variable name '|1' is invalid. Return variable names must be less than

or equal to 64 characters in length, may not start with an equal sign or a space,
Access 2010+



and may not contain any of the following characters, including CR, LF or TAB:
.![]/:*?""<>|2#{}%&.

4005 The return variable '|1' is too long. The return variable string cannot exceed |2
characters. Access 2010+

4006 Duplicate output names detected. Modify the name or alias of one of the
outputs. Access 2013+

4007 Access cannot sort a field or an expression as it does not appear in the output of
the query. Access 2013+

4008
Access was unable to save the query because it uses an unsupported query type,
unsupported expressions, unsupported criteria, or other features that are not
supported in this database.

Access 2013+

4009 Access was unable to save the query because it doesn't include any fields in its
results. Access 2013+

Error Code Error Description Supported Versions

4010 Access was unable to save the query because it displays too many fields in its
results. Access 2013+

4011 Access was unable to save the query because it does not specify which table to
SELECT FROM. Access 2013+

4012 Access was unable to save the query because the query results contain multiple
fields with the same name. Access 2013+

4013 Access was unable to save the query because some of its parameters could not
be converted for use in this database. Access 2013+

4014 Circular reference caused by '|'. '|' has been removed from the query. Access 2013+

4015

The query can't be saved because Access can't determine which join should be
performed first. To force one of the joins to be performed first, create a separate
query that performs the first join, and then include that query as a source object
for this query.

Access 2013+

4016 The expression you entered has a function name or operator that cannot be
found. Access 2013+

4017 The current version of Microsoft Access does not support replicated databases.
To use this database, open in a previous version of Microsoft Access. Access 2013+

4018 The database you are trying to open can only be opened by Microsoft Access. Access 2013+

4019
The database you are trying to open cannot be opened by the Microsoft Access
database engine Data Access Object Library. It can only be opened directly
through Microsoft Access.

Access 2013+

6000
Errors were encountered during the save operation.@@@1@@1 Access 2007+
uses different description: 'Errors were encountered during the save
operation.@@@1@@@1'

Access 2003+

6001

A form or report cannot be the subdatasheet of a table or query.@Only a table
or query can be inserted into another table or query.@@1@@1 Access 2007+
uses different description: 'A form or report cannot be the subdatasheet of a
table or query.@Only a table or query can be inserted into another table or
query.@@1@@@1'

Access 2003+

6002 Microsoft Office Access cannot expand this subdatasheet because all of the
records are locked.@The RecordLocks property of the form or report or the
Default Record Locking option on the Advanced tab of the Options dialog box
(Tools menu) is set to All Records.@Reset the value to No Locks or Edited
Record as appropriate.@1@@1 Access 2007+ uses different description:
'Microsoft Office Access cannot expand this subdatasheet because all of the
records are locked. @Either the RecordLocks property of the form or report or
the Default Record Locking option in the Advanced section of the Access
Options dialog box (click the Microsoft Office Button, and then click Access
Options) is set to All Records.@Reset the value to No Locks or Edited Record,
as appropriate.@1@1@472@1' Access 2010+ uses different description:

Access 2003+



'Microsoft Access cannot expand this subdatasheet because all of the records
are locked. @Either the RecordLocks property of the form or report or the
Default Record Locking option in the Advanced section of the Access Options
dialog box (click the File tab, and then click Access Options) is set to All
Records.@Reset the value to No Locks or Edited Record, as
appropriate.@1@1@472@1'

6003
The setting for the Precision property must be from 1 through 28.@@@1@@1
Access 2007+ uses different description: 'The setting for the Precision
property must be from 1 through 28.@@@1@@@1'

Access 2003+

6004
The setting for the Scale property must be from 0 through 28.@@@1@@1
Access 2007+ uses different description: 'The setting for the Scale property
must be from 0 through 28.@@@1@@@1'

Access 2003+

6005

The table or query name '|' you entered in either the property sheet or macro is
misspelled or refers to a table or query that doesn't exist.@If the invalid name is
in a macro, an Action Failed dialog box will display the macro name and the
macro's arguments after you click OK. Open the Macro window, and enter the
correct name.@@1@@1 Access 2007+ uses different description: 'The table
or query name '|' you entered in either the property sheet or macro is misspelled
or refers to a table or query that doesn't exist.@If the invalid name is in a
macro, an Action Failed dialog box will display the macro name and the
macro's arguments after you click OK. Open the Macro window, and enter the
correct name.@@1@@@1'

Access 2003+

6006

Filter by selection of a partial value is only supported for fields containing
character data.@@@1@@1 Access 2007+ uses different description: 'Filter
by selection of a partial value is only supported for fields containing character
data.@@@1@@@1'

Access 2003+

6007

Cannot open a form bound to a stored procedure in server filter by form
mode.@@@1@@1 Access 2007+ uses different description: 'Cannot open a
form bound to a stored procedure in server filter by form
mode.@@@1@@@1'

Access 2003+

6008

Microsoft Office Access encountered an error closing your connection.
@Please close all of your application windows before trying again.@@1@@1
Access 2007+ uses different description: 'Microsoft Office Access
encountered an error closing your connection. @Please close all of your
application windows before trying again.@@1@@@1' Access 2010+ uses
different description: 'Microsoft Access encountered an error closing your
connection. @Please close all of your application windows before trying
again.@@1@@@1'

Access 2003+

6009

Invalid connection string.@You may need to specify a valid connection string
and try it again.@@1@@1 Access 2007+ uses different description: 'Invalid
connection string.@You may need to specify a valid connection string and try it
again.@@1@@@1'

Access 2003+

Error Code Error Description Supported Versions

6010

Invalid use of Move method.@The Move method is not applicable to subforms
or subreports.@@1@@1 Access 2007+ uses different description: 'Invalid
use of Move method.@The Move method is not applicable to subforms or
subreports.@@1@@@1'

Access 2003+

6011
Do you want to save the data changes on form '|'?@@@13@@4 Access 2007+
uses different description: 'Do you want to save the data changes on form '|'?
@@@13@@@4'

Access 2003+

6012 Microsoft Office Access can't set this property to No right now.@You cannot
set the Allow Form View, Allow Datasheet View, Allow PivotTable View, and
Allow PivotChart View properties to No at the same time.@Set one of the other
properties to Yes before changing this one to No.@1@@1 Access 2007+ uses
different description: 'Microsoft Office Access can't set this property to No
right now.@You cannot set the Allow Form View, Allow Datasheet View,

Access 2003+



Allow PivotTable View, and Allow PivotChart View properties to No at the
same time.@Set one of the other properties to Yes before changing this one to
No.@1@@@1' Access 2010+ uses different description: 'Microsoft Access
can't set this property to No right now.@You cannot set the Allow Form View,
Allow Datasheet View, Allow PivotTable View, and Allow PivotChart View
properties to No at the same time.@Set one of the other properties to Yes before
changing this one to No.@1@@@1'

6013
Unable to remove item. '|' not found in list.@@@1@@1 Access 2007+ uses
different description: 'Unable to remove item. '|' not found in
list.@@@1@@@1'

Access 2003+

6014

The RowSourceType property must be set to 'Value List' to use this
method.@@@1@@1 Access 2007+ uses different description: 'The
RowSourceType property must be set to 'Value List' to use this
method.@@@1@@@1'

Access 2003+

6015
Can't add this item. The index is too large.@@@1@@1 Access 2007+ uses
different description: 'Can't add this item. The index is too
large.@@@1@@@1'

Access 2003+

6016

Microsoft Office Access is unable to switch to PivotTable or PivotChart view
right now.@You must set the Record Source property of the form before
attempting to PivotTable or PivotChart view.@@1@@1 Access 2007+ uses
different description: ''

Access 2003

6017

Microsoft Office Access doesn't support the requested property for this type of
database object.@The DateCreated and DateModified properties are not
supported for Tables, Queries, Stored Procedures, Database Diagrams, and
Functions in a Client Server database.@@1@@1 Access 2007+ uses different
description: 'Microsoft Office Access doesn't support the requested property
for this type of database object.@The DateCreated and DateModified
properties are not supported for Tables, Queries, Stored Procedures, Database
Diagrams, and Functions in a Client Server database.@@1@@@1' Access
2010+ uses different description: 'Microsoft Access doesn't support the
requested property for this type of database object.@The DateCreated and
DateModified properties are not supported for Tables, Queries, Stored
Procedures, Database Diagrams, and Functions in a Client Server
database.@@1@@@1'

Access 2003+

6018

The form or report template is open in Design view.Before creating a new form
or report, close the corresponding template.@@@1@@1 Access 2007+ uses
different description: 'The form or report template is open in Design
view.Before creating a new form or report, close the corresponding
template.@@@1@@@1'

Access 2003+

6019 You must save new or dirty objects in the database before you can save them to
this external format.@@@1@@1 Access 2007+ uses different description: '' Access 2003

6020

This format does not support objects named '|'. Rename the object and try
again.@@@1@@1 Access 2007+ uses different description: 'This format
does not support objects named '|'. Rename the object and try
again.@@@1@@@1'

Access 2003+

6021

You cannot create a form with AutoForm or a report with AutoReport by using
a scalar function; you can use a table, view, stored procedure, inline function, or
table function.@@@1@@1 Access 2007+ uses different description:
'Microsoft Office Access cannot build a form or report based on the data
returned by the function object that you have currently selected. @Select a
table, query, form, or report, and try again.@@1@@@1' Access 2010+ uses
different description: 'Microsoft Access cannot build a form or report based
on the data returned by the function object that you have currently selected.
@Select a table, query, form, or report, and try again.@@1@@@1'

Access 2003+

6022 This option cannot be changed in an Access Project file.@@@1@@1 Access
2007+ uses different description: '' Access 2003



6023
The Maximum Record Count setting cannot be a negative
number.@@@1@@1 Access 2007+ uses different description: 'The
Maximum Record Count setting cannot be a negative number.@@@1@@@1'

Access 2003+

6024

The Maximum Record Count setting cannot contain text - please enter a
number.@@@1@@1 Access 2007+ uses different description: 'The
Maximum Record Count setting cannot contain text - please enter a
number.@@@1@@@1'

Access 2003+

6025

The Requery action cannot be used on a control bound to a
Recordset.@@@1@@1 Access 2007+ uses different description: 'The
Requery action cannot be used on a control bound to a
Recordset.@@@1@@@1'

Access 2003+

6026

The RowSourceType property must be set to 'Table/Query' to use this
method.@@@1@@1 Access 2007+ uses different description: 'The
RowSourceType property must be set to 'Table/Query' to use this
method.@@@1@@@1'

Access 2003+

6027

You can't save or undo the record at this time. The form's BatchUpdates
property is set to Yes, but the form is not bound to a record source. Either set
the form's BatchUpdates property to No, or bind the form to a record source by
setting a value in the RecordSource property.@@@1@@1 Access 2007+ uses
different description: ''

Access 2003

6028

The OLE object failed to persist itself. You will not be able to undo this
operation.@@@1@@1 Access 2007+ uses different description: 'The OLE
object failed to persist itself. You will not be able to undo this
operation.@@@1@@@1'

Access 2003+

6029 |@@@1@@@1 Access 2007+
Error Code Error Description Supported Versions

6030 The current record in |1 |2 must be saved before you can complete this
operation.@Do you want to save the current record in |1 |2?@@3@@@1 Access 2007+

6031 You can't modify the structure of table '|', because it is already in use by another
person or process.@@@1@@@1 Access 2007+

6032 The value you entered isn't valid for this field.@For example, you may have
entered a null value.@@1@@@1 Access 2007+

6033
The '|1' form does not exist.@Enter the name of an existing form in the List
Items Edit Form property of the '|2' control or leave the property
empty.@@1@@@1

Access 2007+

6034 This property is only available for attachment controls bound to attachment
fields.@@@1@@@1 Access 2007+

6035 Layout view is unavailable for this |.@@@1@@@1 Access 2007+

6036 You cannot add a form to another form that shows multiple
items.@@@1@@@1 Access 2007+

6037 This object was saved in an invalid format and cannot be read.@@@1@@@1 Access 2007+

6038

Microsoft Office Access was not able to update the value list.@The table may
be locked by another user, it may be read-only, or you may not have permission
to modify the table.@@1@@@1 Access 2010+ uses different description:
'Microsoft Access was not able to update the value list.@The table may be
locked by another user, it may be read-only, or you may not have permission to
modify the table.@@1@@@1'

Access 2007+

6039 Do you want to save the datasheet so that it will be available for use by other
forms and reports?@@@33@1@151798@4 Access 2007+

6040

Because dependency checking is not enabled on this database, Access cannot
verify whether this datasheet is used on other forms or reports.@Do you want
to save the datasheet so that it will be available for use by other forms and
reports?@@33@1@151798@4

Access 2007+



6041 Grouping information can only be changed in Layout View and Design
View.@@@1@2@5054@1 Access 2007+

6042

Deleting the |1 control will permanently remove filter, grouping, or sort order
settings that are based on the control from the form or report. Are you sure you
want to delete the |1 control?.@@@20@1@5833@4 Access 2010+ uses
different description: 'Deleting the |1 control will permanently remove filter,
grouping, or sort order settings that are based on the control from the form or
report.@Are you sure you want to delete the |1 control?@@20@1@5833@4'

Access 2007+

6043

Deleting the selected controls will permanently remove filter, grouping, or sort
order settings that are based on those controls from the form or report. Are you
sure you want to delete the controls?.@@@20@1@5833@4 Access 2010+
uses different description: 'Deleting the selected controls will permanently
remove filter, grouping, or sort order settings that are based on those controls
from the form or report.@Are you sure you want to delete the controls?
@@20@1@5833@4'

Access 2007+

6044 You will not be able to undo the creation or deletion of this object.@Do you
still want to continue?@@20@1@@4 Access 2007+

6045

Microsoft Office Access cannot save the form or report, because it displays
characters from a language that cannot be saved in your current system
locale.@Switch your system locale to the language in the form or report, and
then try again.@@1@2@5054@1 Access 2010+ uses different description:
'Microsoft Access cannot save the form or report, because it displays characters
from a language that cannot be saved in your current system locale.@Switch
your system locale to the language in the form or report, and then try
again.@@1@2@5054@1'

Access 2007+

6046
Your changes cannot be saved because the field '|' has been updated by another
user.@@@1@@@1 Access 2010+ uses different description: 'Your changes
cannot be saved because the field '|' has been updated by another user.'

Access 2007+

6047

The number of fields from your currently selected table or query exceeds the
maximum height in Microsoft Office Access forms.@Microsoft Office Access
will create a new form with no fields and open the field list so you can
individually select fields to add to this object.@@3@@@2 Access 2010+ uses
different description: 'The number of fields from your currently selected table
or query exceeds the maximum height in Microsoft Access forms.@Microsoft
Access will create a new form with no fields and open the field list so you can
individually select fields to add to this object.@@3@@@2'

Access 2007+

6048

The number of fields from your currently selected table or query exceeds the
maximum width in Microsoft Office Access forms and reports.@Microsoft
Office Access will create a new form or report with no fields and open the field
list so you can individually select fields to add to this object.@@3@@@2
Access 2010+ uses different description: 'The number of fields from your
currently selected table or query exceeds the maximum width in Microsoft
Access forms and reports.@Microsoft Access will create a new form or report
with no fields and open the field list so you can individually select fields to add
to this object.@@3@@@2'

Access 2007+

6049

Because databases in the current format do not support the Attachment control,
you will not be able to complete this operation.@@@1@@@1 Access 2010+
uses different description: 'Since databases in the current format do not
support the Attachment control, you will not be able to complete this operation.'

Access 2007+

Error Code Error Description Supported Versions
6050 Microsoft Access could not instantiate the Web Browser Control. Access 2010+
6051 Web Browser could not parse the transform Access 2010+
6052 Web Browser cannot apply the transform. Access 2010+
6053 To apply this change, close and reopen the form or report Access 2010+



6054 The macro action BrowseTo requires a valid Path argument. A valid Path
argument is of the form: MainForm1.Subform1>Form1.Subform1 Access 2010+

6055 This form already has a navigation control.@You will not be able to complete
this operation.@@1@@@1 Access 2010+

6056 The Web browser control is not supported in a report or a continuous form. Access 2010+

6057 Because databases in the current format do not support the Empty Cell control,
you will not be able to complete this operation. Access 2010+

6058 The Navigation control is not supported by the current database format. Access 2010+
6059 Cannot create a Web | based on a source that is not Web compatible. Access 2010+
6060 The navigation control is not supported on reports. Access 2010+

6061 Some controls on this object shared the same name.@These controls have been
given unique names.@@1@@@1 Access 2010+

6062 You must be in Design or Layout View to create or delete
controls.@@@1@2@5054@1 Access 2010+

6063 The report position change was stopped Access 2010+
6064 Invalid menu command. Access 2010+

7700

Microsoft Office Access is unable to complete the operation.@Try the
operation again. If the error persists, restart Microsoft Office
Access.@@1@@1 Access 2007+ uses different description: 'Microsoft
Office Access is unable to complete the operation.@Try the operation again. If
the error persists, restart Microsoft Office Access.@@1@@@1' Access 2010+
uses different description: 'Microsoft Access is unable to complete the
operation.@Try the operation again. If the error persists, restart Microsoft
Access.@@1@@@1'

Access 2003+

7701

Microsoft Office Access can't synchronize with Synchronizer '|1.'@A possible
reason for the failure to synchronize with '|1' is that both the Synchronizer and
Microsoft Office Access were trying to write to the current database at the same
time. Try synchronizing with '|1' again.@Do you want to continue
synchronizing with the remaining Synchronizers?@19@@2 Access 2007+
uses different description: 'Microsoft Office Access can't synchronize with
Synchronizer '|1.'@A possible reason for the failure to synchronize with '|1' is
that both the Synchronizer and Microsoft Office Access were trying to write to
the current database at the same time. Try synchronizing with '|1' again.@Do
you want to continue synchronizing with the remaining Synchronizers?
@19@@@2' Access 2010+ uses different description: 'Microsoft Access
can't synchronize with Synchronizer '|1.'@A possible reason for the failure to
synchronize with '|1' is that both the Synchronizer and Microsoft Access were
trying to write to the current database at the same time. Try synchronizing with
'|1' again.@Do you want to continue synchronizing with the remaining
Synchronizers?@19@@@2'

Access 2003+

7702

The user-supplied function named '|', the program to assist you in resolving
conflicts, could not be found.@Contact the author of this customized database
application.@@1@@3 Access 2007+ uses different description: 'The user-
supplied function named '|', the program to assist you in resolving conflicts,
could not be found.@Contact the author of this customized database
application.@@1@@@3'

Access 2003+

7703
There are no synchronization conflicts to resolve.@@@1@@1 Access 2007+
uses different description: 'There are no synchronization conflicts to
resolve.@@@1@@@1'

Access 2003+

7704

You can't modify the design of '|' at a replica.@Design changes to replicated
objects can be made only at the Design Master. Do you want to open it as read-
only?@@19@@2 Access 2007+ uses different description: 'You can't modify
the design of '|' at a replica.@Design changes to replicated objects can be made
only at the Design Master. Do you want to open it as read-only?@@19@@@2'

Access 2003+



Error Code Error Description Supported Versions

7705

This member of the replica set has conflicts from synchronizing changes with
other members.@Do you want to resolve these conflicts now?@@19@@2
Access 2007+ uses different description: 'This member of the replica set has
conflicts from synchronizing changes with other members.@Do you want to
resolve these conflicts now?@@19@@@2'

Access 2003+

7706
This member of the replica set has errors from synchronizing changes with
another member.@Do you want to see the errors now?@@19@@2 Access
2007+ uses different description: ''

Access 2003

7707
This member of the replica set has both errors and conflicts from synchronizing
changes with another member.@Do you want to see the errors and resolve the
conflicts now?@@19@@2 Access 2007+ uses different description: ''

Access 2003

7708

'|1' was the last designated Design Master for the replica set. Has '|2' been
moved, renamed, deleted, or corrupted?@You should never have more than one
Design Master for each replica set. Having more than one Design Master in a
replica set prevents the members of the set from synchronizing correctly.@Use
Windows Explorer to determine whether the file has been moved or deleted.
Open the file to determine whether it has been corrupted.@13@@2 Access
2007+ uses different description: ''|1' was the last designated Design Master
for the replica set. Has '|2' been moved, renamed, deleted, or corrupted?@You
should never have more than one Design Master for each replica set. Having
more than one Design Master in a replica set prevents the members of the set
from synchronizing correctly.@Use Windows Explorer to determine whether
the file has been moved or deleted. Open the file to determine whether it has
been corrupted.@13@@@2'

Access 2003+

7709

To make this replica the Design Master for the replica set, point to Replication
on the Tools menu, click Synchronize Now, enter the path to '|' (the current
Design Master), and select the Make ... The Design Master check
box.@@@1@@1 Access 2007+ uses different description: 'To make this
replica the Design Master for the replica set, on the Database Tools tab, in the
Database Tools group, click Replication Options, click Synchronize Now, enter
the path to '|' (the current Design Master), and then select the Make ... The
Design Master check box.@@@1@@@1'

Access 2003+

7710

To make this replica the Design Master for the replica set, first synchronize this
replica with all other replicas in the set.@This ensures that this replica includes
all design changes made at the previous Design Master. If you have already
synchronized this replica, do you want to make it the Design Master?
@@19@@2 Access 2007+ uses different description: 'To make this replica
the Design Master for the replica set, first synchronize this replica with all other
replicas in the set.@This ensures that this replica includes all design changes
made at the previous Design Master. If you have already synchronized this
replica, do you want to make it the Design Master?@@19@@@2'

Access 2003+

7711

This member of the replica set is now the Design Master. Microsoft Office
Access will now close and reopen the database in order for the changes to take
effect.@@@1@@1 Access 2007+ uses different description: 'This member
of the replica set is now the Design Master. Microsoft Office Access will now
close and reopen the database in order for the changes to take
effect.@@@1@@@1' Access 2010+ uses different description: 'This
member of the replica set is now the Design Master. Microsoft Access will now
close and reopen the database in order for the changes to take
effect.@@@1@@@1'

Access 2003+

7712 This member of the replica set has exceeded the maximum number of days
allowed between synchronizations and can't be synchronized with any other
member of the replica set.@Delete this replica set member and create a new
replica.@@1@@1 Access 2007+ uses different description: 'This member of
the replica set has exceeded the maximum number of days allowed between

Access 2003+



synchronizations and can't be synchronized with any other member of the
replica set.@Delete this replica set member and create a new
replica.@@1@@@1'

7713

This member of the replica set will expire in | days because it hasn't been
synchronized with another member of the replica set.@If the member is
allowed to expire, it can no longer be synchronized with any other member of
the replica set.@Synchronize with another member as soon as possible. To
synchronize, point to Replication on the Tools menu, and click Synchronize
Now.@1@@1 Access 2007+ uses different description: 'This member of the
replica set will expire in | days because it has not been synchronized with
another member of the replica set.@If the member is allowed to expire, it can
no longer be synchronized with any other member of the replica set.@You
should synchronize this member with another member as soon as possible. To
synchronize, on the the Database Tools tab, in the Database Tools group, click
Replication Options, and then click Synchronize Now.@1@@@1'

Access 2003+

7714

Microsoft Office Access cannot close the database at this time.@Make sure
there is no Visual Basic code executing in the current database. You may need
to run Setup again to properly install Briefcase Replication.@@1@@1 Access
2007+ uses different description: 'Microsoft Office Access cannot close the
database at this time.@Make sure there is no Visual Basic code executing in the
current database. You may need to run Setup again to properly install Briefcase
Replication.@@1@@@1' Access 2010+ uses different description:
'Microsoft Access cannot close the database at this time.@Make sure there is no
Visual Basic code executing in the current database. You may need to run Setup
again to properly install Briefcase Replication.@@1@@@1'

Access 2003+

7715

Microsoft Office Access cannot complete this operation because it can't find or
initialize the dynamic-link library Msrclr40.@Rerun Microsoft Office Access
or Microsoft Office Setup again to reinstall Microsoft Briefcase Replication.
During Setup, click Add/Remove, and select Microsoft Briefcase Replication. If
you want to preserve your security or custom settings, back up the Microsoft
Office Access workgroup information file. For information on backing up files,
search the Microsoft Windows Help index for 'backing up files'.@@1@@3
Access 2007+ uses different description: 'Microsoft Office Access cannot
complete this operation because it can't find or initialize the dynamic-link
library AceRclr.@Rerun Microsoft Office Access or Microsoft Office Setup
again to reinstall Microsoft Briefcase Replication. During Setup, click
Add/Remove, and select Microsoft Briefcase Replication. If you want to
preserve your security or custom settings, back up the Microsoft Office Access
workgroup information file. For information on backing up files, search the
Microsoft Windows Help index for 'backing up files'.@@1@@@3' Access
2010+ uses different description: 'Microsoft Access cannot complete this
operation because it can't find or initialize the dynamic-link library
AceRclr.@Rerun Microsoft Access or Microsoft Office Setup again to reinstall
Microsoft Briefcase Replication. During Setup, click Add/Remove, and select
Microsoft Briefcase Replication. If you want to preserve your security or
custom settings, back up the Microsoft Access workgroup information file. For
information on backing up files, search the Microsoft Windows Help index for
'backing up files'.@@1@@@3'

Access 2003+

7716

The database must be closed prior to synchronization.@Do you want Microsoft
Office Access to close the database and synchronize with '|'?@@19@@2
Access 2007+ uses different description: 'The database must be closed prior
to synchronization.@Do you want Microsoft Office Access to close the
database and synchronize with '|'?@@19@@@2' Access 2010+ uses different
description: 'The database must be closed prior to synchronization.@Do you
want Microsoft Access to close the database and synchronize with '|1'?
@@19@@@2'

Access 2003+



7717

All open objects must be closed before synchronizing.@Do you want Microsoft
Office Access to close the objects?@@19@@2 Access 2007+ uses different
description: 'All open objects must be closed before synchronizing.@Do you
want Microsoft Office Access to close the objects?@@19@@@2' Access
2010+ uses different description: 'All open objects must be closed before
synchronizing.@Do you want Microsoft Access to close the objects?
@@19@@@2'

Access 2003+

7718

Microsoft Office Access can't synchronize this member of the replica set
because one or more objects are open.@Because synchronizing may involve
updating the data in or design of the database, all objects must be closed before
you synchronize.@Close all objects and try again.@1@@1 Access 2007+ uses
different description: 'Microsoft Office Access can't synchronize this member
of the replica set because one or more objects are open.@Because
synchronizing may involve updating the data in or design of the database, all
objects must be closed before you synchronize.@Close all objects and try
again.@1@@@1' Access 2010+ uses different description: 'Microsoft Access
can't synchronize this member of the replica set because one or more objects
are open.@Because synchronizing may involve updating the data in or design
of the database, all objects must be closed before you synchronize.@Close all
objects and try again.@1@@@1'

Access 2003+

7719

You can't save design changes to '|' at a replica.@Design changes to replicated
objects can be made only at the Design Master.@@1@@1 Access 2007+ uses
different description: 'You can't save design changes to '|' at a replica.@Design
changes to replicated objects can be made only at the Design
Master.@@1@@@1'

Access 2003+

7720

You can't save design changes to '|1' at a replica.@Design changes to replicated
objects can be made only at the Design Master. Do you want to save it as a new,
local object?@@19@@2 Access 2007+ uses different description: 'You can't
save design changes to '|1' at a replica.@Design changes to replicated objects
can be made only at the Design Master. Do you want to save it as a new, local
object?@@19@@@2'

Access 2003+

7721

You can't delete or rename '|' at a replica.@These operations can't be performed
on a replica; they can be performed only at the Design Master.@@1@@1
Access 2007+ uses different description: 'You can't delete or rename '|' at a
replica.@These operations can't be performed on a replica; they can be
performed only at the Design Master.@@1@@@1'

Access 2003+

7722
All open objects must be closed before creating a replica.@Do you want
Microsoft Office Access to close the objects?@@19@@2 Access 2007+ uses
different description: ''

Access 2003

7723 Microsoft Office Access couldn't close one or more objects.@Close all objects
manually and try again.@@1@@1 Access 2007+ uses different description: '' Access 2003

7724

Microsoft Office Access has converted '|1' to the Design Master for the replica
set.@Only the Design Master can accept changes to the database structure;
however, data changes can be made at the Design Master or any
replica.@@1@@1 Access 2007+ uses different description: 'Microsoft
Office Access has converted '|1' to the Design Master for the replica set.@Only
the Design Master can accept changes to the database structure; however, data
changes can be made at the Design Master or any replica.@@1@@@1' Access
2010+ uses different description: 'Microsoft Access has converted '|1' to the
Design Master for the replica set.@Only the Design Master can accept changes
to the database structure; however, data changes can be made at the Design
Master or any replica.@@1@@@1'

Access 2003+

Error Code Error Description Supported Versions
7725 Microsoft Office Access has converted '|1' to the Design Master for the replica

set and has created a replica at '|2'.@Only the Design Master can accept
changes to the database structure; however, data changes can be made at the

Access 2003+



Design Master or any replica.@@1@@1 Access 2007+ uses different
description: 'Microsoft Office Access has converted '|1' to the Design Master
for the replica set and has created a replica at '|2'.@Only the Design Master can
accept changes to the database structure; however, data changes can be made at
the Design Master or any replica.@@1@@@1' Access 2010+ uses different
description: 'Microsoft Access has converted '|1' to the Design Master for the
replica set and has created a replica at '|2'.@Only the Design Master can accept
changes to the database structure; however, data changes can be made at the
Design Master or any replica.@@1@@@1'

7726

Microsoft Office Access has created a replica at '|2'.@@@1@@1 Access
2007+ uses different description: 'Microsoft Office Access has created a
replica at '|2'.@@@1@@@1' Access 2010+ uses different description:
'Microsoft Access has created a replica at '|2'.@@@1@@@1'

Access 2003+

7727

Microsoft Office Access can't create a replica because this database is already
open in exclusive mode.@Do you want Microsoft Office Access to close the
database?@@19@@2 Access 2007+ uses different description: 'Microsoft
Office Access can't create a replica because this database is already open in
exclusive mode.@Do you want Microsoft Office Access to close the database?
@@19@@@2' Access 2010+ uses different description: 'Microsoft Access
can't create a replica because this database is already open in exclusive
mode.@Do you want Microsoft Access to close the database?@@19@@@2'

Access 2003+

7728

Microsoft Office Access can't overwrite '|': the replica can't be created at this
location.@The file you are trying to overwrite may be open.@Close any other
applications that might be using this file.@1@@1 Access 2007+ uses different
description: 'Microsoft Office Access can't overwrite '|': the replica can't be
created at this location.@The file you are trying to overwrite may be
open.@Close any other applications that might be using this file.@1@@@1'
Access 2010+ uses different description: 'Microsoft Access can't overwrite
'|1': the replica can't be created at this location.@The file you are trying to
overwrite may be open.@Close any other applications that might be using this
file.@1@@@1'

Access 2003+

7729

Microsoft Office Access can't make a new replica at '|' because the source has
the same path and file name.@Choose a different path or file name for the new
replica.@@1@@1 Access 2007+ uses different description: 'Microsoft
Office Access can't make a new replica at '|' because the source has the same
path and file name.@Choose a different path or file name for the new
replica.@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access can't make a new replica at '|1' because the source has the same path and
file name.@Choose a different path or file name for the new
replica.@@1@@@1'

Access 2003+

7730
The synchronization was completed successfully.@@@1@@1 Access 2007+
uses different description: 'The synchronization was completed
successfully.@@@1@@@1'

Access 2003+

7731

Microsoft Office Access can't synchronize this member of the replica set
because it is open in exclusive mode. @To open the database in shared mode,
close the database, click Open Database on the File menu, and clear the
Exclusive check box. Then select the database.@@1@@1 Access 2007+ uses
different description: 'Microsoft Office Access cannot synchronize this
member of the replica set because it is open in Exclusive mode. @To open the
database in Shared mode, close and reopen the database.@@1@@@1' Access
2010+ uses different description: 'Microsoft Access cannot synchronize this
member of the replica set because it is open in Exclusive mode. @To open the
database in Shared mode, close and reopen the database.@@1@@@1'

Access 2003+

7732 '|' is saved as a local table. Changes made to it won't be sent to the replicas in
the set.@To make this table available to other members of the replica set, close
the table, select it in the Database window, click Properties on the View menu,
and then select the Replicated check box.@@1@@1 Access 2007+ uses

Access 2003+



different description: ''|' is saved as a local table. Changes made to the table
will not be sent to the replicas in the set.@To make this table available to other
members of the replica set, close the table, right-click it in the Navigation Pane,
click Table Properties on the shortcut menu, and then select the Replicated
check box.@@1@@@1'

7733

The synchronization request has been received, and the Synchronizer will
complete the process as resources become available.@Make sure that the
Synchronizer for this member of the replica set is running. It may be several
minutes before the synchronization will occur.@@1@@1 Access 2007+ uses
different description: 'The synchronization request has been received, and the
Synchronizer will complete the process as resources become available.@Make
sure that the Synchronizer for this member of the replica set is running. It may
be several minutes before the synchronization will occur.@@1@@@1'

Access 2003+

7734

Microsoft Office Access has saved the design of table '|,' but it will not be made
replicable until the Table window is closed.@@@1@@1 Access 2007+ uses
different description: 'Microsoft Office Access has saved the design of table '|,'
but it will not be made replicable until the Table window is
closed.@@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access has saved the design of table '|1,' but it will not be made replicable until
the Table window is closed.@@@1@@@1'

Access 2003+

7735

Changes to this object can be made only at the Design Master.@Any changes
you make will be discarded when the form is closed.@To save your changes,
click Save As on the File menu and save the object under a different
name.@1@@1 Access 2007+ uses different description: 'Changes to this
object can be made only at the Design Master.@Any changes you make will be
discarded when the form is closed.@To save your changes, click the Microsoft
Office Button, point to Save As, and then save the object under a different
name.@1@@@1' Access 2010+ uses different description: 'Changes to this
object can be made only at the Design Master.@Any changes you make will be
discarded when the form is closed.@To save your changes, click the File tab,
point to Save As, and then save the object under a different name.@1@@@0'

Access 2003+

7736

Microsoft Office Access has deleted '|' and removed it from the replica
set.@This change isn't reflected until the database is closed and reopened.@Do
you want Microsoft Office Access to close and reopen the database now?
@19@@2 Access 2007+ uses different description: ''

Access 2003

7737

Microsoft Office Access has converted '|1' to the Design Master for the replica
set and has created a replica at '|2'.@The new replica will not appear in the list
of potential synchronization partners until this database is closed and
reopened.@Do you want Microsoft Office Access to close and reopen the
database now?@19@@2 Access 2007+ uses different description: 'Microsoft
Office Access has converted '|1' to the Design Master for the replica set and has
created a replica at '|2'.@The new replica will not appear in the list of potential
synchronization partners until this database is closed and reopened.@Do you
want Microsoft Office Access to close and reopen the database now?
@19@@@2' Access 2010+ uses different description: 'Microsoft Access has
converted '|1' to the Design Master for the replica set and has created a replica
at '|2'.@The new replica will not appear in the list of potential synchronization
partners until this database is closed and reopened.@Do you want Microsoft
Access to close and reopen the database now?@19@@@2'

Access 2003+

7738 Microsoft Office Access has successfully created a replica at '|2'.@However,
the new replica will not appear in the list of potential synchronization partners
until this database is closed and reopened.@Do you want Microsoft Office
Access to close and reopen the database now?@19@@2 Access 2007+ uses
different description: 'Microsoft Office Access has successfully created a
replica at '|2'.@However, the new replica will not appear in the list of potential
synchronization partners until this database is closed and reopened.@Do you
want Microsoft Office Access to close and reopen the database now?

Access 2003+



@19@@@2' Access 2010+ uses different description: 'Microsoft Access has
successfully created a replica at '|2'.@However, the new replica will not appear
in the list of potential synchronization partners until this database is closed and
reopened.@Do you want Microsoft Access to close and reopen the database
now?@19@@@2'

7739

Microsoft Office Access has deleted '|' and removed it from the replica
set.@This change isn't reflected until the database is closed and
reopened.@Please close and reopen the database when you are finished
synchronizing replicas.@1@@1 Access 2007+ uses different description:
'Microsoft Office Access has deleted '|' and removed it from the replica
set.@This change isn't reflected until the database is closed and
reopened.@Please close and reopen the database when you are finished
synchronizing replicas.@1@@@1' Access 2010+ uses different description:
'Microsoft Access has deleted '|1' and removed it from the replica set.@This
change isn't reflected until the database is closed and reopened.@Please close
and reopen the database when you are finished synchronizing
replicas.@1@@@1'

Access 2003+

7740

Microsoft Office Access cannot synchronize with a database from a previous
version.@Convert the database you are trying to synchronize with, before
synchronizing.@@1@@1 Access 2007+ uses different description:
'Microsoft Office Access cannot synchronize with a database from a previous
version.@Convert the database you are trying to synchronize with, before
synchronizing.@@1@@@1' Access 2010+ uses different description:
'Microsoft Access cannot synchronize with a database from a previous
version.@Convert the database you are trying to synchronize with, before
synchronizing.@@1@@@1'

Access 2003+

7741

Microsoft Office Access can't make a new replica at '|' because the value
entered for priority is out of range.@Priority for new replicas should be in the
range of 0-100.@@1@@1 Access 2007+ uses different description:
'Microsoft Office Access can't make a new replica at '|' because the value
entered for priority is out of range.@Priority for new replicas should be in the
range of 0-100.@@1@@@1' Access 2010+ uses different description:
'Microsoft Access can't make a new replica at '|1' because the value entered for
priority is out of range.@Priority for new replicas should be in the range of 0-
100.@@1@@@1'

Access 2003+

7742

Microsoft Office Access can't make a password-protected database replicable
Access 2007+ uses different description: 'Microsoft Office Access cannot
replicate a password-protected database.' Access 2010+ uses different
description: 'Microsoft Access cannot replicate a password-protected database.'

Access 2003+

7743

Backup, restore, and drop database operations are only available for Microsoft
SQL Server version 7.0 or later running on your local computer. Access 2007+
uses different description: 'Backup, restore, and drop database operations are
available only when you have at least Microsoft SQL Server 2000 installed on
your local computer.' Access 2010+ uses different description: 'Backup,
restore, and drop database operations are available only when you have a
version of Microsoft SQL Server supported by Microsoft Access installed on
your local computer. See the Microsoft Office Update Web site for the latest
information and downloads.'

Access 2003+

7744

Microsoft Office Access can't make a new replica at '|' because the value
entered for priority is out of range.@Priority for anonymous replicas should be
0.@@1@@1 Access 2007+ uses different description: 'Microsoft Office
Access can't make a new replica at '|' because the value entered for priority is
out of range.@Priority for anonymous replicas should be 0.@@1@@@1'
Access 2010+ uses different description: 'Microsoft Access can't make a new
replica at '|1' because the value entered for priority is out of range.@Priority for
anonymous replicas should be 0.@@1@@@1'

Access 2003+



Error Code Error Description Supported Versions

7745 You can't copy local objects in a replica. Design changes to replicated objects
can be made only at the Design Master. Access 2003+

7746 The Database administrative components failed to load or initialize.Verify that
the components are installed and registered locally. Access 2003+

7747
Database Replicas cannot be converted to prior versions of Microsoft Office
Access. Access 2010+ uses different description: 'Database Replicas cannot
be converted to prior versions of Microsoft Access.'

Access 2003+

7748 This stage of the conversion process is finished. To complete the conversion
process, synchronize this replica to the (converted) Design Master. Access 2003+

7749 Open the Design Master and sync to this replica before opening. Access 2003+

7750

In Datasheet view, you can't set a control property if the control is part of an
option group.@@@1@@1 Access 2007+ uses different description: 'In
Datasheet view, you can't set a control property if the control is part of an
option group.@@@1@@@1'

Access 2003+

7751

In Design view, you can't retrieve the value of the ObjectPalette property for an
OLE object contained in a bound object frame.@Microsoft Office Access
doesn't display the OLE object in the object frame in Design view.@Remove
the reference to the ObjectPalette property, or switch to Form view before you
run the macro or Visual Basic code that references the ObjectPalette
property.@1@@1 Access 2007+ uses different description: 'In Design view,
you can't retrieve the value of the ObjectPalette property for an OLE object
contained in a bound object frame.@Microsoft Office Access doesn't display
the OLE object in the object frame in Design view.@Remove the reference to
the ObjectPalette property, or switch to Form view before you run the macro or
Visual Basic code that references the ObjectPalette property.@1@@@1'
Access 2010+ uses different description: 'In Design view, you can't retrieve
the value of the ObjectPalette property for an OLE object contained in a bound
object frame.@Microsoft Access doesn't display the OLE object in the object
frame in Design view.@Remove the reference to the ObjectPalette property, or
switch to Form view before you run the macro or Visual Basic code that
references the ObjectPalette property.@1@@@1'

Access 2003+

7752

Microsoft Office Access can't apply the filter because all the records are
locked.@The RecordLocks property of the form or report or the Default Record
Locking option on the Advanced tab of the Options dialog box (Tools menu) is
set to All Records.@Reset the value to No Locks or Edited Record as
appropriate.@1@600472@1 Access 2007+ uses different description:
'Microsoft Office Access cannot apply the filter because all of the records are
locked.@Either the RecordLocks property of the form or report or the Default
Record Locking option in the Advanced section of the Access Options dialog
box (click the Microsoft Office Button, and then click Access Options) is set to
All Records.@Reset the value to No Locks or Edited Record, as
appropriate.@1@1@472@1' Access 2010+ uses different description:
'Microsoft Access cannot apply the filter because all of the records are
locked.@Either the RecordLocks property of the form or report or the Default
Record Locking option in the Advanced section of the Access Options dialog
box (click the File tab, and then click Access Options) is set to All
Records.@Reset the value to No Locks or Edited Record, as
appropriate.@1@1@472@1'

Access 2003+

7753 |@@@1@7236@1 Access 2007+ uses different description:
'|@@@1@2@7236@1' Access 2003+

7754 You can't move columns between two frozen columns in a datasheet.@To
unfreeze all columns, click Unfreeze All Columns on the Format
menu.@@1@209174@1 Access 2007+ uses different description: 'You
cannot position columns between two frozen columns in a datasheet.@To

Access 2003+



unfreeze all columns, on the Home tab, in the Records group, click More, and
then click Unfreeze All Columns.@@1@1@9174@1'

7755

Microsoft Office Access can't start the Chart Wizard.@The wizard may not be
installed, or this wizard has been disabled.@To install the Chart Wizard, rerun
the Microsoft Office Access or Microsoft Office Setup program, click
Add/Remove, and then select the Wizards check box. To reenable this wizard,
click About Microsoft Office Access on the Help menu, and then click the
Disabled Items button to view a list of addins which you can enable.@1@@3
Access 2007+ uses different description: 'Microsoft Office Access can't start
the Chart Wizard.@The wizard may not be installed, or this wizard has been
disabled.@To install the Chart Wizard, rerun the Microsoft Office Access or the
Microsoft Office Setup program, click Add/Remove, and then select the
Wizards check box. To reenable this wizard, click the Microsoft Office Button,
and then click Access Options. Click Add-Ins, and then in the Manage list, click
Disabled Items, and then click Go.@1@@@3' Access 2010+ uses different
description: 'This feature isn't installed, or has been disabled.@To install this
feature, rerun the Microsoft Access or the Microsoft Office Setup program or, if
you're using a third-party add-in, reinstall the add-in. To reenable this wizard,
click the File tab, and then click Access Options. Click Add-Ins, and then in the
Manage list, click Disabled Items, and then click Go.@@1@@@3'

Access 2003+

7756

The form can't display the What's This button if the Minimize button or the
Maximize button is displayed.@Set the WhatsThisButton property to No, or set
the MinMaxButtons property to None.@@1@@1 Access 2007+ uses different
description: ''

Access 2003

7757
The form can't display the Minimize button or the Maximize button if the
What's This button is displayed.@@@1@@1 Access 2007+ uses different
description: ''

Access 2003

7758

This ActiveX control isn't enabled in Form view.@You can't set the Enabled or
TabStop properties to True.@@1@@1 Access 2007+ uses different
description: 'This ActiveX control isn't enabled in Form view.@You can't set
the Enabled or TabStop properties to True.@@1@@@1'

Access 2003+

7759

This ActiveX control isn't visible in Form view.@You can't set the Visible or
TabStop properties to True.@@1@@1 Access 2007+ uses different
description: 'This ActiveX control isn't visible in Form view.@You can't set
the Visible or TabStop properties to True.@@1@@@1'

Access 2003+

7760
This property is locked and can't be changed.@@@1@@1 Access 2007+ uses
different description: 'This property is locked and can't be
changed.@@@1@@@1'

Access 2003+

7761
An error occurred when you changed the control.@@@1@@1 Access 2007+
uses different description: 'An error occurred when you changed the
control.@@@1@@@1'

Access 2003+

7762 The pattern string is invalid.@@@2@210109@1 Access 2007+ uses different
description: 'The pattern string is invalid.@@@2@1@10109@1' Access 2003+

7763 This feature isn't installed, or has been disabled.@To install this feature, rerun
the Microsoft Office Access or Microsoft Office Setup program or, if you're
using a third-party add-in, reinstall the add-in. To reenable this wizard, click
About Microsoft Office Access on the Help menu, and then click the Disabled
Items button to view a list of addins which you can enable.@@1@@3 Access
2007+ uses different description: 'This feature isn't installed, or has been
disabled.@To install this feature, rerun the Microsoft Office Access or the
Microsoft Office Setup program or, if you're using a third-party add-in, reinstall
the add-in. To reenable this wizard, click the Microsoft Office Button, and then
click Access Options. Click Add-Ins, and then in the Manage list, click
Disabled Items, and then click Go.@@1@@@3' Access 2010+ uses different
description: 'This feature isn't installed, or has been disabled.@To install this
feature, rerun the Microsoft Access or the Microsoft Office Setup program or, if

Access 2003+



you're using a third-party add-in, reinstall the add-in. To reenable this wizard,
click the File tab, and then click Options. Click Add-Ins, and then in the
Manage list, click Disabled Items, and then click Go.@@1@@@3'

7764

This feature isn't installed, or has been disabled.@To install this feature, rerun
the Microsoft Office Access or Microsoft Office Setup program, click
Add/Remove, and then select the Wizards check box. To reenable this wizard,
click About Microsoft Office Access on the Help menu, and then click the
Disabled Items button to view a list of addins which you can enable.@@1@@3
Access 2007+ uses different description: ''

Access 2003

Error Code Error Description Supported Versions

7765

This feature isn't installed, or has been disabled.@To install this feature, rerun
the Microsoft Office Access or Microsoft Office Setup program, click
Add/Remove, and then click the Additional Wizards check box. To reenable
this wizard, click About Microsoft Office Access on the Help menu, and then
click the Disabled Items button to view a list of addins which you can
enable.@@1@@3 Access 2007+ uses different description: ''

Access 2003

7766
This control can't be changed to the type you requested.@@@1@@1 Access
2007+ uses different description: 'This control can't be changed to the type
you requested.@@@1@@@1'

Access 2003+

7767

An error occurred while Microsoft Office Access was creating a
section.@@@1@@1 Access 2007+ uses different description: 'An error
occurred while Microsoft Office Access was creating a section.@@@1@@@1'
Access 2010+ uses different description: 'An error occurred while Microsoft
Access was creating a section.@@@1@@@1'

Access 2003+

7768

In order to change data through this form, the focus must be in a bound field
that can be modified.@@@1@@1 Access 2007+ uses different description:
'In order to change data through this form, the focus must be in a bound field
that can be modified.@@@1@@@1'

Access 2003+

7769
The filter operation was canceled. The filter would be too long.@@@1@@1
Access 2007+ uses different description: 'The filter operation was canceled.
The filter would be too long.@@@1@@@1'

Access 2003+

7770

Microsoft Office Access didn't apply the filter.@Microsoft Office Access may
not be able to apply the filter if you entered an invalid data type in one of the
fields. Do you want to close the filter anyway?@If you click Yes, Microsoft
Office Access will build the filter, but won't apply it to the recordset. Then it
will close the Filter By Form window.@19@@2 Access 2007+ uses different
description: 'Microsoft Office Access didn't apply the filter.@Microsoft Office
Access may not be able to apply the filter if you entered an invalid data type in
one of the fields. Do you want to close the filter anyway?@If you click Yes,
Microsoft Office Access will build the filter, but won't apply it to the recordset.
Then it will close the Filter By Form window.@19@@@2' Access 2010+ uses
different description: 'Microsoft Access didn't apply the filter.@Microsoft
Access may not be able to apply the filter if you entered an invalid data type in
one of the fields. Do you want to close the filter anyway?@If you click Yes,
Microsoft Access will build the filter, but won't apply it to the recordset. Then it
will close the Filter By Form window.@19@@@2'

Access 2003+

7771

You can't set the ColumnOrder property when you are in Form view or Print
Preview.@@@1@@1 Access 2007+ uses different description: 'You can't set
the ColumnOrder property when you are in Form view or Print
Preview.@@@1@@@1'

Access 2003+

7773 Microsoft Office Access can't set the LimitToList property to No right
now.@The first visible column, which is determined by the ColumnWidths
property, isn't equal to the bound column.@Adjust the ColumnWidths property
first, and then set the LimitToList property.@1@600929@1 Access 2007+ uses
different description: 'Microsoft Office Access can't set the LimitToList
property to No right now.@The first visible column, which is determined by the

Access 2003+



ColumnWidths property, isn't equal to the bound column.@Adjust the
ColumnWidths property first, and then set the LimitToList
property.@1@1@929@1' Access 2010+ uses different description:
'Microsoft Access can't set the LimitToList property to No right now.@The first
visible column, which is determined by the ColumnWidths property, isn't equal
to the bound column.@Adjust the ColumnWidths property first, and then set
the LimitToList property.@1@1@929@1'

7774
You can't set the MenuBar property while an OLE object is in-place
active.@@@1@@1 Access 2007+ uses different description: 'You can't set
the MenuBar property while an OLE object is in-place active.@@@1@@@1'

Access 2003+

7775
There are too many controls on the form to allow Filter By Form.@@@1@@1
Access 2007+ uses different description: 'There are too many controls on the
form to allow Filter By Form.@@@1@@@1'

Access 2003+

7777
You've used the ListIndex property incorrectly.@@@2@606997@1 Access
2007+ uses different description: 'You've used the ListIndex property
incorrectly.@@@2@1@6997@1'

Access 2003+

7778

You can't save an object when you are in the Filter By Form window.@Switch
to Form view, and then save the object.@@1@@1 Access 2007+ uses
different description: 'You can't save an object when you are in the Filter By
Form window.@Switch to Form view, and then save the object.@@1@@@1'

Access 2003+

7779

You can't set a form's MenuBar property from its menu bar macro.@Right-click
the Form selector button (located to the left of the horizontal ruler) on the form
in Design view.Click Properties, click the Other tab, and then set the MenuBar
property.@@1@@1 Access 2007+ uses different description: 'You cannot set
a form's MenuBar property from its menu bar macro.@@1@@@1'

Access 2003+

7780

You're trying to insert into a section that can't grow enough for the control
you're trying to add.@The maximum total height for all sections in a report,
including the section headers, is 200 inches (508 cm).@Remove, or reduce the
height of, at least one section. Then try to add the control again.@1@@1
Access 2007+ uses different description: 'You're trying to insert into a section
that can't grow enough for the control you're trying to add.@The maximum
total height for all sections in a report, including the section headers, is 200
inches (508 cm).@Remove, or reduce the height of, at least one section. Then
try to add the control again.@1@@@1'

Access 2003+

7782
You can't create a new instance of this form or report while it is in Design
view.@@@1@@1 Access 2007+ uses different description: 'You can't create
a new instance of this form or report while it is in Design view.@@@1@@@1'

Access 2003+

7784

This form or report is already being designed as a subform or subreport. To
open this form in Design view, select the subform or subreport and click
Subform in New Window on the View menu. Access 2007+ uses different
description: 'The object you have selected is already open for design as a
subform or subreport. To open this object in Design view, select the subform or
subreport in the object in which it is already open, and then on the Design tab,
in the Tools group, click Subform in New Window.'

Access 2003+

7785

Microsoft Office Access didn't build the filter.@There is an error in the current
field. Do you want to close the filter anyway?@If you click Yes, Microsoft
Office Access will undo the changes to the filter, and then close the Filter By
Form window.@19@@2 Access 2007+ uses different description: 'Microsoft
Office Access didn't build the filter.@There is an error in the current field. Do
you want to close the filter anyway?@If you click Yes, Microsoft Office Access
will undo the changes to the filter, and then close the Filter By Form
window.@19@@@2' Access 2010+ uses different description: 'Microsoft
Access didn't build the filter.@There is an error in the current field. Do you
want to close the filter anyway?@If you click Yes, Microsoft Access will undo
the changes to the filter, and then close the Filter By Form
window.@19@@@2'

Access 2003+



7788 Compile error.@@@1@@1 Access 2007+ uses different description: '' Access 2003

7789 Type mismatch.@@@1@@1 Access 2007+ uses different description: 'Type
mismatch.@@@1@@@1' Access 2003+

7790

Microsoft Office Access can't create the |1.@Either there was an error getting
information from the table or query you selected, or a new |2 could not be
created.@@1@@1 Access 2007+ uses different description: 'Microsoft
Office Access can't create the |1.@Either there was an error getting information
from the table or query you selected, or a new |2 could not be
created.@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access can't create the |1.@Either there was an error getting information from
the table or query you selected, or a new |2 could not be created.@@1@@@1'

Access 2003+

Error Code Error Description Supported Versions

7791

There was an error creating your |1.@Some fields may have been skipped
because there was an error getting information about them or because they
didn't fit on the |2.@@1@@1 Access 2007+ uses different description: 'There
was an error creating your |1.@Some fields may have been skipped because
there was an error getting information about them or because they didn't fit on
the |2.@@1@@@1'

Access 2003+

7792
You can't open a subform when it is also open in Design view.@@@1@@1
Access 2007+ uses different description: 'You can't open a subform or
subreport when it is also open in Design view.@@@1@@@1'

Access 2003+

7793
You must save the form '|' before you can embed it.@@@1@@1 Access 2007+
uses different description: 'You must save the form '|' before you can embed
it.@@@1@@@1'

Access 2003+

7794

Microsoft Office Access couldn't find the toolbar '|'.@@@1@@1 Access
2007+ uses different description: 'Microsoft Office Access couldn't find the
toolbar '|'.@@@1@@@1' Access 2010+ uses different description:
'Microsoft Access could not find the toolbar '|1'.@@@1@@@1'

Access 2003+

7795

The custom toolbar '|' is the wrong type (menu, shortcut menu, or toolbar) for
the property it's being used in.@@@1@@1 Access 2007+ uses different
description: 'The custom toolbar '|' is the wrong type (menu, shortcut menu, or
toolbar) for the property it's being used in.@@@1@@@1'

Access 2003+

7796

The process failed because there is no printer installed.@Because Microsoft
Office Access saves the printer settings with each form or report, a printer is
needed to convert, enable, copy and paste, import, or export your forms or
reports. To install a printer, point to Settings on the Windows Start menu, click
Printers, and then double-click Add Printer. Follow the instructions in the
wizard.@@1@@1 Access 2007+ uses different description: 'The process
failed because there is no printer installed.@Because Microsoft Office Access
saves the printer settings with each form or report, a printer is needed to
convert, enable, copy and paste, import, or export your forms or reports. To
install a printer: In Microsoft Windows XP, click Start, and then click Printers
and Faxes. Under Printer Tasks, click Add a printer. In Microsoft Windows
2000, click Start, point to Settings, and then click Printers. Double-click Add
Printer. Follow the instructions in the wizard.@@1@@@1' Access 2010+ uses
different description: 'The process failed because there is no printer
installed.@Because Microsoft Access saves the printer settings with each form
or report, a printer is needed to convert, enable, copy and paste, import, or
export your forms or reports. To install a printer: In Microsoft Windows XP,
click Start, and then click Printers and Faxes. Under Printer Tasks, click Add a
printer. In Microsoft Windows 2000, click Start, point to Settings, and then
click Printers. Double-click Add Printer. Follow the instructions in the
wizard.@@1@@@1'

Access 2003+

7797 You must save new objects in the database before you can save them to this
external format.@@@1@@1 Access 2007+ uses different description: 'You

Access 2003+



must save new objects in the database before you can save them to this external
format.@@@1@@@1'

7798
You can only save select, crosstab, and union queries to this
format.@@@1@@1 Access 2007+ uses different description: 'You can only
save select, crosstab, and union queries to this format.@@@1@@@1'

Access 2003+

7799

This form or report is based on a query that exceeds the limit for data in a
single record.@Exclude any unnecessary fields from the query, or change some
of the field types to Memo in the original tables.@@1@@1 Access 2007+ uses
different description: 'This form or report is based on a query that exceeds the
limit for data in a single record.@Exclude any unnecessary fields from the
query, or change some of the field types to Memo in the original
tables.@@1@@@1'

Access 2003+

7800

You can't create a Microsoft Office Access MDE database from a database in an
old format.@Close the database and convert it to the current version of
Microsoft Office Access. Then create the MDE database.@@1@@1 Access
2007+ uses different description: 'You can't create a Microsoft Office Access
MDE database from a database in an old format.@Close the database and
convert it to the current version of Microsoft Office Access. Then create the
MDE database.@@1@@@1' Access 2010+ uses different description: 'You
can't create a Microsoft Access MDE database from a database in an old
format.@Close the database and convert it to the current version of Microsoft
Access. Then create the MDE database.@@1@@@1'

Access 2003+

7801

This database is in an unrecognized format.@The database may have been
created with a later version of Microsoft Office Access than the one you are
using. Upgrade your version of Microsoft Office Access to the current one, then
open this database.@@1@@1 Access 2007+ uses different description: 'This
database is in an unrecognized format.@The database may have been created
with a later version of Microsoft Office Access than the one you are using.
Upgrade your version of Microsoft Office Access to the current one, then open
this database.@@1@@@1' Access 2010+ uses different description: 'This
database is in an unrecognized format.@The database may have been created
with a later version of Microsoft Access than the one you are using. Upgrade
your version of Microsoft Access to the current one, then open this
database.@@1@@@1'

Access 2003+

7802
That command isn't available in an MDE/ADE database.@@@1@@1 Access
2007+ uses different description: 'The command you specified is not available
in an .mde, .accde, or .ade database.@@@1@@@1'

Access 2003+

7803

Microsoft Office Access can't rename |1 to |2. The convert operation
failed.@@@1@@1 Access 2007+ uses different description: 'Microsoft
Office Access can't rename |1 to |2. The convert operation
failed.@@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access can't rename |1 to |2. The convert operation failed.@@@1@@@1'

Access 2003+

7805 This is already an MDE database.@@@1@@1 Access 2007+ uses different
description: 'This is already an MDE database.@@@1@@@1' Access 2003+

7806

This database does not have a Visual Basic project, so it can't be made into an
MDE file.@Open the database in Microsoft Office Access to create the Visual
Basic project.@@1@@1 Access 2007+ uses different description: 'This
database does not have a Visual Basic project, so it can't be made into an MDE
file.@Open the database in Microsoft Office Access to create the Visual Basic
project.@@1@@@1' Access 2010+ uses different description: 'This database
does not have a Visual Basic project, so it can't be made into an MDE
file.@Open the database in Microsoft Access to create the Visual Basic
project.@@1@@@1'

Access 2003+

7807 You can't make the open database into an MDE file while running a macro or
Visual Basic code.@Instead of using a macro or code, on the Tools menu, point
to Database Utilities, and then click Make MDE File.@@1@@1 Access 2007+

Access 2003+



uses different description: 'You cannot convert the open database to an MDE
file by running a macro or Visual Basic code.@Instead of using a macro or
code, on the Database Tools tab, in the Database Tools group, click Make
MDE.@@1@@@1'

7808

Microsoft Office Access can't replace an existing file as a result of converting
the Microsoft Office Access database.You must select a new file
name.@@@1@@1 Access 2007+ uses different description: 'Microsoft
Office Access can't replace an existing file as a result of converting the
Microsoft Office Access database.You must select a new file
name.@@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access can't replace an existing file as a result of converting the Microsoft
Access database.You must select a new file name.@@@1@@@1'

Access 2003+

7809

You can't rename a | object in the client/server version of Microsoft Office
Access.@@@1@@1 Access 2007+ uses different description: 'You can't
rename a | object in the client/server version of Microsoft Office
Access.@@@1@@@1' Access 2010+ uses different description: 'You cannot
rename a |1 object in the client/server version of Microsoft
Access.@@@1@@@1'

Access 2003+

7810

You can't compact the open database while running a macro or Visual Basic
code.@Instead of using a macro or code, on the Tools menu, point to Database
Utilities, and then click Compact/Repair Database.@@1@@1 Access 2007+
uses different description: 'You cannot compact the open database by running
a macro or Visual Basic code.@Instead of using a macro or code, click the
Microsoft Office Button, point to Manage, and then click Compact and Repair
Database.@@1@@@1' Access 2010+ uses different description: 'You cannot
compact the open database by running a macro or Visual Basic code.@Instead
of using a macro or code, click the File tab and then click Compact and Repair
Database.@@1@@@0'

Access 2003+

7811

Microsoft Office Accessrequires Microsoft SQL Server 6.5 or later for Access
projects.You need to upgrade the selected SQL database to Microsoft SQL
Server 6.5 or later.@@@1@@1 Access 2007+ uses different description:
'Microsoft Office Accessrequires Microsoft SQL Server 6.5 or later for Access
projects.You need to upgrade the selected SQL database to Microsoft SQL
Server 6.5 or later.@@@1@@@1' Access 2010+ uses different description:
'Microsoft Accessrequires Microsoft SQL Server 6.5 or later for Access
projects.You need to upgrade the selected SQL database to Microsoft SQL
Server 6.5 or later.@@@1@@@1'

Access 2003+

Error Code Error Description Supported Versions

7812
Microsoft Office Access projects can only be connected to Microsoft SQL
Server Access 2010+ uses different description: 'Microsoft Access projects
can only be connected to Microsoft SQL Server'

Access 2003+

7813
Restoring a database requires that no one is currently using the database.@Do
you want to close all objects, select a backup file, and restore the database from
backup?@@1@@1 Access 2007+ uses different description: ''

Access 2003

7814
Dropping a database requires that no one is currently using the database.@Do
you want to close all open objects and drop the database?@@1@@1 Access
2007+ uses different description: ''

Access 2003

7815

Microsoft Office Access was unable to create an ADE database.@@@1@@1
Access 2007+ uses different description: 'Microsoft Office Access was unable
to create an ADE database.@@@1@@@1' Access 2010+ uses different
description: 'Microsoft Access was unable to create an ADE
database.@@@1@@@1'

Access 2003+

7816 Microsoft Office Access requires this Microsoft SQL Server 6.5 installation to
be upgraded to service pack 5 in order to successfully connect to this server.
@@@1@@1 Access 2007+ uses different description: 'Microsoft Office
Access requires this Microsoft SQL Server 6.5 installation to be upgraded to

Access 2003+



service pack 5 in order to successfully connect to this server. @@@1@@@1'
Access 2010+ uses different description: 'Microsoft Access requires this
Microsoft SQL Server 6.5 installation to be upgraded to service pack 5 in order
to successfully connect to this server. @@@1@@@1'

7817
The database file '|' is already open. You cannot encode to an open
file.@@@1@@1 Access 2007+ uses different description: 'The database file
'|' is already open. You cannot encode to an open file.@@@1@@@1'

Access 2003+

7818
Microsoft Office Access was unable to create the Database window.@Please
upgrade to a newer version of Microsoft Internet Explorer.@@1@@1 Access
2007+ uses different description: ''

Access 2003

7819

You have chosen a database template file that is not supported in the current
version of Microsoft Office Access.@To create a database using the Database
Wizard, click the Databases tab in the New dialog box and then double-click a
database icon.@@1@@1 Access 2007+ uses different description: 'You have
chosen a database template file that is not supported in the current version of
Microsoft Office Access.@To create a database using the Database Wizard,
click the Databases tab in the New dialog box and then double-click a database
icon.@@1@@@1' Access 2010+ uses different description: 'You have
chosen a database template file that is not supported in the current version of
Microsoft Access.@To create a database using the Database Wizard, click the
Databases tab in the New dialog box and then double-click a database
icon.@@1@@@1'

Access 2003+

7820 Microsoft Office Access no longer supports Pages as startup documents. Access
2007+ uses different description: '' Access 2003

7821

The TEMP environment variable isn't defined.Microsoft Office Access can't
find the temporary file directory.@@@1@@1 Access 2007+ uses different
description: 'The TEMP environment variable isn't defined.Microsoft Office
Access can't find the temporary file directory.@@@1@@@1' Access 2010+
uses different description: 'The TEMP environment variable isn't
defined.Microsoft Access can't find the temporary file
directory.@@@1@@@1'

Access 2003+

7822

Microsoft Office Access can't initialize the transfer object.Make sure you have
Microsoft SQL Server or the Microsoft SQL Server Desktop Engine installed
on the local machine.@@@1@@1 Access 2007+ uses different description:
'Microsoft Office Access can't initialize the transfer object.Make sure you have
Microsoft SQL Server or the Microsoft SQL Server Desktop Engine installed
on the local machine.@@@1@@@1' Access 2010+ uses different
description: 'Microsoft Access can't initialize the transfer object.Make sure you
have Microsoft SQL Server or the Microsoft SQL Server Desktop Engine
installed on the local machine.@@@1@@@1'

Access 2003+

7823

The source or destination database name is missing.The transfer operation can't
continue.@@@1@@1 Access 2007+ uses different description: 'The source
or destination database name is missing.The transfer operation can't
continue.@@@1@@@1'

Access 2003+

7824

The source or destination server name is missing.The transfer operation can't
continue.@@@1@@1 Access 2007+ uses different description: 'The source
or destination server name is missing.The transfer operation can't
continue.@@@1@@@1'

Access 2003+

7825

Microsoft Office Access can't find the server '|'.@@@1@@1 Access 2007+
uses different description: 'Microsoft Office Access can't find the server
'|'.@@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access cannot find the server '|1'.@@@1@@@1'

Access 2003+

7826 The database object type isn't supported by the Microsoft Office Access transfer
operation.@@@1@@1 Access 2007+ uses different description: 'The
database object type isn't supported by the Microsoft Office Access transfer
operation.@@@1@@@1' Access 2010+ uses different description: 'The

Access 2003+



database object type isn't supported by the Microsoft Access transfer
operation.@@@1@@@1'

7827

The current database '|1' has |2 active connections.Microsoft Office Access must
disconnect all applications before you can copy the database file.What do you
want to do to all the active connections?�&Disconnect�Cancel@@@35@@
Access 2007+ uses different description: 'The current database '|1' has |2
active connections.Microsoft Office Access must disconnect all applications
before you can copy the database file.What do you want to do to all the active
connections?�&Disconnect�Cancel@@@35@@@' Access 2010+ uses
different description: 'The current database '|1' has |2 active
connections.Microsoft Access must disconnect all applications before you can
copy the database file.What do you want to do to all the active
connections?�&Disconnect�Cancel@@@35@@@'

Access 2003+

7828

The object '|' is not a valid Microsoft SQL Server database object.Microsoft
Office Access can't transfer this object.@@@1@@1 Access 2007+ uses
different description: 'The object '|' is not a valid Microsoft SQL Server
database object.Microsoft Office Access can't transfer this
object.@@@1@@@1' Access 2010+ uses different description: 'The object
'|1' is not a valid Microsoft SQL Server database object.Microsoft Access can't
transfer this object.@@@1@@@1'

Access 2003+

7829

The SQL script used to create database objects is corrupted. Microsoft Office
Access can't create the new objects.@@@1@@1 Access 2007+ uses different
description: 'The SQL script used to create database objects is corrupted.
Microsoft Office Access can't create the new objects.@@@1@@@1' Access
2010+ uses different description: 'The SQL script used to create database
objects is corrupted. Microsoft Access can't create the new
objects.@@@1@@@1'

Access 2003+

7830

The SQL script used to create database object '|' is corrupted. Microsoft Office
Access can't create the new object.@@@1@@1 Access 2007+ uses different
description: 'The SQL script used to create database object '|' is corrupted.
Microsoft Office Access can't create the new object.@@@1@@@1' Access
2010+ uses different description: 'The SQL script used to create database
object '|1' is corrupted. Microsoft Access can't create the new
object.@@@1@@@1'

Access 2003+

7831

Microsoft Office Access can't create the file '|'.@@@1@@1 Access 2007+
uses different description: 'Microsoft Office Access can't create the file
'|'.@@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access cannot create the file '|1'.@@@1@@@1'

Access 2003+

Error Code Error Description Supported Versions

7832

The current database '|' is replicated and can't be copied until you disable
replication. Use Microsoft SQL Server Enterprise Manager to remove
publications and subscriptions before copying the database file.@@@1@@1
Access 2007+ uses different description: 'The current database '|' is replicated
and can't be copied until you disable replication. Use Microsoft SQL Server
Enterprise Manager to remove publications and subscriptions before copying
the database file.@@@1@@@1'

Access 2003+

7833
The current database '|' has more than one data file and can't be
copied.@@@1@@1 Access 2007+ uses different description: 'The current
database '|' has more than one data file and can't be copied.@@@1@@@1'

Access 2003+

7834

The Transfer Database Wizard didn't provide enough information to perform
the transfer operation.@@@1@@1 Access 2007+ uses different description:
'The Transfer Database Wizard didn't provide enough information to perform
the transfer operation.@@@1@@@1'

Access 2003+

7835 Microsoft Office Access can't copy the database file because one or more
objects are open. Do you want to close all the objects?@@@1@@1 Access
2007+ uses different description: 'Microsoft Office Access can't copy the

Access 2003+



database file because one or more objects are open. Do you want to close all the
objects?@@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access can't copy the database file because one or more objects are open. Do
you want to close all the objects?@@@1@@@1'

7836

Microsoft Office Access can't copy the database file because one or more
objects are open. Close all objects and try again.@@@1@@1 Access 2007+
uses different description: 'Microsoft Office Access can't copy the database
file because one or more objects are open. Close all objects and try
again.@@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access can't copy the database file because one or more objects are open. Close
all objects and try again.@@@1@@@1'

Access 2003+

7837 Invalid argument in script.@@@1@@1 Access 2007+ uses different
description: 'Invalid argument in script.@@@1@@@1' Access 2003+

7838

There were errors during the database transfer operation.Open the transfer log
file for details.@@@1@@1 Access 2007+ uses different description: 'There
were errors during the database transfer operation.Open the transfer log file for
details.@@@1@@@1'

Access 2003+

7839
Errors occurred during the database transfer operation.@@@1@@1 Access
2007+ uses different description: 'Errors occurred during the database transfer
operation.@@@1@@@1'

Access 2003+

7840

The database transfer operation failed. The destination database '|' was created
and is in an unknown state.What would you like to do with the destination
database?�&Keep�&Delete@@@35@@ Access 2007+ uses different
description: 'The database transfer operation failed. The destination database '|'
was created and is in an unknown state.What would you like to do with the
destination database?�&Keep�&Delete@@@35@@@'

Access 2003+

7841

The destination file '|' already exists. Set the Overwrite flag to TRUE if you
want to replace the existing file.@@@1@@1 Access 2007+ uses different
description: 'The destination file '|' already exists. Set the Overwrite flag to
TRUE if you want to replace the existing file.@@@1@@@1'

Access 2003+

7842

This operation requires Microsoft SQL Server version 7.0 or later on your local
computer. You can install Microsoft SQL Server 2000 Desktop Engine from the
MSDE2000 folder on the Microsoft Office CD-ROM.@@@1@@1 Access
2007+ uses different description: 'This operation requires at least Microsoft
SQL Server 2000 to be installed on your local computer.@@@1@@@1'
Access 2010+ uses different description: 'This database operation is available
only when you have a version of Microsoft SQL Server supported by Microsoft
Access installed on your local computer. See the Microsoft Office Update Web
site for the latest information and downloads.@@@1@@@1'

Access 2003+

7843

You can only copy the database file when the current database is on your local
computer. If you want to make a copy of a database on a remote server point to
Database Utilities on the Tools menu, and then click Transfer
Database.@@@1@@1 Access 2007+ uses different description: 'You can
only copy a database that is on your local computer. To make a copy of a
database on a remote computer, click the Microsoft Office Button, point to
Server Tasks, and then click Transfer Database.@@@1@@@1' Access 2010+
uses different description: 'You can only copy a database that is on your local
computer. To make a copy of a database on a remote computer, click the File
tab, point to Server Tasks, and then click Transfer Database.@@@1@@@0'

Access 2003+

7844

Microsoft Office Access can't copy the database file because there are active
connections to the current database.@@@1@@1 Access 2007+ uses different
description: 'Microsoft Office Access can't copy the database file because there
are active connections to the current database.@@@1@@@1' Access 2010+
uses different description: 'Microsoft Access can't copy the database file
because there are active connections to the current database.@@@1@@@1'

Access 2003+

7845 |@@@1@@1 Access 2007+ uses different description: '|@@@1@@@1' Access 2003+



7846

Microsoft Office Access can't compact and repair the current
database.@@@1@@1 Access 2007+ uses different description: 'Microsoft
Office Access can't compact and repair the current database.@@@1@@@1'
Access 2010+ uses different description: 'Microsoft Access can't compact and
repair the current database.@@@1@@@1'

Access 2003+

7847

'|' already exists.Microsoft Office Access must create a backup of your file
before performing the repair operation. Enter a name for the backup
file.@@@1@@1 Access 2007+ uses different description: ''|' already
exists.Microsoft Office Access must create a backup of your file before
performing the repair operation. Enter a name for the backup
file.@@@1@@@1' Access 2010+ uses different description: '|1' already
exists.Microsoft Access must create a backup of your file before you perform
the repair operation. Enter a name for the backup file.@@@1@@@1'

Access 2003+

7848

The transfer operation has been cancelled. The destination database '|' was
created and is in an unknown state.What would you like to do with the
destination database?�&Keep�&Delete@@@35@@ Access 2007+ uses
different description: 'The transfer operation has been cancelled. The
destination database '|' was created and is in an unknown state.What would you
like to do with the destination database?�&Keep�&Delete@@@35@@@'

Access 2003+

7849

The repair operation has been cancelled because Microsoft Office Access
couldn't create a backup of the file.You might not have adequate permissions or
enough disk space to create the backup file. To repair the file manually, point to
Database Utilities on the Tools menu, and then click Compact and Repair
Database.@@@1@@1 Access 2007+ uses different description: 'The repair
operation has been canceled because Microsoft Office Access could not create a
backup of the file. You might not have adequate permissions or enough disk
space to create the backup file. To repair the file manually, click the Microsoft
Office Button, point to Manage, and then click Compact and Repair
Database.@@@1@@@1' Access 2010+ uses different description: 'The
repair operation has been canceled because Microsoft Access could not create a
backup of the file. You might not have adequate permissions or enough disk
space to create the backup file. To repair the file manually, click the File tab,
point to Manage, and then click Compact and Repair Database.@@@1@@@1'

Access 2003+

7850

Microsoft Office Access can't find the wizard, or the wizard has not been
installed, or there is a syntax error in the Declarations section of a Visual Basic
module.@ The wizard you need may be missing from the Libraries key of the
Microsoft Office Access section of the Windows Registry, or the wizard has
been disabled.@To make sure that the wizard is in the Windows Registry, run
Setup to reinstall Microsoft Office Access, and then compile all Visual Basic
modules in the database. To reenable this wizard, click About Microsoft Office
Access on the Help menu, and then click the Disabled Items button to view a
list of addins which you can enable. @1@@3 Access 2007+ uses different
description: 'The wizard you've requested is not installed or is in a bad state.
Please install or reinstall the wizard.If you do not have permission to do this on
your computer, please contact your help desk
representative.@@@1@1@153723@1'

Access 2003+

7851

The toolbar name '|' you entered already exists.@Enter a unique name for this
toolbar.@@1@@1 Access 2007+ uses different description: 'The toolbar
name '|' you entered already exists.@Enter a unique name for this
toolbar.@@1@@@1'

Access 2003+

Error Code Error Description Supported Versions
7852 The toolbar name '|' you entered doesn't follow Microsoft Office Access object-

naming rules.@For more information about naming objects, click
Help.@@2@611734@1 Access 2007+ uses different description: 'The
toolbar name '|' you entered doesn't follow Microsoft Office Access object-
naming rules.@For more information about naming objects, click

Access 2003+



Help.@@2@1@11734@1' Access 2010+ uses different description: 'The
toolbar name '|1' you entered doesn't follow Microsoft Access object-naming
rules.@For more information about naming objects, click
Help.@@2@1@11734@1'

7853
The default column width must be at least 0.1 inch.@@@1@@1 Access 2007+
uses different description: 'The default column width must be at least 0.1
inch.@@@1@@@1'

Access 2003+

7854

You can't export database objects (except tables) from the current version of
Microsoft Office Access to earlier versions of Microsoft Office
Access.@@@1@@1 Access 2007+ uses different description: 'You can't
export database objects (except tables) from the current version of Microsoft
Office Access to earlier versions of Microsoft Office Access.@@@1@@@1'
Access 2010+ uses different description: 'You can't export database objects
(except tables) from the current version of Microsoft Access to earlier versions
of Microsoft Access.@@@1@@@1'

Access 2003+

7855

You must have a database open to create custom toolbars, and the database can't
be read-only.@@@1@@1 Access 2007+ uses different description: 'You
must have a database open to create custom toolbars, and the database can't be
read-only.@@@1@@@1'

Access 2003+

7856
'|' cannot be imported, exported, or copied to Access project files.@@@1@@1
Access 2007+ uses different description: ''|' cannot be imported, exported, or
copied to Access project files.@@@1@@@1'

Access 2003+

7858

The Tab Width setting in the Options dialog box (Tools menu) for the Module
or Debug window must be from 1 through 32.@@@1@@1 Access 2007+ uses
different description: 'The Tab Width setting in the Options dialog box (Tools
menu) for the Module or Debug window must be from 1 through
32.@@@1@@@1'

Access 2003+

7859
Microsoft Office Access can't start because there is no license for it on this
machine. Access 2010+ uses different description: 'Microsoft Access can't
start because there is no license for it on this machine.'

Access 2003+

7860

The profile '|' that you specified on the command line doesn't exist in the
Windows Registry.@@@1@@1 Access 2007+ uses different description:
'The profile '|' that you specified on the command line doesn't exist in the
Windows Registry.@@@1@@@1'

Access 2003+

7861
'|' cannot be imported, exported, or copied to Access database
files.@@@1@@1 Access 2007+ uses different description: ''|' cannot be
imported, exported, or copied to Access database files.@@@1@@@1'

Access 2003+

7862 Microsoft Office Access can't find the wizard.This wizard has not been
installed, or there is an incorrect setting in the Windows Registry, or this wizard
has been disabled. @To reenable this wizard, click About Microsoft Office
Access on the Help menu, and then click the Disabled Items button to view a
list of addins which you can enable. Rerun Microsoft Office Access or
Microsoft Office Setup to reinstall the wizards. If the missing wizard is not a
Microsoft Office Access wizard, reinstall it using the Add-in
Manager.@@1@@3 Access 2007+ uses different description: 'Microsoft
Office Access can't find the wizard. This wizard has not been installed, or there
is an incorrect setting in the Windows Registry, or this wizard has been
disabled. @To reenable this wizard, click the Microsoft Office Button, and
click Access Options. Click Add-Ins, and then in the Manage list, click
Disabled Items, and then click Go. Rerun Microsoft Office Access or Microsoft
Office Setup program to reinstall the wizards. If the missing wizard is not a
Microsoft Office Access wizard, reinstall it using the Add-in
Manager.@@1@@@3' Access 2010+ uses different description: 'Microsoft
Access can't find the wizard. This wizard has not been installed, or there is an
incorrect setting in the Windows Registry, or this wizard has been disabled.
@To reenable this wizard, click the File tab, and click Access Options. Click

Access 2003+



Add-Ins, and then in the Manage list, click Disabled Items, and then click Go.
Rerun Microsoft Access or Microsoft Office Setup program to reinstall the
wizards. If the missing wizard is not a Microsoft Access wizard, reinstall it
using the Add-in Manager.@@1@@@3'

7863
Links can only be created between Microsoft Office Access database files.
Access 2010+ uses different description: 'Links can only be created between
Microsoft Access database files.' Access 2013+ uses different description: ''

Access 2003,2007,2010

7864
Microsoft Office Access doesn't allow empty strings.@@@1@@1 Access
2013 uses different description: 'There is already an existing database with the
name you entered. Give the new database a unique name.'

Access 2003,2013

7865

There is already an existing database with the name you entered. Give the new
database a unique name. Access 2013 uses different description: 'Microsoft
Access can't open the database because it is missing, or opened exclusively by
another user, or it is not an ADP file.'

Access 2003+

7866

Microsoft Office Access can't open the database because it is missing, or
opened exclusively by another user. Access 2007 uses different description:
'Microsoft Office Access can't open the database because it is missing, or
opened exclusively by another user, or it is not an ADP file.' Access 2010 uses
different description: 'Microsoft Access can't open the database because it is
missing, or opened exclusively by another user, or it is not an ADP file.' Access
2013 uses different description: 'You already have the database open.' Access
2016 uses different description: 'Microsoft Access can't open the database
because it is missing, or opened exclusively by another user, or it is not an ADP
file.'

Access 2003+

7867
You already have the database open. Access 2013 uses different description:
'You can't use a SetMenuItem macro action on a default menu.@SetMenuItem
is for custom menus only.@@1@@@1'

Access 2003+

7868

You can't use a SetMenuItem macro action on a default menu.@SetMenuItem
is for custom menus only.@@1@@1 Access 2007 uses different description:
'You can't use a SetMenuItem macro action on a default menu.@SetMenuItem
is for custom menus only.@@1@@@1' Access 2010 uses different
description: 'You can't use a SetMenuItem macro action on a default
menu.@SetMenuItem is for custom menus only.@@1@@@1' Access 2013
uses different description: 'The SetMenuItem action does not have enough
information to be carried out.@An argument is invalid, or there are not enough
arguments.@@1@@@1' Access 2016 uses different description: 'You can't
use a SetMenuItem macro action on a default menu.@SetMenuItem is for
custom menus only.@@1@@@1'

Access 2003+

7869

The SetMenuItem action does not have enough information to be carried
out.@An argument is invalid, or there are not enough arguments.@@1@@1
Access 2007 uses different description: 'The SetMenuItem action does not
have enough information to be carried out.@An argument is invalid, or there
are not enough arguments.@@1@@@1' Access 2010 uses different
description: 'The SetMenuItem action does not have enough information to be
carried out.@An argument is invalid, or there are not enough
arguments.@@1@@@1' Access 2013 uses different description: 'Microsoft
Access can't find the database '|1.'@Check the database name (and path, if
specified) to make sure you entered it correctly.@@1@@@1' Access 2016
uses different description: 'The SetMenuItem action does not have enough
information to be carried out.@An argument is invalid, or there are not enough
arguments.@@1@@@1'

Access 2003+

7870 Microsoft Office Access can't find the database '|.'@Check the database name
(and path, if specified) to make sure you entered it correctly.@@1@@1 Access
2007 uses different description: 'Microsoft Office Access can't find the
database '|.'@Check the database name (and path, if specified) to make sure you
entered it correctly.@@1@@@1' Access 2010 uses different description:

Access 2003+



'Microsoft Access can't find the database '|1.'@Check the database name (and
path, if specified) to make sure you entered it correctly.@@1@@@1' Access
2013 uses different description: 'The table name you entered doesn't follow
Microsoft Access object-naming rules.@For more information about naming
objects, click Help.@@2@1@11734@1' Access 2016 uses different
description: 'Microsoft Access can't find the database '|1.'@Check the database
name (and path, if specified) to make sure you entered it
correctly.@@1@@@1'

7871

The table name you entered doesn't follow Microsoft Office Access object-
naming rules.@For more information about naming objects, click
Help.@@2@611734@1 Access 2007 uses different description: 'The table
name you entered doesn't follow Microsoft Office Access object-naming
rules.@For more information about naming objects, click
Help.@@2@1@11734@1' Access 2010 uses different description: 'The table
name you entered doesn't follow Microsoft Access object-naming rules.@For
more information about naming objects, click Help.@@2@1@11734@1'
Access 2013 uses different description: 'This recordset is not updatable.'
Access 2016 uses different description: 'The table name you entered doesn't
follow Microsoft Access object-naming rules.@For more information about
naming objects, click Help.@@2@1@11734@1'

Access 2003+

7872
This recordset is not updatable. Access 2013 uses different description: ''|'
cannot be imported, exported, or copied to another database or project
file.@@@1@@@1'

Access 2003+

Error Code Error Description Supported Versions

7873

'|' cannot be imported, exported, or copied to another database or project
file.@@@1@@1 Access 2007 uses different description: ''|' cannot be
imported, exported, or copied to another database or project
file.@@@1@@@1' Access 2010 uses different description: ''|' cannot be
imported, exported, or copied to another database or project
file.@@@1@@@1' Access 2013 uses different description: 'Microsoft
Access can't find the object '|1'.@* You misspelled the object name. Check for
missing underscores ( _ ) or other punctuation, and make sure you didn't enter
leading spaces. * You tried to open a linked table, but the file containing the
table isn't on the path you specified. Use the Linked Table Manager to update
the link and point to the correct path.@@1@@@1' Access 2016 uses different
description: ''|' cannot be imported, exported, or copied to another database or
project file.@@@1@@@1'

Access 2003+

7874 Microsoft Office Access can't find the object '|.'@* You misspelled the object
name. Check for missing underscores ( _ ) or other punctuation, and make sure
you didn't enter leading spaces. * You tried to open a linked table, but the file
containing the table isn't on the path you specified. Use the Linked Table
Manager to update the link and point to the correct path.@@1@@1 Access
2007 uses different description: 'Microsoft Office Access can't find the object
'|'.@* You misspelled the object name. Check for missing underscores ( _ ) or
other punctuation, and make sure you didn't enter leading spaces. * You tried to
open a linked table, but the file containing the table isn't on the path you
specified. Use the Linked Table Manager to update the link and point to the
correct path.@@1@@@1' Access 2010 uses different description: 'Microsoft
Access can't find the object '|1'.@* You misspelled the object name. Check for
missing underscores ( _ ) or other punctuation, and make sure you didn't enter
leading spaces. * You tried to open a linked table, but the file containing the
table isn't on the path you specified. Use the Linked Table Manager to update
the link and point to the correct path.@@1@@@1' Access 2013 uses different
description: 'The table '|1' already exists.@You created or renamed a table, and
then tried to save it. Before Microsoft Access could save the table, another user
created or renamed one using the same name.@@1@@@1' Access 2016 uses
different description: 'Microsoft Access can't find the object '|1'.@* You

Access 2003+



misspelled the object name. Check for missing underscores ( _ ) or other
punctuation, and make sure you didn't enter leading spaces. * You tried to open
a linked table, but the file containing the table isn't on the path you specified.
Use the Linked Table Manager to update the link and point to the correct
path.@@1@@@1'

7875

The table '|' already exists.@You created or renamed a table, and then tried to
save it. Before Microsoft Office Access could save the table, another user
created or renamed one using the same name.@@1@@1 Access 2007 uses
different description: 'The table '|' already exists.@You created or renamed a
table, and then tried to save it. Before Microsoft Office Access could save the
table, another user created or renamed one using the same name.@@1@@@1'
Access 2010 uses different description: 'The table '|1' already exists.@You
created or renamed a table, and then tried to save it. Before Microsoft Access
could save the table, another user created or renamed one using the same
name.@@1@@@1' Access 2013 uses different description: 'There isn't
enough temporary disk space to complete the operation.@Free disk space, and
then try the operation again. For more information on freeing temporary disk
space, search the Microsoft Windows Help index for 'disk space, freeing'. For
information on compacting a database to free disk space, click
Help.@@2@1@9009@3' Access 2016 uses different description: 'The table
'|1' already exists.@You created or renamed a table, and then tried to save it.
Before Microsoft Access could save the table, another user created or renamed
one using the same name.@@1@@@1'

Access 2003+

7876

There isn't enough temporary disk space to complete the operation.@Free disk
space, and then try the operation again. For more information on freeing
temporary disk space, search the Microsoft Windows Help index for 'disk
space, freeing'. For information on compacting a database to free disk space,
click Help.@@2@209009@3 Access 2007 uses different description: 'There
isn't enough temporary disk space to complete the operation.@Free disk space,
and then try the operation again. For more information on freeing temporary
disk space, search the Microsoft Windows Help index for 'disk space, freeing'.
For information on compacting a database to free disk space, click
Help.@@2@1@9009@3' Access 2010 uses different description: 'There isn't
enough temporary disk space to complete the operation.@Free disk space, and
then try the operation again. For more information on freeing temporary disk
space, search the Microsoft Windows Help index for 'disk space, freeing'. For
information on compacting a database to free disk space, click
Help.@@2@1@9009@3' Access 2013 uses different description: 'Microsoft
Access can't sort on the Memo, OLE Object, or Hyperlink '|1'.@The ORDER
BY clause of an SQL statement can't include any Memo, OLE Object, or
Hyperlink fields.@@1@@@1' Access 2016 uses different description: 'There
isn't enough temporary disk space to complete the operation.@Free disk space,
and then try the operation again. For more information on freeing temporary
disk space, search the Microsoft Windows Help index for 'disk space, freeing'.
For information on compacting a database to free disk space, click
Help.@@2@1@9009@3'

Access 2003+

7877 Microsoft Office Access can't sort on the Memo, OLE Object, or Hyperlink
'|'.@The ORDER BY clause of an SQL statement can't include any Memo, OLE
Object, or Hyperlink fields.@@1@@1 Access 2007 uses different
description: 'Microsoft Office Access can't sort on the Memo, OLE Object, or
Hyperlink '|'.@The ORDER BY clause of an SQL statement can't include any
Memo, OLE Object, or Hyperlink fields.@@1@@@1' Access 2010 uses
different description: 'Microsoft Access can't sort on the Memo, OLE Object,
or Hyperlink '|1'.@The ORDER BY clause of an SQL statement can't include
any Memo, OLE Object, or Hyperlink fields.@@1@@@1' Access 2013 uses
different description: 'The data has been changed.@Another user edited this
record and saved the changes before you attempted to save your changes.@Re-
edit the record.@1@@@1' Access 2016 uses different description: 'Microsoft

Access 2003+



Access can't sort on the Memo, OLE Object, or Hyperlink '|1'.@The ORDER
BY clause of an SQL statement can't include any Memo, OLE Object, or
Hyperlink fields.@@1@@@1'

7878

The data has been changed.@Another user edited this record and saved the
changes before you attempted to save your changes.@Re-edit the
record.@1@@1 Access 2007 uses different description: 'The data has been
changed.@Another user edited this record and saved the changes before you
attempted to save your changes.@Re-edit the record.@1@@@1' Access 2010
uses different description: 'The data has been changed.@Another user edited
this record and saved the changes before you attempted to save your
changes.@Re-edit the record.@1@@@1' Access 2013 uses different
description: 'An invalid IDA has been passed to Microsoft Access error
handling.@Please report this error and the steps that caused it.@@1@@@1'
Access 2016 uses different description: 'The data has been
changed.@Another user edited this record and saved the changes before you
attempted to save your changes.@Re-edit the record.@1@@@1'

Access 2003+

7879

An invalid IDA has been passed to Microsoft Office Access error
handling.@Please report this error and the steps that caused it.@@1@@1
Access 2007 uses different description: 'An invalid IDA has been passed to
Microsoft Office Access error handling.@Please report this error and the steps
that caused it.@@1@@@1' Access 2010 uses different description: 'An
invalid IDA has been passed to Microsoft Access error handling.@Please report
this error and the steps that caused it.@@1@@@1' Access 2013 uses different
description: 'The value you entered is the wrong data type for this
field.@Enter an integer.@@1@@@1' Access 2016 uses different description:
'An invalid IDA has been passed to Microsoft Access error handling.@Please
report this error and the steps that caused it.@@1@@@1'

Access 2003+

7880

The value you entered is the wrong data type for this field.@Enter an
integer.@@1@@1 Access 2007 uses different description: 'The value you
entered is the wrong data type for this field.@Enter an integer.@@1@@@1'
Access 2010 uses different description: 'The value you entered is the wrong
data type for this field.@Enter an integer.@@1@@@1' Access 2013 uses
different description: 'The Macro Conversion Wizard can't be started.@This
wizard may not be installed, or this wizard has been disabled.@To reenable this
wizard, click the File tab, and then click Access Options. Click Add-Ins, and
then in the Manage list, click Disabled Items, and then click Go. Rerun
Microsoft Access or the Microsoft Office Setup program to reinstall this
wizard. If you want to preserve your security or custom settings, back up the
Microsoft Access workgroup information file. For more information on backing
up files, search for 'backing up files' in Microsoft Windows Help.@1@@@2'
Access 2016 uses different description: 'The value you entered is the wrong
data type for this field.@Enter an integer.@@1@@@1'

Access 2003+

7881 The Macro Conversion Wizard can't be started.@This wizard may not be
installed, or this wizard has been disabled.@To reenable this wizard, click
About Microsoft Office Access on the Help menu, and then click the Disabled
Items button to view a list of addins which you can enable. Rerun Microsoft
Office Access or Microsoft Office Setup to reinstall this wizard. If you want to
preserve your security or custom settings, back up the Microsoft Office Access
workgroup information file. For more information on backing up files, search
the Microsoft Windows Help index for 'backing up files'.@1@@3 Access 2007
uses different description: 'The Macro Conversion Wizard can't be
started.@This wizard may not be installed, or this wizard has been
disabled.@To reenable this wizard, click the Microsoft Office Button, and then
click Access Options. Click Add-Ins, and then in the Manage list, click
Disabled Items, and then click Go. Rerun Microsoft Office Access or the
Microsoft Office Setup program to reinstall this wizard. If you want to preserve
your security or custom settings, back up the Microsoft Office Access

Access 2003+



workgroup information file. For more information on backing up files, search
for 'backing up files' in Microsoft Windows Help.@1@@@3' Access 2010
uses different description: 'The Macro Conversion Wizard can't be
started.@This wizard may not be installed, or this wizard has been
disabled.@To reenable this wizard, click the File tab, and then click Access
Options. Click Add-Ins, and then in the Manage list, click Disabled Items, and
then click Go. Rerun Microsoft Access or the Microsoft Office Setup program
to reinstall this wizard. If you want to preserve your security or custom settings,
back up the Microsoft Access workgroup information file. For more
information on backing up files, search for 'backing up files' in Microsoft
Windows Help.@1@@@2' Access 2013 uses different description: 'You can't
convert, enable, or encode an Access Project file.@@@1@@@1' Access 2016
uses different description: 'The Macro Conversion Wizard can't be
started.@This wizard may not be installed, or this wizard has been
disabled.@To reenable this wizard, click the File tab, and then click Access
Options. Click Add-Ins, and then in the Manage list, click Disabled Items, and
then click Go. Rerun Microsoft Access or the Microsoft Office Setup program
to reinstall this wizard. If you want to preserve your security or custom settings,
back up the Microsoft Access workgroup information file. For more
information on backing up files, search for 'backing up files' in Microsoft
Windows Help.@1@@@2'

7882

You can't convert, enable, or encode an Access Project file.@@@1@@1
Access 2007 uses different description: 'You can't convert, enable, or encode
an Access Project file.@@@1@@@1' Access 2010 uses different
description: 'You can't convert, enable, or encode an Access Project
file.@@@1@@@1' Access 2013 uses different description: 'You can't set the
MenuBar property unless a database is open.@@@1@@@1' Access 2016 uses
different description: 'You can't convert, enable, or encode an Access Project
file.@@@1@@@1'

Access 2003+

7883

You can't set the MenuBar property unless a database is open.@@@1@@1
Access 2007 uses different description: 'You can't set the MenuBar property
unless a database is open.@@@1@@@1' Access 2010 uses different
description: 'You can't set the MenuBar property unless a database is
open.@@@1@@@1' Access 2013 uses different description: 'You can't
export an object to itself.@Select a different database to export to, or give the
object a new name.@@1@@@1' Access 2016 uses different description:
'You can't set the MenuBar property unless a database is open.@@@1@@@1'

Access 2003+

7884

You can't export an object to itself.@Select a different database to export to, or
give the object a new name.@@1@@1 Access 2007 uses different
description: 'You can't export an object to itself.@Select a different database to
export to, or give the object a new name.@@1@@@1' Access 2010 uses
different description: 'You can't export an object to itself.@Select a different
database to export to, or give the object a new name.@@1@@@1' Access
2016 uses different description: 'You can't export an object to itself.@Select a
different database to export to, or give the object a new name.@@1@@@1'

Access 2016+

7885

The source database has no import/export specifications to copy.@@@1@@1
Access 2013 uses different description: 'Microsoft Access can't find the
dynamic-link library (DLL) Mso.@Rerun the Microsoft Access or Microsoft
Office Setup program.@@1@@@3'

Access 2003,2013

7886 Microsoft Office Access can't find the dynamic-link library (DLL)
Mso.@Rerun the Microsoft Office Access or Microsoft Office Setup
program.@@1@@3 Access 2007 uses different description: 'Microsoft
Office Access can't find the dynamic-link library (DLL) Mso.@Rerun the
Microsoft Office Access or Microsoft Office Setup program.@@1@@@3'
Access 2010 uses different description: 'Microsoft Access can't find the
dynamic-link library (DLL) Mso.@Rerun the Microsoft Access or Microsoft
Office Setup program.@@1@@@3' Access 2013 uses different description:

Access 2003+



'A unique record identifier can't consist of more than 10 fields.@@@1@@@1'
Access 2016 uses different description: 'Microsoft Access can't find the
dynamic-link library (DLL) Mso.@Rerun the Microsoft Access or Microsoft
Office Setup program.@@1@@@3'

7887

A unique record identifier can't consist of more than 10 fields.@@@1@@1
Access 2007 uses different description: 'A unique record identifier can't
consist of more than 10 fields.@@@1@@@1' Access 2010 uses different
description: 'A unique record identifier can't consist of more than 10
fields.@@@1@@@1' Access 2013 uses different description: 'You must set
the default font size to a number from |1 through |2.@For more information on
the FontSize property, click Help.@@2@2@5477@1' Access 2016 uses
different description: 'A unique record identifier can't consist of more than 10
fields.@@@1@@@1'

Access 2003+

7888

You must set the default font size to a number from |1 through |2.@For more
information on the FontSize property, click Help.@@2@5477@1 Access 2007
uses different description: 'You must set the default font size to a number
from |1 through |2.@For more information on the FontSize property, click
Help.@@2@2@5477@1' Access 2010 uses different description: 'You must
set the default font size to a number from |1 through |2.@For more information
on the FontSize property, click Help.@@2@2@5477@1' Access 2013 uses
different description: 'The file '|' does not exist.@@@1@@@1' Access 2016
uses different description: 'You must set the default font size to a number
from |1 through |2.@For more information on the FontSize property, click
Help.@@2@2@5477@1'

Access 2003+

7889

The file '|' does not exist.@@@1@@1 Access 2007 uses different
description: 'The file '|' does not exist.@@@1@@@1' Access 2010 uses
different description: 'The file '|' does not exist.@@@1@@@1' Access 2013
uses different description: 'The file '|' doesn't contain any data.@You can't
import from, or link to, an empty spreadsheet.@@1@@@1' Access 2016 uses
different description: 'The file '|' does not exist.@@@1@@@1'

Access 2003+

7890

The file '|' doesn't contain any data.@You can't import from, or link to, an
empty spreadsheet.@@1@@1 Access 2007 uses different description: 'The
file '|' doesn't contain any data.@You can't import from, or link to, an empty
spreadsheet.@@1@@@1' Access 2010 uses different description: 'The file '|'
doesn't contain any data.@You can't import from, or link to, an empty
spreadsheet.@@1@@@1' Access 2016 uses different description: 'The file '|'
doesn't contain any data.@You can't import from, or link to, an empty
spreadsheet.@@1@@@1'

Access 2016+

7891

This database is read-only.@The conditional compilation argument option can't
be saved.@@1@@1 Access 2013 uses different description: 'An error
occurred while saving module options.@You may be running Visual Basic in
break mode.@Reset the running code before changing the module
options.@1@@@1'

Access 2003,2013

7892 An error occurred while saving module options.@You may be running Visual
Basic in break mode.@Reset the running code before changing the module
options.@1@@1 Access 2007 uses different description: 'An error occurred
while saving module options.@You may be running Visual Basic in break
mode.@Reset the running code before changing the module
options.@1@@@1' Access 2010 uses different description: 'An error
occurred while saving module options.@You may be running Visual Basic in
break mode.@Reset the running code before changing the module
options.@1@@@1' Access 2013 uses different description: 'You cannot
import objects into a database created in an earlier version of Microsoft
Access.@To convert the database to the current version of Microsoft Access,
click the File tab, and then click Convert@@1@1@9029@0' Access 2016 uses
different description: 'An error occurred while saving module options.@You

Access 2003+



may be running Visual Basic in break mode.@Reset the running code before
changing the module options.@1@@@1'

Error Code Error Description Supported Versions

7893

You can't import objects into a database created in an earlier version of
Microsoft Office Access.@Convert the database to the current version of
Microsoft Office Access using the Convert Database command (Tools menu,
Database Utilities submenu).@@1@209029@1 Access 2007 uses different
description: 'You cannot import objects into a database created in an earlier
version of Microsoft Office Access.@To convert the database to the current
version of Microsoft Office Access, click the Microsoft Office Button, and then
click Convert@@1@1@9029@1' Access 2010 uses different description:
'You cannot import objects into a database created in an earlier version of
Microsoft Access.@To convert the database to the current version of Microsoft
Access, click the File tab, and then click Convert@@1@1@9029@0' Access
2016 uses different description: 'You cannot import objects into a database
created in an earlier version of Microsoft Access.@To convert the database to
the current version of Microsoft Access, click the File tab, and then click
Convert@@1@1@9029@0'

Access 2016+

7894

Microsoft Access was unable to create a window.@The system is out of
resources or memory.@Close unneeded programs and try again. For more
information on freeing memory, search the Microsoft Windows Help index for
'memory, troubleshooting'.@1@@@3 Access 2016+ uses different
description: ''

Access 2013

7895

Microsoft Office Access was unable to create a window.@The system is out of
resources or memory.@Close unneeded programs and try again. For more
information on freeing memory, search the Microsoft Windows Help index for
'memory, troubleshooting'.@1@@3 Access 2007 uses different description:
'Microsoft Office Access was unable to create a window.@The system is out of
resources or memory.@Close unneeded programs and try again. For more
information on freeing memory, search the Microsoft Windows Help index for
'memory, troubleshooting'.@1@@@3' Access 2010 uses different
description: 'Microsoft Access was unable to create a window.@The system is
out of resources or memory.@Close unneeded programs and try again. For
more information on freeing memory, search the Microsoft Windows Help
index for 'memory, troubleshooting'.@1@@@3' Access 2013 uses different
description: 'Error '|' in the validation rule.@@@2@1@687@1' Access 2016
uses different description: 'Microsoft Access was unable to create a
window.@The system is out of resources or memory.@Close unneeded
programs and try again. For more information on freeing memory, search the
Microsoft Windows Help index for 'memory, troubleshooting'.@1@@@3'

Access 2003+

7896

Error '|' in the validation rule.@@@2@600687@1 Access 2007 uses different
description: 'Error '|' in the validation rule.@@@2@1@687@1' Access 2010
uses different description: 'Error '|' in the validation rule.@@@2@1@687@1'
Access 2013 uses different description: 'Error '|' in the default
value.@@@2@1@2264@1' Access 2016 uses different description: 'Error '|'
in the validation rule.@@@2@1@687@1'

Access 2003+

7897

Error '|' in the default value.@@@2@602264@1 Access 2007 uses different
description: 'Error '|' in the default value.@@@2@1@2264@1' Access 2010
uses different description: 'Error '|' in the default value.@@@2@1@2264@1'
Access 2013 uses different description: 'Execution of this application has
stopped due to a run-time error.@The application can't continue and will be
shut down.@@1@@@3' Access 2016 uses different description: 'Error '|' in
the default value.@@@2@1@2264@1'

Access 2003+

7898 Execution of this application has stopped due to a run-time error.@The
application can't continue and will be shut down.@@1@@3 Access 2007 uses
different description: 'Execution of this application has stopped due to a run-
time error.@The application can't continue and will be shut

Access 2003+



down.@@1@@@3' Access 2010 uses different description: 'Execution of
this application has stopped due to a run-time error.@The application can't
continue and will be shut down.@@1@@@3' Access 2013 uses different
description: 'Microsoft Access can't be started.@Microsoft Access was unable
to initialize the Windows Registry.@Rerun Microsoft Access or Microsoft
Office Setup to reinstall Microsoft Access.@1@@185309@3' Access 2016
uses different description: 'Execution of this application has stopped due to a
run-time error.@The application can't continue and will be shut
down.@@1@@@3'

7899

Microsoft Office Access can't be started.@Microsoft Office Access was unable
to initialize the Windows Registry.@Rerun Microsoft Office Access or
Microsoft Office Setup to reinstall Microsoft Office Access.@1@@3 Access
2007 uses different description: 'Microsoft Office Access can't be
started.@Microsoft Office Access was unable to initialize the Windows
Registry.@Rerun Microsoft Office Access or Microsoft Office Setup to reinstall
Microsoft Office Access.@1@@185309@3' Access 2010 uses different
description: 'Microsoft Access can't be started.@Microsoft Access was unable
to initialize the Windows Registry.@Rerun Microsoft Access or Microsoft
Office Setup to reinstall Microsoft Access.@1@@185309@3' Access 2016
uses different description: 'Microsoft Access can't be started.@Microsoft
Access was unable to initialize the Windows Registry.@Rerun Microsoft
Access or Microsoft Office Setup to reinstall Microsoft
Access.@1@@185309@3'

Access 2016+

7900

Microsoft Office Access can't convert the database because it can't create an
error table.@@@1@@1 Access 2007+ uses different description: 'Microsoft
Office Access can't convert the database because it can't create an error
table.@@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access can't convert the database because it can't create an error
table.@@@1@@@1'

Access 2003+

7901

Microsoft Office Access can't convert the database because it can't write to the
error table.@@@1@@1 Access 2007+ uses different description: 'Microsoft
Office Access can't convert the database because it can't write to the error
table.@@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access can't convert the database because it can't write to the error
table.@@@1@@@1'

Access 2003+

7902

Errors occurred converting |1 validation rules and default values.@See error
table '|2' for a list of errors.@@1@@1 Access 2007+ uses different
description: 'Errors occurred converting |1 validation rules and default
values.@See error table '|2' for a list of errors.@@1@@@1'

Access 2003+

7903

Microsoft Office Access can't insert this field.@There are too many fields in the
table. The limit is 255.@@1@@1 Access 2007+ uses different description:
'Microsoft Office Access can't insert this field.@There are too many fields in
the table. The limit is 255.@@1@@@1' Access 2010+ uses different
description: 'Microsoft Access can't insert this field.@There are too many
fields in the table. The limit is 255.@@1@@@1'

Access 2003+

7904

An error occurred in the Field Builder.@You've replaced or modified the
default Field Builder, and Microsoft Office Access is unable to run the new
version. Reinstall Microsoft Office Access to correct the error.@@1@@1
Access 2007+ uses different description: 'An error occurred in the Field
Builder.@You've replaced or modified the default Field Builder, and Microsoft
Office Access is unable to run the new version. Reinstall Microsoft Office
Access to correct the error.@@1@@185309@1' Access 2010+ uses different
description: 'An error occurred in the Field Builder.@You've replaced or
modified the default Field Builder, and Microsoft Access is unable to run the
new version. Reinstall Microsoft Access to correct the
error.@@1@@185309@1'

Access 2003+



7905

Microsoft Office Access can't change these field data types.@Some data in this
table violates the record validation rule.@Before any data types can be
changed, remove the record validation rule or correct the data.@1@@1 Access
2007+ uses different description: 'Microsoft Office Access can't change these
field data types.@Some data in this table violates the record validation
rule.@Before any data types can be changed, remove the record validation rule
or correct the data.@1@@@1' Access 2010+ uses different description:
'Microsoft Access can't change these field data types.@Some data in this table
violates the record validation rule.@Before any data types can be changed,
remove the record validation rule or correct the data.@1@@@1'

Access 2003+

7906

Microsoft Office Access couldn't launch the Lookup Wizard, or this wizard has
been disabled.@Rerun the Microsoft Office Access or Microsoft Office Setup
program, click Add/Remove, and select the Wizards check box. To reenable this
wizard, click About Microsoft Office Access on the Help menu, and then click
the Disabled Items button to view a list of addins which you can
enable.@@1@@1 Access 2007+ uses different description: 'Microsoft Office
Access couldn't launch the Lookup Wizard, or this wizard has been
disabled.@Rerun the Microsoft Office Access or the Microsoft Office Setup
program, click Add/Remove, and select the Wizards check box. To reenable this
wizard, click the Microsoft Office Button, and then click Access Options. Click
Add-Ins, and then in the Manage list, click Disabled Items, and then click
Go.@@1@@@1' Access 2010+ uses different description: 'Microsoft Access
couldn't launch the Lookup Wizard, or this wizard has been disabled.@Rerun
the Microsoft Access or the Microsoft Office Setup program, click
Add/Remove, and select the Wizards check box. To reenable this wizard, click
the File tab, and then click Access Options. Click Add-Ins, and then in the
Manage list, click Disabled Items, and then click Go.@@1@@@1'

Access 2003+

7907

You don't have permission to modify the design of this table.@For more
information on permissions and who can set them, click
Help.@@2@410222@1 Access 2007+ uses different description: 'You don't
have permission to modify the design of this table.@For more information on
permissions and who can set them, click Help.@@2@1@10222@1'

Access 2003+

7908
You can't modify this table now because someone else is using it.@@@1@@1
Access 2007+ uses different description: 'You can't modify this table now
because someone else is using it.@@@1@@@1'

Access 2003+

7909

Microsoft Office Access can't add another column to this table.@You can have
up to 255 columns in your table.@@1@@1 Access 2007+ uses different
description: 'Microsoft Office Access can't add another column to this
table.@You can have up to 255 columns in your table.@@1@@@1' Access
2010+ uses different description: 'Microsoft Access can't add another column
to this table.@You can have up to 255 columns in your table.@@1@@@1'

Access 2003+

7910

Microsoft Office Access can't delete this column.@Tables must have at least
one column.@@1@@1 Access 2007+ uses different description: 'Microsoft
Office Access can't delete this column.@Tables must have at least one
column.@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access can't delete this column.@Tables must have at least one
column.@@1@@@1'

Access 2003+

7911

Microsoft Office Access can't delete this index.@This table participates in one
or more relationships.@Delete its relationships in the Relationships window
first.@1@@1 Access 2007+ uses different description: 'Microsoft Office
Access can't delete this index.@This table participates in one or more
relationships.@Delete its relationships in the Relationships window
first.@1@@@1' Access 2010+ uses different description: 'Microsoft Access
can't delete this index.@This table participates in one or more
relationships.@Delete its relationships in the Relationships window
first.@1@@@1'

Access 2003+



7912

Once you save the change to the data type of this column, you will not be able
to change back to the previous data type.@Are you sure you want change the
data type?@@20@@2 Access 2007+ uses different description: 'Once you
save the change to the data type of this column, you will not be able to change
back to the previous data type.@Are you sure you want change the data type?
@@20@@@2'

Access 2003+

Error Code Error Description Supported Versions

7913

You can't change a random-valued AutoNumber field to an incremental
AutoNumber field.@The values of random-valued AutoNumber fields aren't
continuous.@@1@@1 Access 2007+ uses different description: 'You can't
change a random-valued AutoNumber field to an incremental AutoNumber
field.@The values of random-valued AutoNumber fields aren't
continuous.@@1@@@1'

Access 2003+

7914
You can't convert ReplicationID values to other data types.@@@1@@1
Access 2007+ uses different description: 'You can't convert ReplicationID
values to other data types.@@@1@@@1'

Access 2003+

7915

You can't delete the field '|'; it is a replication system field.@Use a make-table
query to create a new table that contains all the fields in the table except system
fields. For information on make-table queries, click Help.@@2@209993@1
Access 2007+ uses different description: 'You can't delete the field '|'; it is a
replication system field.@Use a make-table query to create a new table that
contains all the fields in the table except system fields. For information on
make-table queries, click Help.@@2@1@9993@1'

Access 2003+

7916

Microsoft Office Access is unable to start the Lookup Wizard.@The Lookup
Wizard doesn't apply to fields of this data type.@@1@@1 Access 2007+ uses
different description: 'Microsoft Office Access is unable to start the Lookup
Wizard.@The Lookup Wizard doesn't apply to fields of this data
type.@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access is unable to start the Lookup Wizard.@The Lookup Wizard doesn't
apply to fields of this data type.@@1@@@1'

Access 2003+

7917

'|' cannot be created due to the project being disconnected.@Use the
Connection... command under the File menu to connect the project to a
database.@@1@@1 Access 2007+ uses different description: ''|' cannot be
created because the project is disconnected.@To connect the project to a
database, click Connection under Server Tasks on the File menu.@@1@@@1'

Access 2003+

7918

The Object Name argument for the 'Save' macro action is not supported within
an Access Project for Table or Query objects.@You cannot save these objects
with a new name in an Access Project.@@1@@1 Access 2007+ uses different
description: ''

Access 2003

7919

The default data type you selected is not supported in all versions of Microsoft
SQL Server.@If the server doesn't support the data type you have chosen, the
varchar data type will be used in its place.@@1@@1 Access 2007+ uses
different description: 'The default data type you selected is not supported in
all versions of Microsoft SQL Server.@If the server doesn't support the data
type you have chosen, the varchar data type will be used in its
place.@@1@@@1'

Access 2003+

7920 The '|' lookup column was changed to store multiple values. You cannot reverse
this setting.@@@1@@@1 Access 2007+

7921
You have changed the '|' lookup column to store multiple values. You will not
be able to undo this change once you save the table.@Do you want to change '|'
to store multiple values?@@19@@@2

Access 2007+

7922

You have changed the '|' lookup column to be displayed by a text box. After you
save the table, this change will make the column read-only and lose the lookup
properties.@Do you want to change '|' to be displayed by a text box?
@@19@@@2

Access 2007+



7923

The data type for field '|' is of type Attachment and cannot be
changed.@@@1@@@1 Access 2010+ uses different description: 'The data
type of field '|1' is |2. This data type cannot be changed once the field has been
saved.'

Access 2007+

7924

You cannot set '|' to the Attachment data type. You can only set a column to the
Attachment data type when that column is first created.@@@1@@@1 Access
2010+ uses different description: 'You cannot set '|1' to the |2 data type.@Use
Add Field in the Modify Fields ribbon to add a field with the |2 data
type.@@1@@@1' Access 2013+ uses different description: 'You cannot set
'|1' to the |2 data type.@You can add a new field instead.@@1@@@1'

Access 2007+

7925

The table or query you are exporting contains more than one attachment
column. Microsoft Windows SharePoint Services only supports one attachment
column. Remove all but one attachment column, and then retry exporting the
table or query. Access 2010+ uses different description: 'The table or query
you are exporting contains more than one attachment column. Microsoft
SharePoint Foundation only supports one attachment column. Remove all but
one attachment column, and then retry exporting the table or query.'

Access 2007+

7926
You can't change the column '|' to store multiple values; it is part of a multiple
column relationship.@If you want to change the column to store multiple
values, first delete the relationship in the Relationships window.@@1@@@1

Access 2007+

7927
You can't change the column '|' to store multiple values; it is part of an enforced
relationship.@If you want to change the column to store multiple values, first
delete the relationship in the Relationships window.@@1@@@1

Access 2007+

7928 The calculated field cannot be created.@Verify that expression '|1' includes
fields that exist in the current table.@@1@@@1 Access 2010+

7929
There are calculated columns in this table that depend on the column
'|1'.@Changing or deleting this column may cause errors in one or more of the
dependent calculated columns.@Do you want to continue?@19@@@2

Access 2010+

7930 '|' cannot be removed from the list definition. Access 2010+
7931 The data type of '|' cannot be changed. Access 2010+
7932 Microsoft SharePoint Foundation does not support this data type change. Access 2010+
Error Code Error Description Supported Versions
7933 An error prevents the data type change of field '|'. Access 2010+
7934 The Web does not support multiple attachment columns. Access 2010+

7935

An error has occurred trying to save the formula for the calculated
column.@There may be an error in the formula, or a disallowed field type
might have been used. Memo fields, hyperlink fields, and fields with a table or
query lookup cannot be used in a calculation.@@1@@@1

Access 2010+

7950
You can't refer to the RecordsetClone property of a form when the form is open
in Design view.@@@1@607393@1 Access 2007+ uses different
description: ''

Access 2003

7951

You entered an expression that has an invalid reference to the RecordsetClone
property.@For example, you may have used the RecordsetClone property with
a form or report that isn't based on a table or query.@@1@607393@1 Access
2007+ uses different description: 'You entered an expression that has an
invalid reference to the RecordsetClone property.@For example, you may have
used the RecordsetClone property with a form or report that isn't based on a
table or query.@@1@1@7393@1'

Access 2003+

7952

You made an illegal function call.@Check the syntax of the function you are
trying to use.@@1@@1 Access 2007+ uses different description: 'You made
an illegal function call.@Check the syntax of the function you are trying to
use.@@1@@@1'

Access 2003+

7953 The value you entered doesn't match the type required.@* The variable,
property, or object may not be of the correct type. * You may have used an If

Access 2003+



TypeOf construct with something other than a control.@@1@@1 Access
2007+ uses different description: 'The value you entered doesn't match the
type required.@* The variable, property, or object may not be of the correct
type. * You may have used an If TypeOf construct with something other than a
control.@@1@@@1'

7954

The expression you entered requires the control to be in the active
window.@Try one of the following: * Open or select a form or report
containing the control. * Create a new control in the active window, and try the
operation again.@@1@@1 Access 2007+ uses different description: 'The
expression you entered requires the control to be in the active window.@Try
one of the following: * Open or select a form or report containing the control. *
Create a new control in the active window, and try the operation
again.@@1@@@1'

Access 2003+

7955
There is no current code context object.@@@1@@1 Access 2007+ uses
different description: 'There is no current code context
object.@@@1@@@1'

Access 2003+

7956

The syntax of the subquery in this expression is incorrect.@Check the
subquery's syntax and enclose the subquery in parentheses.@@2@209989@1
Access 2007+ uses different description: 'The syntax of the subquery in this
expression is incorrect.@Check the subquery's syntax and enclose the subquery
in parentheses.@@2@1@9989@1'

Access 2003+

7957

You used a Like operator with an incorrect pattern.@Make sure the comparison
value is enclosed in quotation marks.@@1@1008961@1 Access 2007+ uses
different description: '' Access 2010+ uses different description: 'The LIKE
syntax in the expression is not valid.'

Access 2010+

7958

The Replication ID you entered is invalid.@Make sure the Replication ID you
enter contains only digits or letters for hexadecimal numbers, that the
Replication ID is the correct length, and that it is in a canonical SQL
form.@@1@@1 Access 2007+ uses different description: '' Access 2010+
uses different description: 'The expression contains a malformed GUID
constant.'

Access 2010+

7959

The expression contains an ambiguous name.@You may have two or more
functions with the same name in different modules.@Rename the functions so
that each one has a unique name.@1@@1 Access 2007+ uses different
description: '' Access 2010+ uses different description: 'The expression
contains an ambiguous name. Verify that each name in the expression refers to
a unique object.'

Access 2010+

7960

There was an error compiling this function.@The Visual Basic module contains
a syntax error.@Check the code, and then recompile it.@1@@1 Access 2007+
uses different description: 'There was an error compiling this function.@The
Visual Basic module contains a syntax error.@Check the code, and then
recompile it.@1@@@1'

Access 2003+

7961

Microsoft Office Access can't find the module '|' referred to in a macro
expression or Visual Basic code.@The module you referenced may be closed or
may not exist in this database, or the name may be misspelled.@@1@@1
Access 2007+ uses different description: 'Microsoft Office Access can't find
the module '|' referred to in a macro expression or Visual Basic code.@The
module you referenced may be closed or may not exist in this database, or the
name may be misspelled.@@1@@@1' Access 2010+ uses different
description: 'Microsoft Access can't find the module '|1' referred to in a macro
expression or Visual Basic code.@The module you referenced may be closed or
may not exist in this database, or the name may be misspelled.@@1@@@1'

Access 2003+

7962 The index number you used to refer to the module is invalid.@Use the Count
property to count the open modules and make sure that the module number is
not greater than the number of open modules minus 1.@@1@@1 Access
2007+ uses different description: 'The index number you used to refer to the

Access 2003+



module is invalid.@Use the Count property to count the open modules and
make sure that the module number is not greater than the number of open
modules minus 1.@@1@@@1'

7963

Microsoft Office Access can't run the macro or callback function '|'.@Make
sure the macro or function exists and takes the correct parameters.@@1@@1
Access 2007+ uses different description: 'Microsoft Office Access can't run
the macro or callback function '|'.@Make sure the macro or function exists and
takes the correct parameters.@@1@@@1' Access 2010+ uses different
description: 'Microsoft Access cannot run the macro or callback function
'|1'.@Make sure the macro or function exists and takes the correct
parameters.@@1@@@1'

Access 2003+

7964

You entered an expression that has an invalid reference to the Recordset
property.@You can only use a dynaset or snapshot recordset to set this
property.@@1@607393@1 Access 2007+ uses different description: 'You
entered an expression that has an invalid reference to the Recordset
property.@You can only use a dynaset or snapshot recordset to set this
property.@@1@1@7393@1'

Access 2003+

7965

The object you entered is not a valid Recordset property.@For example, you
may have used a forward-only recordset, or tried to set it to
null.@@1@607393@1 Access 2007+ uses different description: 'The object
you entered is not a valid Recordset property.@For example, you may have
used a forward-only recordset, or tried to set it to null.@@1@1@7393@1'

Access 2003+

7966

The format condition number you specified is greater than the number of
format conditions.@Use the Count property to count the format conditions for
the control and then check that the format condition number you cite is within
the range of existing format conditions.@@1@@1 Access 2007+ uses
different description: 'The format condition number you specified is greater
than the number of format conditions.@Use the Count property to count the
format conditions for the control and then check that the format condition
number you cite is within the range of existing format conditions.@@1@@@1'

Access 2003+

Error Code Error Description Supported Versions

7967
A required minimum or maximum value is missing.@@@1@@1 Access
2007+ uses different description: 'A required minimum or maximum value is
missing.@@@1@@@1'

Access 2003+

7968

The format condition Type you specified is invalid.@Valid values for the Type
property are 0 to 2 for the first condition, and 0 to 1 for all other format
conditions.@@1@@1 Access 2007+ uses different description: 'The format
condition Type you specified is invalid.@Valid values for the Type property are
0 to 2 for the first condition, and 0 to 1 for all other format
conditions.@@1@@@1'

Access 2003+

7969

The format condition Operator you specified is invalid.@Valid values for the
Operator property are 0 to 7.@@1@@1 Access 2007+ uses different
description: 'The format condition Operator you specified is invalid.@Valid
values for the Operator property are 0 to 7.@@1@@@1'

Access 2003+

7970
Microsoft Office Access can't open the file '|.'@It may not be a database, or it
may be a database you are unable to open.@@1@@1 Access 2007+ uses
different description: ''

Access 2003

7971

Microsoft Office Access can't follow the hyperlink to '|'.@Please verify the
destination.@@1@@1 Access 2007+ uses different description: 'Microsoft
Office Access can't follow the hyperlink to '|'.@Please verify the
destination.@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access cannot follow the hyperlink to '|1'.@Please verify the
destination.@@1@@@1'

Access 2003+

7972 Microsoft Office Access encountered an error while trying to show the
Hyperlink dialog.@@@1@@1 Access 2007+ uses different description:
'Microsoft Office Access encountered an error while trying to show the

Access 2003+



Hyperlink dialog.@@@1@@@1' Access 2010+ uses different description:
'Microsoft Access encountered an error while trying to show the Hyperlink
dialog.@@@1@@@1'

7973

The hyperlink address or subaddress text you entered was too long for
Microsoft Office Access to store.@The text was truncated to fit in the available
space, so the link may not work as expected.@@1@@1 Access 2007+ uses
different description: ''

Access 2003

7974

Microsoft Office Access failed to insert a hyperlink at the current
location.@@@1@@1 Access 2007+ uses different description: 'Microsoft
Office Access failed to insert a hyperlink at the current
location.@@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access failed to insert a hyperlink at the current location.@@@1@@@1'

Access 2003+

7975

You chose an invalid control type for use with hyperlinks.@You can only use
hyperlinks with labels, images, command buttons, or bound text
boxes.@@1@@1 Access 2007+ uses different description: 'You chose an
invalid control type for use with hyperlinks.@You can only use hyperlinks with
labels, images, command buttons, or bound text boxes.@@1@@@1'

Access 2003+

7976
There is no stored hyperlink in this control.@@@1@@1 Access 2007+ uses
different description: 'There is no stored hyperlink in this
control.@@@1@@@1'

Access 2003+

7977

Microsoft Office Access is unable to paste the data on the clipboard as a
hyperlink.@@@1@@1 Access 2007+ uses different description: 'Microsoft
Office Access is unable to paste the data on the clipboard as a
hyperlink.@@@1@@@1' Access 2010+ uses different description:
'Microsoft Access is unable to paste the data on the clipboard as a
hyperlink.@@@1@@@1'

Access 2003+

7978

Microsoft Office Access is unable to add the current hyperlink to the favorites
folder.@@@1@@1 Access 2007+ uses different description: 'Microsoft
Office Access is unable to add the current hyperlink to the favorites
folder.@@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access is unable to add the current hyperlink to the favorites
folder.@@@1@@@1'

Access 2003+

7979

You can't use the hyperlink property builder with more than one control
selected.@@@1@@1 Access 2007+ uses different description: 'You can't use
the hyperlink property builder with more than one control
selected.@@@1@@@1'

Access 2003+

7980

The HyperlinkAddress or HyperlinkSubAddress property is read-only for this
hyperlink.@@@1@@1 Access 2007+ uses different description: 'The
HyperlinkAddress or HyperlinkSubAddress property is read-only for this
hyperlink.@@@1@@@1'

Access 2003+

7981

The values for 'File or web page name' and/or 'Text to Display' are too
long.@The values will be truncated. To keep your original values, click Cancel
in the Edit Hyperlink dialog.@@1@@1 Access 2007+ uses different
description: 'The values for 'File or web page name' and/or 'Text to Display'
are too long.@The values will be truncated. To keep your original values, click
Cancel in the Edit Hyperlink dialog.@@1@@@1' Access 2010+ uses
different description: 'The values for 'File or Web page name' and/or 'Text to
Display' are too long.@The values will be truncated. To keep your original
values, click Cancel in the Edit Hyperlink dialog.@@1@@@1'

Access 2003+

7983

Microsoft Office Access can't follow the hyperlink because it couldn't create the
hyperlink object.@@@1@@1 Access 2007+ uses different description:
'Microsoft Office Access can't follow the hyperlink.@@@1@@@1' Access
2010+ uses different description: 'Microsoft Access can't follow the
hyperlink.@@@1@@@1'

Access 2003+

7990 You entered an invalid project name.@You may have deleted the default project
name and forgotten to specify a new one.@@1@@3 Access 2007+ uses

Access 2003+



different description: 'You entered an invalid project name.@You may have
deleted the default project name and forgotten to specify a new
one.@@1@@@3'

7991

The Microsoft Office Access Source Code Control Add-in is not available; this
object will be opened read-only.@@@1@@3 Access 2007+ uses different
description: 'The Microsoft Office Access Source Code Control Add-in is not
available; this object will be opened read-only.@@@1@@@3' Access 2010+
uses different description: 'The Microsoft Access Source Code Control Add-in
is not available; this object will be opened read-only.@@@1@@@3'

Access 2003+

7992

The Microsoft Office Access Source Code Control Add-in could not be
started.@@@1@@3 Access 2007+ uses different description: 'The Microsoft
Office Access Source Code Control Add-in could not be
started.@@@1@@@3' Access 2010+ uses different description: 'The
Microsoft Access Source Code Control Add-in could not be
started.@@@1@@@3'

Access 2003+

7993

The object | is currently checked in and is therefore read-only.@To modify the
object, close it first, then check it out and reopen it.@@1@@1 Access 2007+
uses different description: 'The object | is currently checked in and is therefore
read-only.@To modify the object, close it first, then check it out and reopen
it.@@1@@@1'

Access 2003+

Error Code Error Description Supported Versions

7994
There was a problem communicating with the Source Code Control Add-
in.@@@1@@3 Access 2007+ uses different description: 'There was a
problem communicating with the Source Code Control Add-in.@@@1@@@3'

Access 2003+

7995

The menus on your form or report that are based on Microsoft Office Access
macros will not be visible while the Customize dialog box is open.@To have
the full power of menu or toolbar customization, convert your macro-based
menus to menus or toolbars. With the macro selected in the Database window,
point to Macro on the Tools menu, and create a menu, a toolbar, or a shortcut
menu from that macro.@@1@@1 Access 2007+ uses different description:
'The menus on your form or report that are based on Microsoft Office Access
macros will not be visible while the Customize dialog box is open.@To have
the full power of menu or toolbar customization, convert your macro-based
menus to menus or toolbars. With the macro selected in the Navigation Pane,
point to Macro on the Tools menu, and create a menu, a toolbar, or a shortcut
menu from that macro.@@1@@@1' Access 2010+ uses different
description: 'The menus on your form or report that are based on Microsoft
Access macros will not be visible while the Customize dialog box is open.@To
have the full power of menu or toolbar customization, convert your macro-
based menus to menus or toolbars. With the macro selected in the Navigation
Pane, point to Macro on the Tools menu, and create a menu, a toolbar, or a
shortcut menu from that macro.@@1@@@1'

Access 2003+



7996

Microsoft Office Access couldn't create the Data and Misc. Objects because the
linked table '|' could not be found.@To create the Data and Misc. Objects, use
the Linked Table Manager (Tools menu, Add-ins submenu) to update the link to
the source table or file, or delete the link from your current
database.@@1@@1 Access 2007+ uses different description: 'Microsoft
Office Access could not create the Data and Misc. objects because the linked
table '|' could not be found.@To create the data and miscellaneous objects, use
the Linked Table Manager (on the Database Tools tab, in the Database Tools
group) to update the link to the source table or file, or delete the link from your
current database.@@1@@@1' Access 2010+ uses different description:
'Microsoft Access could not create the Data and Misc. objects because the
linked table '|1' could not be found.@To create the data and miscellaneous
objects, use the Linked Table Manager (on the Database Tools tab, in the
Database Tools group) to update the link to the source table or file, or delete the
link from your current database.@@1@@@1'

Access 2003+

7997

You can't save the standard module '|' over a class module with the same
name.@Save the standard module to a different name, or delete the class
module first.@@1@@1 Access 2007+ uses different description: 'You can't
save the standard module '|' over a class module with the same name.@Save the
standard module to a different name, or delete the class module
first.@@1@@@1'

Access 2003+

7998

You can't save the class module '|' over a standard module with the same
name.@Save the class module to a different name, or delete the standard
module first.@@1@@1 Access 2007+ uses different description: 'You can't
save the class module '|' over a standard module with the same name.@Save the
class module to a different name, or delete the standard module
first.@@1@@@1'

Access 2003+

7999

Microsoft Office Access can't delete this relationship because you don't have
the Data and Misc. Objects checked out.@Check out the Data and Misc.
Objects and then delete the relationship.@@1@@1 Access 2007+ uses
different description: 'Microsoft Office Access can't delete this relationship
because you don't have the Data and Misc. Objects checked out.@Check out
the Data and Misc. Objects and then delete the relationship.@@1@@@1'
Access 2010+ uses different description: 'Microsoft Access can't delete this
relationship because you don't have the Data and Misc. Objects checked
out.@Check out the Data and Misc. Objects and then delete the
relationship.@@1@@@1'

Access 2003+

8000

The name you entered already exists for another object of the same type in this
database.@Do you want to replace the existing |?@@20@@2 Access 2007+
uses different description: 'The name you entered already exists for another
object of the same type in this database.@Do you want to replace the existing |?
@@20@@@2'

Access 2003+

8001

'|' has been changed since the last time you opened it, either by another user or
because another instance of it was opened on your own machine.@Do you want
to replace the changes that you or another user made?@* To save your most
recent changes and discard the other user's changes or your previous changes,
click Yes. * To save this version of the object with another name, click
No.@19@@2 Access 2007+ uses different description: ''|' has been changed
since the last time you opened it, either by another user or because another
instance of it was opened on your own machine.@Do you want to replace the
changes that you or another user made?@* To save your most recent changes
and discard the other user's changes or your previous changes, click Yes. * To
save this version of the object with another name, click No.@19@@@2'

Access 2003+

8002 '|' has been changed since the last time you opened it, either by another user or
because another instance of it was opened on your own machine.@Do you want
to replace the changes that you or another user made?@* To save your most
recent changes and discard the other user's changes or your previous changes,

Access 2003



click Yes. * To cancel saving this version of the object, click No.@19@@2
Access 2007+ uses different description: ''

8003

You must save a table or query before you can create a new object based on
it.@Do you want to save and use the table or query to create a new object?
@@13@@2 Access 2007+ uses different description: 'You must save the |
before you can create a new object based on it.@Do you want to save the | and
create a new object?@@13@@@2'

Access 2003+

8004

The layout of '|' has been changed since the last time you opened it, either by
another user or because another instance of it was opened on your own
machine.@Do you want to replace the changes that you or another user made?
@* To save your most recent changes and discard the other user's changes or
your previous changes, click Yes. * To cancel saving this version of the object,
click No.@19@@2 Access 2007+ uses different description: 'The layout of '|'
has been changed since the last time you opened it, either by another user or
because another instance of it was opened on your own machine.@Do you want
to replace the changes that you or another user made?@* To save your most
recent changes and discard the other user's changes or your previous changes,
click Yes. * To cancel saving this version of the object, click No.@19@@@2'

Access 2003+

8005
You can't save this object.@You must have Administer permission for the
Database object in order to save modules, forms, or reports in a Design
Master.@@1@@1 Access 2007+ uses different description: ''

Access 2003

8006

The name you entered already exists for another object of the same type in this
database.@Do you want to replace the existing |?You will not be able to undo
this operation.@@20@@2 Access 2007+ uses different description: 'The
name you entered already exists for another object of the same type in this
database.@Do you want to replace the existing |?You will not be able to undo
this operation.@@20@@@2'

Access 2003+

8007

You cannot get into Exclusive Mode right now because this database is opened
by other users or because you do not have permissions to open
exclusively.@@@1@@1 Access 2007+ uses different description: 'You
cannot get into Exclusive Mode right now because this database is opened by
other users or because you do not have permissions to open
exclusively.@@@1@@@1'

Access 2003+

8008 The stored procedure executed successfully but did not return records. Access 2003+

8050
Do you want to save changes to the design of |?@@@13@@2 Access 2007+
uses different description: 'Do you want to save changes to the design of |?
@@@13@@@2'

Access 2003+

8051 Do you want to save changes to |?@@@19@@2 Access 2007+ uses different
description: '' Access 2003

8052

Do you want to delete the | and empty the Clipboard?@You tried to delete a
database object that is currently on the Microsoft Office Access Clipboard. If
you delete it from your database, you won't be able to paste it later.@@20@@2
Access 2007+ uses different description: 'Do you want to delete the | and
empty the Clipboard?@You tried to delete a database object that is currently on
the Microsoft Office Access Clipboard. If you delete it from your database, you
won't be able to paste it later.@@20@@@2' Access 2010+ uses different
description: 'Do you want to delete the |1 and empty the Clipboard?@You tried
to delete a database object that is currently on the Microsoft Access Clipboard.
If you delete it from your database, you won't be able to paste it
later.@@20@@@2'

Access 2003+

8053

Do you want to delete the |?@For more information on how to prevent this
message from displaying every time you delete an object, click
Help.@@21@209058@2 Access 2007+ uses different description: 'Do you
want to delete the |? Deleting this object will remove it from all groups.@For
more information on how to prevent this message from displaying every time
you delete an object, click Help.@@21@1@9058@2'

Access 2003+



8054

Do you want to exit Microsoft Office Access and empty the Clipboard?
@@@19@@2 Access 2007+ uses different description: 'Do you want to exit
Microsoft Office Access and empty the Clipboard?@@@19@@@2' Access
2010+ uses different description: 'This action will cause Microsoft Access to
empty the Clipboard. Do you want to continue?@@@19@@@2'

Access 2003+

Error Code Error Description Supported Versions

8055

Microsoft Office Access can't change the working directory to '|.'@Verify that
the drive is valid and the path is 260 characters or less in length.@@1@@1
Access 2007+ uses different description: 'Microsoft Office Access can't
change the working directory to '|.'@Verify that the drive is valid and the path is
260 characters or less in length.@@1@@@1' Access 2010+ uses different
description: 'Microsoft Access can't change the working directory to
'|1.'@Verify that the drive is valid and the path is 260 characters or less in
length.@@1@@@1'

Access 2003+

8057 | Access 2003+

8058
Do you want to save changes to the layout of |?@@@13@@2 Access 2007+
uses different description: 'Do you want to save changes to the layout of |?
@@@13@@@2'

Access 2003+

8059

Do you want to remove the link to the |?@If you delete the link, you delete only
the information Microsoft Office Access uses to open the table, not the table
itself.@@19@@2 Access 2007+ uses different description: 'Do you want to
remove the link to the |?@If you delete the link, you delete only the information
Microsoft Office Access uses to open the table, not the table
itself.@@19@@@2' Access 2010+ uses different description: 'Do you want
to remove the link to the |1?@If you delete the link, you delete only the
information Microsoft Access uses to open the table, not the table
itself.@@19@@@2'

Access 2003+

8060

The toolbar '|' is partly unreadable.@ Microsoft Office Access can't display all
the toolbar buttons. The specified toolbar may be in a different format than the
toolbars in the current version of Microsoft Office Access.@Click OK to close
the dialog box, and then add the buttons missing from the toolbar. Microsoft
Office Access will then update the toolbar to the latest format.@1@210064@1
Access 2007+ uses different description: 'The toolbar '|' is partly
unreadable.@ Microsoft Office Access can't display all the toolbar buttons. The
specified toolbar may be in a different format than the toolbars in the current
version of Microsoft Office Access.@Click OK to close the dialog box, and
then add the buttons missing from the toolbar. Microsoft Office Access will
then update the toolbar to the latest format.@1@1@10064@1' Access 2010+
uses different description: 'The toolbar '|1' is partly unreadable.@ Microsoft
Access can't display all the toolbar buttons. The specified toolbar may be in a
different format than the toolbars in the current version of Microsoft
Access.@Click OK to close the dialog box, and then add the buttons missing
from the toolbar. Microsoft Access will then update the toolbar to the latest
format.@1@1@10064@1'

Access 2003+

8061 Are you sure you want to restore the default settings to the built-in toolbar or
menu bar |?@If you previously customized, moved, changed the visibility, or
otherwise altered the toolbar or menu bar, or any of the menus that cascade
from it, Microsoft Office Access removes your changes, returns the original
buttons to their original order, and shows or hides the toolbar based on the
original setting. To return the built-in toolbar or menu bar to its original state,
click Yes.@@19@@2 Access 2007+ uses different description: 'Are you sure
you want to restore the default settings to the built-in toolbar or menu bar |?@If
you previously customized, moved, changed the visibility, or otherwise altered
the toolbar or menu bar, or any of the menus that cascade from it, Microsoft
Office Access removes your changes, returns the original buttons to their
original order, and shows or hides the toolbar based on the original setting. To

Access 2003+



return the built-in toolbar or menu bar to its original state, click
Yes.@@19@@@2' Access 2010+ uses different description: 'Are you sure
that you want to restore the default settings to the built-in toolbar or menu bar
|1?@If you previously customized, moved, changed the visibility, or otherwise
changed the toolbar or menu bar, or any of the menus that cascade from it,
Microsoft Access removes your changes, returns the original buttons to their
original order, and shows or hides the toolbar based on the original setting. To
return the built-in toolbar or menu bar to its original state, click
Yes.@@19@@@2'

8063

The source application isn't responding. Do you want to continue waiting?
@The DDE channel is established, but the data exchange wasn't completed in
the amount of time specified in the OLE/DDE Timeout setting in the Options
dialog box (Tools menu).@* To continue waiting for the data exchange to be
completed, click Yes. *To cancel the data exchange and try again later, click No
.@20@@2 Access 2007+ uses different description: 'The source application
is not responding. Do you want to continue waiting?@The DDE channel has
been established, but the data exchange was not completed in the amount of
time specified in the OLE/DDE Timeout setting in the Access Options dialog
box (click the Microsoft Office Button and then click Access Options).@* To
continue waiting for the data exchange to be completed, click Yes. *To cancel
the data exchange and try again later, click No .@20@@@2' Access 2010+
uses different description: 'The source application is not responding. Do you
want to continue waiting?@The DDE channel has been established, but the
data exchange was not completed in the amount of time specified in the
OLE/DDE Timeout setting in the Access Options dialog box (click the File tab
and then click Access Options).@* To continue waiting for the data exchange
to be completed, click Yes. * ?To cancel the data exchange and try again later,
click No .@20@@@1'

Access 2003+

8064

This linked table has indexes that use an unsupported sort order.@If you
modify this table, the Microsoft Jet database engine can't correctly maintain the
table's indexes. As a result, your data may appear in the wrong order, and
functions that use the table's indexes may have unexpected results.@Try one of
the following: * Cancel this operation. Use the application in which the table
was created to re-create the indexes, making sure to specify an ASCII or
International sort order. Then try again to link the tables. * Use this table on a
read-only basis.@1@209057@1 Access 2007+ uses different description:
'This linked table has indexes that use an unsupported sort order.@If you
modify this table, the Microsoft Office Access database engine can't correctly
maintain the table's indexes. As a result, your data may appear in the wrong
order, and functions that use the table's indexes may have unexpected
results.@Try one of the following: * Cancel this operation. Use the application
in which the table was created to re-create the indexes, making sure to specify
an ASCII or International sort order. Then try again to link the tables. * Use this
table on a read-only basis.@1@1@9057@1' Access 2010+ uses different
description: 'This linked table has indexes that use an unsupported sort
order.@If you modify this table, the Microsoft Access database engine can't
correctly maintain the table's indexes. As a result, your data may appear in the
wrong order, and functions that use the table's indexes may have unexpected
results.@Try one of the following: * Cancel this operation. Use the application
in which the table was created to re-create the indexes, making sure to specify
an ASCII or International sort order. Then try again to link the tables. * Use this
table on a read-only basis.@1@1@9057@1'

Access 2003+

8065 You can't delete the table '|' until its relationships to other tables have been
deleted.@Do you want Microsoft Office Access to delete the relationships
now?@@19@@2 Access 2007+ uses different description: 'You can't delete
the table '|' until its relationships to other tables have been deleted.@Do you
want Microsoft Office Access to delete the relationships now?@@19@@@2'
Access 2010+ uses different description: 'You can't delete the table '|1' until its

Access 2003+



relationships to other tables have been deleted.@Do you want Microsoft Access
to delete the relationships now?@@19@@@2'

8067

Do you want to permanently delete the |?@If you click Yes, you won't be able
to undo the deletion.@@19@@2 Access 2007+ uses different description:
'Do you want to permanently delete the |?@If you click Yes, you won't be able
to undo the deletion.@@19@@@2'

Access 2003+

8069

Microsoft Office Access couldn't create the custom toolbar '|.'@@@1@@3
Access 2007+ uses different description: 'Microsoft Office Access couldn't
create the custom toolbar '|.'@@@1@@@3' Access 2010+ uses different
description: 'Microsoft Access couldn't create the custom toolbar
'|1.'@@@1@@@3'

Access 2003+

8071
Would you like to remove the compacted database from Source Code Control?
@@@19@@2 Access 2007+ uses different description: 'Would you like to
remove the compacted database from Source Code Control?@@@19@@@2'

Access 2003+

8072

Microsoft Office Access must close the | in order to complete this
operation.@Would you like Microsoft Office Access to close it now?
@@19@@1 Access 2007+ uses different description: 'Microsoft Office
Access must close the | in order to complete this operation.@Would you like
Microsoft Office Access to close it now?@@19@@@1' Access 2010+ uses
different description: 'Microsoft Access must close the |1 in order to complete
this operation.@Would you like Microsoft Access to close it now?
@@19@@@1'

Access 2003+

8073

You do not have the | checked out.@Microsoft Office Access can't check out an
object while it is open, and you can't make design changes until you check it
out.@If you want to make design changes to this object, first close it, check it
out, and then reopen it.@1@@1 Access 2007+ uses different description:
'You do not have the | checked out.@Microsoft Office Access can't check out an
object while it is open, and you can't make design changes until you check it
out.@If you want to make design changes to this object, first close it, check it
out, and then reopen it.@1@@@1' Access 2010+ uses different description:
'You do not have the |1 checked out.@Microsoft Access can't check out an
object while it is open, and you can't make design changes until you check it
out.@If you want to make design changes to this object, first close it, check it
out, and then reopen it.@1@@@1'

Access 2003+

8074

Microsoft Office Access must save the | in order to complete this
operation.@Would you like Microsoft Office Access to save it now?
@@19@@1 Access 2007+ uses different description: 'Microsoft Office
Access must save the | in order to complete this operation.@Would you like
Microsoft Office Access to save it now?@@19@@@1' Access 2010+ uses
different description: 'Microsoft Access must save the |1 in order to complete
this operation.@Would you like Microsoft Access to save it now?
@@19@@@1'

Access 2003+

8075

You do not have the Data and Misc. Objects checked out.You can't create a new
table or save changes to a data access page.@@@1@@1 Access 2007+ uses
different description: 'You do not have the Data and Misc. Objects checked
out.You can't create a new table or save changes to a data access
page.@@@1@@@1' Access 2010+ uses different description: 'You do not
have the Data and Misc. Objects checked out. You can't create a new table or
save changes to a data access page.@@@1@@@1'

Access 2003+

8076

To import tables, relationships, menus, toolbars, import/export specs or data
access pages you must have the Data and Misc. Objects checked
out.@@@1@@2 Access 2007+ uses different description: 'To import tables,
relationships, menus, toolbars, import/export specs or data access pages you
must have the Data and Misc. Objects checked out.@@@1@@@2'

Access 2003+

8077 Are you sure you want to cut the |?@@@19@@2 Access 2007+ uses different
description: 'Are you sure you want to cut the |?@@@19@@@2' Access 2003+



8078

This object will be removed from your local database, but not from source code
control.@The next time you get this database from source code control, the
object will reappear.Are you sure that you want to delete the local object?
@@20@@2 Access 2007+ uses different description: 'This object will be
removed from your local database, but not from source code control.@The next
time you get this database from source code control, the object will
reappear.Are you sure that you want to delete the local object?@@20@@@2'
Access 2010+ uses different description: 'This object will be removed from
your local database, but not from source code control.@The next time you get
this database from source code control, the object will reappear. Are you sure
that you want to delete the local object?@@20@@@2'

Access 2003+

8079

Microsoft Office Access was not able to add a reference to the type library for
this control because Data and Misc. Objects is not checked out.@Check out the
Data and Misc. Objects and add a reference to the library '|'.@@1@@1 Access
2007+ uses different description: 'Microsoft Office Access was not able to
add a reference to the type library for this control because Data and Misc.
Objects is not checked out.@Check out the Data and Misc. Objects and add a
reference to the library '|'.@@1@@@1' Access 2010+ uses different
description: 'Microsoft Access was not able to add a reference to the type
library for this control because Data and Misc. Objects is not checked
out.@Check out the Data and Misc. Objects and add a reference to the library
'|1'.@@1@@@1'

Access 2003+

Error Code Error Description Supported Versions

8080

An error occurred while trying to create the linked table '|'.@Check to make
sure that the source table or file is available, and then retry the operation on the
Data and Misc. Objects.@@1@@1 Access 2007+ uses different description:
'An error occurred while trying to create the linked table '|'.@Check to make
sure that the source table or file is available, and then retry the operation on the
Data and Misc. Objects.@@1@@@1'

Access 2003+

8081

You have set |1's Type property to Popup, which changes the toolbar to a
shortcut menu.@The shortcut menu disappears because Microsoft Office
Access adds |2 to the Shortcut Menus toolbar. To complete the shortcut menu,
close the Toolbar Properties sheet, display the Shortcut Menus toolbar, click the
Custom category, and then add the commands you want.@@1@@1 Access
2007+ uses different description: 'You have set |1's Type property to Popup,
which changes the toolbar to a shortcut menu.@The shortcut menu disappears
because Microsoft Office Access adds |2 to the Shortcut Menus toolbar. To
complete the shortcut menu, close the Toolbar Properties sheet, display the
Shortcut Menus toolbar, click the Custom category, and then add the commands
you want.@@1@@@1' Access 2010+ uses different description: 'You have
set |1's Type property to Popup, which changes the toolbar to a shortcut
menu.@The shortcut menu disappears because Microsoft Access adds |2 to the
Shortcut Menus toolbar. To complete the shortcut menu, close the Toolbar
Properties sheet, display the Shortcut Menus toolbar, click the Custom category,
and then add the commands you want.@@1@@@1'

Access 2003+

8082

Microsoft Office Access must save the | to the current database in order to
complete this operation.@Would you like Microsoft Office Access to save it
now?@@19@@2 Access 2007+ uses different description: 'Microsoft Office
Access must save the | to the current database in order to complete this
operation.@Would you like Microsoft Office Access to save it now?
@@19@@@2' Access 2010+ uses different description: 'Microsoft Access
must save the |1 to the current database in order to complete this
operation.@Would you like Microsoft Access to save it now?@@19@@@2'

Access 2003+

8086 An error occured trying to add one or more references from the source code
control project.@The library may not be registered on your computer.Check
your project references and add any missing references after registering the
missing components that this database requires.@@1@@1 Access 2007+ uses
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different description: 'An error occured trying to add one or more references
from the source code control project.@The library may not be registered on
your computer.Check your project references and add any missing references
after registering the missing components that this database
requires.@@1@@@1' Access 2010+ uses different description: 'An error
occurred trying to add one or more references from the source code control
project.@The library may not be registered on your computer. Check your
project references and add any missing references after registering the missing
components that this database requires.@@1@@@1'

8087

Restoring a database requires that no one is currently using the database.@Do
you want to close all objects, select a backup file, and restore the database from
backup?@@19@@2 Access 2007+ uses different description: 'Restoring a
database requires that no one is currently using the database.@Do you want to
close all objects, select a backup file, and restore the database from backup?
@@19@@@2'

Access 2003+

8088

Dropping a database requires that no one is currently using the database.@Do
you want to close all open objects, and drop the database?@@19@@2 Access
2007+ uses different description: 'Dropping a database requires that no one is
currently using the database.@Do you want to close all open objects, and drop
the database?@@19@@@2'

Access 2003+

8090

Are you sure you want to delete the conflict table |?@You will not be able to
undo this operation.@@19@@2 Access 2007+ uses different description:
'Are you sure you want to delete the conflict table |?@You will not be able to
undo this operation.@@19@@@2'

Access 2003+

8091

This database is enabled for publication.@Do you want to delete existing
publications and drop the database?@@19@@2 Access 2007+ uses different
description: 'This database is enabled for publication.@Do you want to delete
existing publications and drop the database?@@19@@@2'

Access 2003+

8092

Access could not save your project.@Do you want to cancel the close
operation? *To cancel the close operation, click Yes. *To close without saving,
click No. @@19@@2 Access 2007+ uses different description: 'Access
could not save your project.@Do you want to cancel the close operation? *To
cancel the close operation, click Yes. *To close without saving, click No.
@@19@@@2'

Access 2003+

8093

Send a pointer to the data access page?@To send an e-mail message that
contains a pointer to your data access page, click Send Pointer.This is the
recommended method. The e-mail recipient must have access to the server or
public share to view the page. To send a copy of the page, click Send Copy. To
cancel sending the page, click Cancel.For more information, click Help.�Send
Pointer�Send Copy�Cancel@@28@613792@4 Access 2007+ uses different
description: ''

Access 2003

8094

Send a copy of the data access page?@The contents of the page will be copied
into the body of the email message, however the page will connect to the data
source when the recipient views the message.If this is correct, click OK.
Otherwise, click Cancel, save the page to a server or public share, and resend a
pointer to the page.It is generally more secure to send a pointer to the page than
to send a copy of the page. For more information, click
Help.@@6@613791@4 Access 2007+ uses different description: ''

Access 2003

8095 You tried to create a group filter based on a column type which cannot be used
in a filter. Access 2007+ uses different description: '' Access 2003

8096

Microsoft Office Access can't change the working directory to '|.'@Please enter
a non-Internet location.@@1@@1 Access 2007+ uses different description:
'Microsoft Office Access can't change the working directory to '|.'@Please enter
a non-Internet location.@@1@@@1' Access 2010+ uses different
description: 'Microsoft Access can't change the working directory to
'|1.'@Please enter a non-Internet location.@@1@@@1'

Access 2003+



8097

The connection string of this page specifies an absolute path.The page might
not be able to connect to data through the network.To connect through a
network, edit the connection string to specify a network (UNC) path.@&Don't
show this warning again@553714119@@@1 Access 2007+ uses different
description: 'The connection string of this page specifies an absolute path.The
page might not be able to connect to data through the network.To connect
through a network, edit the connection string to specify a network (UNC)
path.@&Don't show this warning again@553714119@@@@1' Access 2010+
uses different description: 'The connection string of this page specifies an
absolute path. The page might not be able to connect to data through the
network. To connect through a network, edit the connection string to specify a
network (UNC) path.@&Don't show this warning
again@553714119@@@@1'

Access 2003+

8098

Your computer has resumed operation after Critical Suspend mode.Any
unsaved changes might have been lost. To ensure proper operation, close and
reopen any files.Restarting Microsoft Office Access is
recommended.@@@1@@1 Access 2007+ uses different description: 'Your
computer has resumed operation after Critical Suspend mode.Any unsaved
changes might have been lost. To ensure proper operation, close and reopen any
files.Restarting Microsoft Office Access is recommended.@@@1@@@1'
Access 2010+ uses different description: 'Your computer has resumed
operation after Critical Suspend mode. Any unsaved changes might have been
lost. To ensure proper operation, close and reopen any files. Restarting
Microsoft Access is recommended.@@@1@@@1'

Access 2003+

8100

The report is still more than one page wide.@To fit the report on one page
decrease the report width or increase the page width.@You can decrease the
report width by selecting each control that is farthest to the right, moving it to
the left, and removing the extra report space. You may need to repeat this
multiple times. You can increase the page width by adjusting the page setup
options.@1@@1 Access 2007+ uses different description: 'The report is still
more than one page wide.@To fit the report on one page decrease the report
width or increase the page width.@You can decrease the report width by
selecting each control that is farthest to the right, moving it to the left, and
removing the extra report space. You may need to repeat this multiple times.
You can increase the page width by adjusting the page setup
options.@1@@@1'

Access 2003+

8101

The report is still more than one page wide.@To fit the report on one page
decrease the report width or increase the page width.@You can decrease the
report width by selecting each control that is farthest to the left, moving it to the
right, and removing the extra report space. You may need to repeat this multiple
times. You can increase the page width by adjusting the page setup
options.@1@@1 Access 2007+ uses different description: 'The report is still
more than one page wide.@To fit the report on one page decrease the report
width or increase the page width.@You can decrease the report width by
selecting each control that is farthest to the left, moving it to the right, and
removing the extra report space. You may need to repeat this multiple times.
You can increase the page width by adjusting the page setup
options.@1@@@1'

Access 2003+

8103

Do you want to discard the pending changes and delete the link to the list |?
@The linked list you are attempting to delete has changes that have not been
saved to the server. Do you still want to delete the linked list and lose these
pending changes?@@19@@@2

Access 2007+

8104 The name you supplied is a reserved word. Reserved words have a specific
meaning to Microsoft Office Access or to the Microsoft Office Access database
engine. @If you use a reserved word, you may receive an error when referring
to this field.@@5@1@141675@1 Access 2010+ uses different description:
'The name you supplied is a reserved word. Reserved words have a specific
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meaning to Microsoft Access or to the Microsoft Access database engine. @If
you use a reserved word, you may receive an error when referring to this
field.@@5@1@141675@1'

8105 You must close and reopen the current database for the specified option to take
effect. Access 2007+

Error Code Error Description Supported Versions

8106 Encrypting with a block cipher is incompatible with row level locking. Row
level locking will be ignored. Access 2010+

8107
Microsoft Access cannot save the database to the |1 file format.@The specified
database sort order, |2, is not supported for the target database
format.@@1@@@1

Access 2010+

8108 You must save changes to the table before opening an Event Data Macro.@Do
you want to save changes to the table?@@19@@@2 Access 2013+

8109 If you delete |, you will also delete all data and views that use it.@You can't
undo this action.@Are you sure you want to delete |?@19@@@2 Access 2013+

8110
If you delete |, you will also delete all data and views that use it.@You can't
undo this action.@Are you sure you want to delete
|?�&Delete�&Cancel@36@@@2

Access 2013+

8111
Disabling all connectivity will prevent external programs or reports from
accessing the app and may cause other applications to break. @Are you sure
you want to disable all connectivity?@@19@@@2

Access 2013+

8112

Microsoft Access can't connect you to the database right now. This might be a
result of missing drivers or a more general problem contacting the server. We
recommend that you install the SQL Server 2012 Native Client drivers if they
are not already installed.@Would you like to us to open a page where you can
download these drivers now?@@19@@@2

Access 2013+

8400

The database '|' is read-only.@You won't be able to save changes made to data
or object definitions in this database.@@1@209033@1 Access 2007+ uses
different description: 'The database '|' is read-only.@You won't be able to save
changes made to data or object definitions in this database.@@3@1@9033@1'

Access 2003+

8401

You can't make changes to the database objects in the database '|.'@This
database was created in an earlier version of Microsoft Office Access.@To
convert this database to the current version of Microsoft Office Access, close
the database, point to Database Utilities on the Tools menu, and then click
Convert Database.@1@209029@1 Access 2007+ uses different description:
'You cannot make changes to the database objects in the database '|.'@This
database was created in an earlier version of Microsoft Office Access.@To
convert this database to the current version of Microsoft Office Access, click
the Microsoft Office Button, and then click Convert.@3@1@9029@1' Access
2010+ uses different description: 'You cannot make changes to the database
objects in the database '|1.'@This database was created in an earlier version of
Microsoft Access.@To convert this database to the current version of Microsoft
Access, click the File tab, and then click Convert.@3@1@9029@0'

Access 2003+

8402

The file '|' already exists.@Do you want to replace the existing file? If you want
to compact or convert to a different file name, click No. Enter the new file
name after the /compact or /convert option in the command line, and run the
command again.@@20@@2 Access 2007+ uses different description: 'The
file '|' already exists.@Do you want to replace the existing file? If you want to
compact or convert to a different file name, click No. Enter the new file name
after the /compact or /convert option in the command line, and run the
command again.@@20@@@2'

Access 2003+

8403 The setting you entered is invalid.@The database's sort order can't be updated.
The setting you entered in the New Database Sort Order option of the Options
dialog box (Tools menu) isn't a valid sort order for the version of the database
you are compacting.@@1@@1 Access 2007+ uses different description: 'The
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setting you entered is invalid.@The database's sort order cannot be updated.
The setting you entered for the New database sort order option (Personalize
category) of the Access Options dialog box (click the Microsoft Office Button
and then click Access Options) is not a valid sort order for the version of the
database you are compacting.@@1@@@1' Access 2010+ uses different
description: 'The setting you entered is invalid.@The database's sort order
cannot be updated. The setting you entered for the New database sort order
option (Personalize category) of the Access Options dialog box (click the File
tab and then click Access Options) is not a valid sort order for the version of the
database you are compacting.@@1@@@1'

8404

You can't open '|' for exclusive use because another user has the database open
or because you do not have permissions to open exclusively.@Microsoft Office
Access will open the database for shared access.@@1@@1 Access 2007+ uses
different description: 'You can't open '|' for exclusive use because another user
has the database open or because you do not have permissions to open
exclusively.@Microsoft Office Access will open the database for shared
access.@@3@@@1' Access 2010+ uses different description: 'You can't
open '|1' for exclusive use because another user has the database open or
because you do not have permissions to open exclusively.@Microsoft Access
will open the database for shared access.@@3@@@1'

Access 2003+

8405

You can't make changes to the database objects in the database '|.'@This
database was created in an earlier version of Microsoft Office Access.@To
convert this database to the current version of Microsoft Office Access, close
the database, point to Database Utilities on the Tools menu, and then click
Convert Database.@1@@1 Access 2007+ uses different description: 'This
database was created using a previous version of Microsoft Office Access.@-
You can share the database with users of previous versions of Microsoft Office
Access, however some enhancements will be unavailable. - You can open the
database, view objects and modify records using this release of Microsoft
Office Access, but design changes will be disabled. - To make design changes
you must use an earlier version of Microsoft Office Access that supports the old
database format, or upgrade the database.@@1@@@1' Access 2010+ uses
different description: 'This database was created using a previous version of
Microsoft Access.@- You can share the database with users of previous
versions of Microsoft Access, however some enhancements will be unavailable.
- You can open the database, view objects and modify records using this release
of Microsoft Access, but design changes will be disabled. - To make design
changes you must use an earlier version of Microsoft Access that supports the
old database format, or upgrade the database.@@1@@@1'

Access 2003+

8406
Does the first row of your data contain column headings?@@@20@@1
Access 2007+ uses different description: 'Does the first row of your data
contain column headings?@@@20@@@1'

Access 2003+

8407

This database is a replica created in a previous version of Microsoft Office
Access.@You can view objects in this database, but you can't modify their
design. If you want to modify objects in this database, convert the Design
Master for this replica set to the current version of Microsoft Office Access and
synchronize this replica.@Do you want to open the database anyway?
@19@@1 Access 2007+ uses different description: ''

Access 2003

8408

The name you entered already exists for another custom group in this
database.@Do you want to replace the existing custom group |?You will not be
able to undo this operation.@@20@@2 Access 2007+ uses different
description: ''

Access 2003

8409 Microsoft Office Access has made a backup of database |1 at |2. Note: Only
server-related objects have been backed up. To back up your project, click Back
Up Project on the File menu Access 2010+ uses different description:
'Microsoft Access has made a backup of database |1 at |2. Note: Only server-
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related objects have been backed up. To back up your project, click Back Up
Project on the File menu'

8410
Microsoft Office Access successfully restored database |1 from its backup at |2
Access 2010+ uses different description: 'Microsoft Access successfully
restored database |1 from its backup at |2'

Access 2003+

8411
Do you want to permanently delete the custom group '|'?@If you click Yes, all
shortcuts in the custom group will be deleted as well, and you won't be able to
undo the deletion.@@20@@2 Access 2007+ uses different description: ''

Access 2003

8412

The name you entered already exists for another shortcut in this group.@Do
you want to replace the existing shortcut '|?'@@20@@2 Access 2007+ uses
different description: 'The name you entered already exists for another
shortcut in this group.@Do you want to replace the existing shortcut
'|?'@@20@@@2'

Access 2003+

Error Code Error Description Supported Versions

8413
The project '|' is read-only.@You won't be able to save changes made to object
definitions in this project.@@1@209033@1 Access 2007+ uses different
description: ''

Access 2003

8414

Microsoft Office Access encountered one or more errors during conversion. To
view a summary of these errors, open the '|' table.@@@2@553714191@1
Access 2007+ uses different description: 'Microsoft Office Access
encountered one or more errors during conversion. To view a summary of these
errors, open the '|' table.@@@2@1@553714191@1' Access 2010+ uses
different description: 'Microsoft Access encountered one or more errors
during conversion. To view a summary of these errors, open the '|1'
table.@@@2@1@553714191@1'

Access 2003+

8415

The HTML file associated with this link has been moved, renamed, or
deleted.@File: '|'�&Update Link...�Cancel@@35@@2 Access 2007+ uses
different description: 'The HTML file associated with this link has been
moved, renamed, or deleted.@File: '|'�&Update Link...�Cancel@@35@@@2'

Access 2003+

8416

Renaming this user-defined function removes any existing permissions and
extended properties.@Do you want to complete the rename action?
@@20@@2 Access 2007+ uses different description: 'Renaming this user-
defined function removes any existing permissions and extended
properties.@Do you want to complete the rename action?@@20@@@2'

Access 2003+

8417 The file '|' cannot be opened because it has been locked by another user.@Try
again when the file is available.@@3@@@1 Access 2007+

8500

A form with a subform object can't have its DefaultView property set to
Continuous Forms.@You tried to add a subform to a form in Design view.
Microsoft Office Access will reset the property to Single Form.@@1@@1
Access 2007+ uses different description: 'A form with a subform object can't
have its DefaultView property set to Continuous Forms.@You tried to add a
subform to a form in Design view. Microsoft Office Access will reset the
property to Single Form.@@1@@@1' Access 2010+ uses different
description: 'A form with a subform object can't have its DefaultView property
set to Continuous Forms.@You tried to add a subform to a form in Design
view. Microsoft Access will reset the property to Single Form.@@1@@@1'

Access 2003+

8501

You can't modify this field because it is read-only.@Some fields, such as a
calculated field, are read-only by design. However, any field can be read-only if
its Locked property is set to Yes.@@1@600865@1 Access 2007+ uses
different description: 'You can't modify this field because it is read-
only.@Some fields, such as a calculated field, are read-only by design.
However, any field can be read-only if its Locked property is set to
Yes.@@1@1@865@1'

Access 2003+

8502 Microsoft Office Access has reached the end of the records.@Do you want to
continue searching from the beginning?@@19@@2 Access 2007+ uses
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different description: 'Microsoft Office Access has reached the end of the
records.@Do you want to continue searching from the beginning?
@@19@@@2' Access 2010+ uses different description: 'Microsoft Access
has reached the end of the records.@Do you want to continue searching from
the beginning?@@19@@@2'

8503

Microsoft Office Access has reached the beginning of the records.@Do you
want to continue searching from the end?@@19@@2 Access 2007+ uses
different description: 'Microsoft Office Access has reached the beginning of
the records.@Do you want to continue searching from the end?@@19@@@2'
Access 2010+ uses different description: 'Microsoft Access has reached the
beginning of the records.@Do you want to continue searching from the end?
@@19@@@2'

Access 2003+

8504

Microsoft Office Access finished searching the records. The search item was
not found.@@@1@@1 Access 2007+ uses different description: 'Microsoft
Office Access finished searching the records. The search item was not
found.@@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access finished searching the records. The search item was not
found.@@@1@@@1'

Access 2003+

8505
Do you want to continue to search or replace?@@@19@@2 Access 2007+
uses different description: 'Do you want to continue to search or replace?
@@@19@@@2'

Access 2003+

8506

There isn't enough memory to save the current filter.@Close unneeded
programs. Return to the form or datasheet, and then redefine and reapply the
filter. For more information on freeing memory, search the Microsoft Windows
Help index for 'memory, troubleshooting'.@@1@@3 Access 2007+ uses
different description: ''

Access 2003

8507

There isn't enough memory to execute the macro that updates the active
filter.@Microsoft Office Access is closing the Filter window. Close unneeded
programs. Then try again to open the Filter window. For more information on
freeing memory, search the Microsoft Windows Help index for 'memory,
troubleshooting'.@@1@@3 Access 2007+ uses different description: 'There
isn't enough memory to execute the macro that updates the active
filter.@Microsoft Office Access is closing the Filter window. Close unneeded
programs. Then try again to open the Filter window. For more information on
freeing memory, search the Microsoft Windows Help index for 'memory,
troubleshooting'.@@1@@@3' Access 2010+ uses different description:
'There isn't enough memory to execute the macro that updates the active
filter.@Microsoft Access is closing the Filter window. Close unneeded
programs. Then try again to open the Filter window. For more information on
freeing memory, search the Microsoft Windows Help index for 'memory,
troubleshooting'.@@1@@@3'

Access 2003+

8508

Microsoft Office Access can't find '|.'@The text string you entered in the Find
What box can't be evaluated against the current field.@Reenter the text string
so that it conforms to the data type of the field.@1@@1 Access 2007+ uses
different description: 'Microsoft Office Access can't find '|.'@The text string
you entered in the Find What box can't be evaluated against the current
field.@Reenter the text string so that it conforms to the data type of the
field.@1@@@1' Access 2010+ uses different description: 'Microsoft Access
can't find '|1.'@The text string you entered in the Find What box can't be
evaluated against the current field.@Reenter the text string so that it conforms
to the data type of the field.@1@@@1'

Access 2003+

8509

You won't be able to undo this Replace operation.@There isn't enough free
memory to use the Undo command. Do you want to continue?@@19@@2
Access 2007+ uses different description: 'You won't be able to undo this
Replace operation.@There isn't enough free memory to use the Undo
command. Do you want to continue?@@19@@@2'

Access 2003+



8510

Microsoft Office Access can't save the current record.@Do you want to undo
the changes to the record and continue the Paste operation?@@19@@2 Access
2007+ uses different description: 'Microsoft Office Access can't save the
current record.@Do you want to undo the changes to the record and continue
the Paste operation?@@19@@@2' Access 2010+ uses different description:
'Microsoft Access can't save the current record.@Do you want to undo the
changes to the record and continue the Paste operation?@@19@@@2'

Access 2003+

8511

Records that Microsoft Office Access was unable to paste have been inserted
into a new table called '|.'@In the Database window, open the new table to see
the unpasted records. After you fix the problems that resulted in the paste
errors, copy and paste the records from the new table.@@1@@1 Access 2007+
uses different description: 'Records that Microsoft Office Access was unable
to paste have been inserted into a new table called '|.'@In the Navigation Pane,
open the new table to see the unpasted records. After you fix the problems that
resulted in the paste errors, copy and paste the records from the new
table.@@1@@@1' Access 2010+ uses different description: 'Records that
Microsoft Access was unable to paste have been inserted into a new table called
'|1.'@In the Navigation Pane, open the new table to see the unpasted records.
After you fix the problems that resulted in the paste errors, copy and paste the
records from the new table.@@1@@@1'

Access 2003+

8512

None of the field names you pasted onto the Clipboard match the field names
on the form.@Microsoft Office Access treats the data in the first row on the
Clipboard as field names. If you copied the data from another application, the
first row of data may have taken the place of the field names. Do you want to
paste the field names in the order you defined with the Tab Order command?
@@21@311022@2 Access 2007+ uses different description: 'None of the
field names you pasted onto the Clipboard match the field names on the
form.@Microsoft Office Access treats the data in the first row on the Clipboard
as field names. If you copied the data from another application, the first row of
data may have taken the place of the field names. Do you want to paste the field
names in the order you defined with the Tab Order command?
@@21@1@11022@2' Access 2010+ uses different description: 'None of the
field names you pasted onto the Clipboard match the field names on the
form.@Microsoft Access treats the data in the first row on the Clipboard as
field names. If you copied the data from another application, the first row of
data may have taken the place of the field names. Do you want to paste the field
names in the order you defined with the Tab Order command?
@@21@1@11022@2'

Access 2003+

8513

Some of the field names for the data you tried to paste don't match field names
on the form.@Microsoft Office Access treats data in the first row on the
Clipboard as field names. In this case, some of those field names don't match
the field names on the form. Do you want to paste only that data whose names
match the field names on the Clipboard?@@19@311022@2 Access 2007+
uses different description: 'Some of the field names for the data you tried to
paste don't match field names on the form.@Microsoft Office Access treats data
in the first row on the Clipboard as field names. In this case, some of those field
names don't match the field names on the form. Do you want to paste only that
data whose names match the field names on the Clipboard?
@@19@1@11022@2' Access 2010+ uses different description: 'Some of the
field names for the data you tried to paste don't match field names on the
form.@Microsoft Access treats data in the first row on the Clipboard as field
names. In this case, some of those field names don't match the field names on
the form. Do you want to paste only that data whose names match the field
names on the Clipboard?@@19@1@11022@2'

Access 2003+

8514 Do you want to suppress further error messages telling you why records can't
be pasted?@If you click No, a message will appear for every record that can't
be pasted.@@13@@2 Access 2007+ uses different description: 'Do you want

Access 2003+



to suppress further error messages telling you why records can't be pasted?@If
you click No, a message will appear for every record that can't be
pasted.@@13@@@2'

Error Code Error Description Supported Versions

8515

You copied a large amount of data onto the Clipboard.@When you copy data
onto the Clipboard, only the reference to the object is copied. If you close the
source document, however, Microsoft Office Access must paste all the data
from its source. Depending on the amount of data, this can take some time. Do
you want to save this data on the Clipboard?@@19@@2 Access 2007+ uses
different description: 'You copied a large amount of data onto the
Clipboard.@When you copy data onto the Clipboard, only the reference to the
object is copied. If you close the source document, however, Microsoft Office
Access must paste all the data from its source. Depending on the amount of
data, this can take some time. Do you want to save this data on the Clipboard?
@@19@@@2' Access 2010+ uses different description: 'You copied a large
amount of data onto the Clipboard.@When you copy data onto the Clipboard,
only the reference to the object is copied. If you close the source document,
however, Microsoft Access must paste all the data from its source. Depending
on the amount of data, this can take some time. Do you want to save this data
on the Clipboard?@@19@@@2'

Access 2003+

8516

You selected more records than can be copied onto the Clipboard at one
time.@Divide the records into two or more groups, and then copy and paste
one group at a time. The maximum number of records you can paste at one time
is approximately 65,000.@@1@@1 Access 2007+ uses different description:
'You selected more records than can be copied onto the Clipboard at one
time.@Divide the records into two or more groups, and then copy and paste
one group at a time. The maximum number of records you can paste at one time
is approximately 65,000.@@1@@@1'

Access 2003+

8517

Do you want to suppress further error messages telling you why records can't
be deleted?@If you click No, a message will appear for every record that can't
be deleted.@@13@@2 Access 2007+ uses different description: 'Do you
want to suppress further error messages telling you why records can't be
deleted?@If you click No, a message will appear for every record that can't be
deleted.@@13@@@2'

Access 2003+

8518
You won't be able to undo this Replace operation.@Do you want to continue?
@@19@@2 Access 2007+ uses different description: 'You won't be able to
undo this Replace operation.@Do you want to continue?@@19@@@2'

Access 2003+

8519

You are about to delete | record(s).@If you click Yes, you won't be able to undo
this Delete operation. Are you sure you want to delete these records?
@@19@@2 Access 2007+ uses different description: 'You are about to
delete | record(s).@If you click Yes, you won't be able to undo this Delete
operation. Are you sure you want to delete these records?@@19@@@2'

Access 2003+

8520

You are about to paste | record(s).@Are you sure you want to paste these
records?@@19@@2 Access 2007+ uses different description: 'You are about
to paste | record(s).@Are you sure you want to paste these records?
@@19@@@2'

Access 2003+

8521

You won't be able to undo this Delete operation.@The Undo command won't be
available because this operation is too large, or there isn't enough free memory.
Do you want to delete these items?@@19@@2 Access 2007+ uses different
description: 'You won't be able to undo this Delete operation.@The Undo
command won't be available because this operation is too large, or there isn't
enough free memory. Do you want to delete these items?@@19@@@2'

Access 2003+

8522

All timers are in use.@Set the TimerInterval property back to zero so that you
can start another timer.@@2@606342@1 Access 2007+ uses different
description: 'All timers are in use.@Set the TimerInterval property back to
zero so that you can start another timer.@@2@1@6342@1'

Access 2003+



8523

Do you want to delete the custom palette information from this form or report
and revert to the default palette?@@@20@@2 Access 2007+ uses different
description: 'Do you want to delete the custom palette information from this
form or report and revert to the default palette?@@@20@@@2'

Access 2003+

8524
Do you want to delete the graphic from this button?@@@20@@2 Access
2007+ uses different description: 'Do you want to remove this picture from
this control?@@@20@@@2'

Access 2003+

8525

The remote data isn't accessible.@You tried to open a form or report that
includes a DDE or DDESend function in a calculated control that specifies an
OLE server application. Do you want to start the application |?@@19@@2
Access 2007+ uses different description: 'The remote data isn't
accessible.@You tried to open a form or report that includes a DDE or
DDESend function in a calculated control that specifies an OLE server
application. Do you want to start the application |?@@19@@@2'

Access 2003+

8526

Microsoft Office Access encountered a problem while trying to switch views
and must close this window.@@@1@@1 Access 2007+ uses different
description: 'Microsoft Office Access encountered a problem while trying to
switch views and must close this window.@@@1@@@1' Access 2010+ uses
different description: 'Microsoft Access encountered a problem while trying to
switch views and must close this window.@@@1@@@1'

Access 2003+

8527

Do you want to delete the group section for the database object '|' and its
contents? You will not be able to undo this action.@The group header or footer
you want to delete contains controls and will be deleted along with the
section.@@20@@2 Access 2007+ uses different description: 'Do you want
to delete the group section for the database object '|' and its contents?@The
group header or footer you want to delete contains controls which will be
deleted along with the section.@@20@@@2'

Access 2003+

8528

Deleting these sections will also delete all controls in them. You will not be able
to undo this action.@Do you want to delete these sections anyway?
@@20@@2 Access 2007+ uses different description: 'Deleting these
sections will also delete all controls in them. You will not be able to undo this
action.@Do you want to delete these sections anyway?@@20@@@2'

Access 2003+

8529

Do you want to delete the selected group level(s) and all associated sections
and their controls?@The field or expression you're deleting from the Sorting
and Grouping box has an associated section (a header or footer) containing
controls that will be deleted along with the section.@@20@@2 Access 2007+
uses different description: 'The grouping level that you are trying to delete has
a group header or group footer section. The section contains controls that will
also be deleted.@Do you want to continue?@@20@@@2'

Access 2003+

8530

Relationships that specify cascading deletes are about to cause | record(s) in this
table and in related tables to be deleted.@Are you sure you want to delete these
records?@@21@409096@2 Access 2007+ uses different description:
'Relationships that specify cascading deletes are about to cause | record(s) in
this table and in related tables to be deleted.@Are you sure you want to delete
these records?@@21@1@9096@2' Access 2010+ uses different description:
'Relationships that specify cascading deletes are about to cause | record(s) in
this table, along with related records in related tables, to be deleted.@Are you
sure you want to delete these records?@@21@1@9096@2'

Access 2003+

8531

The section width is greater than the page width, and there are no items in the
additional space, so some pages may be blank.@For example, the report width
may be wider than the page width.@@3@@1 Access 2007+ uses different
description: 'The section width is greater than the page width, and there are no
items in the additional space, so some pages may be blank.@For example, the
report width may be wider than the page width.@@3@@@1'

Access 2003+

8532 Do you want to remove this picture from the form?@@@20@@2 Access
2007+ uses different description: 'Do you want to remove this picture from

Access 2003+



the form?@@@20@@@2'

8533

Some data may not be displayed.@There is not enough horizontal space on the
page for the number of columns and column spacing you specified.@Click
Page Setup on the File menu, click the Columns tab, and then reduce the
number of columns or the size of the columns.@3@@1 Access 2007+ uses
different description: 'Some data may not be displayed.@There is not enough
horizontal space on the page for the number of columns and column spacing
you specified.@Click Page Setup on the File menu, click the Columns tab, and
then reduce the number of columns or the size of the columns.@3@@@1'

Access 2003+

8534

When you save this form or report, any code behind it will be deleted.@You
have set the HasModule property to No, creating a form or report that opens
more quickly. Any macros associated with this form or report will not be
affected, nor will code in separate modules that is called from this property
sheet.@Are you sure you want to do this?@20@@2 Access 2007+ uses
different description: 'When you save this form or report, any code behind it
will be deleted.@You have set the HasModule property to No, creating a form
or report that opens more quickly. Any macros associated with this form or
report will not be affected, nor will code in separate modules that is called from
this property sheet.@Are you sure you want to do this?@20@@@2'

Access 2003+

Error Code Error Description Supported Versions

8538
You are about to delete this section. @If you click Yes, the controls you placed
in this section will be deleted. Are you sure you want to delete these controls?
@@20@@2 Access 2007+ uses different description: ''

Access 2003

8539

Relationships that specify cascading deletes are about to cause record(s) in this
table and in related tables to be deleted.@Are you sure you want to delete these
records?@@21@409096@2 Access 2007+ uses different description:
'Relationships that specify cascading deletes are about to cause record(s) in this
table and in related tables to be deleted.@Are you sure you want to delete these
records?@@21@1@9096@2'

Access 2003+

8540

You are about to delete one or more records.@If you click Yes, you won't be
able to undo this Delete operation. Are you sure you want to delete these
records?@@19@@2 Access 2007+ uses different description: 'You are about
to delete one or more records.@If you click Yes, you won't be able to undo this
Delete operation. Are you sure you want to delete these records?
@@19@@@2'

Access 2003+

8541

Microsoft Office Access could not perform the delete operation. An error
occurred during the delete operation, no records were deleted. Access 2010+
uses different description: 'Microsoft Access could not perform the delete
operation. An error occurred during the delete operation, no records were
deleted.'

Access 2003+

8542

Microsoft Office Access did not detect a relationship between the fields you
have chosen.@Do you want a relationship to be created for you now?
@@19@@3 Access 2007+ uses different description: 'Microsoft Office
Access did not detect a relationship between the fields you have chosen.@Do
you want a relationship to be created for you now?@@19@@@3' Access
2010+ uses different description: 'Microsoft Access did not detect a
relationship between the fields you have chosen.@Do you want a relationship
to be created for you now?@@19@@@3'

Access 2003+

8543

You are about to delete this section and all related sections. @If you click Yes,
the controls you placed in these sections will be deleted. Are you sure you want
to delete these controls?@@20@@2 Access 2007+ uses different
description: ''

Access 2003

8544
You won't be able to undo this paste operation.@Do you want to continue?
@@19@@2 Access 2007+ uses different description: 'You won't be able to
undo this paste operation.@Do you want to continue?@@19@@@2'

Access 2003+



8545

Microsoft Office Access can't save the filter criteria you entered in the Insert
Hyperlink dialog box. Make sure that the data access page is bound to a record
source before you set the filter criteria. Also make sure that the criteria is in the
form of a WHERE clause; for example, EmployeeID=[EmployeeID]. Access
2007+ uses different description: ''

Access 2003

8546

Current object must first be saved before exporting data to XML. @Would you
like to save '|' and then continue?@@19@@2 Access 2007+ uses different
description: 'Current object must first be saved before exporting data to XML.
@Would you like to save '|' and then continue?@@19@@@2'

Access 2003+

8547 Do you want to save the changes made to the macro and update the property?
@@@13@1@4309@2 Access 2007+

8548

To complete this operation, Access must modify the RecordSource property of
the current form or report.@Access will create a new query and embed it
directly into the form's or report's RecordSource property. The form or report
will no longer be based on the '|' query.@Do you want to accept this change?
@19@@@2

Access 2007+

8549 This table contains one or more Lookup fields. Display values for Lookup
fields cannot be changed by using the Replace operation.@@@1@1@865@1 Access 2007+

8550
A table or query needed in order to create the new form, report, or query is
currently open in Design view.@Save or discard the changes to this table or
query and open it in Datasheet view, then try again.@@1@@@1

Access 2007+

8551 Do you want to remove this picture from the report?@@@20@@@2 Access 2007+

8552 Do you want to save the changes made to the macro by saving the table?
@@@13@1@4309@2 Access 2013+

9502

Microsoft Office Access won't be able to undo this action or subsequent
actions. To make more resources available so that Access can record further
design actions, close and reopen this window. @Do you want to continue
anyway?@@19@@2 Access 2007+ uses different description: 'Microsoft
Office Access won't be able to undo this action or subsequent actions. To make
more resources available so that Access can record further design actions, close
and reopen this window. @Do you want to continue anyway?@@19@@@2'
Access 2010+ uses different description: 'Microsoft Access won't be able to
undo this action or subsequent actions. To make more resources available so
that Access can record further design actions, close and reopen this window.
@Do you want to continue anyway?@@19@@@2'

Access 2003+

9504

The file '|' is not readable by JET. @If you think you have a valid JET file then
this is most likely due to the recent file format change. Do you want to attempt
to upgrade the database format?@@19@@2 Access 2007+ uses different
description: 'The file '|' is not readable by the Access database engine. @If you
think you have a valid Access database, this is most likely because of the recent
file format change. Do you want to attempt to upgrade the database format?
@@19@@@2'

Access 2003+

9505 The database '|' needs to be repaired or isn't a database file.@You or another
user may have unexpectedly quit Microsoft Office Access while a Microsoft
Office Access database was open. Do you want Microsoft Office Access to
attempt to repair the database?@@19@209010@2 Access 2007+ uses
different description: 'Microsoft Office Access has detected that this database
is in an inconsistent state, and will attempt to recover the database.During this
process, a backup copy of the database will be made and all recovered objects
will be placed in a new database. Access will then open the new database. The
names of objects that were not successfully recovered will be logged in the
""Recovery Errors"" table.@@@1@@@2' Access 2010+ uses different
description: 'Microsoft Access has detected that this database is in an
inconsistent state, and will attempt to recover the database. During this process,
a backup copy of the database will be made and all recovered objects will be
placed in a new database. Access will then open the new database. The names

Access 2003+



of objects that were not successfully recovered will be logged in the
""Recovery Errors"" table.@@@1@@@2'

9507

Microsoft Office Access was unable to load all the library
modules.@@@1@@1 Access 2007+ uses different description: 'Microsoft
Office Access was unable to load all the library modules.@@@1@@@1'
Access 2010+ uses different description: 'Microsoft Access was unable to
load all the library modules.@@@1@@@1'

Access 2003+

9508

Microsoft Office Access couldn't close database '|.'@Your last change may not
have been saved because an internal buffer was locked by another user (whose
name was given in the previous message). To avoid losing data, wait for the
other user to finish using the record, and then click OK again. If you click
Cancel, you may lose changes that haven't been saved.@@3@@2 Access
2007+ uses different description: 'Microsoft Office Access couldn't close
database '|.'@Your last change may not have been saved because an internal
buffer was locked by another user (whose name was given in the previous
message). To avoid losing data, wait for the other user to finish using the
record, and then click OK again. If you click Cancel, you may lose changes that
haven't been saved.@@3@@@2' Access 2010+ uses different description:
'Microsoft Access couldn't close database '|1.'@Your last change may not have
been saved because a record was locked by another user. To avoid losing data,
wait for the other user to finish editing the record, then click OK again. If you
click Cancel, you will lose unsaved changes.@@3@@@2'

Access 2003+

Error Code Error Description Supported Versions

9509

You can't undo this command and, once it's completed, you won't be able to edit
this object.@Do you want to continue anyway?@@19@@2 Access 2007+
uses different description: 'You can't undo this command and, once it's
completed, you won't be able to edit this object.@Do you want to continue
anyway?@@19@@@2'

Access 2003+

9510 Microsoft Office Access can't open the file '|'.@@@1@@1 Access 2007+ uses
different description: '' Access 2003

9511 |@@@1@@1 Access 2007+ uses different description: '|@@@1@@@1' Access 2003+

9512 Successfully repaired the '|' database.@@@1@@1 Access 2007+ uses
different description: '' Access 2003

9513

Microsoft Office Access was unable to completely repair the '|' table and
deleted some Memo, OLE Object, or Hyperlink field values.@To recover the
data, restore from your backup copy of the database. Note that the data in the
deleted field may have been damaged by a bad sector on your hard disk. For
more information on checking your disk's surface, files, and folders for errors,
search the Windows Help index for 'checking for disk errors'.@@1@@1
Access 2007+ uses different description: 'Microsoft Office Access was unable
to completely repair the '|' table and deleted some Memo, OLE Object, or
Hyperlink field values.@To recover the data, restore from your backup copy of
the database. Note that the data in the deleted field may have been damaged by
a bad sector on your hard disk. For more information on checking your disk's
surface, files, and folders for errors, search the Windows Help index for
'checking for disk errors'.@@1@@@1' Access 2010+ uses different
description: 'Microsoft Access was unable to completely repair the '|1' table
and deleted some Memo, OLE Object, or Hyperlink field values.@To recover
the data, restore from your backup copy of the database. Note that the data in
the deleted field may have been damaged by a bad sector on your hard disk. For
more information on checking your disk's surface, files, and folders for errors,
search the Windows Help index for 'checking for disk errors'.@@1@@@1'

Access 2003+

9514
One or more records were unrecoverable and were deleted from the '|'
table.@@@1@@1 Access 2007+ uses different description: 'One or more
records were unrecoverable and were deleted from the '|' table.@@@1@@@1'

Access 2003+



9515
The '|' table was truncated; data was lost.@@@1@@1 Access 2007+ uses
different description: 'The '|' table was truncated; data was
lost.@@@1@@@1'

Access 2003+

9516
One or more indexes from the '|' table couldn't be repaired and were
deleted.@@@1@@1 Access 2007+ uses different description: 'One or more
indexes from the '|' table couldn't be repaired and were deleted.@@@1@@@1'

Access 2003+

9517

The Save As command can't process any subforms contained in your
report.@Do you want to proceed anyway?@@19@@2 Access 2007+ uses
different description: 'The Save As command can't process any subforms
contained in your report.@Do you want to proceed anyway?@@19@@@2'

Access 2003+

9518

An error occurred while adding this word to the custom dictionary.@* The
dictionary file may be read-only. * There may be a disk error.@@1@@1
Access 2007+ uses different description: 'An error occurred while adding this
word to the custom dictionary.@* The dictionary file may be read-only. * There
may be a disk error.@@1@@@1'

Access 2003+

9519

An error occurred while adding this word to the Change All list.@The
dictionary may be full.@@1@@1 Access 2007+ uses different description:
'An error occurred while adding this word to the Change All list.@The
dictionary may be full.@@1@@@1'

Access 2003+

9520

An error occurred while adding the word to the Ignore All list.@The dictionary
may be full.@@1@@1 Access 2007+ uses different description: 'An error
occurred while adding the word to the Ignore All list.@The dictionary may be
full.@@1@@@1'

Access 2003+

9521
The specified word is too large.@Words can't exceed 64 characters.@@1@@1
Access 2007+ uses different description: 'The specified word is too
large.@Words can't exceed 64 characters.@@1@@@1'

Access 2003+

9523

Microsoft Office Access can't open the '|' custom dictionary.@@@1@@1
Access 2007+ uses different description: 'Microsoft Office Access can't open
the '|' custom dictionary.@@@1@@@1' Access 2010+ uses different
description: 'Microsoft Access can't open the '|1' custom
dictionary.@@@1@@@1'

Access 2003+

9524

Microsoft Office Access can't start the spelling checker because it isn't
installed.@@@1@@1 Access 2007+ uses different description: 'Microsoft
Office Access can't start the spelling checker because it isn't
installed.@@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access can't start the spelling checker because it isn't installed.@@@1@@@1'

Access 2003+

9525

Microsoft Office Access can't open the main dictionary file.@Verify that this
file has been correctly installed.@@1@@1 Access 2007+ uses different
description: 'Microsoft Office Access can't open the main dictionary
file.@Verify that this file has been correctly installed.@@1@@@1' Access
2010+ uses different description: 'Microsoft Access can't open the main
dictionary file.@Verify that this file has been correctly installed.@@1@@@1'

Access 2003+

9526

The spelling checker only works on text fields that contain text data.@You're
trying to check a field with a data type other than Text or Memo.@@1@@1
Access 2007+ uses different description: 'The spelling checker only works on
text fields that contain text data.@You're trying to check a field with a data type
other than Text or Memo.@@1@@@1'

Access 2003+

9527

The spelling checker can't proceed; you must first select data from a table,
query, view, stored procedure, or form.@@@1@@1 Access 2007+ uses
different description: 'The spelling checker can't proceed; you must first select
data from a table, query, view, stored procedure, or form.@@@1@@@1'

Access 2003+

9529 The spelling checker can't proceed; form data is not updatable.@The form may
be based on a query that isn't updatable or is only partly updatable. For
information on when a query is updatable, click Help.@@2@409932@1
Access 2007+ uses different description: 'Microsoft Office Access cannot run

Access 2003+



the spell checker because the data in this form or query is not
updatable.@@@2@1@9932@1' Access 2010+ uses different description:
'Microsoft Access cannot run the spell checker because the data in this form or
query is not updatable.@@@2@1@9932@1'

9530

An error occurred while trying to modify the contents of field '|.'@The field
may be locked or read-only, or you may not have permissions to change it. For
information on security permissions and who can change them, click
Help.@@2@410222@1 Access 2007+ uses different description: 'An error
occurred while trying to modify the contents of field '|.'@The field may be
locked or read-only, or you may not have permissions to change it. For
information on security permissions and who can change them, click
Help.@@2@1@10222@1'

Access 2003+

Error Code Error Description Supported Versions

9531 An error occurred while trying to save spelling preferences.@@@1@@1
Access 2007+ uses different description: '' Access 2003

9532
The '|' field can't be modified because it's a read-only field.@@@1@@1
Access 2007+ uses different description: 'The '|' field can't be modified
because it's a read-only field.@@@1@@@1'

Access 2003+

9533
An error occurred while trying to add the word pair to the AutoCorrect
list.@@@1@@1 Access 2007+ uses different description: 'An error occurred
while trying to add the word pair to the AutoCorrect list.@@@1@@@1'

Access 2003+

9534

The current selection does not contain any fields that can be checked for
spelling errors.@You can check the spelling of text box controls with Text or
Memo data types.@@1@@1 Access 2007+ uses different description: 'The
current selection does not contain any fields that can be checked for spelling
errors.@You can check the spelling of text box controls with Text or Memo
data types.@@1@@@1'

Access 2003+

9535
You entered an invalid main dictionary.@Please select a valid entry.@@1@@1
Access 2007+ uses different description: 'You entered an invalid main
dictionary.@Please select a valid entry.@@1@@@1'

Access 2003+

9536 The spelling check is complete.@@@1@@1 Access 2007+ uses different
description: 'The spelling check is complete.@@@1@@@1' Access 2003+

9537

You must restart the spelling checker for the dictionary change to take
effect.@@@1@@1 Access 2007+ uses different description: 'You must
restart the spelling checker for the dictionary change to take
effect.@@@1@@@1'

Access 2003+

9538 The '|' custom dictionary doesn't exist.@Do you want to create it?@@20@@1
Access 2007+ uses different description: '' Access 2003

9539

You have specified a word that isn't found in the main or custom
dictionary.@Do you want to use this word and continue checking?@@20@@1
Access 2007+ uses different description: 'You have specified a word that isn't
found in the main or custom dictionary.@Do you want to use this word and
continue checking?@@20@@@1'

Access 2003+

9540 The main dictionary you selected can't be used.@It has not been correctly
installed.@@1@@1 Access 2007+ uses different description: '' Access 2003

9541

The spelling checker can't undo your last change.@The data in field '|' has been
modified by another user. To resume the spelling check, click OK.@@1@@1
Access 2007+ uses different description: 'The spelling checker can't undo
your last change.@The data in field '|' has been modified by another user. To
resume the spelling check, click OK.@@1@@@1'

Access 2003+

9542 This database must be closed before you can create a replica.@Do you want
Microsoft Office Access to close this database and create the replica? If you
proceed, Microsoft Office Access will close your database and convert it to a
Design Master. The database may increase in size.@@19@@2 Access 2007+
uses different description: 'This database must be closed before you can create
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a replica.@Do you want Microsoft Office Access to close this database and
create the replica? If you proceed, Microsoft Office Access will close your
database and convert it to a Design Master. The database may increase in
size.@@19@@@2' Access 2010+ uses different description: 'This database
must be closed before you can create a replica.@Do you want Microsoft Access
to close this database and create the replica? If you proceed, Microsoft Access
will close your database and convert it to a Design Master. The database may
increase in size.@@19@@@2'

9543

The Hangul Hanja Converter can't proceed. There is no Hangul or Hanja data to
convert.@@@1@@1 Access 2007+ uses different description: 'The Hangul
Hanja Converter can't proceed. There is no Hangul or Hanja data to
convert.@@@1@@@1'

Access 2003+

9544

Microsoft Office Access can't register the '|' custom dictionary.@@@1@@1
Access 2007+ uses different description: 'Microsoft Office Access can't
register the '|' custom dictionary.@@@1@@@1' Access 2010+ uses different
description: 'Microsoft Access can't register the '|1' custom
dictionary.@@@1@@@1'

Access 2003+

9545

After you have converted this file to Access 2002 - 2003 File Format, the new
file cannot be shared with Access 2000 users or Access 97 users.@For more
information about conversion, click Help.@@2@553714162@1 Access 2007+
uses different description: 'After you have converted this file to Access 2002 -
2003 File Format, the new file cannot be shared with Access 2000 users or
Access 97 users.@For more information about conversion, click
Help.@@2@1@553714162@1'

Access 2003+

9546

This data access page was created in a previous version of Microsoft Office
Access. To open this page in Design view, you must convert it to the current
version of Access. Once you have converted this page, you can't open it in
Design view in a previous version of Access.�Con&vert�Cancel@@@35@@
Access 2007+ uses different description: ''

Access 2003

9547

After you have converted this file to Access 2000 File Format, the new file
cannot be shared with Access 97 users. @Any functionality specific to Access
2002 or later will not be available in Access 2000.@For more information
about conversion, click Help.@2@553714162@1 Access 2007+ uses different
description: 'After you have converted this file to Access 2000 File Format, the
new file cannot be shared with Access 97 users. @Any functionality specific to
Access 2002 or later will not be available in Access 2000.@For more
information about conversion, click Help.@2@1@553714162@1'

Access 2003+

9548

After you have converted this file to Access 97 File Format, any functionality
specific to Access 2000 or later will be lost.@For more information about
conversion, click Help.@@2@553714162@1 Access 2007+ uses different
description: 'After you have converted this file to Access 97 File Format, any
functionality specific to Access 2000 or later will be lost.@For more
information about conversion, click Help.@@2@1@553714162@1'

Access 2003+

9549
This Database has been upgraded to the Access 2007 File Format. The new
database cannot be shared with users of Access 2003 or earlier versions.@For
more information about conversion, click Help.@@2@1@553714162@1

Access 2007+

9550

The Text Format property of the bound field '|' is not currently Rich Text. You
should change the Text Format property of the table field before you change the
property of this control. If you change the Text Format property of this control
to Rich Text before you change the property of the bound field, some data that
is not valid HTML might not be displayed.@Do you want to continue?
@@19@@@2

Access 2007+

Error Code Error Description Supported Versions
9551 The Text Format property of the bound field '|' is not currently Plain Text. You

should change the Text Format property of the table field before you change the
property of this control. If you change the Text Format property of this control
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to Plain Text before you change the property of the bound field, some data
might be displayed as HTML tags.@Do you want to continue?@@19@@@2

9552 The application is already in sync with the server. Access 2010+

9553 There are pending updates to this application that must be applied before you
can save your changes to the server. Do you want to apply these updates now? Access 2010+

9554 The site '|' already exists. Please select another name. Access 2010+

9555

This connection file contains definitions that conflict with connections already
installed in your database. Click OK to overwrite the existing connection
definition. Click Cancel to keep the existing connection definition and cancel
the installation.

Access 2010+

9556 Deleting this object from your database will cause associated linked tables and
expressions to cease functioning. Access 2010+

10000
You must first save the table.@Do you want to save the table now?@@19@@1
Access 2007+ uses different description: 'You must first save the table.@Do
you want to save the table now?@@19@@@1'

Access 2003+

10001
You must first save the view.@Do you want to save the view now?@@19@@1
Access 2007+ uses different description: 'You must first save the view.@Do
you want to save the view now?@@19@@@1'

Access 2003+

10002

You must first save the stored procedure.@Do you want to save the stored
procedure now?@@19@@1 Access 2007+ uses different description: 'You
must first save the stored procedure.@Do you want to save the stored procedure
now?@@19@@@1'

Access 2003+

10003
You must first save the query.@Do you want to save the query now?
@@19@@1 Access 2007+ uses different description: 'You must first save the
query.@Do you want to save the query now?@@19@@@1'

Access 2003+

10004

Do you want to permanently delete the selected field(s) and all the data in the
field(s)?@To permanently delete the field(s), click Yes.@@19@@2 Access
2007+ uses different description: 'Do you want to permanently delete the
selected field(s) and all the data in the field(s)?@To permanently delete the
field(s), click Yes.@@19@@@2'

Access 2003+

10005

There is no primary key defined.@Although a primary key isn't required, it's
highly recommended. A table must have a primary key for you to define a
relationship between this table and other tables in the database. Do you want to
create a primary key now?@@13@@2 Access 2007+ uses different
description: 'There is no primary key defined.@Although a primary key isn't
required, it's highly recommended. A table must have a primary key for you to
define a relationship between this table and other tables in the database. Do you
want to create a primary key now?@@13@@@2'

Access 2003+

10006 Changing to this data type requires removal of one or more indexes.@You can't
use indexes on fields with a Memo, OLE Object, or Hyperlink data type. If you
click Yes, Microsoft Office Access will delete the indexes that include that
field. Do you want to continue anyway?@@20@@2 Access 2007 uses
different description: 'Changing to this data type requires removal of one or
more indexes.@You can't use indexes on fields with a Memo, OLE Object, or
Hyperlink data type. If you click Yes, Microsoft Office Access will delete the
indexes that include that field. Do you want to continue anyway?
@@20@@@2' Access 2010 uses different description: 'Changing to this data
type requires removal of one or more indexes.@You can't use indexes on fields
with a Memo, OLE Object, or Hyperlink data type. If you click Yes, Microsoft
Access will delete the indexes that include that field. Do you want to continue
anyway?@@20@@@2' Access 2013 uses different description: 'Changing to
this data type requires removal of one or more indexes.@The new field type
you selected doesn't allow indexes. If you click Yes, Microsoft Access will
delete the indexes that include this field.@Do you want to change the data type
and remove the indexes?@20@@@2' Access 2016 uses different description:
'Changing to this data type requires removal of one or more indexes.@The new
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field type you selected doesn't allow indexes. If you click Yes, Microsoft
Access will delete the indexes that include this field.@Do you want to change
the data type and remove the indexes?@20@@@2'

10007

Deleting field '|' requires Microsoft Office Access to delete the primary
key.@Do you want to delete this field anyway?@@19@@2 Access 2007+
uses different description: 'Deleting field '|' requires Microsoft Office Access
to delete the primary key.@Do you want to delete this field anyway?
@@19@@@2' Access 2010+ uses different description: 'Deleting field '|1'
requires Microsoft Access to delete the primary key.@Do you want to delete
this field anyway?@@19@@@2'

Access 2003+

10008

Deleting field '|' requires Microsoft Office Access to delete one or more
indexes.@If you click Yes, Microsoft Office Access will delete the field and all
its indexes. Do you want to delete this field anyway?@@19@@2 Access
2007+ uses different description: 'Deleting field '|' requires Microsoft Office
Access to delete one or more indexes.@If you click Yes, Microsoft Office
Access will delete the field and all its indexes. Do you want to delete this field
anyway?@@19@@@2' Access 2010+ uses different description: 'Deleting
field '|1' requires Microsoft Access to delete one or more indexes.@If you click
Yes, Microsoft Access will delete the field and all its indexes. Do you want to
delete this field anyway?@@19@@@2'

Access 2003+

10009

You can't open the table '|' for modification.@A query or form bound to the
table is open, you may not have permission to open this table in Design view, or
another user has the table open. Do you want to open this table as read-only?
@If you have opened a query or form bound to this table, close it, and then try
again to open the table in Design view.@19@@2 Access 2007+ uses different
description: 'Either an object bound to table '|' is open or another user has the
table open. Do you want to open the table as read-only?@To open the table as
read-only, click Yes.@To open the table as read/write, click No, make sure the
table and all objects bound to it are closed, and then try opening it again in
Design view.@19@@@2'

Access 2003+

10010

Table '|' is a linked table with some properties that can't be modified.@Do you
want to open it anyway?@@19@@2 Access 2007+ uses different
description: 'Table '|' is a linked table whose design can't be modified. If you
want to add or remove fields or change their properties or data types, you must
do so in the source database.@Do you want to open it anyway?@@19@@@2'

Access 2003+

10011

Microsoft Office Access encountered errors while converting the data.@The
contents of fields in |1 record(s) were deleted. Do you want to proceed anyway?
@@19@@2 Access 2007+ uses different description: 'Microsoft Office
Access encountered errors while converting the data.@The contents of fields in
|1 record(s) were deleted. Do you want to proceed anyway?@@19@@@2'
Access 2010+ uses different description: 'Microsoft Access encountered
errors while converting the data.@The contents of fields in |1 record(s) were
deleted. Do you want to proceed anyway?@@19@@@2'

Access 2003+

10012 Microsoft Office Access can't retrieve field properties from the system
tables.@The database needs to be repaired. If you click Yes, Microsoft Office
Access will open the table in Design view. The settings of the FieldName,
DataType, FieldSize, Indexed, and Primary properties will remain intact, but
the settings of other field properties will be lost. You can attempt to redefine the
lost properties, but it is recommended that you restore the database from a
backup copy, or close it and use the Repair Database command on the Tools
menu (Database Utilities submenu). Do you want to continue anyway?
@@20@@2 Access 2007+ uses different description: 'Microsoft Office
Access cannot retrieve field properties from the system tables.@This database
needs to be repaired. If you click Yes, Microsoft Office Access will open the
table in Design view. The settings of the FieldName, DataType, FieldSize,
Indexed, and Primary properties will remain intact, but the settings of other
field properties will be lost. You can attempt to redefine the lost properties, but

Access 2003+



we recommend that you restore the database from a backup copy, or close it
and use the Compact and Repair Database command (click the Microsoft
Office Button and point to Manage). Do you want to continue?@@20@@@2'
Access 2010+ uses different description: 'Microsoft Access cannot retrieve
field properties from the system tables.@This database needs to be repaired. If
you click Yes, Microsoft Access will open the table in Design view. The
settings of the FieldName, DataType, FieldSize, Indexed, and Primary
properties will remain intact, but the settings of other field properties will be
lost. You can attempt to redefine the lost properties, but we recommend that you
restore the database from a backup copy, or close it and use the Compact and
Repair Database command (click the File tab and point to Manage). Do you
want to continue?@@20@@@1'

10013

Microsoft Office Access can't save property changes for linked tables.@Do you
want to continue anyway?@@19@@2 Access 2007+ uses different
description: 'Microsoft Office Access can't save property changes for linked
tables.@Do you want to continue anyway?@@19@@@2' Access 2010+ uses
different description: 'Microsoft Access can't save property changes for linked
tables.@Do you want to continue anyway?@@19@@@2'

Access 2003+

Error Code Error Description Supported Versions

10014

Microsoft Office Access was unable to append all the data to the table.@The
contents of fields in |1 record(s) were deleted, and |2 record(s) were lost due to
key violations. * If data was deleted, the data you pasted or imported doesn't
match the field data types or the FieldSize property in the destination table. * If
records were lost, either the records you pasted contain primary key values that
already exist in the destination table, or they violate referential integrity rules
for a relationship defined between tables. Do you want to proceed anyway?
@@22@600922@1 Access 2007+ uses different description: 'Microsoft
Office Access was unable to append all the data to the table.@The contents of
fields in |1 record(s) were deleted, and |2 record(s) were lost due to key
violations. * If data was deleted, the data you pasted or imported doesn't match
the field data types or the FieldSize property in the destination table. * If
records were lost, either the records you pasted contain primary key values that
already exist in the destination table, or they violate referential integrity rules
for a relationship defined between tables. Do you want to proceed anyway?
@@22@1@922@1' Access 2010+ uses different description: 'Microsoft
Access was unable to append all the data to the table.@The contents of fields in
|1 record(s) were deleted, and |2 record(s) were lost due to key violations. * If
data was deleted, the data you pasted or imported doesn't match the field data
types or the FieldSize property in the destination table. * If records were lost,
either the records you pasted contain primary key values that already exist in
the destination table, or they violate referential integrity rules for a relationship
defined between tables. Do you want to proceed anyway?@@22@1@922@1'

Access 2003+

10015

Changing to this data type requires removal of the primary key.@Do you want
to continue anyway?@@19@@2 Access 2007+ uses different description:
'Changing to this data type requires removal of the primary key.@Do you want
to continue anyway?@@19@@@2'

Access 2003+

10016 Some data may be lost.@The setting for the FieldSize property of one or more
fields has been changed to a shorter size. If data is lost, validation rules may be
violated as a result. Do you want to continue anyway?@@20@@2 Access
2007 uses different description: 'Some data may be lost.@The setting for the
FieldSize property of one or more fields has been changed to a shorter size. If
data is lost, validation rules may be violated as a result. Do you want to
continue anyway?@@20@@@2' Access 2010 uses different description:
'Some data may be lost.@The setting for the FieldSize property of one or more
fields has been changed to a shorter size. If data is lost, validation rules may be
violated as a result. Do you want to continue anyway?@@20@@@2' Access
2013 uses different description: 'Some data may be lost.@The size of one or

Access 2003+



more fields has been changed to a shorter size. If data is lost, validation rules
may be violated as a result. Do you want to continue anyway?@@20@@@2'
Access 2016 uses different description: 'Some data may be lost.@The size of
one or more fields has been changed to a shorter size. If data is lost, validation
rules may be violated as a result. Do you want to continue anyway?
@@20@@@2'

10017

Your computer is out of disk space.@You won't be able to undo this paste
append. Do you want to continue anyway?@@19@@2 Access 2007+ uses
different description: 'Your computer is out of disk space.@You won't be able
to undo this paste append. Do you want to continue anyway?@@19@@@2'

Access 2003+

10018

Microsoft Office Access was unable to append all the data to the table.@The
contents of fields in |1 record(s) were deleted, and |2 record(s) were lost due to
key violations. * If data was deleted, the data you pasted or imported doesn't
match the field data types or the FieldSize property in the destination table. * If
records were lost, the records you pasted contain primary key values that
already exist in the destination table, or they violate referential integrity rules
for a relationship defined between tables.@@2@600922@1 Access 2007+
uses different description: 'Microsoft Office Access was unable to append all
the data to the table.@The contents of fields in |1 record(s) were deleted, and |2
record(s) were lost due to key violations. * If data was deleted, the data you
pasted or imported doesn't match the field data types or the FieldSize property
in the destination table. * If records were lost, the records you pasted contain
primary key values that already exist in the destination table, or they violate
referential integrity rules for a relationship defined between
tables.@@2@1@922@1' Access 2010+ uses different description: 'Microsoft
Access was unable to append all the data to the table.@The contents of fields in
|1 record(s) were deleted, and |2 record(s) were lost due to key violations. * If
data was deleted, the data you pasted or imported doesn't match the field data
types or the FieldSize property in the destination table. * If records were lost,
the records you pasted contain primary key values that already exist in the
destination table, or they violate referential integrity rules for a relationship
defined between tables.@@2@1@922@1'

Access 2003+

10019

Microsoft Office Access can't find the database containing the linked table
'|.'@The properties set in Microsoft Office Access for the linked table will be
lost. Do you want to continue with the conversion anyway?@@19@@2 Access
2007+ uses different description: 'Microsoft Office Access can't find the
database containing the linked table '|.'@The properties set in Microsoft Office
Access for the linked table will be lost. Do you want to continue with the
conversion anyway?@@19@@@2' Access 2010+ uses different description:
'Microsoft Access can't find the database containing the linked table '|1.'@The
properties set in Microsoft Access for the linked table will be lost. Do you want
to continue with the conversion anyway?@@19@@@2'

Access 2003+

10020

Data integrity rules have been changed; existing data may not be valid for the
new rules.@This process may take a long time. Do you want the existing data
to be tested with the new rules?@@13@@2 Access 2007+ uses different
description: 'Data integrity rules have been changed; existing data may not be
valid for the new rules.@This process may take a long time. Do you want the
existing data to be tested with the new rules?@@13@@@2'

Access 2003+

10021

Existing data violates the new record validation rule.@Do you want to keep
testing with the new rule? * To keep the new rule and continue testing, click
Yes. * To revert to the old rule and continue testing, click No. * To stop testing,
click Cancel.@@13@@1 Access 2007+ uses different description: 'Existing
data violates the new record validation rule.@Do you want to keep testing with
the new rule? * To keep the new rule and continue testing, click Yes. * To revert
to the old rule and continue testing, click No. * To stop testing, click
Cancel.@@13@@@1'

Access 2003+



10022

Existing data violates the new setting for the '|1' property for field '|2.'@Do you
want to keep testing with the new setting? * To keep the new setting and
continue testing, click Yes. * To revert to the old setting and continue testing,
click No. * To stop testing, click Cancel.@@13@@2 Access 2007+ uses
different description: 'Existing data violates the new setting for the '|1'
property for field '|2.'@Do you want to keep testing with the new setting? * To
keep the new setting and continue testing, click Yes. * To revert to the old
setting and continue testing, click No. * To stop testing, click
Cancel.@@13@@@2'

Access 2003+

10023

Microsoft Office Access deleted | indexes on the converted fields.@Some data
did not convert properly.@@1@@1 Access 2007+ uses different description:
'Microsoft Office Access deleted | indexes on the converted fields.@Some data
did not convert properly.@@1@@@1' Access 2010+ uses different
description: 'Microsoft Access deleted |1 indexes on the converted
fields.@Some data did not convert properly.@@1@@@1'

Access 2003+

10024

You must save the table first.@Microsoft Office Access can't test your data
until you save the design changes you made. Do you want to save the table
now?@@19@@2 Access 2007+ uses different description: 'You must save
the table first.@Microsoft Office Access can't test your data until you save the
design changes you made. Do you want to save the table now?@@19@@@2'
Access 2010+ uses different description: 'You must save the table
first.@Microsoft Access can't test your data until you save the design changes
you made. Do you want to save the table now?@@19@@@2'

Access 2003+

10025

This operation will test the table's record and field validation rules, as well as
the Required and AllowZeroLength properties, for all data in the table.@This
process may take a long time. Do you want to continue anyway?@@19@@2
Access 2007+ uses different description: 'This operation will test the table's
record and field validation rules, as well as the Required and AllowZeroLength
properties, for all data in the table.@This process may take a long time. Do you
want to continue anyway?@@19@@@2'

Access 2003+

10026 All data was valid for all rules.@@@1@@1 Access 2007+ uses different
description: 'All data was valid for all rules.@@@1@@@1' Access 2003+

10027

Existing data violates the new record validation rule.@Do you want to continue
testing data with this new rule? * To continue testing for other new rule
violations, click Yes. * To continue to test only the old validation rules, click
No. * To stop testing, click Cancel.@@13@@2 Access 2007+ uses different
description: 'Existing data violates the new record validation rule.@Do you
want to continue testing data with this new rule? * To continue testing for other
new rule violations, click Yes. * To continue to test only the old validation
rules, click No. * To stop testing, click Cancel.@@13@@@2'

Access 2003+

10028

The existing data violates the '|1' property for field '|2.'@If you continue testing,
Microsoft Office Access will inform you if data violates any other property
settings in the table. Would you like to continue testing?@@19@@2 Access
2007+ uses different description: 'The existing data violates the '|1' property
for field '|2.'@If you continue testing, Microsoft Office Access will inform you
if data violates any other property settings in the table. Would you like to
continue testing?@@19@@@2' Access 2010+ uses different description:
'The existing data violates the '|1' property for field '|2.'@If you continue
testing, Microsoft Access will inform you if data violates any other property
settings in the table. Would you like to continue testing?@@19@@@2'

Access 2003+

10029

There is no primary key defined.@Although a primary key isn't required, it's
highly recommended.A table must have a primary key for you to add data to
this table or to define relationships between this table and other tables in the
database. Do you want to return to table design and add a primary key now?
@@13@@2 Access 2007+ uses different description: ''

Access 2003



10030

There is no primary key defined.@Although a primary key isn't required, it's
highly recommended.A table must have a primary key for you to define
relationships between this table and other tables in the database. Do you want to
return to table design and add a primary key now?@@13@@2 Access 2007+
uses different description: 'There is no primary key defined.@Although a
primary key isn't required, it's highly recommended.A table must have a
primary key for you to define relationships between this table and other tables
in the database. Do you want to return to table design and add a primary key
now?@@13@@@2' Access 2010+ uses different description: 'There is no
primary key defined.@Although a primary key isn't required, it's highly
recommended. A table must have a primary key for you to define relationships
between this table and other tables in the database. Do you want to return to
table design and add a primary key now?@@13@@@2'

Access 2003+

10031
You must first save the function.@Do you want to save the function now?
@@19@@1 Access 2007+ uses different description: 'You must first save the
function.@Do you want to save the function now?@@19@@@1'

Access 2003+

10032 This field will be converted to Plain Text and all the formatting in the field will
be removed.@Do you want to convert the column to Plain Text?@@20@@@2 Access 2007+

10033

This field will be converted to Rich Text, and all the data it contains will be
HTML encoded.@If your data already contains valid HTML Rich Text, you
can remove any extra HTML encoding by using the PlainText function in an
update query.Do you want to convert the column to Rich Text?@@20@@@2
Access 2010+ uses different description: 'This field will be converted to Rich
Text, and all the data it contains will be HTML encoded.@If your data already
contains valid HTML Rich Text, you can remove any extra HTML encoding by
using the PlainText function in an update query.@Do you want to convert the
column to Rich Text?@20@@@2'

Access 2007+

Error Code Error Description Supported Versions

10034 Warning: This change will cause all history for column '|' to be lost.@Do you
want to continue?@@19@@@2 Access 2010+

10035 After this change, you will not be able to switch back to the current data
type.@Do you want to continue with this data type change?@@19@@@1 Access 2010+

10250

You can't print the scrollable (unfrozen) columns on the datasheet.@The frozen
columns are wider than the page. Do you want to print just the frozen columns?
@If you want to print the unfrozen columns, try one or more of the following: *
Decrease the column width and increase the row height of the frozen columns.
* Change the page orientation to Landscape in the printer Properties dialog box.
* Decrease the size of the left and right page margins in the Page Setup dialog
box.@21@209172@2 Access 2007+ uses different description: 'You can't
print the scrollable (unfrozen) columns on the datasheet.@The frozen columns
are wider than the page. Do you want to print just the frozen columns?@If you
want to print the unfrozen columns, try one or more of the following: *
Decrease the column width and increase the row height of the frozen columns.
* Change the page orientation to Landscape in the printer Properties dialog box.
* Decrease the size of the left and right page margins in the Page Setup dialog
box.@21@1@9172@2'

Access 2003+

10251 The column heading is too tall to fit on the page. Part of the heading will be cut
off.@Do you want to print the incomplete heading?@To prevent headings from
being cut off, try one or more of the following: * Change the page orientation to
Portrait in the printer Properties dialog box. * Decrease the size of the top and
bottom page margins in the Page Setup dialog box.@19@@2 Access 2007+
uses different description: 'The column heading is too tall to fit on the page.
Part of the heading will be cut off.@Do you want to print the incomplete
heading?@To prevent headings from being cut off, try one or more of the
following: * Change the page orientation to Portrait in the printer Properties

Access 2003+



dialog box. * Decrease the size of the top and bottom page margins in the Page
Setup dialog box.@19@@@2'

10252

At least one column is too wide to fit on the page. Data in that column will be
cut off.@Do you want to print the column with incomplete data?@To prevent
data from being cut off, try one or more of the following: * Decrease the
column width and increase the row height. * Change the page orientation to
Landscape in the printer Properties dialog box. * Decrease the size of the left
and right page margins in the Page Setup dialog box.@19@@2 Access 2007+
uses different description: 'At least one column is too wide to fit on the page.
Data in that column will be cut off.@Do you want to print the column with
incomplete data?@To prevent data from being cut off, try one or more of the
following: * Decrease the column width and increase the row height. * Change
the page orientation to Landscape in the printer Properties dialog box. *
Decrease the size of the left and right page margins in the Page Setup dialog
box.@19@@@2'

Access 2003+

10253

The row height exceeds the space between the top and bottom margins.@Do
you want to print the columns with incomplete data?@To prevent data from
being cut off, try one or more of the following: * Increase the column width and
decrease the row height. * Change the page orientation to Portrait in the printer
Properties dialog box. * Decrease the size of the top and bottom page margins
in the Page Setup dialog box.@19@@2 Access 2007+ uses different
description: 'The row height exceeds the space between the top and bottom
margins.@Do you want to print the columns with incomplete data?@To
prevent data from being cut off, try one or more of the following: * Increase the
column width and decrease the row height. * Change the page orientation to
Portrait in the printer Properties dialog box. * Decrease the size of the top and
bottom page margins in the Page Setup dialog box.@19@@@2'

Access 2003+

10500

You are about to run an update query that will modify data in your table.@Are
you sure you want to run this type of action query? For information on how to
prevent this message from displaying every time you run an action query, click
Help.@@21@209058@2 Access 2007+ uses different description: 'You are
about to run an update query that will modify data in your table.@Are you sure
you want to run this type of action query? For information on how to prevent
this message from displaying every time you run an action query, click
Help.@@21@1@9058@2'

Access 2003+

10501

You are about to run an append query that will modify data in your table.@Are
you sure you want to run this type of action query? For information on turning
off confirmation messages for document deletions, click
Help.@@21@209058@2 Access 2007+ uses different description: 'You are
about to run an append query that will modify data in your table.@Are you sure
you want to run this type of action query? For information on turning off
confirmation messages for document deletions, click
Help.@@21@1@9058@2'

Access 2003+

10502

You are about to run a make-table query that will modify data in your
table.@Are you sure you want to run this type of action query? For information
on how to prevent this message from displaying every time you run an action
query, click Help.@@21@209058@2 Access 2007+ uses different
description: 'You are about to run a make-table query that will modify data in
your table.@Are you sure you want to run this type of action query? For
information on how to prevent this message from displaying every time you run
an action query, click Help.@@21@1@9058@2'

Access 2003+

10503 You are about to run a delete query that will modify data in your table.@Are
you sure you want to run this type of action query? For information on how to
prevent this message from displaying every time you run an action query, click
Help.@@21@209058@2 Access 2007+ uses different description: 'You are
about to run a delete query that will modify data in your table.@Are you sure
you want to run this type of action query? For information on how to prevent

Access 2003+



this message from displaying every time you run an action query, click
Help.@@21@1@9058@2'

10504

You are about to run a data-definition query that may modify data in your
table.@Are you sure you want to run this type of an SQL query? If not, click
No and then modify the query or close it to run later.@@19@@2 Access
2007+ uses different description: 'You are about to run a data-definition query
that may modify data in your table.@Are you sure you want to run this type of
an SQL query? If not, click No and then modify the query or close it to run
later.@@19@@@2'

Access 2003+

10505

You are about to update | row(s).@Once you click Yes, you can't use the Undo
command to reverse the changes. Are you sure you want to update these
records?@@19@@2 Access 2007+ uses different description: 'You are about
to update | row(s).@Once you click Yes, you can't use the Undo command to
reverse the changes. Are you sure you want to update these records?
@@19@@@2'

Access 2003+

10506

You are about to append | row(s).@Once you click Yes, you can't use the Undo
command to reverse the changes. Are you sure you want to append the selected
rows?@@19@@2 Access 2007+ uses different description: 'You are about to
append | row(s).@Once you click Yes, you can't use the Undo command to
reverse the changes. Are you sure you want to append the selected rows?
@@19@@@2'

Access 2003+

10507

You are about to paste | row(s) into a new table.@Once you click Yes, you can't
use the Undo command to reverse the changes. Are you sure you want to create
a new table with the selected records?@@19@@2 Access 2007+ uses
different description: 'You are about to paste | row(s) into a new table.@Once
you click Yes, you can't use the Undo command to reverse the changes. Are you
sure you want to create a new table with the selected records?@@19@@@2'

Access 2003+

10508

You are about to delete | row(s) from the specified table.@Once you click Yes,
you can't use the Undo command to reverse the changes. Are you sure you want
to delete the selected records?@@19@@2 Access 2007+ uses different
description: 'You are about to delete | row(s) from the specified table.@Once
you click Yes, you can't use the Undo command to reverse the changes. Are you
sure you want to delete the selected records?@@19@@@2'

Access 2003+

10509

Microsoft Office Access can't update all the records in the update
query.@Microsoft Office Access didn't update |1 field(s) due to a type
conversion failure, |2 record(s) due to key violations, |3 record(s) due to lock
violations, and |4 record(s) due to validation rule violations. Do you want to
continue running this type of action query anyway? To ignore the error(s) and
run the query, click Yes. For an explanation of the causes of the violations, click
Help.@@21@310019@2 Access 2007+ uses different description: 'Microsoft
Office Access can't update all the records in the update query.@Microsoft
Office Access didn't update |1 field(s) due to a type conversion failure, |2
record(s) due to key violations, |3 record(s) due to lock violations, and |4
record(s) due to validation rule violations. Do you want to continue running this
type of action query anyway? To ignore the error(s) and run the query, click
Yes. For an explanation of the causes of the violations, click
Help.@@21@1@10019@2' Access 2010+ uses different description:
'Microsoft Access can't update all the records in the update query.@Microsoft
Access didn't update |1 field(s) due to a type conversion failure, |2 record(s) due
to key violations, |3 record(s) due to lock violations, and |4 record(s) due to
validation rule violations. Do you want to continue running this type of action
query anyway? To ignore the error(s) and run the query, click Yes. For an
explanation of the causes of the violations, click Help.@@21@1@10019@2'

Access 2003+

10510 Microsoft Office Access can't append all the records in the append
query.@Microsoft Office Access set |1 field(s) to Null due to a type conversion
failure, and it didn't add |2 record(s) to the table due to key violations, |3
record(s) due to lock violations, and |4 record(s) due to validation rule

Access 2003+



violations. Do you want to run the action query anyway? To ignore the error(s)
and run the query, click Yes. For an explanation of the causes of the violations,
click Help.@@21@310020@2 Access 2007+ uses different description:
'Microsoft Office Access can't append all the records in the append
query.@Microsoft Office Access set |1 field(s) to Null due to a type conversion
failure, and it didn't add |2 record(s) to the table due to key violations, |3
record(s) due to lock violations, and |4 record(s) due to validation rule
violations. Do you want to run the action query anyway? To ignore the error(s)
and run the query, click Yes. For an explanation of the causes of the violations,
click Help.@@21@1@10020@2' Access 2010+ uses different description:
'Microsoft Access can't append all the records in the append query.@Microsoft
Access set |1 field(s) to Null due to a type conversion failure, and it didn't add
|2 record(s) to the table due to key violations, |3 record(s) due to lock
violations, and |4 record(s) due to validation rule violations. Do you want to run
the action query anyway? To ignore the error(s) and run the query, click Yes.
For an explanation of the causes of the violations, click
Help.@@21@1@10020@2'

10511

Microsoft Office Access can't add all the records in the update or append
query.@It set |1 field(s) to Null due to a type conversion failure. A type
conversion failure is caused when the data in one or more fields doesn't match
the DataType or FieldSize property in the destination table. For example,
leaving blank fields in a Yes/No field or entering text in a numeric field will
cause this error. Do you want to ignore the errors and run the update or append
query anyway? To ignore the error(s) and run the query, click
Yes.@@19@600922@2 Access 2007+ uses different description: 'Microsoft
Office Access can't add all the records in the update or append query.@It set |1
field(s) to Null due to a type conversion failure. A type conversion failure is
caused when the data in one or more fields doesn't match the DataType or
FieldSize property in the destination table. For example, leaving blank fields in
a Yes/No field or entering text in a numeric field will cause this error. Do you
want to ignore the errors and run the update or append query anyway? To
ignore the error(s) and run the query, click Yes.@@19@1@922@2' Access
2010+ uses different description: 'Microsoft Access can't add all the records in
the update or append query.@It set |1 field(s) to Null due to a type conversion
failure. A type conversion failure is caused when the data in one or more fields
doesn't match the DataType or FieldSize property in the destination table. For
example, leaving blank fields in a Yes/No field or entering text in a numeric
field will cause this error. Do you want to ignore the errors and run the update
or append query anyway? To ignore the error(s) and run the query, click
Yes.@@19@1@922@2'

Access 2003+

10512

Microsoft Office Access can't delete |2 record(s) in the delete query due to key
violations and |3 record(s) due to lock violations.@Do you want to run this
action query anyway? To ignore the error(s) and run the query, click Yes. For an
explanation of the causes of the violations, click Help.@@21@310016@2
Access 2007+ uses different description: 'Microsoft Office Access can't delete
|2 record(s) in the delete query due to key violations and |3 record(s) due to lock
violations.@Do you want to run this action query anyway? To ignore the
error(s) and run the query, click Yes. For an explanation of the causes of the
violations, click Help.@@21@1@10016@2' Access 2010+ uses different
description: 'Microsoft Access can't delete |2 record(s) in the delete query due
to key violations and |3 record(s) due to lock violations.@Do you want to run
this action query anyway? To ignore the error(s) and run the query, click Yes.
For an explanation of the causes of the violations, click
Help.@@21@1@10016@2'

Access 2003+



10513

The existing | will be deleted before you run the query.@Do you want to
continue anyway?@@20@@2 Access 2007+ uses different description: 'The
existing | will be deleted before you run the query.@Do you want to continue
anyway?@@20@@@2'

Access 2003+

Error Code Error Description Supported Versions

10514

You won't be able to undo the changes this action query is about to make to the
data in a linked table or tables.@Do you want to run this action query anyway?
@@19@@2 Access 2007+ uses different description: 'You won't be able to
undo the changes this action query is about to make to the data in a linked table
or tables.@Do you want to run this action query anyway?@@19@@@2'

Access 2003+

10515

Microsoft Office Access was unable to update all the records in the update
query.@Microsoft Office Access didn't update |1 field(s) due to a type
conversion failure, |2 record(s) due to key violations, |3 record(s) due to lock
violations, and |4 record(s) due to validation rule violations. For an explanation
of the causes of the violations, click Help.@@2@310019@1 Access 2007+
uses different description: 'Microsoft Office Access was unable to update all
the records in the update query.@Microsoft Office Access didn't update |1
field(s) due to a type conversion failure, |2 record(s) due to key violations, |3
record(s) due to lock violations, and |4 record(s) due to validation rule
violations. For an explanation of the causes of the violations, click
Help.@@2@1@10019@1' Access 2010+ uses different description:
'Microsoft Access was unable to update all the records in the update
query.@Microsoft Access didn't update |1 field(s) due to a type conversion
failure, |2 record(s) due to key violations, |3 record(s) due to lock violations,
and |4 record(s) due to validation rule violations. For an explanation of the
causes of the violations, click Help.@@2@1@10019@1'

Access 2003+

10516

Microsoft Office Access can't append all the records to the table.@Microsoft
Office Access set |1 field(s) to Null due to a type conversion failure, and it
didn't add |2 record(s) due to key violations, |3 record(s) due to lock violations,
and |4 record(s) due to validation rule violations. For an explanation of the
causes of the violations, click Help.@@2@310020@1 Access 2007+ uses
different description: 'Microsoft Office Access can't append all the records to
the table.@Microsoft Office Access set |1 field(s) to Null due to a type
conversion failure, and it didn't add |2 record(s) due to key violations, |3
record(s) due to lock violations, and |4 record(s) due to validation rule
violations. For an explanation of the causes of the violations, click
Help.@@2@1@10020@1' Access 2010+ uses different description:
'Microsoft Access can't append all the records to the table.@Microsoft Access
set |1 field(s) to Null due to a type conversion failure, and it didn't add |2
record(s) due to key violations, |3 record(s) due to lock violations, and |4
record(s) due to validation rule violations. For an explanation of the causes of
the violations, click Help.@@2@1@10020@1'

Access 2003+

10517 Microsoft Office Access can't add all the records in the make-table query.@It
set |1 field(s) to Null due to a type conversion failure. A type conversion failure
is caused when the data in one or more fields doesn't match the DataType or
FieldSize property in the destination table. For example, leaving blank fields in
a Yes/No field or adding text in numeric field will cause this
error.@@1@600922@1 Access 2007+ uses different description: 'Microsoft
Office Access can't add all the records in the make-table query.@It set |1
field(s) to Null due to a type conversion failure. A type conversion failure is
caused when the data in one or more fields doesn't match the DataType or
FieldSize property in the destination table. For example, leaving blank fields in
a Yes/No field or adding text in numeric field will cause this
error.@@1@1@922@1' Access 2010+ uses different description: 'Microsoft
Access can't add all the records in the make-table query.@It set |1 field(s) to
Null due to a type conversion failure. A type conversion failure is caused when
the data in one or more fields doesn't match the DataType or FieldSize property

Access 2003+



in the destination table. For example, leaving blank fields in a Yes/No field or
adding text in numeric field will cause this error.@@1@1@922@1'

10518

Microsoft Office Access can't delete all the records in the delete
query.@Microsoft Office Access didn't delete |2 record(s) due to key violations
and |3 record(s) due to lock violations. For an explanation of the causes of the
violation, click Help.@@2@310016@1 Access 2007+ uses different
description: 'Microsoft Office Access can't delete all the records in the delete
query.@Microsoft Office Access didn't delete |2 record(s) due to key violations
and |3 record(s) due to lock violations. For an explanation of the causes of the
violation, click Help.@@2@1@10016@1' Access 2010+ uses different
description: 'Microsoft Access can't delete all the records in the delete
query.@Microsoft Access didn't delete |2 record(s) due to key violations and |3
record(s) due to lock violations. For an explanation of the causes of the
violation, click Help.@@2@1@10016@1'

Access 2003+

10519

There isn't enough disk space or memory to undo the data changes this action
query is about to make.@Do you want to run this action query anyway? For
information on freeing disk space or freeing memory, search the Microsoft
Windows Help index for 'disk space, freeing' or 'memory,
troubleshooting'.@@19@@2 Access 2007+ uses different description: 'There
isn't enough disk space or memory to undo the data changes this action query is
about to make.@Do you want to run this action query anyway? For information
on freeing disk space or freeing memory, search the Microsoft Windows Help
index for 'disk space, freeing' or 'memory, troubleshooting'.@@19@@@2'

Access 2003+

10520

Do you want to save the changes made to the SQL statement and update the
property?@The RecordSource or RowSource property contained a SQL
statement when you invoked the Query Builder, so the original SQL statement
was modified.@To close the Query Builder without changing the original SQL
statement, click No.@13@604309@2 Access 2007+ uses different
description: 'Do you want to save the changes made to the SQL statement and
update the property?@The RecordSource or RowSource property contained an
SQL statement when you invoked the Query Builder, so the original SQL
statement was modified.@To close the Query Builder without changing the
original SQL statement, click No.@13@1@4309@2'

Access 2003+

10521

Do you want to save the changes made to the query and update the property?
@The RecordSource or RowSource property contained the name of a query
when you invoked the Query Builder, so the original query was modified.@To
close the Query Builder without changing the original query, click
No.@13@604309@2 Access 2007+ uses different description: 'Do you want
to save the changes made to the query and update the property?@The
RecordSource or RowSource property contained the name of a query when you
invoked the Query Builder, so the original query was modified.@To close the
Query Builder without changing the original query, click
No.@13@1@4309@2'

Access 2003+

10522

You invoked the Query Builder on a table.@Do you want to create a query
based on the table?@@19@@2 Access 2007+ uses different description:
'You invoked the Query Builder on a table.@Do you want to create a query
based on the table?@@19@@@2'

Access 2003+

10523

You are about to run a pass-through query that may modify data in your
table.@Are you sure you want to run this type of an SQL query? For
information on how to prevent this message from displaying every time you run
an SQL query, click Help.@@21@209058@2 Access 2007+ uses different
description: 'You are about to run a pass-through query that may modify data
in your table.@Are you sure you want to run this type of an SQL query? For
information on how to prevent this message from displaying every time you run
an SQL query, click Help.@@21@1@9058@2'

Access 2003+

10524 | output column(s) in the query were unnamed and will not show any
data.@@@1@@1 Access 2007+ uses different description: '| output

Access 2003+



column(s) in the query were unnamed and will not show any
data.@@@1@@@1'

10526

Do you want to save the changes made to the SQL Statement and update the
text editor?@The Stored Procedure or Function contained an SQL statement
when you invoked the Query Builder, so the original SQL statement was
modified.@To close the Query Builder without changing the original SQL
statement, click No.@13@604309@2 Access 2007+ uses different
description: 'Do you want to save the changes made to the SQL Statement and
update the text editor?@The Stored Procedure or Function contained an SQL
statement when you invoked the Query Builder, so the original SQL statement
was modified.@To close the Query Builder without changing the original SQL
statement, click No.@13@1@4309@2'

Access 2003+

10600

Are you sure you want to permanently delete the selected relationship from
your database?@@@19@@2 Access 2007+ uses different description: 'Are
you sure you want to permanently delete the selected relationship from your
database?@@@19@@@2'

Access 2003+

10601

A relationship already exists.@Do you want to edit the existing relationship? To
create a new relationship, click No.@@13@@2 Access 2007+ uses different
description: 'A relationship already exists.@Do you want to edit the existing
relationship? To create a new relationship, click No.@@13@@@2'

Access 2003+

10602

The field name is missing in row |.@You haven't selected a matching field for
this relationship in each row of the grid.@Select fields so that the grid has the
same number of fields on the left and right sides, and then try to create the
relationship again.@1@@1 Access 2007+ uses different description: 'The
field name is missing in row |.@You haven't selected a matching field for this
relationship in each row of the grid.@Select fields so that the grid has the same
number of fields on the left and right sides, and then try to create the
relationship again.@1@@@1'

Access 2003+

10603

This relationship has been modified or deleted by another user since you
opened the Relationships window.@Do you want to edit the relationship and
overwrite the other user's changes? To update your Relationships window to
include the other user's changes, click No.@@19@@2 Access 2007+ uses
different description: 'This relationship has been modified or deleted by
another user since you opened the Relationships window.@Do you want to edit
the relationship and overwrite the other user's changes? To update your
Relationships window to include the other user's changes, click
No.@@19@@@2'

Access 2003+

10604

This relationship has already been deleted by another user.@To update your
view, click OK.@@1@@1 Access 2007+ uses different description: 'This
relationship has already been deleted by another user.@To update your view,
click OK.@@1@@@1'

Access 2003+

10605

The layout of the Relationships window will be cleared.@Do you want to
continue?@@19@@2 Access 2007+ uses different description: 'The layout
of the Relationships window will be cleared.@Do you want to continue?
@@19@@@2'

Access 2003+

10606 You can't display queries or linked tables in the Relationships window for this
database.@The database '|' was created in an earlier version of Microsoft Office
Access. If you want to convert this database to the current version of Microsoft
Office Access, use the Convert Database command on the Tools menu
(Database Utilities submenu).@@1@@1 Access 2007+ uses different
description: 'You cannot display queries or linked tables in the Relationships
window for this database.@The database '|' was created in an earlier version of
Microsoft Office Access. To convert this database to the current version of
Microsoft Office Access, click the Microsoft Office Button, and then click
Convert.@@3@1@9029@1' Access 2010+ uses different description: 'You
cannot display queries or linked tables in the Relationships window for this
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database.@The database '|1' was created in an earlier version of Microsoft
Access. To convert this database to the current version of Microsoft Access,
click the File tab, and then click Convert.@@1@@@0'

10607

The relationship has been created as a one-to-many relationship because there
are duplicate entries in the related field.@You've tried to create a one-to-one
relationship, but the data in the tables suggests that a one-to-many relationship
is more appropriate.@@2@411617@1 Access 2007+ uses different
description: 'The relationship has been created as a one-to-many relationship
because there are duplicate entries in the related field.@You've tried to create a
one-to-one relationship, but the data in the tables suggests that a one-to-many
relationship is more appropriate.@@2@1@11617@1'

Access 2003+

Error Code Error Description Supported Versions

10608

To create a relationship, use the mouse to drag a field from one table to
another.@@@1@@1 Access 2007+ uses different description: 'To create a
relationship, use the mouse to drag a field from one table to
another.@@@1@@@1'

Access 2003+

10700

This document was previously formatted for the printer |1 on |2, but that printer
isn't available. Do you want to use the default printer |3?@@@19@@1 Access
2007+ uses different description: 'This document was previously formatted
for the printer |1 on |2, but that printer isn't available. Do you want to use the
default printer |3?@@@19@@@1'

Access 2003+

10701

This document was previously formatted for the printer '|1 on |2', but that
printer isn't available. The page settings shown in the Print Setup dialog box are
for the current default printer '|3'.@Do you want to continue?@@19@@1
Access 2007+ uses different description: 'This document was previously
formatted for the printer '|1 on |2', but that printer isn't available. The page
settings shown in the Print Setup dialog box are for the current default printer
'|3'.@Do you want to continue?@@19@@@1'

Access 2003+

10702

Previewing or printing this PivotTable view might take a long time because it
displays a large amount of detail data.Microsoft Office Access might not
respond for some time.@Do you want to continue?@* To reduce the amount of
time required, hide most or all of the detail data in the view. * For more
information, consult Microsoft Knowledge Base article Q282315.@3@@1
Access 2007+ uses different description: 'Previewing or printing this
PivotTable view might take a long time because it displays a large amount of
detail data.Microsoft Office Access might not respond for some time.@Do you
want to continue?@* To reduce the amount of time required, hide most or all of
the detail data in the view. * For more information, consult Microsoft
Knowledge Base article Q282315.@3@@@1' Access 2010+ uses different
description: 'Previewing or printing this PivotTable view might take a long
time because it displays a large amount of detail data.Microsoft Access might
not respond for some time.@Do you want to continue?@* To reduce the
amount of time required, hide most or all of the detail data in the view. * For
more information, consult Microsoft Knowledge Base article
Q282315.@3@@@1'

Access 2003+

10750

You must save the macro before you run it.@Do you want to save the macro
now? * To save the macro and then run it, click Yes. * To return to the Macro
window for this macro or to the window you executed the Run Macro
command from, click No.@@19@@2 Access 2007+ uses different
description: 'You must save the macro before you run it.@Do you want to save
the macro now? * To save the macro and then run it, click Yes. * To return to
the Macro window for this macro or to the window you executed the Run
Macro command from, click No.@@19@@@2'

Access 2003+

10751 Some of the macro actions you are trying to save cannot be performed in
Access 97. These actions will be permanently deleted from the macro in the
Access 97 version of your database.@@@1@@1 Access 2007+ uses different
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description: 'Some of the macro actions you are trying to save cannot be
performed in Access 97. These actions will be permanently deleted from the
macro in the Access 97 version of your database.@@@1@@@1'

10800

Microsoft Office Access finished adding the index '|.'@Add another index from
the Select Index Files dialog box, or click Close.@@1@@1 Access 2007+
uses different description: 'Microsoft Office Access finished adding the index
'|.'@Add another index from the Select Index Files dialog box, or click
Close.@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access finished adding the index '|1.'@Add another index from the Select Index
Files dialog box, or click Close.@@1@@@1'

Access 2003+

10801

The Microsoft Office Access index information (.inf) file for '|' already
exists.@Do you want to replace the existing Microsoft Office Access .inf file
for the dBASE or Microsoft FoxPro file you're linking?@* To create a new .inf
file, click Yes. * To use the existing file, click No. If the .inf file contains
invalid or outdated information, you must click Yes to create a new .inf file
before you can link the table.@17@209186@2 Access 2007+ uses different
description: 'The Microsoft Office Access index information (.inf) file for '|'
already exists.@Do you want to replace the existing Microsoft Office Access
.inf file for the dBASE or Microsoft FoxPro file you're linking?@* To create a
new .inf file, click Yes. * To use the existing file, click No. If the .inf file
contains invalid or outdated information, you must click Yes to create a new .inf
file before you can link the table.@17@1@9186@2' Access 2010+ uses
different description: 'The Microsoft Access index information (.inf) file for
'|1' already exists.@Do you want to replace the existing Microsoft Access .inf
file for the dBASE or Microsoft FoxPro file you're linking?@* To create a new
.inf file, click Yes. * To use the existing file, click No. If the .inf file contains
invalid or outdated information, you must click Yes to create a new .inf file
before you can link the table.@17@1@9186@2'

Access 2003+

10803

The database object '|' already exists.@Do you want to replace the existing
database object with the one you are exporting? If you want to export this
object without replacing the existing database object, click No. You can then
export the object again and rename it in the Export dialog box.@@20@@2
Access 2007+ uses different description: 'The object '|' already exists.@Do
you want to replace the existing object with the one you are exporting? If you
want to export this object without replacing the existing object, click No.You
can then choose a new name in the Export dialog box.@@20@@@2'

Access 2003+

10804

Not all of the import specifications could be imported due to name
conflicts.Conflicts existed in | of the specifications.@Rename the conflicting
import specifications, and try the import operation again.@@1@@1 Access
2007+ uses different description: 'Not all of the import specifications could be
imported due to name conflicts.Conflicts existed in | of the
specifications.@Rename the conflicting import specifications, and try the
import operation again.@@1@@@1'

Access 2003+

10805 Invalid CDF file name Access 2007+ uses different description: '' Access 2003
10806 Related data is not supported with the live data option. Access 2003+
10807 Please specify XML export location. Access 2003+
10808 The current record was not unique.All identical records were exported. Access 2003+
10892 A form with a bound ActiveX control or an embedded object bound to a data

source can't have its DefaultView property set to Continuous Forms.@You tried
to add a bound ActiveX control to a form in Design view. Microsoft Office
Access will reset the DefaultView property to Single Form.@@1@@1 Access
2007+ uses different description: 'A form with a bound ActiveX control or an
embedded object bound to a data source can't have its DefaultView property set
to Continuous Forms.@You tried to add a bound ActiveX control to a form in
Design view. Microsoft Office Access will reset the DefaultView property to
Single Form.@@1@@@1' Access 2010+ uses different description: 'A form
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with a bound ActiveX control or an embedded object bound to a data source
can't have its DefaultView property set to Continuous Forms.@You tried to add
a bound ActiveX control to a form in Design view. Microsoft Access will reset
the DefaultView property to Single Form.@@1@@@1'

10893
Either the data access page file has been opened by another user or you don't
have write permission to the file.If you make changes, you will have to save
them to another file. Access 2007+ uses different description: ''

Access 2003

10894 An unexpected error occurred while saving document properties to the data
access page. Access 2007+ uses different description: '' Access 2003

10895
You tried to drop an OLE or binary column onto your data access page.There is
no HTML control which binds correctly to this column type. Access 2007+
uses different description: ''

Access 2003

10896

You have chosen to permanently delete the data access page.@Do you want to
delete both the link and page file(s), or delete just the link?�&Delete Link and
Files�Delete &Link Only�Cancel@@27@@ Access 2007+ uses different
description: 'You have chosen to permanently delete the link to the data access
page.@�Delete &Link�Cancel@@27@@@' Access 2010+ uses different
description: 'You have chosen to permanently delete the link to the data access
page.�Delete &Link�Cancel@@@27@@@'

Access 2003+

10897

|@There is a problem with Internet Explorer registry settings.@Please reinstall
Internet Explorer.@1@@1 Access 2007+ uses different description: '|@There
is a problem with Internet Explorer registry settings.@Please reinstall Internet
Explorer.@1@@@1'

Access 2003+

Error Code Error Description Supported Versions

10898

Microsoft Office Access data access pages can only be viewed in Microsoft
Internet Explorer, but it is not your default Browser.@Do you want to open
Internet Explorer to view this page?@@19@@ Access 2007+ uses different
description: 'Microsoft Office Access data access pages can only be viewed in
Windows Internet Explorer, but it is not your default Browser.@Do you want to
open Internet Explorer to view this page?@@19@@@' Access 2010+ uses
different description: 'Microsoft Access data access pages can only be viewed
in Windows Internet Explorer, but it is not your default Browser.@Do you want
to open Internet Explorer to view this page?@@19@@@'

Access 2003+

10899

A link to this data access page could not be created because the Data and Misc.
Objects are not checked out.@@@1@@1 Access 2007+ uses different
description: 'A link to this data access page could not be created because the
Data and Misc. Objects are not checked out.@@@1@@@1'

Access 2003+

10900

The save operation was successful.@A folder was created for your supporting
files at the save destination.@This directory had to be created because the
server does not support long file names.@1@@1 Access 2007+ uses different
description: ''

Access 2003

10901 You must save your data access page before you can preview it.@Do you want
to save now?@@19@@ Access 2007+ uses different description: '' Access 2003

10902

The data access page has been saved, but one or more of the supporting files
(i.e., image, sound, video files) are missing.@You may need to: *Delete and
recreate the HTML object(s) on the page. *Reapply the theme, if the page has a
theme.@@1@@1 Access 2007+ uses different description: ''

Access 2003

10903
The save completed, but files for the selected theme are missing.@Please apply
a new theme to your data access page, and save again.@@1@@1 Access
2007+ uses different description: ''

Access 2003

10904 Do you want Microsoft Office Access to set the DataPageSize property of this
group level to All?@@@19@@ Access 2007+ uses different description: '' Access 2003

10905 You have opened a page that was designed using Access 2000. To be able to
edit the page, you must save it using a more recent version of the Microsoft
Office Web Components. Do you want Access to convert this page by saving it
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using a more recent version of the Microsoft Office Web
Components?�&Convert�Cancel@@@35@@ Access 2007+ uses different
description: ''

10950

Are you sure you want to delete this account?@You can't undo the deletion of a
user or group account. To restore a user or group account that has been deleted,
you must recreate the account using the same name and personal identifier
(PID).@@20@@2 Access 2007+ uses different description: 'Are you sure
you want to delete this account?@You can't undo the deletion of a user or group
account. To restore a user or group account that has been deleted, you must
recreate the account using the same name and personal identifier
(PID).@@20@@@2'

Access 2003+

10951

You don't have permission to modify '|.'@To modify this object, you must have
Modify Design permission for it. If the object is a table, you must also have
Delete Data and Update Data permissions for it. Do you want to save a copy of
the object as a new object?@@21@410222@1 Access 2007+ uses different
description: 'You don't have permission to modify '|.'@To modify this object,
you must have Modify Design permission for it. If the object is a table, you
must also have Delete Data and Update Data permissions for it. Do you want to
save a copy of the object as a new object?@@21@1@10222@1'

Access 2003+

10952

You don't have permission to view this macro.@To view a macro, you must
have Read Design permission for it. Do you want to continue to run the macro?
@@21@410222@2 Access 2007+ uses different description: 'You don't have
permission to view this macro.@To view a macro, you must have Read Design
permission for it. Do you want to continue to run the macro?
@@21@1@10222@2'

Access 2003+

10953

You don't have permission to modify '|.'@To modify this object, you must have
Modify Design permission for it. If the object is a table, you must also have
Delete Data and Update Data permissions for it. Do you want to open it as read-
only?@@21@410222@1 Access 2007+ uses different description: 'You don't
have permission to modify '|.'@To modify this object, you must have Modify
Design permission for it. If the object is a table, you must also have Delete Data
and Update Data permissions for it. Do you want to open it as read-only?
@@21@1@10222@1'

Access 2003+

10954

You changed the permissions of '|1' for '|2.'@Do you want to assign these
permissions now?@@19@@2 Access 2007+ uses different description: 'You
changed the permissions of '|1' for '|2.'@Do you want to assign these
permissions now?@@19@@@2'

Access 2003+

10955

You don't have permission to open '|' for exclusive use.@Microsoft Office
Access is opening the database for shared access. To open a database for
exclusive access, you must have Open Exclusive permission for it. For more
information on permissions and who can set them, click
Help.@@2@410222@1 Access 2007+ uses different description: 'You don't
have permission to open '|' for exclusive use.@Microsoft Office Access is
opening the database for shared access. To open a database for exclusive
access, you must have Open Exclusive permission for it. For more information
on permissions and who can set them, click Help.@@5@1@10222@1' Access
2010+ uses different description: 'You don't have permission to open '|1' for
exclusive use.@Microsoft Access is opening the database for shared access. To
open a database for exclusive access, you must have Open Exclusive
permission for it. For more information on permissions and who can set them,
click Help.@@5@1@10222@1'

Access 2003+

10956 ;LCID=0x0409 Access 2003+
10957 You haven't entered a workgroup ID. To ensure that your workgroup

information file is unique, enter a unique workgroup ID of up to 20 numbers or
letters. Continue without a workgroup ID?@@@20@@1 Access 2007+ uses
different description: 'You haven't entered a workgroup ID. To ensure that
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your workgroup information file is unique, enter a unique workgroup ID of up
to 20 numbers or letters. Continue without a workgroup ID?@@@20@@@1'

10958
The file '|' already exists. Replace existing file?@@@20@@1 Access 2007+
uses different description: 'The file '|' already exists. Replace existing file?
@@@20@@@1'

Access 2003+

10959 Workgroup Files (*.mdw) Access 2003+
10960 Select Workgroup Information File Access 2003+
10961 Open Access 2003+
Error Code Error Description Supported Versions

10962
You have successfully created the workgroup information file '|.'@@@1@@4
Access 2007+ uses different description: 'You have successfully created the
workgroup information file '|.'@@@1@@@4'

Access 2003+

10963 Could not find file: '|' Access 2007+ uses different description: '' Access 2003

10964

You have successfully joined the workgroup defined by the workgroup
information file '|'@@@1@@2 Access 2007+ uses different description: 'You
have successfully joined the workgroup defined by the workgroup information
file '|'@@@1@@@2'

Access 2003+

10965

It is strongly recommended that you change the system administrator (SA)
password when this operation is complete.To change the SA password point to
Security on the Tools menu, and then click Set Login Password. Access 2007+
uses different description: ''

Access 2003

10966 You must restart the application for the new security level to take
effect.@@@1@@1 Access 2007+ uses different description: '' Access 2003

10967

Microsoft Office Access cannot change the registry setting that controls
whether or not unsafe expressions are blocked.@Your account is not authorized
to change this registry setting. To change this setting, contact your system
administrator.@@2@553714182@2 Access 2007+ uses different description:
''

Access 2003

10968

Microsoft Office Access cannot add a digital signature to your file because
Access cannot gain exclusive access to the file. @Make sure no other person or
program has the file open and try to add the digital signature again.@@1@@2
Access 2007+ uses different description: 'Microsoft Office Access cannot add
a digital signature to your file because Access cannot gain exclusive access to
the file. @Make sure no other person or program has the file open and try to
add the digital signature again.@@1@@@2' Access 2010+ uses different
description: 'Microsoft Access cannot add a digital signature to your file
because Access cannot gain exclusive access to the file. @Make sure no other
person or program has the file open and try to add the digital signature
again.@@1@@@2'

Access 2003+

10969

For the Medium or High macro security levels to function properly, your
computer must also be configured to block unsafe expressions.@Blocking
unsafe expressions affects all users on this computer.@Do you want to block
unsafe expressions?@21@553714182@2 Access 2007+ uses different
description: ''

Access 2003

10970

Unsafe expressions are blocked. You can configure your computer to allow all
expressions to be evaluated.@Allowing all expressions to be evaluated affects
all users on this computer.@Do you want to allow the evaluation of potentially
unsafe expressions?@22@553714182@2 Access 2007+ uses different
description: ''

Access 2003

10971

Security Warning: Unsafe expressions are not blocked.@To block unsafe
expressions, Microsoft Jet 4.0 Service Pack 8 or later must be installed. To get
the latest version of Jet 4.0, go to http://windowsupdate.microsoft.com.@'|' may
not be safe to open if it contains expressions that were intended to harm your
computer. Do you want to open this file?@20@553714182@2 Access 2007+
uses different description: ''

Access 2003



10972
Security Warning: Unsafe expressions are not blocked.@Do you want to block
unsafe expressions?@@21@553714182@2 Access 2007+ uses different
description: ''

Access 2003

10973
'|' cannot be opened because you must restart the application for the new
security level to take effect.@@@1@553714182@1 Access 2007+ uses
different description: ''

Access 2003

10974
Modifications to the database or project have invalidated the associated digital
signature.@This may require you to make a trust decision the next time you
open the database or project. @@2@1@553714150@1

Access 2007+

13000
Switching fields will lose rule changes that have not been applied.�Continue
and &Discard Changes�Continue and &Apply
Changes�Cancel@@@28@@@1

Access 2010+

13001 Publishing an application will unencrypt your data and remove the database
password. Do you want to continue? Access 2010+

13002 Unable to create or send email for collecting data. Outlook is not configured to
collect data via email; please contact your system administrator. Access 2010+

13003 Access cannot perform the export operation. Verify that the export table and
related tables have numeric primary keys. Access 2010+

13004 The Force New Page property cannot be changed on Web reports that contain
multiple columns. Access 2010+

13005 Microsoft Access is unable to link to list '|1'. The list is not a standard
SharePoint list.@@@1@@@3 Access 2010+

13006 Microsoft Access was unable to connect to the Web application because your
Internet settings are configured to Work Offline. Access 2010+

Error Code Error Description Supported Versions
13007 The site '|' was not found. Access 2010+
13008 The server is busy. Try again later. Access 2010+
13009 Web queries support only the Select query type. Access 2010+

13010 Web queries must have relationships between all tables. Add relationships or
remove the tables that you do not need. Access 2010+

13011 The alias name specified is not valid for Web queries. Please ensure the name
does not contain special characters and is not longer than 64 characters. Access 2010+

13012 Web queries cannot sort or filter on complex data columns. Access 2010+

13013 Microsoft Access was unable to publish the database because your Internet
settings are configured to Work Offline. Access 2010+

13014 The SetOrderBy action cannot sort on the '|' field. Access 2010+

13015
Local variable names must be less than or equal to 64 characters in length, may
not start with an equal sign or a space, and may not contain any of the
following characters including CR, LF or TAB: .![]/:*?""<>|#{}%~&.

Access 2010+

13016 '|' is not in the list of sites your administrator has allowed for publishing or
syncing Access Services applications. Access 2010+

13017 This expression was last modified using another design environment and
contains an unsupported function. The expression cannot be modified here. Access 2010+

13018
An error occurred when trying to save the database as a template because the
table '|1' could not be exported to a Web compatible format.Run the
Compatibility Checker, fix any reported issues, then try again.

Access 2010+

13019 Data bars are supported only for tables and named queries. Access 2010+

13020 This action will delete the template from your hard drive. Do you want to
continue? Access 2010+

13021 Your template has been successfully saved in '|' Access 2013+ uses different
description: 'Your template has been successfully saved as '|'' Access 2010+



13022 This database was created with the 64-bit version of Microsoft Access. Please
open it with the 64-bit version of Microsoft Access. Access 2010+

13023 This database was created with the 32-bit version of Microsoft Access. Please
open it with the 32-bit version of Microsoft Access. Access 2010+

13024
Network connectivity was lost while changing caching mode. Some tables may
not have changed modes. You will be prompted to change modes again next
time your database is closed and opened.

Access 2010+

13025

All data changes made in disconnected tables will be permanently
discarded.@If you discard your changes, you will automatically be reconnected
to the SharePoint site if a connection exists.@Do you want to continue?
@3@@@1

Access 2010+

13026

This macro appears to have been changed in an older version of Access. Do you
want to convert the macro to a format compatible with Access 2010? You may
lose the current macro formatting. If you would like to keep the formatting and
potentially lose changes made in the older version select 'No'. Access 2013 uses
different description: 'This macro appears to have been changed in an older
version of Access. Do you want to convert the macro to a format compatible
with Access 2013? You may lose the current macro formatting. If you would
like to keep the formatting and potentially lose changes made in the older
version select 'No'.' Access 2016 uses different description: 'This macro
appears to have been changed in an older version of Access. Do you want to
convert the macro to a format compatible with Access 2016? You may lose the
current macro formatting. If you would like to keep the formatting and
potentially lose changes made in the older version select 'No'.'

Access 2010+

Error Code Error Description Supported Versions

13027 In a Web form, if the Inherit Value List property is false, then the Allow Value
List Edits property must also be false. Access 2010+

13028 The SetProperty macro action cannot set the Value property on the '|' control. Access 2010+

13029 The SetProperty macro action cannot set the Value property because the
solution contains links to external data and the database is not trusted. Access 2010+

13030 The RunDataMacro macro action failed because the solution contains links to
external data and the database is not trusted. Access 2010+

13031

The lookup field was not created. The database engine could not lock the table
'|1' because it is already in use by another person or process. Verify that the
table '|1' and the forms, queries, and reports that use it are closed before creating
this lookup field.

Access 2010+

13032

Your change to the data integrity was not saved. The database engine could not
lock the table '|1' because it is already in use by another person or process.
Verify that the table '|1' and the forms, queries, and reports that use it are closed
before making this change.

Access 2010+

13033 The '|' link is used by Microsoft Access to maintain your Web application. It
may not be deleted or renamed. Access 2010+

13034 Created a local copy of '|2' at '|1'. Access 2010+
13035 The control '|' cannot be used in Web reports because it uses padding. Access 2010+
13036 Either the Web location or application name entered was invalid. Access 2010+

13037

Operation did not succeed. Some table properties and data macros could not be
saved because there is not a connection to a SharePoint site. To ensure that the
properties and macros are saved, restore the connection to the SharePoint site.
Data macros can be copied to the Clipboard and pasted back into the macro
designer when the connection is restored.

Access 2010+

13038 Only form, report, or query Web objects can be saved as client objects. Access 2010+

13039 Only ACCDB files that are not yet Web databases can be prepared for Web
publish. Access 2010+



13040 Microsoft Access encountered an error while checking the database '|' for Web
compatibility.@The conversion failed.@@1@@@1 Access 2010+

13041

Any data changes made while your application was disconnected from the
server will be discarded when the database is closed. To save these changes,
click the Cancel button and reconnect with the server. Do you want to continue
to close the database and discard your data?

Access 2010+

13042 The server returned a response that Microsoft Access was unable to understand.
Please contact your server administrator. Access 2010+

13043
The table '|' is in use and cannot be converted to a local table. Close open
objects that may have dependencies on this table and ensure no other user has it
open.

Access 2010+

13044 The Outlook task could not be created. Access 2010+
13045 The maximum number of nesting levels has been reached. Access 2010+

13046 The '|1' argument value is not valid for the macro action '|2'.@A Macro with
parameters cannot be an error handler.@@1@@@1 Access 2010+

Error Code Error Description Supported Versions

13047 This property cannot be changed because one or more of the tab pages contains
a shared or linked image. Access 2010+

13048 The Unique property could not be set on the table because duplicate values
exist in the field. Remove the duplicate values and try again. Access 2010+

13049 Microsoft Access cannot export your object to the database you have selected.
Please select a different database or a different object to export. Access 2010+

13050
Microsoft Access cannot import the selected objects into the current database
because one or more of them are not web compatible. Fix the compatibility
errors and try again, or select different objects to import.

Access 2010+

13051

Microsoft Access cannot export the objects to the selected database because one
or more of them are not web compatible.@A log table containing the errors
encountered can be found in the database to which the export was
attempted.@Fix the compatibility errors and try again, or select different
objects to export.@1@@@1

Access 2010+

13052 Object must be open. Access 2010+
13053 Object not found. Access 2010+
13054 Object not supported. Access 2010+
13055 The value of a Display Form property was invalid and was not saved. Access 2010+

13056
Web queries may not have more than one join between the same two
tables.@Extra joins must be removed from this query.@Changes to the joins in
the query will not affect table relationships.@1@@@1

Access 2010+

13057 You can't delete the '|1' field. This field is used to identify and store the rows in
your table. Access 2010+

13058 The data macro did not run because the table is not on the server. Synchronize
the application with the server and then run the data macro. Access 2010+

13059 The lookup field was not created. At least one value is needed for a value list. Access 2010+

13060 Only Web databases may be published to Access Services. Run ""Prepare for
Web"" on this database first. Access 2010+

13061 The Web location you specified does not support Access Services. Access 2010+

13062 The data type cannot change on a field that is indexed. Consider setting the
index property to false before changing the data type. Access 2010+

13063 The Submacro with same name already exists. Enter a different name. Access 2010+
13064 Cannot convert the expression '|' for use on the Web. Access 2010+
13065 The table is too large for this change to be saved. Access 2010+
13066 The change could not be saved to the server. Access 2010+
Error Code Error Description Supported Versions



13067 A timeout prevented the change from saving to the server. Access 2010+

13068 Fields of type Memo, Binary and Lookup cannot be used in a validation rule for
Web tables. Access 2010+

13069
Renaming the table failed because there is not a connection to a SharePoint site.
Restore the connection to the SharePoint site, synchronize the application with
the server, and try the rename operation again.

Access 2010+

13070 The expression that you entered is not valid for Web-compatible default values. Access 2010+

13071 The expression that you entered is not valid for Web-compatible table
validation rules. Access 2010+

13072 The expression that you entered is not valid for Web-compatible field validation
rules. Access 2010+

13073 The expression that you entered is not valid for Web-compatible forms. Access 2010+
13074 The expression that you entered is not valid for Web-compatible reports. Access 2010+
13075 The expression that you entered is not valid for Web-compatible macros. Access 2010+
13076 The expression that you entered is not valid for Web-compatible databases. Access 2010+
13077 The expression that you entered is not valid for Web-compatible data macros. Access 2010+

13078 The expression that you entered is not valid for Web-compatible calculated
columns. Access 2010+

13079 This template contains client-only information and may not be imported into a
Web database. Access 2010+

13080 LoadFromAXL is not available when you have disconnected tables.Please
reconnect all of your tables before attempting to use LoadFromAXL. Access 2010+

13081 The |2 database was not synced because the site '|1' is unavailable. Access 2010+

13082 The update to the field did not complete because a dependent form, query, or
report is open. Synchronize with the server to complete the update. Access 2010+

13083 The server '|' does not support Access Services. Access 2010+
13084 The VBA project is password-protected. Access 2010+

13085
You can't delete the table '|'; it is participating in one or more relationships.@If
you want to delete this table, first delete any lookups in this table or that
reference this table.@@1@@@1

Access 2010+

13086 Lookup field '|1' contains values that do not exist in the related table '|2'. Access 2010+
Error Code Error Description Supported Versions

13087 The RunDataMacro action failed to invoke a data macro on the server. Please
check your connectivity to the server. Access 2010+

13088 Unable to insert control. The selected control is not valid in web reports. Access 2010+
13089 The object cannot be imported because the database is read-only. Access 2010+

13090 The table '|' cannot be converted to a local table because it is not web
compatible. Fix the compatibility errors and try again. Access 2010+

13091 The server requires lookup fields with data integrity to be indexed. Access 2010+
13092 Close and reopen the table to see the changes. Access 2010+

13093 One or more web compatibility issues were found. The issues are listed in table
'|1'. Access 2010+

13094 There was an error evaluating web compatibility. Any compatibility issues
found before the error are listed in table '|1'. Access 2010+

13095

This template's objects are saved in a format that is no longer supported by
Access 2010.Open the template in an older version to view its contents. Access
2013 uses different description: 'This template's objects are saved in a format
that is no longer supported by Access 2013.Open the template in an older
version to view its contents.' Access 2016 uses different description: 'This
template's objects are saved in a format that is no longer supported by Access
2016.Open the template in an older version to view its contents.'

Access 2010+



13096 This template's objects are saved in a format that requires a newer version of
Access. Access 2010+

13097

'|' did not respond. Either the server does not exist, Microsoft Access Services
are not enabled on the server, or the server is using an older version of
Microsoft Access Services that is not compatible with Access 2010. Access
2013+ uses different description: ''|' did not respond. Either the server does
not exist, Microsoft Access Services are not enabled on the server, or the server
is using an incompatible version of Microsoft Access Services.'

Access 2010+

13098
The version of Microsoft Access Services installed on the server '|' is a newer
version that is not compatible with the version of Microsoft Access you are
using.You must upgrade Microsoft Access in order to publish to it.

Access 2010+

13099 Your application was not upgraded to the current version of Microsoft
Access.Try again by selecting the Upgrade button. Access 2010+

13100
This table already has the maximum number of fields with the same data type
as '|'. For the purposes of this calculation, Number and Currency are considered
the same data type.

Access 2010+

13101 Microsoft Access was unable to close database objects. @Please close all
opened database objects before trying again.@@1@@@1 Access 2010+

13102 Microsoft Access cannot reconnect one or more of the disconnected tables.
Please check network connectivity and server availability. Access 2010+

13103 The validation rule contains a syntax error and cannot be saved. A field or
function may be misspelled or missing. Access 2010+

13104 Unable to insert control. The selected control is not valid in reports. Access 2010+

13105

The form or report has run out of memory. New macros cannot be added to the
object. Please convert the embedded macros on the object into standalone
macros and call them from the embedded macro using the RunMacro macro
action.

Access 2010+

13106

Table properties and data macros could not be saved because the application
has changed on the server.@Synchronize with the server before making
changes.@To save your current data, copy and paste your last entered row to
another file. Data macros can be copied to the Clipboard and pasted back into
the macro designer once you have synchronized.@1@@@1

Access 2010+

Error Code Error Description Supported Versions

13107
An error has occurred in an AfterDelete data macro. The delete which triggered
the event completed successfully. Please check in the USysApplicationLog
table for more details.@@@1@@@1

Access 2010+

13108

This template may contain potentially harmful content that will run on creation.
If you trust the contents of this template and would like to enable it, click Yes.
Access 2013+ uses different description: 'This template wants to run a form
after being imported. Do you trust the code in this form?'

Access 2010+

13109 The OpenReport macro action does not support passing query parameters to the
report when the View argument is set to Print. Access 2010+

13110 This operation is not supported for Microsoft SQL Server 2008 and later. Access 2010+

13111

Referential integrity cannot be enforced between linked tables and local
tables.@Enforcement of referential integrity will be dropped on all
relationships between tables converted to local and tables that remain as
links.@@5@1@6013@1

Access 2010+

13112

Web compatibility errors prevented the upgrade from succeeding.@Your
application has been restored to its pre-upgrade state.@To complete the
upgrade, you must make a local copy of your application, resolve the
compatibility errors, and republish your application to a different
site.@1@@@1

Access 2010+

13113 The upgrade operation was cancelled.@Your application has been restored to
its pre-upgrade state and will remain read-only. Save a local copy of your

Access 2010+



application to make changes.@@1@@@1

13114

Your application was not upgraded to the current version of Microsoft
Access.@Your application has been restored to its pre-upgrade state and will
remain read-only.@You can try again by selecting the Upgrade button, or save
a local copy of your application to continue working with it.@1@@@1

Access 2010+

13115
Your application was successfully upgraded to the current version of Microsoft
Access.@A local backup copy of your application has been saved in
'|1'.@@1@@@1

Access 2010+

13116 Your application was successfully upgraded to the current version of Microsoft
Access. Access 2010+

13117 Microsoft Access was unable to retrieve data for one or more tables on the
server. Some data may be missing or out of date. Access 2010+

13118 The column '|1' cannot be changed or deleted because a calculated field or
record validation rule depends on it. Access 2010+

13119

Your data macro changes could not be saved because someone else has
modified the data macros of this table.@To save your changes and overwrite
the other user's changes, click ""Overwrite"".@If you click Cancel, you can re-
enter the macro designer and copy your changes to the Clipboard, then
synchronize with the server, enter the macro designer again and paste your
changes back in.�&Overwrite�Cancel@36@@@2

Access 2010+

13120 The '|' action requires a valid control name that corresponds to a
subform.@@@1@@@1 Access 2010+

13121 The |1 event is not available for controls on datasheet Web forms. Access 2010+

13122

This form or report contains changes that are incompatible with the current
database format. The form or report was not saved.@In order to save your
changes, you must remove any layouts that have empty cells in them and/or set
the HasModule property for the form or report to No.@@1@@@1

Access 2010+

13123 The length must be greater than 0 and less than or equal to
4000.@@@1@@@2 Access 2013+

13124 The field cannot be indexed if its length is greater than 220
characters.@@@1@@@2 Access 2013+

13125 The table must have a primary key.@@@1@@@2 Access 2013+
13126 This field cannot be changed or removed.@@@1@@@2 Access 2013+
Error Code Error Description Supported Versions
13127 Only Select type queries are supported. Access 2013+

13128 Queries must have relationships between all tables. Add relationships or
remove the tables that you do not need. Access 2013+

13129 The alias name specified is not valid. Please ensure the name does not contain
special characters and is not longer than 64 characters. Access 2013+

13130 Do you want to permanently delete all of the selected objects?@If you click
Yes, you won't be able to undo the deletion.@@20@@@2 Access 2013+

13131 The value for Title is required. Access 2013+

13132 Can't open this application because it contains information that is not in a
recognized format. Please contact your systems administrator. Access 2013+

13133 The expression you entered uses a function that is not valid in the given
context. Access 2013+

13134 The |1 property cannot be edited. Access 2013+
13135 Access Data Projects are no longer supported in this version of Access. Access 2013+

13136 '|1' can't be saved because someone else has made changes to it.�Save
As...�Discard Changes@@@27@@@ Access 2013+

13137 '|1' can't be renamed because someone else has made changes to it. Access 2013+
13138 '|1' can't be deleted because someone else has made changes to it. Access 2013+



13139 The calculated field '|1' cannot be saved without a valid expression. Access 2013+

13140
The application has been upgraded to a newer version on the server.@You will
not be able to modify the application until you reload it.@Would you like to
reload the application now?@20@@@2

Access 2013+

13141 This database was created with the ARM version of Microsoft Access. Please
open it with the ARM version of Microsoft Access. Access 2013+

13142
Export to the chosen Microsoft Access app is not supported. If you are
attempting to export data from tables or queries, open the Microsoft Access app
and use Import.

Access 2013+

13143 Microsoft Access failed to change the theme to |1.@|2@Try again, or contact
your administrator if the error persists.@1@@@2 Access 2013+

13144 The primary key can have only one field.@Please delete the additional fields or
specify an index name to create a new index.@@1@@@2 Access 2013+

13145 The table definition is not in a format that is recognized by Microsoft
Access.@You will not be able to create this table.@@1@@@2 Access 2013+

13146
Sorry, an unexpected error occurred. Please exit and restart Microsoft
Access.@If you've made recent design changes, please save your work before
you exit.@@3@@@1

Access 2013+

Error Code Error Description Supported Versions
13147 This field must have a default value. Access 2013+

13148 There are pending changes in the open table. Closing this table may discard
those changes.@@@3@@@1 Access 2013+

13149 A data type must be specified for parameters.@Please select a valid data type
for each parameter.@@1@@@2 Access 2013+

13150
An error occurred while attempting to connect to the server '|1' or the server
took too long to respond.@Please try the operation again or contact your
system administrator or technical support.@HTTP Status Code: '|2'.@1@@@2

Access 2013+

13151
An error occurred while attempting to connect to the server '|1'.@Check the
spelling of the server name. If it is correct, please contact your system
administrator or technical support.@HTTP Status Code: '|2'.@1@@@2

Access 2013+

13152

An error occurred while attempting to connect to the server '|1'.@Check the
spelling of the server name. If you typed a web location starting with http:, try
https: instead. If everything looks correct, please contact your system
administrator or technical support.@HTTP Status Code: '|2'.@1@@@2

Access 2013+

13153
An error occurred in the client while attempting to communicate with the server
'|1'.@Please contact your system administrator or technical
support.@@1@@@2

Access 2013+

13154
An error occurred while communicating with the server '|1'.@Please contact
your system administrator or technical support.@HTTP Status Code:
'|2'.@1@@@2

Access 2013+

13155

To complete this operation, Microsoft Access must modify the RecordSource
property of the current view.@Microsoft Access will create a new query and
embed it directly into the view's RecordSource property.The view will no
longer be based on the '|' query.@Do you want to accept this change?
@19@@@2

Access 2013+

13156 Sorry, we can't import your data this way. Please select Other Data (ODBC)
instead. Access 2013+

13157 You can't delete the table '|1'. There are lookups in the following tables that
reference it. These lookups must be changed or deleted first. |2 Access 2013+

13158 Sorry, Microsoft Access cannot open this web application in runtime mode. Access 2013+

13159
The server '|1' doesn't support this feature. This is supported in a newer server
version. Access 2016+ uses different description: 'Sorry, this feature isn��t
available on the server '|1'. The feature requires a newer version of SharePoint.'

Access 2013+



13160
The value for Version is required. Access 2016+ uses different description:
'Microsoft Access cannot create the reports database right now because your
computer setup requires that you manually disable IPv6.'

Access 2013+

13161
The name '|1' is reserved for the On Deploy macro and can't be used as a name
for other objects.@Please choose another name.@@1@@@1 Access 2016+
uses different description: 'The value for Version is required.'

Access 2013+

13162 The name '|1' is reserved for the On Deploy macro and can't be used as a name
for other objects.@Please choose another name.@@1@@@1 Access 2016+

29000

There isn't enough memory to create an input area.@Close unneeded programs.
Then try to create the input area again. For more information on freeing
memory, search the Microsoft Windows Help index for 'memory,
troubleshooting'.@@1@@1 Access 2007+ uses different description: 'There
isn't enough memory to create an input area.@Close unneeded programs. Then
try to create the input area again. For more information on freeing memory,
search the Microsoft Windows Help index for 'memory,
troubleshooting'.@@1@@@1'

Access 2003+

29001

Microsoft Office Access failed to save module '|.'@Your computer may be low
on disk space. For information on freeing memory or disk space, search the
Microsoft Windows Help index for 'memory, troubleshooting' or 'disk space,
freeing'.@@1@@3 Access 2007+ uses different description: 'Microsoft
Office Access failed to save module '|.'@Your computer may be low on disk
space. For information on freeing memory or disk space, search the Microsoft
Windows Help index for 'memory, troubleshooting' or 'disk space,
freeing'.@@1@@@3' Access 2010+ uses different description: 'Microsoft
Access failed to save module '|1.'@Your computer may be low on disk space.
For information on freeing memory or disk space, search the Microsoft
Windows Help index for 'memory, troubleshooting' or 'disk space,
freeing'.@@1@@@3'

Access 2003+

29002

Microsoft Office Access failed to create the Visual Basic module '|.'@If your
database is on a network drive, check your network connection, and then try
again.@@1@@1 Access 2007+ uses different description: 'Microsoft Office
Access failed to create the Visual Basic module '|.'@If your database is on a
network drive, check your network connection, and then try
again.@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access failed to create the Visual Basic module '|1.'@If your database is on a
network drive, check your network connection, and then try
again.@@1@@@1'

Access 2003+

29003

Microsoft Office Access failed to convert or enable your code modules.@Your
computer may be low on disk space or memory.@@1@@1 Access 2007+ uses
different description: 'Microsoft Office Access failed to convert or enable
your code modules.@Your computer may be low on disk space or
memory.@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access failed to convert or enable your code modules.@Your computer may be
low on disk space or memory.@@1@@@1'

Access 2003+

Error Code Error Description Supported Versions

29004
The new procedure name you provided is invalid.@@@2@611738@1 Access
2007+ uses different description: 'The new procedure name you provided is
invalid.@@@2@1@11738@1'

Access 2003+

29005
The procedure '|' already exists.@Choose another procedure name.@@1@@1
Access 2007+ uses different description: 'The procedure '|' already
exists.@Choose another procedure name.@@1@@@1'

Access 2003+

29006 Microsoft Office Access failed to create a Debug window toolbar.@The system
may be out of resource memory.@Close unneeded programs and try again. For
more information on freeing memory, search the Microsoft Windows Help
index for 'memory, troubleshooting'.@1@@1 Access 2007+ uses different
description: 'Microsoft Office Access failed to create a Debug window

Access 2003+



toolbar.@The system may be out of resource memory.@Close unneeded
programs and try again. For more information on freeing memory, search the
Microsoft Windows Help index for 'memory, troubleshooting'.@1@@@1'
Access 2010+ uses different description: 'Microsoft Access failed to create a
Debug window toolbar.@The system may be out of resource memory.@Close
unneeded programs and try again. For more information on freeing memory,
search the Microsoft Windows Help index for 'memory,
troubleshooting'.@1@@@1'

29007

During the paste or import operation, Microsoft Office Access failed to convert
the '|' module from an earlier version of a Microsoft Office Access
database.@Your computer may be low on disk space or memory.@@1@@1
Access 2007+ uses different description: 'During the paste or import
operation, Microsoft Office Access failed to convert the '|' module from an
earlier version of a Microsoft Office Access database.@Your computer may be
low on disk space or memory.@@1@@@1' Access 2010+ uses different
description: 'During the paste or import operation, Microsoft Access failed to
convert the '|1' module from an earlier version of a Microsoft Access
database.@Your computer may be low on disk space or memory.@@1@@@1'

Access 2003+

29008

Microsoft Office Access couldn't create storage space for a Visual Basic
module.@If your database is on a network drive, check your network
connection, and then try again.@@1@@3 Access 2007+ uses different
description: 'Microsoft Office Access couldn't create storage space for a Visual
Basic module.@If your database is on a network drive, check your network
connection, and then try again.@@1@@@3' Access 2010+ uses different
description: 'Microsoft Access couldn't create storage space for a Visual Basic
module.@If your database is on a network drive, check your network
connection, and then try again.@@1@@@3'

Access 2003+

29009

Microsoft Office Access couldn't open the storage space for a Visual Basic
module.@Your computer may be low on disk space. For information on freeing
memory or disk space, search the Microsoft Windows Help index for 'memory,
troubleshooting' or 'disk space, freeing'.@@1@@3 Access 2007+ uses
different description: 'Microsoft Office Access couldn't open the storage space
for a Visual Basic module.@Your computer may be low on disk space. For
information on freeing memory or disk space, search the Microsoft Windows
Help index for 'memory, troubleshooting' or 'disk space, freeing'.@@1@@@3'
Access 2010+ uses different description: 'Microsoft Access couldn't open the
storage space for a Visual Basic module.@Your computer may be low on disk
space. For information on freeing memory or disk space, search the Microsoft
Windows Help index for 'memory, troubleshooting' or 'disk space,
freeing'.@@1@@@3'

Access 2003+

29010

The function name is too long.@Microsoft Office Access will truncate the
function name to 255 characters.@@1@411738@1 Access 2007+ uses
different description: 'The function name is too long.@Microsoft Office
Access will truncate the function name to 255 characters.@@1@1@11738@1'
Access 2010+ uses different description: 'The function name is too
long.@Microsoft Access will truncate the function name to 255
characters.@@1@1@11738@1'

Access 2003+

29011 Microsoft Office Access failed to save the database.@Your computer may be
low on disk space. For information on freeing memory or disk space, search the
Microsoft Windows Help index for 'memory, troubleshooting' or 'disk space,
freeing'.@@1@@3 Access 2007+ uses different description: 'Microsoft
Office Access failed to save the database.@Your computer may be low on disk
space. For information on freeing memory or disk space, search the Microsoft
Windows Help index for 'memory, troubleshooting' or 'disk space,
freeing'.@@1@@@3' Access 2010+ uses different description: 'Microsoft
Access failed to save the database.@Your computer may be low on disk space.
For information on freeing memory or disk space, search the Microsoft

Access 2003+



Windows Help index for 'memory, troubleshooting' or 'disk space,
freeing'.@@1@@@3'

29013

This action will reset the current code in break mode.@Do you want to stop the
running code?@* To halt the execution of the program so the Module window
can be closed, select Yes. * To leave the code in the current state, select
No.@20@@1 Access 2007+ uses different description: 'This action will reset
the current code in break mode.@Do you want to stop the running code?@* To
halt the execution of the program so the Module window can be closed, select
Yes. * To leave the code in the current state, select No.@20@@@1'

Access 2003+

29014

You can't add a reference to a Microsoft Office Access
workgroup.@@@2@613780@1 Access 2007+ uses different description:
'You can't add a reference to a Microsoft Office Access
workgroup.@@@2@1@13780@1' Access 2010+ uses different description:
'You can't add a reference to a Microsoft Access
workgroup.@@@2@1@13780@1'

Access 2003+

29015

You can't remove this reference.@Microsoft Office Access needs this reference
in order to work properly.@@1@@1 Access 2007+ uses different
description: 'You can't remove this reference.@Microsoft Office Access needs
this reference in order to work properly.@@1@@@1' Access 2010+ uses
different description: 'You can't remove this reference.@Microsoft Access
needs this reference in order to work properly.@@1@@@1'

Access 2003+

29016
You can't add a reference to the open database.@@@1@@1 Access 2007+
uses different description: 'You can't add a reference to the open
database.@@@1@@@1'

Access 2003+

29017

The database | was created in an earlier version of Microsoft Office
Access.@Convert this database to the current version of Microsoft Office
Access by using the Convert Database command on the Tools menu (Database
Utilities submenu).@@1@@1 Access 2007+ uses different description: 'The
database | was created in an earlier version of Microsoft Office
Access.@Convert this database to the current version of Microsoft Office
Access by using the Convert Database command on the Tools menu (Database
Utilities submenu).@@1@@@1' Access 2010+ uses different description:
'The database |1 was created in an earlier version of Microsoft
Access.@Convert this database to the current version of Microsoft Access by
using the Convert Database command on the Tools menu (Database Utilities
submenu).@@1@@@1'

Access 2003+

29018
You can't use a standard module for this operation.@@@1@@1 Access 2007+
uses different description: 'You can't use a standard module for this
operation.@@@1@@@1'

Access 2003+

29019

The module name '|' is invalid.@* The module name may start with the prefix
Form_ or Report_. * The module can't be named Forms, Reports, Modules,
Application, Screen, Assistant, CommandBars, References, or DoCmd. * The
module name may have too many characters.@@2@611734@1 Access 2007+
uses different description: 'The module name '|' is invalid.@* The module
name may start with the prefix Form_ or Report_. * The module can't be named
Forms, Reports, Modules, Application, Screen, Assistant, CommandBars,
References, or DoCmd. * The module name may have too many
characters.@@2@1@11734@1'

Access 2003+

29020

Another user has modified this database.@To see the current version, close the
database and open it again.@@1@@1 Access 2007+ uses different
description: 'Another user has modified this database.@To see the current
version, close the database and open it again.@@1@@@1'

Access 2003+

29021 This operation isn't available while there is a module in break mode.@Reset the
executing code and try the operation again.@@1@@1 Access 2007+ uses
different description: 'This operation isn't available while there is a module in

Access 2003+



break mode.@Reset the executing code and try the operation
again.@@1@@@1'

29022

There were compilation errors during the conversion or enabling of this
database.@The database has not been saved in a compiled state. The
performance of this database will be impaired because Microsoft Office Access
will need to recompile the database for each session. For information on
improving performance, click Help.@@2@611705@1 Access 2007+ uses
different description: 'There were compilation errors during the conversion or
enabling of this database.@The database has not been saved in a compiled
state. The performance of this database will be impaired because Microsoft
Office Access will need to recompile the database for each session. For
information on improving performance, click Help.@@2@1@11705@1'
Access 2010+ uses different description: 'There were compilation errors
during the conversion or enabling of this database.@The database has not been
saved in a compiled state. The performance of this database will be impaired
because Microsoft Access will need to recompile the database for each session.
For information on improving performance, click Help.@@2@1@11705@1'

Access 2003+

29023

There are calls to 16-bit dynamic-link libraries (.dll) in modules in this
database.@These won't work under Microsoft Windows 95 or Microsoft
Windows NT.@Change your code to call equivalent 32-bit dynamic-link
libraries (.dll).@2@611961@1 Access 2007+ uses different description:
'There are calls to 16-bit dynamic-link libraries (.dll) in modules in this
database.@These won't work under Microsoft Windows 95 or Microsoft
Windows NT.@Change your code to call equivalent 32-bit dynamic-link
libraries (.dll).@2@1@11961@1'

Access 2003+

29024

The current user account doesn't have permission to convert or enable this
database.@To convert or enable a database, ensure the following: * You must
join the workgroup that defines the user accounts used to access the database. *
Your user account must have Open/Run and Open Exclusive permissions for
the database object. * Your user account must have Modify Design or
Administer permissions for all tables in the database, or it must be the owner of
all tables in the database. * Your user account must have Read Design
permission for all objects in the database. * Request that other users close the
database.@@2@77316@ Access 2007+ uses different description: 'The
current user account doesn't have permission to convert or enable this
database.@To convert or enable a database, ensure the following: * You must
join the workgroup that defines the user accounts used to access the database. *
Your user account must have Open/Run and Open Exclusive permissions for
the database object. * Your user account must have Modify Design or
Administer permissions for all tables in the database, or it must be the owner of
all tables in the database. * Your user account must have Read Design
permission for all objects in the database. * Request that other users close the
database.@@2@2@77316@'

Access 2003+

Error Code Error Description Supported Versions

29025

There are calls to 16-bit dynamic-link libraries (.dll) in modules in this
database.@These won't work under Microsoft Windows 95 or Microsoft
Windows NT.@Translate these calls to equivalent 32-bit dynamic-link
libraries.@2@611961@ Access 2007+ uses different description: 'There are
calls to 16-bit dynamic-link libraries (.dll) in modules in this database.@These
won't work under Microsoft Windows 95 or Microsoft Windows
NT.@Translate these calls to equivalent 32-bit dynamic-link
libraries.@2@1@11961@'

Access 2003+

29026 The database that you are trying to open or convert is currently in use, or you
do not have permission to open it exclusively.@When you convert a database,
or the first time you open an earlier version database, another user can't have
the database open.@Try one of the following: * Request that other users close
the database. * Using the version of Microsoft Office Access in which the

Access 2003+



database is written, have your workgroup administrator grant you the
permission to open the database exclusively. Multiple users can share the
database after you convert it, or after you open it for the first
time.@1@109027@1 Access 2007+ uses different description: 'The database
that you are trying to open or convert is currently in use, or you do not have
permission to open it exclusively.@When you convert a database, or the first
time you open an earlier version database, another user can't have the database
open.@Try one of the following: * Request that other users close the database.
* Using the version of Microsoft Office Access in which the database is written,
have your workgroup administrator grant you the permission to open the
database exclusively. Multiple users can share the database after you convert it,
or after you open it for the first time.@1@1@9027@1' Access 2010+ uses
different description: 'The database that you are trying to open or convert is
currently in use, or you do not have permission to open it exclusively.@When
you convert a database, or the first time you open an earlier version database,
another user can't have the database open.@Try one of the following: * Request
that other users close the database. * Using the version of Microsoft Access in
which the database is written, have your workgroup administrator grant you the
permission to open the database exclusively. Multiple users can share the
database after you convert it, or after you open it for the first
time.@1@1@9027@1'

29027

Microsoft Office Access was unable to save the project.@Another user is
saving the project now. Do you want to retry?@@23@@1 Access 2007+ uses
different description: 'Microsoft Office Access was unable to save the
project.@Another user is saving the project now. Do you want to retry?
@@23@@@1' Access 2010+ uses different description: 'Microsoft Access
was unable to save the project.@Another user is saving the project now. Do you
want to retry?@@23@@@1'

Access 2003+

29028 The Save operation failed.@@@1@@1 Access 2007+ uses different
description: 'The Save operation failed.@@@1@@@1' Access 2003+

29029

You are trying to open a read-only database.@The first time you open an earlier
version database, you must be able to write changes to the database. * The
database file's read-only attribute may be set; clear this attribute. * You may
have chosen the Open Read Only command in the Open dialog box. Don't
choose this command the first time you open the database. * Your license to use
this application may have expired.@@1@@1 Access 2007+ uses different
description: 'You are trying to open a read-only database.@The first time you
open an earlier version database, you must be able to write changes to the
database. * The database file's read-only attribute may be set; clear this
attribute. * You may have chosen the Open Read Only command in the Open
dialog box. Don't choose this command the first time you open the database. *
Your license to use this application may have expired.@@1@@@1'

Access 2003+

29030

Microsoft Office Access can't establish a reference to the specified
database.@The referenced database can't be found, or it's locked exclusively by
another user so it can't be opened.@Restore the referenced database from a
backup copy or ask the user that has the database locked to open the database in
nonexclusive mode.@1@@1 Access 2007+ uses different description:
'Microsoft Office Access can't establish a reference to the specified
database.@The referenced database can't be found, or it's locked exclusively by
another user so it can't be opened.@Restore the referenced database from a
backup copy or ask the user that has the database locked to open the database in
nonexclusive mode.@1@@@1' Access 2010+ uses different description:
'Microsoft Access can't establish a reference to the specified database.@The
referenced database can't be found, or it's locked exclusively by another user so
it can't be opened.@Restore the referenced database from a backup copy or ask
the user that has the database locked to open the database in nonexclusive
mode.@1@@@1'

Access 2003+



29031

Microsoft Office Access can't create or open the requested database now.@The
database may be locked exclusively by another user.@@1@@1 Access 2007+
uses different description: 'Microsoft Office Access can't create or open the
requested database now.@The database may be locked exclusively by another
user.@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access can't create or open the requested database now.@The database may be
locked exclusively by another user.@@1@@@1'

Access 2003+

29032

The '|' moduleis open; Microsoft Office Access can't set the permissions on an
open module.@@@1@@1 Access 2007+ uses different description: 'The '|'
moduleis open; Microsoft Office Access can't set the permissions on an open
module.@@@1@@@1' Access 2010+ uses different description: 'The '|1'
module is open; Microsoft Access can't set the permissions on an open
module.@@@1@@@1'

Access 2003+

29033

Microsoft Office Access can't add references to a replicated database; changes
will be ignored.@@@1@@1 Access 2007+ uses different description:
'Microsoft Office Access can't add references to a replicated database; changes
will be ignored.@@@1@@@1' Access 2010+ uses different description:
'Microsoft Access can't add references to a replicated database; changes will be
ignored.@@@1@@@1'

Access 2003+

29034

Microsoft Office Access is unable to import the module from the source
replica.@Synchronize the source database.@@1@@1 Access 2007+ uses
different description: 'Microsoft Office Access is unable to import the module
from the source replica.@Synchronize the source database.@@1@@@1'
Access 2010+ uses different description: 'Microsoft Access is unable to
import the module from the source replica.@Synchronize the source
database.@@1@@@1'

Access 2003+

29040

Microsoft Office Access is currently unable to rename the form, report, or
module to '|'.@Close the database, reopen it, and then try the rename operation
again.@@1@@1 Access 2007+ uses different description: 'Microsoft Office
Access is currently unable to rename the form, report, or module to '|'.@Close
the database, reopen it, and then try the rename operation again.@@1@@@1'
Access 2010+ uses different description: 'Microsoft Access is currently
unable to rename the form, report, or module to '|1'.@Close the database,
reopen it, and then try the rename operation again.@@1@@@1'

Access 2003+

29041

One or more forms or reports contains an ActiveX control that could not be
loaded.@These controls will not function properly until you register them, open
the forms or reports in Design view, and save the forms or reports.@@1@@1
Access 2007+ uses different description: 'One or more forms or reports
contains an ActiveX control that could not be loaded.@These controls will not
function properly until you register them, open the forms or reports in Design
view, and save the forms or reports.@@1@@@1'

Access 2003+

29042

One or more forms or reports contains an ActiveX control that could not be
loaded.@These controls will not function properly until you register them, open
the forms or reports in Design view, and save the forms or reports.@@1@@1
Access 2007+ uses different description: 'One or more forms or reports
contains an ActiveX control that could not be loaded.@These controls will not
function properly until you register them, open the forms or reports in Design
view, and save the forms or reports.@@1@@@1'

Access 2003+

29043 Microsoft Office Access has converted the code in '|' to your current version of
Visual Basic.@To improve the performance of this database, do the following:
1. Open any module in this database in Design view. 2. On the Debug menu,
click Compile And Save All Modules.@@1@@1 Access 2007+ uses different
description: 'Microsoft Office Access has converted the code in '|' to your
current version of Visual Basic.@To improve the performance of this database,
do the following: 1. Open any module in this database in Design view. 2. On
the Debug menu, click Compile And Save All Modules.@@1@@@1' Access
2010+ uses different description: 'Microsoft Access has converted the code in
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'|1' to your current version of Visual Basic.@To improve the performance of
this database, do the following: 1. Open any module in this database in Design
view. 2. On the Debug menu, click Compile And Save All
Modules.@@1@@@1'

29044

DAO version 3.0 is not compatible with this version of Microsoft Office
Access.@Create a reference to DAO version 3.5. For information on setting
references, click Help.@@2@613780@1 Access 2007+ uses different
description: 'DAO version 3.0 is not compatible with this version of Microsoft
Office Access.@Create a reference to DAO version 3.5. For information on
setting references, click Help.@@2@1@13780@1' Access 2010+ uses
different description: 'DAO version 3.0 is not compatible with this version of
Microsoft Access.@Create a reference to DAO version 3.5. For information on
setting references, click Help.@@2@1@13780@1'

Access 2003+

29045

You can't import, export, create, modify, or rename any forms, reports, pages or
modules in an MDE database.@@@1@@1 Access 2007+ uses different
description: 'You can't import, export, create, modify, or rename any forms,
reports, pages or modules in an ACCDE, MDE or ADE
database.@@@1@@@1'

Access 2003+

29046

You can't create a module for a form or report if it is read-only, or if the
database is read-only.@@@1@@1 Access 2007+ uses different description:
'You can't create a module for a form or report if it is read-only, or if the
database is read-only.@@@1@@@1'

Access 2003+

29047

Microsoft Office Access was unable to open the Visual Basic project for this
database.@Another user is saving the project now. Do you want to retry?
@@23@@1 Access 2007+ uses different description: 'Microsoft Office
Access was unable to open the Visual Basic project for this database.@Another
user is saving the project now. Do you want to retry?@@23@@@1' Access
2010+ uses different description: 'Microsoft Access was unable to open the
Visual Basic project for this database.@Another user is saving the project now.
Do you want to retry?@@23@@@1'

Access 2003+

29048

MDE databases can't reference MDB databases.@MDE databases can only
reference other MDE databases or type libraries.@@1@@1 Access 2007+ uses
different description: 'MDE databases can't reference MDB databases.@MDE
databases can only reference other MDE databases or type
libraries.@@1@@@1'

Access 2003+

29049

You can't refer to a form or report module from Form view or Report preview if
the form's or report's HasModule property is set to No.@Switch to Design view
or set the HasModule property to Yes in order to refer to the
module.@@1@@1 Access 2007+ uses different description: 'To add a code
module to a form or report, you must switch to Design view and set the
HasModule property of the form or report to Yes.@@@1@@@1'

Access 2003+

Error Code Error Description Supported Versions
29050 Microsoft Office Access couldn't compile this database because one or more

references couldn't be resolved.@The database has not been saved in a
compiled state. The performance of this database will be slower because
Microsoft Office Access will need to recompile the database for each
session.@For information on improving performance, click
Help.@2@611705@1 Access 2007+ uses different description: 'Microsoft
Office Access couldn't compile this database because one or more references
couldn't be resolved.@The database has not been saved in a compiled state. The
performance of this database will be slower because Microsoft Office Access
will need to recompile the database for each session.@For information on
improving performance, click Help.@2@1@11705@1' Access 2010+ uses
different description: 'Microsoft Access couldn't compile this database
because one or more references couldn't be resolved.@The database has not
been saved in a compiled state. The performance of this database will be slower

Access 2003+



because Microsoft Access will need to recompile the database for each
session.@For information on improving performance, click
Help.@2@1@11705@1'

29051

The current user account doesn't have permission to make an MDE file from
this database.@To make an MDE file, do the following: * Join the workgroup
that defines the user accounts used to access the database. * Make sure the user
account has Open/Run and Open Exclusive permissions for the database object.
* Make sure the user account has Modify Design or Administer permissions for
the MSysModules2 table in the database. * Request that other users close the
database.@@1@@1 Access 2007+ uses different description: 'The current
user account doesn't have permission to make an MDE file from this
database.@To make an MDE file, do the following: * Join the workgroup that
defines the user accounts used to access the database. * Make sure the user
account has Open/Run and Open Exclusive permissions for the database object.
* Make sure the user account has Modify Design or Administer permissions for
the MSysModules2 table in the database. * Request that other users close the
database.@@1@@@1'

Access 2003+

29052

The Visual Basic for Applications project in the database '|' can't be converted
to the current Visual Basic format.@If the database is an MDE, you will need
to rebuild the MDE from the source MDB. If you don't have the source MDB,
you will need to obtain a new version of the MDE that is compatible with the
current version of Visual Basic.@@1@@1 Access 2007+ uses different
description: 'The Visual Basic for Applications project in the database '|' can't
be converted to the current Visual Basic format.@If the database is an MDE,
you will need to rebuild the MDE from the source MDB. If you don't have the
source MDB, you will need to obtain a new version of the MDE that is
compatible with the current version of Visual Basic.@@1@@@1'

Access 2003+

29053

Microsoft Office Access can't create any more controls on this form or
report.@If you have deleted controls from this form or report in the past, you
may be able to rename the form or report and then add more controls to
it.@@1@@1 Access 2007+ uses different description: 'Microsoft Office
Access can't create any more controls on this form or report.@If you have
deleted controls from this form or report in the past, you may be able to rename
the form or report and then add more controls to it.@@1@@@1' Access 2010+
uses different description: 'Microsoft Access can't create any more controls on
this form or report.@If you have deleted controls from this form or report in the
past, you may be able to rename the form or report and then add more controls
to it.@@1@@@1'

Access 2003+

29054

Microsoft Office Access can't add, rename, or delete the control(s) you
requested.@@@1@@1 Access 2007+ uses different description: 'Microsoft
Office Access can't add, rename, or delete the control(s) you
requested.@@@1@@@1' Access 2010+ uses different description:
'Microsoft Access can't add, rename, or delete the control(s) you
requested.@@@1@@@1'

Access 2003+

29055

The form or report '|' has too many controls.@Reduce the number of controls
on the form or report before using it in this version of Microsoft Office
Access.@@1@@1 Access 2007+ uses different description: 'The form or
report '|' has too many controls.@Reduce the number of controls on the form or
report before using it in this version of Microsoft Office Access.@@1@@@1'
Access 2010+ uses different description: 'The form or report '|1' has too many
controls.@Reduce the number of controls on the form or report before using it
in this version of Microsoft Access.@@1@@@1'

Access 2003+

29056 Someone else is using '|' and the Visual Basic for Applications project does not
match your version of Visual Basic.@You need to open the database
exclusively in order to upgrade the Visual Basic for Applications project in this
database.@@1@@1 Access 2007+ uses different description: 'Someone else
is using '|' and the Visual Basic for Applications project does not match your

Access 2003+



version of Visual Basic.@You need to open the database exclusively in order to
upgrade the Visual Basic for Applications project in this
database.@@1@@@1'

29057

The database '|' is read-only and the Visual Basic for Applications project does
not match your version of Visual Basic.@You need to open the database read-
write in order to upgrade the Visual Basic for Applications project in this
database.@@1@@1 Access 2007+ uses different description: 'The database
'|' is read-only and the Visual Basic for Applications project does not match
your version of Visual Basic.@You need to open the database read-write in
order to upgrade the Visual Basic for Applications project in this
database.@@1@@@1'

Access 2003+

29058

You can't create a module for a form or report while an instance of the form or
report is in browse mode.@@@1@@1 Access 2007+ uses different
description: 'You can't create a module for a form or report while an instance
of the form or report is in browse mode.@@@1@@@1'

Access 2003+

29059

Microsoft Office Access was unable do display the module.@@@1@@1
Access 2007+ uses different description: 'Microsoft Office Access was unable
do display the module.@@@1@@@1' Access 2010+ uses different
description: 'Microsoft Access was unable do display the
module.@@@1@@@1'

Access 2003+

29060 File not found.@@@1@@1 Access 2007+ uses different description: 'File
not found.@@@1@@@1' Access 2003+

29061

There were compilation errors during the conversion or enabling of this
database.@This might be due to old DAO syntax that is no longer supported.
For an example on how to fixup the code, click Help. @@2@611705@1
Access 2007+ uses different description: 'There were compilation errors
during the conversion or enabling of this database.@This might be due to old
DAO syntax that is no longer supported. For an example on how to fixup the
code, click Help. @@2@1@11705@1'

Access 2003+

29062

The module name '|' is misspelled or refers to a module that doesn't exist.@If
the invalid module name is in a macro, an Action Failed dialog box will display
the macro name and the macro's arguments after you click OK. Open the Macro
window, and enter the correct module name.@@1@@1 Access 2007+ uses
different description: 'The module name '|' is misspelled or refers to a module
that doesn't exist.@If the invalid module name is in a macro, an Action Failed
dialog box will display the macro name and the macro's arguments after you
click OK. Open the Macro window, and enter the correct module
name.@@1@@@1'

Access 2003+

29063 The Visual Basic for Applications project in the database is corrupt. Access 2003+

29064 You do not have exclusive access to the database at this time.If you proceed to
make changes, you may not be able to save them later. Access 2003+

29065

Microsoft Office Access can't save design changes or save to a new database
object because another user has the file open. To save your design changes or to
save to a new object, you must have exclusive access to the file. Access 2010+
uses different description: 'Microsoft Access can't save design changes or
save to a new database object because another user has the file open. To save
your design changes or to save to a new object, you must have exclusive access
to the file.'

Access 2003+

29066 You do not have exclusive access to the database.Your design changes cannot
be saved at this time.Do you want to close without saving your changes? Access 2003+

29067 You do not have exclusive access to the database.You cannot convert this
database at this time. Access 2003+

29068
Microsoft Office Access cannot complete this operation. You must stop the
code and try again. Access 2010+ uses different description: 'Microsoft
Access cannot complete this operation. You must stop the code and try again.'

Access 2003+



29069

Microsoft Office Access cannot save the digital signature at this time.@* You
may be in a database under Source Code Control. * You may be in a database
which is read only.@@1@@1 Access 2007+ uses different description:
'Microsoft Office Access cannot save the digital signature at this time.@* You
may be in a database under Source Code Control. * You may be in a database
which is read only. * The database uses either the *.accdb or *.accde file name
extension. To sign such a database, click the Microsoft Office Button, point to
the Publish menu, and then click Package and Sign.@@1@@@1' Access
2010+ uses different description: 'Microsoft Access cannot save the digital
signature at this time.@* You may be in a database under Source Code Control.
* You may be in a database which is read only. * The database uses either the
*.accdb or *.accde file name extension. To sign such a database, click the File
tab, point to the Publish menu, and then click Package and Sign.@@1@@@0'

Access 2003+

Error Code Error Description Supported Versions

29070

Your Microsoft Office Access database or project contains a missing or broken
reference to the file '|1'|2@* To ensure that your database or project works
properly, you must fix this reference. @@1@5043@1 Access 2007+ uses
different description: 'Your Microsoft Office Access database or project
contains a missing or broken reference to the file '|1'|2@* To ensure that your
database or project works properly, you must fix this reference.
@@1@2@5043@1' Access 2010+ uses different description: 'Your
Microsoft Access database or project contains a missing or broken reference to
the file '|1'|2@* To ensure that your database or project works properly, you
must fix this reference. @@1@2@5043@1'

Access 2003+

29071 Missing or broken VBE reference to the file '|1'. Access 2003+

29072

Microsoft Office Access has detected corruption in this file. To try to repair the
corruption, first make a backup copy of the file. Then, on the Tools menu, point
to Database Utilities and click Compact and Repair Database. If you are
currently trying to repair this corruption then you will need to recreate this file
or restore it from a previous backup.@@@2@553714192@1 Access 2007+
uses different description: 'Microsoft Office Access has detected corruption in
this file. To try to repair the corruption, first make a backup copy of the file.
Click the Microsoft Office Button, point to Manage and then click Compact
and Repair Database. If you are currently trying to repair this corruption, you
need to recreate this file or restore it from a previous
backup.@@@2@1@553714192@1' Access 2010+ uses different
description: 'Microsoft Access has detected corruption in this file. To try to
repair the corruption, first make a backup copy of the file. Click the File tab,
point to Manage and then click Compact and Repair Database. If you are
currently trying to repair this corruption, you need to recreate this file or restore
it from a previous backup.@@@2@1@553714192@1'

Access 2003+

29073 You do not have exclusive access to the database.You cannot continue with the
Source Code Control command. Access 2003+

29074

Microsoft Office Access failed to create the Visual Basic module.@If your
database is on a network drive, check your network connection, and then try
again.@@1@@1 Access 2007+ uses different description: 'Microsoft Office
Access failed to create the Visual Basic module.@If your database is on a
network drive, check your network connection, and then try
again.@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access failed to create the Visual Basic module.@If your database is on a
network drive, check your network connection, and then try
again.@@1@@@1'

Access 2003+

29075 Access cannot add a digital signature to a file created in Access 97 or
earlier.@Convert the file to Access 2000 or later file format, and then add a
digital signature.@@1@@1 Access 2007+ uses different description: 'Access
cannot add a digital signature to a file created in Access 97 or earlier.@Convert

Access 2003+



the file to Access 2000 or later file format, and then add a digital
signature.@@1@@@1'

29076

There was a problem with the digital certificate. The VBA project could not be
signed. The signature will be discarded.@@@1@@1 Access 2007+ uses
different description: 'There was a problem with the digital certificate. The
VBA project could not be signed. The signature will be
discarded.@@@1@@@1'

Access 2003+

29079

Microsoft Office Access is unable to read the VBA modules in this database
and cannot recover the modules because the file is read-only. To recover the
VBA modules, close the database and make a backup copy of the database.
Then open the database with read/write
permission.@@@2@2@553713744@1 Access 2010+ uses different
description: 'Microsoft Access is unable to read the VBA modules in this
database and cannot recover the modules because the file is read-only. To
recover the VBA modules, close the database and make a backup copy of the
database. Then open the database with read/write
permission.@@@2@2@553713744@1'

Access 2007+

29080

The VBA modules in this database appear to have been saved with
errors.Access can recover the modules, but you should backup the database
first.To cancel so you can make a backup copy of the database, click Cancel.
Then make a backup copy of the database. @If you have a backup copy of the
database, click OK.When the database opens, examine the modules to see that
they are correct. If they are not, you should revert to a recent
backup.@@6@2@553713744@1

Access 2007+

29081

The database cannot be opened because the VBA project contained in it cannot
be read. The database can be opened only if the VBA project is first deleted.
Deleting the VBA project removes all code from modules, forms and reports.
You should back up your database before attempting to open the database and
delete the VBA project.@To create a backup copy, click Cancel and then make
a backup copy of your database. To open the database and delete the VBA
project without creating a backup copy, click OK.@@6@2@553713744@1

Access 2007+

29082

The version of Access used to save this database cannot be detected. This
problem cannot be corrected because the database is read-only. Click OK, and
after the database closes, make a backup copy of the database. Then open the
database with read/write permission.@@@2@2@553713744@1

Access 2007+

29083
The object '|1' could not be imported because it contains elements from the
namespace '|2', which is no longer supported.Use an older version of Access to
import the object.

Access 2010+

29084
The object '|1' could not be imported because it contains elements from the
namespace '|2', which is from a newer version of Access.Use a newer version of
Access to import the object.

Access 2010+

29085 The object '|1' could not be imported because it contains elements from the
namespace '|2', which Access does not understand. Access 2010+

29086 The object '|1' could not be imported from the file '|2'. Ensure that the file exists
and is in the correct format. Access 2010+

30000

Microsoft Office Access could not find the SQL Server specified.Verify that the
server name is correct. Access 2010+ uses different description: 'Microsoft
Access could not find the SQL Server specified.Verify that the server name is
correct.'

Access 2003+

30001

Microsoft Office Access could not find the database on the server.Verify that
the database name is correct. Access 2010+ uses different description:
'Microsoft Access could not find the database on the server.Verify that the
database name is correct.'

Access 2003+

30002 Microsoft Office Access could not log on to the server.Verify that the log on
information is correct. Access 2010+ uses different description: 'Microsoft

Access 2003+



Access could not log on to the server.Verify that the log on information is
correct.'

30004 The Default Max Records setting must be between 0 and 2147483647. Access 2003+
30005 Missing SQL command Access 2003+
Error Code Error Description Supported Versions

30006 Access was not able to perform this operation because the project is not
connected to a SQL Server database. Access 2003+

30007 Can't sort on one or more fields specified in 'Order By' property or
sorting/grouping dialog. Access 2003+

30008
The server you are trying to access is case sensitive.Objects of the same name
but of different case are not supported.Using these objects may result in a loss
of data.

Access 2003+

30009 Another user or application has deleted this record or changed the value of its
primary key. Access 2003+

30010 Cannot apply Filter on one or more fields specified in the Filter property. Access 2003+
30011 Cannot get column information for the database object being browsed. Access 2003+

30012 A Server Filter cannot be applied to a stored procedure Record Source. Filter
not applied. Access 2003+

30013 You can't update the record because another user or application deleted it or
changed the value of its primary key. Access 2003+

30014 The data was added to the database but the data won't be displayed in the form
because it doesn't satisfy the criteria in the underlying record source. Access 2003+

30015 The specified record source contains duplicate names for some output
fields.Use aliases in your SELECT statement to give each field a unique name. Access 2003+

30016 The field '|' is read only. Access 2003+
30017 This database is not enabled for publication. Access 2003+

30018 Cannot create objects of type '|' against current SQL backend. Please check your
permissions and server setup. Access 2003+

30019
Microsoft Office Access cannot copy a table with a name that is longer than 64
characters. Access 2010+ uses different description: 'Microsoft Access cannot
copy a table with a name that is longer than 64 characters.'

Access 2003+

30020 Cannot find column '|'. Access 2003+
30021 Cannot use domain functions on stored procedures. Access 2003+

30022 The Access project could not be opened.You may not have adequate
permissions, or the project may be read-only. Access 2003+

30023 Cannot use domain functions on scalar functions. Access 2003+

30024

Your password will not be encrypted before it is saved to the file.@Users who
view the source contents of the file will be able to see the account user name
and password.�&Save Password�Cancel@@36@553714179@ Access 2007+
uses different description: 'Your password will not be encrypted before it is
saved to the file.@Users who view the source contents of the file will be able to
see the account user name and password.�&Save
Password�Cancel@@36@1@553714179@'

Access 2003+

30025 Invalid SQL Statement. Check the server filter on the form record source Access 2003+
Error Code Error Description Supported Versions

30026 Access is unable to connect to '|1' database on the '|2' server.Make sure that the
database still exists and that the server is running. Access 2003+

30027 The value you entered is not consistent with the data type or length of the
column. Access 2003+

30028 The database name for the attached database file is blank.Enter a name for your
database. Access 2003+



30029

This version of Microsoft Office Access doesn't support design changes with
the version of Microsoft SQL Server your Access project is connected to. See
the Microsoft Office Update Web site for the latest information and downloads
(on the Help menu, click Office on the Web). Your design changes will not be
saved. Access 2007+ uses different description: 'This version of Microsoft
Office Access does not support design changes with the version of Microsoft
SQL Server to which your Access project is connected. See the Microsoft
Office Update Web site for the latest information and downloads. Your design
changes will not be saved.' Access 2010+ uses different description: 'This
version of Microsoft Access does not support design changes with the version
of Microsoft SQL Server to which your Access project is connected. See the
Microsoft Office Update Web site for the latest information and downloads.
Your design changes will not be saved.'

Access 2003+

31000

You must specify criteria for all conditional formats.@@@1@@1 Access
2007+ uses different description: 'You must specify criteria for all conditional
formats.@@@1@@@1' Access 2010+ uses different description: 'You must
specify criteria for all conditional formats.'

Access 2003+

31001

A conditional format expression can't be longer than 946
characters.@@@1@@1 Access 2007+ uses different description: 'A
conditional format expression can't be longer than 946
characters.@@@1@@@1' Access 2010+ uses different description: 'A
conditional format expression can't be longer than 435
characters.@@@1@@@1'

Access 2003+

31002

Microsoft Office Access can't modify the control's conditional formats right
now.@Your program tried to modify the conditional format of a control while
the conditional format was being evaluated.@@1@@1 Access 2007+ uses
different description: 'Microsoft Office Access can't modify the control's
conditional formats right now.@Your program tried to modify the conditional
format of a control while the conditional format was being
evaluated.@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access can't modify the control's conditional formats right now.@Your
program tried to modify the conditional format of a control while the
conditional format was being evaluated.@@1@@@1'

Access 2003+

31003

The setting for this property is too long.@You can enter up to either 255 or
2,048 characters for this property, depending on the data type.@@1@@1
Access 2007+ uses different description: 'The setting for this property is too
long.@You can enter up to either 255 or 2,048 characters for this property,
depending on the data type.@@1@@@1'

Access 2003+

31004

The value of an (AutoNumber) field cannot be retrived prior to being saved.
Please save the record that contains the (AutoNumber) field prior to performing
this action.@@@1@@1 Access 2007 uses different description: 'The value
of an (AutoNumber) field cannot be retrived prior to being saved. Please save
the record that contains the (AutoNumber) field prior to performing this
action.@@@1@@@1' Access 2010 uses different description: 'The value of
an (AutoNumber) field cannot be retrived prior to being saved. Please save the
record that contains the (AutoNumber) field prior to performing this
action.@@@1@@@1' Access 2013 uses different description: 'The value of
an (AutoNumber) field cannot be retrived prior to being saved. Please save the
record that contains the (AutoNumber) field prior to performing this
action.@@@1@@@1' Access 2016 uses different description: 'The value of
an (AutoNumber) field cannot be retrived prior to being saved.Please save the
record that contains the (AutoNumber) field prior to performing this
action.@@@1@@@1'

Access 2003+

31005 Access failed to evaluate one or more expressions because '|' was referenced in
an expression. Only functions and properties that are considered to be safe are
allowed in expressions when Access runs in sandbox mode.@For more
information on sandbox mode, search for ""Sandbox mode"" in Access

Access 2007+



Help.@@1@@@1 Access 2010+ uses different description: 'Access failed to
evaluate one or more expressions because '|' was referenced in an
expression.@Only functions and properties that are considered to be safe are
allowed in expressions when Access runs in sandbox mode.@For more
information on sandbox mode, search for ""Sandbox mode"" in Access
Help.@1@@@1'

31006

This method is not supported for Attachment controls in the current database
file format.@@@1@@@1 Access 2010+ uses different description: 'This
method is not supported for Attachment controls in the current database file
format.'

Access 2007+

31007 This operation is not supported for Web browser controls in the current
database file format. Access 2010+

31008 This method is not supported for Empty Cell controls in the current database
file format. Access 2010+

31009 This method is not supported for creating Empty Cell controls. Access 2010+

31010 This operation is not supported for navigation controls in the current database
file format. Access 2010+

31011 The expression that you entered is not valid for Web-compatible
queries.@@@1@1@11732@1 Access 2010+

31012
You either have an error in your expression or you have attempted to use an
undeclared parameter.@Check the expression for errors or enter the parameter
'|' in the Query Parameters dialog.@@2@1@11805@1

Access 2010+

31500

Microsoft Office Access can't send this format in a mail message.@To send this
format in a mail message, click Export on the File menu, or use the OutputTo
method to create the files and attach them to a mail message.@@1@@1
Access 2007+ uses different description: 'Microsoft Office Access can't send
this format in a mail message.@To send this format in a mail message, click
Export on the File menu, or use the OutputTo method to create the files and
attach them to a mail message.@@1@@@1' Access 2010+ uses different
description: 'Microsoft Access can't send this format in a mail message.@To
send this format in a mail message, click Export on the File menu, or use the
OutputTo method to create the files and attach them to a mail
message.@@1@@@1'

Access 2003+

31501 The selected transform file '|' cannot be found. Please select a different
transform. Access 2003+

31502

Microsoft Office Access can't find the Microsoft Office international dynamic-
link library (DLL).@Reinstall Microsoft Office.@@1@@3 Access 2007+ uses
different description: 'Microsoft Office Access can't find the Microsoft Office
international dynamic-link library (DLL).@Reinstall Microsoft
Office.@@1@@@3' Access 2010+ uses different description: 'Microsoft
Access can't find the Microsoft Office international dynamic-link library
(DLL).@Reinstall Microsoft Office.@@1@@@3'

Access 2003+

Error Code Error Description Supported Versions

31503 The specified transform did not successfully convert the data.Select a different
transform. Access 2003+

31504 The data was transformed in a format that cannot be imported. Access 2003+

31505

Are you sure you want to remove '|' from the list of available transforms? This
will not actually delete the transform file. Access 2016+ uses different
description: 'Are you sure you want to remove '|' from the list of available
transforms?This will not actually delete the transform file.'

Access 2003+

31506 The selected transform file cannot be found. Select a different transform or
remove the transform. Then try to export again. Access 2003+

31507 Invalid field data type. Access 2003+



31508

Cannot load the Office Web Components@Access had a problem loading the
Office Web Components Version 9.0.Try going through set-up to re-install
them@@1@@3 Access 2007+ uses different description: 'Cannot load the
Office Web Components@Access had a problem loading the Office Web
Components Version 9.0.Try going through set-up to re-install
them@@1@@@3'

Access 2003+

31509

Cannot load the Office Web Components@Access had a problem loading the
Office Web Components Version 10.0.Try going through set-up to re-install
them@@1@@3 Access 2007+ uses different description: 'Cannot load the
Office Web Components@Access had a problem loading the Office Web
Components Version 10.0.Try going through set-up to re-install
them@@1@@@3'

Access 2003+

31510

Microsoft Office Access can't load the dynamic-link library |. @You need to
resolve the failure and start Access again.@@1@@3 Access 2007+ uses
different description: 'Microsoft Office Access can't load the dynamic-link
library |. @You need to resolve the failure and start Access again.@@1@@@3'
Access 2010+ uses different description: 'Microsoft Access can't load the
dynamic-link library |1. @You need to resolve the failure and start Access
again.@@1@@@3'

Access 2003+

31511

You have chosen to alter the mode in which SQL syntax will be interpreted in
this database. This will mean: @* Existing queries may return different results
or not run at all. * The range of data-types and reserved words will change. *
Different wildcards will be used. @It is recommended that you make a backup
copy of this database before continuing. If you agree to continue, Access will
close this database, compact it, and re-open in the new mode. Select OK to
continue.@5@324324@1 Access 2007+ uses different description: 'You have
chosen to alter the mode in which SQL syntax will be interpreted in this
database. This will mean: @* Existing queries may return different results or
not run at all. * The range of data-types and reserved words will change. *
Different wildcards will be used. @It is recommended that you make a backup
copy of this database before continuing. If you agree to continue, Access will
close this database, compact it, and re-open in the new mode. Select OK to
continue.@5@1@24324@1'

Access 2003+

31512

Microsoft Office Access can't open the mail session.@You may not have
configured an e-mail client on this computer.Ensure that your e-mail software
has been installed and configured properly.@@1@@1 Access 2007+ uses
different description: 'Microsoft Office Access can't open the mail
session.@You may not have configured an e-mail client on this
computer.Ensure that your e-mail software has been installed and configured
properly.@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access can't open the mail session.@You may not have configured an e-mail
client on this computer.Ensure that your e-mail software has been installed and
configured properly.@@1@@@1'

Access 2003+

31513

All open objects must be closed prior to converting to a different version.@Do
you want Microsoft Office Access to close the objects?@@19@@2 Access
2007+ uses different description: 'All open objects must be closed prior to
converting to a different version.@Do you want Microsoft Office Access to
close the objects?@@19@@@2' Access 2010+ uses different description:
'All open objects must be closed prior to continuing this operation.@Do you
want Microsoft Access to close the objects?@@19@@@2'

Access 2003+

31514 Microsoft Office Access can't convert this database to a different version
because one or more objects are open.@Close all objects and try
again.@@1@@3 Access 2007+ uses different description: 'Microsoft Office
Access can't convert this database to a different version because one or more
objects are open.@Close all objects and try again.@@1@@@3' Access 2010+
uses different description: 'Microsoft Access can't convert this database to a

Access 2003+



different version because one or more objects are open.@Close all objects and
try again.@@1@@@3'

31515

Your database is using SQL Server Compatible Syntax (ANSI 92) for which
Access 2000 has limited support.This will mean:@* Access 2000 users may not
be able to see some queries. * Existing queries may return different results or
not run at all. * The range of data-types and reserved words will change. *
Different wildcards will be used. @It is recommended that you change the SQL
Server Compatible Syntax (ANSI 92) setting before converting this database to
the Access 2000 file format.Select Cancel to abort the conversion process and
change the SQL Server Compatible Syntax (ANSI 92) setting.@5@324324@1
Access 2007+ uses different description: 'Your database is using SQL Server
Compatible Syntax (ANSI 92) for which Access 2000 has limited support.This
will mean:@* Access 2000 users may not be able to see some queries. *
Existing queries may return different results or not run at all. * The range of
data-types and reserved words will change. * Different wildcards will be used.
@It is recommended that you change the SQL Server Compatible Syntax
(ANSI 92) setting before converting this database to the Access 2000 file
format.Select Cancel to abort the conversion process and change the SQL
Server Compatible Syntax (ANSI 92) setting.@5@1@24324@1'

Access 2003+

31516

Microsoft Office Access can't convert this database to the requested version
because it has been 'enabled' to work with newer versions of Microsoft Office
Access than it was originally created with.@You can convert this database to a
newer format, and then retry this operation with the newly converted
database.@@1@@1 Access 2007+ uses different description: 'Microsoft
Office Access can't convert this database to the requested version because it has
been 'enabled' to work with newer versions of Microsoft Office Access than it
was originally created with.@You can convert this database to a newer format,
and then retry this operation with the newly converted database.@@1@@@1'
Access 2010+ uses different description: 'Microsoft Access can't convert this
database to the requested version because it has been 'enabled' to work with
newer versions of Microsoft Access than it was originally created with.@You
can convert this database to a newer format, and then retry this operation with
the newly converted database.@@1@@@1'

Access 2003+

31517

Microsoft Office Access can't convert this database to the requested version
because it is from an older version of Microsoft Office Access.@You can
convert this database to a newer format, and then retry this operation with the
newly converted database.@@1@@1 Access 2007+ uses different
description: 'Microsoft Office Access can't convert this database to the
requested version because it is from an older version of Microsoft Office
Access.@You can convert this database to a newer format, and then retry this
operation with the newly converted database.@@1@@@1' Access 2010+ uses
different description: 'Microsoft Access can't convert this database to the
requested version because it is from an older version of Microsoft
Access.@You can convert this database to a newer format, and then retry this
operation with the newly converted database.@@1@@@1'

Access 2003+

31518

The following controls contain expressions that can't be represented in a
Microsoft Office Access project PivotTable or PivotChart view:|.@Do you still
want to switch to PivotTable or PivotChart view?@@19@@2 Access 2007+
uses different description: 'The following controls contain expressions that
can't be represented in a Microsoft Office Access project PivotTable or
PivotChart view:|.@Do you still want to switch to PivotTable or PivotChart
view?@@19@@@2' Access 2010+ uses different description: 'The following
controls contain expressions that can't be represented in a Microsoft Access
project PivotTable or PivotChart view:|1.@Do you still want to switch to
PivotTable or PivotChart view?@@19@@@2'

Access 2003+

31519 You cannot import this file.@You cannot import a text file unless it has one of
these extensions: |.@@1@@1 Access 2007+ uses different description: 'You

Access 2003+



cannot import this file.@You cannot import a text file unless it has one of these
extensions: |.@@1@@@1'

31520

You cannot import this file.@You cannot import a text file that has one of these
extensions: |.@@1@@1 Access 2007+ uses different description: 'You
cannot import this file.@You cannot import a text file that has one of these
extensions: |.@@1@@@1'

Access 2003+

31521
Cannot establish connection to the server.@|@@1@@1 Access 2007+ uses
different description: 'Cannot establish connection to the
server.@|@@1@@@1'

Access 2003+

31522

Microsoft SQL Server Desktop Engine must be on the machine running
Microsoft Office Access.@@@1@@1 Access 2007+ uses different
description: 'Microsoft SQL Server Desktop Engine must be on the machine
running Microsoft Office Access.@@@1@@@1' Access 2010+ uses different
description: 'Microsoft SQL Server Desktop Engine must be on the machine
running Microsoft Access.@@@1@@@1'

Access 2003+

Error Code Error Description Supported Versions

31523

Microsoft Office Access was unable to open the file '|'. The file may not be an
Access file, the path or filename specified may be incorrect, or the file can not
be opened exclusively. To repair the file manually, on the Tools menu, point to
Database Utilities, and then click Compact and Repair Database.@@@1@@1
Access 2007+ uses different description: 'Microsoft Office Access was unable
to open the file '|'. The file may not be an Access file, the path or filename
specified may be incorrect, or the file can not be opened exclusively. To repair
the file manually, on the File menu, point to Manage Database, and then click
Compact and Repair Database.@@@1@@@1' Access 2010+ uses different
description: 'Microsoft Access was unable to open the file '|1'. The file may not
be an Access file, the path or filename specified may be incorrect, or the file
can not be opened exclusively. To repair the file manually, on the File menu,
point to Manage Database, and then click Compact and Repair
Database.@@@1@@@1'

Access 2003+

31524

Microsoft Office Access can't transfer the user-defined function '|'. User-defined
functions can only be transferred between Microsoft SQL Servers that are
version 8.0 or higher.@@@1@@1 Access 2007+ uses different description:
'Microsoft Office Access can't transfer the user-defined function '|'. User-
defined functions can only be transferred between Microsoft SQL Servers that
are version 8.0 or higher.@@@1@@@1' Access 2010+ uses different
description: 'Microsoft Access can't transfer the user-defined function '|1'.
User-defined functions can only be transferred between Microsoft SQL Servers
that are version 8.0 or higher.@@@1@@@1'

Access 2003+

31525

The selected object can't be pasted because the version of either the source or
the destination server is less than 7.0.@Microsoft Office Access can only copy
and paste this object if both Microsoft SQL Servers are version 7.0 or
higher.@@1@@1 Access 2007+ uses different description: 'You can copy
and paste this object only if at least Microsoft SQL Server 2000 is installed on
both the source and destination servers.@@@1@@@1'

Access 2003+

31526

You cannot create a Microsoft Office Access ADE or MDE file from a database
saved in Microsoft Office Access 2000 format.@Convert the database to the
current version of Microsoft Office Access.Then create the ADE or MDE
file.@@1@@1 Access 2007+ uses different description: 'You cannot create a
Microsoft Office Access ADE or MDE file from a database saved in Microsoft
Office Access 2000 format.@Convert the database to the current version of
Microsoft Office Access.Then create the ADE or MDE file.@@1@@@1'
Access 2010+ uses different description: 'You cannot create a Microsoft
Access ADE or MDE file from a database saved in Microsoft Access 2000
format.@Convert the database to the current version of Microsoft Access.Then
create the ADE or MDE file.@@1@@@1'

Access 2003+



31527 Path not found: |.@@@1@@1 Access 2007+ uses different description: 'Path
not found: |.@@@1@@@1' Access 2003+

31528
Table '|' is in use. Please close the table and retry import.@@@1@@1 Access
2007+ uses different description: 'Table '|' is in use. Please close the table and
retry import.@@@1@@@1'

Access 2003+

31529
View '|' is in use. Please close the view and retry import.@@@1@@1 Access
2007+ uses different description: 'View '|' is in use. Please close the view and
retry import.@@@1@@@1'

Access 2003+

31530
Procedure '|' is in use. Please close the procedure and retry
import.@@@1@@1 Access 2007+ uses different description: 'Procedure '|' is
in use. Please close the procedure and retry import.@@@1@@@1'

Access 2003+

31531

Microsoft Office Access cannot create table(s) using the information contained
in the document(s) you are trying to import.@@@1@@1 Access 2007+ uses
different description: 'Microsoft Office Access cannot create table(s) using the
information contained in the document(s) you are trying to
import.@@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access cannot create table(s) using the information contained in the
document(s) you are trying to import.@@@1@@@1'

Access 2003+

31532

Microsoft Office Access was unable to export the data.@@@1@@1 Access
2007+ uses different description: 'Microsoft Office Access was unable to
export the data.@@@1@@@1' Access 2010+ uses different description:
'Microsoft Access was unable to export the data.@@@1@@@1'

Access 2003+

31533 Invalid filename.@@@1@@1 Access 2007+ uses different description:
'Invalid filename.@@@1@@@1' Access 2003+

31534

Your database is using SQL Server Compatible Syntax (ANSI 92) for which
Access 97 has limited support.This will mean:@* Existing queries may return
different results or not run at all. * The range of data-types and reserved words
will change. * Different wildcards will be used. @It is recommended that you
change the SQL Server Compatible Syntax (ANSI 92) setting before converting
this database to the Access 97 file format.Select Cancel to abort the conversion
process and change the SQL Server Compatible Syntax (ANSI 92)
setting.@5@324324@1 Access 2007+ uses different description: 'Your
database is using SQL Server Compatible Syntax (ANSI 92) for which Access
97 has limited support.This will mean:@* Existing queries may return different
results or not run at all. * The range of data-types and reserved words will
change. * Different wildcards will be used. @It is recommended that you
change the SQL Server Compatible Syntax (ANSI 92) setting before converting
this database to the Access 97 file format.Select Cancel to abort the conversion
process and change the SQL Server Compatible Syntax (ANSI 92)
setting.@5@1@24324@1'

Access 2003+

31535

Invalid parameters for ExportXML.@Press Help for more
information.@@2@5170@1 Access 2007+ uses different description:
'Invalid parameters for ExportXML.@Press Help for more
information.@@2@2@5170@1'

Access 2003+

31536

The XML schema properties do not match the existing table
structures.@Overwrite existing structures?@@19@@1 Access 2007+ uses
different description: 'The XML schema properties do not match the existing
table structures.@Overwrite existing structures?@@19@@@1'

Access 2003+

31537
There is already an object named '|' in the database.@@@1@@1 Access 2007+
uses different description: 'There is already an object named '|' in the
database.@@@1@@@1'

Access 2003+

31538 Microsoft Office Access cannot create this file. To create the file, you must give
the file a unique name, provide a valid connection string and user ID, and you
must have the necessary connection and file creation permissions.@@@1@@1
Access 2007+ uses different description: 'Microsoft Office Access cannot
create this file. To create the file, you must give the file a unique name, provide

Access 2003+



a valid connection string and user ID, and you must have the necessary
connection and file creation permissions.@@@1@@@1' Access 2010+ uses
different description: 'Microsoft Access cannot create this file. To create the
file, you must give the file a unique name, provide a valid connection string and
user ID, and you must have the necessary connection and file creation
permissions.@@@1@@@1'

31539
There was an error loading the XSL transformation file '|1'. Please make sure
that the file is a properly formatted XSL file and is the correct file to use for the
data supplied.|2

Access 2003+

31540 There was an error loading the XML data file '|1'. Please make sure that the file
is a properly formatted XML file. |2 Access 2003+

31541

Microsoft Office Access cannot open this file.@This file is located outside your
intranet or on an untrusted site.Microsoft Office Access will not open the file
due to potential security problems. @To open the file, copy it to your machine
or an accessible network location.@2@@1 Access 2007+ uses different
description: 'Microsoft Office Access cannot open this file.@This file is
located outside your intranet or on an untrusted site.Microsoft Office Access
will not open the file due to potential security problems. @To open the file,
copy it to your machine or an accessible network location.@2@@@1' Access
2010+ uses different description: 'Microsoft Access cannot open this
file.@This file is located outside your intranet or on an untrusted site.Microsoft
Access will not open the file due to potential security problems. @To open the
file, copy it to your machine or an accessible network location.@2@@@1'

Access 2003+

31542

The startup action associated with this file may not be safe.Do you want to
execute the startup action as you open the file?@@@22@@1 Access 2007+
uses different description: 'The startup action associated with this file may not
be safe.Do you want to execute the startup action as you open the file?
@@@22@@@1'

Access 2003+

Error Code Error Description Supported Versions

31543

The startup action associated with this file may not be safe.If you choose not to
execute the startup action, Microsoft Office Access will not open the file.Do
you want to execute the startup action and open the file?@@@22@@1 Access
2007+ uses different description: 'The startup action associated with this file
may not be safe.If you choose not to execute the startup action, Microsoft
Office Access will not open the file.Do you want to execute the startup action
and open the file?@@@22@@@1' Access 2010+ uses different description:
'The startup action associated with this file may not be safe.If you choose not to
execute the startup action, Microsoft Access will not open the file.Do you want
to execute the startup action and open the file?@@@22@@@1'

Access 2003+

31544

Microsoft Office Access cannot open this file.@The author of this file has set it
to open only when a startup action is executed, and Microsoft Office Access is
currently set to disable startup actions.@To address this problem, contact the
author of the file or your system administrator.@2@@1 Access 2007+ uses
different description: 'Microsoft Office Access cannot open this file.@The
author of this file has set it to open only when a startup action is executed, and
Microsoft Office Access is currently set to disable startup actions.@To address
this problem, contact the author of the file or your system
administrator.@2@@@1' Access 2010+ uses different description: 'Microsoft
Access cannot open this file.@The author of this file has set it to open only
when a startup action is executed, and Microsoft Access is currently set to
disable startup actions.@To address this problem, contact the author of the file
or your system administrator.@2@@@1'

Access 2003+

31545 Microsoft Office Access cannot open this file.@The Internet Security Zone
Manager is missing or not correctly installed and therefore the safety of this file
cannot be verified.@To address this problem, reinstall Microsoft Internet
Explorer or the appropriate Office System Pack.@2@@1 Access 2007+ uses

Access 2003+



different description: 'Microsoft Office Access cannot open this file.@The
Internet Security Zone Manager is missing or not correctly installed and
therefore the safety of this file cannot be verified.@To address this problem,
reinstall Windows Internet Explorer or the appropriate Office System
Pack.@2@@@1' Access 2010+ uses different description: 'Microsoft Access
cannot open this file.@The Internet Security Zone Manager is missing or not
correctly installed and therefore the safety of this file cannot be verified.@To
address this problem, reinstall Windows Internet Explorer or the appropriate
Office System Pack.@2@@@1'

31546

This database is a Microsoft Office Access 7.0/8.0/9.0 Design Master.@If you
click OK, the database you selected will be renamed to |1 and then converted to
|2. Everyone using a replica of this database will have to upgrade to Microsoft
Office Access 2002 after the next synchronization.@@4@@2 Access 2007+
uses different description: 'This database is a Microsoft Office Access
7.0/8.0/9.0 Design Master.@If you click OK, the database you selected will be
renamed to |1 and then converted to |2. Everyone using a replica of this
database will have to upgrade to Microsoft Office Access 2002 after the next
synchronization.@@4@@@2' Access 2010+ uses different description: 'This
database is a Microsoft Access 7.0/8.0/9.0 Design Master.@If you click OK,
the database you selected will be renamed to |1 and then converted to |2.
Everyone using a replica of this database will have to upgrade to Microsoft
Access 2002 after the next synchronization.@@4@@@2'

Access 2003+

31547

Microsoft Office Access cannot export this object to XML when it is open in
Print Preview. Close the object and try again.@@@1@@1 Access 2007+ uses
different description: 'Microsoft Office Access cannot export this object to
XML when it is open in Print Preview. Close the object and try
again.@@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access cannot export this object to XML when it is open in Print Preview.
Close the object and try again.@@@1@@@1'

Access 2003+

31548

Microsoft Office Access cannot export a table to XML when it is open in
Design. Close the object and try again.@@@1@@1 Access 2007+ uses
different description: 'Microsoft Office Access cannot export a table to XML
when it is open in Design. Close the object and try again.@@@1@@@1'
Access 2010+ uses different description: 'Microsoft Access cannot export a
table to XML when it is open in Design. Close the object and try
again.@@@1@@@1'

Access 2003+

31549 Finished importing document '|'. Access 2003+

31550

Not all of your data was successfully imported.Error descriptions with
associated row numbers of bad records can be found in the Microsoft Office
Access table '|'. Access 2010+ uses different description: 'Not all of your data
was successfully imported.Error descriptions with associated row numbers of
bad records can be found in the Microsoft Access table '|1'.'

Access 2003+

31551

Only XML files can be exported to an Internet address (http://, ftp://). Enter a
path that points to a location on your computer or on the network.@@@1@@1
Access 2007+ uses different description: 'Only XML files can be exported to
an Internet address (http://, ftp://). Enter a path that points to a location on your
computer or on the network.@@@1@@@1'

Access 2003+

31552 The document(s) you are importing contain XML Schema (XSD) information
created outside Microsoft Office Access. XML Schema information created
outside Microsoft Office Access is not supported. If you continue, Microsoft
Office Access will only import the data, and ignore the XML Schema.@Would
you like to continue?@@19@@1 Access 2007+ uses different description:
'The document(s) you are importing contain XML Schema (XSD) information
created outside Microsoft Office Access. XML Schema information created
outside Microsoft Office Access is not supported. If you continue, Microsoft
Office Access will only import the data, and ignore the XML Schema.@Would
you like to continue?@@19@@@1' Access 2010+ uses different description:

Access 2003+



'The document(s) you are importing contain XML Schema (XSD) information
created outside Microsoft Access.@XML Schema information created outside
Microsoft Access is not supported. If you continue, Microsoft Access will only
import the data, and ignore the XML Schema.@Would you like to continue?
@19@@@1'

31553

The Smart Tag property value cannot exceed 1024 characters.@@@1@@1
Access 2007+ uses different description: 'The Smart Tag property value
cannot exceed 1024 characters.@@@1@@@1' Access 2010+ uses different
description: 'The Action Tag property value cannot exceed 1024 characters.'

Access 2003+

31554

You are attempting to apply more smart tags then the system can
handle.@Please uncheck some of the selected tags.@@1@@1 Access 2007+
uses different description: 'You are attempting to apply more smart tags then
the system can handle.@Please uncheck some of the selected
tags.@@1@@@1' Access 2010+ uses different description: 'You are
attempting to apply too many Action Tags.@Please uncheck some of the
selected tags.@@1@@@1'

Access 2003+

31555

The specified transform did not successfully convert the data. Would you like to
save a copy of the Data to Export at '|' for troubleshooting? Access 2016+ uses
different description: 'The specified transform did not successfully convert the
data.Would you like to save a copy of the Data to Export at '|' for
troubleshooting?'

Access 2003+

31556

To view object dependencies or change the Track name AutoCorrect info
option, Microsoft Office Access must close all objects and update dependency
information.@This could take several minutes. Do you want to continue?
@@21@553713744@1 Access 2007+ uses different description: 'To view
object dependencies or change the Track name AutoCorrect info option,
Microsoft Office Access must close all objects and update dependency
information.@This could take several minutes. Do you want to continue?
@@21@1@553713744@1' Access 2010+ uses different description: 'To
view object dependencies or change the Track name AutoCorrect info option,
Microsoft Access must close all objects and update dependency
information.@This could take several minutes. Do you want to continue?
@@21@1@553713744@1'

Access 2003+

31557

Microsoft Office Access cannot update dependency information because one or
more objects are open.@Close all objects and try again.@@1@@3 Access
2007+ uses different description: 'Microsoft Office Access cannot update
dependency information because one or more objects are open.@Close all
objects and try again.@@1@@@3' Access 2010+ uses different description:
'Microsoft Access cannot update dependency information because one or more
objects are open.@Close all objects and try again.@@1@@@3'

Access 2003+

31558

The Track name AutoCorrect info option generates name maps for the objects
in the database. This may take several minutes.@Do you want to leave this
option turned on?@@3@@1 Access 2007+ uses different description: 'The
Track name AutoCorrect info option generates name maps for the objects in the
database. This may take several minutes.@Do you want to leave this option
turned on?@@3@@@1'

Access 2003+

31559

Microsoft Office Access could not connect to the site you specified.Verify the
address of the site or contact your site administrator. Access 2010+ uses
different description: 'Microsoft Access could not connect to the site you
specified.Verify the address of the site or contact your site administrator.'

Access 2003+

31560 The site you specified does not support linking to a Microsoft Office Access
database. The site must be running Windows SharePoint Services from
Microsoft Access 2007+ uses different description: 'The site you specified
does not support linking to a Microsoft Office Access database. The site must
be running Windows SharePoint Services from Microsoft.' Access 2010+ uses
different description: 'The site you specified does not support linking to a

Access 2003+



Microsoft Access database. The site must be running Microsoft SharePoint
Foundation.'

31561

The site you specified does not support importing data to a Microsoft Office
Access database. The site must be running Windows SharePoint Services from
Microsoft. Access 2007+ uses different description: 'The site you specified
does not support importing data to a Microsoft Office Access database. The site
must be running Microsoft Windows SharePoint Services.' Access 2010+ uses
different description: 'The site you specified does not support importing data
to a Microsoft Access database. The site must be running Microsoft SharePoint
Foundation.'

Access 2003+

31562 The site you specified does not contain any lists.Verify the address of the site,
or contact your site administrator. Access 2003+

Error Code Error Description Supported Versions

31563

Microsoft Office Access could not enable name AutoCorrect for one or more
objects because Access could not open and save the objects. An open or save
operation could have failed due to one or more of the following reasons - the
object is already open, you don't have permissions to open the object in Design
view, the database is read-only, or the source of a linked table could not be
found.@@@2@553713743@1 Access 2007+ uses different description:
'Microsoft Office Access could not enable name AutoCorrect for one or more
objects because Access could not open and save the objects. An open or save
operation could have failed due to one or more of the following reasons - the
object is already open, you don't have permissions to open the object in Design
view, the database is read-only, or the source of a linked table could not be
found.@@@2@1@553713743@1' Access 2010+ uses different description:
'Microsoft Access could not enable name AutoCorrect for one or more objects
because Access could not open and save the objects. An open or save operation
could have failed due to one or more of the following reasons - the object is
already open, you don't have permissions to open the object in Design view, the
database is read-only, or the source of a linked table could not be
found.@@@2@1@553713743@1'

Access 2003+

31564

To generate object dependencies, the Track name AutoCorrect info option must
be turned on.@Enable name AutoCorrect and continue?@@5@553713744@1
Access 2007+ uses different description: 'To generate object dependencies,
the Track name AutoCorrect info option must be turned on.@Enable name
AutoCorrect and continue?@@5@1@553713744@1'

Access 2003+

31565

Dependency information needs to be updated before you can view object
dependencies.This could take several minutes.@Do you want to continue?
@@5@553713744@1 Access 2007+ uses different description: 'Dependency
information needs to be updated before you can view object dependencies.This
could take several minutes.@Do you want to continue?
@@5@1@553713744@1'

Access 2003+

31566

The object dependencies feature is not enabled for this database because
dependency info needs to be updated.@@@5@553713744@1 Access 2007+
uses different description: 'The object dependencies feature is not enabled for
this database because dependency info needs to be
updated.@@@5@1@553713744@1'

Access 2003+

31567

The object that you have selected in the Object Dependencies pane no longer
exists in the database.@@@1@@1 Access 2007+ uses different description:
'The object that you have selected in the Object Dependencies pane no longer
exists in the database.@@@1@@@1'

Access 2003+

31568

You do not have the necessary permissions to generate dependency information
for the selected object.@@@2@553713744@1 Access 2007+ uses different
description: 'You do not have the necessary permissions to generate
dependency information for the selected object.@@@2@1@553713744@1'

Access 2003+



31569

To view dependency information, you must select a table, query, form, or
report.@@@1@553713742@1 Access 2007+ uses different description: 'To
view dependency information, you must select a table, query, form, or
report.@@@1@1@553713742@1'

Access 2003+

31570

Dependency information cannot be generated because name maps are either
missing or outdated. Turn on the Track name AutoCorrect info option, make
sure you have sufficient permissions to open an object in Design view, and
make sure the database is not read-only.@@@2@553713744@1 Access 2007+
uses different description: 'Dependency information cannot be generated
because name maps are either missing or outdated. Turn on the Track name
AutoCorrect info option, make sure you have sufficient permissions to open an
object in Design view, and make sure the database is not read-
only.@@@2@1@553713744@1'

Access 2003+

31571

Dependency information cannot be generated because name maps are outdated,
and the database is read-only.@@@2@553713744@1 Access 2007+ uses
different description: 'Dependency information cannot be generated because
name maps are outdated, and the database is read-
only.@@@2@1@553713744@1'

Access 2003+

31572

Microsoft Office Access cannot generate dependency information for a new
unsaved object. Save the new object and then check for object
dependencies.@@@2@553713744@1 Access 2007+ uses different
description: 'Microsoft Office Access cannot generate dependency information
for a new unsaved object. Save the new object and then check for object
dependencies.@@@2@1@553713744@1' Access 2010+ uses different
description: 'Microsoft Access cannot generate dependency information for a
new unsaved object. Save the new object and then check for object
dependencies.@@@2@1@553713744@1'

Access 2003+

31573

Microsoft Office Access cannot generate dependency information for objects in
a project.@@@1@@1 Access 2007+ uses different description: 'Microsoft
Office Access cannot generate dependency information for objects in a
project.@@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access cannot generate dependency information for objects in a
project.@@@1@@@1'

Access 2003+

31574
Microsoft Office Access cannot export unbound forms or reports as XML
documents. Access 2010+ uses different description: 'Microsoft Access
cannot export unbound forms or reports as XML documents.'

Access 2003+

31575

All open objects must be closed prior to backing up your database or
project.@Do you want Microsoft Office Access to close the objects?
@@19@@2 Access 2007+ uses different description: 'All open objects must
be closed prior to backing up your database or project.@Do you want
Microsoft Office Access to close the objects?@@19@@@2' Access 2010+
uses different description: 'All open objects must be closed prior to backing
up your database or project.@Do you want Microsoft Access to close the
objects?@@19@@@2'

Access 2003+

31576

Microsoft Office Access cannot backup this database or project because one or
more objects are open.@Close all objects and try again.@@1@@3 Access
2007+ uses different description: 'Microsoft Office Access cannot backup this
database or project because one or more objects are open.@Close all objects
and try again.@@1@@@3' Access 2010+ uses different description:
'Microsoft Access cannot backup this database or project because one or more
objects are open.@Close all objects and try again.@@1@@@3'

Access 2003+

31577

Microsoft Office Access could not connect to the site you specified. Verify the
address of the site or contact your site administrator. Access 2010+ uses
different description: 'Microsoft Access could not connect to the site you
specified. Verify the address of the site or contact your site administrator.'

Access 2003+



31578

The table could not be exported because you do not have sufficient
permissions. Please contact your site administrator. Access 2007+ uses
different description: 'Microsoft Office Access was unable to transfer data to
the Microsoft Windows SharePoint Services site. The '|1' step failed. |2' Access
2010+ uses different description: ''

Access 2003,2007

31579

A list with the specified name already exists. Type a different name and try
again. Access 2007+ uses different description: 'The table could not be
exported because you do not have sufficient permissions. Please contact your
site administrator.'

Access 2003+

31580
The list name cannot contain any of the following characters: /:*?""<>|. Type a
different name and try again. Access 2007+ uses different description: 'A list
with the specified name already exists. Type a different name and try again.'

Access 2003+

31581

Microsoft Office Access cannot generate dependency information for objects in
a replica database.@@@1@@1 Access 2007+ uses different description:
'The list name cannot contain any of the following characters: /:*?""<>|. Type a
different name and try again.'

Access 2003+

31582

Finished importing from '|'. Access 2007+ uses different description:
'Microsoft Office Access cannot generate dependency information for objects in
a replica database.@@@1@@@1' Access 2010+ uses different description:
'Microsoft Access cannot generate dependency information for objects in a
replica database.@@@1@@@1'

Access 2003+

Error Code Error Description Supported Versions

31583 Finished linking to '|'. Access 2007+ uses different description: 'Finished
importing from '|'.' Access 2003+

31584 Finished exporting table '|1' to '|2'. Access 2007+ uses different description:
'Finished linking to '|'.' Access 2003+

31585

The site you specified does not support importing data from a Microsoft Office
Access database. The site must be running Windows SharePoint Services from
Microsoft. Access 2007+ uses different description: 'Finished exporting '|1' to
'|2'.'

Access 2003+

31586

Microsoft Office Access cannot generate dependency information because the
Track name AutoCorrect info option is turned off. This option cannot be turned
on because the database is either read-only or you do not have
sufficientpermissions.@@@1@@1 Access 2007+ uses different description:
'The site you specified does not support importing data from a Microsoft Office
Access database. The site must be running Windows SharePoint Services from
Microsoft.' Access 2010+ uses different description: 'The site you specified
does not support importing data from a Microsoft Access database. The site
must be running Microsoft SharePoint Foundation.'

Access 2003+

31587

Error exporting picture file '|1' to specified path '|2'. Access 2007+ uses
different description: 'Microsoft Office Access cannot generate dependency
information because the Track Name AutoCorrect Info option is turned off.
This option cannot be turned on because the database is either read-only or you
do not have sufficient permissions.@@@1@@@1' Access 2010+ uses
different description: 'Microsoft Access cannot generate dependency
information because the Track Name AutoCorrect Info option is turned off.
This option cannot be turned on because the database is either read-only or you
do not have sufficient permissions.@@@1@@@1'

Access 2003+

31588
Specified transform failed to successfully transform your data. | Access 2007+
uses different description: 'Error exporting picture file '|1' to specified path
'|2'.'

Access 2003+

31589
A list named '|' already exists.You must either use a different name or go to the
site and delete the list. Access 2007+ uses different description: 'Specified
transform failed to successfully transform your data. |'

Access 2003+



31590

Microsoft Office Access is unable to export '|' to Windows SharePoint Services
due to limitations on the number of times each data type can appear in a
Windows SharePoint Services list.@See help to find out exactly what the
restrictions are and for details on how to create a query that will define the
Windows SharePoint Services list that you would like to
create.@@2@553714173@1 Access 2007+ uses different description: 'A list
named '|' already exists.You must either use a different name or go to the site
and delete the list.'

Access 2003+

31591

Cannot find the specified schema file '|'. Remove or update the file reference
and try to import again. Access 2007+ uses different description: 'Microsoft
Office Access is unable to export '|' to Windows SharePoint Services due to
limitations on the number of times each data type can appear in a Windows
SharePoint Services list.@See help to find out exactly what the restrictions are
and for details on how to create a query that will define the Windows
SharePoint Services list that you would like to
create.@@2@1@553714173@1' Access 2010+ uses different description:
'Microsoft Access is unable to export '|1' to Microsoft SharePoint Foundation
due to limitations on the number of times each data type can appear in a
Microsoft SharePoint Foundation list.@See help to find out exactly what the
restrictions are and for details on how to create a query that will define the
Microsoft SharePoint Foundation list that you would like to
create.@@2@1@553714173@1'

Access 2003+

31592

Microsoft Office Access has encountered an error processing the XML schema
in file '|1'. |2 Access 2007+ uses different description: 'Cannot find the
specified schema file '|'. Remove or update the file reference, and try again to
import.@@@1@@@1'

Access 2003+

31593

Microsoft Office Access was unable to export XML data to'|'. Access 2007 uses
different description: 'Microsoft Office Access has encountered an error
processing the XML schema in file '|1'.|2@@@1@@@1' Access 2010 uses
different description: 'Microsoft Access has encountered an error processing
the XML schema in file '|1'. |2@@@1@@@1' Access 2013 uses different
description: 'Microsoft Access has encountered an error processing the XML
schema in file '|1'. |2@@@1@@@1' Access 2016 uses different description:
'Microsoft Access has encountered an error processing the XML schema in file
'|1'. |2@@@1@@@1'

Access 2003+

31594

You must install the Microsoft Access 2.0 Converter in order to convert this
file.@To get the Access 2.0 Converter from the Microsoft Office Web site, click
""Microsoft Office Online"" on the Help menu.@@1@@1 Access 2007+ uses
different description: 'Microsoft Office Access was unable to export XML
data to'|'.@@@1@@@1' Access 2010+ uses different description: 'Microsoft
Access was unable to export XML data to '|1'.@@@1@@@1'

Access 2003+

31595

This database was saved in the Microsoft Access | file format.@For information
on how to import data from this database into a new file, click Microsoft Office
Online on the Getting Started with Microsoft Office Access page.@@1@@@1
Access 2010+ uses different description: 'This database was saved in the
Microsoft Access | file format.@For information on how to import data from
this database into a new file, click Office.com on the Getting Started with
Microsoft Access page.@@1@@@1'

Access 2007+

31596 Cannot load the specification '|'. Try re-creating the
specification.@@@1@@@1 Access 2007+

31597 The specification XML failed to validate against the schema. There is an error
in the following line of the XML document: |.@@@1@@@1 Access 2007+

31598
The specification XML failed to validate against the schema. There is an error
in the following specification XML string: |1 Possible value could be one of
following '|2'.@@@1@@@1

Access 2007+



31599

The specified name '|' cannot be set due to one of the following reasons: ? The
specified name is not unique. ? The specified name is blank. ? The specified
name does not follow Microsoft Office Access object-naming
rules.@@@1@@@1 Access 2010+ uses different description: 'The specified
name '|1' cannot be set due to one of the following reasons: ? The specified
name is not unique. ? The specified name is blank. ? The specified name does
not follow Microsoft Access object-naming rules.@@@1@@@1'

Access 2007+

31600 The specified description '|' is too long. The description cannot exceed 255
characters.@@@1@@@1 Access 2007+

31601 The specification does not contain a description. '|'.@@@1@@@1 Access 2007+

31602 The specification with the specified index does not exist. Specify a different
index. '|'.@@@1@@@1 Access 2007+

Error Code Error Description Supported Versions

31603 The name '|' is already in use. Enter a different name or click on the Manage
Data Tasks button to rename the existing specification. @@@1@@@1 Access 2007+

31604 The required element is missing under and for a fixed width
format.@@@1@@@1 Access 2007+

31605 The Width attribute is required for all elements under or for a fixed width
format.@@@1@@@1 Access 2007+

31606 Cannot open the destination database. If the database is open, close it, and then
try again.@@@1@@@1 Access 2007+

31607 The Path attribute is required for all formats except ImportWSS, ImportOutlook
and ExportXML. Access 2007+

31608 Specify a name for the import specification in the Save As box. Access 2007+
31609 Specify a name for the export specification in the Save As box. Access 2007+
31610 Do you want to delete '|'? Access 2007+
31611 Specify the name of the source or destination file in the File name box. Access 2007+
31612 The specification failed to execute. Try re-creating the specification. Access 2007+

31613

You have selected ""Tables and Related Views"" as the way to group objects in
the database.Access needs to update information on object dependencies to
create the groups. This will take some time for large databases.@Do you want
to continue?@@3@@@1

Access 2007+

31614
Are you sure you want to delete the item '|' from the Categories list?@Note that
the individual groups and the shortcuts to the objects in the database will be
deleted, but the objects themselves will not be deleted.@@3@@@1

Access 2007+

31615 Are you sure you want to delete the group?@Note that only the shortcuts, and
not the actual objects will be deleted.@@3@@@1 Access 2007+

31616 Duplicate Item Name@An item with the name | already exists in the Categories
list. Specify a different name for the item.@@1@@@1 Access 2007+

31617 Duplicate Group Name@A group named | already exists. Specify a different
name for the group.@@1@@@1 Access 2007+

31618 Blank Item Name@You have not specified a name for the item that you added
to the Categories list.@@1@@@1 Access 2007+

31619 Blank Group Name@You have not specified a name for the
group.@@1@@@1 Access 2007+

31620 This will clear all the contents in your MSysNavPaneXXX system tables.@Do
you want to continue?@@3@@@1 Access 2007+

31621 There is already a shortcut named '|1' to the '|2' object in this
group.@@@1@@@1 Access 2007+

31622 The table description cannot be changed for a linked table Access 2007+
Error Code Error Description Supported Versions



31623

Microsoft Office Access has imported 'Favorites' and other groups into the
converted database. If you change the imported groups in Access 2007, you will
not see those changes if you open the database in an older version of Access.
Also, if you change the imported groups by using an older version of Access,
you will not see those changes if you open the database in Access 2007.
@@@1@@@1 Access 2010+ uses different description: 'Microsoft Access
has imported 'Favorites' and other groups into the converted database. If you
change the imported groups in Access 2007 or greater, you will not see those
changes if you open the database in an older version of Access. Also, if you
change the imported groups by using an older version of Access, you will not
see those changes if you open the database in Access 2007 or greater.
@@@1@@@1'

Access 2007+

31624 Enter a valid date.@@@1@@@1 Access 2007+
31625 Enter a valid value.@@@1@@@1 Access 2007+

31626
| issues were found that could result in unwanted behavior or missing data.@Do
you want to cancel the wizard and review the issues?@Click No to ignore the
issues and continue with the migration.

Access 2007+

31627 A copy of the database has moved to |. Continue opening current file? Access 2007+

31628 Moving to SharePoint is not supported for databases that have the
AllowBypassKey property disabled. Access 2007+

31629 Template '|1' could not be instantiated.@|2@@@@@3 Access 2007+
31630 Failed to set the database property '|'. Access 2007+

31631 The object name '|' could not be used because it doesn't follow object-naming
rules. Access 2007+

31632 Failed to load '|1' into '|2'. Access 2007+
31633 '|' is not a supported AccessObject type. Access 2007+
31634 Failed to create relationship '|'. Access 2007+
31635 Manifest.xml does not match the defined schema. | Access 2007+
31636 Tables.xml does not exist. Access 2007+

31637

This template cannot be used because it requires a later version of Microsoft
Office Access. See Microsoft Office Online for the latest templates you can use
with your current version of Microsoft Office Access. Access 2010 uses
different description: 'This template cannot be used because it requires a later
version of Microsoft Access. See Office.com for the latest templates you can
use with your current version of Microsoft Access.' Access 2013 uses different
description: 'This template cannot be used because it requires a later version of
Microsoft Access. See Office.com for the latest templates you can use with
your current version of Microsoft Access.' Access 2016 uses different
description: 'This template cannot be used because it requires a later version of
Microsoft Access. See Office.com for the latest templates you can use with
your current version of Microsoft Access.'

Access 2007+

31638 Errors were encountered while loading Tables.xml. Access 2007+
31639 Manifest.xml does not exist. Access 2007+
31640 Relationships.xml does not match the required schema. Access 2007+
31641 An unexpected error occurred when opening the template. Access 2007+
31642 NavPane.xml does not match the required schema. Access 2007+
Error Code Error Description Supported Versions
31643 '|' is not a valid template. Access 2007+
31644 Failed to create a database with the specified CollatingOrder. Access 2007+
31645 Failed to set |1 on |2 '|3'. Access 2007+
31646 Failed to load NavPane.xml. Access 2007+
31647 An error occurred while flipping |1 '|2' right-to-left. Access 2007+



31648 An error occurred while performing Name AutoCorrect. Access 2007+
31649 An error occurred while fixing up the labels on |1 '|2'. Access 2007+
31650 The source file '|1' for |2 '|3' does not exist. Access 2007+

31651 The object name '|' could not be used because another object with the same
name already exists. Access 2007+

31652 You do not have exclusive access to the database. Your SharePoint Lists can not
be taken offline or cached at this time. Try again later. Access 2007+

31653
Microsoft Office Access is unable to take your lists offline. A circular
relationship was detected. Access 2010+ uses different description: 'Microsoft
Access is unable to take your lists offline. A circular relationship was detected.'

Access 2007+

31654 Access denied. You do not have permissions to SharePoint server. Verify
permissions, and retry this operation. Access 2007+

31655

Microsoft Office Outlook could not be started. Make sure Outlook is installed
and properly set up on your computer. Access 2010+ uses different
description: 'Microsoft Outlook could not be started. Make sure Outlook is
installed and properly set up on your computer.'

Access 2007+

31656
You must have Microsoft Office Outlook 2007 on this computer to enable this
feature. Access 2010+ uses different description: 'You must have Microsoft
Office Outlook 2007 or later on this computer to enable this feature.'

Access 2007+

31657 You cannot set up a collecting data using e-mail task, because your database
has reached its maximum size limit. Free some disk space and try again. Access 2007+

31658 The selected table or query does not have any fields that support collecting data
using e-mail. Access 2007+

31659 | is read-only. You cannot use e-mail messages to collect or update data on this
object. Access 2007+

31660 You cannot collect data for action queries, SQL-specific queries, and parameter
queries by using e-mail messages. Access 2007+

31661 The e-mail address field you have specified does not contain any valid
addresses. Specify another field. Access 2007+

31662 The value you have entered is not valid for the maximum number of replies. Access 2007+
Error Code Error Description Supported Versions
31663 The value you have entered is not valid for the date and time to stop. Access 2007+

31664 The date and time to stop processing replies has to be greater than the current
date and time. Access 2007+

31665 | Access 2007+

31666

The UpdateDependencyInfo method could not update one or more objects.
Microsoft Office Access has created a Name AutoCorrect Save Failures table in
the current database with more information about the failing
objects.@@@2@1@553713744@1 Access 2010+ uses different description:
'The UpdateDependencyInfo method could not update one or more objects.
Microsoft Access has created a Name AutoCorrect Save Failures table in the
current database with more information about the failing
objects.@@@2@1@553713744@1'

Access 2007+

31667

Do you want to delete all of the selected objects?Deleting these objects will
remove them from all groups.@You cannot undelete forms, reports, and
modules.@@20@@@1 Access 2013+ uses different description: 'Do you
want to delete all of the selected objects? Deleting these objects will remove
them from all groups.@You cannot undelete forms, reports, and
modules.@@20@@@2'

Access 2007+

31668 Microsoft Office Access does not support opening HTML pages. @To open a
Data Access Page, use Windows Internet Explorer or Microsoft Office Access
2003 or earlier.@@2@@4294967294@1 Access 2010+ uses different
description: 'Microsoft Access does not support opening HTML pages. @To

Access 2007+



open a Data Access Page, use Windows Internet Explorer or Microsoft Access
2003 or earlier.@@2@@4294967294@1' Access 2013+ uses different
description: 'Microsoft Access does not support opening HTML
pages.@@@2@@4294967294@1'

31669

Design changes are not supported for Data Access Pages. @To change the
design of a Data Access Page, use Microsoft Office Access 2003 or
earlier.@@2@@4294967294@1 Access 2010+ uses different description:
'Design changes are not supported for Data Access Pages. @To change the
design of a Data Access Page, use Microsoft Access 2003 or
earlier.@@2@@4294967294@1'

Access 2007+

31670

Microsoft Office Access does not support this operation for Data Access Pages.
To perform this operation, use Microsoft Office Access 2003 or
earlier.@@@1@@@1 Access 2010+ uses different description: 'Microsoft
Access does not support this operation for Data Access Pages. To perform this
operation, use Microsoft Access 2003 or earlier.@@@1@@@1'

Access 2007+

31671 | Access 2007+

31672
This operation is not supported for SharePoint linked tables. To manage
SharePoint linked tables, point to Get External Data on the Data menu, and then
click SharePoint List. Access 2013+ uses different description: '|1|2'

Access 2007+

31673

Changes have been made to this database by an older version of Access or by
an external source.In order to use the Tables and Related Views group in the
Navigation Pane the dependency tree must be rebuilt.This may take a few
moments.@Do you want to continue?@@3@@@1 Access 2013 uses
different description: 'TECHNICAL DETAILSCorrelation ID: |1 Date and
Time: |2' Access 2016 uses different description: 'TECHNICAL
DETAILSCorrelation ID: |1 Date and Time: |2'

Access 2007+

31674

Do you want to delete all of the selected objects?Deleting these objects will
remove them from all groups.@@@20@@@1 Access 2013+ uses different
description: 'This operation is not supported for SharePoint linked tables. To
manage SharePoint linked tables, point to Get External Data on the Data menu,
and then click SharePoint List.'

Access 2007+

31675

You cannot create an .accde or .mde file from a disabled (non-trusted) database.
If you trust the source of this database, you can enable it by using the Message
bar.@@@1@@@1 Access 2013+ uses different description: 'Changes have
been made to this database by an older version of Access or by an external
source.In order to use the Tables and Related Views group in the Navigation
Pane the dependency tree must be rebuilt.This may take a few moments.@Do
you want to continue?@@3@@@1'

Access 2007+

31676 Do you want to delete all of the selected objects? Deleting these objects will
remove them from all groups.@@@20@@@2 Access 2013+

31677
You cannot create an .accde or .mde file from a disabled (non-trusted) database.
If you trust the source of this database, you can enable it by using the Message
bar.@@@1@@@1

Access 2013+

32000 The '|1' macro action cannot run with the specified '|2' argument either when in
disabled mode or when called from an embedded macro.@@@1@@@1 Access 2007+

32001 The '|' RunCommand cannot be run in disabled mode.@@@1@@@1 Access 2007+
32002 Cannot open or run macro '|', because it is not valid.@@@1@@@1 Access 2007+

32003

The ApplyFilter action requires a valid control name that corresponds to a
subform or subreport.@@@1@@@1 Access 2010+ uses different
description: 'The '|' action requires a valid control name that corresponds to a
subform or subreport.@@@1@@@1'

Access 2007+

32004

The control name '|' is misspelled or refers to a control that doesn't exist.@If the
invalid control name is in a macro, an Action Failed dialog box will display the
macro name and the macro's arguments after you click OK. Open the Macro
window, and enter the correct control name.@@1@@@1

Access 2007+



Error Code Error Description Supported Versions
32005 One or more actions are unknown and cannot be pasted.@@@1@@@1 Access 2007+
32006 Microsoft Access could not understand the macro format. Access 2010+
32007 The '|1' macro action needs a value for the '|2' argument.@@@1@@@1 Access 2010+
32008 The '|1' macro action has an invalid value for the '|2' argument.@@@1@@@1 Access 2010+
32009 The SubMacro needs a valid name argument Access 2010+
32010 The text you entered is not an item in the list. Access 2010+
32011 Microsoft Access can't parse the expression: '|1'. Access 2010+

32012 The ApplyOrderBy action requires a valid control name that corresponds to a
subform or subreport.@@@1@@@1 Access 2010+

32013 An unknown error has occurred in a data macro.@@@1@@@1 Access 2010+

32014 Are you sure you wish to permanently delete |1 from your table? If the table is
open, the change will not be committed until the table is saved. Access 2010+

32015 Deletion failed for '|1'. Access 2010+
32016 Rename failed for '|1'. Access 2010+
32017 The SQL statement is not valid. Access 2010+
32018 Changes may not have been saved. Access 2010+
32019 Time-out error. Server processing failed. Access 2010+

32020
An error occurred while checking for the status of a Data Macro.@To view the
error, look up the DataMacroInstanceID '|1' in the USysApplicationLog
table.@@1@@@1

Access 2010+

32021 The If and Else If conditions are required arguments. Access 2010+
32022 The macro cannot be imported because it is invalid. Access 2010+
32023 The '|1' action is not valid for the current context. Access 2010+
32024 The data macro cannot support any more parameters. Access 2010+
Error Code Error Description Supported Versions
32500 The group '|' you entered is invalid.@@@1@@@1 Access 2007+
32501 The category '|' you entered is invalid.@@@1@@@1 Access 2007+

32502
The value you entered isn't valid for the field '|'.@For example, you may have
entered text in a numeric field or a number that is greater than the FieldSize
setting permits.@@1@@@1

Access 2007+

32503 Support for export to .PDF or .XPS is not installed on this
computer.@@@1@@@1 Access 2007+

32504 The text you entered isn't an item in the list.@Do you want to edit the items in
the list?@@20@@@4 Access 2007+

32505

Microsoft Office Access has recovered this database. Examine the database to
verify that there are no missing database objects.@@@1@@@1 Access 2010+
uses different description: 'Microsoft Access has recovered this database.
Examine the database to verify that there are no missing database
objects.@@@1@@@1'

Access 2007+

32506

Microsoft Office Access has recovered this database, but one or more tables
were found to contain data corruption and were deleted. Deleted tables were
logged in the MSysRecoveryErrors table. This table is currently displayed in
the datasheet.@@@1@@@1 Access 2010+ uses different description:
'Microsoft Access has recovered this database, but one or more tables were
found to contain data corruption and were deleted. Deleted tables were logged
in the MSysRecoveryErrors table. This table is currently displayed in the
datasheet.@@@1@@@1'

Access 2007+

32507 Microsoft Office Access has recovered this database, but one or more tables
were found to contain data corruption and were deleted. Deleted tables were
logged in the MSysRecoveryErrors table. @@@1@@@1 Access 2010+ uses

Access 2007+



different description: 'Microsoft Access has recovered this database, but one
or more tables were found to contain data corruption and were deleted. Deleted
tables were logged in the MSysRecoveryErrors table. @@@1@@@1'

32508 The 'Save as Outlook Contact' command failed.@@@1@@@1 Access 2007+
32509 The 'Add from Outlook' command failed.@@@1@@@1 Access 2007+

32510

Microsoft Office Access could not find any fields that match the fields in a
Microsoft Office Outlook Contact.@@@1@@@1 Access 2010+ uses
different description: 'Microsoft Access could not find any fields that match
the fields in a Microsoft Outlook Contact.@@@1@@@1'

Access 2007+

32511 Successfully added | contact(s).@@@1@@@1 Access 2007+

32512

You cannot save this database in an earlier version format, because it uses
features that require the current file format.@Features that require the current
file format include attachments, multivalued fields, offline data, or links to
external files that are not supported by earlier versions of Access.@@1@@@1
Access 2010+ uses different description: 'You cannot save this database in an
earlier version format, because it uses features that require the current file
format.@These features include attachments, multi-valued fields, offline data,
data macros, calculated columns, links to unsupported external files, newer sort
orders, newer encryption types, and navigation controls.@@1@@@1'

Access 2007+

32513

All open objects must be closed before you save the database.@Do you want
Microsoft Office Access to close all open objects?@@19@@@2 Access
2010+ uses different description: 'All open objects must be closed before you
save the database.@Do you want Microsoft Access to close all open objects?
@@19@@@2'

Access 2007+

32514

Microsoft Office Access can't save this database to a different version, because
one or more objects are open.@Close all objects, and then try
again.@@1@@@3 Access 2010+ uses different description: 'Microsoft
Access can't save this database to a different version, because one or more
objects are open.@Close all objects, and then try again.@@1@@@3'

Access 2007+

32515 You are about to delete the list and all its data from the SharePoint site. Do you
want to continue? Access 2007+

32516 The filter string you entered is not valid or you cannot apply a filter at this time. Access 2007+
32517 This SharePoint list or one of related lists doesn't exist on the SharePoint site. Access 2007+
32518 The following errors have occurred: Access 2007+

32519 The value specified for the Type parameter is invalid. Specify one of the
following: Report, Form, Query, or Table. Access 2007+

Error Code Error Description Supported Versions

32520 The repair operation was cancelled. To repair the file manually, on the File
menu, point to Manage Database, and then click Compact and Repair Database. Access 2007+

32521 You can't change the value of this property in the OnPaint
event.@@@1@@@1 Access 2007+

32522

No contacts were imported.None of the fields have the necessary '|' property
specified.@@@1@@@1 Access 2010+ uses different description: 'No
contacts were imported. None of the fields have the necessary '|' property
specified.@@@1@@@1'

Access 2007+

32523 A custom macro in this report has failed to run, and is preventing the report
from rendering.@@@1@@@1 Access 2007+

32524 Access could not create '|1'.@|2@Make sure that the file name (and location, if
provided) are in the correct format, such as c:locationfile name.@1@@@1 Access 2007+

32525
Access could not download the template from Microsoft Office Online. Access
2010+ uses different description: 'Access could not download the template
from Office.com.'

Access 2007+

32526 You attempted to create an .mdb file on a SharePoint site. You can create only
Access 2007 database (.accdb) files on SharePoint sites. Either change the file

Access 2007+



type or select a different location. Access 2013 uses different description:
'You attempted to create an .mdb file on a SharePoint site. You can create only
Access 2007 - 2013 database (.accdb) files on SharePoint sites. Either change
the file type or select a different location.' Access 2016 uses different
description: 'You attempted to create an .mdb file on a SharePoint site. You can
create only Access 2007 - 2016 database (.accdb) files on SharePoint sites.
Either change the file type or select a different location.'

32527

You attempted to create an .adp file on a SharePoint site. You can create only
Access 2007 database (.accdb) files on SharePoint sites. Either change the file
type or select a different location. Access 2013 uses different description:
'You attempted to create an .adp file on a SharePoint site. You can create only
Access 2007 - 2013 database (.accdb) files on SharePoint sites. Either change
the file type or select a different location.' Access 2016 uses different
description: 'You attempted to create an .adp file on a SharePoint site. You can
create only Access 2007 - 2016 database (.accdb) files on SharePoint sites.
Either change the file type or select a different location.'

Access 2007+

32528 The application is disabled, and databases may not be created. Access 2007+

32529 This operation is not supported for parameterized queries or objects based on
parameterized queries.@@@1@@@1 Access 2007+

32530

Sharing to Windows SharePoint Services requires the database to be in an
Access 2007 or greater format. Access 2010+ uses different description:
'Sharing to Microsoft SharePoint Foundation requires the database to be in an
Access 2007 or greater format.'

Access 2007+

32531

Microsoft Office Access failed to create the SharePoint list. This could be
because you don't have the necessary permissions. Access 2010+ uses different
description: 'Microsoft Access failed to create the SharePoint list. This could
be because you don't have the necessary permissions.'

Access 2007+

32532 The project cannot be converted to this format. The project can only be
converted to Access 2000 or newer format. Access 2007+

32533 Failed to create field '|1' on table '|2' Access 2007+
32534 Failed to delete predefined field '|1' on table '|2' Access 2007+

32535 Failed to rename the the field '|1' on the SharePoint list '|2' Access 2010+ uses
different description: 'Failed to rename the field '|1' on the SharePoint list '|2'' Access 2007+

32536

The specified command (OutputTo) is not available now.Close objects open in
Design View or Layout View and try again.@@@1@@@1 Access 2010+ uses
different description: 'The specified command (OutputTo) is not available
now. Close objects open in Design View or Layout View and try
again.@@@1@@@1'

Access 2007+

32537 Only 256 TempVars can be created. Be sure to remove any TempVars that are
not needed. Access 2007+

32538 TempVars can only store data. They cannot store objects. Access 2007+
32539 TempVars can only store strings with up to 65,356 characters. Access 2007+
Error Code Error Description Supported Versions

32540

The name of this TempVar is too long.TempVar names must be 256 characters
or less.Use a shorter name. Access 2010+ uses different description: 'The
name of this TempVar is too long. TempVar names must be 256 characters or
less. Use a shorter name.'

Access 2007+

32541 You must specify a name to set or remove a temporary variable. Access 2007+
32542 You must specify a value to set the temporary variable to. Access 2007+

32543 Do you want to connect to an existing SQL Server database?@Select No to
create a new SQL Server database.@@16@@@4 Access 2007+

32544 You are trying to convert an encoded database. Decode the database, and then
try again. To protect the converted database, use the Encrypt with Password
command. Access 2016+ uses different description: 'You are trying to convert

Access 2007+



an encoded database. Decode the database, and then try again.To protect the
converted database, use the Encrypt with Password command.'

32545

You are trying to convert a password protected database. Remove the password,
and then try again. To protect the converted database, use the Encrypt with
Password command. Access 2016+ uses different description: 'You are trying
to convert a password protected database. Remove the password, and then try
again.To protect the converted database, use the Encrypt with Password
command.'

Access 2007+

32546

You are trying to convert an encoded database that uses a password. Decode the
database, remove the password, and then try again. To protect the converted
database, use the Encrypt with Password command. Access 2016+ uses
different description: 'You are trying to convert an encoded database that uses
a password. Decode the database, remove the password, and then try again.To
protect the converted database, use the Encrypt with Password command.'

Access 2007+

32547

You are trying to convert a database that is encrypted with a password. Remove
the password, and then try again. To protect the converted database, use the Set
Database Password command. Access 2016+ uses different description: 'You
are trying to convert a database that is encrypted with a password. Remove the
password, and then try again.To protect the converted database, use the Set
Database Password command.'

Access 2007+

32548

There was an error displaying the mail message.Make sure that there are no
open dialogs in Outlook and try again. Access 2010+ uses different
description: 'There was an error displaying the mail message. Make sure that
there are no open dialogs in Outlook and try again.'

Access 2007+

32549

'|' contains over 10,000 rows.Processing may take several moments.Would you
like to continue? Access 2010+ uses different description: ''|' contains over
10,000 rows. Processing may take several moments. Would you like to
continue?'

Access 2007+

32550
'|' is an empty lookup field. You will not be able to collect data for this field. To
continue, remove the empty lookup field from the list of fields to be included in
this e-mail message.

Access 2007+

32551

There was an error displaying the task.Make sure that there are no open dialogs
in Outlook and try again. Access 2010+ uses different description: 'There was
an error displaying the task. Make sure that there are no open dialogs in
Outlook and try again.'

Access 2007+

32552 This command is not available when the database is opened from the Web
server. Would you like to save a local copy of the database? Access 2007+

32553
To sign and deploy a database, you must use a database created with Microsoft
Office Access 2007 or later. Convert the database to the Access 2007 format
and start the signing process again.

Access 2007+

32554

Microsoft Office Access could not create a deployment package with the
current database. Check the path to the file.@@@1@@@1 Access 2010+ uses
different description: 'Microsoft Access could not create a deployment
package with the current database. Check the path to the file.@@@1@@@1'

Access 2007+

32555

Microsoft Office Access could not sign the current database. Ensure that the
digital certificate used to sign the database is valid.@@@1@@@1 Access
2010+ uses different description: 'Microsoft Access could not sign the current
database. Ensure that the digital certificate used to sign the database is
valid.@@@1@@@1'

Access 2007+

32556

Microsoft Office Access could not extract the database. Check the file name
and the path to the file.@@@1@@@1 Access 2010+ uses different
description: 'Microsoft Access could not extract the database. Check the file
name and the path to the file.@@@1@@@1'

Access 2007+

32557 Microsoft Office Access could not download the packaged database. Network
issues or issues with the Web site may have prevented the download. Start the

Access 2007+



download again or browse to the site and ensure that it is
operating.@@@1@@@1 Access 2010+ uses different description:
'Microsoft Access could not download the packaged database. Network issues
or issues with the Web site may have prevented the download. Start the
download again or browse to the site and ensure that it is
operating.@@@1@@@1'

32558 You requested an invalid file. The file may be corrupt. Contact the person who
created the file and request a new copy.@@@1@@@1 Access 2007+

32559 The template is in an unknown format and cannot be opened. Access 2007+
Error Code Error Description Supported Versions
32560 The specified template does not exist. Access 2007+

32561 The specified template contains errors or is not a valid template. Access 2010+
uses different description: ''|' is not a valid database template.' Access 2007+

32562

The specified template cannot be created in the specified file format.Specify a
different file format for the new database. Access 2010+ uses different
description: 'The specified template cannot be created in the specified file
format. Specify a different file format for the new database.'

Access 2007+

32563 You cannot use a template file to create a database directly on a SharePoint site. Access 2007+

32564

This does not appear to be a template file.The file may have become corrupt, or
the package format may contain an error. Access 2010+ uses different
description: 'This does not appear to be a template file. The file may have
become corrupt, or the package format may contain an error.'

Access 2007+

32565

The |0 '|1' could not be read from the template file.The object may be in an
unrecognized format or contain invalid data. Access 2010+ uses different
description: 'The |0 '|1' could not be read from the template file. The object
may be in an unrecognized format or contain invalid data.'

Access 2007+

32566 The table '|0' in the template could not be associated with a SharePoint list with
ID |1. Access 2007+

32567
The |0 '|1' in the template could not be loaded from text because of a parsing
error. |2 Access 2016+ uses different description: 'The |0 '|1' in the template
could not be loaded from text because of a parsing error. |2'

Access 2007+

32568 The table |0 or one of its fields could not be successfully renamed. Access 2007+
32569 Failed to add the VBA reference |0 Access 2007+

32570 A Design Master or Replica cannot be converted to the Access 2007 file
format.@@@1@@@1 Access 2007+

32571 The contents of the Navigation Pane may not be changed while it is locked. Access 2007+

32572

Access Projects do not support custom groups in the Navigation Pane.You may
not import or export custom groups from an Access Project. Access 2010+ uses
different description: 'Access Projects do not support custom groups in the
Navigation Pane. You may not import or export custom groups from an Access
Project.'

Access 2007+

32573
Microsoft Office Access cannot perform the export operation. Access 2010+
uses different description: 'Microsoft Access cannot perform the export
operation.'

Access 2007+

32574
This template requires a SharePoint site with a newer version of Windows
SharePoint services.Specify a different site. Access 2010+ uses different
description: ''

Access 2007

32575

The acCmdExport command for RunCommand has been deprecated.Use the
OutputTo action or one of the more specific RunCommands, such as
acCmdExportExcel, acCmdExportRTF, and acCmdExportText. Access 2010+
uses different description: 'The acCmdExport command for RunCommand
has been deprecated. Use the OutputTo action or one of the more specific
RunCommands, such as acCmdExportExcel, acCmdExportRTF, and
acCmdExportText.'

Access 2007+



32576

The acCmdImport command for RunCommand has been deprecated.Use one of
the more specific RunCommands, such as acCmdImportAttachAccess,
acCmdImportAttachExcel, and acCmdImportAttachText. Access 2010+ uses
different description: 'The acCmdImport command for RunCommand has
been deprecated. Use one of the more specific RunCommands, such as
acCmdImportAttachAccess, acCmdImportAttachExcel, and
acCmdImportAttachText.'

Access 2007+

32577

The acCmdLinkTables command for RunCommand has been deprecated.Use
one of the more specific RunCommands, such as acCmdImportAttachAccess,
acCmdImportAttachExcel, and acCmdImportAttachText. Access 2010+ uses
different description: 'The acCmdLinkTables command for RunCommand has
been deprecated. Use one of the more specific RunCommands, such as
acCmdImportAttachAccess, acCmdImportAttachExcel, and
acCmdImportAttachText.'

Access 2007+

32578

Microsoft Office Access could not load the Access database engine.Run setup
again and restart the application.@@@1@@@1 Access 2010+ uses different
description: 'Microsoft Access could not load the Access database engine. Run
setup again and restart the application.@@@1@@@1'

Access 2007+

32579 You do not have permissions to write to this SharePoint site. Contact your site
administrator for assistance. Access 2007+

Error Code Error Description Supported Versions

32580 Cannot publish the file | as the file is either checked out or locked for editing by
another user. Access 2007+

32581

SQL Distributed Management Objects (SQL-DMO) must be on the machine
running Microsoft Office Access. Access 2010+ uses different description:
'SQL Distributed Management Objects (SQL-DMO) must be on the machine
running Microsoft Access.'

Access 2007+

32582

The specified file name could not be used to create a database.Specify a
different database name. Access 2010+ uses different description: 'The
specified file name could not be used to create a database. Specify a different
database name.'

Access 2007+

32583 An error occurred while trying to create the database. Access 2007+
32584 No object with the given name and type exists in the current database. Access 2007+
32585 This feature is only available in an ADP.@@@1@@@1 Access 2007+
32586 This database object cannot be saved as a report.@@@1@@@1 Access 2007+
32587 The Source value you have specified is not valid.@@@1@@@1 Access 2007+

32588
The table which you are trying to append to is currently open and must be
closed before proceeding. Do you want to save the changes and close the table?
@@@20@@@2

Access 2007+

32589
Microsoft Office Access encountered an error trying to close the
table.@@@1@@@1 Access 2010+ uses different description: 'Microsoft
Access encountered an error trying to close the table.@@@1@@@1'

Access 2007+

32590
You cannot link to a database that is stored on an Internet location. You should
first save the database to a location that uses a Universal Naming Convention
(UNC), such as a server share, and then link to it.@@@1@@@1

Access 2007+

32591 The file path you specified is not valid. Please specify a full file
path.@@@1@@@1 Access 2007+

32592
The file name extension of '|' is not valid for the format to which you are trying
to export. This action is potentially unsafe. Do you want to continue?
@@@20@@@2

Access 2007+

32593 Overwite existing table or query '|'?@@@20@@@2 Access 2007+

32594
The Show Column History command is not available while you are working
with a SharePoint list offline. Reconnect to the list and try
again.@@@1@@@1

Access 2007+



32595

Microsoft Office Access cannot delete the SharePoint list, because you don't
have the necessary permissions to delete the list or the list has been renamed or
no longer exists. Access 2010+ uses different description: 'Microsoft Access
cannot delete the SharePoint list, because you don't have the necessary
permissions to delete the list or the list has been renamed or no longer exists.'

Access 2007+

32596

The Microsoft Office Access Outlook Add-in is disabled in Microsoft Office
Outlook 2007. To collect data by using e-mail messages in Microsoft Office
Access 2007, verify that this add-in is installed and enabled from within Office
Outlook 2007. Access 2010+ uses different description: 'The Microsoft
Access Outlook Add-in is disabled in Microsoft Outlook. To collect data by
using e-mail messages in Microsoft Access, verify that this add-in is installed
and enabled from within Microsoft Outlook.'

Access 2007+

32597

This database contains links to lists on the selected SharePoint site. Do you
want to be able to add shortcuts to each list's View menu? This will enable other
people to open forms and reports from the SharePoint Web page. Access 2016+
uses different description: 'This database contains links to lists on the selected
SharePoint site.Do you want to be able to add shortcuts to each list's View
menu? This will enable other people to open forms and reports from the
SharePoint Web page.'

Access 2007+

32598 The name '|' is already in use. Enter a different name. @@@1@@@1 Access 2007+

32599
Only XML files can be imported from an Internet address (http://, ftp://). Enter
a path that points to a location on your computer or on the
network.@@@1@@@1

Access 2007+

Error Code Error Description Supported Versions
32600 The list |1 is already used by the |2 link table. Select a different list. Access 2007+

32601 You are about to change sites. Any changes you have made to link tables will
be discarded. Do you want to continue without saving these changes? Access 2007+

32602

The SetProperty action or method failed because there was no form or report
context.@To establish the correct context for SetProperty, call OpenForm or
OpenReport before calling SetProperty, or call SetProperty from an event on a
form or report.@@1@@@1

Access 2007+

32603 SharePoint List data will be cached in this database. If this database is shared,
users who do not have permissions to view this data will be able to see it. Access 2007+

32604 There was an error publishing your database. Verify your publish URL and
permissions, and then try again. Access 2007+

32605 Your data source contains more than 255 fields (columns). Access will import
only the first 255 fields. Access 2007+

32606

Attachment fields are not supported in the MDB or ADP database formats.
Attachment fields are included in the source database table and those fields will
not be exported. Do you want to continue? Access 2010+ uses different
description: 'Some field types, such as attachment fields and calculated fields,
are not supported in the MDB or ADP database. Do you want to continue?'

Access 2007+

32607

Attachment fields are not supported in the MDB or ADP database formats. If
attachment fields are included in the source database tables, those fields will
not be imported. Do you want to continue? Access 2010+ uses different
description: 'Field types such as attachment fields and calculated fields, are not
supported in the MDB or ADP database formats. If any unsupported field types
exist in the source database tables, those fields will not be imported. Do you
want to continue?'

Access 2007+

32608
This database file cannot be converted because it contains linked tables that
refer to one or more files that cannot be found. To continue, delete these linked
tables or repair the links.@@@1@@@1

Access 2007+

32609 |1 cannot load customization '|2'. This customization name was already loaded. Access 2007+



32610

Automatic configuration of the current version of Microsoft Office Access has
failed. Your database might not function correctly. This can occur if you do not
have the necessary permissions to install Microsoft Office Access on this
computer.@@@1@@@1 Access 2010+ uses different description:
'Automatic configuration of the current version of Microsoft Access has failed.
Your database might not function correctly. This can occur if you do not have
the necessary permissions to install Microsoft Access on this
computer.@@@1@@@1'

Access 2007+

32611 The file '|' already exists.@Do you want to update the existing file?
@@20@@@2 Access 2007+

32612

Microsoft Office Access cannot open this file. This file was converted to
runtime mode by changing its file name extension to .accdr. This file will open
only when Access is in runtime mode. To open the file, either double-click it in
Windows Explorer, open it by using a shortcut, or use the /runtime command-
line switch. To modify the design of this database, rename it with an .accdb file
name extension, and then open it in Access. Access 2010+ uses different
description: 'Microsoft Access cannot open this file. This file was converted to
runtime mode by changing its file name extension to .accdr. This file will open
only when Access is in runtime mode. To open the file, either double-click it in
Windows Explorer, open it by using a shortcut, or use the /runtime command-
line switch. To modify the design of this database, rename it with an .accdb file
name extension, and then open it in Access.'

Access 2007+

32613

This feature requires the Microsoft Office Access 2007 program to be installed
on your computer. The application you are running is powered by the Microsoft
Office Access 2007 Runtime. For information about the differences between the
Microsoft Office Access program and the Microsoft Office Access Runtime, in
the status bar, click Powered by Microsoft Office Access. Access 2010 uses
different description: 'This feature requires the Microsoft Access 2010
program to be installed on your computer. The application you are running is
powered by the Microsoft Access 2010 Runtime. For information about the
differences between the Microsoft Access program and the Microsoft Access
Runtime, in the status bar, click Powered by Microsoft Access.' Access 2013
uses different description: 'This feature requires the Microsoft Access 2013
program to be installed on your computer. The application you are running is
powered by the Microsoft Access 2013 Runtime. For information about the
differences between the Microsoft Access program and the Microsoft Access
Runtime, in the status bar, click Powered by Microsoft Access.' Access 2016
uses different description: 'This feature requires the Microsoft Access 2016
program to be installed on your computer.The application you are running is
powered by the Microsoft Access 2016 Runtime. For information about the
differences between the Microsoft Access program and the Microsoft Access
Runtime, in the status bar, click Powered by Microsoft Access.'

Access 2007+

32614 Microsoft Access cannot read the data in |1. The minimum required version to
read the data is |2. Access 2010+

32615 Microsoft Access cannot update the data in |1. The minimum required version
to update the data is |2. Access 2010+

32616 Microsoft Access cannot change the design of |1. The minimum required
version to change the design is |2. Access 2010+

32617 The database you are trying to open requires a newer version of Microsoft
Access. Access 2010+

32618 Click here to learn more about this error. Access 2010+
32619 0,0 Access 2010+
Error Code Error Description Supported Versions

32620 An Access 2007 format (.accdb) database must be open before you use this
command. Access 2010+



32621

The file '|1' could not be created. Verify that you have the correct permissions
and that the file is not locked or read-only, and then try again. Access 2016+
uses different description: 'The file '|1' could not be created.Verify that you
have the correct permissions and that the file is not locked or read-only, and
then try again.'

Access 2010+

32622 An error occurred when trying to save the database as a template because the
object |1:[|2] could not be exported. Access 2010+

32623 An error occurred when trying to save the database as a template because the
preview image could not be saved. Access 2010+

32624 An error occurred when trying to save the database as a template because the
icon could not be saved. Access 2010+

32625 An error occurred when trying to save the database as a template because
Relationships failed to export. Access 2010+

32626 An error occurred when trying to save the database as a template because the
Navigation Pane failed to export. Access 2010+

32627 The value for Name is required. Access 2010+
32628 The value for Category is required. Access 2010+
32629 The label for the lookup columnn is required. Access 2010+

32630 The database must be in online mode to complete this operation.@Do you want
to switch to online mode now?@@20@@@4 Access 2010+

32631 The Web application '|1/|2' already exists. Select a different site or Web
application name and try again. Access 2010+

32632 Access to '|' was denied. Please contact the server administrator to request
permissions to publish Access Services databases. Access 2010+

32633 While attempting to publish your database, the server reported the following
error: | Access 2010+

32634
An unknown error occurred while communicating with the server. Please verify
that you are connected to the network, the full URL to the site you are creating
is correct, and that the server is available.

Access 2010+

32635 Microsoft Access could not open the Web application from |1. Please verify that
the server is available. Access 2010+

32636 The server did not respond. Please verify that you are connected to the network
and that the server is available. Access 2010+

32637 The specified server does not support publishing Access Services applications. Access 2010+
32638 You must specify a name to set or remove a local variable. Access 2010+
32639 You must specify a value to set the local variable to. Access 2010+
Error Code Error Description Supported Versions

32640 The database object '|' must be closed in order to make this change.@Please
close the object and try again.@@1@@@1 Access 2010+

32641 You cannot open the database object '|' in design mode with the current settings. Access 2010+
32642 Save As action is not available for Web objects. Access 2010+
32643 You must specify an object for the BrowseTo to open. Access 2010+

32644 Some of the lists selected for import will only be available when the database
application is opened in Microsoft Access. Do you want to continue? Access 2010+

32645 Object name may not exceed | characters. Please specify a shorter name. Access 2010+

32646 There are no valid objects to package into a template. No template file was
created. Access 2010+

32647 You cannot run Web Expressions in a non-trusted database. If you trust the
source of this database, you can enable it by using the Message bar. Access 2010+

32648 This operation is only allowed on Custom Groups. Access 2010+
32649 This operation is only allowed on Custom Categories. Access 2010+



32650 This operation is only allowed on Object Shortcuts in Custom Groups. Access 2010+
32651 This group does not allow this type of customization. Access 2010+
32652 This category does not allow this kind of customization. Access 2010+
32653 Invalid position. Access 2010+
32654 The position of items in the Navigation Pane cannot be changed. Access 2010+

32655 This object cannot be saved as a report because it contains a navigation
control.@@@1@@@1 Access 2010+

32656

Microsoft Access has detected that this database contains both Microsoft
Access 2007 compatible links and Access 2010 compatible links.@Would you
like to convert all links to use improved Access 2010 caching? This will mean
the links cannot be opened in Microsoft Access 2007.@@13@@@4 Access
2013 uses different description: 'Microsoft Access has detected that this
database contains both Microsoft Access 2007 compatible links and Access
2013 compatible links.@Would you like to convert all links to use improved
Access 2013 caching? This will mean the links cannot be opened in Microsoft
Access 2007.@@13@@@4' Access 2016 uses different description:
'Microsoft Access has detected that this database contains both Microsoft
Access 2007 compatible links and Access 2016 compatible links.@Would you
like to convert all links to use improved Access 2016 caching? This will mean
the links cannot be opened in Microsoft Access 2007.@@13@@@4'

Access 2010+

32657

The compact and repair operation has been cancelled. You might not have
adequate permissions to the folder that the database is located in. You need full
permissions to the directory the database is located to compact and repair.
Contact your system administrator for more information.@@@1@@@1

Access 2010+

32658 An error occurred while initializing the Access Services database. Access 2010+

32659 Inserting a datatype template is only supported in an open table with a current
selection. Access 2010+

Error Code Error Description Supported Versions

32660
Microsoft Access does not support this operation for Data Access Pages. To
perform this operation, use Microsoft Office Access 2007 or
earlier.@@@1@@@1

Access 2010+

32661

The ReplicationConflictFunction property is not set properly to resolve
conflicts.@Contact the author of this database application or go to
http://support.microsoft.com/kb/158930 to see how to create such a
function.@@1@@@3

Access 2010+

32662 The form cannot be saved as a report because it contains a Web browser
control. Access 2010+

32663 Please provide a data source for the report. Access 2010+
32664 There was an error opening the file '|'. Access 2010+
32665 The object ""|1"" (|2) could not be found in the current Web application. Access 2010+
32666 Invalid Table Name. Access 2010+

32667 Access was unable to automatically restore your backup database. The backup
database can be accessed here: | Access 2010+

32668 All open objects must be closed before instantiating this application part.@Do
you want Microsoft Access to close all open objects?@@19@@@2 Access 2010+

32669 Microsoft Access encountered an error while checking the object '|' for Web
compatibility.@The conversion failed.@@1@@@1 Access 2010+

32670

Access 2010 cannot contact the server. Check your network connection or
contact the server administrator. Access 2013 uses different description:
'Access 2013 cannot contact the server. Check your network connection or
contact the server administrator.' Access 2016 uses different description:
'Access 2016 cannot contact the server. Check your network connection or
contact the server administrator.'

Access 2010+



32671
Network connectivity lost while updating links.Some tables may not have
changed modes.You will be prompted to change modes again next time your
database is closed and opened.

Access 2010+

32672
Microsoft Access could not create the linked table '|1' with the specified
connection information. Please rename the link and check that the data source
is available.

Access 2010+

32673 Microsoft Access does not have any Web service connection definitions. Access 2010+
32674 The resource name '|' is already in use. Access 2010+

32675 Microsoft Access could not add '|1' to your Image Gallery.@|1 is not an image
file, or is saved in an unrecognized image format.@@1@@@1 Access 2010+

32676 Microsoft Access was unable to add the requested resource to the resources
collection. Ensure that the file exists and is in a valid format. Access 2010+

32677 A resource with the specified name and type already exists in the resource
collection. Only one resource can exist for each combination of name and type. Access 2010+

32678 There was an error adding an image from the file '|1'. Only graphic files
supported by Microsoft Access may be added. Access 2010+

32679 The file '|1' could not be opened. Please verify that the file exists and try again. Access 2010+
Error Code Error Description Supported Versions

32680 The resource name '|1' is invalid.Resource names must be between 1 and 64
characters long, and may not contain most punctuation. Access 2010+

32681 You cannot delete themes directly. Themes are automatically deleted when no
objects are using them. Access 2010+

32682
The current database does not support resource collections. Resource
collections are not supported on Access projects (ADP) or Access databases in
the MDB format.

Access 2010+


